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Preface

This section explains the objectives, intended audience, and organization of this publication and describes the
conventions that convey instructions and other information.

Cisco ONS 15454 M2 chassis has reached its end-of-life status. For more information, see the Retirement
Notification page.

Note

This section provides the following information:

• Document Objectives, on page xxvii
• Audience, on page xxvii
• Document Organization, on page xxvii
• Document Conventions, on page xxix
• Related Documentation, on page xxxv
• Obtaining Optical Networking Information, on page xxxv
• Communications, Services, and Additional Information, on page xxxvi

Document Objectives
This document provides background and reference material for Cisco ONS 15454 dense wavelength division
(DWDM) systems.

Audience
To use this publication, you should be familiar with Cisco or equivalent optical transmission hardware and
cabling, telecommunications hardware and cabling, electronic circuitry and wiring practices, and preferably
have experience as a telecommunications technician.

Document Organization
This document is organized into the following chapters:
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DescriptionChapter

Includes descriptions of OSCM andOSC-CSM cards.
Also provides references to related procedures.

Setting Up Optical Service Channel Cards

Includes descriptions of the optical amplifier cards.
Also provides references to related procedures.

Provisioning Optical Amplifier Cards

Includes descriptions of the 32-MUX-O, 32DMX-O,
and 4MD-xx.x cards. Also provides references to
related procedures.

Provisioning Multiplexer and Demultiplexer Cards

Explains the Tunable Dispersion Compensating Units
(T-DCU) used in DWDM networks. Also provides
references to related procedures.

Setting Up Tunable Dispersion Compensating Units

Includes descriptions of the Protection Switching
Module (PSM) card used in DWDM networks. Also
provides references to related procedures.

Provisioning Protection Switching Module

Includes descriptions of the ROADM cards. Also
provides references to related procedures.

Provisioning Reconfigurable Optical Add/Drop Cards

Includes descriptions of transponder (TXP),
muxponder (MXP), Xponder (GE_XP, 10GE_XP,
GE_XPE and 10GE_XPE), and ADM-10G cards.
Also provides references to related procedures.

Provisioning Transponder and Muxponder Cards

Describes how to provision GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards using Pseudo
Command Line Interface (PCLI).

Configuring GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE Cards Using PCLI

Describes Pseudo-IOS command line interface (PCLI)
for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards.

Pseudo Command Line Interface Reference

Describes the card features.Card Features

Contains hardware specifications for the shelf
assemblies and cards.

Card Specifications

Describes the administrative and service states for
line cards, optical payload ports, out-of-band optical
service channel (OSC) ports, optical channel network
connections (OCHNCs), and transponder/muxponder
cards and ports.

Administrative and Service States

Explains Simple Network Management Protocol
(SNMP) as implemented by the Cisco ONS 15454.

SNMP

Describes the Cisco Transport Controller (CTC)
views, menus options, tool options, shortcuts, and
table display options.

CTC Enhancements, Operations, and Shortcuts
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DescriptionChapter

Describes the defaults for the network element settings
for Cisco ONS 15454 shelf assemblies.

Network Element Defaults

Document Conventions
This document uses the following conventions:

DescriptionConvention

Both the ^ symbol and Ctrl represent the Control (Ctrl) key on a keyboard.
For example, the key combination ^D or Ctrl-D means that you hold
down the Control key while you press the D key. (Keys are indicated in
capital letters but are not case sensitive.)

^ or Ctrl

Commands and keywords and user-entered text appear in bold font.bold font

Document titles, new or emphasized terms, and arguments for which you
supply values are in italic font.

Italic font

Terminal sessions and information the system displays appear in courier
font.

Courier font

Bold Courier font indicates text that the user must enter.Bold Courier font

Elements in square brackets are optional.[x]

An ellipsis (three consecutive nonbolded periods without spaces) after a
syntax element indicates that the element can be repeated.

...

A vertical line, called a pipe, indicates a choice within a set of keywords
or arguments.

|

Optional alternative keywords are grouped in brackets and separated by
vertical bars.

[x | y]

Required alternative keywords are grouped in braces and separated by
vertical bars.

{x | y}

Nested set of square brackets or braces indicate optional or required
choices within optional or required elements. Braces and a vertical bar
within square brackets indicate a required choice within an optional
element.

[x {y | z}]

A nonquoted set of characters. Do not use quotation marks around the
string or the string will include the quotation marks.

string

Nonprinting characters such as passwords are in angle brackets.< >

Default responses to system prompts are in square brackets.[ ]
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DescriptionConvention

An exclamation point (!) or a pound sign (#) at the beginning of a line of
code indicates a comment line.

!, #

Reader Alert Conventions

This document uses the following conventions for reader alerts:

Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.Note

Means the following information will help you solve a problem.Tip

Means reader be careful. In this situation, you might do something that could result in equipment damage or
loss of data.

Caution

Means the described action saves time.You can save time by performing the action described in the paragraph.Timesaver

Means reader be warned. In this situation, you might perform an action that could result in bodily
injury.

Warning

IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could
cause bodily injury. Before you work on any equipment, be aware of the
hazards involved with electrical circuitry and be familiar with standard
practices for preventing accidents. Use the statement number provided
at the end of each warning to locate its translation in the translated safety
warnings that accompanied this device. Statement 1071

SAVE THESE INSTRUCTIONS

BELANGRIJKE VEILIGHEIDSINSTRUCTIES

Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie
die lichamelijk letsel kan veroorzaken. Voordat u aan enige apparatuur
gaat werken, dient u zich bewust te zijn van de bij elektrische schakelingen
betrokken risico's en dient u op de hoogte te zijn van de standaard
praktijken om ongelukken te voorkomen. Gebruik het nummer van de
verklaring onderaan de waarschuwing als u een vertaling van de
waarschuwing die bij het apparaat wordt geleverd, wilt raadplegen.

BEWAAR DEZE INSTRUCTIES

Waarschuwing
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TÄRKEITÄ TURVALLISUUSOHJEITA

Tämä varoitusmerkki merkitsee vaaraa. Tilanne voi aiheuttaa ruumiillisia
vammoja. Ennen kuin käsittelet laitteistoa, huomioi sähköpiirien
käsittelemiseen liittyvät riskit ja tutustu onnettomuuksien yleisiin
ehkäisytapoihin. Turvallisuusvaroitusten käännökset löytyvät laitteen
mukana toimitettujen käännettyjen turvallisuusvaroitusten joukosta
varoitusten lopussa näkyvien lausuntonumeroiden avulla.

SÄILYTÄ NÄMÄ OHJEET

Varoitus

IMPORTANTES INFORMATIONS DE SÉCURITÉ

Ce symbole d'avertissement indique un danger. Vous vous trouvez dans
une situation pouvant entraîner des blessures ou des dommages corporels.
Avant de travailler sur un équipement, soyez conscient des dangers liés
aux circuits électriques et familiarisez-vous avec les procédures
couramment utilisées pour éviter les accidents. Pour prendre connaissance
des traductions des avertissements figurant dans les consignes de sécurité
traduites qui accompagnent cet appareil, référez-vous au numéro de
l'instruction situé à la fin de chaque avertissement.

CONSERVEZ CES INFORMATIONS

Attention

WICHTIGE SICHERHEITSHINWEISE

Dieses Warnsymbol bedeutet Gefahr. Sie befinden sich in einer Situation,
die zu Verletzungen führen kann. Machen Sie sich vor der Arbeit mit
Geräten mit den Gefahren elektrischer Schaltungen und den üblichen
Verfahren zur Vorbeugung vor Unfällen vertraut. Suchen Sie mit der am
Ende jeder Warnung angegebenen Anweisungsnummer nach der
jeweiligen Übersetzung in den übersetzten Sicherheitshinweisen, die
zusammen mit diesem Gerät ausgeliefert wurden.

BEWAHREN SIE DIESE HINWEISE GUT AUF.

Warnung

IMPORTANTI ISTRUZIONI SULLA SICUREZZA

Questo simbolo di avvertenza indica un pericolo. La situazione potrebbe
causare infortuni alle persone. Prima di intervenire su qualsiasi
apparecchiatura, occorre essere al corrente dei pericoli relativi ai circuiti
elettrici e conoscere le procedure standard per la prevenzione di incidenti.
Utilizzare il numero di istruzione presente alla fine di ciascuna avvertenza
per individuare le traduzioni delle avvertenze riportate in questo
documento.

CONSERVARE QUESTE ISTRUZIONI

Avvertenza
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VIKTIGE SIKKERHETSINSTRUKSJONER

Dette advarselssymbolet betyr fare. Du er i en situasjon som kan føre til
skade på person. Før du begynner å arbeide med noe av utstyret, må du
være oppmerksom på farene forbundet med elektriske kretser, og kjenne
til standardprosedyrer for å forhindre ulykker. Bruk nummeret i slutten
av hver advarsel for å finne oversettelsen i de oversatte
sikkerhetsadvarslene som fulgte med denne enheten.

TA VARE PÅ DISSE INSTRUKSJONENE

Advarsel

INSTRUÇÕES IMPORTANTES DE SEGURANÇA

Este símbolo de aviso significa perigo. Você está em uma situação que
poderá ser causadora de lesões corporais. Antes de iniciar a utilização de
qualquer equipamento, tenha conhecimento dos perigos envolvidos no
manuseio de circuitos elétricos e familiarize-se com as práticas habituais
de prevenção de acidentes. Utilize o número da instrução fornecido ao
final de cada aviso para localizar sua tradução nos avisos de segurança
traduzidos que acompanham este dispositivo.

GUARDE ESTAS INSTRUÇÕES

Aviso

INSTRUCCIONES IMPORTANTES DE SEGURIDAD

Este símbolo de aviso indica peligro. Existe riesgo para su integridad
física. Antes de manipular cualquier equipo, considere los riesgos de la
corriente eléctrica y familiarícese con los procedimientos estándar de
prevención de accidentes. Al final de cada advertencia encontrará el
número que le ayudará a encontrar el texto traducido en el apartado de
traducciones que acompaña a este dispositivo.

GUARDE ESTAS INSTRUCCIONES

¡Advertencia!

VIKTIGA SÄKERHETSANVISNINGAR

Denna varningssignal signalerar fara. Du befinner dig i en situation som
kan leda till personskada. Innan du utför arbete på någon utrustning
måste du vara medveten om farorna med elkretsar och känna till vanliga
förfaranden för att förebygga olyckor. Använd det nummer som finns i
slutet av varje varning för att hitta dess översättning i de översatta
säkerhetsvarningar som medföljer denna anordning.

SPARA DESSA ANVISNINGAR

Varning!
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INSTRUÇÕES IMPORTANTES DE SEGURANÇA

Este símbolo de aviso significa perigo. Você se encontra em uma situação
em que há risco de lesões corporais. Antes de trabalhar com qualquer
equipamento, esteja ciente dos riscos que envolvem os circuitos elétricos
e familiarize-se com as práticas padrão de prevenção de acidentes. Use o
número da declaração fornecido ao final de cada aviso para localizar sua
tradução nos avisos de segurança traduzidos que acompanham o
dispositivo.

GUARDE ESTAS INSTRUÇÕES

Aviso

VIGTIGE SIKKERHEDSANVISNINGER

Dette advarselssymbol betyder fare. Du befinder dig i en situation med
risiko for legemesbeskadigelse. Før du begynder arbejde på udstyr, skal
du være opmærksom på de involverede risici, der er ved elektriske
kredsløb, og du skal sætte dig ind i standardprocedurer til undgåelse af
ulykker. Brug erklæringsnummeret efter hver advarsel for at finde
oversættelsen i de oversatte advarsler, der fulgte med denne enhed.

GEM DISSE ANVISNINGER

Advarsel
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Related Documentation
Use this guide in conjunction with the following referenced release publications:

• Release Notes for Cisco ONS 15454 DWDM
• Cisco ONS 15454 DWDM Control Card and Node Configuration Guide
• Cisco ONS 15454 DWDM Network Configuration Guide
• Cisco ONS 15454 DWDM Licensing Configuration Guide
• Cisco ONS 15454 Hardware Installation Guide
• Cisco ONS 15454 DWDM Troubleshooting Guide
• Cisco Transport Planner - DWDM Operations Guide
• Regulatory Compliance and Safety Information for Cisco ONS Platforms
• Electrostatic Discharge and Grounding Guide for Cisco CPT and Cisco ONS Platforms
• Installing the GBIC, SFP, SFP+, XFP, CXP, and CFP Optical Modules in Cisco ONS Platforms
• Installing the Cisco ONS 15454 DWDM Passive Optical Modules

For an update on End-of-Life and End-of-Sale notices, refer to

http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_eol_notices_list.html

Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that pertains
to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.

Where to Find Safety and Warning Information
For safety and warning information, refer to the Regulatory Compliance and Safety Information document
that accompanied the product. This publication describes the international agency compliance and safety
information. It also includes translations of the safety warnings.

Safety Labels

Cisco NCS 2000 Series cards are classified as Laser Class 1 or 1M as per IEC 60825-1 and Hazard Level 1M
as per IEC 60825-2.
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Figure 1: Class 1M Laser Product Label

Figure 2: Class 1M Laser Product Label

Statement 291

Communications, Services, and Additional Information
• To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.

• To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.

• To submit a service request, visit Cisco Support.

• To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit
Cisco Marketplace.

• To obtain general networking, training, and certification titles, visit Cisco Press.

• To find warranty information for a specific product or product family, access Cisco Warranty Finder.
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Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides
you with detailed defect information about your products and software.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
xxxvii

Preface
Preface

https://www.cisco.com/c/en/us/support/web/tools/bst/bsthelp/index.html


Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
xxxviii

Preface
Preface



Cisco ONS Documentation Roadmap

To quickly access publications of Cisco ONS Release 10.x.x, see the Documentation Roadmap.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
xxxix

http://www.cisco.com/en/US/docs/optical/15000r10_0/dwdm/doc_roadmap/b_onsroadmap10.html


Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
xl

Cisco ONS Documentation Roadmap
Cisco ONS Documentation Roadmap



New and Changed Information

This table summarizes the new and changed information for Release 11.0, and tells you where the features
are documented.

Table 1: New and Changed Features - R11.0

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

NTP-G367 Provisioning Encryption
on 400G-XP-LC Card

The OTNXC operating mode on the
400G-XP-LC card supports encryption.

OTNXC encryption

Cisco ONS 15454 DWDM Line
Card Configuration Guide

NTP-G363 Provisioning LSC on
Cards

The 400G-XP-LC card supports the
generation of a Certificate Signing Request
(CSR) and the installation of Locally
Significant Certificates (LSCs) that can be
used to authenticate the peer card connection.
Third party certificates also referred to as
Locally Significant Certificates (LSCs) are
certificates that are signed by a Certification
Authority (CA) other than Cisco Certificate
Authority. LSCs allow customers to have
their own Public Key Infrastructure (PKI) to
provide better security, to have control of
their own CA, and to define policies,
restrictions, and usages on the generated
certificates.

Third party certificates
for encryption

Cisco ONS 15454 DWDM Network
Configuration Guide

Automatic Node Setup

The upgradedNE update XML file imported
on the CTC for the respective node will
import the newANS parameters and settings
for the new degree or modules. The existing
ANS parameters or module settings are not
affected. This prevents unintended changes
to the APC corrections to the existing degree
and its associations.

ANS APC Skipping
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• Provisioning OTDR

Manage the Node

• NTP-G357 Perform OTDR
Scan and OTDR Event Scan

A TNCS-2O card has an optical module that
provides Optical Time Domain
Reflectometer (OTDR) measurement, ORL
measurement, and standard Optical Service
Channel (OSC) capability on two ports.
These capabilities are available for upto four
ports for each shelf; one shelf can have two
TNCS-2O cards.

OTDR Support for
TNCS-2O Cards

Cisco ONS 15454 DWDM Network
Configuration Guide

For using a regenerator, the optical path
needs to be validated. If the optical validation
fails, then, the regenerator cannot be used,
and the circuit creation fails. If validation is
not supported, pre-validated paths are
calculated offline and provided as a
constraint to the control plane, while setting
up the main and restored paths.

Regenerator Constraints
Support

Cisco ONS 15454 Control Card and
Node Configuartion Guide

TNCS-2 and TNCS-2O Cards

The TNCS-2 and TNCS-2O are new control
cards compatible with all chassis types such
as, Cisco ONS 15454M2, Cisco ONS 15454
M6, and NCS 2015.

TNCS-2 and TNCS-2O
Control Cards

Cisco ONS 15454 Control Card and
Node Configuartion Guide

TNCS-O Card

The TNCS-O card is supported on the Cisco
15454 M2.

TNCS-O Card Support

Cisco ONS 15454 DWDM Line
Card Configuration Guide

400G-XP-LC Card

• The new payloads supported for the
MXP operating mode are FC-10G,
FC-8G, and 40G.

• The OPM_2x40G_2x10G slice mode
can be configured in theMXP operating
mode for 40GE payloads.

• LLDP support—The source MAC
address of 10 or 100GE ports can be
retrieved after an LLDP packet is
received on the client port. LLDP
filtering is enabled or disabled on the
10GE or 100GE ports using the
Provisioning > Line > Ethernet tab in
CTC.

400G-XP-LC
enhancements

Cisco ONS 15454 DWDM Network
Configuration Guide

DLP-G800 Create an LMP Link
Using CTC

Two variants of 300G, such as 300G_3bps
and 300G_3.4375bps are added in the
wavelength drop-down list.

NCS 1004 Alien
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

Provision GMPLSOptical Channel
Network Connections Using
Non-SSON

In non-SSON, the user can force the
wavelength by checking the wavelength
configuration check box and choosing the
wavelength from the drop-down list.

8QAM Support on
non-SSON

This table summarizes the new and changed information for Release 10.9, and tells you where the features
are documented.

Table 2: New and Changed Features - R10.9

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

The 400G-XP-LC card provides encryption
capability on the OTU4 ports. This card provides
confidentiality of the data, which is sent over a fiber
optic communication channel, using Next
Generation Cryptography. The MXP operating
mode supports the encryption feature.

Encryption on
400G-XP-LC card

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• The cross-connect circuit bandwidth supported
are ODU2, ODU2e, and ODU4.

• The OPM_10x10G slice mode is supported
for OTN cross-connect circuits.

• The new payloads supported for the OTNXC
operating mode are OC192/STM64, OTU2,
OTU2e, and 100G.

• The new payloads supported for the MXP
operating mode are OC192/STM64 and
OTU2e.

• The ODU4 internal ports on the 400G-XP-LC
card support configuration of Pseudo Random
Binary Sequence (PRBS) with all operating
modes.

• The Trunk GCC0 configuration is supported
on the 400G-XP-LC card.

• The 2x150G 8QAM modulation format is
configurable on the 400G-XP MXP trunk
ports.

400G-XP-LC
Enhancements
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Where DocumentedDescriptionFeature

Cisco NCS 2000 Series Network
Configuration Guide

• The transponder node containing a set of
transponders is physically connected to the
ROADM-A node using the external PPC.

• The PPC represent the physical connection
between transponder and ROADM node
add/drop port. The Staic LMP or UNI need to
be created on remote transponder andROADM
accordingly.

• This feature supports the following transponder
cards:

100G-LC-C

100G-CK-C

100GS-CK-C

200G-CK-C

400G-XP-LC with both MXP/OTNXC
operating modes

Remote TXP

Cisco ONS 15454 DWDM Network
Configuration Guide

In case of a fiber cut in a path, the media channels
in a media channel group (MCHG) are restored
using another available path. This helps reduce the
network outage time. After restoration, there is also
an option to shrink the media channel group to the
minimum size to maintain all the media channnels
in the same group.

MCG Restoration

This table summarizes the new and changed information for Release 10.8, and tells you where the features
are documented.

Table 3: New and Changed Features - R10.8

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• OTNCross-connect Capability
on 400G-XP-LC Cards

Cisco ONS 15454 DWDM Network
Configuration Guide

• NTP-G365
Creating,Managing, and
Deleting ODUCircuits for the
400G-XP-LC Card

The 400G-XP-LC card supports a new OTN
cross-connect (OTNXC) operatingmode. Thismode
allows ODU2e switching between client to trunk
ports or trunk to trunk ports within a single
400G-XP-LC card for 100G and 200G trunk rates.
Only the 10GE client payloads are supported. Each
10GE is mapped to an ODU2e channel. Each 10G
client port of the 400G-XP-LC card consists of only
one ODU2e and each OTU4C2 ( 200G) trunk port
of the 400G-XP-LC card consists of 20 ODU2es.
Client-to-trunk cross-connections can be protected
or unprotected. Single card cross-connects or
end-to-end cross-connects can be created in an OTN
ring.

OTN
Cross-connect
support on
400G-XP-LC
Cards
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• NTP-G355 Provisioning
OTDR for TNCS-O Cards

Manage the Node

• NTP-G357 Perform OTDR
Scan and OTDR Event Scan

• Scan performances are improved using specific
scan parameters targeted on the characteristics
of the fiber plant such as span length, reflection
contributions, and major events.

• OTDR identifies the Fiber End as a fiber
termination event along with reflection or loss
event.

• Automode scan is enhancedwith the composite
trace.

• Fast Span Trace is displayed to the user for
quick reference before the composite trace.

• OTDR module can perform Optical Return
Loss (ORL) measurement.

• Any ongoing scan operation can be cancelled.

• A progress bar is provided to the user for each
scan in the sector that displays the percentage
of execution of the entire scan operation.

• It is possible to activate automatic scan on
ORL value exceeding the provisioned
threshold.

• The insertion loss due to amplifier cards and
patchcords is displayed in the OTDR
provisioning panel.

• New OTDR alarms and conditions are
introduced to provide more information about
the OTDR functionality.

• Prevention of WSON circuit creation is
extended for new OTDR alarms and
conditions.

• CTC panes for OTDR provisioning are
redesigned for better user experience.

OTDR
Enhancements

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Regeneration Mode for
400G-XP LC

400G- XP LC card can be configured as a
regenerator. The regeneration functionality is
available only on the trunk ports. The two trunk
ports must have the same rate to achieve
regeneration. Regen mode is not supported on the
client ports.

Support for
Regeneration
Mode on
400G-XP-LC
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 400G-XP-LC Card

400G-XPLC card supports the Protection Switching
Module (PSM). The switch time for all 10G
payloads is less than 50 ms. The switch time for
100G trunk rate is higher than the 200G.

PSM support on
400G-XP-LC

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• OPT-EDFA-35

Manage the Node

• NTP-G76 Verify Optical Span
Loss Using CTC

• NTP-G77 Manage Automatic
Power Control

Monitor Performance

• NTP-G74 Monitor DWDM
Card Performance

• DLP-G140 View Power
Statistics for Optical
Amplifier, 40-SMR1-C, and
40-SMR2-C Cards

The OPT-EDFA-35 card is a C-band, DWDM
EDFAamplifiers/preamplifierswith +23dBmoutput
power. The card includes two identical amplification
sections to serve two fiber directions
simultaneously. The OPT-EDFA-35 card is
bidirectional and has an operative optical gain range
up to 24 dB and 35 dB.

OPT-EDFA-35

Cisco ONS 15454 DWDM Series
Line Card Configuration Guide,
Release 10.x.x

• GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE Cards

• MXP_MR_10DMEX_CCard

• OPT-RAMP-C and
OPT-RAMP-CE Cards

The GE_XP, 10GE_XP, GE_XPE,10GE_XPE,
MXP_MR_10DME_C, and OPT-RAMP-CE cards
are supported on the Cisco NCS 2015 chassis.

Card Support in
Cisco NCS 2015

Cisco ONS 15454 DWDM Network
Configuration Guide, Release
10.x.x

• OpenSSH Version

TheOpenSSH has been upgraded to CiscoSSH 1.4.Software
Enhancements

This table summarizes the new and changed information for Release 10.7, and tells you where the features
are documented.
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Table 4: New and Changed Features - R10.7

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Key Features of 100G-LC-C,
100G-ME-C, 100G-CK-C,
100ME-CKC, 10x10G-LC,
100GS-CK-LC,
200G-CK-LC, CFP-LC, and
MR-MXP Cards

Y-cable protection is supported
when the 200G-CK-LC card is
configured in TXP-100G operating
mode and the 100G client CPAK
ports are provisioned with 100GE
payload. This configuration uses
the CPAK-100G-LR4 pluggable.

Y-cable protection is supported
when the 10x10G-LC card is
configured in MXP-10x10G
operatingmodewith 200G-CK-LC
card and the 10x10G-LC card is
provisioned with 10GE,
OC-192/STM-64 payloads. This
configuration uses the
ONS-SC+-10G-LR and
ONS-SC+-10G-SR pluggables.

Y-cable support for 200G-CK-LC
and 10x10G-LC cards

Cisco ONS 15454 DWDM Network
Configuration Guide

SSON allows the user to provide
more than 96 channels in a span.
The SSON package is enabled
using a specific package.

The supported SSON circuits are:

• Media Channel

• Media Channel Group

• Carrier

SSON

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• MR-MXP Card

2X10GE+2X40GE payload is
supported inMXP-100G operating
mode which comprises of
200G-CK-LC andMR-MXP cards.
This payload is supported only
when the subOpMode inMR-MXP
card is OPM_2x40G_2x10G.

OTU4 payload is supported in
MXP-CK-100G operating mode
which comprises of 200G-CK-LC
and MR-MXP cards. This payload
is supported only when the sub
OpMode in MR-MXP card is
OPM_100G.

MR-MXP Configuration for 100G
and 200G OTU4
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

The MR-MXP card supports the
generation of a Certificate Signing
Request (CSR) and installation of
Locally Significant Certificates
(LSCs) that can be used to
authenticate the peer card
connection.

Third Party Certificates forMR-XP
Card

Cisco ONS 15454 DWDM Line
Card Configuration Guide

One 400G-XP-LC card can be
installed in the Cisco ONS 15454
M2 DC chassis that is powered by
15454-M2-DCor 15454-M2-DC-E.

Support of 400G-XP-LC cards on
Cisco ONS 15454 M2

Cisco ONS 15454 DWDM Line
Card Configuration Guide

This payload is supported only on
the ONS-QSFP28-LR4 pluggable.
The payload can be provisioned for
the OPM_100G slice mode for any
trunk configuration.

Support for OTU4 traffic on
400G-XP-LC Cards

Cisco ONS 15454 DWDM Line
Card Configuration Guide

This line card is interoperable with
theNCS55-6X200-DWDM-S card
supported on NCS 5500 and the
NCS4K-4H-OPW-QC2 Card
supported on NCS 4000.

Interoperability with 400G-XP-LC
card

This table summarizes the new and changed information for Release 10.6.2, and tells you where the features
are documented.

Table 5: New and Changed Features - R10.6.2

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Support for 16G-Fiber
Channel and OTU2 payloads

• Support for trunk PM
parameters-Second Order
PMD (SOPMD) and
Polarization Depended Loss
(PDL).

400G-XP-LC card enhancements

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
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Where DocumentedDescriptionFeature

Cisco ONS 15454 Network
Configuration Guide

Two enhancements have been
introduced to recover the node
without traffic loss.

• When provisioning database
loss occurs, the
BAD-DB-DETECTED and
NODE-FACTORY-MODE
critical alarms are raised at the
node level.

• When system database loss
occurs on the active or
standby control card, an
INVALID SYSDB alarm is
raised on the control card.

Steps to clear the alarms have been
documented.

Node recovery enhancements

Cisco ONS 15454 DWDM Line
Card Configuration Guide

The following configurations are
supported:

• 40 400G-XP-LC cards
provisioned with 10GE
payloads

• 20 400G-XP-LC, 36
200G-CK-LC, and 72
MR-MXP cards provisioned
with 10GE payloads

• 80 400G-XP-LC cards
provisioned with 100GE
payloads

• 20 400G-XP-LC cards
provisioned with 100GE
payloads along with 36
200G-CK-LC and 72
MR-MXP cards provisioned
with 10GE payloads.

MSM supported configurations
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Control
Card and Node Configuration
Guide

• Duplicate Node Controller

(Only on ONS 15454M6 and NCS
2015) When a
TNC/TNC-E/TSC/TSC-E/TNCS/TNCS-O
node controller connects to the
same switch where an NCS 2006
or NCS 2015 node controller exists,
both the node controllers raise the
critical Duplicate Node Controller
(DUP-NC) alarm. The subtending
shelves of both the node controllers
raise the Shelf Communication
Failure (SHELF-COMM-FAIL)
alarm. Both the node controllers
and their subtending shelves shut
down their ports on ASIC towards
the MSM ports in ECU. However,
the traffic is not affected.

Duplicate Node Controller

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• MR-MXP Card

OC192/STM64 and OTU2 client
payloads are supported on the
MR-MXP card in MXP-200G,
MXP-10x10G-100G,
MXP-CK-100G, and MXP-100G
operating modes. OC192/STM64
and OTU2 client payloads are
supported only when the sub
OpMode is OPM_10x10G on the
MR-MXP card.

MR-MXP Enhancements

Cisco ONS 15454 DWDM Control
Card and Node Configuration
Guide

• TCC2 and TCC2P Cards

The nodes with the TCC2/TCC2P
cards in releases prior to R10.6.2
cannot be upgraded to R10.6.2 as
the size of the software package
exceeds the size of the
TCC2/TCC2P flash drive. Hence,
R10.6.2 does not have the
TCC2/TCC2P software package. If
the user wants to continue with the
ONS 15454 chassis, it is
recommended to use the TCC3
control card. If the user wants to
upgrade to a ONS 15454 M6 or
NCS 2015 chassis, it is
recommended to use the TNCS or
TNCS-O control cards.

TCC2 and TCC2P Card Support
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Multivendor Interoperability

The 200G-CK LC can be
configured to interoperate with
other vendor devices. The Interop
Mode option is available on the full
PID, NCS2K-200G-CK, and on the
licenced PID,
NCS2K-200G-CK-LIC, when
licence L-NCS2K-DQPSK-LH= is
active.

Multivendor Interoperability

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Operating Mode

To support the 16G FC payload, a
new operating mode,
OPM_6x16G_FC is introduced.
This operating mode can be
provisioned on any MXP card
configuration slice, with M_100G
and M_200G trunk ports.

OperatingMode to support 16G FC
payload

Cisco ONS 15454 DWDM Network
Configuration Guide

• Node Reference

A new colorless, directional A/D
stage is available using the passive
A/D module, MF-6AD-CFS. This
A/D stage provides modular A/D
capability up to 96 channels that
can be used to insert or extract
colorless channels to or from a
specific ROADM direction.

ROADM Configurations

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• WSE Card

• NTP-G340 Provisioning
Encryption on the WSE and
MR-MXP Cards

The WSE card supports the
generation of a Certificate Signing
Request (CSR) and installation of
Locally Significant Certificates
(LSCs) that can be used to
authenticate the peer card
connection.

Third Party Certificates for WSE
Card

Cisco NCS 2000 Series Network
Configuration Guide

• DLP-G793 Configuring
Common OTDR Parameters
for OTDR Scan on TNCS-O
Cards

Manage the Node

• DLP-G787 Perform OTDR
Event Scan on TNCS-OCards

• The OTDR scan starts
automatically after the LOS
alarm is raised and cleared.

• The default value for the
automatic OTDR scan to
begin is 3 minutes.

• Location [km] in the
Reflection table or the
Insertion Loss table is
enhanced with the Accuracy
(km) details.

OTDR Enhancements

This table summarizes the new and changed information for Release 10.6.1, and tells you where the features
are documented.
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Table 6: New and Changed Features - R10.6.1

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

400G-XP-LC Card

The 400G-XP-LC card is a tunable
DWDM trunk card that simplifies
the integration and transport of 10
Gigabit and 100 Gigabit Ethernet
interfaces and services into
enterprises and service provider
optical networks. The card is a
double- slot unit that provides 400
Gbps of client and 400 Gbps of
trunk capacity. The card supports
six QSFP+ based client ports that
can be equipped with 4x 10 Gbps
optics and four QSFP28 or QSFP+
based client ports that can be
equipped with 100 Gbps QSFP28
and 4x 10Gbps QSFP+ optics. The
card is capable of aggregating client
traffic to either of the two 200 Gbps
coherent CFP2 trunk ports.

The 400G-XP-LC card is supported
only on Cisco ONS 15454 M6 and
Cisco NCS 2015 platforms.

400G-XP-LC card

Installing the Cisco ONS 15454 M2
and ONS 15454 M6 Passive
Optical Modules

The following types of modules are
supported:

• MPO-24 to 20-LC Fan-out
Module
(NCS2K-MF-MPO-20LC=)

• 6 Port Add/Drop Module
(NCS2K-MF-6AD-CFS=)

Passive Optical Modules

Cisco ONS 15454 Hardware
Installation Guide

ONS 15454M6 ECU60-S is a new
type of ECU-S introduced for the
ONS 15454 M6 when the shelf is
powered at –60 VDC nominal
input voltage. This module has
eight USB 2.0 ports and two USB
3.0 ports.

ONS 15454 M6 ECU60-S
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Where DocumentedDescriptionFeature

Installing the Cisco ONS 15454
DWDM Passive Optical Modules

New MPO Cables

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
liii
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Where DocumentedDescriptionFeature

The following table lists the MPO
cables that can be used with the
passive modules from Release
10.6.1:

• ONS-MPO-16LC-2—Fan-out
cable with one MPO-24
connector on one side and 16
LC connectors on the other
side. The cable is two meters
long and can be used in
ROADM configurations with
the NCS2K-MF-6AD-CFS
module. This cable can also
be used as a fan-out cable to
connect the LC interface
directly to the SMR20 FS
MPO ports.

• ONS-12MPO-MPO-x—Multi-fiber
patch cord with MPO-12
connectors. The 12 fibers have
straight connections. There are
four variants: two, four, six,
and eight meters. The cables
can interconnect the QSFP+
client ports of
NCS2K-400G-2C2 and
NCS4K-4H-OPW-QC2 with
the NCS2K-MF-8X10G-FO
passive module.

• ONS-12MPO-XMPO-x—Multi-fiber
patch cord with MPO-12
connectors. The 12 fibers have
crossed fiber interconnections.
The cable is used to
interconnect the
NCS2K-MF-DEG-5-CV and
the NCS2K-MF-UPG-4-CV
passive modules with the
NCS2K-MF-MPO-8LC
adapter.

• ONS-16MPO-MPO-x—Multi-fiber
patch cord with MPO-24
connectors that has only 16
fibers connected. Fibers 1, 2,
11, 12, 13, 14, 23, and 24 are
not connected. The cable is
used for interconnections
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Where DocumentedDescriptionFeature

inside the ROADM with
MPO-24 standard. The patch
cord can be used for
interconnections between
SMR20 FS and
NCS2K-MF-M16LC-CV, or
NCS2K-MF-2MPO-ADP or
NCS2K-PPMESH8-5AD.The
patch cord can also be used
for interconnections between
NCS2K-16-AD-CCOFS and
NCS2K-MF-M16LC-CV.

Synchronizing Node Timing chapter
of the

Cisco ONS 15454 DWDM Control
Card and Node Configuration
Guide

Synchronous Ethernet (SyncE)
provides synchronized timing to
multiple remote network elements
(NEs) without using an external
circuit for timing. SyncE provides
the required synchronization at the
physical level and uses the Ethernet
SynchronizationMessage Channel
(ESMC) to enable traceability of
the best clock source. SyncE clocks
are compatible with the clocks used
in the SONET or SDH
synchronization network.

SyncE is supported on TNCS and
TNCS-O controller cards. You
must enable ESMC on anOSC port
to configure it as a clock source.

Synchronous Ethernet
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Where DocumentedDescriptionFeature

Cisco ONS 15454 Network
Configuration Guide

• NTP-G355 Provisioning
OTDR for TNCS-O Cards

Manage the Node

• NTP-G357 Perform OTDR
Scan and OTDR Event Scan

• Two types of OTDR scans are
available for TNCS-O cards:
hybrid scan and fast scan.

When you start a fast scan on
a TX or an RX port, an
OTDR_FAST_SCAN_IN
PROGRESS_TX or an
OTDR_FAST_SCAN_IN
PROGRESS_RX alarm is
raised. Fast scan shuts down
the OSC channel.

When you start a hybrid scan
on a TX or an RX port, an
OTDR_HYBRID_SCAN_IN_PROGRESS_TX
or an
OTDR_HYBRID_SCAN_IN_PROGRESS_RX
alarm is raised. Hybrid scan
does not shut down the OSC
channel and takes more time
to complete.

• New OTDR alarms are
introduced to provide more
information about the OTDR
events. Select an event to view
its details as a graph or in a
tabular format.

• CTC logs the data of a
maximum of 32 historical
OTDR scans. The history is
maintained for OTDR scans
in the same zone and
direction. The values of the
back reflection and insertion
loss are listed for each scan
along with the date and
timestamp.

OTDR Enhancements
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Supported Cards
• Running the Connection
Verification

Cisco ONS 15454 DWDM Network
Configuration Guide

• Node Reference
• NTP-G356 Verify the
Connections in Optical Cables

• View and troubleshoot patch
cords that have an excess
insertion loss higher than the
threshold value.

• View the originating and
destination slots for the
connection verification along
with the patch cords in the
cable view and front panel
view of the card.

• If there is at least one patch
cord highlighted in yellow and
no patch cords highlighted in
orange on a node, an
IPC-VERIFICATION-DEGRADE
alarm is raised on the node.

• If there is at least one patch
cord highlighted in orange on
the node, an
IPC-VERIFICATION-FAIL
alarm is raised on the node.

• When the insertion loss is
greater than the insertion loss
degrade threshold and less
than the insertion loss fail
threshold, the value of the
insertion loss verification of
the patch cord is degrade. The
corresponding row of the
patch cord in the Connection
Verification pane is
highlighted in yellow.

• When the insertion loss is
greater than the insertion loss
fail threshold, the value of the
insertion loss verification of
the patch cord is fail. The
corresponding row of the
patch cord in the Connection
Verification pane is
highlighted in orange.

• Connectivity verification is
displayed only for an MPO
cable and not for each of the
patch cords in it.

Connection Verification
Enhancements
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• MR-MXP Card

• NTP-G340 Provisioning
Encryption on the WSE and
MR-MXP Cards

Cisco ONS 15454 DWDM
Licensing Configuration Guide

The MR-MXP card supports the
following enhancements:

• Payload authentication can be
enabled on theMR-MXP card
to validate the integrity of the
received payloads.

• Payload authentication error
thresholds can be set on the
MR-MXP card.

• MR-MXP-K9 and
MR-MXP-K9= PIDs of
MR-MXP card are introduced
and are referred as Encryption
as an appliance PIDs. The card
authentication and payload
encryption are enabled by
default and cannot be disabled
for these PIDs.

MR-MXP Enhancements

Cisco ONS 15454 DWDM Network
Configuration Guide

• DLP-G800 Create an LMP
Link Using CTC

• DLP-G801 Configure Local
UNI Using CTC

LinkManagement Protocol (LMP)
link can be created between the
DWDM node and non DWDM
node using a wizard in CTC.

LMP Wizard Enhancements

TCC2 and TCC2P CardsThe TCC2P card can be used as a
control card in a subtended shelf
where the node controller is TCC3
card on ONS 15454 chassis or
TNC/TNCE/TNCS/TNCS-O cards
on ONS 15454 M6 or NCS 20015
chassis. The TCC2P card can also
be used as a node controller in a
stand-alone configuration.

TCC2P support
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Where DocumentedDescriptionFeature

• NTP-G353 Creating GMPLS
Circuits Using the Fast Circuit
Mode

• DLP-G732 Editing a GMPLS
Circuit

• NTP-G359 Changing the
Channel Frequency
Measurement Unit

• NTP-G135 Editing Network
Element Defaults

• NTP-G345 Viewing Ethernet
Statistical PM Counts

• Split ROADM Nodes

• DLP-G381 ProvisioningLayer
2 Protection Settings

• 200G-CK-LC

Several software enhancements are
introduced in Release 10.6.1.

• Reroute enhancements

• Retuning wavelengths of
existing circuits

• Changing the channel
frequency measurement units
to THz or GHz

• Fast restoration of circuits

• CTC displays the historical
ethernet statistics that are
retrieved from the ethernet
controllers on the router.

• Support of 40-SMR1-C cards
in a split ROADM
configuration

• When a fault occurs on the
working path of a FAPs ring,
all the SVLANs, whose
protection is set, are moved to
the protection path of the
FAPS ring. Up to 1024
SVLANs can be protected or
a range of SVLANs can be
protected.

• 200G-CK-LC card supports
additional configurations in
the MXP_200G and
MXP_CK_100G operating
modes.

Software Enhancements
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Where DocumentedDescriptionFeature

• Manage the Node

• Connect the PC and Log into
the GUI

• RADIUS authentication is
supported for security super
user, security user, and root
user.

• Security policy can be
changed for the security level
that you want to provision:
Retrieve, Maintenance,
Provisioning, Superuser,
Security user, Security super
user, or ROOT15 user.

• RSA-based authentication is
supported for dynamic
challenge response security
feature.

• Node reauthentication is
supported in CTC for Cisco
NCS 2000 and Cisco CRS
nodes.

• Text string in the Shared
Secret field is masked and the
shared secret serves as a
password between a RADIUS
client and RADIUS server.

Security Enhancements

• Manage the Node

• Cisco ONS 15454 Hardware
Installation Guide

The System Mode can be changed
by:

• Using CTC

• Using LCD

System Mode Change

Cisco ONS 15454 DWDM Network
Configuration Guide

• DLP-G790 Create a Static
LMP Connection

With LMP extension for trunk
ports, traffic is directed to the NCS
4000 series router from the trunk
ports of the NCS 2000 series router.

LMP Protocol Extension for Trunk
Ports

Cisco ONS 15454 DWDM Network
Configuration Guide

• Node Reference

New layer-2 A/D extensions for
ROADM

ROADM Configurations
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• Configuring an Explicit Route
Object

• Recording a Route Object

• Configuring SRLG Diversity

The enhancements include the
following:

• Explicit Route Object (ERO)
- defines the route(s) to be
used through a list of specified
nodes for a LSP.

• Record Route Object (RRO)
- enables the user to obtain a
list of used resources.

• SRLG diversity - enables the
user to create a new circuit,
with resources which are not
used in the reference circuit.

GMPLS enhancements

Cisco ONS 15454 DWDM Network
Configuration Guide

• Repairing a Circuit

When some nodes change their
network IP, WSON is not able to
restore the correct state of the
involved circuits. The Repair
Circuits feature enables the user to
fix circuits that WSON is not able
to automatically repair.

Repair Circuits

CTC Enhancements, Operations
and Shortcuts

Highlights the recent changesmade
by the user.

CTC Cell Highlight

This table summarizes the new and changed information for Release 10.5.2, and tells you where the features
are documented.
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Table 7: New and Changed Features - R10.5.2

Where DocumentedDescriptionFeature

Cisco NCS 2000 Series Hardware
Installation Guide

The Cisco NCS 2015 AC shelf
assembly has 18 vertical slots
numbered 1 to 18. While slot 2 to
slot 16 is for line cards that provide
10 to 100 Gbps interconnections,
slot 1 and slot 17 is for the TNCS
or TNCS-O cards (timing and
control cards). Slot 18 is for the
external connection unit (ECU).
TheNCS 2015AC shelf is powered
by AC power modules with 1+0,
1+1, 2+0, and 2+2 redundancy. The
NCS 2015 AC shelf contains
backup flashmemory that supports
the database (DB) and image
backup in the single mode
operation. The LCD unit is
integrated with the fan tray
assembly. The fiber or cable guide
used in the NCS 2015 AC shelf
provides improved fiber
management. The air in the NCS
2015 AC shelf is drawn in through
a two-inch air inlet at the bottom of
the shelf, and expelled at the
top-rear. A single NCS 2015 AC
shelf supports both ANSI and ETSI
standards.

Cisco NCS 2015 AC Shelf
Assembly

Cisco ONS 15454 Hardware
Installation Guide

The ONS 15454 M6 ECU-S is a
new type of ECU introduced for the
ONS 15454 M6. It has 2 USB 3.0
connections and 8 USB 2.0
connections. The Fiber Shuffle or
the MPO-fan-out unit can be
connected to the ONS 15454 M6
ECU-S using the USB 3.0 port.

ONS 15454 M6 ECU-S

Cisco ONS 15454 DWDM Control
Card and Node Configuration
Guide

• NTP-G24 Setting Up Name,
Date, Time, and Contact
Information

A node alias (up to 128 characters)
can be configured for a node. It
shows as a tool tip in the Network
Map and Explorer Tree of the CTC.

Node Alias
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Provisioning Protection
Switching Module

PSM cards support automatic
bi-directional traffic reversion.

SNMP support is added for PSM
Cards to retrieve the port status.

PSM cards support automatic
Optical Multiplex Section (OMS)
protection when provisioned with
Transponder (TXP) andMuxponder
(MXP) cards.

PSM Cards
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Where DocumentedDescriptionFeature

The SMR20 FS CV cards are
tunable over 96 channels in the
C-band, at 50-GHz spacing on the
ITU-T grid. The cards provide flex
spectrum capability, which allows
the flexibility to allocate the
channel bandwidth and to increase
the network scalability. The cards
support up to 20 directions for each
ROADMnode and can be installed
in any service slots in the chassis.
The SMR20 FS CV cards provide
the connection verification
capability using a connectivity
check signal. The correctness and
the quality of the interconnections
(determined by measuring the
insertion loss of the external
passive path) can be validated with
the connection verification feature
in the cards.

SMR20 FS CV Cards
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 17 SMR9 FS, 24 SMR9 FS,
34 SMR9 FS and SMR20 FS
Cards

• Connection Verification
• Supported Cards
• Running the Connection
Verification

Cisco ONS 15454 DWDM Network
Configuration Guide

• Node Reference
• NTP-G356 Verify the
Connections in Optical Cables

Cisco ONS 15454 DWDM Network
Configuration Guide

• DLP-G325 Changing Optical
Amplifier Line Settings

• DLP-G326 Changing Optical
Amplifier Threshold Settings

• DLP-G406 Changing Card
Optical Channel Parameters
for 40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G407 Changing the
Optical Channel Thresholds
for 40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G408 Changing Optical
Line Parameters for
40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G409 Changing the
Optical Line Thresholds for
40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G772 Viewing
Wavelength Power for
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Where DocumentedDescriptionFeature

16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Card

• DLP-G773 Creating a Flex
Spectrum or ITU Circuit for
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Card

• DLP-G140 View Power
Statistics for Optical
Amplifier, 40-SMR1-C,
40-SMR2-C,17 SMR9 FS, 24
SMR9 FS, 34 SMR9 FS, and
SMR20 FS Cards

• DLP-G141 View Optical
Power Statistics for
32MUX-O, 32WSS,
32WSS-L,
32DMX-O,32DMX,
32DMX-L, 40-WSS-C,
40-WSS-CE, 40-WXC-C,
80-WXC-C, 16-WXC-FS, 17
SMR9 FS, 24 SMR9 FS, 34
SMR9 FS, SMR20 FS,
SMR20 FS CV, 40-MUX-C,
40-DMX-C, and 40-DMX-CE
Cards
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Control
Card and Node Configuration
Guide

• TNCS-O Cards

• NTP-G313 Installing and
Configuring the TNC, TNCE,
TSC, TSCE, or TNCS Card

Cisco NCS 2000 Series Network
Configuration Guide

• NTP-G355 Provisioning
OTDR for TNCS-O Cards

Manage the Node

• NTP-G357 Perform OTDR
Scan and OTDR Event Scan

The TNCS-O cards are provisioned
as active and standby cards in the
CiscoONS 15454M6 orNCS 2015
shelves. On the NCS 2015 shelf,
the TNCS-O cards can be installed
in slots 1 and 17. On the ONS
15454 M6 shelf, the cards can be
installed in slot 1 and 8. If the
active TNCS-O card fails, system
traffic switches to the redundant
TNCS-O card. The TNCS-O cards
support only Fast Ethernet (FE) and
wavelength of 1518 nm in OSC
transmissions.

A TNCS-O card has an optical
module that provides Optical Time
Domain Reflectometer (OTDR)
measurement capability and
standard Optical Service Channel
(OSC) transmission on two ports.
OTDR capability lets you monitor
variations in scan values and
thresholds andmeasure the distance
and magnitude of defects like
insertion loss and reflection loss on
a fiber span across different
measurement ranges.

TNCS-O Cards

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• MR-MXP Card

• Operating Modes for
MR-MXP Card

• NTP-G340 Provisioning
Encryption on the WSE and
MR-MXP Cards

Cisco ONS 15454 DWDM
Licensing Configuration Guide

The MR-MXP card supports the
following enhancements:

• Supports 100G operating
modes - MXP-100G,
TXP-100G, and 100G_B2B.

• Provides encryption capability
at the optical layer.

• Supports feature-based
licensing to support high
speed and low speed
encryption.

MR-MXP Enhancements
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http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01101.html#ID1074
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01101.html#ID1074
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01101.html#ID1074
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1074
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1074
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_05D88C20DA2047F2BBBDCE538E30E7D7
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_05D88C20DA2047F2BBBDCE538E30E7D7
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#reference_4B3C93DECA934375A17DDDE4A978A90F
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#reference_7876F0F9EBEC43DB99290F40B50FB0B2
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#reference_7876F0F9EBEC43DB99290F40B50FB0B2
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID10182
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• DLP-G714Changing the Card
Line Settings

• DLP-G217 Changing the 10G
Multirate Transponder Line
Settings

• DLP-G218 Changing the 10G
or 40GMultirate Transponder
Line Section Trace Settings

• DLP-G666 Changing the 40G
Muxponder Line Settings

The Squelch hold off timer can be
configured for TXP_MR_10E,
40E-MXP-C, OTU2_XP,
100G-LC-C, 100G-CK-C,
100ME-CK-C, CFP-LC,
10x10G-LC, and MR-MXP cards
for 10GE and 100GE client
payloads in TXP and MXP
operating modes.

DLP-G722 Changing the Card
OTN Settings

Squelch Hold Off Timer

Cisco ONS 15454 DWDM Network
Configuration Guide

• Node Reference

The Split ROADM feature is
enhanced to support chassis
replacement in post-split nodes.

Split ROADM Nodes

Cisco NCS 2000 Series Hardware
Installation Guide

The followingMSMconfigurations
are supported:

• Cisco NCS 2015 as the node
controller with up to 10 NCS
2015 as subtended shelves.

• Cisco NCS 2015 as the node
controller with a mix of up to
15 NCS 2015, NCS 2006, and
ONS 15454 as subtended
shelves.

• Cisco NCS 2006 as the node
controller with a mix of up to
15 NCS 2015, NCS 2006, and
ONS 15454 shelves as
subtended shelves.

• Cisco ONS 15454 as the node
controller with a mix NCS
2015, NCS 2006, and ONS
15454 shelves as subtended
shelves.

The ONS 15454
shelves must have
TCC3 cards installed
for the
configurations.

Note

MSM support
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide, Release
10.x.x.

• Unnumbered Interface (UNI)
Support

• DLP-G789 Enable RSVP on
an Interface

• DLP-G790 Create a Static
LMP Connection

• DLP-G791 Creating the
WSON UNI-C Circuit

The UNI is the service control
interface between the transport
network and client equipment. It is
used to utilize the supported
network services. It eliminates the
need of managing IP addresses to
identify the interfaces.

Unnumbered Interface (UNI)
Support

Manage the Node

• DLP-G785 Zoom In/Out with
Graphs

The ROADM flex spectrum cards
support zoom in or zoom out
functionality on the graphs
displayed in CTC.

Zoom In/Out of Graphs

Cisco ONS 15454 DWDM Network
Configuration Guide, Release
10.x.x

• Power Redundancy

• Power Redundancy Mode
While Upgrading from
Release 10.5

• NTP-G358 Configuring a
Power Redundancy Mode

The power redundancy mode of an
NCS 2015 chassis can be
configured using CTC or TL1
commands. TheACpowermodules
support 1+0, 1+1, 2+0, and 2+2
redundancy. The DC power
modules support 1+0, 1+1, 2+0,
2+1, 2+2, 3+0, and 3+1
redundancy.

Power Redundancy

This table summarizes the new and changed information for Release 10.5, and tells you where the features
are documented.
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Table 8: New and Changed Features - R10.5

Where DocumentedDescriptionFeature

Cisco NCS 2000 Series Hardware
Installation Guide

The Cisco NCS 2015 shelf
assembly has 18 vertical slots
numbered 1 to 18. While slot 2 to
slot 16 is for line cards that provide
10 to 100 Gbps interconnections,
slot 1 and slot 17 is for the TNCS
cards (timing and control cards).
Slot 18 is for the external
connection unit (ECU). The NCS
2015 system can be powered by
redundant DC powermodules. The
NCS 2015 system contains backup
flash memory that supports the
database (DB) and image backup
in the single mode operation. The
LCD unit is integrated with the fan
tray assembly. The fiber or cable
guide used in the NCS 2015 shelf
provides improved fiber
management. The air in the NCS
2015 chassis is drawn in through a
two-inch air inlet at the bottom of
the chassis, and expelled at the
top-rear. A single NCS 2015 shelf
assembly supports both ANSI and
ETSI standards.

Cisco NCS 2015 Shelf Assembly

Cisco ONS 15454 DWDM Control
Card and Node Configuration
Guide

• TNCS Card

• NTP-G313 Installing and
Configuring the TNC, TNCE,
TSC, TSCE, or TNCS Card

The TNCS cards can be
provisioned as active and standby
cards in the NCS 2015 shelf. The
TNCS cards serve as the processor
card for the node. The TNCS cards
can be installed in slots 1 and 17 on
the NCS 2015 shelf. If the active
TNCS card fails, system traffic
switches to the redundant TNCS
card.

TNCS Card
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The 17 SMR9 FS, 24 SMR9 FS, 34
SMR9 FS, and SMR20 FS cards
are tunable over 96 channels in the
C-band, at 50-GHz spacing on the
ITU-T grid. The card provides the
flex spectrum capability, which
allows the user the flexibility to
allocate the channel bandwidth, to
increase the network scalability.
The 17 SMR9 FS, 24 SMR9 FS,
and 34 SMR9 FS cards support up
to 9 directions for each ROADM
node. The SMR20 FS card supports
up to 20 directions for each
ROADM node. The cards support
count based licensing and can be
installed in any service slots in the
chassis.

17 SMR9 FS, 24 SMR9 FS, 34
SMR9 FS and SMR20 FS Cards
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 17 SMR9 FS, 24 SMR9 FS,
34 SMR9 FS and SMR20 FS
Cards

Cisco ONS 15454 DWDM Network
Configuration Guide

• Node Reference

Cisco ONS 15454 DWDM Network
Configuration Guide

• DLP-G325 Changing Optical
Amplifier Line Settings

• DLP-G326 Changing Optical
Amplifier Threshold Settings

• DLP-G406 Changing Card
Optical Channel Parameters
for 40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G407 Changing the
Optical Channel Thresholds
for 40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G408 Changing Optical
Line Parameters for
40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G409 Changing the
Optical Line Thresholds for
40-WXC-C, 80-WXC-C,
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Cards

• DLP-G772 Viewing
Wavelength Power for
16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Card

• DLP-G773 Creating a Flex
Spectrum or ITU Circuit for
16-WXC-FS, 17 SMR9 FS,
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24 SMR9 FS, 34 SMR9 FS,
or SMR20 FS Card

• DLP-G140 View Power
Statistics for Optical
Amplifier, 40-SMR1-C,
40-SMR2-C,17 SMR9 FS, 24
SMR9 FS, 34 SMR9 FS, and
SMR20 FS Cards

Cisco ONS 15454 DWDM
Licensing Configuration Guide

• 17 SMR9 FS, 24 SMR9 FS,
34 SMR9 FS, and SMR20 FS
Cards

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 12-AD-FS Card
• 16-AD-FS Card

Cisco ONS 15454 DWDM Network
Configuration Guide

• DLP-G414 Changing Optical
Line Settings for Multiplexer
and Demultiplexer Cards

• DLP-G415 Changing Optical
Line Threshold Settings for
Multiplexer and
Demultiplexer Cards

• DLP-G781 Switching the
Channels for 12-AD-FS and
16-AD-FS Cards

• DLP-G479 View Optical
Power Statistics for the PSM,
12-AD-FS, and 16-AD-FS
Cards

The 12-AD-FS card is an add/drop
card that provides contentionless,
colorless, omnidirectional, and flex
spectrum capability on 4 channels
over 4 directions. The 16-AD-FS
card provides contentionless,
colorless, omnidirectional, and flex
spectrum capability on 16 channels
over more than 4 directions using
upgrade ports. The cards can be
installed in any service slots in the
Cisco ONS 15454 M6 and NCS
2015 chassis.

12-AD-FS and 16-AD-FS Cards
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Installing the Cisco ONS 15454
DWDM Passive Optical Modules

• Components of Cisco ONS
15454 DWDM Passive
Optical Modules

A new generation of passive optical
modules can be used to
accommodate the ROADM nodes
built with the SMR FS and AD-FS
cards. Two types of modules are
available: interconnectionmodules,
and add/drop modules. The
modules are MF-MPO-16LC,
MF-2MPO-ADP, MF-16AE-CFS,
MF-10AD-CFS, and
PPMESH8-5AD. The SMRFS and
AD-FS cards can be interconnected
by the MF-MPO-16LC,
MF-2MPO-ADP, and the
PPMESH8-5AD modules. The
MF-16AE-CFS and
MF-10AD-CFS are only used as
passive add/drop modules in TDM
networks.

Passive Optical Modules

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Operating Modes for
10x10G-LC Card

Splitter protection can be
implemented on the 10x10G-LC
card in the TXPP-10G mode. The
10x10G-LC card supports up to
two splitter protection groups with
one client and two trunk ports.

Splitter protection on 10x10G-LC
card

• NTP-G235 Provisioning an
Operating Mode

-NTP-G236 Modifying the
100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC,
10x10G-LC, 100GS-CK-LC, ,
200G-CK-LC, CFP-LC, WSE, or
MR-MXP Card Line Settings and
PM Parameter Thresholds

Cisco ONS 15454 DWDM Network
Configuration Guide

• WSON Full Coherent
Networks Control Plane

• GMPLS Control Plane

The linear impairments in full
coherent networks follow the full
Local Optimization Global
Optimization (LOGO) model that
is applicable to 100G full coherent
networks. This enables circuit
selection and path validation during
routing process. The linear
impairment is calculated directly
form the source node.

WSON Full LOGO support
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Cisco ONS 15454 DWDM Network
Configuration Guide

• Card Support

• DLP-G705 Provisioning
GMPLS Optical Channel
Client Connections

All the transponder andmuxponder
cards support OCHCC circuit
creation using WSON except
AR-MXP and AR-XPE cards.
OCHCC circuits can be configured
on the AR-XP card only in the
TXP-MR,TXPP-MR,MXP-MR-S,
andMXPP-MR-S operatingmodes.

OCHCC circuit creation using
WSON

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 100GS-CK-LC and
200G-CK-LC Cards

• FEC Modes for 100G-LC-C,
CFP-LC, 100G-CK-C,
100GS-CK-LC, and
200G-CK-LC Cards

The 100GS-CK-LC and
200G-CK-LC cards support Hard
Decision FEC (HD-FEC) encoding
with 7% overhead.

7% HD-FEC support on
100GS-CK-LC and 200G-CK-LC

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 100GS-CK-LC and
200G-CK-LC Cards

• Key Features

The 100GS-CK-LC and
200G-CK-LC cards in
MXP-10X10G operating mode
allows 10GE and OC-192 clients
(multiplexed on 100G trunk) to
interoperate with Cisco NCS 4000
platform.

Interoperability with NCS 4000

Cisco ONS 15454 DWDM Network
Configuration Guide

• DLP-G54 Create a Local User
on a Single Node Using CTC

• DLP-G55 Creating a New
User on Multiple Nodes

• TACACS Access Server
• RADIUS Access Server

The user name can be up to 40
characters (up to 39 characters for
TACACS and RADIUS
authentication).

User Login Credentials

This table summarizes the new and changed information for Release 10.3, and tells you where the features
are documented.
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http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_appendix_010100.html#ID614
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_appendix_010100.html#ID614
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_appendix_010100.html#ID614
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_appendix_010100.html#ID614
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID6708
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01110.html#ID483
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01110.html#ID483
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01110.html#ID536
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01110.html#ID536
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_security_reference.html#concept_F9FFF77355504CF38E27A3F71F5EB8C0
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_security_reference.html#reference_BE86E55FD10A4A649FB9DCB2890E2AAE


Table 9: New and Changed Features - R10.3

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• MR-MXP Card
• NTP-G236 Modifying the
100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC,
10x10G-LC, 100GS-CK-LC,
, 200G-CK-LC, CFP-LC,
WSE, or MR-MXP Card Line
Settings and PM Parameter
Thresholds

The MXP-MR card is a mixed rate
10G and 40G clientmuxponder that
is supported on the Cisco ONS
15454 M2 and Cisco ONS 15454
M6 platforms. The card is equipped
with one CPAK port, two SFP
ports, and two QSFP+ ports. The
card can interoperate with
100GS-CK-LC, 200G-CK-LC, and
10x10G-LC cards through an ONS
15454 M6, ONS 15454 M2
backplane.

The MR-MXP card provides the
following features:

• Supports 200G operating
modes such as
MXP_10x10G_100G,
MXP_CK_100G, and
MXP_200G.

• Supports sub OpModes such
as OPM_10x10G and
OPM_100G on the card client
ports.

• Aggregation of 10x10G
clients payloads. The
aggregated payloads are then
forwarded to a 200G
companion trunk card.

• Termination point for a 100G
client payload on the CPAK
port.

MR-MXP Cards
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http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#reference_4B3C93DECA934375A17DDDE4A978A90F
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460


Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 100G-LC-C, 100G-ME-C,
100G-CK-C, 100GS-CK-LC,
100ME-CKC, and
200G-CK-LC Cards

• NTP-G236 Modifying the
100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC,
10x10G-LC, 100GS-CK-LC,
, 200G-CK-LC, CFP-LC,
WSE, or MR-MXP Card Line
Settings and PM Parameter
Thresholds

The 200G-CK-LC and
200G-CK-LIC cards transport 100
or 200 gigabits per second across
metro, regional, long-haul, and
ultra-long-haul DWDM optical
networks. The 200G-CK-LIC is the
licensed card version of the
200G-CK-LC card.

The 200G-CK-LC card provides
the following benefits:

• Supports 200G operating
modes such as
MXP_10x10G_100G,
MXP_CK_100G, and
MXP_200G.

• Allows choosing 16QAMand
QPSK as the modulation
formats at the line side.

• Provides Standard G-FEC
(Reed-Solomon), Soft
Decision FEC (SD-FEC)
encoding with 20% overhead.

• Provides Nyquist filtering for
best performance and optimal
band usage.

• Supports feature-based
licensing.

200G-CK-LC and 200G-CK-LIC
Cards

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• Operating Modes for
100G-LC-C, 100G-ME-C,
100G-CK-C, 100GS-CK-LC,
200G-CK-LC, and
100ME-CKC Cards

The 100GS-CK-LC card supports
200G operating modes such as
MXP_10x10G_100G,
MXP_CK_100G, andMXP_200G.

100GS-CK-LCCardEnhancements

Cisco ONS 15454 DWDM
Licensing Configuration Guide

• 200G-CK-LC Card

The 200G-CK-LIC card supports
feature-based licensing. The
200G-CK-LIC is the licensed card
version of the 200G-CK-LC card.
The base functionality is enabled
in the licensed card version.
Additional features are provided
through specific feature licenses.

Licensing
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http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7617
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID8460
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7653
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7653
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7653
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7653
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7653
https://www.cisco.com/c/en/us/td/docs/optical/15000r/licensing/guide/dwdm_licensing/test_chapter_01.html#concept_D54D7E58A9B549EDA501295D0FE39E12


Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• Optical SMU

• NTP-G347 Managing SMUs
Using CTC

An Optical software maintenance
upgrade (SMU) is a patch that is
provided to the customer to fix an
emergency situation, such as
network failure or traffic loss. The
user can download and activate a
patch on the node(s) through CTC.

Optical SMU

Cisco ONS 15454 DWDM Network
Configuration Guide

• NTP-G352 Enabling PRBS
Settings for an Interface on the
Cisco CRS Router

• NTP-G350 Viewing PRBS
Statistics for an Interface on
the Cisco CRS Router

• NTP-G337 Configuring
Provisioning Parameters for
an Interface on the Cisco
CRS-1 Router

Monitor Performance

• NTP-G349 Viewing PM
Parameters for an Interface on
the Cisco CRS Router

• Pseudo Random Binary
Sequence (PRBS) generation
is supported on VTXP.

• PM statistics for the CRS
PLIM interface can be viewed
in a tabular format in CTC.

• Trail trace identifier (TTI) is
supported on VTXP. It is
possible to individually
manage the Source Access
Point Identifier (SAPI),
Destination Access Point
Identifier (DAPI), and User
Operator Data fields.

VTXP Enhancements

Cisco ONS 15454 DWDM Network
Configuration Guide

• DWDM Network Functional
View

• NTP-G353 Creating GMPLS
Circuits Using the Fast Circuit
Mode

• In the Network Functional
View (NFV), all the panes
with the exception of the
Overview pane are iconised or
hidden. The panes are visible
on request.

• Fast circuit creation of
protected and unprotected
circuits is supported.

• The pre-route option allows
the WSON to detect the
probable path of the circuit.

NFV Enhancements
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http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#concept_61E58AE0B5554799A94E8CCD3129E221
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#managesmu
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#managesmu
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#task_8867A5858021494BA99F1808ED76B0C5
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#task_8867A5858021494BA99F1808ED76B0C5
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#task_8867A5858021494BA99F1808ED76B0C5
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#task_ACCC0A1D35CB4AFC9B137209EC02CD45
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#task_ACCC0A1D35CB4AFC9B137209EC02CD45
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#task_ACCC0A1D35CB4AFC9B137209EC02CD45
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#ID3501
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#ID3501
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#ID3501
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010001.html#ID3501
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_D5E1B5CB82DD4E8CB7E8ABD3A4C795EA
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_D5E1B5CB82DD4E8CB7E8ABD3A4C795EA
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_D5E1B5CB82DD4E8CB7E8ABD3A4C795EA
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01101.html#ID2540
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01101.html#ID2540
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010100.html#task_2CA386E17E10417AA4E6ACF171828938
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010100.html#task_2CA386E17E10417AA4E6ACF171828938
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010100.html#task_2CA386E17E10417AA4E6ACF171828938


Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• NTP-G354 Enabling Cooling
Profile Using CTC

Security Reference

• User Privileges and Policies

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• DLP-G722Changing the Card
OTN Settings

• Key Features of 100G-LC-C,
100G-ME-C, 100G-CK-C,
100ME-CKC, 10x10G-LC,
100GS-CK-LC,
200G-CK-LC, CFP-LC, and
MR-MXP Cards

Cisco ONS 15454 DWDM Control
Card and Node Configuration
Guide

• DLP-G492 Editing an Optical
Side

Several software enhancements are
introduced in Release 10.3 :

• The TNC/TSC/TNCE/TSCE
control cards on the ONS
15454 M6 chassis
automatically detects and
adjusts the cooling profile
according to the cards present
on the chassis.

• The privilege for Provisioning
user has been extended at
Node View and Network
View.

• The Trail Trace Identifier
(TTI) in the path monitoring
overhead is supported inOTU,
and ODU OTN frames. It is
possible to individually
manage the Source Access
Point Identifer (SAPI),
Destination Access Point
Identifier (DAPI), and User
Operator Data fields.

• A new squelch option named
LF is supported for 10GE,
40GE, and 100GE payloads.
This option is supported on
10x10G-LC, CFP-LC,
100G-LC-C, 100G-CK-LC,
100GS-CK-LC, and
200G-CK-LC cards.

• A side description can be
created or edited for all the
optical and virtual sides of the
node using CTC or TL1.

• PSM is supported on
100GS-CK-LC or
200G-CK-LC cards on their
trunk ports where the
protection switch time of 50
ms is achieved in the
TXP-100G configurationwith
20%SD FEC.

Software Enhancements
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http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#enablecoolingprofile
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#enablecoolingprofile
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_security_reference.html#concept_BD8C7A5CD9924B309EECEA58346509F0
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#t_changecardotn
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#t_changecardotn
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7802
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7802
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7802
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7802
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7802
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/linecard_config/guide/b_ons_line_card_configuration/b_ons_line_card_configuration_chapter_01011.html#ID7802
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01110.html#ID3608
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01110.html#ID3608


This table summarizes the new and changed information for Release 10.1.0.1, and tells you where the features
are documented.

Table 10: New and Changed Features - R10.1.0.1

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 100G-LC-C, 100G-ME-C,
100G-CK-C, 100GS-CK-LC,
and 100ME-CKC Cards

• NTP-G236 Modifying the
100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC,
10x10G-LC, 100GS-CK-LC,
CFP-LC, or WSE Card Line
Settings and PM Parameter
Thresholds

The 100GS-CK-LC card is a
tunable DWDM trunk card that
simplifies the integration and
transport of the 100 Gigabit
Ethernet interfaces and services on
the enterprise or service provider
optical networks.

The 100GS-CK-LC card provides
the following benefits:

• Allows choosing 100GQPSK
as the modulation format at
the line side.

• Provides 20% SD (Soft
Decision) FEC encoding and
Nyquist filtering for best
performance and optimal band
usage.

• Supports gridless tunability.

• Allows client access either
through the local 100GCPAK
interface or through backplane
lines that allow
interconnection with an
adjacent 10x10G-LC card.

100GS-CK-LC Card

Cisco ONS 15454 DWDM Network
Configuration Guide, Release
10.x.x

• Node Reference

The split ROADM node feature
allows the ROADM node to have
separate Network Elements (NEs)
for each line side leading to the
separation of different ROADM
degrees. When a node split is
configured, each line side is treated
as a separate NE. The whole NE
manageability is not lost in case of
failure. The legacy ROADM
configurations can be migrated to
split ROADMconfigurations using
CTC and CTP.

Split ROADM Nodes
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Where DocumentedDescriptionFeature

• NTP-G346 Resetting the
Network Element to Factory
Defaults

• DLP-G775 Displaying the
Bandwidth Usage of the STS
Timeslots

• TACACS+ Security

• DLP-G776 Configure the
Node for TACACS+
Authentication

Several software enhancements are
introduced in Release 10.1.

Software Enhancements

OSC Combiner/Splitter ModuleThe FLD-OSC is a passive unit
used to combine the optical service
channel (OSC)wavelengths to form
the DWDM aggregated signal, or
split the OSCwavelengths from the
DWDM aggregated signal. The
passive unit occupies a single slot
in the rack mounting bracket. The
passive unit is introduced due to the
end-of-sale of the OSC-CSM card
in the MSTP platform.

FLD-OSC

This table summarizes the new and changed information for Release 10.0.2, and tells you where the features
are documented.

Table 11: New and Changed Features - R10.0.2

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• DLP-G705 Provisioning
GMPLS Optical Channel
Client Connections

• Source and Destination Port
Configuration

The user can provision an OCHCC
circuit using the Network
Functional View (NFV between the
MSTP transponder or muxponder
client interface and the router PLIM
interface ( 10G and 100G ethernet
controller). The OCHTrail circuit
type is no longer directly supported
between the router interfaces and
the MSTP ones; it is indirectly
created by the creation of the OCH
CC circuit.

VTXP Enhancements
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• GMPLS Path Constraints

• DLP-G732 Editing a GMPLS
Circuit

• DLP-G337 Configuring
Provisioning Parameters for
an Interface on the Cisco
CRS-1 Router

• CTC displays the circuit
constraints of the circuit in the
graphical view of the Circuit
Maintenance perspective of
the NFV. The user can also
modify the circuit constraints
of the circuit being edited in
the NFV. These modified
circuit constraints are applied
after resignalling of the circuit
(automatic circuit restoration
or manual reroute).

• CTC displays the link
direction in the circuit map for
Link Management Protocol
(LMP) links between the
router PLIM interface and the
OCH ports on the MSTP
node. This is also applicable
to the internal patchcords
between the trunk interface
and the OCH ports of the
MSTP node.

• CTC allows tuning of the
router PLIM interface by
specifying the channel ID,
frequency or the wavelength.

• CTC displays the ethernet
statistics that are retrieved
from the ethernet controllers
on the router. The information
is displayed in a tabular
format.

CTC Enhancements

Cisco ONS 15454 DWDM Network
Configuration Guide

DLP-G705 Provisioning GMPLS
Optical Channel Client Connections

The user can configure optical
validation threshold values for the
protected GMPLS circuits.

WSON Enhancements
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Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

Key Features of 100G-LC-C,
100G-ME-C, 100G-CK-C,
100ME-CKC, 10x10G-LC,
100GS-CK-LC, andCFP-LCCards

The loopback and drop facility is
supported on the 100G-LC-C,
10x10G-LC, CFP-LC, and
100G-CK-C cards as follows:

1. Trunk facility loopback (drop)
and client facility loopback
(drop) is supported on:

• 100G-LC-C cards
configured in the TXP
mode (with CXP client
pluggable) for OTU4 and
100GE client payloads.

• 100G-CK-LC configured
in the TXP mode (with
CPAK client pluggable)
for OTU4 and 100GE
client payloads.

2. Backplane facility loopback
(drop) is supported on:

• 100G-LC-C and CFP-LC
configured in the TXP
mode (with CFP client
pluggable) for OTU4 and
100GE client payloads.

• 100G-CK-C and CFP-LC
configured in the TXP
mode (with CFP client
pluggable) for OTU4 and
100GE client payloads.

Non-continuous Loopback Support
on 100G Cards

Cisco ONS 15454 DWDM Network
Configuration Guide

ROADM Node

Four new A/D ROADM
configurations are supported for 48
channel 100 GHz systems.

New ROADM Configurations

This table summarizes the new and changed information for Release 10.0.1, and tells you where the features
are documented.
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Table 12: New and Changed Features - R10.0.1

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Network
Configuration Guide

• WSON Full Coherent
Networks Control Plane

• DLP-G346 Provisioning
Optical Channel Client
Connections

• DLP-G395 Creating an
Optical Channel Trail

• DLP-G707 Upgrading a
Non-GMPLS Circuit to a
GMPLS Circuit

• DLP-G708 Creating a
GMPLSOptical Channel Trail

• DLP-G733 Configuring
GMPLS UNI

• The user can regenerate a
circuit that is created from
UNI interface or VTXP.

• The user can configure the
expected circuit wavelength
for VTXP using CTC.

• The user can create a GMPLS
UNI circuit when VTXP UNI
is enabled in CTC.

• The user can either specify a
mandatory or preferred
wavelength for routing while
creating the GMPLS circuit
using CTC.

• The user can upgrade an
existing GMPLS circuit from
the legacy signaling to the
new signaling that supports
the LOGO (Local
Optimization Global
Optimization) and
regeneration features on the
GMPLS circuit.

VTXP and GMPLS Enhancements

This table summarizes the new and changed information for Release 10.0, and tells you where the features
are documented.
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Table 13: New and Changed Features - R10.0

Where DocumentedDescriptionFeature

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• EDRA-1-xx and EDRA-2-xx
Cards

• EDRA Workflow Diagram
• EDRA-1-xx and EDRA-2-xx
Cards Power Monitoring

Cisco ONS 15454 DWDM Network
Configuration Guide

• Automatic Raman Pump
Calculation

• ARPC Workflow
• EDRA Card Start Up and
Fiber Link Turn Up

• NTP-G184 Creating a
Provisionable Patchcord

• NTP-G160 Modifying Card
Line Settings and PM
Thresholds

• EDRA optical safety
• DLP-G140 View Power
Statistics for Optical
Amplifier, 40-SMR1-C, and
40-SMR2-C Cards

The double-slot EDRA-1-xx and
EDRA-2-xx cards are
erbium-doped Raman amplifiers
(EDRAs) that support Raman
amplification on very long
unregenerated spans. Each EDRA
card canmanage up to 96 channels,
50-GHz-spaced from 196.1 GHz
(1528.77nm) to 191.35 GHz
(1566.72 nm).

EDRA-1-xx andEDRA-2-xxCards

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 16-WXC-FS Card

Cisco ONS 15454 DWDM Network
Configuration Guide

• NTP-G174 Modifying the
Line Settings and PM
Thresholds for 40-WXC-C,
80-WXC-C, or 16-WXC-FS
Cards

• Node Reference

The double-slot cross connect
16-port Flex Spectrum ROADM
line card (16-WXC-FS) can be used
in the core of the network. The card
is used to build ROADM nodes
with 96 channels spaced at 50-GHz,
flex spectrum channels, or a
combination of the two. The card
provides the flex spectrum
capability, which allows the user
the flexibility to allocate the
channel bandwidth, to increase the
network scalability.

16WXC-FS Card
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Where DocumentedDescriptionFeature

Installing the Cisco ONS 15454 M2
and ONS 15454 M6 Passive
Optical Modules

Anew generation of passive optical
modules can be used to
accommodate ROADMnodes built
with the 16-WXC-FS and EDRA
cards. Three types of modules are
available: patch panel modules,
add/drop modules, and adapter
modules.

Passive Optical Modules

Cisco ONS 15454 DWDM Line
Card Configuration Guide

• 100G-LC-C, 100G-ME-C,
100G-CK-C, 100GS-CK-LC,
and 100ME-CKC Cards

• NTP-G236 Modifying the
100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC,
10x10G-LC, 100GS-CK-LC,
CFP-LC, or WSE Card Line
Settings and PM Parameter
Thresholds

The 100G-CK-C and 100ME-CKC
cards are tuneable over the entire
C-band. The 100G-CK-C card
works similar to the 100G-LC-C
card. The 100G-CK-C card has the
new CPAK client interface
replacing the CXP client interface
of the 100G-LC-C card.

100G-CK-C and 100ME-CK-C
Cards

Cisco ONS 15454 DWDM Network
Configuration Guide

• LSP Priority
• LSP Setup with Regenerators
• Restoration Based on LSP
Priority

• WSON Full Coherent
Networks Control Plane

• DLP-G705 Provisioning
GMPLS Optical Channel
Client Connections

• DLP-G708 Creating a
GMPLSOptical Channel Trail

• DLP-G733 Configuring
GMPLS UNI

• DLP-G774 Changing the
Frame Type on the OSC

Several software enhancements are
introduced in Release 10.0

Software Enhancements
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C H A P T E R 1
Setting Up Optical Service Channel Cards

This chapter describes the optical service channel (OSC) cards for Cisco ONS 15454 dense wavelength
division multiplexing (DWDM) networks. For card safety and compliance information, refer to the Regulatory
Compliance and Safety Information for Cisco ONS Platforms document.

An optical service channel (OSC) is a bidirectional channel connecting two adjacent nodes in a DWDM ring.
For every DWDM node (except terminal nodes), two different OSC terminations are present, one for the west
side and another for the east side. The channel transports OSC overhead that is used to manage DWDM
networks. An OSC signal uses the 1510-nmwavelength and does not affect client traffic. The primary purpose
of this channel is to carry clock synchronization and orderwire channel communications for the DWDM
network. It also provides transparent links between each node in the network. The OSC is an OC-3/STM-1
formatted signal.

There are two versions of the OSC modules: the OSCM, and the OSC-CSM, which contains the OSC
wavelength combiner and separator component in addition to the OSC module.

The Mesh/Multiring Upgrade (MMU) card is used to optically bypass a given wavelength from one section
of the network or ring to another one without requiring 3R regeneration.

On 15454-M2 and 15454-M6 shelves, the TNC and TNCE cards include the functions of the OSCM card.
OSC can be created on the OC3 port (SFP-0) of the TNC, TNCE, and TNCS cards.

Note

The TNC, TNCE, and TNCS cards support two optical service channels (OSC): primary OSC and secondary
OSC.

The primary optical service channel (SFP-0) supports the following interfaces:

• OC-3/STM-1

• Fast Ethernet (FE)

• Gigabit Ethernet (GE).

The secondary optical service channel (SFP-1) supports the following interfaces:

• Fast Ethernet (FE)

• Gigabit Ethernet (GE).
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Unless noted otherwise, the cards described in this chapter are supported on the
Cisco ONS 15454, Cisco ONS 15454 M6, Cisco ONS 15454 M2 platforms.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf
assemblies.

Note

• Card Compatibility, on page 2
• Class 1 Laser Safety Labels, on page 2
• OSCM Card, on page 2
• OSC-CSM Card, on page 4

Card Compatibility
Table 14: Software Release Compatibility for Optical Service Channel Cards in Cisco ONS 15454

R11.x.xR10.5.2/10.6.1/10.6.2/10.7/10.8/10.9R10.5R4.5 - R10.0Card Name

ONS
15454

ONS 15454ONS 15454ONS 15454OSCM

ONS
15454,
ONS
15454
M2,
ONS
15454
M6,
NCS
2015

ONS 15454, ONS 15454 M2, ONS 15454 M6,
NCS 2015

ONS 15454, ONS 15454 M2,
ONS 15454 M6

ONS 15454, ONS 15454
M2, ONS 15454 M6

OSC-CSM

Class 1 Laser Safety Labels
For information about safety labels, see the "Safety Labels" section.

OSCM Card
The OSCM card has reached end of support.

(Cisco ONS 15454 only)
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For OSCM card specifications, see the OSCM Card Specifications document.Note

On 15454-M2 and 15454-M6 shelves, the TNC and TNCE cards include the functions of the OSCM card.Note

The OSCM card is used in amplified nodes that include the OPT-BST, OPT-BST-E, or OPT-BST-L booster
amplifier. The OPT-BST, OPT-BST-E, and OPT-BST-L cards include the required OSCwavelength combiner
and separator component. The OSCM cannot be used in nodes where you use OC-N/STM-N cards, electrical
cards, or cross-connect cards. The OSCM uses Slots 8 and 10, which are also cross-connect card slots.

The OSCM supports the following features:

• OC-3/STM-1 formatted OSC

• Supervisory data channel (SDC) forwarded to the TCC2/TCC2P/TCC3 cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT far-end (FE) User Channel (UC)

• Monitoring functions such as orderwire support and optical safety

The OC-3/STM-1 section data communications channel (SDCC or RS-DCC) overhead bytes are used for
network communications. An optical transceiver terminates the OC-3/STM-1, then it is regenerated and
converted into an electrical signal. The SDCC or RS-DCC bytes are forwarded to the active and standby
TCC2/TCC2P/TCC3 cards for processing through the system communication link (SCL) bus on the backplane.
Orderwire bytes (E1, E2, F1) are also forwarded via the SCL bus to the TCC2/TCC2P/TCC3 for forwarding
to the AIC-I card.

The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UC. The frame is sent to a
packet-over-SONET/SDH (POS) processing block that extracts the Ethernet packets andmakes them available
at the RJ-45 connector.

The OSCM distributes the reference clock information by removing it from the incoming OC-3/STM-1 signal
and then sending it to the DWDM cards. The DWDM cards then forward the clock information to the active
and standby TCC2/TCC2P/TCC3 cards.

Due to memory limitations, TCC2/TCC2P cards are not supported from Release 10.5.2 onwards. As a result,
in a multishelf configuration, the TCC2/TCC2P card cannot be a node controller or a shelf controller. Upgrade
the TCC2/TCC2P card to a TCC3 card.

Note

For more information about the OSCM card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet09186a00801a1641.html.

OSCM Card Functions
The functions of the OSCM card are:

• OSCM Card Power Monitoring
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• Card-level LEDs on OSCM and OSC-CSM Cards

• Port-level LEDs

OSCM Card Power Monitoring
Physical photodiode P1 monitors the power for the OSCM card. The returned power level value is calibrated
to the OSC TX port.

Table 15: OSCM VOA Port Calibration

Calibrated to PortCTC Type NamePhotodiode

OSC TXOutput OSCP1

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

OSC-CSM Card
The OSC-CSM card has reached end of support.

For OSC-CSM card specifications, see the OSC-CSM Card Specifications document.Note

The OSC-CSM card is used in unamplified nodes. This means that the booster amplifier with the OSC
wavelength combiner and separator is not required for OSC-CSM operation. The OSC-CSM can be installed
in Slots 1 to 6 and 12 to 17. To operate in hybrid mode, the OSC-CSM cards must be accompanied by
cross-connect cards. The cross-connect cards enable functionality on the OC-N/STM-N cards and electrical
cards.

The OSC-CSM supports the following features:

• Optical combiner and separator module for multiplexing and demultiplexing the optical service channel
to or from the wavelength division multiplexing (WDM) signal

• OC-3/STM-1 formatted OSC

• SDC forwarded to the TCC2/TCC2P/TCC3 cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT FE UC

• Monitoring functions such as orderwire support

• Optical safety: Signal loss detection and alarming, fast transmitted power shut down by means of an
optical 1x1 switch

• Optical safety remote interlock (OSRI), a feature capable of shutting down the optical output power
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• Automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut. For details on
ALS provisioning for the card, see the . For information on using the card to implement ALS in a network,
see the .

The WDM signal coming from the line is passed through the OSC combiner and separator, where the OSC
signal is extracted from the WDM signal. The WDM signal is sent along with the remaining channels to the
COM port (label on the front panel) for routing to the OADM or amplifier units, while the OSC signal is sent
to an optical transceiver.

The OSC is an OC-3/STM-1 formatted signal. The OC-3/STM-1 SDCC or RS-DCC overhead bytes are used
for network communications. An optical transceiver terminates the OC-3/STM-1, and then it is regenerated
and converted into an electrical signal. The SDCC or RS-DCC bytes are forwarded to the active and standby
TCC2/TCC2P/TCC3 cards for processing via the SCL bus on the backplane. Orderwire bytes (E1, E2, F1)
are also forwarded via the SCL bus to the TCC2/TCC2P/TCC3 for forwarding to the AIC-I card.

The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UC. The frame is sent to a POS
processing block that extracts the Ethernet packets andmakes them available at the RJ-45 front panel connector.

The OSC-CSM distributes the reference clock information by removing it from the incoming OC-3/STM-1
signal and then sending it to the active and standby TCC2/TCC2P/TCC3 cards. The clock distribution is
different from the OSCM card because the OSC-CSM does not use Slot 8 or 10 (cross-connect card slots).

Due to memory limitations, TCC2/TCC2P cards are not supported from Release 10.5.2 onwards. As a result,
in a multishelf configuration, the TCC2/TCC2P card cannot be a node controller or a shelf controller. Upgrade
the TCC2/TCC2P card to a TCC3 card

Note

S1 and S2 (Figure 4-5 on page 4-10) are optical splitters with a splitter ratio of 2:98. The result is that the
power at the MON TX port is about 17 dB lower than the relevant power at the COM RX port, and the power
at the MON RX port is about 20 dB lower than the power at the COM TX port. The difference is due to the
presence of a tap coupler for the P1 photodiode.

Note

For more information about the OSCM card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet09186a00801a1641.html.

OSC-CSM Card Functions
The functions of the OSC-CSM card are:

• OSC-CSM Card Power Monitoring

• Alarms and Thresholds

• Card-level LEDs on OSCM and OSC-CSM Cards

• Port-level LEDs
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OSC-CSM Card Power Monitoring
Physical photodiodes P1, P2, P3, and P5 monitor the power for the OSC-CSM card. Their function is as
follows:

• P1: The returned power value is calibrated to the LINE RX port, including the insertion loss of the
previous filter (the reading of this power dynamic range has been brought backward towards the LINE
RX output).

• P2: The returned value is calibrated to the LINE RX port.

• P3: The returned value is calibrated to the COM RX port.

• P5: The returned value is calibrated to the OSC TX port, including the insertion loss of the subsequent
filter.

The returned power level values are calibrated to the ports as shown in the following table.

Table 16: OSC-CSM Port Calibration

PM ParametersPowerCalibrated to PortCTC Type NamePhotodiode

SupportedChannel PowerLINE RXInput LineP1

OSC Power

SupportedOSC PowerLINE RXInput LineP2

SupportedChannel PowerCOM RXInput ComP3

SupportedOSC PowerOSC TXOutput OSCP5

The OSC power on the LINE TX is the same as the power reported from P5.

The PM parameters for the power values are listed at Optics and 8b10b PM Parameter Definitions.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.
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C H A P T E R 2
Provisioning Optical Amplifier Cards

This chapter describes the optical amplifier cards used in Cisco ONS 15454 dense wavelength division
multiplexing (DWDM) networks and related procedures.

For card safety and compliance information, refer to the Regulatory Compliance and Safety Information for
Cisco ONS Platforms document.

Optical amplifier card architecture includes an optical plug-in module with a controller that manages optical
power, laser current, and temperature control loops. An amplifier also manages communication with the
control card and operation, administration, maintenance, and provisioning (OAM&P) functions such as
provisioning, controls, and alarms.

The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6,
Cisco ONS 15454 M2 platforms, unless noted otherwise.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to the
15454-M-RAMAN-COP card.

Note

• Applications of Amplifiers, on page 8
• Card Compatibility, on page 8
• OPT-PRE Amplifier Card, on page 11
• OPT-BST and OPT-BST-E Amplifier Card, on page 12
• OPT-BST-L Amplifier Card, on page 14
• OPT-AMP-L Card, on page 15
• OPT-AMP-17-C Card, on page 16
• OPT-AMP-C Card, on page 18
• OPT-RAMP-C and OPT-RAMP-CE Cards, on page 19
• RAMAN-CTP and RAMAN-COP Cards, on page 21
• OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 Cards, on page 24
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• EDRA-1-xx and EDRA-2-xx Cards, on page 27

Applications of Amplifiers
The following amplifiers can be configured as booster or preamplifiers:

• OPT-AMP-C

• OPT-AMP-17C

• OPT-AMP-L

• OPT-BST-E

• OPT-BST

• OPT-EDFA-17

• OPT-EDFA-24

The amplifier functions as a booster amplifier by default. The amplifier role is automatically configured when
the CTP NE update configuration file is loaded in CTC. The amplifier role can also be manually modified.

The OPT-BST and OPT-BST-E amplifiers are supported as preamplifiers in sites that are equipped with the
OPT-RAMP-C card. In any other configuration, the OPT-BST and OPT-BST-E cards must be configured as
a booster amplifier.

Note

For more information about the supported configurations and network topologies, see and

Card Compatibility
The following table lists the Cisco Transport Controller (CTC) software compatibility for each optical amplifier
card.

Table 17: Software Release Compatibility for Optical Amplifier Cards

R8.0R7.0/R7.2R6.0R4.7/R5.0R4.5 /R4.6Card Name

15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMOPT-PRE

15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMOPT-BST

15454-DWDM15454-DWDM15454-DWDM15454-DWDMNoOPT-BST-E

15454-DWDM15454-DWDMNoNoNoOPT-BST-L

15454-DWDM15454-DWDMNoNoNoOPT-AMP-L

15454-DWDMNoNoNoNoOPT-AMP-17-C

NoNoNoNoNoOPT-AMP-C
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R8.0R7.0/R7.2R6.0R4.7/R5.0R4.5 /R4.6Card Name

NoNoNoNoNoOPT-RAMP-C

NoNoNoNoNoOPT-RAMP-CE

NoNoNoNoNoRAMAN-CTP

NoNoNoNoNoRAMAN-COP

NoNoNoNoNoOPT-EDFA-17

NoNoNoNoNoOPT-EDFA-24

R11.x.x R10.7/10.8/10.9 R10.5.2/10.6.1/10.6.2 R10.5R10.0R9.3 - R9.8R9.2/R9.2.1R9.1R9.0R8.5Card Name

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM15454-DWDM15454-DWDMOPT-PRE

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM15454-DWDM15454-DWDMOPT-BST

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM15454-DWDM15454-DWDMOPT-BST-E

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMOPT-BST-L

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMOPT-AMP-L

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM15454-DWDM15454-DWDMOPT-AMP-17-C

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM15454-DWDM15454-DWDMOPT-AMP-C

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M6

15454-DWDM,
15454-M6

15454-DWDM,
15454-M6

15454-DWDM15454-DWDMNoOPT-RAMP-C
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R11.x.x R10.7/10.8/10.9 R10.5.2/10.6.1/10.6.2 R10.5R10.0R9.3 - R9.8R9.2/R9.2.1R9.1R9.0R8.5Card Name

15454-DWDM,
15454-M2,
15454-M6

(From
R10.8)
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

(From
R10.8)
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M6

15454-DWDM,
15454-M6

15454-DWDM,
15454-M6

15454-DWDMNoNoOPT-RAMP-CE

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6

15454-M2,
15454-M6

NoNoNoNoRAMAN-CTP

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6

15454-M2,
15454-M6

NoNoNoNoRAMAN-COP

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

NoNoNoNoOPT-EDFA-17

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6,
NCS
2015

15454-DWDM,
15454-M2,
15454-M6

15454-DWDM,
15454-M2,
15454-M6

NoNoNoNoOPT-EDFA-24

From
R10.8,
15454
M2,
15454
M6,
NCS
2015

From
R10.8,
15454
M2,
15454
M6,
NCS
2015

No NoNoNoNoNoNoNoOPT-EDFA-35

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6NoNoNoNoNoEDRA-1-26

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6NoNoNoNoNoEDRA-1-35

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6NoNoNoNoNoEDRA-2-26
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R11.x.x R10.7/10.8/10.9 R10.5.2/10.6.1/10.6.2 R10.5R10.0R9.3 - R9.8R9.2/R9.2.1R9.1R9.0R8.5Card Name

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6NoNoNoNoNoEDRA-2-35

OPT-PRE Amplifier Card
The OPT-PRE card has reached end of support.

For OPT-PRE card safety labels, see Class 1M Laser Product Cards.Note

The OPT-PRE is a C-band, DWDM, two-stage erbium-doped fiber amplifier (EDFA) with midamplifier loss
(MAL) that can be connected to a dispersion compensating unit (DCU). The OPT-PRE is equipped with a
built-in variable optical attenuator (VOA) that controls the gain tilt and can also be used to pad the DCU to
a reference value. The card is designed to support up to 80 channels at 50-GHz channel spacing. The OPT-PRE
card features include:

• Fixed gain mode with programmable tilt

• True variable gain

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• MAL for fiber-based DCU

• Amplified spontaneous emissions (ASE) compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• Four signal photodiodes to monitor the input and output optical power of the two amplifier stages through
CTC

• An optical output port for external monitoring

The optical splitter has a ratio of 1:99, resulting in about 20 dB-lower power at
the MON port than at the COM TX port.

Note

You can install the OPT-PRE card in slots 1 to 6 and 12 to 17 in ONS 15454 M12.

You can install the OPT-PRE card in the following slots.

• Slots 2 and 3 in ONS 15454 M2

• Slots 2 to 7 in ONS 15454 M6
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• Slots 2 to 16 in NCS 2015.

For more information about the OPT-PRE Amplifier card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd800e4d24.html
and Card Features, on page 739.

Related Procedures for OPT-PRE Card
The following is the list of procedures and tasks related to the configuration of the OPT-PRE card:

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

OPT-BST and OPT-BST-E Amplifier Card
The OPT-BST card has reached end of support.

For OPT-BST and OPT-BST-E cards safety labels, see "Class 1M Laser Product Cards". .Note

TheOPT-BST is designed to ultimately support up to 80 channels at 50-GHz channel spacing. The OPT-BST-E
amplifier card is a gain-enhanced version of the OPT-BST card. It is designed to support up to 80 channels
at 50-GHz channel spacing. Both the cards are C-band, DWDM EDFA with optical service channel (OSC)
add-and-drop capability. When an OPT-BST or an OPT-BST-E is installed, an OSCM card is also needed to
process the OSC. The OPT-BST cards features include:

• Fixed gain mode (with programmable tilt)

• Gain range of 5 to 20 dB in constant gain mode and output power mode for an OPT-BST card

• Gain range of 8 to 23 dBmwith the tilt managed at 0 dBm in constant gain mode and output power mode
for an OPT-BST-E card

• Enhanced gain range of 23 to 26 dBm with unmanaged tilt with OPT-BST-E card

• True variable gain

• Built-in VOA to control gain tilt
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• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• Optical Safety Remote Interlock (OSRI), a CTC software feature capable of shutting down optical output
power or reducing the power to a safe level (automatic power reduction)

• Automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut. For information
about using the card to implement ALS in a network, see "Network Optical Safety". .

The optical splitters each have a ratio of 1:99. The result is that MON TX and
MON RX port power is about 20 dB lower than COM TX and COM RX port
power.

Note

You can install the OPT-BST and OPT-BST-E cards in slots 1 to 6 and 12 to 17 in ONS 15454 M12.

You can install the OPT-BST and OPT-BST-E cards in the following slots.

• Slots 2 and 3 in ONS 15454 M2

• Slots 2 to 7 in ONS 15454 M6

• Slots 2 to 16 in NCS 2015.

For more information about the OPT-BST and OPT-BST-E Amplifier cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd802be30a.html
and Card Features, on page 739.

Related Procedures for OPT-BST and OPT-BST-E Cards
The following is the list of procedures and tasks related to the configuration of the OPT-BST and OPT-BST-E
cards:

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards
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• NTP-G77 Manage Automatic Power Control

OPT-BST-L Amplifier Card

For OPT-BST-L safety labels, see "Class 1M Laser Product Cards".Note

The OPT-BST-L is an L-band, DWDM EDFA with OSC add-and-drop capability. The card is well suited for
use in networks that employ dispersion shifted (DS) fiber or SMF-28 single-mode fiber. The OPT-BST-L is
designed to ultimately support 64 channels at 50-GHz channel spacing, but in Software R9.0 and earlier it is
limited to 32 channels at 100-GHz spacing. When the system has an OPT-BST-L installed, an OSCM card
is needed to process the OSC. You can install the OPT-BST-L card in Slots 1 to 6 and 12 to 17 of ONS 15454
M12. The card’s features include:

• Fixed gain mode (with programmable tilt)

• Standard gain range of 8 to 20 dB in the programmable gain tilt mode

• True variable gain

• 20 to 27 dB gain range in the uncontrolled gain tilt mode

• Built-in VOA to control gain tilt

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• OSRI

• ALS

The optical splitters each have a ratio of 1:99. The result is that MON TX and
MON RX port power is about 20 dB lower than COM TX and COM RX port
power.

Note

For more information about the OPT-BST-L Amplifier card, see Data Sheet and Card Features, on page 739.

Related Procedures for OPT-BST-L Card
The following is the list of procedures and tasks related to the configuration of the OPT-BST-L card:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File
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• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

OPT-AMP-L Card

For OPT-AMP-L card safety labels, see "Class 1M Laser Product Cards"..Note

The OPT-AMP-L is an L-band, DWDM optical amplifier card consisting of a two-stage EDFAwith midstage
access loss (MSL) for an external DCU andOSC add-and-drop capability. Using CTC, the card is provisionable
as a preamplifier (OPT-PRE) or booster amplifier (OPT-BST), and is well suited for use in networks that
employ DS or SMF-28 fiber. The amplifier can operate up to 64 optical transmission channels at 50-GHz
channel spacing in the 1570 nm to 1605 nm wavelength range.

When an OPT-AMP-L installed, an OSCM card is needed to process the OSC. You can install the two-slot
OPT-AMP-L card in slots 1 to 6 and 12 to 17 of ONS 15454 M12.

The card has the following features:

• Maximum power output of 20 dBm

• True variable gain amplifier with settable range from 12 to 24 dBm in the standard gain range and 24
dBm to 35 dbM with uncontrolled gain tilt

• Built-in VOA to control gain tilt

• Up to 12 dBm MSL for an external DCU

• Fast transient suppression; able to adjust power levels in hundreds of microseconds to avoid bit errors
in failure or capacity growth situations

• Nondistorting low frequency transfer function

• Midstage access loss for dispersion compensation unit

• Constant pump current mode (test mode)

• Constant output power mode (used during optical node setup)

• Constant gain mode
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• Internal ASE compensation in constant gain mode and in constant output power mode

• Full monitoring and alarm handling capability

• Optical safety support through signal loss detection and alarm at any input port, fast power down control
(less than one second), and reduced maximum output power in safe power mode. For information on
using the card to implement ALS in a network, see "Network Optical Safety".

Before disconnecting any OPT AMP-L fiber for troubleshooting, first make sure
the OPT AMP-L card is unplugged.

Note

For more information about the OPT-AMP-L card, see the Data Sheet.

Related Procedures for OPT-AMP-L Card
The following is the list of procedures and tasks related to the configuration of the OPT-AMP-L card:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line
Settings and PM Thresholds

OPT-AMP-17-C Card

For OPT-AMP-17-C safety labels, see "Class 1M Laser Product Cards"..Note

The OPT-AMP-17-C is a 17-dB gain, C-band, DWDMEDFA amplifier/preamplifier with OSC add-and-drop
capability. It supports 80 channels at 50-GHz channel spacing in the C-band (that is, the 1529 nm to 1562.5 nm
wavelength range). When the system has an OPT-AMP-17-C installed, an OSCM card is needed to process
the OSC.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
16

Provisioning Optical Amplifier Cards
Related Procedures for OPT-AMP-L Card

http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd803fc4f4_ps13234_Products_Data_Sheet.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_F1E51EA0611E4D6E808D5ADFE153435D
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_00571E134BC6419DB84C48B88127E0C8
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_6F7DB9E72ABD455C969AA54F2040DAC5
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_49020A0465444625AF7652CC995032A8


The card features include:

• Fixed gain mode (no programmable tilt)

• Standard gain range of 14 to 20 dB at startup when configured as a preamplifier

• Standard gain range of 20 to 23 dB in the transient mode when configured as a preamplifier

• Gain range of 14 to 23 dB (with no transient gain range) when configured as a booster amplifier

• True variable gain

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• OSRI

• ALS

You can install the OPT-AMP-17-C card in slots 1 to 6 and 12 to 17 in ONS 15454 M12.

You can install the OPT-AMP-17-C card in the following slots.

• Slots 2 and 3 in ONS 15454 M2

• Slots 2 to 7 in ONS 15454 M6

• Slots 2 to 16 in NCS 2015.

For more information about the OPT-AMP-17-C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd800e4d24.html
and Card Features, on page 739.

Related Procedures for OPT-AMP-17-C Card
The following is the list of procedures and tasks related to the configuration of the OPT-AMP-17-C card:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance
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• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line
Settings and PM Thresholds

OPT-AMP-C Card
The OPT-AMP-C card is a 20-dB output power, C-band, DWDMEDFA amplifier or preamplifier. It contains
midstage access loss for a Dispersion Compensation Unit (DCU). A Variable Optical Attenuator (VOA) is
used to control gain tilt. The VOA can also be used to attenuate the signal of the DCU to a reference value.
The amplifier module also includes the OSC add (TX direction) and drop (RX direction) optical filters.

The OPT-AMP-C card supports 80 channels at 50-GHz channel spacing in the C-band (that is, the 1529 to
1562.5-nm wavelength range). When the system has an OPT-AMP-C card that is installed, an OSCM card is
needed to process the OSC.

The features of the card include:

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Mid-stage access for DCU

• Constant pump current mode (test mode)

• Fixed output power mode

• Constant gain mode

• Amplified spontaneous emissions (ASE) compensation in Constant Gain and Constant Output Power
modes

• Programmable tilt

• Full monitoring and alarm handling capability

• Gain range with gain tilt control of 12–24 dB

• Extended gain range (with uncontrolled tilt) of 24–35 dB

• Full monitoring and alarm handling with settable thresholds

• Optical Safety Remote Interlock (OSRI)—Shuts down optical output power or reduces the power to a
safe level

• Automatic laser shutdown (ALS)—Safety mechanism used in case of fiber cut

In ONS 15454 M12, slots 2–6 and slots 12–16 are the default slots for provisioning the OPT-AMP-C card as
a preamplifier, and slots 1 and 17 are the default slots for provisioning the OPT-AMP-C card as a booster
amplifier.

You can install the OPT-AMP-C card in the following slots:
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• Slots 2–7 in ONS 15454 M6

For more information about the OPT-AMP-C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/prod_data_sheet0900aecd8072b322.html.
and Card Features.

Related Procedures for OPT-AMP-C Card
The following is the list of procedures and tasks related to the configuration of the OPT-AMP-C card:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line
Settings and PM Thresholds

OPT-RAMP-C and OPT-RAMP-CE Cards

For OPT-RAMP-C or OPT-RAMP-CE card safety labels, see "Class 1M Laser Product Cards".Note

The OPT-RAMP-C card is a double-slot card that improves unregenerated sections in long spans using the
span fiber to amplify the optical signal. Different wavelengths in C-band receive different gain values. To
achieve Raman amplification, two Raman signals (that do not carry any payload or overhead) are required to
be transmitted on the optical fiber because the gain generated by one signal is not flat. The energy of these
Raman signals transfer to the higher region of the spectrum thereby amplifying the signals transmitted at
higher wavelengths. The Raman effect reduces span loss but does not compensate it completely.

When the Raman optical powers are set correctly, a gain profile with limited ripple is achieved. The wavelengths
of the Raman signals are not in the C-band of the spectrum (used by MSTP for payload signals). The two
Raman wavelengths are fixed and always the same. Due to a limited Raman gain, an EDFA amplifier is
embedded into the card to generate a higher total gain. An embedded EDFA gain block provides a first
amplification stage, while the mid stage access (MSA) is used for DCU loss compensation.
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The OPT-RAMP-CE card is a 20 dBm output power, gain-enhanced version of the OPT-RAMP-C card and
is optimized for short spans. The OPT-RAMP-C and OPT-RAMP-CE cards can support up to 80 optical
transmission channels at 50-GHz channel spacing over the C-band of the optical spectrum (wavelengths from
1529 nm to 1562.5 nm). To provide a counter-propagating Raman pump into the transmission fiber, the Raman
amplifier provides up to 500 mW at the LINE-RX connector. The OPT-RAMP-C or OPT-RAMP-CE card
can be installed in Slots 1 to 5 and 12 to 16, and supports all network configurations. However, the
OPT-RAMP-C or OPT-RAMP-CE card must be equipped on both endpoints of a span.

The Raman total power and Raman ratio can be configured using CTC. The Raman configuration can be
viewed on the Maintenance > Installation tab.

The features of the OPT-RAMP-C and OPT-RAMP-CE card include:

• Raman pump with embedded EDFA gain block

• Raman section: 500 mW total pump power for two pump wavelengths

• EDFA section:

• OPT-RAMP-C: 16 dB gain and 17 dB output power

• OPT-RAMP-CE: 11 dB gain and 20 dB output power

• Gain Flattening Filter (GFF) for Raman plus EDFA ripple compensation

• MSA for DC units

• VOA for DC input power control

• Full monitoring of pump, OSC, and signal power

• Fast gain control for transient suppression

• Low-FIT (hardware-managed) optical laser safety

• Hardware output signals for LOS monitoring at input photodiodes

• Optical service channel add and drop filters

• Raman pump back-reflection detector

You can install the OPT-RAMP-C and OPT-RAMP-CE cards in the following slots.

• Slots 2 and 3 in ONS 15454 M2

• Slots 2 to 7 in ONS 15454 M6

• Slots 2 to 7 in Cisco 2015 chassis. These cards upgrade to a new bootcode automatically when they are
installed between slots 2 and 7.

After the bootcode upgrade, the cards can be installed in Slots from 2 to 16 in Cisco NCS 2015 chassis.

For more information about the OPT-RAMP-C and OPT-RAMP-CE cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-500925.html. and Card
Features, on page 739.
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Related Procedures for OPT-RAMP-C and OPT-RAMP-CE Cards
The following is the list of procedures and tasks related to the configuration of the OPT-RAMP-C and
OPT-RAMP-CE cards:

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G201 Configure the Raman Pump on an MSTP Link

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line
Settings and PM Thresholds

RAMAN-CTP and RAMAN-COP Cards

The RAMAN-CTP and RAMAN-COP cards are supported in R9.3.02 and later.Note

LASER ENERGY - EXPOSURE NEAR APERTURE MAY CAUSE BURNSCaution

The single-slot RAMAN-CTP and RAMAN-COP cards support counter and co-propagating Raman
amplification on very long unregenerated spans.

The cards manage up to 96 ITU-T 50-GHz spaced channels over the C-band of the optical spectrum
(wavelengths from 1528.77 nm to 1566.72 nm). The counter-propagating RAMAN-CTP card is the primary
unit. The co-propagating RAMAN-COP card is the secondary unit and can be used only when the
counter-propagating unit is present. The RAMAN-CTP card and the RAMAN-COP card must be installed in
adjacent slots for Cisco NCS 2000 Series chassis. For example, you can install in Slots 2 and 3, 4 and 5, or 6
and 7 in ONS 15454 M6. However, these adjacent slots must not be used to install two RAMAN-CTP or two
RAMAN-COP cards.

The RAMAN-CTP card can be calibrated either manually or using the Automatic Raman PumpAmplification
(ARPC) procedure from the Card tab in the Provisioning panel in CTC.When the RAMAN-COP card is used,
the RAMAN-CTP card can be calibrated only using the manual option. ARPC is supported only in the NCS
Flex package.
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The features of the RAMAN-CTP and RAMAN-COP cards include:

• Raman section: 1000 mW total pump power for four pumps and two wavelengths

• Embedded distributed feedback (DFB) laser at 1568.77 nm to be used for optical safety and link continuity
(in RAMAN-CTP card only)

• Photodiodes to enable monitoring of Raman pump power

• Photodiodes to enable monitoring of the DFB laser and signal power (in RAMAN-CTP card only)

• Hardware managed automatic laser shutdown (ALS) for optical laser safety

• Hardware output signals for loss of signal (LOS) monitoring at input photodiodes

• Raman pump back reflection detector to check for excessive back reflection

You can install the RAMAN-CTP and RAMAN-COP cards in the following slots.

• Slots 2 and 3 in ONS 15454 M2

• Slots 2 to 7 in ONS 15454 M6

• Slots 2 to 16 in NCS 2015.

Important Notes Regarding Patchcord Installation
Warning Avoid eye or skin exposure to direct or scattered radiation.

• Two E-2000 PS PC to F-3000s SM PC patchcords are shipped with the RAMAN-CTP card.

• One E-2000 PS PC to E-2000 PS PC patchcord is shipped with the RAMAN-COP card.

• Connect the F-3000s SM PC connector to the RAMAN-CTP card before connecting the E2000 PS PC
high optical power connector to the card.

• The F-3000s SM PC connector is mechanically and optically compatible with the LC PC connectors and
the LC PC mating adapters. If the connectors are clean, the standard connectors and the F-3000s SM PC
connectors can be used for optical power of 250 mW and higher.

RAMAN-CTP and RAMAN-COP Cards Power Monitoring
Physical photodiodes P1 through P10 monitor the power for the RAMAN-CTP card.

Table 18: RAMAN-CTP Port Calibration

Calibrated to PortCTC Type NamePhotodiode

LINE-TXDFB in-fiber Output PowerP1

LINE-RXDWDM RX Input PowerP2

LINE-RXPump 1 in-fiber Output PowerP3

LINE-RXPump 2 in-fiber Output PowerP4
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Calibrated to PortCTC Type NamePhotodiode

LINE-RXTotal Pump in-fiber Output PowerP5

LINE-RXBack-Reflected Pump PowerP6

COM-RXDWDM TX Input PowerP7

LINE-TXTotal Co-Pump in-fiber Output PowerP8

LINE-RXDFB Input PowerP9

LINE-RXASE Input PowerP10

Physical photodiodes P3 through P6 monitor the power for the RAMAN-COP card.

Table 19: RAMAN-CTP Port Calibration

Calibrated to PortCTC Type NamePhotodiode

RAMAN-TXPump 1 in-fiber Output PowerP3

RAMAN-TXPump 2 in-fiber Output PowerP4

RAMAN-TXTotal Pump in-fiber Output PowerP5

RAMAN-TXBack-Reflected Pump PowerP6

The PM parameters for the power values are listed at Optics and 8b10b PM Parameter Definitions.

For information on the associated TL1 AIDs for the optical power monitoring points, see the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.8.

For more information about the RAMAN-CTP and RAMAN-COP cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-658538.html and Card
Features, on page 739.

Related Procedures for RAMAN-CTP and RAMAN-COP Cards

During a software upgrade, do not unplug the RAMAN-CTP or RAMAN-COP card fibers or connectors. The
ends of unterminated fibers or connectors emit invisible laser radiation.

Caution

The following is the list of procedures and tasks related to the configuration of the RAMAN-CTP and
RAMAN-COP cards:

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up
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• NTP-G201 Configure the Raman Pump on an MSTP Link

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line
Settings and PM Thresholds

• NTP-G184 Create a Provisionable Patchcord

• DLP-G690 Configure the Raman Pump Using Manual Day-0 Installation

OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 Cards
The OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 cards are C-band DWDM EDFA amplifiers and
preamplifiers. The cards are true variable gain amplifiers, offering an optimal equalization of the transmitted
optical channels over a wide gain range. They support 96 channels at 50-GHz channel spacing in the C-band
(that is, 1528.77 to 1566.72-nm wavelength range). The OPT-EDFA-17 and OPT-EDFA-24 cards deliver
20-dBm output powers and the OPT-EDFA-35 card delivers +23-dBm output power. These cards do not
contain mid-stage access loss for a Dispersion Compensation Unit (DCU). The cards provide a noise-figure
optimized version of the EDFA amplifiers to cope with new modulation formats like PM-DQPSK, which do
not need dispersion compensation. To control gain tilt, a VOA is used. The amplifier module also includes
the OSC add (TX direction) and drop (RX direction) optical filters.

The OPT-EDFA-17, and OPT-EDFA-24 cards share the same hardware platform and firmware architecture,
but they differ in their operative optical gain range, which is 17 and 24 dB respectively.

The OPT-EDFA-35 card includes two identical amplification sections to serve two fiber directions
simultaneously. Each section has a switchable gain range that allows its usage over a wide gain range. The
OPT-EDFA-35 card is bidirectional. The card acts on both pairs of fibers entering and exiting from the node.

The OPT-EDFA-35 card has two possible gain ranges: gain range 1 from 12–24, gain range 2 from 20–35.
The card also has extended gain range up to 40 dB without tilt control.

The OPT-EDFA-35 card is managed in a similar way as the OPT-EDFA-17 and OPT-EDFA-24 cards. For
each EDFA unit inside the OPT-EDFA-35 card, the following settings are allowed:

• Configuration of PRE or BST role

• Configuration of Constant Gain working mode

• Configuration of Gain Range

The main functionalities of the OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 cards are:

• (OPT-EDFA-17 and OPT-EDFA-24) Amplification of the input signal at the COM-RX port toward the
LINE-TX port through a true-variable gain EDFA block.

(OPT-EDFA-35) Two EDFA amplifier units embedded into the card, amplification of the input signal
at the LINE-1-RX port toward the LINE-2-TX port through a true-variable gain EDFA-2 block, and
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amplification of the input signal at the LINE-2-RX port toward the LINE-1-TX port through a true-variable
gain EDFA-1 block.

• Multiplexing the OSC to the LINE-TX port

• Demultiplexing the OSC from the LINE-RX port

• Monitoring of the LINE input or output signal with 1% TAP splitters

The features of the OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 cards are:

• Embedded Gain Flattening Filter

• Constant pump current mode (test mode)

• Constant output power mode

• Constant gain mode

• Nondistorting low-frequency transfer function

• ASE compensation in Constant Gain and Constant Output Power modes

• Fast transient suppression

• Programmable tilt

• Full monitoring and alarm handling capability

• Gain range with gain tilt control of 5–17 dB (for OPT-EDFA-17 card) , 12 to 24 dB and 20 to 35 dB (for
OPT-EDFA-35 card), and 12–24 dB (for OPT-EDFA-24 card).

• Extended gain range (with uncontrolled tilt) of 17–20 dB (for OPT-EDFA-17 card) , (for OPT-EDFA-35
card) of upto 27dB (for Gain Range1) and 40dB (for Gain Range2), and 24–27 dB (for OPT-EDFA-24
card).

• Optical Safety Remote Interlock (OSRI)

• Automatic Laser Shutdown (ALS)

You can install the OPT-EDFA-17 and OPT-EDFA-24 cards in slots 1–6 and 12–17 in ONS 15454 M12.

You can install the OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 cards in the following slots:

• Slots 2–7 in ONS 15454 M6

• Slots 2–16 in NCS 2015

Power Monitoring of OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 Cards
Physical photodiodes PD1 through PD6 monitor the power for the OPT-EDFA-17 and OPT-EDFA-24 cards.

Table 20: Port Calibration of OPT-EDFA-17 and OPT-EDFA-24 Cards

Calibrated to PortPhotodiode

COM-RXPD1
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Calibrated to PortPhotodiode

LINE-TXPD2

LINE-TXPD3

OSC-RXPD4

LINE-RXPD5

LINE-RXPD6

Physical photodiodes PD1 through PD8 monitor the power for the OPT-EDFA-35 card.

Table 21: Port Calibration of OPT-EDFA-35 Card

Calibrated to PortPhotodiode

LINE-2-RXPD1

LINE-1-TXPD2

LINE-1-RXPD3

LINE-2-TXPD4

OSC-2-RXPD5

OSC-2-TXPD6

OSC-1-TXPD7

OSC-1-RXPD8

Related Procedures for OPT-EDFA-17, OPT-EDFA-24, and OPT-EDFA-35 Cards
The list of procedures and tasks related to the configuration of the OPT-EDFA-17, OPT-EDFA-24, and
OPT-EFDA-35 cards are:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File

• NTP-G30 Install the DWDM Cards

• NTP-G31 Install the DWDM Dispersion Compensating Units

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance
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• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, OPT-EDFA-24, andOPT-EDFA-35
Card Line Settings and PM Thresholds

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

EDRA-1-xx and EDRA-2-xx Cards
(Cisco ONS 15454 M6)

For EDRA-1-xx and EDRA-2-xx card safety labels, see the section, Class 1M Laser Product Cards.Note

The double-slot EDRA-1-xx and EDRA-2-xx cards are erbium-doped Raman amplifiers that support Raman
amplification on long unregenerated spans.

The cards manage up to 96 ITU-T 50 GHz spaced channels over the C-band of the optical spectrum
(wavelengths from 1528.77 nm to 1566.72 nm). You can install the EDRA-1-xx and EDRA-2-xx cards in the
lowest slots to allow high output power. The power output is limited to 21dBm when the cards are inserted
in any slot. The OSC pluggable used with the cards is ONS-SC-OSC-18.0=.

The cards can be used in point-to-point, ring, multi-ring, or mesh topologies and are supported on flexible
nodes in these node configurations:

• Optical line amplifier nodes

• Terminal nodes

• Dynamic gain equaliser nodes

Apart from these node configurations having only EDRA cards as amplifiers, the system also supports hybrid
configurations with OPT-EDFA-17, OPT-EDFA-24, RAMAN-CTP, and RAMAN-COP cards. These cards
support span loss and gain values that are not supported in EDRA cards.

• For gain less than 15dB, OPT-EDFA-17 or OPT-EDFA-24 must be used.

• For gain greater than 35dB, RAMAN-CTP, RAMAN-COP, OPT-EDFA-17 or OPT-EDFA-24 must be
used.

The EDRA-1-xx and EDRA-2-xx cards are not compatible with 15454 -M6-FTA= fan tray assembly. The
cards are compatible only with 15454 -M6-FTA2 fan tray assembly or a subsequent fan tray assembly release.

Note

You can install the EDRA-1-xx and EDRA-2-xx cards in the following slots.

• Slots 2 to 7 in ONS 15454 M6

• Slots 2 to 16 in NCS 2015.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
27

Provisioning Optical Amplifier Cards
EDRA-1-xx and EDRA-2-xx Cards

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_6F7DB9E72ABD455C969AA54F2040DAC5
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_49020A0465444625AF7652CC995032A8


For more information about the EDRA-1-xx and EDRA-2-xx cards, see
http://www.cisco.com/en/US/solutions/collateral/ns340/ns394/ns398/ns406/data_sheet_c78-729313.html.

EDRA Workflow Diagram
This figure shows the workflow diagram of the EDRA card. The diagram depicts the tasks required to configure
the EDRA card.

Figure 3: EDRA Card Workflow Diagram
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EDRA-1-xx and EDRA-2-xx Cards Power Monitoring
The following table lists the physical photodiodes that monitor the power for the EDRA-1-xx and EDRA-2-xx
cards.

Table 22: EDRA-1-xx and EDRA-2-xx Port Calibration

Calibrated to PortCTC Type NamePhotodiode

LINE-TXRemnant Pump Input powerPD1

OSC-RXOSC Add Input PowerPD2

LINE-RXEDFA1 Input PowerPD3

COM-TXEDFA1 Output PowerPD4

COM-RXEDFA2 Input PowerPD5

LINE-TXEDFA2/LINE-TX Output PowerPD6

LINE-TXOSC Drop Output PowerPD7

LINE-RXPump λ1 in-fibre Output PowerPD11

LINE-RXPump λ2 in-fibre Output PowerPD12

LINE-RXPump λ3 in-fibre Output PowerPD13

LINE-RXPump λ4 in-fibre Output PowerPD14

LINE-RXTotal Pump in-fibre Output PowerPD15

LINE-RXBack-Reflected Pump PowerPD16

OTDR2-L-RXOTDR2-L Input PowerPD17

The PM parameters for the power values are listed at Optics and 8b10b PM Parameter Definitions.

For information on the associated TL1 AIDs for the optical power monitoring points, see the “CTC Port
Numbers and TL1 Aids” section in Cisco NCS 2000 Series TL1 Command Guide.

Related Procedures for EDRA-1-xx and EDRA-2-xx Cards
The list of procedures and tasks related to the configuration of the EDRA-1-xx and EDRA-2-xx cards are:

• NTP-G30 Install the DWDM Cards

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G38 Provision OSC Terminations

• NTP-G37 Run Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up
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• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line
Settings and PM Thresholds

• NTP-G184 Create a Provisionable Patchcord

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
30

Provisioning Optical Amplifier Cards
Related Procedures for EDRA-1-xx and EDRA-2-xx Cards

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_F1E51EA0611E4D6E808D5ADFE153435D
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_00571E134BC6419DB84C48B88127E0C8
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_6F7DB9E72ABD455C969AA54F2040DAC5
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_49020A0465444625AF7652CC995032A8


C H A P T E R 3
Provisioning Multiplexer and Demultiplexer
Cards

This chapter describes legacymultiplexer and demultiplexer cards used in Cisco ONS 15454 dense wavelength
division multiplexing (DWDM) networks and related procedures.

For card safety and compliance information, refer to the Regulatory Compliance and Safety Information for
Cisco ONS Platforms document.

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

• Card Compatibility, on page 31
• Optical Performance Parameters, on page 32
• DWDM Channel Allocation Plan, on page 35
• Safety Labels, on page 39
• 32DMX-O Card, on page 42
• 4MD-xx.x Card, on page 44
• 12-AD-FS Card, on page 46
• 16-AD-CCOFS Card, on page 47
• Related Procedures for the 12-AD-FS and 16-AD-FS Cards, on page 47

Card Compatibility
The table below lists the software compatibility for the respective cards.

Table 23: Software Compatibility for Multiplexer and Demultiplexer Cards in Cisco ONS 15454

CardsRelease

12-AD-FS, 16-AD-FS4MD-xx.x32DMX-O32MUX-O

NoYesYesYesR4.5

NoYesYesYesR4.6

NoYesYesYesR4.7
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NoYesYesYesR5.0

NoYesYesYesR6.0

NoYesYesYesR7.0

NoYesYesYesR7.2

NoYesYesYesR8.0

NoYesYesYesR8.5

NoYesYesYesR9.0

NoYesYesYesR9.1

NoYesYesYesR9.2

NoYesYesYesR9.2.1

NoYesYesYesR9.3

NoYesYesYesR9.4

NoYesYesYesR9.6.x

NoYesYesYesR9.8

NoYesYesYesR10.0

YesNoNoNoR10.5.2

YesNoNoNoR10.6.1/10.6.2

YesNoNoNoR10.7/10.8/10.9

YesNoNoNoR11.x.x

Optical Performance Parameters
The following table lists the optical performance parameters for 40-Gbps cards that provide signal input to
multiplexer and demultiplexer cards.

Table 24: 40-Gbps Interface Optical Performance

Class IClass BClass AParameter

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

40 Gbps40 Gbps40 GbpsMaximum bit rate

3R3R3RRegeneration
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Class IClass BClass AParameter

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

Yes (E-FEC)NoYesFEC

OptimumAverageOptimumThreshold

10–1510–1210–15Maximum BER

8 dB20 dB19 dB23 dB9 dB23 dBOSNR sensitivity

–18 dBm–26 dBm–20 dBm–21 dBm–18 dBm–24 dBmPower sensitivity

–8 dBm–8 dBm–8 dBmPower overload

Transmitted Power Range

—+2.5 to 3.5 dBm+2.5 to 3.5 dBm40-Gbps multirate
transponder/40-Gbps
EC transponder
(40E-TXP-C and
40ME-TXP-C)

———OC-192 LR ITU

+/–800 ps/nm+/–1,000 ps/nm+/–800 ps/nmDispersion
compensation tolerance

• OSNR = optical signal-to-noise ratio

• BER = bit error rate

• Transmitted Power Range values decreased by patchcord and connector losses, are also the input power
values for the OADM cards.

Note

The following table lists the optical performance parameters that provide signal input for the 40-Gbps
multiplexer and demultiplexer cards.

Table 25: 10-Gbps Interface Optical Performance Parameters

Class IClass CClass BClass AParameter

OSNR
Limited

Power
Limited

OSNR
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

10 Gbps10 Gbps10 Gbps10 GbpsMaximum bit rate

3R3R3R3RRegeneration

Yes (E-FEC)NoNoYesFEC
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Class IClass CClass BClass AParameter

OSNR
Limited

Power
Limited

OSNR
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

OptimumAverageAverageOptimumThreshold

10–1510–1210–1210–15Maximum BER

8 dB20 dB19 dB19 dB23 dB9 dB23 dBOSNR sensitivity

–18 dBm–26 dBm–22 dBm–20 dBm–21 dBm–18 dBm–24 dBmPower sensitivity

–8 dBm–9 dBm–8 dBm–8 dBmPower overload

Transmitted Power Range

——+2.5 to 3.5 dBm+2.5 to 3.5 dBm10-Gbps multirate
transponder/10-Gbps
FEC transponder
(TXP_MR_10G)

—+3.0 to 6.0
dBm

——OC-192 LR ITU

+3.0 to 6.0 dBm—+3.0 to 6.0 dBm+3.0 to 6.0 dBm10-Gbps multirate
transponder/10-Gbps
FEC transponder
(TXP_MR_10E)

+/–800 ps/nm+/–1,000
ps/nm

+/–1,000 ps/nm+/–800 ps/nmDispersion
compensation tolerance

• OSNR = optical signal-to-noise ratio

• BER = bit error rate

• Transmitted Power Range values decreased by patchcord and connector losses, are also the input power
values for the OADM cards.

Note

The following table lists the optical interface performance parameters for 2.5-Gbps cards that provide signal
input to multiplexer and demultiplexer cards.

Table 26: 2.5-Gbps Interface Optical Performance

Class JClass HClass GClass FClass EClass DParameter

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

2.5 Gbps1.25 Gbps2.5 Gbps2.5 Gbps2.5 Gbps2.5 GbpsMaximum bit rate
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Class JClass HClass GClass FClass EClass DParameter

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

3R3R3R2R3R3RRegeneration

NoNoNoNoNoYesFEC

AverageAverageAverageAverageAverageAverageThreshold

10–1210–1210–1210–1210–1210–15Maximum BER

12 dB8 dB13 dB11 dB14 dB15 dB10 dB14 dB6 dB14 dBOSNR sensitivity

–26 dBm–18 dBm–28 dBm–33 dBm–27 dBm–24 dBm–23
dBm

–30
dBm

–25 dBm–31 dBmPower sensitivity

–17dBm–7 dBm–9 dBm–9 dBm–9 dBm–9 dBmPower overload

Transmitted Power Range

–2.0 to 0 dBm–1.0 to
1.0 dBm

–1.0 to 1.0 dBm–1.0 to 1.0 dBmTXP_MR_2.5G

–4.5 to
–2.5 dBm

–4.5 to –2.5 dBm–4.5 to –2.5 dBmTXPP_MR_2.5G

—+2.0 to +4.0 dBm—MXP_MR_2.5G

—–1.5 to +0.5 dBm—MXPP_MR_2.5G

—+2.5 to 3.5 dBm2/4 port GbE
Transponder (GBIC
WDM 100GHz)

–1000 to
+3200
ps/nm

–1000 to +3600
ps/nm

–1200 to
+3300 ps/nm

–1200 to
+3300
ps/nm

–1200 to
+5400 ps/nm

–1200 to
+5400 ps/nm

Dispersion
compensation
tolerance

Transmitted Power Range values decreased by patchcord and connector losses, are also the input power values
for the OADM cards.

Note

DWDM Channel Allocation Plan
ONS 15454 DWDM multiplexer and demultiplexer cards are designed for use with specific channels in the
C band and L band. In most cases, the channels for these cards are either numbered (for example, 1 to 32 or
1 to 40) or delimited (odd or even). Client interfaces must comply with these channel assignments to be
compatible with the ONS 15454 system.
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Table 27: DWDM Channel Allocation Plan (C Band) lists the channel IDs and wavelengths assigned to the
C-band DWDM channels.

In some cases, a card uses only one of the bands (C band or L band) and some or all of the channels listed in
a band. Also, some cards use channels on the 100-GHz ITU grid while others use channels on the 50-GHz
ITU grid. See the specific card description or the “Hardware Specifications” document for more details.

Note

Table 27: DWDM Channel Allocation Plan (C Band)

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1545.72193.95421529.55196.001

1546.119193.90431529.94195.952

1546.518193.85441530.334195.903

1546.917193.80451530.725195.854

1547.316193.75461531.116195.805

1547.715193.70471531.507195.756

1548.115193.65481531.898195.707

1548.515193.60491532.290195.658

1548.915193.55501532.681195.609

1549.32193.50511533.073195.5510

1549.71193.45521533.47195.5011

1550.116193.40531533.86195.4512

1550.517193.35541534.250195.4013

1550.918193.30551534.643195.3514

1551.319193.25561535.036195.3015

1551.721193.20571535.429195.2516

1552.122193.15581535.822195.2017

1552.524193.10591536.216195.1518

1552.926193.05601536.609195.1019

1553.33193.00611537.003195.0520

1553.73192.95621537.40195.0021
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1554.134192.90631537.79194.9522

1554.537192.85641538.186194.9023

1554.940192.80651538.581194.8524

1555.343192.75661538.976194.8025

1555.747192.70671539.371194.7526

1556.151192.65681539.766194.7027

1556.555192.60691540.162194.6528

1556.959192.55701540.557194.6029

1557.36192.50711540.953194.5530

1557.77192.45721541.35194.5031

1558.173192.40731541.75194.4532

1558.578192.35741542.142194.4033

1558.983192.30751542.539194.3534

1559.389192.25761542.936194.3035

1559.794192.20771543.333194.2536

1560.200192.15781543.730194.2037

1560.606192.10791544.128194.1538

1561.013192.05801544.526194.1039

1561.42192.00811544.924194.0540

1561.83191.95821545.32194.0041

The following table lists the channel IDs and wavelengths assigned to the L-band channels.

Table 28: DWDM Channel Allocation Plan (L Band)

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1587.46188.85411570.83190.851

1587.88188.8421571.24190.82

1588.30188.75431571.65190.753
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1588.73188.7441572.06190.74

1589.15188.65451572.48190.655

1589.57188.6461572.89190.66

1589.99188.55471573.30190.557

1590.41188.5481573.71190.58

1590.83188.45491574.13190.459

1591.26188.4501574.54190.410

1591.68188.35511574.95190.3511

1592.10188.3521575.37190.312

1592.52188.25531575.78190.2513

1592.95188.2541576.20190.214

1593.37188.15551576.61190.1515

1593.79188.1561577.03190.116

1594.22188.05571577.44190.0517

1594.64188581577.8619018

1595.06187.95591578.27189.9519

1595.49187.9601578.69189.920

1595.91187.85611579.10189.8521

1596.34187.8621579.52189.822

1596.76187.75631579.93189.7523

1597.19187.7641580.35189.724

1597.62187.65651580.77189.6525

1598.04187.6661581.18189.626

1598.47187.55671581.60189.5527

1598.89187.5681582.02189.528

1599.32187.45691582.44189.4529

1599.75187.4701582.85189.430
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1600.17187.35711583.27189.3531

1600.60187.3721583.69189.332

1601.03187.25731584.11189.2533

1601.46187.2741584.53189.234

1601.88187.15751584.95189.1535

1602.31187.1761585.36189.136

1602.74187.05771585.78189.0537

1603.17187781586.2018938

1603.60186.95791586.62188.9539

1604.03186.9801587.04188.940

Safety Labels
For information about safety labels, see the 10.1 Safety Labels.

32MUX-O Card
The 32MUX-O card has reached end of support.

For 32MUX-O card specifications, see the “32MUX-O Card Specifications” section in the Hardware
Specifications document.

Note

The 32-Channel Multiplexer (32MUX-O) card multiplexes 32 100-GHz-spaced channels identified in the
channel plan. The 32MUX-O card takes up two slots in an ONS 15454 and can be installed in Slots 1 to 5
and 12 to 16.

32MUX-O Card Functions
The 32MUX-O card functions include:

• Arrayed waveguide grating (AWG) device that enables full multiplexing functions for the channels.

• Each single-channel port is equipped with VOAs for automatic optical power regulation prior to
multiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation for safety
purposes. A manual VOA setting is also available.

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.
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• Card level indicators—

An additional optical monitoring port with 1:99 splitting ratio is available.

Port-Level Indicators for the 32MUX-O Cards
The 32MUX-O card has five sets of ports located on the faceplate. COM TX is the line output. COM MON
is the optical monitoring port. The xx.x to yy.y RX ports represent the four groups of eight channels ranging
from wavelength xx.x to wavelength yy.y, according to the channel plan.

32MUX-O Channel Plan
The 32MUX-O card is typically used in hub nodes and provides the multiplexing of 32 channels, spaced at
100 GHz, into one fiber before their amplification and transmission along the line. The channel plan is shown
in the following table.

Table 29: 32MUX-O Channel Plan

Wavelength (nm)Frequency (GHz)Channel IDChannel Number

1530.33195.930.31

1531.12195.831.22

1531.90195.731.93

1532.68195.632.64

1534.25195.434.25

1535.04195.335.06

1535.82195.235.87

1536.61195.136.68

1538.19194.938.19

1538.98194.838.910

1539.77194.739.711

1540.56194.640.512

1542.14194.442.113

1542.94194.342.914

1543.73194.243.715

1544.53194.144.516

1546.12193.946.117

1546.92193.846.918
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Wavelength (nm)Frequency (GHz)Channel IDChannel Number

1547.72193.747.719

1548.51193.648.520

1550.12193.450.121

1550.92193.350.922

1551.72193.251.723

1552.52193.152.524

1554.13192.954.125

1554.94192.854.926

1555.75192.755.727

1556.55192.656.528

1558.17192.458.129

1558.98192.358.930

1559.79192.259.731

1560.61192.160.632

The Channel Number column is only for reference purposes. The channel ID is consistent with the ONS 15454
and is used in card identification.

Note

Power Monitoring
Physical photodiodes P1 through P32 monitor the power for the 32MUX-O card. The returned power level
values are calibrated to the ports as shown in the following table.

Table 30: 32MUX-O Port Calibration

Calibrated to PortCTC Type NamePhotodiode

COM TXADDP1–P32

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

Related Procedures for the 32MUX-O Card
The following is the list of procedures and tasks related to the configuration of the 32MUX-O card:
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32DMX-O Card
The 32DMX-O card has reached end of support.

For 32DMX-O card specifications, see the “32DMX-O Card Specifications” section in the Hardware
Specifications document.

Note

The 32-Channel Demultiplexer (32DMX-O) card demultiplexes 32 100-GHz-spaced channels identified in
the channel plan. The 32DMX-O takes up two slots in an ONS 15454 and can be installed in Slots 1 to 5 and
12 to 16.

32DMX-O Card Functions
The 32DMX-O card functions include:

• AWG that enables channel demultiplexing functions.

• Each single-channel port is equipped with VOAs for automatic optical power regulation after
demultiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation for
safety purposes. A manual VOA setting is also available.

• The 32DXM-O has four physical receive connectors that accept MPO cables on its front panel for the
client input interfaces. MPO cables break out into eight separate cables.

In contrast, the single-slot 32DMX card does not have VOAs on each drop port
for optical power regulation. The 32DMX optical demultiplexer module is used
in conjunction with the 32WSS card in ONS 15454 Multiservice Transport
Platform (MSTP) nodes.

Note

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.

• Card level indicators— Table G-4 on page G-9

Port-Level Indicators for the 32DMX-O Card
The 32DMX-O card has five sets of ports located on the faceplate. MON is the output monitor port. COM
RX is the line input. The xx.x to yy.y TX ports represent the four groups of eight channels ranging from
wavelength xx.x to wavelength yy.y according to the channel plan.

Power Monitoring
Physical photodiodes P1 through P33 monitor the power for the 32DMX-O card. The returned power level
values are calibrated to the ports as shown in Table 31: 32DMX-O Port Calibration.
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Table 31: 32DMX-O Port Calibration

Calibrated to PortCTC Type NamePhotodiode

DROP TXDROPP1–P32

COM RXINPUT COMP33

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

Related Procedures for the 32DMX-O Card
The following is the list of procedures and tasks related to the configuration of the 32DMX-O card:

• DLP-G353 Preprovisioning a Slot

• NTP-G30 Installing the DWDM Cards

• NTP-G143 Importing the Cisco Transport Planner NE Update Configuration File

• NTP-G34 Installing Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• DLP-G315 Installing Fiber-Optic Cables From the 32WSS/32DMX Cards to the Standard Patch Panel
Tray

• DLP-G356 Installing Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to
the Deep Patch Panel Tray

• NTP-G86 Convert a Pass-Through Connection to Add/Drop Connections

• NTP-G44 Performing the Anti-ASE Hub Node Acceptance Test

• NTP-G41 Performing the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test

• NTP-G74 Monitor DWDM Card Performance

• DLP-G78 Verifying the 32MUX-O or 40-MUX-C Card Power

• DLP-G269 Verifying the 32DMX-O or 40-DMX-C Card Power

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G175 Modifying Line Card Settings and PM Thresholds for Multiplexer and Demultiplexer Cards

• DLP-G415 Changing Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards

• DLP-G416 Changing Optical Channel Settings for Multiplexer and Demultiplexer Cards

• DLP-G417 Changing Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
43

Provisioning Multiplexer and Demultiplexer Cards
Related Procedures for the 32DMX-O Card

http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID254
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1134
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/controlcard_nodeconfig/guide/b_ons_control_card_node_config/b_ons_control_card_node_config_chapter_01110.html#ID2330
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1474
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1636
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1787
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1787
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1787
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1787
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_7D32F0D9CEB24E6B97D25B5A93FF376B
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010101.html#ID15
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010101.html#ID15
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_00571E134BC6419DB84C48B88127E0C8
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010101.html#ID278
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010101.html#ID278
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_858A0BD3FDC54E19B891BB5568BB4988
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_858A0BD3FDC54E19B891BB5568BB4988
http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_858A0BD3FDC54E19B891BB5568BB4988
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010111.html#ID2556
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010111.html#ID2738
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010111.html#ID2879
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010111.html#ID2997


4MD-xx.x Card
The 4MD-xx.x card has reached end of support.

For 4MD-xx.x card specifications, see the section “4MD-xx.x Card Specifications” section in the Hardware
Specifications document.

Note

The 4-Channel Multiplexer/Demultiplexer (4MD-xx.x) card multiplexes and demultiplexes four
100-GHz-spaced channels identified in the channel plan.

The card is bidirectional. The demultiplexer and multiplexer functions are implemented in two different
sections of the same card. In this way, the same card can manage signals flowing in opposite directions.

There are eight versions of this card that correspond with the eight sub-bands specified in Table 32: 4MD-xx.x
Channel Sets. The 4MD-xx.x can be installed in Slots 1 to 6 and 12 to 17.

4MD-xx.x Card Functions
The 4MD-xx.x has the following functions implemented inside a plug-in optical module:

• Passive cascade of interferential filters perform the channel multiplex/demultiplex function.

• Software-controlled VOAs at every port of the multiplex section regulate the optical power of each
multiplexed channel.

• Software-monitored photodiodes at the input and output multiplexer and demultiplexer ports for power
control and safety purposes.

• Software-monitored virtual photodiodes at the common DWDM output and input ports. A virtual
photodiode is a firmware calculation of the optical power at that port. This calculation is based on the
single channel photodiode reading and insertion losses of the appropriated paths.

Port-Level Indicators for the 4MD-xx.x Cards
The 4MD-xx.x card has five sets of ports located on the faceplate. COM RX is the line input. COM TX is the
line output. The 15xx.x TX ports represent demultiplexed channel outputs 1 to 4. The 15xx.x RX ports represent
multiplexed channel inputs 1 to 4.

Wavelength Pairs
The following table shows the band IDs and the add/drop channel IDs for the 4MD-xx.x card.

Table 32: 4MD-xx.x Channel Sets

Add/Drop Channel IDsBand ID

30.3, 31.2, 31.9, 32.6Band 30.3 (A)

34.2, 35.0, 35.8, 36.6Band 34.2 (B)
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Add/Drop Channel IDsBand ID

38.1, 38.9, 39.7, 40.5Band 38.1 (C)

42.1, 42.9, 43.7, 44.5Band 42.1 (D)

46.1, 46.9, 47.7, 48.5Band 46.1 (E)

50.1, 50.9, 51.7, 52.5Band 50.1 (F)

54.1, 54.9, 55.7, 56.5Band 54.1 (G)

58.1, 58.9, 59.7, 60.6Band 58.1 (H)

Power Monitoring
Physical photodiodes P1 through P8 and virtual photodiodes V1 and V2 monitor the power for the 4MD-xx.x
card. The returned power level values are calibrated to the ports as shown in the following table.

Table 33: 4MD-xx.x Port Calibration

Calibrated to PortCTC Type NamePhotodiode

COM TXADDP1–P4

DROP TXDROPP5–P8

COM TXOUT COMV1

COM RXIN COMV2

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

Related Procedures for the 4MD-xx.x Card
The following is the list of procedures and tasks related to the configuration of the 4MD-xx.x card:

• DLP-G353 Preprovisioning a Slot

• NTP-G30 Installing the DWDM Cards

• NTP-G143 Importing the Cisco Transport Planner NE Update Configuration File

• NTP-G49 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards

• DLP-G94 Verifying Add and Drop Connections on an OADM Node with OSC-CSM Cards

• NTP-G34 Installing Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• DLP-G315 Installing Fiber-Optic Cables From the 32WSS/32DMX Cards to the Standard Patch Panel
Tray
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• DLP-G356 Installing Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to
the Deep Patch Panel Tray

• NTP-G41 Performing the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance Test

• NTP-G44 Performing the Anti-ASE Hub Node Acceptance Test

• NTP-G86 Convert a Pass-Through Connection to Add/Drop Connections

• DLP-G78 Verifying the 32MUX-O or 40-MUX-C Card Power

• DLP-G269 Verifying the 32DMX-O or 40-DMX-C Card Power

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G175 Modifying Line Card Settings and PM Thresholds for Multiplexer and Demultiplexer Cards

• DLP-G414 Changing Optical Line Settings for Multiplexer and Demultiplexer Cards

• DLP-G415 Changing Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards

• DLP-G416 Changing Optical Channel Settings for Multiplexer and Demultiplexer Cards

• DLP-G417 Changing Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards

12-AD-FS Card
The 12-AD-FS card is a single slot add/drop card that provides colorless, contentionless, omnidirectional,
and flex spectrum capability on 12 channels over 4 ROADMdirections. The card receives the samewavelength
from transponder cards and forwards it to different ROADM nodes without collision. This capability is
achieved using multicast switches.

Each add/drop port pair in the card is:

• Colorless - forwards any wavelength on a specific port

• Contentionless - adds/drops the same wavelength from the same add/drop section to different directions

• Omnidirectional - connects to both the add and drop directions

The 12-AD-FS card can be installed in any service slots in the Cisco NCS 2006 and NCS 2015 chassis. The
12-AD-FS card works only in the Cisco NCS Flex node.

Key Features

• Integrates three independent add/drop sections that individually support add/drop of up to four channels
over four ROADMdirections. The channels can be forwarded to a direction only within the same section.

• Provides add/drop sections, each of which has a 4 channel multiplexer and a 4 channel demultiplexer.

• Monitors optical power on the input ports through optical photo diodes and raises alarms when the
threshold is exceeded.

• Supports tone detection on the input ports in the add direction.
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• Provides a multicast switch that does not block any wavelength and that does not have any optical filtering
element.

For more information about the 12-AD-FS card, such as the block diagram and card specifications, see the
data sheet.

16-AD-CCOFS Card
In this chapter, "16-AD-CCOFS" refers to the NCS2K-16-AD-CCOFS card.

The 16-AD-CCOFS card is a single slot add or drop card that provides colorless, contentionless, omnidirectional,
and flex spectrum capability on 16 channels over 4 ROADMdirections. The card receives the samewavelength
from 16 transponder cards and forwards it to different ROADM nodes without collision. This capability is
achieved using multicast switches. 2 or 3 16-AD-CCOFS cards can be connected using upgrade ports to
provide the add/drop capability on 16 channels over 8 or 12 ROADM directions respectively.

Each add/drop port pair in the card is:

• Colorless - forwards any wavelength on a specific port

• Contentionless - adds/drops the same wavelength from the same add/drop section to different directions

• Omnidirectional - connects to both the add and drop directions

The 16-AD-CCOFS card can be installed in any service slots in the Cisco NCS 2006 and NCS 2015 chassis.
The 16-AD-CCOFS card works only in the Cisco NCS Flex node.

Key Features

• Has a 16x4 multiplexer and a 4x16 demultiplexer.

• Monitors optical power on the input ports through optical photo diodes and raises alarms when the
threshold is exceeded.

• Supports tone detection on the input ports in the add direction.

• Provides a multicast switch that does not block any wavelength and does not have any optical filtering
element.

• Has fixed gain EDFA amplifiers in the add or drop directions to compensate for high optical insertion
loss. The gain is -1 dB in the drop direction and -2 dB in the add direction.

For more information about the 16-AD-CCOFS card, such as the block diagram and card specifications, see
the data sheet.

Related Procedures for the 12-AD-FS and 16-AD-FS Cards
The following is the list of procedures and tasks related to the configuration of the 12-AD-FS and 16-AD-FS
cards:

• DLP-G414 Changing Optical Line Settings for Multiplexer and Demultiplexer Cards

• DLP-G415 Changing Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards
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• DLP-G781 Switching the Channels for 12-AD-FS and 16-AD-FS Cards

• DLP-G479 View Optical Power Statistics for the PSM, 12-AD-FS, and 16-AD-FS Cards
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C H A P T E R 4
Setting Up Tunable Dispersion Compensating
Units

This chapter explains the Tunable Dispersion Compensating Units (T-DCU) used in Cisco ONS 15454 dense
wavelength division multiplexing (DWDM) networks.

For card safety and compliance information, refer to the Regulatory Compliance and Safety Information for
Cisco ONS Platforms document.

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

The T-DCU unit compensates for chromatic dispersion (CD) of the transmission fiber. The T-DCU provides
two line cards with varied set of tunable wavelengths to compensate for CD.

The T-DCU card provides a selectable set of discrete negative chromatic dispersion values to compensate for
chromatic dispersion of the transmission line. The card operates over the entire C-band (in the range of 1529.0
nm to 1562.5 nm) and monitors the optical power at the input and the output ports. The two types of T-DCU
line cards are:

• TDC-CC (Coarse T-DCU)

• TDC-FC (Fine T-DCU)

Each T-DCU card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf
assembly. Cards should be installed in slots that have the same symbols. See the “Card Slot Requirements”
section in the Cisco ONS 15454 Hardware Installation Guide.

Note

• Safety Labels, on page 49
• TDC-CC and TDC-FC Cards, on page 50
• Optical Performance, on page 51

Safety Labels
For information about safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.
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TDC-CC and TDC-FC Cards
The TDC-CC card provides 16 values of CD ranging from 0 to -1650 ps/nm with a granularity of 110 ps/nm
in the C-band spectrum.

The TDC-FC card provides 16 values of CD ranging from 0 to -675 ps/nm with a granularity of 45 ps/nm in
the C-band spectrum.

You can configure the TDC-CC and TDC-FC cards for the CD value listed in the following table.

Table 34: TDC-CC and TDC-FC Tunable CD Value

TDC-FC [ps/nm]TDC-CC [ps/nm]Unit Configuration

000

-45-1101

-90-2202

-135-3303

-180-4404

-225-5505

-270-6606

-315-7707

-360-8808

-405-9909

-450-110010

-495-121011

-540-132012

-585-143013

-630-154014

-675-165015

The default TDC-CC CD value for Coarse Unit is 0. The default TDC-FC value for Fine Unit is 0.Note

Key Features
The TDC-CC and TDC-FC cards provide these features:
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• Single slot card with three LEDs on the front panel.

• Two LC-PC-II optical connectors on the front panel.

• Operates in slots from slot 1 to 6 and 12 to 17.

• Operates over the C-band (wavelengths from 1529 nm to 1562.5 nm) of the optical spectrum.

• Allows upto 16 provisionable CD values for chromatic dispersion compensation.

• Connects to OPT-PRE, OPT-AMP-C, OPT-RAMP-C, and OPT-RAMP-CE amplifiers and 40-SMR-1
and 40-SMR-2 cards.

• Supports performance monitoring and alarm handling for selectable thresholds.

• Allows monitoring and provisioning using CTC, SNMP, or TL1.

For more information about the TDC-CC and TDC-FC cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-581114.html

Optical Ports
The T-DCU unit contains the DC-RX (input) and DC-TX (output) ports. The optical signal enters the DC-RX
port, compensates the chromatic dispersion and then exits from the DC-TX port.

TDC-CC and TDC-FC Card Functions
The functions of the TDC-CC and TDC-FC cards are:

• G.15 Lamp Test, page G-22

• Card level indicators— Table G-1 on page G-8

Optical Performance
The TDC-CC and TDC-FC cards monitor the optical input power and optical output power of the fiber. It
monitors the insertion loss from the input (DC-RX) to the output (DC-TX) port, with the help of the two
photodiodes PD1 and PD2. The TDC-CC and TDC-FC cards report the minimum, average, and maximum
power statistics of each of the monitored ports or channels in the specific card. To view the optical power
statistics of the TDC-CC and TDC-FC cards, refer to the Monitor Performance document. The performance
data is recorded at 15 minutes and 24 hours intervals.

You can view the performance monitoring (PM) data of the card using CTC, SNMP, and TL1 interfaces.Note

The PM data is stored on a wrap-around basis at 32 x 15 min. and 2 x 24 hour intervals.Note
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Related Procedures for TDC-CC and TDC-FC Cards
The following section lists procedures and tasks related to the configuration of the TDC-CC and TDC-FC
cards:

• NTP-G30 Installing the DWDM Cards

• DLP-G525 View Optical Power Statistics for TDC-CC and TDC-FC cards

• NTP-G240 Modifying Line Settings and PM Thresholds for the TDC-CC and TDC-FC Cards

• NTP-G242 Modify the CD setting of TDC-CC and TDC-FC Cards
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C H A P T E R 5
Provisioning Protection Switching Module

This chapter describes the Protection SwitchingModule (PSM) card used in CiscoONS 15454 densewavelength
division multiplexing (DWDM) networks. For card safety and compliance information, refer to the Regulatory
Compliance and Safety Information for Cisco ONS Platforms document. .

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

• PSM Card, on page 53

PSM Card
The PSM card performs splitter protection functions. In the transmit (TX) section of the PSM card, the signal
received on the common receive port is duplicated by a hardware splitter to both the working and protect
transmit ports. In the receive (RX) section of the PSM card, a switch is provided to select one of the two input
signals (on working and protect receive ports) to be transmitted through the common transmit port.

The PSM card supports multiple protection configurations:

• Channel protection—The PSM COM ports are connected to the TXP/MXP trunk ports.

• Line (or path) protection—The PSM working (W) and protect (P) ports are connected directly to the
external line.

• Multiplex section protection—The PSM is equipped between theMUX/DMX stage and the amplification
stage.

• Standalone—The PSM can be equipped in any slot and supports all node configurations.

The PSM card is a single-slot card that can be installed in any node from Slot 1 to 6 and 12 to 17. The PSM
card includes six LC-PC-II optical connectors on the front panel. In channel protection configuration, the
PSM card can be installed in a different shelf from its peer TXP/MXP card.

It is strongly recommended that you use the default layouts designed by Cisco Transport Planner, which place
the PSM card and its peer TXP/MXP card as close as possible to simplify cable management.

Note
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Key Features
The PSM card provides the following features:

• Operates over the C-band (wavelengths from 1529 nm to 1562.5 nm) and L-band (wavelengths from
1570.5 nm to 1604 nm) of the optical spectrum.

• Implements bidirectional non-revertive protection scheme. For more details on bidirectional switching,
see the PSM Bidirectional Switching.

• Release 10.5.2 implements bidirectional revertive protection scheme. For more details on bidirectional
switching, see the PSM Bidirectional Switching.

PSM reversion is supported only for Optical Channel (OCH) protection and not
supported for Optical Multiplex Section (OMS) and OTS protection.

Note

• Release 10.5.2 supports automatic Optical Multiplex Section (OMS) protection when PSM cards are
provisioned with Multiplexers and De-multiplexer cards.

• Supports automatic creation of splitter protection group when the PSM card is provisioned.

• Supports switching priorities based on ITU-T G.873.1.

• Supports performance monitoring and alarm handling with settable thresholds.

• Supports automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut. ALS is
applicable only in line protection configuration. For information about using the card to implement ALS
in a network, see the .

PSM Card-Level Indicators
Table G-1 "Card-level indicators" describes the card-level indicators on the card.

PSM Bidirectional Switching
A VOA is equipped after the hardware splitter within the PSM card. The VOA implements bidirectional
switching when there is a single fiber cut in a protection configuration involving two peer PSM cards. The
following figure shows a sample configuration that explains the bidirectional switching capability of the PSM
card.
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Figure 4: PSM Bidirectional Switching

In this example, there is a fiber cut in the working path from Station A to Station B. As a result of the fiber
cut, an LOS alarm is raised on the W-RX port of Station B and it immediately switches traffic on to its P-RX
port. Station B simultaneously also stops transmission (for approximately 25 milliseconds) on its W-TX port,
which raises an LOS alarm on the W-RX port of Station A. This causes Station A to also switch traffic to its
P-RX port. In this way, PSM implements bidirectional switching without any data exchange between the two
stations.

Because the two stations do not communicate using signaling protocols (overhead bytes), a Manual or Force
protection switch on the PSM card is implemented by creating a traffic hit. For example, consider that you
perform aManual or Force protection switch on Station A. The TXVOA on the active path is set to automatic
VOA shutdown (AVS) state for 25 milliseconds. This causes Station B to switch traffic to the other path
because it cannot differentiate between a maintenance operation and a real fail. After 25 milliseconds, the
VOA in Station A is automatically reset. Now Station B does not revert back by itself if the non-revertive
switching protection scheme is used in the PSM card. However, if the automatic reversion feature on the PSM
card is enabled, Station B reverts back to the working path once Wait To Restore (WTR) timer is over. For
more details on the automatic reversion feature, see the Automatic PSM Reversion section.

To effectively implement switching, the Lockout and Force commands must be performed on both the stations.
If these commands are not performed on both the stations, the far-end and near-end PSMs can be misaligned.
In case of misalignment, when a path recovers, traffic might not recover automatically. You might have to
perform a Force protection switch to recover traffic.

The order in which you repair the paths is important in the event of a double failure (both the working and
protect paths are down due to a fiber cut) on the PSM card in line protection configuration when the active
path is the working path. If you repair the working path first, traffic is automatically restored. However, if
you repair the protect path first, traffic is not automatically restored. You must perform a Force protection
switch to restore traffic on the protect path.

Note
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Automatic PSM Reversion
FromRelease 10.5.2, the PSM cards support automatic bidirectional switching.When the fault on the working
path clears, traffic automatically switches from the protection path to the working path. The reversion takes
place after the Wait To Restore (WTR) timer is over. The key features of automatic PSM reversion are:

• Only normal and standalone modes of PSM card support automatic reversion.

• Protection cannot be provisioned as revertive if automatic laser shutdown (ALS) is enabled in standalone
mode, and vice versa.

• Revertive feature is supported for only OCH protection.

• By default, the protection in PSM is non-revertive. To enable the revertive feature, perform step 4 of
DLP-G176 Modify a Splitter Protection Group.

PSM revertive mode does not support user switching requests from working(W) to protect(P) path. In order
to perform maintenance on the working path, the user must disable revertive mode and then perform W to P
path switching.

Note

• Reversion parameters that include revertive/non-revertive protection, WTR, pulse width, and interval
can be configured only when the working path is active.

• WTR time can be set to a duration between 30 seconds to 12 minutes and is configurable only if the
protection is revertive. By default, the timer is set to five minutes.

• Reversion PulseWidth is between 10 to 200 seconds and is configurable only if the protection is revertive.
By default, the duration is set to 60 seconds. This parameter value can be calculated using the following
formula:

Minimum reversion pulse width = ROADM delay + 10 seconds

ROADM delay = N x 5 x 2

N=number of filter cards in the network between the source and destination PSM nodes on the working
path.

5 = maximum startup delay in seconds

2=bidirectional communication

For example, if a network has four ROADM nodes with the end nodes having PSM cards on the working
path as depicted below:

[PSM - Node 1 - FILTER 1 ] ==== [FILTER 2 - Node 2 - FILTER 3 ] ==== [FILTER 4 - Node 3 -
FILTER 5 ] ==== [FILTER 6 - Node 4 - PSM]

then N = 6

ROADM delay = 6 x 5 x 2= 60

Minimum reversion pulse width = 60 + 10 = 70 seconds

• Recovery Pulse Interval for reversion is auto-calculated and the user cannot configure the thresholds.
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Related Procedures for PSM Card
The following is the list of procedures and tasks related to the configuration of the PSM card:

• NTP-G30 Installing the DWDM Cards

• NTP-G202 Modify PSM Card Line Settings and PM Thresholds

• NTP-G242 Create an Internal Patchcord Manually

• DLP-G493 Provision Protected Optical Channel Network Connections

• DLP-G479 View Optical Power Statistics for the PSM Card

• DLP-G176 Modify a Splitter Protection Group

• DLP-G459 Delete a Splitter Protection Group
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C H A P T E R 6
Provisioning Optical Add/Drop Cards

This chapter describes optical add/drop cards used in Cisco ONS 15454 dense wavelength divisionmultiplexing
(DWDM) networks. For card safety and compliance information, refer to the Regulatory Compliance and
Safety Information for Cisco ONS Products document.

The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, Cisco
ONS 15454 M2 platforms, unless noted otherwise.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

Chapter topics include:

• Safety Labels, on page 59
• Card Overview, on page 59
• AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x Cards, on page 62
• AD-1B-xx.x and AD-4B-xx.x Cards, on page 65

Safety Labels
For information about safety labels, see the section, Class 1M Laser Product Cards .

Card Overview
The card overview section contains card overview, software compatibility, and channel allocation information
for optical add/drop cards.

Optical add/drop cards are divided into two groups:

• Band optical add/drop multiplexer (OADM) cards

• Channel OADM cards
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Band OADM cards add and drop one or four bands of adjacent channels. The cards in this chapter, including
the 4-Band OADM (AD-4B-xx.x) and the 1-Band OADM (AD-1B-xx.x) are utilized only in the C band.

Channel OADM cards add and drop one, two, or four adjacent channels; they include the 4-Channel OADM
(AD-4C-xx.x), the 2-Channel OADM (AD-2C-xx.x), and the 1-Channel OADM (AD-1C-xx.x).

Card Compatibility
The following table lists the CTC software compatibility for each optical add/drop card.

Table 35: Software Release Compatibility for Optical Add/Drop Cards

R10.7 R10.6.2R10.6.1R10.5.2R10.5R10.0
/R10.1/R10.3

R9.2 - R9.8R4.5 - R9.1Card Name

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2, 15454-M6,
15454 -DWDM

15454-M2,
15454-M6,
15454 -DWDM

15454-M2,
15454-M6, 15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6, 15454
-DWDM

15454 -DWDMAD-1C-xx.x

15454-M2,
15454-M6,
15454-DWDM

15454-M2,
15454-M6,
15454-DWDM

15454-M2, 15454-M6,
15454 -DWDM

15454-M2,
15454-M6,
15454 -DWDM

15454-M2,
15454-M6, 15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454-DWDM

15454 -DWDMAD-2C-xx.x

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2, 15454-M6,
15454 -DWDM

15454-M2,
15454-M6,
15454 -DWDM

15454-M2,
15454-M6, 15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6, 15454
-DWDM

15454 -DWDMAD-4C-xx.x

15454
-DWDM

15454
-DWDM

15454 -DWDM15454 -DWDM15454 -DWDM15454
-DWDM

15454 -DWDM15454 -DWDMAD-1B-xx.x

15454
-DWDM

15454
-DWDM

15454 -DWDM15454 -DWDM15454 -DWDM15454
-DWDM

15454 -DWDM15454 -DWDMAD-4B-xx.x

DWDM Card Channel Allocation Plan
ONS 15454 DWDM channel OADM and band OADM cards are designed for use with specific channels in
the C band. In most cases, the channels for these cards are either numbered (for example, 1 to 32) or delimited
(odd or even). Client interfaces must comply with these channel assignments to be compatible with the
ONS 15454 system.

Table 36: DWDM Channel Allocation Plan (C Band) lists the channel IDs and wavelengths assigned to the
C-band DWDM channels.

In some cases, a card uses only some or all of the channels listed in a band. Also, some cards use channels
on the 100-GHz ITU-T grid while others use channels on the 50-GHz ITU-T grid.

Note

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
60

Provisioning Optical Add/Drop Cards
Card Compatibility



Table 36: DWDM Channel Allocation Plan (C Band)

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1545.72193.95421529.55196.001

1546.119193.90431529.94195.952

1546.518193.85441530.334195.903

1546.917193.80451530.725195.854

1547.316193.75461531.116195.805

1547.715193.70471531.507195.756

1548.115193.65481531.898195.707

1548.515193.60491532.290195.658

1548.915193.55501532.681195.609

1549.32193.50511533.073195.5510

1549.71193.45521533.47195.5011

1550.116193.40531533.86195.4512

1550.517193.35541534.250195.4013

1550.918193.30551534.643195.3514

1551.319193.25561535.036195.3015

1551.721193.20571535.429195.2516

1552.122193.15581535.822195.2017

1552.524193.10591536.216195.1518

1552.926193.05601536.609195.1019

1553.33193.00611537.003195.0520

1553.73192.95621537.40195.0021

1554.134192.90631537.79194.9522

1554.537192.85641538.186194.9023

1554.940192.80651538.581194.8524

1555.343192.75661538.976194.8025

1555.747192.70671539.371194.7526
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1556.151192.65681539.766194.7027

1556.555192.60691540.162194.6528

1556.959192.55701540.557194.6029

1557.36192.50711540.953194.5530

1557.77192.45721541.35194.5031

1558.173192.40731541.75194.4532

1558.578192.35741542.142194.4033

1558.983192.30751542.539194.3534

1559.389192.25761542.936194.3035

1559.794192.20771543.333194.2536

1560.200192.15781543.730194.2037

1560.606192.10791544.128194.1538

1561.013192.05801544.526194.1039

1561.42192.00811544.924194.0540

1561.83191.95821545.32194.0041

AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x Cards

AD-1C-xx.x Card
The AD-1C-xx.x card has reached end of support.

The 1-Channel OADM (AD-1C-xx.x) card passively adds or drops one of the 32 channels utilized within the
100-GHz-spacing of the DWDM card system. Thirty-two versions of this card—each designed only for use
with one wavelength—are used in the ONS 15454 DWDM system. Each wavelength version of the card has
a different part number.

The features of the AD-1C-xx.x card are listed in the section, "Features of AD-1C-xx.x, AD-2C-xx.x, and
AD-4C-xx.x Cards".

For more information about the AD-1C-xx.x card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet09186a00801a5572.html.
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AD-2C-xx.x Card
The AD-2C-xx.x card has reached end of support.

The 2-Channel OADM (AD-2C-xx.x) card passively adds or drops two adjacent 100-GHz channels within
the same band. Sixteen versions of this card—each designed for use with one pair of wavelengths—are used
in the ONS 15454 DWDM system. The card bidirectionally adds and drops in two different sections on the
same card to manage signal flow in both directions. Each version of the card has a different part number.

The features of the AD-2C-xx.x card are listed in the section, "Features of AD-1C-xx.x, AD-2C-xx.x, and
AD-4C-xx.x Cards".

For more information about the AD-2C-xx.x card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet09186a00801a5572.html.

AD-4C-xx.x Card
The AD-4C-xx.x card has reached end of support.

The 4-Channel OADM (AD-4C-xx.x) card passively adds or drops all four 100-GHz-spaced channels within
the same band. Eight versions of this card—each designed for use with one band of wavelengths—are used
in the ONS 15454 DWDM system. The card bidirectionally adds and drops in two different sections on the
same card to manage signal flow in both directions. There are eight versions of this card with eight part
numbers.

The features of the AD-2C-xx.x card are listed in the section, "Features of AD-1C-xx.x, AD-2C-xx.x, and
AD-4C-xx.x Cards".

For more information about the AD-4C-xx.x card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet09186a00801a5572.html.

Features of AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x Cards
The AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x cards have the following features:

• Passive cascaded optical interferential filters perform the channel add and drop functions.

• Software-controlled variable optical attenuators (VOA) regulate the optical power of the inserted channel.

• Software-controlled VOA regulate the insertion loss of the express optical path.

• VOA settings and functions, photodiode detection, and alarm thresholds, are internally controlled.

• Virtual photodiodes (firmware calculations of port optical power) at the common DWDM output and
input ports are monitored within the software.

Power Monitoring
Physical photodiodes P1 through P4 and virtual photodiodes V1 and V2monitor the power for the AD-1C-xx.x
card. The returned power level values are calibrated to the ports as shown in the following table.
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Table 37: AD-1C-xx.x Port Calibration

Calibrated to PortCTC Type NamePhotodiode

DROP RXADDP1

DROP TXDROPP2

EXP RXIN EXPP3

EXP TXOUT EXPP4

COM RXIN COMV1

COM TXOUT COMV2

Physical photodiodes P1 through P10 and virtual photodiodes V1 andV2monitor the power for the AD-2C-xx.x
card. The returned power level values are calibrated to the ports as shown in the following table.

Table 38: AD-2C-xx.x Port Calibration

Calibrated to PortCTC Type NamePhotodiode

COM TXADDP1–P2

DROP TXDROPP3–P4

EXP RXIN EXPP5

EXP TXOUT EXPP6

COM RXIN COMV1

COM TXOUT COMV2

Physical photodiodes P1 through P10 and virtual photodiodes V1 andV2monitor the power for the AD-4C-xx.x
card. The returned power level values are calibrated to the ports as shown in the following table.

Table 39: AD-4C-xx.x Port Calibration

Calibrated to PortCTC Type NamePhotodiode

COM TXADDP1–P4

DROP TXDROPP5–P8

EXP RXIN EXPP9

EXP TXOUT EXPP10

COM RXIN COMV1

COM TXOUT COMV2

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.
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Related Procedures for AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x Cards
• NTP-G30 Installing the DWDM Cards

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G74 Monitor DWDM Card Performance

• NTP-G106 Resetting Cards Using CTC

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

• NTP-G119 Powering Down the Node

AD-1B-xx.x and AD-4B-xx.x Cards

AD-1B-xx.x Card
The AD-1B-xx.x card has reached end of support.

(Cisco ONS 15454 only)

The 1-BandOADM (AD-1B-xx.x) card passively adds or drops a single band of four adjacent 100-GHz-spaced
channels. Eight versions of this card with eight different part numbers—each version designed for use with
one band of wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and
drops in two different sections on the same card to manage signal flow in both directions. This card can be
used when there is asymmetric adding and dropping on each side (east or west) of the node; a band can be
added or dropped on one side but not on the other.

The features of the AD-1B-xx.x card are listed in the section, "Features of AD-1B-xx.x and AD-4B-xx.x
Cards".

For more information about the AD-1B-xx.x card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet09186a00801a5572.html.

AD-4B-xx.x Card
The AD-4B-xx.x card has reached end of support.

(Cisco ONS 15454 only)

The 4-Band OADM (AD-4B-xx.x) card passively adds or drops four bands of four adjacent 100-GHz-spaced
channels. Two versions of this card with different part numbers—each version designed for use with one set
of bands—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in two different
sections on the same card to manage signal flow in both directions. This card can be used when there is
asymmetric adding and dropping on each side (east or west) of the node; a band can be added or dropped on
one side but not on the other.

The features of the AD-4B-xx.x card are listed in the section, "Features of AD-1B-xx.x and AD-4B-xx.x
Cards".
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For more information about the AD-4B-xx.x card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet09186a00801a5572.html.

Features of AD-1B-xx.x and AD-4B-xx.x Cards
The AD-1B-xx.x and AD-4B-xx.x cards have the following features:

• Software-controlled VOAs regulate the optical power flowing in the OADM paths.

• Output power of the dropped band is set by changing the attenuation of the VOA drop.

• The VOA express is used to regulate the insertion loss of the express path.

• VOA settings and functions, photodiode detection, and alarm thresholds are internally controlled.

• Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common
DWDM output and input ports.

The AD-4B-xx.x card has only one virtual photodiode at the common DWDM
output port.

Note

Power Monitoring
Physical photodiodes P1 through P4 and virtual photodiodes V1 and V2monitor the power for the AD-1B-xx.x
card. The returned power level values are calibrated to the ports as shown in the following table.

Table 40: AD-1B-xx.x Port Calibration

Calibrated to PortCTC Type NamePhotodiode

BAND RXADDP1

BAND TXDROPP2

EXP RXIN EXPP3

EXP TXOUT EXPP4

COM RXIN COMV1

COM TXOUT COMV2

Physical photodiodes P1 through P11 and virtual photodiode V1 monitor the power for the AD-4B-xx.x card.
The returned power level values are calibrated to the ports as shown in the following table.

Table 41: AD-4B-xx.x Port Calibration

Calibrated to PortCTC Type NamePhotodiode

COM TXADDP1–P4

DROP TXDROPP5–P8
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Calibrated to PortCTC Type NamePhotodiode

EXP RXIN EXPP9

EXP TXOUT EXPP10

COM RXIN COMP11

COM TXOUT COMV1

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

Related Procedures for AD-1B-xx.x and AD-4B-xx.x Cards
• NTP-G30 Installing the DWDM Cards

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G74 Monitor DWDM Card Performance

• NTP-G106 Resetting Cards Using CTC

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

• NTP-G119 Powering Down the Node
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C H A P T E R 7
Provisioning Reconfigurable Optical Add/Drop
Cards

This chapter describes the line cards deployed in reconfigurable optical add/drop (ROADM) networks. These
cards perform mesh topology functions.

For card safety and compliance information, refer to the Regulatory Compliance and Safety Information for
Cisco ONS Platforms document.

The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6,
Cisco ONS 15454 M2 platforms, unless noted otherwise.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

• Card Compatibility, on page 69
• Channel Allocation Plans, on page 71
• Safety Labels, on page 74
• 32WSS and 32WSS-L Cards, on page 74
• 32DMX and 32DMX-L Cards, on page 79
• 40-DMX-C and 40-DMX-CE Card, on page 81
• 40-MUX-C Card, on page 86
• 40-WSS-C and 40-WSS-CE Card, on page 88
• 40-WXC-C Card, on page 91
• 80-WXC-C Card, on page 95
• 16-WXC-FS Card, on page 102
• Single Module ROADM (SMR-C) Cards, on page 106
• MMU Card, on page 119

Card Compatibility
The following table lists the Cisco Transport Controller (CTC) software compatibility for the ROADM cards.
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Table 42: Software Release Compatibility for ROADM Cards

R11.x.xR10.6.1
/R10.6.2/R10.7/10.8/10.9

R10.5.2R10.5R10.0
/10.1/10.3

R9.2 -
R9.8

R9.1R8.0 -
R9.0

R7.0
-R7.2

R4.7 -
R6.0

Card
Name

15454
-DWDM
,
15454-M6

15454
-DWDM ,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

32WSS

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

No32WSS
-L

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454
-M6,
15454-DWDM

15454
-DWDM

15454
-DWDM

NoNo40
-WSS
-C

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454
-DWDM

15454
-DWDM

NoNo40
-WSS
-CE

15454
-DWDM
,
15454-M6

15454
-DWDM ,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM
,
15454-M6

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

32
DMX

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

No32
DMX
-L

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454
-DWDM

15454
-DWDM

NoNo40
-DMX
-C

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454
-DWDM

15454
-DWDM

NoNo40
-DMX
-CE

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454
-DWDM

15454
-DWDM

NoNo40
-MUX
-C

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

15454
-DWDM

15454
-DWDM

NoNo40
-WXC
-C

15454
-DWDM,
15454-M6,
NCS
2015

15454
-DWDM,
15454-M6,
NCS 2015

15454
-DWDM,
15454
-M6,
NCS
2015

15454-M6,
15454-DWDM

15454-M6,
15454
-DWDM

15454-M6,
15454
-DWDM

NoNoNoNo80
-WXC
-C
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R11.x.xR10.6.1
/R10.6.2/R10.7/10.8/10.9

R10.5.2R10.5R10.0
/10.1/10.3

R9.2 -
R9.8

R9.1R8.0 -
R9.0

R7.0
-R7.2

R4.7 -
R6.0

Card
Name

15454-M6,
NCS
2015

15454-M6,
NCS 2015

15454-M6,
NCS
2015

15454-M6,
NCS
2015

15454-M6NoNoNoNoNo16
-WXC
-FS

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454
-DWDM

NoNoNo40
-SMR1
-C

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454-M2,
15454-M6,
15454
-DWDM

15454
-DWDM

NoNoNo40
-SMR2
-C

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

15454
-DWDM

NoMMU

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS 2015

15454-M2,
15454-M6,
NCS
2015

15454
-M2,
15454
-M6,
NCS
2015

NoNoNoNoNoNo17
SMR9
FS, 24
SMR9
FS, 34
SMR9
FS,
SMR20
FS,
SMR20
FS
CV

15454-M2,
15454-M6,
NCS
2015

15454-M2,
15454-M6,
NCS 2015

15454-M2,
15454-M6,
NCS
2015

15454
-M2,
15454
-M6,
NCS
2015

NoNoNoNoNoNo12-AD-FS,
16-AD-FS

Channel Allocation Plans
ROADM cards are designed for use with specific channels in the C band and L band. In most cases, the
channels for these cards are either numbered (for example, 1 to 32 or 1 to 40) or delimited (odd or even).
Client interfaces must comply with these channel assignments to be compatible with the ONS 15454 system.

The following cards operate in the C-band:

• 32WSS

• 32DMX
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• 32DMX-C

• 40-MUX-C

• 40-WXC-C

• 80-WXC-C

• 40-SMR1-C

• 40-SMR2-C

• MMU

The following add drop cards utilize the L-band DWDM channels:

• 32WSS-L

• 32DMX-L

Table 43: DWDM L-band Channel Allocation Plan at 50 GHz Spacing, on page 72 lists the L-band channel
IDs and wavelengths at ITU-T 50-GHz intervals. This is a comprehensive L-band channel table that
encompasses present and future card capabilities.

Table 43: DWDM L-band Channel Allocation Plan at 50 GHz Spacing

Wavelength (nm)Frequency
(THz)

Channel NumberWavelength (nm)Frequency
(THz)

Channel
Number1

1587.46188.85411570.83190.851

1587.88188.8421571.24190.82

1588.30188.75431571.65190.753

1588.73188.7441572.06190.74

1589.15188.65451572.48190.655

1589.57188.6461572.89190.66

1589.99188.55471573.30190.557

1590.41188.5481573.71190.58

1590.83188.45491574.13190.459

1591.26188.4501574.54190.410

1591.68188.35511574.95190.3511

1592.10188.3521575.37190.312

1592.52188.25531575.78190.2513

1592.95188.2541576.20190.214

1593.37188.15551576.61190.1515
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Wavelength (nm)Frequency
(THz)

Channel NumberWavelength (nm)Frequency
(THz)

Channel
Number1

1593.79188.1561577.03190.116

1594.22188.05571577.44190.0517

1594.64188581577.8619018

1595.06187.95591578.27189.9519

1595.49187.9601578.69189.920

1595.91187.85611579.10189.8521

1596.34187.8621579.52189.822

1596.76187.75631579.93189.7523

1597.19187.7641580.35189.724

1597.62187.65651580.77189.6525

1598.04187.6661581.18189.626

1598.47187.55671581.60189.5527

1598.89187.5681582.02189.528

1599.32187.45691582.44189.4529

1599.75187.4701582.85189.430

1600.17187.35711583.27189.3531

1600.60187.3721583.69189.332

1601.03187.25731584.11189.2533

1601.46187.2741584.53189.234

1601.88187.15751584.95189.1535

1602.31187.1761585.36189.136

1602.74187.05771585.78189.0537

1603.17187781586.2018938

1603.60186.95791586.62188.9539

1604.03186.9801587.04188.940

1 Channels on the L-band are contiguous, starting at 1577.86 nm. The channels listed in this table begin
with 1570.83 nm for backward compatibility with other ONS products.
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Safety Labels
For information about safety labels, see the section, Class 1M Laser Product Cards.

32WSS and 32WSS-L Cards
(Cisco ONS 15454 only)

The two-slot 32-ChannelWavelength Selective Switch (32WSS) and 32-ChannelWavelength Selective Switch
L-Band (32WSS-L) cards perform channel add/drop processing within the DWDM node. The 32WSS or
32WSS-L card can be installed in the following pairs of slots:

• Slots 1 and 2

• Slots 3 and 4

• Slots 5 and 6

• Slots 12 and 13

• Slots 14 and 15

• Slots 16 and 17

The 32WSS or 32WSS-L cards has six types of ports:

• ADDRX ports (1 to 32): These ports are used for adding channels (listed in Table 45: Channel Allocation
Plan, on page 76 or Table 46: Channel Allocation Plan, on page 77). Each add channel is associated
with an individual switch element that selects whether that channel is added. Each add port has optical
power regulation provided by a variable optical attenuator (VOA). The 32WSS has four physical receive
connectors that accept multifiber push-on (MPO) cables on its front panel for the client input interfaces.
Each MPO cable breaks out into eight separate cables.

• EXPRX port: The EXPRX port receives an optical signal from another 32WSS card in the same network
element (NE).

• EXP TX port: The EXP TX port sends an optical signal to the other 32WSS card within the NE.

• COM TX port: The COM TX (line input) port sends an aggregate optical signal to a booster amplifier
card (for example, OPT-BST) for transmission outside of the NE.

• COMRX port: The COMRX port receives the optical signal from a preamplifier (such as the OPT-PRE)
and sends it to the optical splitter.

• DROP TX port: The DROP TX port sends the split-off optical signal containing drop channels to the
32DMX card, where the channels are further processed and dropped.

Aggregate optical signals that enter the EXP RX and COM RX port are processed in two ways:

• EXP RX Port Add Channel/Pass-through Processing

The incoming optical signal is received at the EXP RX port from the other 32WSS card within the NE.
The incoming aggregate optical signal is demultiplexed into 32 individual wavelengths, or channels.
Each channel is then individually processed by the optical switch, which performs add/pass-through
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processing. By using software controls, the switch either selects the optical channel coming in from the
demultiplexer (that is, the pass-through channel) or it selects the external ADD channel. If the ADD port
channel is selected this channel is transmitted and the optical signal coming from the demultiplexer is
blocked.

After the optical switch stage, all of the channels are multiplexed into an aggregate optical signal, which
is sent out on the COM TX port. The output is typically connected to an OPT-AMP-L or OPT-BST-E
card (in the event a booster amplifier is needed) or to an OSC-CSM card (if no amplification is needed).

• COM RX Port Optical Splitter Processing

The COMRX port receives the incoming optical signal and directs it to the 32WSS card’s optical splitter.
The splitter optically diverts channels that are designated to be dropped to the DROPTX port. The DROP
TX port is typically connected to the COM RX port of the 32DMX where the drop channels are being
dropped. Channels that are not dropped pass-through the optical splitter and flow out of the 32WSS card
EXP TX port. Typically, this optical signal is connected to the other 32WSS module within the NE.

The COM TX value can be measured by either a physical or a virtual photodiode of the 32WSS card. If the
vendor ID of the 32WSS card is between 1024 (0x400) and 2047 (0x800) the COM TX value is measured by
physical photodiode. If the vendor ID of the 32WSS card is greater than 2048 (0x800), the COM TX value
is measured by the virtual photodiode. For COMTX values measured by virtual photodiode, check the values
at the RX port in the downstream of the COM TX port (COM-RX port on OPT-BST or OSC-CSM card).

For more information about the 32WSS or 32WSS-L card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd803fc52f.html.

32WSS and 32WSS-L ROADM Functionality
To implement ROADM functionality, the 32WSS (or 32WSS-L) card works in combination with the 32DMX
(or 32DMX-L) card. As a ROADMnode, the node can be configured to add or drop individual optical channels
using CTC, Cisco Transport Planner, and Cisco Transport Manager (CTM). ROADM functionality using the
32WSS (or 32WSS-L) card requires two 32DMX (or 32DMX-L) single-slot cards and two 32WSS (or
32WSS-L) double-slot cards (totalling six slots needed in the chassis).

For other cards’ ROADM functionality, see that card’s description in this chapter. For a diagram of a typical
ROADM configuration, see the section, ROADMNode in theCisco ONS 15454 DWDM Network Operations
Guide.

A terminal site can be configured using only a 32WSS (or 32WSS-L) card and a 32DMX (or 32DMX-L) card
plugged into the east or west side of the shelf.

Note

32WSS and 32 WSS-L Power Monitoring
Physical photodiodes P1 through P69 monitor the power for the 32WSS or 32WSS-L card. The following
table shows how the returned power level values are calibrated to each port.

Table 44: 32WSS or 32WSS-L Port Calibration

Calibrated to PortCTC Type NamePhotodiode

ADD RXADD (Power ADD)P1–P32
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Calibrated to PortCTC Type NamePhotodiode

COM TXPASS THROUGHP33–P64
2

COM TXADD (Power)

EXP TXOUT EXPP65

EXP RXIN EXPP66

COM TXOUT COMP67

COM RXIN COMP68

DROP TXDROPP69

2 P33–P64 monitor either ADD or PASSTHROUGH power, depending on the state of the optical switch

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

32WSS and 32WSS-L Channel Allocation Plan
The 32WSS card’s channel labels, frequencies, and wavelengths are listed in the following table.

Table 45: Channel Allocation Plan

Wavelength (nm)Frequency (THz)Channel LabelBand ID

1530.33195.930.3B30.3

1531.12195.831.1

1531.90195.731.9

1532.68195.632.6

1534.25195.434.2B34.2

1535.04195.335.0

1535.82195.235.8

1536.61195.136.1

1538.19194.938.1B38.1

1538.87194.838.9

1539.77194.739.7

1540.46194.640.5
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Wavelength (nm)Frequency (THz)Channel LabelBand ID

1542.14194.442.1B42.1

1542.94194.342.9

1543.73194.243.7

1544.53194.144.5

1546.12193.946.1B46.1

1546.92193.846.9

1547.72193.747.7

1548.51193.648.5

1550.12193.450.1B50.1

1550.92193.350.9

1551.72193.251.7

1552.52193.152.5

1554.13192.954.1B54.1

1554.94192.854.9

1555.75192.755.7

1556.55192.656.5

1558.17192.458.1B58.1

1558.98192.358.9

1559.79192.259.7

1560.61192.160.6

The 32WSS-L card uses 32 banded channels on the ITU-T 100-GHz grid, as shown in the following table.

Table 46: Channel Allocation Plan

Wavelength (nm)Frequency (THz)Channel LabelBand ID

1577.8619077.8B77.8

1578.69189.978.6

1579.52189.879.5

1580.35189.780.3
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Wavelength (nm)Frequency (THz)Channel LabelBand ID

1581.18189.681.1B81.1

1582.02189.582.0

1582.85189.482.8

1583.69189.383.6

1584.53189.284.5B84.5

1585.36189.185.3

1586.2018986.2

1587.04188.987.0

1587.88188.887.8B87.8

1588.73188.788.7

1589.57188.689.5

1590.41188.590.4

591.26188.491.2B91.2

1592.10188.392.1

1592.95188.292.9

1593.79188.193.7

1594.6418894.6B94.6

1595.49187.995.4

1596.34187.896.3

1597.19187.797.1

1598.04187.698.0B98.0

1598.89187.598.8

1599.75187.499.7

1600.60187.300.6

1601.46187.201.4B01.4

1602.31187.102.3

1603.1718703.1

1604.03186.904.0
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Related Procedures for 32WSS and 32WSS-L Cards
The following section lists procedures and tasks related to the configuration of the 32WSS or 32WSS-L cards:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G93 Modifying the WSS Card Line Settings and PM Thresholds

32DMX and 32DMX-L Cards
(Cisco ONS 15454 only)

The single-slot 32-channel demultiplexer (32DMX) or the 32-channel demultiplexer L-band (32DMX-L) card
is an optical demultiplexer. The card receives an aggregate optical signal on its COMRXport and demultiplexes
it into to (32) ITU-T 100-GHz-spaced channels. The 32DMX or 32DMX-L card can be installed in Slots 1
to 6 and in Slots 12 to 17. The 32DMX-L card is particularly well suited for use in networks that employ DS
fiber or SMF-28 single-mode fiber.

The 32DMX or 32DMX-L card has two types of ports:

• COMRX port: COMRX is the input port for the aggregate optical signal being demultiplexed. This port
is supported by a VOA for optical power regulation and a photodiode for optical power monitoring.

• DROP TX ports (1 to 32): On its output, the 32DMX provides 32 drop ports that are typically used for
dropping channels within the ROADM node. These ports are connected using four 8-fiber MPO ribbon
connectors. The incoming optical signal to the demultiplexer comes into the COM RX port. This input
port is connected using a single LC duplex optical connector. Each drop port has a photodiode for optical
power monitoring. Unlike the two-slot 32DMX-O demultiplexer, the drop ports on the 32DMX do not
have a VOA per channel for optical power regulation.

For more information about the 32DMX or 32DMX-L card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd803fc52f.html.

32DMX and 32DMX-L ROADM Functionality
The 32DMX (or 32DMX-L) card works in combination with the 32WSS (or 32WSS-L) card to implement
ROADM functionality. As a ROADM node, the node can be configured to add or drop individual optical
channels using CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 32DMX (or
32DMX-L) card requires two 32DMX (or 32DMX-L) single-slot cards and two 32WSS (or 32WSS-L)
double-slot cards (for six slots total in the chassis).
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For information about the ROADM functionality for other cards, see that card’s description in this chapter.
For a diagram of a typical ROADM configuration, see the section, ROADM Node in the Cisco ONS 15454
DWDM Network Operations Guide.

A terminal site can be configured using only a 32WSS (or 32WSS-L) card and a 32DMX or 32WSS-L) card
plugged into the east or west side of the shelf.

Note

32DMX and 32DMX-L Power Monitoring
Physical photodiodes P1 through P33 monitor the power for the 32DMX or 32DMX-L card. The returned
power level values are calibrated to the ports as shown in following table.

Table 47: 32DMX or 32DMX-L Port Calibration

Calibrated to PortCTC Type NamePhotodiode

DROP TXDROPP1–P32

COM RXINPUT COMP33

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

32DMX and 32DMX-L Channel Allocation Plan
The 32DMX card’s channel labels, frequencies, and wavelengths are listed in Table 45: Channel Allocation
Plan, on page 76.

The 32DMX-L card uses 32 banded channels on the ITU-T 100-GHz grid, as shown in Table 46: Channel
Allocation Plan, on page 77.

Related Procedures for 32DMX and 32DMX-L Cards
The following section lists procedures and tasks related to the configuration of the 32DMX or 32DMX-L
cards:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G93 Modifying the WSS Card Line Settings and PM Thresholds
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40-DMX-C and 40-DMX-CE Card
(Cisco ONS 15454 and ONS 15454 M6 only)

The single-slot 40-channel demultiplexer C-band (40-DMX-C) or single-slot 40-channel demultiplexer C-band,
even channels (40-DMX-CE) card demultiplexes 40 100-GHz-spaced channels identified in the channel plan
(Table 50: Channel Allocation Plan, on page 84), and sends them to dedicated output ports. The overall optical
power can be adjusted using a single VOA that is common to all channels. The 40-DMX-C card is
unidirectional, optically passive, and can be installed in Slots 1 to 6 and 12 to 17.

The 40-DMX-C or 40-DMX-CE has two types of ports:

• COMRX port: COMRX is the line input port for the aggregate optical signal being demultiplexed. This
port is supported by a VOA for optical power regulation and a photodiode for per channel optical power
monitoring.

By default, the VOA is set to its maximum attenuation for safety purposes (for
example, electrical power failure). A manual VOA setting is also available.

Note

• DROP TX ports (1 to 40): On its output, the 40-DMX-C or 40-DMX-CE card provides 40 drop ports
that are typically used for dropping channels within the ROADM node. These ports are connected using
five physical connectors on the front panel that accept MPO client input cables. (MPO cables break out
into eight separate cables.) The 40-DMX-C card also has one LC-PC-II optical connector for the main
input.

The following figure shows the 40-DMX-C or 40-DMX-CE optical module functional block diagram.

Figure 5: 40-DMX-C or 40-DMX-CE Optical Module Functional Block Diagram

For more information about the 40-DMX-C or 40-DMX-CE card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd805ebf1d.html.
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40-DMX-C and 40-DMX-CE ROADM Functionality
The 40-DMX-C (or 40-DMX-CE) card works in combination with the 40-WSS-C (or 40-WSS-CE) card to
implement ROADM functionality. As a ROADM node, the node can be configured at the optical channel
level using CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 40-DMX-C (or
40-DMX-CE) card requires two single-slot 40-DMX-C (or 40-DMX-CE) cards and two 40-WSS-C (or
40-WSS-CE) double-slot cards (for a total of six slots in the chassis).

For other cards’ ROADM functionality, see that card’s description in this chapter. For a diagram of a typical
ROADMconfiguration, see the section, ROADMNode in theCisco ONS 15454 DWDM Network Configuration
Guide.

40-DMX-C and 40-DMX-CE Power Monitoring
Physical photodiodes P1 through P40 monitor the power at the outputs of the 40-DMX-C or 40-DMX-CE
card. P41 monitors the total multiplexed power at the input, calibrated to the COM-RX port. The following
table shows the returned power level values calibrated to each port.

Table 48: 40-DMX-C or 40-DMX-CE Port Calibration

Calibrated to PortCTC Type NamePhotodiode

DROP TXDROPP1–P40

COM RXINPUT COMP41

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

40-DMX-C and 40-DMX-CE Channel Plan
This table shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are demultiplexed by
the 40-DMX-C card.

Table 49: Channel Allocation Plan

Wavelength
(nm)

Frequency (GHz)Channel LabelBand ID

1529.5519629.5Ch. 03

1530.33195.930.3B30.3

1531.12195.831.1

1531.90195.731.9

1532.68195.632.6

1533.47195.533.4
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Wavelength
(nm)

Frequency (GHz)Channel LabelBand ID

1534.25195.434.2B34.2

1535.04195.335.0

1535.82195.235.8

1536.61195.136.6

1537.4019537.4

1538.19194.938.1B38.1

1538.98194.838.9

1539.77194.739.7

1540.56194.640.5

1541.35194.541.3

1542.14194.442.1B42.1

1542.94194.342.9

1543.73194.243.7

1544.53194.144.5

1545.3219445.3

1546.12193.946.1B46.1

1546.92193.846.9

1547.72193.747.7

1548.51193.648.5

1549.32193.549.3

1550.12193.450.1B50.1

1550.92193.350.9

1551.72193.251.7

1552.52193.152.5

1553.3319353.3
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Wavelength
(nm)

Frequency (GHz)Channel LabelBand ID

1554.13192.954.1B54.1

1554.94192.854.9

1555.75192.755.7

1556.55192.656.5

1557.36192.557.3

1558.17192.458.1B58.1

1558.98192.358.9

1559.79192.259.7

1560.61192.160.6

1561.4219261.4

3 This channel is unused by the 40-WXC-C

This table shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are demultiplexed by
the 40-DMX-CE card.

Table 50: Channel Allocation Plan

Wavelength (nm)Frequency (GHz)Channel LabelBand ID

1530.72195.8530.7B30.7

1531.51195.7531.5

1532.29195.6532.3

1533.07195.5533.1

1533.86195.4533.9

1534.64195.3534.6B34.6

1535.43195.2535.4

1536.22195.1536.2

1537.00195.0537.0

1537.79194.9537.8
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Wavelength (nm)Frequency (GHz)Channel LabelBand ID

1538.58194.8538.6B38.6

1539.37194.7539.4

1540.16194.6540.1

1540.95194.5540.9

1541.75194.4541.8

1542.54194.3542.5B42.5

1543.33194.2543.3

1544.13194.1544.1

1544.92194.0544.9

1545.72193.9545.7

1546.52193.8546.5B46.5

1547.32193.7547.3

1548.11193.6548.1

1548.91193.5548.9

1549.72193.4549.7

1550.52193.3550.5B50.5

1551.32193.2551.3

1552.12193.1552.1

1552.93193.0552.9

1553.73192.9553.7

1554.54192.8554.4B54.4

1555.34192.7555.3

1556.15192.6556.1

1556.96192.5556.9

1557.77192.4557.8
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Wavelength (nm)Frequency (GHz)Channel LabelBand ID

1558.58192.3558.6B58.6

1559.39192.2559.4

1560.20192.1560.2

1561.01192.0561.0

1561.83191.9561.8

Related Procedures for 40-DMX-C and 40-DMX-CE Cards
The following section lists procedures and tasks related to the configuration of the 40-DMX-C or 40-DMX-CE
card:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G175 Modifying Line Card Settings and PM Thresholds for Multiplexer and Demultiplexer Cards

40-MUX-C Card
(Cisco ONS 15454 and ONS 15454 M6 only)

The single-slot 40-Channel Multiplexer C-band (40-MUX-C) card multiplexes forty ITU-T 100-GHz-spaced
channels identified in the channel plan in Table 49: Channel Allocation Plan, on page 82. The 40-MUX-C
card can be installed in Slots 1 to 6 and 12 to 17. The 40-MUX-C card is typically used in hub nodes.

The 40-MUX-C card has two types of ports:

• COM TX port: COM TX is the line output port for the aggregate optical signal being multiplexed. This
port is supported by both a VOA for optical power regulation and a photodiode for per channel optical
power monitoring.

By default, the VOA is set to its maximum attenuation for safety purposes (for
example, electrical power failure). A manual VOA setting is also available.

Note
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• DROP RX ports (1 to 40): The 40-MUX-C card provides 40 input optical channels. These ports are
connected using five physical receive connectors on the card’s front panel that accept MPO cables for
the client input interfaces. MPO cables break out into eight separate cables. The 40-DMX-C card also
has one LC-PC-II optical connector for the main output. For the wavelength range, see Table 49: Channel
Allocation Plan, on page 82.

The following figure shows the 40-MUX-C optical module functional block diagram.

Figure 6: 40-MUX-C Optical Module Functional Block Diagram

For more information about the 40-MUX-C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd805ebf1d.html.

40-MUX-C Card Power Monitoring
Physical photodiodes P1 through P40 monitor the power of the individual input ports to the 40-MUX-C card.
P41 monitors the total multiplexed output power, calibrated to the COM-TX port. The following table shows
the returned power level values calibrated to each port.

Table 51: 40-MUX-C Port Calibration

Calibrated to PortCTC Type NamePhotodiode

ADD RXADDP1–P40

COM-TXOUTPUT COMP41

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.
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40-MUX-C Card Channel Plan
Table 49: Channel Allocation Plan, on page 82 shows the 40 ITU-T 100-GHz-spaced, C-band channels
(wavelengths) that are multiplexed by the 40-MUX-C card.

Related Procedures for 40-MUX-C Card
The following section lists procedures and tasks related to the configuration of the 40-MUX-C card:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G175 Modifying Line Card Settings and PM Thresholds for Multiplexer and Demultiplexer Cards

40-WSS-C and 40-WSS-CE Card
(Cisco ONS 15454 and ONS 15454 M6 only)

The double-slot 40-channel wavelength selective switch C-band (40-WSS-C) or the double-slot 40-channel
wavelength selective switch even-channel C-band (40-WSS-CE) card switches 40 ITU-T 100-GHz-spaced
channels identified in the channel plan (Table 49: Channel Allocation Plan, on page 82 or Table 50: Channel
Allocation Plan, on page 84) and sends them to dedicated output ports. The 40-WSS-C or 40-WSS-CE card
is bidirectional and optically passive. The card can be installed in Slots 1 to 6 and 12 to 17

The 40-WSS-C or 40-WSS-CE features include:

• Receipt of an aggregate DWDM signal into 40 output optical channels from the Line receive port (EXP
RX) in one direction and from the COM-RX port in the other direction.

• Per-channel optical power monitoring using photodiodes.

• Signal splitting in a 70%-to-30% ratio, sent to the 40-DMX-C (or 40-DMX-CE) for dropping signals,
then to the other 40-WSS-C (or 40-WSS-CE) card.

• Aggregate DWDM signal monitoring and control through a variable optical attenuator (VOA). In the
case of electrical power failure, the VOA is set to its maximum attenuation for safety purposes. Amanual
VOA setting is also available.

Within the 40-WSS-C or 40-WSS-CE card, the first AWGopens the spectrum and each wavelength is directed
to one of the ports of a 1x2 optical switch. The same wavelength can be passed through or stopped. If the
pass-through wavelength is stopped, a new channel can be added at the ADD port. The card’s second AWG
multiplexes all of the wavelengths, and the aggregate signal is output through the COM-TX port.
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The 40-WSS-C or 40-WSS-CE has eight types of ports:

• ADD RX ports (1 to 40): These ports are used for adding channels. Each add channel is associated with
an individual switch element that selects whether an individual channel is added. Each add port has
optical power regulation provided by a VOA. The five connectors on the card faceplate accept MPO
cables for the client input interfaces. MPO cables break out into eight separate cables. The 40-WSS-C
or 40-WSS-CE card also has one LC-PC-II optical connector for the main input.

• COM RX: The COM RX port receives the optical signal from a preamplifier (such as the OPT-PRE)
and sends it to the optical splitter.

• COM TX: The COM TX port sends an aggregate optical signal to a booster amplifier card (for example,
the OPT-BST card) for transmission outside of the NE.

• EXP RX port: The EXP RX port receives an optical signal from another 40-WSS-C or 40-WSS-CE card
in the same NE.

• EXP TX: The EXP TX port sends an optical signal to the other 40-WSS-C or 40-WSS-CE card within
the NE.

• DROP TX port: The DROP TX port sends the split off optical signal that contains drop channels to the
40-DMX-C( or 40-DMX-CE) card, where the channels are further processed and dropped.

The following figure shows a functional block diagram of the 40-WSS-C or 40-WSS-CE card.

Figure 7: 40-WSS-C or 40-WSS-CE Block Diagram

For more information about the 40-WSS-C or 40-WSS-CE card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd805ebf1d.html.
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40-WSS-C and 40-WSS-CE ROADM Functionality
The 40-WSS-C (or 40-WSS-CE) card works in combination with the 40-DMX-C (or 40-DMX-CE) card to
implement ROADM functionality. As a ROADM node, the node can be configured at the optical channel
level using CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 40-WSS-C (or
40-WSS-CE) card requires two 40-WSS-C (or 40-WSS-CE) double-slot cards and two 40-DMX-C (or
40-DMX-CE) single-slot cards (for a total of six slots in the chassis).

For information about ROADM functionality for other cards, see that card’s description in this chapter. For
a diagram of a typical ROADM configuration, see the section, ROADMNode in theCisco ONS 15454 DWDM
Network Operations Guide.

40-WSS-C and 40-WSS-CE Power Monitoring
The 40-WSS-C (or 40-WSS-CE) has physical diodes that monitor power at various locations on the card. The
following table lists the physical diode descriptions.

Table 52: 40-WSS-C or 40-WSS-CE Physical Photodiode Port Calibration

Calibrated to Port(s)CTC Type NamePhysical Photodiode

DROP TXDROPP1

EXP RXEXPP2

Add i RX ports (that is, channel input Add i RX power),
up to 40 ports and therefore 40 PDs

RXPDi34

COM TX port (that is, per channel output COM TX
power) up to 40 channels and therefore 40 PDs

TXPDi41

COM TX port (that is, total output COM TX power)COMPD5

4 i indicates any channel from 01 through 40.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide .

Additionally, the 40-WSS-C (or 40-WSS-CE) has two virtual diodes. Virtual diodes are monitor points for
each physical photodiode; they are identified with a physical diode relative to the way that the physical diode
is identified with one of the two interlink (ILK) ports. The following table lists the virtual diodes.

Table 53: 40-WSS-C or 40-WSS-CE Virtual Photodiode Port Calibration

Calibrated to Port(s)CTC Type NameVirtual Photodiode

COM RX port (total input COM RX power)COMVPD1

EXP TX port (total output EXP TX power)EXPVPD2
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40-WSS-C and 40-WSS-CE Channel Plan
Table 49: Channel Allocation Plan, on page 82 shows the 40 ITU-T 100-GHz-spaced, C-band channels
(wavelengths) that are switched by the 40-WSS-C card.

Table 50: Channel Allocation Plan, on page 84 shows the 40 ITU-T 100-GHz-spaced, C-band channels
(wavelengths) that are switched by the 40-WSS-CE card.

Related Procedures for 40-WSS-C and 40-WSS-CECards
The following section lists procedures and tasks related to the configuration of the 40-WSS-C or 40-WSS-CE
card:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G93 Modifying the WSS Card Line Settings and PM Thresholds

40-WXC-C Card
(Cisco ONS 15454 and ONS 15454 M6 only)

The double-slot 40-channel wavelength cross-connect C-band (40-WXC-C) card selectively sends any
wavelength combination coming from nine input ports to a common output port. The device can manage up
to 41 channels spaced at 100GHz on each port according to the channel grid in Table 49: Channel Allocation
Plan, on page 82. Each channel can be selected from any input. The card is optically passive and provides
bidirectional capability. It can be installed in Slots 1 to 6 and 12 to 17.

.The 40-WXC-C card provides the following features:

• Demultiplexing, selection, and multiplexing of DWDM aggregate signal from input ports to common
output port.

• Aggregate DWDM signal monitoring and control through a VOA.

• VOAs are deployed in every channel path in order to regulate the channel’s optical power. In the case
of an electrical power failure, VOAs are set to their maximum attenuation value, or to a fixed and
configurable one. The VOA can also be set manually.

• Per-channel optical power monitoring using photodiodes.

The 40-WXC-C card acts as a selector element with the following characteristics:
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• It is able to select a wavelength from one input port and pass the wavelength through to the common out
port. Simultaneously, the card can block the same wavelength coming from the other eight input ports.

• It is able to stop wavelengths from all nine inputs.

• It is able to monitor optical power and control path attenuation using per channel VOA independently
of the wavelength input-to-out port connection.

The 40-WXC-C card has six types of ports:

• COM RX: The COM RX port receives the optical signal from a preamplifier (such as the OPT-PRE)
and sends it to the optical splitter.

• COM TX: The COM TX port sends an aggregate optical signal to a booster amplifier card (for example,
the OPT-BST card) for transmission outside of the NE.

• EXP TX: The EXP TX port sends an optical signal to the other 40-WXC-C card within the NE.

• MON TX: The optical service channel (OSC) monitor.

• ADD/DROP RX: The 40-WXC-C card provides 40 input optical channels. For the wavelength range,
see Table 49: Channel Allocation Plan, on page 82.

• ADD/DROP TX: The DROP TX port sends the split off optical signal that contains drop channels to the
40-WXC-C card, where the channels are further processed and dropped.

The following figure shows the 40-WXC-C optical module functional block diagram.

Figure 8: 40-WXC-C Optical Module Functional Block Diagram
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For more information about the 40-WXC-C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd805ebf1d.html.

40-WXC-C Power Monitoring
The 40-WXC-C has 83 physical diodes (P1 through P40) that monitor power at the outputs of the card. The
following table describes the physical diodes.

Table 54: 40-WXC-C Physical Photodiode Port Calibration

Calibrated to Port(s)CTC Type NamePhysical
Photodiode

DROP TXDROPP1

EXP RXEXPP2

Add i RX ports (that is, channel
input Add i RX power), up to 40
ports and therefore 40 PDs

RXPDi35

COM TX port (that is, per
channel output COMTX power)
up to 40 channels and therefore
40 PDs

TXPDi41

COM TX port (that is, total
output COM TX power)

COMPD5

5 i indicates any channel from 01 through 40.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

Additionally, the 40-WXC-C has two virtual diodes. Virtual diodes are monitor points for each physical
photodiode; they are identified with a physical diode relative to the way that the physical diode is identified
with one of the two interlink (ILK) ports. The following table lists the virtual diodes.

Table 55: 40-WXC-C Virtual Photodiode Port Calibration

Calibrated to Port(s)CTC Type NameVirtual
Photodiode

COM RX port (total input COM
RX power)

COMVPD1

EXP TX port (total output EXP
TX power)

EXPVPD2

The usage of WXC and mesh PP power readings to troubleshoot a LOS-P in WXC COM TX port in Side A
is described in the following example. The example is explained assuming a single wavelength 1558.17 in
the setup that comes from Side H to Side A. If there is more than one wavelength, then there is a risk of
dropping traffic when pulling common fibers. The example is explained below:
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When the wavelength from side H is 1558.17, you can check the power reading at WXC EXP TX port of the
WXC card and verify the consistency with side H pre output power and WXC COMRX-EXPTX port loss.
You can also check with a power meter connected to the 8th fiber (since it is from side H) of an MPO-FC (or
LC) cable connected to the TAP-TX port of the MESH-PP. This value should be consistent with the previous
reading, less than the insertion loss of the installed PP-MESH. If it is consistent, the issue is with the MPO
between side A WXC and PP-MESH. If it is not consistent, the issue is with the PP-MESH or the LC-LC
from side H. With only the PP-MESH already tested during installation, the only issue can be with the patch
cord b.

You can check if the 1558.17 wavelength from side H is unequalized (that is, if the channel is not aligned
with the linear fit of the power values of the other channels) by keeping the DMX COM-RX port of side H
in maintenance, and checking both the signal and ASE levels of CHAN-TX ports of the DMX card. If the
channel is equalized (that is, if the channel is aligned with the linear fit of the power values of the other
channels), then the issue is in the WXC side A that cannot properly regulate the VOA for such channel. If the
channel is unequalized, then the issue is on a remote node.

With an OSA or a spare 40 DMX, you can see the light coming from all the sides from TAP-TX of the
PP-MESH.

Note

40-WXC-C Channel Plan
Table 49: Channel Allocation Plan, on page 82 shows the 40 ITU-T 100-GHz-spaced, C-band channels
(wavelengths) that are cross connected by the 40-WXC-C card.

Related Procedures for 40-WXC-C Card
The following section lists procedures and tasks related to the configuration of the 40-WXC-C card:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G185 Installing Fiber-Optic Cables between Mesh Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G174 Modifying Line Settings and PM Thresholds for 40-WXC-C, 80-WXC-C, or 16-WXC-FS
Cards
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80-WXC-C Card
(Cisco ONS 15454, ONS 15454 M6, NCS 2015 only)

The double-slot 80-channel Wavelength Cross-Connect C-band (80-WXC-C) card manages up to 80 ITU-T
50GHz-spaced channels identified in the channel plan and sends them to dedicated output ports. Each channel
can be selected from any input port to any output port. The card is optically passive, and provides bidirectional
capability. It can be installed in Slots 1 to 5 and 12 to 16 the ONS 15454 chassis. It can be installed in Slots
2 to 6 in the Cisco ONS 15454 M6 and Slots 2 to 17 in the NCS 2015 chassis.

The 80-WXC-C card provides the following functionalities:

• When used in the multiplexer or bidirectional mode, the 80-WXC-C card allows selection of a single
wavelength or any combination of wavelengths from any of the nine input ports to the common output
port.

• When used in the bidirectional mode, the output wavelength from the COM-RX port is split to manage
the express and drop wavelengths.

• When used in the demultiplexer mode, the 80-WXC-C card, allows selection of a single wavelength or
a combination of wavelengths from the common input port to any of the nine output ports.

• Automatic VOA shutdown (AVS) blocking state on each wavelength and port.

• Per-channel (closed loop) power regulation on the output port based on OCM block feedback.

• Per-channel (open loop) attenuation regulation on the output port which is not based on the OCM feedback.

The OCM unit provides per-channel optical power monitoring on the following ports:

• COM port in output direction

• COM port in input direction

• DROP-TX port in output direction

• Eight Express/Add/Drop (EAD) ports and one Add/Drop (AD) port in both input and output directions

The 80-WXC-C card has 14 types of ports:

• MON: The MON port monitors power on the COM T/R port.

• COM RX: The COM RX port receives the optical signal from a preamplifier (such as the OPT-PRE)
and sends it to the optical splitter.

• DROP TX: In the bidirectional mode, the DROP TX port sends the optical signal to the demultiplexer.

• EXP TX: The EXP TX port sends the split off optical signal that contains pass-through channels to the
other side of the NE.

• COM T/R: The COM port is bidirectional. It functions as a COM TX port in the multiplexer mode and
as a COM RX port in the demultiplexer mode.

• AD T/R: The AD port functions as ADD RX port in bidirectional and multiplexer modes and as a DROP
port in the demultiplexer mode.
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• EAD T/R i (where i = 1 to 8): The EAD ports function as EXP ports in the bidirectional mode, as ADD
ports in the multiplexer mode, and as DROP ports in the demultiplexer mode.

The different units of the 80-WXC-C card are:

• 40/60 splitter with VOA on drop path—The preamplifier output signal from the preamplifier is split in
a 40%-to-60% ratio; 40% is sent on the drop path (DROP-TX port) and 60% is sent on the pass-through
path (EXP-TX port). The VOA equipped on the drop path is used to match the power range of the receiver
photodiode without the need for bulk attenuation. If a channel is expected to be dropped in the 80-WXC-C
card, the pass-through channel is stopped after the EXP-TX port either by a 40-WSS-C or a 40-WXC-C
card.

• 50 Ghz 10 port WXC—The WXC block is optically passive and has bidirectional capability. The WXC
block can selectively send any wavelength combination coming from the eight input EAD ports and one
AD port to a common (COM) output port, when used as a multiplexer, whereas it can selectively send
any wavelength combination coming from its common (COM) input port to any of the eight output EAD
ports and one AD port, when used as a demultiplexer. The WXC block can manage (on each port) up to
80 channels according to the channel grid reported in Table 58: 80-WXC-C Channel Plan, on page 97.
Each channel can be selected from any input and routed to any output.

• 50 Ghz Optical Channel Monitor (OCM)—The OCM provides per channel power monitoring on the
COMT/R, DROP-TX, AD, and EADi (i=1 to 8) ports. The power value for each wavelength is refreshed
after a variable timer depending on the port and card activity.

For instructions on proper handling of the 80-WXC-C card, see 80-WXC-C Card Handling.

For more information about the 80-WXC-C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/datasheet_c78-598521.html.

80-WXC-C Power Monitoring
The 80-WXC-C has two physical photodiodes and an OCM unit that monitors power at the different ports of
the card. The following table describes the physical photodiodes.

Table 56: 80-WXC-C Port Calibration

Calibrated to Port(s)CTC Type NamePhysical
Photodiode

COMCOM Total PowerPD1

EXP-TXEXP-TX Total PowerPD2

EAD-1EAD 1 Per-Channel and Total PowerOCM1

EAD-2EAD 2 Per-Channel and Total PowerOCM2

EAD-3EAD 3 Per-Channel and Total PowerOCM3

EAD-4EAD 4 Per-Channel and Total PowerOCM4

EAD-5EAD 5 Per-Channel and Total PowerOCM5

EAD-6EAD 6 Per-Channel and Total PowerOCM6
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Calibrated to Port(s)CTC Type NamePhysical
Photodiode

EAD-7EAD 7 Per-Channel and Total PowerOCM7

EAD-8EAD 8 Per-Channel and Total PowerOCM8

ADAD Per-Channel and Total PowerOCM9

COMOutput Per-Channel and Total PowerOCM10

COMInput Per-Channel and Total PowerOCM11

DROP-TXDrop Per-Channel and Total PowerOCM12

For information on the associated TL1 AIDs for the optical power monitoring points, see the “CTC Port
Numbers and TL1 Aids” section in the Cisco ONS SONET TL1 Command Guide.

Additionally, the 80-WXC-C has two virtual photodiodes. The following table lists the virtual photodiodes.

Table 57: 80-WXC-C Virtual Photodiode Port Calibration

Calibrated to Port(s)CTC Type NameVirtual
Photodiode

DROP-TXDROP-TX Total PowerVPD3

COM-RXCOM-RX Total PowerVPD4

80-WXC-C Channel Plan
The following table shows the 80 ITU-T 50-GHz-spaced, C-band channels (wavelengths) that are cross
connected by the 80-WXC-C card.

Table 58: 80-WXC-C Channel Plan

Wavelength
(nm)

Frequency (THz)Channel LabelBand ID

1529.55196-Ch. 06
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Wavelength
(nm)

Frequency (THz)Channel LabelBand ID

1530.33195.930.330.3

1530.72195.8530.7

1531.12195.831.1

1531.51195.7531.5

1531.90195.731.9

1532.29195.6532.3

1532.68195.632.7

1533.07195.5533.1

1533.47195.533.5

1533.86195.4533.9

1534.25195.434.334.3

1534.64195.3534.6

1535.04195.335.0

1535.43195.2535.4

1535.82195.235.8

1536.22195.1536.2

1536.61195.136.6

1537195.0537.0

1537.4019537.4

1537.79194.9537.8
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Wavelength
(nm)

Frequency (THz)Channel LabelBand ID

1538.19194.938.238.2

1538.58194.8538.6

1538.98194.839.0

1539.37194.7539.4

1539.77194.739.8

1540.16194.6540.2

1540.56194.640.6

1540.95194.5541.0

1541.35194.541.3

1541.75194.4541.7

1542.14194.442.142.1

1542.94194.3542.5

1542.94194.342.9

1543.33194.2543.3

1543.73194.243.7

1544.13194.1544.1

1544.53194.144.5

1544.92194.0544.9

1545.3219445.3

1545.72193.9545.7
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Wavelength
(nm)

Frequency (THz)Channel LabelBand ID

1546.12193.946.146.1

1546.52193.8546.5

1546.92193.846.9

1547.32193.7547.3

1547.72193.747.7

1548.11193.6548.1

1548.51193.648.5

1548.91193.5548.9

1549.32193.549.3

1549.72193.4549.7

1550.12193.450.150.1

1550.52193.3550.5

1550.92193.350.9

1551.32193.2551.3

1551.72193.251.7

1552.12193.1552.1

1552.52193.152.5

1552.93193.0552.9

1553.3319353.3

1553.73192.9553.7
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Wavelength
(nm)

Frequency (THz)Channel LabelBand ID

1554.13192.954.154.1

1554.54192.8554.5

1554.94192.854.9

1555.34192.7555.3

1555.75192.755.7

1556.15192.6556.2

1556.55192.656.6

1556.96192.5557.0

1557.36192.557.4

1557.77192.4557.8

1558.17192.458.258.2

1558.58192.3558.6

1558.98192.359.0

1559.39192.2559.4

1559.79192.259.8

1560.20192.1560.2

1560.61192.160.6

1561.01192.0561.0

1561.4219261.4

1561.83191.9561.8

6 This channel is unused by the 80-WXC-C

Related Procedures for 80-WXC-C Card
The following section lists procedures and tasks related to the configuration of the 80-WXC-C card:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G185 Installing Fiber-Optic Cables between Mesh Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup
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• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G174 Modifying Line Settings and PM Thresholds for 40-WXC-C, 80-WXC-C, or 16-WXC-FS
Cards

16-WXC-FS Card
The 16-WXC-FS card is a double-slot cross connect card, tunable over 96 channels in the C-band, at 50-GHz
spacing on the ITU-T grid. The card provides the flex spectrum capability, which allows the user the flexibility
to allocate the channel bandwidth, to increase the network scalability. The channel bandwidth is not fixed,
but can be defined arbitrarily, with a given granularity and within a given range. Attenuation and power values
are defined for each sub-range. The central frequency ranges from 191'350 Ghz (1566 .72 nm) to 196'100
Ghz (1528 .77 nm).

The 16-WXC-FS card can be used in point-to-point, ring, multi-ring, or mesh topologies. The 16-WXC-FS
card supports up to 16 directions for each ROADMnode. The card is optically passive and provides bidirectional
capability. It can be installed in slots 2, 4, or 6 in the Cisco ONS 15454 M6 chassis. It is recommended that
you use the 16-WXC-FS card in slot 4 when used with EDRA amplifiers to comply with optical safety. It is
recommended that you use the 16-WXC-FS card and the EDRA-2-xx card in slots 2 and 4, 5 and 7, 8 and 10,
11 and 13 of the Cisco ONS 15454 M15 chassis.

In the Cisco ONS 15454 M6 chassis, the 16-WXC-FS card front panel has two compression latch devices.
These latches enforce the position of the unit in the chassis. To insert or remove a card from the Cisco ONS
15454M6 chassis, rotate the compression latches fully in the anti-clockwise direction. After the card is inserted
or removed, close the unit and rotate the compression latches fully in the clockwise direction.

Important

For more information about the 16-WXC-FS card, see Cisco NCS 2000 16-port Flex Spectrum ROADMLine
Card Data Sheet

Limitations

• The 16-WXC-FS card is not compatible with 15454 -M6-FTA fan tray assembly; the card is compatible
with 15454 -M6-FTA2 fan tray assembly or a subsequent fan tray assembly release.

16-WXC-FS Ports
The 16-WXC-FS card has these ports:

• EXP-TXi (where i = 1 to 16)—The EXP TX port sends the split-off optical signal that contains
pass-through channels to the other side of the NE. For example, in four degrees setup, the EXP ports can
be used as drop Tx ports, EXP-Tx(1 to 4) are used as express channel from one side to other side. The
5th to 16th EXP-Tx ports are used to transmit the power to passive units.
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• EXP-RXi (where i = 1 to 16)—The EXP RX port receives the optical signal from the pass-through
channels. For example, in four degrees setup, the EXP ports can be used as drop Rx ports, EXP-Rx(1 to
4) are used to receive power from the express channel from one side to other. The 5th to 16th EXP-Rx
ports are used to receive the power from the passive units.

• COM-TX—The COM TX port transmits the combined power from all directions or add drop ports
towards the amplifier card.

• COM-RX—The COM RX port receives the optical signal from a preamplifier card and sends it to the
optical cross connect.

• UPG-TX—The UPG TX port can be used to drop channels and transmits power to the preamplifier card.
This port can also be used to increase the number of ports by connecting to another 16-WXC-FS card.

• UPG-RX-The UPG RX port can be used to add channels and receives power from the preamamplifer
card. This port can also be used to increase the number of ports by connecting to another 16-WXC-FS
card.

Two LC-duplex adapters are required to connect COM and UPG ports, and four MPO connectors to connect
add/drop ports of the 16-WXC card. All the 16 I/O ports of the 16-WXC-FS card can be used either for node
interconnection or for add/drop.

Key Features
The 16-WXC-FS card provides these features when used in multiplexer mode:

• The card allows you to select a single 50-GHz spaced channel or any combination of the aggregated 96
channels grid on the COM-TX port.

• The combination of input signals from the 16 EXP-RX ports and the UPG-RX port into COM-TX port.

• The selection of an arbitrary wavelength range or different wavelength ranges, with a common insertion
loss value on the COM-TX port.

• Automatic VOA shutdown (AVS) blocking state on each wavelength on the COM-TX port.

• Per-channel (closed loop) power regulation on the COM-TX output port based on OCM block feedback.

• Per-channel (open loop) attenuation regulation on the EXP-TX output port, which is not based on the
OCM feedback.

The 16-WXC-FS card provides these features when used in de-multiplexer mode:

• The card allows you to select a single 50-GHz spaced channel or any combination of the aggregated 96
channels grid on any of the 16 EXP-TX port.

• Splitting of the input signal from COM-RX port into a total of 16 EXP-TX ports and 1 UPG-TX port.

• AVS blocking state on each wavelength on any of the 16 EXP-TX ports.

• Per-channel (closed loop) power regulation on the EXP-TX output port based on OCM block feedback.

• Per-channel (open loop) attenuation regulation on the EXP-TX output port which is not based on the
OCM feedback.

• Selection of an arbitrary wavelength range or of different wavelength ranges, with a common insertion
loss value on any of the 16 EXP-TX ports.
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• DWDM Optical amplifier(s) partially compensates the loss of couplers or splitters and wavelength
blockers.

16-WXC-FS Power Monitoring
The 16-WXC-FS card has two physical photodiodes and an OCM unit that monitors power at the different
ports of the card.

Table 59: 16-WXC-FS Port Calibration

Calibrated to Port(s)CTC Type NamePhysical
Photodiode

COM-RXCOM-RX Total Input PowerPD1

COM-TXCOM-TX Total Output PowerPD2

COM-RXCOM-RX Per-Channel and Input PowerOCM1

COM-TXCOM-TX Per-Channel and Output PowerOCM2

EXP-TXDe-MUX Output PortsOCM3 to
OCM18

EXP-RXMUX Input PortsOCM19 to
OCM34

UPG-TXDe-MUX Output PortsOCM35

UPG-RXMUX Input PortsOCM36

For information on associated TL1 AIDs for the optical power monitoring points, see the “CTC Port Numbers
and TL1 Aids” section in the Cisco ONS SONET TL1 Command Guide.

The OCM unit provides per-channel optical power monitoring on these ports:

• COM-TX and COM-RX ports

• UPG-TX and UPG-RX ports

• EXP-TXi (where i = 1 to 16) ports in output direction

• EXP-RXi (where i = 1 to 16) ports in input direction
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Task Flow Diagram of 16-WXC-FS Card
Figure 9: Task Flow Diagram of 16-WXC-FS Card

Related Procedures for 16-WXC-FS Card
The following section lists procedures and tasks related to the configuration of the 16-WXC-FS card:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G185 Installing Fiber-Optic Cables between Mesh Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards
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• NTP-G174 Modifying Line Settings and PM Thresholds for 40-WXC-C, 80-WXC-C, or 16-WXC-FS
Cards

Single Module ROADM (SMR-C) Cards

For 40-SMR1-C and 40-SMR2-C safety label information, see the Safety Labels.Note

The single-slot 40-channel single module ROADM (SMR-C) cards integrate the following functional blocks
onto a single line card:

• Optical preamplifier

• Optical booster amplifier

• Optical service channel (OSC) filter

• 2x1 wavelength cross-connect (WXC) or a 4x1 WXC

• Optical channel monitor (OCM)

The SMR-C cards are available in two versions:

• 40-SMR1-C Card

• 40-SMR2-C Card

The SMR-C cards can manage up to 40 channels spaced at 100GHz on each port according to the channel
grid in Table 10-10. The cards can be installed in Slots 1 to 6 and 12 to 17.

For more information about the 40-SMR1-C or 40-SMR2-C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-578552.html.

SMR-C Card Key Features
The optical amplifier units in the SMR-C cards provide the following features:

• Embedded gain flattening filter

• Mid-stage access for dispersion compensation unit (only applicable for preamplifier erbium-doped fiber
amplifier [EDFA])

• Fixed output power mode

• Fixed gain mode

• Nondistorting low-frequency transfer function

• Amplified spontaneous emissions (ASE) compensation in fixed gain and fixed output power mode

• Fast transient suppression

• Programmable tilt (only applicable for preamplifier EDFA)
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• Full monitoring and alarm handling capability

• Optical safety support through signal loss detection and alarm at any input port, fast power down control,
and reduced maximum output power in safe power mode.

• EDFA section calculates the signal power, by taking into account the expected ASE power contribution
to the total output power. The signal output power or the signal gain can be used as feedback signals for
the EDFA pump power control loop.

The 1x2 WXC unit (40-SMR1-C card) provides the following features:

• Selection of individual wavelength of the aggregated 100GHz signal from either the EXP-RX or ADD-RX
ports

• Automatic VOA shutdown (AVS) blocking state on each wavelength and port

• Per-channel power regulation based on external OCM unit

• Open loop path attenuation control for each wavelength and port

The 1x4 WXC unit (40-SMR2-C card) provides the following features:

• Selection of individual wavelength of the aggregated 100GHz signal from either the EXPi-RX (where i
= 1, 2, 3) or ADD-RX ports

• Automatic VOA shutdown (AVS) blocking state on each wavelength and port

• Per-channel power regulation based on external OCM unit

• Open loop path attenuation control for each wavelength and port

TheOCMunit provides per channel optical powermonitoring at EXP-RX,ADD-RX,DROP-TX, and LINE-TX
ports.

40-SMR1-C Card
The 40-SMR1-C card includes a 100Ghz 1x2 WXC unit with integrated preamplifier unit (single EDFA).

The 40-SMR1-C card has the following types of ports:

• MON RX: The MON RX port monitors power on the EXP-TX output port.

• MON TX: The MON TX port monitors power on the LINE-TX output port.

• DC RX: The DC RX port receives the optical signal from the dispersion compensating unit (DCU) and
sends it to the second stage preamplifier input.

• DC TX: The DC TX port sends the optical signal from the first stage preamplifier output to the DCU.

• OSC RX: The OSC RX port is the OSC add input port.

• OSC TX: The OSC TX port is the OSC drop output port.

• ADD/DROP RX: The ADD RX port receives the optical signal from the multiplexer section of the NE
and sends it to the 1x2 WXC unit.

• ADD/DROP TX: The DROP TX port sends the split off optical signal to the demultiplexer section of
the NE.
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• LINE RX: The LINE RX port is the input signal port.

• LINE TX: The LINE TX port is the output signal port.

• EXP RX: The EXP RX port receives the optical signal from the other side of the NE and sends it to the
1x2 WXC unit.

• EXP TX: The EXP TX port sends the split off optical signal that contains pass-through channels to the
other side of the NE.

The following figure shows a block diagram of the 40-SMR1-C card.

Figure 10: 40-SMR1-C Block Diagram

The different units of the 40-SMR1-C card are:

• OSC filter—The OSC filter allows to add an OSC channel to the C-band in the transmission path and to
drop an OSC channel on the receiving path. The OSCM card that is connected to the OSC-TX and
OSC-RX ports generates the OSC channel.

• Double-stage variable gain EDFA preamplifier—The double-stage preamplifier allows the insertion of
a DCU between the DC-TX andDC-RX ports to compensate for chromatic dispersion. It is also equipped
with built-in variable optical attenuator (VOA) and gain flattening filter (GFF) that provides tilt
compensation and enables the use of this device over an extended range of span losses (5 dB to 35 dB).

• 70/30 splitter and VOA—The output signal from the preamplifier is split in a 70%-to-30% ratio, 70% is
sent on the pass-through path (EXP-TX port) and 30% is sent on the drop path (DROP-TX port). The
VOA equipped on the drop path is used to match the power range of the receiver photo diode without
the need for bulk attenuation. If a channel is expected to be dropped in the 40-SMR1-C card, the
pass-through channel is stopped after the EXP-TX port either by a 40-WSS-C, 40-SMR1-C, or 40-SMR2-C
card.
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• 1x2 WXC—The 1x2 WXC aggregates on its output port a 100-GHz-spaced optical channel received
from either its ADD-RX or EXP-RX port. In addition to the switching function, the 1x2 WXC allows to
set a different per channel power for each of the managed wavelengths and also monitor the optical
power.

• OCM—The OCM provides per channel power monitoring on the DROP-RX, EXP-RX, ADD-RX, and
LINE-TX ports. The power value for each wavelength is refreshed after a variable timer depending on
the port and card activity.

You can install the 40-SMR1-C card in the following slots.

• Slots 2 and 3 in ONS 15454 M2

• Slots 2 to 7 in ONS 15454 M6

• Slots 2 to 7 in NCS 2015.

40-SMR1-C Power Monitoring
The 40-SMR1-C card has seven physical diodes (PD1 through PD6 and PD8) and an OCM unit that monitors
power at the input and output ports of the card (see the following table).

Table 60: 40-SMR1-C Port Calibration

Calibrated to Port(s)CTC Type NamePhysical
Photodiode

LINE-RXLINEPD1

LINE-RXLINEPD2

DC-TXDCPD3

DC-RXDCPD4

EXP-TXEXPPD5

OSC-RXOSCPD6

LINE-TXLINEPD8

DROP-TXLINE OCHOCM1

EXP-RXDROP OCHOCM2

ADD-RXADD OCHOCM3

LINE-TXEXP OCHOCM4

40-SMR1-C Channel Plan
Table 49: Channel Allocation Plan, on page 82 shows the 40 ITU-T 100-GHz-spaced, C-band channels
(wavelengths) supported by the 40-SMR1-C card.
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40-SMR2-C Card
The 40-SMR2-C card includes a 100Ghz 1x4 WXC unit with integrated preamplifier and booster amplifier
units (double EDFA).

The 40-SMR2-C card has the following types of ports:

• MON RX: The MON RX port monitors power on the EXP-TX output port.

• MON TX: The MON TX port monitors power on the LINE-TX output port.

• DC RX: The DC RX port receives the optical signal from the dispersion compensating unit (DCU) and
sends it to the second stage preamplifier input.

• DC TX: The DC TX port sends the optical signal from the first stage preamplifier output to the DCU.

• OSC RX: The OSC RX port is the OSC add input port.

• OSC TX: The OSC TX port is the OSC drop output port.

• ADD/DROP RX: The ADD RX port receives the optical signal from the multiplexer section of the NE
and sends it to the 1x4 WXC unit.

• ADD/DROP TX: The DROP TX port sends the split off optical signal to the demultiplexer section of
the NE.

• LINE RX: The LINE RX port is the input signal port.

• LINE TX: The LINE TX port is the output signal port.

• EXP TX: The EXP TX port sends the split off optical signal that contains pass-through channels to the
other side of the NE.

• EXPi-RX (where i = 1, 2, 3): The EXPi-RX port receives the optical signal from the other side of the
NE and sends it to the 1x4 WXC unit.

The following figure shows a block diagram of the 40-SMR2-C card.
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Figure 11: 40-SMR2-C Block Diagram

The different units of the 40-SMR2-C card are:

• OSC filter—The OSC filter allows to add an OSC channel to the C-band in the transmission path and to
drop an OSC channel on the receiving path. The OSCM card that is connected to the OSC-TX and
OSC-RX ports generates the OSC channel.

• Double-stage variable gain EDFA preamplifier—The double-stage preamplifier allows the insertion of
a DCU between the DC-TX andDC-RX ports to compensate for chromatic dispersion. It is also equipped
with built-in variable optical attenuator (VOA) and gain flattening filter (GFF) that provides tilt
compensation and enables the use of this device over an extended range of span losses (5 dB to 35 dB).

• 70/30 splitter and VOA—The output signal from the preamplifier is split in a 70%-to-30% ratio, 70% is
sent on the pass-through path (EXP-TX port) and 30% is sent on the drop path (DROP-TX port). The
VOA equipped on the drop path is used to match the power range of the receiver photo diode without
the need for bulk attenuation. If a channel is expected to be dropped in the 40-SMR2-C card, the
pass-through channel is stopped after the EXP-TX port by a 40-WSS-C, 40-SMR1-C, or 40-SMR2-C
card.

• 1x4 WXC—The 1x4 WXC aggregates on its output port a 100-GHz-spaced optical channel received
from either its ADD-RX or EXPi-RX (where i = 1, 2, 3) port. In addition to the switching function, the
1x4 WXC allows to set a different per channel power for each of the managed wavelengths and also
monitor the optical power.
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• Single-stage fixed gain EDFA booster amplifier—The booster amplifier amplifies the output signal from
the 1x4 WXC unit before transmitting it into the fiber. Since it is a fixed gain (17 dB) amplifier, it does
not allow gain tilt control.

• OCM—The OCM provides per channel power monitoring on the DROP-RX, EXPi-RX (where i = 1, 2,
3), ADD-RX, and LINE-TX ports. The power value for each wavelength is refreshed after a variable
timer depending on the port and card activity.

You can install the 40-SMR2-C card in the following slots.

• Slots 2 and 3 in ONS 15454 M2

• Slots 2 to 7 in ONS 15454 M6

• Slots 2 to 7 in NCS 2015.

40-SMR2-C Power Monitoring
The 40-SMR2-C card has eight physical diodes (PD1 through PD8) and an OCM unit that monitors power at
the input and output ports of the card (see the following table).

Table 61: 40-SMR2-C Port Calibration

Calibrated to Port(s)CTC Type NamePhysical
Photodiode

LINE-RXLINEPD1

LINE-RXLINEPD2

DC-TXDCPD3

DC-RXDCPD4

EXP-TXEXPPD5

OSC-RXOSCPD6

Internal portNot reported on CTCPD7

LINE-TXLINEPD8

LINE-TXLINE OCHOCM1

DROP-TXDROP OCHOCM2

ADD-RXADD OCHOCM3

EXP1-RXEXP-1 OCHOCM4

EXP2-RXEXP-2 OCHOCM5

EXP3-RXEXP-3 OCHOCM6
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40-SMR2-C Channel Plan
Table 49: Channel Allocation Plan, on page 82 shows the 40 ITU-T 100-GHz-spaced, C-band channels
(wavelengths) supported by the 40-SMR2-C card.

Related Procedures for 40-SMR1-C and 40-SMR2-C Card
The following section lists procedures and tasks related to the configuration of the 40-SMR-1C and 40-SMR-2C
cards:

• NTP-G140 Installing Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes

• NTP-G185 Installing Fiber-Optic Cables between Mesh Nodes

• NTP-G152 Creating and Verifying Internal Patchcords

• NTP-G37 Running Automatic Node Setup

• NTP-G243 Performing the Two-Degree ROADM Node with 40-SMR-1-C and OPT-AMP-17-C Cards
Acceptance Test

• NTP-G244 Performing the Four Degree ROADM Node with 40-SMR-2-C Cards Acceptance Test

• NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections

• NTP-G51 Verify DWDM Node Turn Up

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 40-MUX-C, 40-DMX-C,
and 40-DMX-CE Cards

• NTP-G241 Modifying the Line Settings and PM Thresholds for 40-SMR1-C and 40-SMR2-C Cards

17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV Cards
The 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV cards are tunable over 96
channels in the C-band, at 50-GHz spacing on the ITU-T grid. The cards provide the flex spectrum capability,
which give the flexibility to allocate channel bandwidth, to increase the network scalability. The channel
bandwidth is not fixed, but can be defined arbitrarily, with a specified granularity and within a given range.
For each sub-range, attenuation and power values are defined. The central frequency ranges from 191350
Ghz (1566 .72 nm) to 196100 Ghz (1528 .77 nm).

The 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV cards are single-slot cards that
integrate two cross-connect blocks (multiplexer and demultiplexer), a variable gain EDFA pre-amplifier, and
a variable gain EDFA booster amplifier. In addition, the SMR20 FS CV card has a dedicated laser source at
the demultiplexer section, and a photodiode at the multiplexer section; these support the connection verification
capability. The 17 SMR9 FS, 24 SMR9 FS, and 34 SMR9 FS cards support up to 9 directions for each ROADM
node. The SMR20 FS/SMR20 FS CV card support up to 20 directions for each ROADM node. The cards can
be installed in any service slot in the Cisco ONS 15454 M2, ONS 15454 M6, and the NCS 2015 chassis. The
cards can be used in point-to-point, ring, multi-ring, or mesh topologies.

The SMR20 FS CV cards provide the connection verification capability using a connectivity check signal.
The correctness and the quality of the interconnections (determined by measuring the insertion loss of the
external passive path) can be validated with the connection verification feature in the cards . For more
information about the connection verification, see Connection Verification section.
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The EDFA pre-amplifier in SMR20 FS/SMR20 FS CV cards have switchable gain ranges. The following
table describes the gain ranges and extended gain ranges of a EDFA pre-amplifier in the 17 SMR9 FS, 24
SMR9 FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV cards.

Table 62: Gain Ranges and Extended Gain Ranges of EDFA Pre-Amplifier

Extended Gain RangeGain RangeCard

20 dB with uncontrolled tilt0 - 17 dB with controlled tilt17 SMR9 FS

27 dB with uncontrolled tilt12 - 24 dB with controlled tilt24 SMR9 FS

40 dB with uncontrolled tilt20 - 34 dB with controlled tilt34 SMR9 FS

20 dB with uncontrolled tiltGain Range 1: 0 - 17 dB with
controlled tilt

SMR20 FS/SMR20 FS CV

35 dB with uncontrolled tiltGain Range 2: 12 - 24 dB with
controlled tilt

For more information, such as the block diagrams and the card specifications of the 17 SMR9 FS, 24 SMR9
FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV cards, see the data sheet.

SMR9 FS Ports
The SMR9 FS card has these ports:

• EXP-TXi (where i = 1 to 9)—The EXP TX port sends the split-off optical signal that contains pass-through
channels to the other side of the NE. For example, in four degrees setup, the EXP ports can be used as
drop Tx ports, EXP-Tx(1 to 4) are used as express channels from one side to other side. The 5th to 9th
EXP-Tx ports are used to transmit power to passive units.

• EXP-RXi (where i = 1 to 9)—The EXPRX port receives the optical signal from the pass-through channels.
For example, in the four degrees setup, the EXP ports can be used as drop Rx ports, EXP-Rx(1 to 4) are
used to receive power from the express channel, from one side to other. The 5th to 9th EXP-Rx ports are
used to receive power from passive units.

• OSC-TX— The OSC-TX port transmits the Service Channel signal received from the LINE-RX port
signal, separating it from the C-Band signals.

• OSC-RX— The OSC-RX port receives signal from the Service Channel module and transmits it to the
LINE-TX port.

• COM-TX—The COM TX port transmits the combined power from all the directions or add drop ports
towards the amplifier.

• COM-RX— The COM RX port receives the optical signal from the pre-amplifier and sends it to the
optical cross connect.

The COM-TX and COM-RX ports are not physical ports on the faceplate. These
ports are represented in CTC.

Note
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• LINE-TX— The booster amplifier amplifies the composite signal coming from WXC-MUX towards
the LINE-TX port.

• LINE-RX— The pre amplifier amplifies the composite signal coming from the LINE-RX port towards
the WXC-DMX input.

20-SMRFS and 20-SMRFS-CV Ports
The 20-SMRFS and 20-SMRFS-CV cards have these ports:

• OSC-TX—The OSC-TX port transmits the Optical Service Channel signal that is received from the
LINE-RX port signal to the controller card, separating it from the C-Band signals.

• OSC-RX—The OSC-RX port receives Optical Service Channel signal from the Controller Card and
transmits it to the LINE-TX port.

• COM-TX—The COM TX port transmits the combined power from all directions or add or drop ports
toward the booster amplifier.

• COM-RX—The COM RX port receives the optical signal from the pre-amplifier and sends it to the
optical cross connect.

The COM-TX and COM-RX ports are not physical ports on the faceplate.Note

• LINE-TX—This port sends the optical signal from the local node to the far end node.

• LINE-RX—This port receives the optical signal from the far end node.

Key Features
The multiplexer section of the 9-SMR17FS, 9-SMR24FS, 9-SMR34FS, 20-SMRFS, and 20-SMRFS-CV
cards provide the following features:

• Selection of any arbitrary wavelength range from any EXP-RXi ports and routing to the MUX output
port.

• Automatic VOA shutdown (AVS) blocking state on each wavelength on the MUX output port.

• Per-channel (closed loop) power regulation on the MUX output port based on OCM block feedback.

• Per-channel (open loop) attenuation regulation on the MUX output port, which is not based on the OCM
feedback.

• Amplification of the aggregated C-Band signal toward the LINE-TX port by the variable gain booster
EDFA amplifier.

• Combination of C-Band signals with 1510 nm by OSC MUX filter.

• Detection of the connectivity check signal, of wavelength 97 nm, by an embedded photodiode.

The demultiplexer section of the 9-SMR17FS, 9-SMR24FS, 9-SMR34FS, 20-SMRFS, and 20-SMRFS-CV
cards provide the following features:

• Selection of any arbitrary wavelength range and routing to any EXP-TXi port.
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• AVS blocking state on each wavelength, on any of the EXP-TXi ports.

• Per-channel (closed loop) power regulation on the EXP-TXi output port based on OCM block feedback.

• Per-channel (open loop) attenuation regulation on the EXP-TXi output port, which is not based on the
OCM feedback.

• Amplification of the C-Band signals entering the LINE-RX port by the pre-amplifier.

• Separation of C-Band signals from 1510 nm by OSC De-MUX filter.

• Generation and transmission of the connectivity check signal into the DE-MUX input port.

Connection Verification
The SMR20 FS CV cards provide the connection verification feature. This feature measures power levels and
verifies the optical cables and patchcords in a node for:

• Connectivity: Checks whether the cable is connected.

• Insertion Loss: Checks whether the cable loss is within expected value.

A 1567 nm connectivity check signal is generated and transmitted into the DE-MUX input port by a dedicated
laser source. This signal, in turn, is detected by an embedded photo diode to complete the verification. The
highlights of this feature are:

• It validates the SMR20 FS CV card connection with other nodes or local Add/Drop elements.

• It detects any incorrect cabling of the ROADM network element.

• It collects insertion losses of every possible optical path inside the network element, in order to predict
any possible failure.

• It verifies the connection every six hours, by default. Refer to http://www.cisco.com/c/en/us/td/docs/
optical/15000r10_0/ncs/network_config/guide/b_ncs_network_configuration/b_ncs_network_
configuration_chapter_010000.html#task_8B1E0075021B4A7EBCAC85FD09C02AC8 for manual
validation of the SMR20 FS CV interconnections.

In releases earlier to Release 10.8, the Connection Verification (CV) procedure terminates when the CV and
circuit creation procedures that use the samewavelength, run concurrently on CV enabled cards. Thewavelength
that was used for CV is then auto-provisioned due to which the circuit creation uses a different wavelength.

Note

Connection Verification Prerequisites
The connection verification works only if the following conditions are fulfilled:

• Flex nodes must be present for the connection verification to work.

• Loopback caps must be installed on all the unused ports of the passive modules.

• At least one SMR20 FS CV card must be present in the node.

• All sides of the node must have a SMR20 FS CV card to test all cables and patchcords.
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• All passive modules must be connected with an USB cable and associated, so that power readings can
be calculated.

Supported Cards
The cards that supports connection verification are as follow:

• 16-AD-FS

• SMR20 FS CV

• MF-DEG-5 and MF-DEG-5-CV

• MF-MPO-16LC and MF-MPO-16LC-CV

• MF-PPMESH8-5AD

• MF-UPG-4 and MF-UPG-4-CV

• 100GC-CK-LC and 200G-CK-LC

• Other MXP and TXP cards support CV partially; these cards support the
CV for the patch cords belonging to paths going from TXP card trunk port
to SMR20-FS-CV EXP-RX ports and not for the patch cords belonging to
path in the opposite direction.

• MF-DEG-5, MF-DEG-5-CV, MF-MPO-16LC, MF-MPO-16LC-CV,
MF-PPMESH8-5AD, MF-UPG-4, and MF-UPG-4-CV cards require
loopback caps on unused ports. The (-CV) version is shipped with the
loopback pre-installed.

Note

Running the Connection Verification
The connection verification runs:

• Automatically at these time intervals and events:

• 20 minutes after first shelf controller boot or reboot

• One minute after enabling the connection verification

• Ten minutes after new patch-cord creation or deletion (*)

• Ten minutes after new circuit creation or deletion (*)

• Every six hours

• For manual execution of connection verification, refer to http://www.cisco.com/c/en/us/td/docs/optical/
15000r10_0/ncs/network_config/guide/b_ncs_network_configuration/b_ncs_network_configuration_
chapter_010000.html#task_8B1E0075021B4A7EBCAC85FD09C02AC8.

(*) indicates that this condition occurs only after an automatic run is interrupted by the creation or deletion
of a circuit or a patch cord.
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PIDs of 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV Cards
The following table lists the PIDs and descriptions of the 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and
SMR20 FS/SMR20 FS CV cards.

DescriptionPID

9 port Single Module ROADM - 0-17 dB Gain - Flex SpectrumNCS2K-9-SMR17FS=

9 port SingleModule ROADM - 12-24 dBGain - Flex SpectrumNCS2K-9-SMR24FS=

9 port SingleModule ROADM - 20-34 dBGain - Flex SpectrumNCS2K-9-SMR34FS=

20 port Single Module ROADM - Switchable Gain - Flex
Spectrum

NCS2K-20-SMRFS=

20 port Single Module ROADM - Switchable Gain Flex
Spectrum with Connection Verification

NCS2K-20-SMRFS-CV=

9 port Single Module ROADM - 0-17 dB Gain - LicensedNCS2K-9-SMR17FS-L=

9 port Single Module ROADM - 12-24 dB Gain - LicensedNCS2K-9-SMR24FS-L=

9 port Single Module ROADM - 20-34 dB Gain - LicensedNCS2K-9-SMR34FS-L=

20 port Single Module ROADM - Switchable Gain - Flex
Spectrum - Licensed

NCS2K-20-SMRFS-L=

License PID to enable Flex Spectrum capability for the 17 SMR9
FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS cards. NCS
Flex package is required to use this license.

L-NCS2K-SMR-FS=

License PID to enable two EXP-TX/EXP-RX ports on the 17
SMR9 FS, 24 SMR9 FS, or 34 SMR9 FS cards.

L-NCS2K-SMR-2P=

License PID to enable four EXP-TX/EXP-RX ports on the
SMR20 FS card.

L-NCS2K-SMR-4P=

Related Procedures for 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV Cards
The following section lists procedures and tasks related to the configuration of the 17 SMR9 FS, 24 SMR9
FS, 34 SMR9 FS, and SMR20 FS/SMR20 FS CV cards:

• DLP-G325 Changing Optical Amplifier Line Settings

• DLP-G326 Changing Optical Amplifier Threshold Settings

• DLP-G406 Changing Card Optical Channel Parameters for 40-WXC-C, 80-WXC-C, 16-WXC-FS, 17
SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, SMR20 FS, or SMR20 FS CV Cards

• DLP-G407 Changing the Optical Channel Thresholds for 40-WXC-C, 80-WXC-C, 16-WXC-FS, 17
SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, SMR20 FS, or SMR20 FS CV Cards

• DLP-G408 Changing Optical Line Parameters for 40-WXC-C, 80-WXC-C, 16-WXC-FS, 17 SMR9 FS,
24 SMR9 FS, 34 SMR9 FS, SMR20 FS, or SMR20 FS CV Cards
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• DLP-G409 Changing the Optical Line Thresholds for 40-WXC-C, 80-WXC-C, 16-WXC-FS, 17 SMR9
FS, 24 SMR9 FS, 34 SMR9 FS, SMR20 FS, or SMR20 FS CV Cards

• DLP-G772 Viewing Wavelength Power for 16-WXC-FS, 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS,
SMR20 FS, or SMR20 FS CV Card

• DLP-G773 Creating a Flex Spectrum or ITU Circuit for 16-WXC-FS, 17 SMR9 FS, 24 SMR9 FS, 34
SMR9 FS, SMR20 FS, or SMR20 FS CV Card

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, 40-SMR2-C, 17 SMR9 FS, 24
SMR9 FS, 34 SMR9 FS, SMR20 FS, and SMR20 FS CV Cards

• DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O,32DMX,
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 16-WXC-FS, 17 SMR9 FS, 24 SMR9
FS, 34 SMR9 FS, SMR20 FS, SMR20 FS CV, 40-MUX-C, 40-DMX-C, and 40-DMX-CE Cards

MMU Card
(Cisco ONS 15454 only)

The single-slot Mesh Multi-Ring Upgrade Module (MMU) card supports multiring and mesh upgrades for
ROADM nodes in both the C-band and the L-band. Mesh/multiring upgrade is the capability to optically
bypass a given wavelength from one section of the network or ring to another one without requiring 3R
regeneration. In each node, you need to install one east MMU and one west MMU. The card can be installed
in Slots 1 through 6 and 12 through 17.

The MMU has six types of ports:

• EXP RX port: The EXP RX port receives the optical signal from the ROADM section available on the
NE.

• EXP TX port: The EXP TX port sends the optical signal to the ROADM section available on the NE.

• EXP-A RX port: The EXP-A RX port receives the optical signal from the ROADM section available on
other NEs or rings.

• EXP-A TX port: The EXP-A TX port sends the optical signal to the ROADM section available on other
NEs or rings.

• COM TX port: The COM TX port sends the optical signal to the fiber stage section.

• COM RX port: The COM RX port receives the optical signal from the fiber stage section.

For more information about the MMU card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd803fc502.html.

MMU Power Monitoring
Physical photodiodes P1 through P3 monitor the power for the MMU card. The returned power level values
are calibrated to the ports as shown in the following table. VP1 to VP3 are virtual photodiodes that have been
created by adding (by software computation) the relevant path insertion losses of the optical splitters (stored
in the module) to the real photodiode (P1 to P3) measurement.
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Table 63: MMU Port Calibration

Calibrated to PortCTC Type NamePhotodiode

EXP RX1 (EXP-RX)P1

EXP A RX5 (EXP A-RX)P2

EXP A TX6 (EXP A-TX)P3

EXP TX2 (EXP-TX)VP1

COM TX4 (COM-TX)VP2

COM RX3 (COM-RX)VP3

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC Port
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

Related Procedures for MMU Card
The following section lists procedures and tasks related to the configuration of the MMU card:

• NTP-G34 Installing Fiber-Optic Cables on DWDM Cards and DCUs

• NTP-G37 Running Automatic Node Setup

• NTP-G51 Verify DWDM Node Turn Up

• NTP-G149 Modifying the MMU Line Settings and PM Thresholds
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C H A P T E R 8
Provisioning Transponder and Muxponder Cards

This chapter describes transponder (TXP), muxponder (MXP), GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
ADM-10G, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100G-ME-C,100ME-CKC,
100GS-CK-LC, 400G-XP-LC, WSE, AR_MXP, AR_XP, and AR_XPE cards, as well as their associated
plug-in modules (Small Form-factor Pluggables [SFP, SFP+, XFP, CXP, or CFP module]). For card safety
and compliance information, see the Regulatory Compliance and Safety Information for Cisco ONS Products
document.

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

The cards and procedures described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454
M6, Cisco ONS 15454 M2 platforms, unless noted otherwise.

Note

In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card.

Note

Cisco ONS 15454 DWDM supports IBM's 5G DDR (Double Data Rate) InfiniBand interfaces.

5G DDR InfiniBand is referred to as IB_5G.

Note

• Card Overview, on page 123
• Safety Labels, on page 132
• Interface Classes, on page 132
• TXP_MR_10G Card, on page 139
• TXP_MR_10E Card, on page 141
• TXP_MR_2.5G and TXPP_MR_2.5G Cards, on page 145
• 40E-TXP-C and 40ME-TXP-C Cards, on page 148
• MXP_2.5G_10G Card, on page 148
• MXP_2.5G_10E Card, on page 150
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• MXP_2.5G_10E_C and MXP_2.5G_10E_L Cards, on page 153
• MXP_MR_2.5G and MXPP_MR_2.5G Cards, on page 158
• MXP_MR_10DME_C and MXP_MR_10DME_L Cards, on page 163
• 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards, on page 170
• GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards, on page 176
• ADM-10G Card, on page 198
• OTU2_XP Card, on page 214
• TXP_MR_10EX_C Card, on page 222
• MXP_2.5G_10EX_C card, on page 223
• MXP_MR_10DMEX_C Card, on page 228
• AR_MXP, AR_XP, and AR_XPE Cards, on page 235
• 100G-LC-C, 100G-ME-C, 100G-CK-C, 100GS-CK-LC, 100ME-CKC, and 200G-CK-LC Cards, on
page 256

• 10x10G-LC Card, on page 261
• CFP-LC Card, on page 264
• MR-MXP Card, on page 265
• Key Features of 100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC, 10x10G-LC, 100GS-CK-LC,
200G-CK-LC, CFP-LC, and MR-MXP Cards, on page 268

• Functions and Features, on page 277
• Related Procedures for 100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC, 10x10G-LC, CFP-LC,
100GS-CK-LC, 200G-CK-LC, and MR-MXP Cards, on page 278

• 400G-XP-LC Card, on page 278
• Supported MSM Configurations, on page 299
• WSE Card, on page 300
• MLSE UT, on page 306
• SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK Modules, on page 307
• NTP-G128 Managing Pluggable Port Modules, on page 307
• Transponder and Muxponder Protection Topologies, on page 323
• Path Diversion Support for Client Protection, on page 334
• NTP-G33 Creating a Y-Cable Protection Group, on page 334
• NTP-G199 Creating a Splitter Protection Group, on page 340
• NTP-G198 Creating 1+1 Protection for Cards, on page 342
• NTP-G98 Provisioning the 2.5GMultirate Transponder Card Line Settings and PMParameter Thresholds,
on page 344

• NTP-G96 Provisioning the 10GMultirate Transponder Card Line Settings, PMParameters, and Thresholds,
on page 368

• NTP-G292 Provisioning the 40G Multirate Transponder Card Line Settings, PM Parameters, and
Thresholds, on page 384

• NTP-G170 Provisioning theADM-10GCard Peer Group, Ethernet Settings, Line Settings, PMParameters,
and Thresholds, on page 400

• NTP-G333 Adding an ADM-10G Card to an Existing Topology, on page 425
• NTP-G97Modifying the 4x2.5GMuxponder Card Line Settings and PM Parameter Thresholds, on page
426

• NTP-G99 Modifying the 2.5G Data Muxponder Card Line Settings and PM Parameter Thresholds, on
page 447

• NTP-G148 Modifying the 10G Data Muxponder Card Line Settings and PM Parameter Thresholds, on
page 469
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• NTP-G293 Modifying the 40G Muxponder Card Line Settings and PM Parameter Thresholds, on page
479

• NTP-G281 Managing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Channel Group Settings,
on page 506

• NTP-G283 Managing the Card CFM Settings, on page 517
• NTP-G285 Managing the Card EFM Settings, on page 529
• NTP-G287 Managing the Card REP Settings, on page 534
• NTP-G165 Modifying the Ethernet, Line and PM Thresholds, on page 540
• NTP-G237 Retrieving and Clearing MAC Addresses on SVLANs, on page 564
• NTP-G311 Provisioning the Storm Control Settings, on page 566
• NTP-G205 Enabling Link Integrity on a Card, on page 567
• DLP-G289 Provisioning CVLAN Rate Limiting on a Card, on page 569
• NTP-G208 Provisioning SVLAN Rate Limiting on a Card, on page 569
• NTP-G204 Enabling IGMP Snooping on a Card, on page 572
• NTP-G206 Enabling MVR on a Card, on page 574
• NTP-G314 Adding a Card on FAPS Ring, on page 585
• NTP-G197 Provisioning the OTU2_XP Card Line Settings, PM Parameters, and Thresholds, on page
588

• NTP-G162 Changing the ALS Maintenance Settings, on page 613
• NTP-G302 Configuring Loopback on a Card, on page 615
• NTP-G299 Configuring Backplane Loopback on a Card, on page 616
• NTP-G192 Forcing FPGA Update, on page 618
• NTP-G196 Forcing FPGA Update on a Card in Protection Group, on page 619
• NTP-G232 Enabling Error Decorrelator, on page 620
• NTP-G315 Enabling the Wavelength Drifted Channel Automatic Shutdown Feature, on page 621
• NTP-G316 Enabling REP and FAPS on the Same Port, on page 621
• NTP-G321 Provisioning Multiple Operating Modes, on page 622
• NTP-G322 Modifying the Card Line Settings and PM Parameter Thresholds, on page 623
• NTP-G235 Provisioning an Operating Mode, on page 652
• NTP-G361 Provisioning an Operating Mode on the 400G-XP-LC Card, on page 653
• NTP-G362 Manual FPGA Upgrade on the 400G-XP-LC Card, on page 655
• NTP-G366 Viewing the ODU Utilization for ODU Circuits, on page 656
• NTP-G367 Provisioning Encryption on 400G-XP-LC Card, on page 657
• NTP-G236 Modifying the 100G-LC-C, 100G-CK-C, 100G-ME-C, 100ME-CKC, 10x10G-LC,
100GS-CK-LC, , 200G-CK-LC, CFP-LC,WSE, MR-MXP, or 400G-XP-LC Card Line Settings and PM
Parameter Thresholds, on page 662

• NTP-G351 Retrieving MAC Addresses on Cards, on page 702
• NTP-G338 Provisioning an Operating Mode on the WSE Card, on page 702
• NTP-G339 Modifying the WSE Card Line Settings and PM Parameter Thresholds, on page 703
• NTP-G340 Provisioning Encryption on the WSE and MR-MXP Cards, on page 718
• NTP-G342 Provisioning FIPS and CC Mode, on page 726
• NTP-G363 Provisioning LSC on Cards, on page 729

Card Overview
The card overview section lists the cards described in this chapter and provides compatibility information.
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The purpose of a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, AR_MXP,
AR_XP, or AR_XPE card is to convert the “gray” optical client interface signals into trunk signals that operate
in the “colored” dense wavelength division multiplexing (DWDM) wavelength range. Client-facing gray
optical signals generally operate at shorter wavelengths, whereas DWDM colored optical signals are in the
longer wavelength range (for example, 1490 nm = violet; 1510 nm = blue; 1530 nm = green; 1550 nm =
yellow; 1570 nm = orange; 1590 nm = red; 1610 nm = brown). Some of the newer client-facing PPMs,
however, operate in the colored region. Transponding or muxponding is the process of converting the signals
between the client and trunk wavelengths.

An MXP generally handles several client signals. It aggregates, or multiplexes, lower rate client signals
together and sends them out over a higher rate trunk port. Likewise, it demultiplexes optical signals coming
in on a trunk and sends them out to individual client ports. A TXP converts a single client signal to a single
trunk signal and converts a single incoming trunk signal to a single client signal. GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards can be provisioned as TXPs, as MXPs, or as Layer 2 switches.

All of the TXP and MXP cards perform optical to electrical to optical (OEO) conversion. As a result, they
are not optically transparent cards. The reason for this is that the cards must operate on the signals passing
through them, so it is necessary to do an OEO conversion.

On the other hand, the termination mode for all of the TXPs and MXPs, which is done at the electrical level,
can be configured to be transparent. In this case, neither the Line nor the Section overhead is terminated. The
cards can also be configured so that either Line or Section overhead can be terminated, or both can be
terminated.

The MXP_2.5G_10G card, by design, when configured in the transparent termination mode, actually does
terminate some of the bytes. See "Termination Modes" section for details.

Note

Card Compatibility
Table 64: Platform and Software Release Compatibility for Transponder and Muxponder Cards

R9.0 and R9.1R8.0 - R8.5R7.0 and R7.2R4.7 - R6.0R4.5 - R4.6Card Name

15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMTXP_MR_10G

15454-DWDM15454-DWDM15454-DWDM15454-DWDMNoTXP_MR_10E

15454-DWDM15454-DWDM15454-DWDMNoNoTXP_MR_10E_C

15454-DWDM15454-DWDM15454-DWDMNoNoTXP_MR_10E_L

15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMTXP_MR_ 2.5G
and TXPP_
MR_2.5G

15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMMXP_2.5G_10G

15454-DWDM15454-DWDM15454-DWDM15454-DWDMNoMXP_2.5G _10E

15454-DWDM15454-DWDM15454-DWDMNoNoMXP_2.5G_
10E_C
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R9.0 and R9.1R8.0 - R8.5R7.0 and R7.2R4.7 - R6.0R4.5 - R4.6Card Name

15454-DWDM15454-DWDM15454-DWDMNoNoMXP_2.5G_
10E_L

15454-DWDM15454-DWDM15454-DWDM15454-DWDMNoMXP_MR_2.5G
and MXPP_MR_
2.5G

15454-DWDM15454-DWDM15454-DWDMNoNoMXP_MR_
10DME_C

15454-DWDM15454-DWDM15454-DWDMNoNoMXP_MR_
10DME_L

15454-DWDM15454-DWDMNoNoNoGE_XP and
10GE_XP

15454-DWDMNoNoNoNoGE_XPE and
10GE_XPE

15454-DWDM15454-DWDMNoNoNoADM-10G

15454-DWDMNoNoNoNoOTU2_XP

No and 15454-
DWDM for
R9.1

NoNoNoNoTXP_MR_10EX_C,
MXP_2.5G _
10EX_C, and
MXP_MR _
10DMEX_C

NoNoNoNoNo40E-TXP-C,
40ME- TXP-C,
40E-MXP-C, and
40ME-MXP-C

NoNoNoNoNo40E-MXP-C

NoNoNoNoNo40G-MXP-C

NoNoNoNoNoAR_XP

NoNoNoNoNoAR_MXP and
AR_XPE

NoNoNoNoNo100G-LC-C,
100G-ME-C,
10x10G-LC, and
100GS-CK-LC

NoNoNoNoNoCFP-LC

NoNoNoNoNoWSE
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R9.0 and R9.1R8.0 - R8.5R7.0 and R7.2R4.7 - R6.0R4.5 - R4.6Card Name

NoNoNoNoNo100G-CK-LC,
100ME-CK-LC,
and 400G-XP-LC

Table 65: Platform and Software Release Compatibility for Transponder and Muxponder Cards

R9.8R9.6.xR9.4R9.3R9.2.1R9.2Card Name

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

TXP_MR_10G

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

TXP_MR_10E

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

TXP_MR_10E_C

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

TXP_MR_10E_L

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

TXP_MR_2.5G and
TXPP_MR_2.5G

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_2.5G_10G

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_2.5G_10E

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

MXP_2.5G_10E_C

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_2.5G_10E_L

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

MXP_MR_2.5G and
MXPP_MR_2.5G
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15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

MXP_MR_10DME_C

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_MR_10DME_L

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

GE_XP and 10GE_XP

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

GE_XPE and
10GE_XPE

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

ADM - 10G

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

OTU2_XP

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

TXP_MR_10EX_C,
MXP_2.5G_10EX_C,
and
MXP_MR_10DMEX_C

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

No40E - TXP - C, 40ME
- TXP - C, 40E - MXP
- C, and 40ME - MXP
- C

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

No40E - MXP - C
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15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
DWDM,
15454 - M2,
15454 - M6

40G - TXP - C

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454 -
M2, 15454
- M6,
15454 -
DWDM

15454-M2,
15454-M6,
15454-DWDM

40G - MXP - C

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

NoNoNoAR_XP

15454 - M2,
15454 - M6,
15454 -
DWDM

15454 - M2,
15454 - M6,
15454 -
DWDM

NoNoNoNoAR_MXP and
AR_XPE

15454 - M2,
15454 - M6

15454 - M2,
15454 - M6

NoNoNoNo100G - LC - C, 100G -
ME-C, and 10x10G-LC

15454 - M615454 - M6NoNoNoNoCFP-LC

15454 - M2,
15454 - M6

NoNoNoNoNoWSE

NoNoNoNoNoNo100GS-CK-LC

NoNoNoNoNoNo200G-CK-LC

NoNoNoNoNoNoMR-MXP

NoNoNoNoNoNo100ME-CKC

NoNoNoNoNoNo100G-CK-C

NoNoNoNoNoNo400G-XP-LC

Table 66: Platform and Software Release Compatibility for Transponder and Muxponder Cards

R11.x.xR10.7
/10.8/10.9

R10.6.1/10.6.2R10.5.2R10.5R10.3R10.1Card Name

15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDM15454-DWDMTXP_MR_10G

15454 -
DWDM,
NCS 2015

15454 -
DWDM,
NCS 2015

15454 -
DWDM,
NCS 2015

15454 -
DWDM,
NCS 2015

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

TXP_MR
_10E

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
128

Provisioning Transponder and Muxponder Cards
Card Compatibility



15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

TXP_MR_10E_C

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

TXP_MR_10E_L

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

TXP_MR_2.5G
and
TXPP_MR_2.5G

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_2.5G_10G

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_2.5G_10E

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

MXP_2.5G_10E_C

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_2.5G_10E_L

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

MXP_MR_2.5G
and
MXPP_MR_2.5G

15454 -M2,
15454 -M6,
15454 -
DWDM
(From
R10.8)NCS
2015

15454 -M2,
15454 -M6,
15454 -
DWDM
(From
R10.8)NCS
2015

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

MXP_MR_10DME_C

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

15454 -
DWDM

MXP_MR_10DME_L

15454 -M2,
15454 -M6,
15454 -
DWDM
(From
R10.8)NCS
2015

15454 -M2,
15454 -M6,
15454 -
DWDM
(From
R10.8)NCS
2015

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

GE_XP and
10GE_XP
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15454 -M2,
15454 -M6,
15454 -
DWDM
(From
R10.8)NCS
2015

15454 -M2,
15454 -M6,
15454 -
DWDM
(From
R10.8)NCS
2015

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

GE_XPE
and
10GE_XPE

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

ADM - 10G

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

OTU2_XP

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

TXP_MR_10EX_C,
MXP_2.5G_10EX_C,
and
MXP_MR_10DMEX_C

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

40E-TXP-C
, 40ME -
TXP - C,
40E-MXP-C,
and 40ME-
MXP-C

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

40E-MXP
-C

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

40G-TXP
-C

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

40G-MXP
-C

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454-M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -
DWDM,
15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

AR_XP
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15454 -M2,
15454 -M6,
15454 -
DWDM,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM,
NCS 2015

15454 -M2,
15454 -M6,
15454 -
DWDM

15454 -M2,
15454 -M6,
15454 -
DWDM

AR_MXP
and
AR_XPE

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 - M6

15454 -M2,
15454 - M6

100G-LC
-C, 100G-
ME-C, and
10x10G-LC

15454-M6,
NCS 2015

15454 -M6,
NCS 2015

15454 -M6,
NCS 2015

15454 -M6,
NCS 2015

15454 - M615454 - M615454 - M6CFP-LC

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 - M6

15454 -M2,
15454 - M6

WSE

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 - M6

15454 -M2,
15454 - M6

100GS
-CK-LC

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 - M6

No200G
-CK-LC

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 - M6

NoMR-MXP

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 - M6

15454 -M2,
15454 - M6

100ME-CKC

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 -M6,
NCS 2015

15454 -M2,
15454 - M6

15454 -M2,
15454 - M6

100G-CK-C

15454 -M2,
15454 - M6
and NCS
2015

15454 -M2,
15454 - M6
and NCS
2015

15454 - M6
and NCS
2015

NoNoNoNo400G-XP-LC

Version Number Compatibility for Transponder and Muxponder Cards

Older versions of the TXP_MR_10E_C, TXP_MR_2.5G, TXPP_MR_2.5G, and MXP_2.5G_10E_C cards
cannot be installed in the Cisco ONS 15454M2 and Cisco ONS 15454M6 shelves because of an incompatible
backplane connector.

The following table describes the version numbers of the cards that are compatible with the Cisco ONS 15454
M2 and Cisco ONS 15454 M6 shelves. The version numbers can be viewed from the HW Rev field in the
Inventory tab.
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Table 67: Version Number Compatibility

Version NumberCard

Version 06 or later of the different unit part numberTXP_MR_2.5G

Version 06 or later of the different unit part numberTXPP_MR_2.5G

Version 04 or later of the 800-26774 part numberMXP_2.5G_10E_C

Version 04 or later of the 800-26772 part numberTXP_MR_10E_C

Safety Labels
For information about safety labels, see the "Safety Labels" section.

Interface Classes
The input interface cards have been grouped in classes listed in the following table. The subsequent tables
list the optical performance and output power of each interface class.

Table 68: Card Interfaces Assigned to Input Power Classes

CardInput Power Class

10-Gbps multirate transponder cards (TXP_MR_10G, TXP_MR_10E,
TXP_MR_10E_C, and TXP_MR_10E_L)with forward error correction (FEC) enabled,
10-Gbpsmuxponder cards (MXP_2.5G_10G,MXP_2.5G_10E,MXP_MR_10DME_C,
MXP_MR_10DME_L,MXP_2.5G_10E_C, andMXP_2.5G_10E_L)with FECenabled,
40-Gbps transponder cards (40E-TXP-C, and 40ME-TXP-C), and 40-Gbps muxponder
cards (40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C)

A

10-Gbps multirate transponder card (TXP_MR_10G) without FEC and the 10-Gbps
muxponder card (MXP_2.5G_10G, MXP_MR_10DME_C, MXP_MR_10DME_L),
40-Gbps transponder cards (40E-TXP-C, and 40ME-TXP-C), and 40-Gbps muxponder
cards (40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C), and ADM-10G cards with
FEC disabled

B

OC-192 LR ITU cards without FEC, 10-Gbps multirate transponder (TXP_MR_10E,
TXP_MR_10E_C, and TXP_MR_10E_L) and muxponder (MXP_2.5G_10E,
MXP_2.5G_10E_L, and MXP_MR_10DME_L) cards with FEC disabled

C

2.5-Gbps multirate transponder card (TXP_MR_2.5G), both protected and unprotected,
with FEC enabled

D

OC-48 100-GHz dense wavelength division multiplexing (DWDM) muxponder card
(MXP_MR_2.5G) and 2.5-Gbpsmultirate transponder card (TXP_MR_2.5G), protected
or unprotected; FEC disabled; and retime, reshape, and regenerate (3R) mode enabled

E

2.5-Gbps multirate transponder card (TXP_MR_2.5G), protected or unprotected, in
regenerate and reshape (2R) mode

F
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CardInput Power Class

OC-48 ELR 100 GHz cardG

2/4 port GbE transponder (GBIC WDM 100GHz)H

10-Gbps multirate transponder cards (TXP_MR_10E, TXP_MR_10E_C, and
TXP_MR_10E_L) and 10-Gbps muxponder cards (MXP_2.5G_10E,
MXP_2.5G_10E_L, andMXP_MR_10DME_L)with enhanced FEC (E-FEC) enabled,
40-Gbps transponder cards (40E-TXP-C, and 40ME-TXP-C), and 40-Gbps muxponder
cards (40G-MXP-C, 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C) with E-FEC
enabled

I

OC-192/STM-64 LR ITU cards without FEC, 100GHz 10Gbps Ethernet Xponder
(GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), Sonet/SDH add/drop (ADM_10G), OTU2
Xponder (OTU2_XP), with FEC disabled

K

40Gbps Duobinary CRS-1 DWDM ITU-T line cardL

2.5 Gbps DWDM ITU-T SPFM

10Gbps enhanced full tunable transponder (TXP_MR_10E_C) and muxponder
(MXP_2.5G_10E_C, MXP_MR_10DME_C) with E-FEC enabled

N

10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), 10Gbps
Sonet/SDH add/drop (ADM_10G), OTU2 Xponder (OTU2_XP), with FEC enabled

O

10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), 10Gbps
Sonet/SDH add/drop (ADM_10G), OTU2 Xponder (OTU2_XP), with E-FEC enabled

P

40Gbps DPSK CRS-1 DWDM ITU-T line cardT

OC-192/STM-64 LR ITU cards without FEC, full tunable 10Gbps Ethernet Xponder
(GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), Sonet/SDH add/drop (ADM_10G), OTU2
Xponder (OTU2_XP), with FEC disabled, full tunable

V

10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), Sonet/SDH
add/drop (ADM_10G), OTU2 Xponder (OTU2_XP), with FEC enabled, full tunable

W

10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), Sonet/SDH
add/drop (ADM_10G), OTU2Xponder (OTU2_XP), with E-FEC enabled, full tunable

X

10Gbps enhanced full tunable transponder (TXP_MR_10EX_C) and muxponder
(MXP_2.5G_10EX_C, MXP_MR_10DMEX_C), with FEC enabled and maximum
likelihood sequence estimator (MLSE) correction

Y

10Gbps enhanced full tunable transponder (TXP_MR_10EX_C) and muxponder
(MXP_2.5G_10EX_C, MXP_MR_10DMEX_C), with E-FEC enabled and MLSE
correction

Z
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Table 69: 40-Gbps Interface Optical Performance

Class IClass BClass AParameter

OSNR
Limited (if
appl.)

Power
Limited

OSNR
Limited (if
appl.)

Power
Limited

OSNR
Limited (if
appl.)

OSNR =
optical
signal-to-noise
ratio

Power
Limited

Type

40 Gbps40 Gbps40 GbpsMaximum bit rate

3R3R3RRegeneration

Yes (E-FEC)NoYesFEC

OptimumAverageOptimumThreshold

10–1510–1210–15Maximum BER

BER = bit error rate

8 dB20 dB19 dB23 dB9 dB23 dBOSNR sensitivity

OSNR = optical
signal-to-noise ratio

–18 dBm–26 dBm–20 dBm–21 dBm–18 dBm–24 dBmPower sensitivity

–8 dBm–8 dBm–8 dBmPower overload

Transmitted Power Range—These values, decreased by patchcord and connector losses, are
also the input power values for the OADM cards.

—+2.5 to 3.5 dBm+2.5 to 3.5 dBm40-Gbps multirate
transponder/40-Gbps
FEC transponder
(40E-TXP-C, and
40ME-TXP-C)

———OC-192 LR ITU

+/–800 ps/nm+/–1,000 ps/nm+/–800 ps/nmDispersion
compensation tolerance
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Table 70: 10-Gbps Interface Optical Performance (Class A, B, C, I, and K)

Class KClass IClass CClass BClass AParameter

OSNR LimitedPower
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

10 Gbps10 Gbps10 Gbps10 Gbps10 GbpsMaximum bit
rate

3R3R3R3R3RRegeneration

NoYes (E-FEC)NoNoYesFEC

AverageOptimumAverageAverageOptimumThreshold

10–1210–1510–1210–1210–15Maximum
BER

16 dB323 dB

This value
is for Xen
Pak XFP
used with
Catalyst
card.

20 dB

6 dB

19 dB19 dB19 dB23 dB8.5 dB23 dBOSNR
sensitivity

17 dB423 dB

This value
is for XFP
used with
Catalyst,
Xponder,
and
ADM-10G
cards.

17 dB523 dB

This value
is for X2
XFP used
with
Catalyst
card.

–17 dBm3–24 dBm3–18
dBm

–26 dBm–22
dBm

–22
dBm

–20
dBm

–21 dBm–18
dBm

–24
dBm

Power
sensitivity

–18 dBm4–23 dBm4

–17 dBm5–23 dBm5

–7 dBm–8 dBm–9 dBm–8 dBm–8 dBmPower
overload
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Class KClass IClass CClass BClass AParameter

OSNR LimitedPower
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

Transmitted Power Range—These values, decreased by patchcord and connector losses, are also the input power values for the
optical add drop multiplexer (OADM) cards.

—+3.0 to 6.0 dBm+3.0 to 6.0 dBm+2.5 to 3.5 dBm+2.5 to 3.5 dBm
(for
TXP_MR_10G)

+3.0 to 6.0 dBm
(for
TXP_MR_10E)

10-Gbps
multirate
transponder
/10-Gbps FEC
transponder

–1.0 to +3.0 dBm—+3.0 to 6.0 dBm——OC-192 LR
ITU

–1.0 to +3.0 dBm————10-Gbps
Ethernet
Xponder,
Sonet/SDH
Add/Drop,
OTU2
Xponder

–400 to +800 ps/nm+/–800 ps/nm+/–1,000 ps/nm+/–1,000 ps/nm+/–800 ps/nmDispersion
compensation
tolerance

Table 71: 10-Gbps Interface Optical Performance (Class N, O, P, and V)

Class VClass PClass OClass NParameter

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

10 Gbps10 Gbps10 Gbps10 GbpsMaximum bit rate

3R3R3R3RRegeneration

NoYes (E-FEC)YesYes (E-FEC)FEC

AverageOptimumOptimumOptimumThreshold

10–1210–1510–1510–15Maximum BER

16 dB23 dB8 dB23 dB11 dB11 dB5 dB19 dBOSNR sensitivity

–18
dBm

–24 dBm–18
dBm

–27 dBm–18 dBm–18 dBm–20
dBm

–27
dBm

Power sensitivity

–7 dBm–7 dBm–7 dBm–8 dBmPower overload
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Class VClass PClass OClass NParameter

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

Transmitted Power Range—These values, decreased by patchcord and connector losses, are also the input power
values for the optical add drop multiplexer (OADM) cards.

———+3.0 to 6.0 dBm10-Gbps multirate
transponder/10-Gbps
FEC transponder

0 to +3.0 dBm———OC-192 LR ITU

0 to +3.0 dBm–1.0 to +3.0 dBm–1.0 to +3.0 dBm—10-Gbps Ethernet
Xponder, Sonet/SDH
Add/Drop, OTU2
Xponder

–500 to +1600 ps/nm–500 to +1100
ps/nm

–500 to +1100 ps/nm+/–800 ps/nmDispersion
compensation
tolerance

Table 72: 10-Gbps Interface Optical Performance (Class W, X, Y, and Z)

Class ZClass YClass XClass WParameter

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

10 Gbps10 Gbps10 Gbps10 GbpsMaximum bit rate

3R3R3R3RRegeneration

Yes (E-FEC)YesYes (E-FEC)YesFEC

OptimumOptimumOptimumOptimumThreshold

10–1510–1510–1510–15Maximum BER

5.5 dB19 dB8 dB23 dB5 dB19 dB8.5 dB8.5 dBOSNR sensitivity

–20
dBm

–27 dBm–20
dBm

–24 dBm–20
dBm

–27 dBm–18
dBm

–18
dBm

Power sensitivity

–8 dBm–8 dBm–7 dBm–7 dBmPower overload

Transmitted Power Range—These values, decreased by patchcord and connector losses, are also the input power values for
the optical add drop multiplexer (OADM) cards.

+3.0 to 6.0 dBm+3.0 to 6.0 dBm——10-Gbps multirate
transponder/10-Gbps FEC
transponder
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Class ZClass YClass XClass WParameter

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

————OC-192 LR ITU

——0 to +3.0 dBm0 to +3.0 dBm10-Gbps Ethernet Xponder,
Sonet/SDH Add/Drop, OTU2
Xponder

–2200 to +3700 ps/nm–800 to +1600 ps/nm–500 to +1300 ps/nm–500 to +1100
ps/nm

Dispersion compensation
tolerance

Table 73: 2.5-Gbps Interface Optical Performance (Class D, E, and F)

Class FClass EClass DParameter

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

2.5 Gbps2.5 Gbps2.5 GbpsMaximum bit rate

2R3R3RRegeneration

NoNoYesFEC

AverageAverageAverageThreshold

10–1210–1210–15Maximum BER

15 dB15 dB10 dB14 dB5 dB14 dBOSNR sensitivity

–24 dBm–24 dBm–23 dBm–30 dBm–25 dBm–31 dBmPower sensitivity

–9 dBm–9 dBm–9 dBmPower overload

Transmitted Power Range—These values, decreased by patchcord and connector losses, are also the input
power values for the optical add drop multiplexer (OADM) cards.

–1.0 to 1.0 dBm–1.0 to 1.0 dBm–1.0 to 1.0 dBmTXP_MR_2.5G and
TXPP_MR_2.5G

—+2.0 to +4.0 dBm—MXP_MR_2.5G and
MXPP_MR_2.5G

———OC-48 ELR 100 GHz

———2/4 port GbE Transponder
(GBIC WDM 100GHz)

———2.5GbpsDWDM ITU-T SPF

–1200 to +3300 ps/nm–1200 to +5400 ps/nm–1200 to +5400 ps/nmDispersion compensation
tolerance
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Table 74: 2.5-Gbps Interface Optical Performance (Class G, H, and M)

Class MClass HClass GParameter

OSNR LimitedPower
Limited

OSNR
Limited

Power
Limited

OSNR
Limited

Power
Limited

Type

2.5 Gbps1.25 Gbps2.5 GbpsMaximum bit rate

3R3R3RRegeneration

NoNoNoFEC

AverageAverageAverageThreshold

10–1210–1210–12Maximum BER

9 dB14 dB8 dB13 dB11 dB14 dBOSNR sensitivity

–22 dBm–28 dBm–18 dBm–28 dBm–23 dBm–27 dBmPower sensitivity

–9 dBm–7 dBm–9 dBmPower overload

Transmitted Power Range—These values, decreased by patchcord and connector
losses, are also the input power values for the optical add drop multiplexer (OADM)
cards.

———TXP_MR_2.5G

—TXPP_MR_2.5G

–2.0 to 0 dBmMXP_MR_2.5G

—MXPP_MR_2.5G

———OC-48 ELR 100 GHz

—0 to +3 dBm–1200 to +3300 ps/nm2/4 port GbE Transponder
(GBIC WDM 100GHz)

0 to +4 dBm—2.5 Gbps DWDM ITU-T
SPF

–800 to +2400 ps/nm–1000 to +3600 ps/nmDispersion compensation
tolerance

TXP_MR_10G Card
The TXP_MR_10G card has reached end of support.

(Cisco ONS 15454 only)

The TXP_MR_10G processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal
(trunk side). It provides one 10-Gbps port per card that can be provisioned for an STM-64/OC-192 short reach
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(1310-nm) signal, compliant with ITU-T G.707, ITU-T G.709, ITU-T G.691, and Telcordia GR-253-CORE,
or a 10GBASE-LR signal compliant with IEEE 802.3.

The TXP_MR_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz range.
It is available in 16 different versions, each of which covers two wavelengths, for a total coverage of 32
different wavelengths in the 1550-nm range.

ITU-T G.709 specifies a form of forward error correction (FEC) that uses a “wrapper” approach. The digital
wrapper lets you transparently take in a signal on the client side, wrap a frame around it and restore it to its
original form. FEC enables longer fiber links because errors caused by the optical signal degrading with
distance are corrected.

Note

The trunk port operates at 9.95328 Gbps (or 10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC) and at
10.3125 Gbps (or 11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC) over unamplified distances up to
80 km (50 miles) with different types of fiber such as C-SMF or dispersion compensated fiber limited by loss
and/or dispersion.

Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_10G card
does not display circuits under card view.

Caution

Youmust use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G card in a loopback
on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G card. Using direct fiber loopbacks
causes irreparable damage to the TXP_MR_10G card.

Caution

You can install TXP_MR_10G cards in Slots 1 to 6 and 12 to 17 and provision this card in a linear configuration.
TXP_MR_10G cards cannot be provisioned as a bidirectional line switched ring (BLSR)/Multiplex Section
- Shared Protection Ring (MS-SPRing), a path protection/subnetwork connection protection (SNCP), or a
regenerator. They can only be used in the middle of BLSR/MS-SPRing and 1+1 spans when the card is
configured for transparent termination mode.

The TXP_MR_10G port features a 1550-nm laser for the trunk port and a 1310-nm laser for the for the client
port and contains two transmit and receive connector pairs (labeled) on the card faceplate.

TheMTU setting is used to display the OverSizePkts counters on the receiving trunk and client port interfaces.
Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client port to the trunk port
and vice versa irrespective of the MTU setting.

The TXP_MR_10G card has the following available wavelengths and versions:

• ITU grid blue band:

• 1538.19 to 1538.98 nm, 10T-L1-38.1

• 1539.77 to 1540.56 nm, 10T-L1-39.7

• 1530.33 to 1531.12 nm, 10T-L1-30.3

• 1531.90 to 1532.68 nm, 10T-L1-31.9

• 1534.25 to 1535.04 nm, 10T-L1-34.2
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• 1535.82 to 1536.61 nm, 10T-L1-35.8

• 1542.14 to 1542.94 nm, 10T-L1-42.1

• 1543.73 to 1544.53 nm, 10T-L1-43.73

• ITU grid red band:

• 1554.13 to 1554.94 nm, 10T-L1-54.1

• 1555.75 to 1556.55 nm, 10T-L1-55.7

• 1546.12 to 1546.92 nm, 10T-L1-46.1

• 1547.72 to 1548.51 nm, 10T-L1-47.7

• 1550.12 to 1550.92 nm, 10T-L1-50.1

• 1551.72 to 1552.52 nm, 10T-L1-51.7

• 1558.17 to 1558.98 nm, 10T-L1-58.1

• 1559.79 to 1560.61 nm, 10T-L1-59.7

For more information about the TXP_MR_10G card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd80121bf7_ps13234_Products_Data_Sheet.html.

Related Procedures for TXP_MR_10G Card
The following is the list of procedures and tasks related to the configuration of the TXP_MR_10G card:

• NTP-G96 Provisioning the 10GMultirate Transponder Card Line Settings, PMParameters, and Thresholds,
on page 368

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance

TXP_MR_10E Card
The card is fully backward compatible with the TXP_MR_10G card. It processes one 10-Gbps signal (client
side) into one 10-Gbps, 100-GHz DWDM signal (trunk side) that is tunable over four wavelength channels
(spaced at 100 GHz on the ITU grid) in the C band and tunable over eight wavelength channels (spaced at
50 GHz on the ITU grid) in the L band. There are eight versions of the C-band card, with each version covering
four wavelengths, for a total coverage of 32 wavelengths. There are five versions of the L-band card, with
each version covering eight wavelengths, for a total coverage of 40 wavelengths.

You can install TXP_MR_10E cards in Slots 1 to 6 and 12 to 17 in ONS 15454 DWDM chassis, Slots 2 and
3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6, Slots 2 to 16 in Cisco NCS 2015 chassis and
provision the cards in a linear configuration, BLSR/MS-SPRing, path protection/SNCP, or a regenerator. The
card can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent
termination mode.
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The TXP_MR_10E card features a 1550-nm tunable laser (C band) or a 1580-nm tunable laser (L band) for
the trunk port and ONS-XC-10G-S1 1310-nm or ONS-XC-10G-L2 1550-nm laser XFP module for the client
port that can be ordered separately.

When the ONS-XC-10G-L2 XFP is installed, the TXP_MR_10E card must be installed in Slots 6, 7, 12, or
13 in the ONS 15454 chassis.

Note

On its faceplate, the TXP_MR_10E card contains two transmit and receive connector pairs, one for the trunk
port and one for the client port. Each connector pair is labeled.

Key Features

The key features of the TXP_MR_10E card are:

• A tri-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately)

• OC-192 (SR1)

• 10GE (10GBASE-LR)

• 10G-FC (1200-SM-LL-L)

• IB_5G

• OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping

• The MTU setting is used to display the OverSizePkts counters on the receiving Gigabit Ethernet client
port interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client
port to the trunk port irrespective of the MTU setting.

TXP_MR_10E Functions
The following functions of the TXP_MR_10E card are explained in "Card Features" chapter:

• Client Interface

• DWDM Trunk Interface

• FEC

• Client-to-Trunk Mapping

For more information about the TXP_MR_10E card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd803fc3e8_ps13234_Products_Data_Sheet.html.

Related Procedures for TXP_MR_10E Card
The following is the list of procedures and tasks related to the configuration of the TXP_MR_10E card:

• NTP-G96 Provisioning the 10GMultirate Transponder Card Line Settings, PMParameters, and Thresholds,
on page 368

• NTP-G33 Creating a Y-Cable Protection Group, on page 334
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• NTP-G75 Monitor Transponder and Muxponder Performance

TXP_MR_10E_C and TXP_MR_10E_L Cards
The TXP_MR_10E_C and TXP_MR_10E_L cards are fully backward compatible with the TXP_MR_10G
and TXP_MR_10E cards. They processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHzDWDM
signal (trunk side). The TXP_MR_10E_C is tunable over the entire set of C-band wavelength channels (82
channels spaced at 50 GHz on the ITU grid). The TXP_MR_10E_L is tunable over the entire set of L-band
wavelength channels (80 channels spaced at 50 GHz on the ITU grid) and is particularly well suited for use
in networks that employ DS fiber or SMF-28 single-mode fiber.

The advantage of these cards over previous versions (TXP_MR_10G and TXP_MR_10E) is that there is only
one version of each card (one C-band version and one L-band version) instead of several versions needed to
cover each band.

You can install TXP_MR_10E_C and TXP_MR_10E_L cards in Slots 1 to 6 and 12 to 17 in ONS 15454
DWDM chassis, Slot 2 in ONS 15454 M2 chassis, Slots 2 to 6 in ONS 15454 M6 and provision the cards in
a linear configuration, BLSR/MS-SPRing, path protection/SNCP, or a regenerator. The cards can be used in
the middle of BLSR/MS-SPRing or 1+1 spans when the cards are configured for transparent termination
mode.

The TXP_MR_10E_C and TXP_MR_10E_L cards feature a universal transponder 2 (UT2) 1550-nm tunable
laser (C band) or a UT2 1580-nm tunable laser (L band) for the trunk port and a separately orderable
ONS-XC-10G-S1 1310-nm or ONS-XC-10G-L2 1550-nm laser XFP module for the client port.

When the ONS-XC-10G-L2 XFP is installed, the TXP_MR_10E_C or TXP_MR_10E-L card is required to
be installed in a high-speed slot (slot 6, 7, 12, or 13).

Note

On its faceplate, the TXP_MR_10E_C and TXP_MR_10E_L cards contain two transmit and receive connector
pairs, one for the trunk port and one for the client port. Each connector pair is labeled.

Key Features
The key features of the TXP_MR_10E_C and TXP_MR_10E_L cards are:

• A tri-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately):

• OC-192 (SR1)

• 10GE (10GBASE-LR)

• 10G-FC (1200-SM-LL-L)

• A UT2 module tunable through the entire C band (TXP_MR_10E_C card) or L band (TXP_MR_10E_L
card). The channels are spaced at 50 GHz on the ITU grid.

• OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping.

• The MTU setting is used to display the OverSizePkts counters on the receiving Gigabit Ethernet client
port interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client
port to the trunk port irrespective of the MTU setting.
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For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Faceplates and Block Diagram
Figure 12: TXP_MR_10E_C and TXP_MR_10E_L Faceplates and Block Diagram

For information about safety labels for the cards, see the "Class 1M Laser Product Cards” section.

You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E_C or
TXP_MR_10E_L card in a loopback on the trunk port. Do not use direct fiber loopbacks with the cards. Using
direct fiber loopbacks causes irreparable damage to the cards.

Caution

TXP_MR_10E_C and TXP_MR_10E_L Functions
The following functions of the TXP_MR_10E_C and TXP_MR_10E_L cards are explained in "Card Features"
chapter:

• Automatic Laser Shutdown

• Card level indicators

• Port level indicators

• Client Interface

• DWDM Trunk Interface

• FEC

• Client-to-Trunk Mapping
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Related Procedures for TXP_MR_10E_C and TXP_MR_10E_L Cards
The following is the list of procedures and tasks related to the configuration for both TXP_MR_10E_C and
TXP_MR_10E_L:

• NTP-G96 Provisioning the 10GMultirate Transponder Card Line Settings, PMParameters, and Thresholds,
on page 368

• DLP-G358 Provisioning TXP_MR_10E_L and TXP_MR_10E_C Cards for Acceptance Testing

• NTP-G75 Monitor Transponder and Muxponder Performance

TXP_MR_2.5G and TXPP_MR_2.5G Cards
The TXP_MR_2.5G card processes one 8-Mbps to 2.488-Gbps signal (client side) into one 8-Mbps to 2.5-Gbps,
100-GHz DWDM signal (trunk side). It provides one long-reach STM-16/OC-48 port per card, compliant
with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE.

The TXPP_MR_2.5G card processes one 8-Mbps to 2.488-Gbps signal (client side) into two 8-Mbps to
2.5-Gbps, 100-GHz DWDM signals (trunk side). It provides two long-reach STM-16/OC-48 ports per card,
compliant with ITU-T G.707, ITU-T G.957, and Telcordia GR-253-CORE.

The TXP_MR_2.5G and TXPP_MR_2.5G cards are tunable over four wavelengths in the 1550-nm,
ITU 100-GHz range. They are available in eight versions, each of which covers four wavelengths, for a total
coverage of 32 different wavelengths in the 1550-nm range.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

ITU-TG.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you transparently
take in a signal on the client side, wrap a frame around it, and restore it to its original form. FEC enables
longer fiber links because errors caused by the optical signal degrading with distance are corrected.

Note

The trunk/line port operates at up to 2.488 Gbps (or up to 2.66 Gbps with ITU-T G.709 Digital Wrapper/FEC)
over unamplified distances up to 360 km (223.7 miles) with different types of fiber such as C-SMF or higher
if dispersion compensation is used.

Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_2.5G or
TXPP_MR_2.5G card does not display circuits under card view.

Caution

The TXP_MR_2.5G and TXPP_MR_2.5G cards support 2R (retime, regenerate) and 3R (retime, reshape,
and regenerate) modes of operation where the client signal is mapped into a ITU-TG.709 frame. The mapping
function is simply done by placing a digital wrapper around the client signal. Only OC-48/STM-16 client
signals are fully ITU-T G.709 compliant, and the output bit rate depends on the input client signal. The
following table shows the possible combinations of client interfaces, input bit rates, 2R and 3R modes, and
ITU-T G.709 monitoring.
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Table 75: 2R and 3R Mode and ITU-T G.709 Compliance by Client Interface

ITU-T G.7093R vs. 2RInput Bit RateClient Interface

On or Off3R2.488 GbpsOC-48/STM-16

—2R2.38 GbpsDV-6000

On or Off3R

No monitoring

2.125 Gbps2 Gigabit Fibre Channel (2G-FC)/fiber connectivity
(FICON)

—2R1.48 GbpsHigh-Definition Television (HDTV)

On or Off3R1.25 GbpsGigabit Ethernet (GE)

On or Off3R1.06 Gbps1 Gigabit Fibre Channel (1G-FC)/FICON

On or Off3R622 MbpsOC-12/STM-4

On or Off3R155 MbpsOC-3/STM-1

—2R200 MbpsEnterprise System Connection (ESCON)

—2R270 MbpsSDI/D1/DVB-ASI video

Off2R1.06 GbpsISC-1 Compat

—2R1.06 or
2.125 Gbps

ISC-3

—2R16 MbpsETR_CLO

ITU-T G.709 and FEC support is disabled for all the 2R payload types in the TXP_MR_2.5G and
TXPP_MR_2.5G cards.

Note

The output bit rate is calculated for the trunk bit rate by using the 255/238 ratio as specified in ITU-T G.709
for OTU1. The following table lists the calculated trunk bit rates for the client interfaces with ITU-T G.709
enabled.

Table 76: Trunk Bit Rates With ITU-T G.709 Enabled

ITU-T G.709 EnabledITU-T G.709 DisabledClient Interface

2.66 Gbps2.488 GbpsOC-48/STM-16

2.27 Gbps2.125 Gbps2G-FC

1.34 Gbps1.25 GbpsGE

1.14 Gbps1.06 Gbps1G-FC

666.43 Mbps622 MbpsOC-12/STM-3
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ITU-T G.709 EnabledITU-T G.709 DisabledClient Interface

166.07 Mbps155 MbpsOC-3/STM-1

For 2R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards have the ability to pass data through
transparently from client side interfaces to a trunk side interface, which resides on an ITU grid. The data might
vary at any bit rate from 200-Mbps up to 2.38-Gbps, including ESCON, DVB-ASI, ISC-1, and video signals.
In this pass-through mode, no performance monitoring (PM) or digital wrapping of the incoming signal is
provided, except for the usual PM outputs from the SFPs. Similarly, this card has the ability to pass data
through transparently from the trunk side interfaces to the client side interfaces with bit rates varying from
200-Mbps up to 2.38-Gbps. Again, no PM or digital wrapping of received signals is available in this
pass-through mode.

For 3R operationmode, the TXP_MR_2.5G and TXPP_MR_2.5G cards apply a digital wrapper to the incoming
client interface signals (OC-N/STM-N, 1G-FC, 2G-FC, GE). PM is available on all of these signals except
for 2G-FC, and varies depending upon the type of signal. For client inputs other than OC-48/STM-16, a digital
wrapper might be applied but the resulting signal is not ITU-T G.709 compliant. The card applies a digital
wrapper that is scaled to the frequency of the input signal.

The TXP_MR_2.5G and TXPP_MR_2.5G cards have the ability to take digitally wrapped signals in from
the trunk interface, remove the digital wrapper, and send the unwrapped data through to the client interface.
PM of the ITU-T G.709 OH and SONET/SDH OH is implemented.

You can install TXP_MR_2.5G and TXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17 in ONS 15454DWDM
chassis, Slots 2 and 3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6. You can provision this card
in a linear configuration. TXP_MR_10G and TXPP_MR_2.5G cards cannot be provisioned as a
BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the middle of
BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination mode.

The TXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm laser for the client
port. It contains two transmit and receive connector pairs (labeled) on the card faceplate. The card uses dual
LC connectors for optical cable termination.

The TXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser
(depending on the SFP) for the client port and contains three transmit and receive connector pairs (labeled)
on the card faceplate. The card uses dual LC connectors for optical cable termination.

Related Procedures for TXP_MR_2.5G and TXPP_MR_2.5G Cards
The following is the list of procedures and tasks related to the configuration for both TXP_MR_2.5G and
TXPP_MR_2.5G:

• NTP-G98 Provisioning the 2.5GMultirate Transponder Card Line Settings and PMParameter Thresholds,
on page 344

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance
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40E-TXP-C and 40ME-TXP-C Cards
The 40E-TXP-C and 40ME-TXP-C cards process a single 40-Gbps signal (client side) into a single 40-Gbps,
50-GHz DWDM signal (trunk side). It provides one 40-Gbps port per card that can be provisioned for an
OC-768/STM-256 very short reach (1550-nm) signal compliant with ITU-T G.707, ITU-T G.691, and
Telcordia GR-253-CORE, 40G Ethernet LAN signal compliant with IEEE 802.3ba, or OTU3 signal compliant
with ITU-T G.709.

You can install and provision the 40E-TXP-C and 40ME-TXP-C cards in a linear configuration in:

• Slots 1 to 5 and 12 to 16 in ONS 15454 DWDM chassis

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 6 in ONS 15454 M6 chassis

When a protection switch occurs on the 40E-TXP-C, and 40ME-TXP-C cards, the recovery from
PSM protection switch takes about 3 to 4 minutes.

For more information about the 40E-TXP-C and 40ME-TXP-C cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-643796.html.

Related Procedures for 40E-TXP-C and 40ME-TXP-C Cards
The following is the list of procedures and tasks related to the configuration of 40E-TXP-C and 40ME-TXP-C:

• NTP-G292 Provisioning the 40G Multirate Transponder Card Line Settings, PM Parameters, and
Thresholds, on page 384

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance

MXP_2.5G_10G Card
The MXP_2.5G_10G card has reached end of support.

The MXP_2.5G_10G card multiplexes/demultiplexes four 2.5-Gbps signals (client side) into one 10-Gbps,
100-GHz DWDM signal (trunk side). It provides one extended long-range STM-64/OC-192 port per card on
the trunk side (compliant with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE) and
four intermediate- or short-range OC-48/STM-16 ports per card on the client side. The port operates at 9.95328
Gbps over unamplified distances up to 80 km (50 miles) with different types of fiber such as C-SMF or
dispersion compensated fiber limited by loss and/or dispersion.

Client ports on the MXP_2.5G_10G card are also interoperable with SONET OC48.

TheMXP_2.5G_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz range.
It is available in 16 different versions, each of which covers two wavelengths, for a total coverage of 32
different wavelengths in the 1550-nm range.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html
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ITU-TG.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you transparently
take in a signal on the client side, wrap a frame around it and restore it to its original form. FEC enables longer
fiber links because errors caused by the optical signal degrading with distance are corrected.

Note

The port can also operate at 10.70923 Gbps in ITU-T G.709 Digital Wrapper/FEC mode.

Because the transponder has no capability to look into the payload and detect circuits, an MXP_2.5G_10G
card does not display circuits under card view.

Caution

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G card in a
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10G card. Using direct
fiber loopbacks causes irreparable damage to the MXP_2.5G_10G card.

Caution

You can install MXP_2.5G_10G cards in Slots 1 to 6 and 12 to 17 in ONS 15454 DWDM chassis, Slots 2
and 3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6.

Do not install an MXP_2.5G_10G card in Slot 3 if you have installed a DS3/EC1-48 card in Slots 1or 2.
Likewise, do not install an MXP_2.5G_10G card in Slot 17 if you have installed a DS3/EC1-48 card in Slots
15 or 16. If you do, the cards will interact and cause DS-3 bit errors.

Caution

You can provision this card in a linear configuration. MXP_2.5G_10G cards cannot be provisioned as a
BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the middle of
BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination mode.

The MXP_2.5G_10G port features a 1550-nm laser on the trunk port and four 1310-nm lasers on the client
ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The card uses a
dual LC connector on the trunk side and SFP connectors on the client side for optical cable termination.

When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is necessary to provision a
4xOC-48 OCHCC circuit.

Note

For more information about the MXP_2.5G_10G card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd80121bee_ps13234_Products_Data_Sheet.html.

Related Procedures for MXP_2.5G_10G Card
The following is the list of procedures and tasks related to the configuration of MXP_2.5G_10G:

• NTP-G97Modifying the 4x2.5GMuxponder Card Line Settings and PM Parameter Thresholds, on page
426

• NTP-G33 Creating a Y-Cable Protection Group, on page 334
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• NTP-G75 Monitor Transponder and Muxponder Performance

MXP_2.5G_10E Card
The MXP_2.5G_10E card has reached end of support.

The faceplate designation of the card is “4x2.5G 10EMXP.” TheMXP_2.5G_10E card is a DWDMmuxponder
that supports full transparent termination the client side. The card multiplexes four 2.5 Gbps client signals (4
x OC48/STM-16 SFP) into a single 10-Gbps DWDM optical signal on the trunk side. The MXP_2.5G_10E
provides wavelength transmission service for the four incoming 2.5 Gbps client interfaces. TheMXP_2.5G_10E
muxponder passes all SONET/SDH overhead bytes transparently.

The MXP_2.5G_10E card is not compatible with the MXP_2.5G_10G card, which does not support full
transparent termination. You can install MXP_2.5G_10E cards in Slots 1 to 6 and 12 to 17 in ONS 15454
DWDM chassis, Slots 2 and 3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6. You can provision
this card in a linear configuration, as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. The card
can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent
termination mode.

The MXP_2.5G_10E features a 1550-nm laser on the trunk port and four 1310-nm lasers on the client ports
and contains five transmit and receive connector pairs (labeled) on the card faceplate. The card uses a dual
LC connector on the trunk side and uses SFP modules on the client side for optical cable termination. The
SFP pluggable modules are short reach (SR) or intermediate reach (IR) and support an LC fiber connector.

When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is necessary to provision a
4xOC-48 OCHCC circuit.

Note

Key Features
The MXP_2.5G_10E card has the following high level features:

• Four 2.5 Gbps client interfaces (OC-48/STM-16) and one 10 Gbps trunk. The four OC-48 signals are
mapped into a ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard E-FEC processor: The processor supports both standard Reed-Solomon (RS, specified in ITU-T
G.709) and E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the
transmission range on these interfaces. The E-FEC functionality increases the correction capability of
the transponder to improve performance, allowing operation at a lower OSNR compared to the standard
RS (255,239) correction algorithm. A new block code (BCH) algorithm implemented in E-FEC allows
recovery of an input BER up to 1E-3.

• Pluggable client interface optic modules: The MXP_2.5G_10E card has modular interfaces. Two types
of optics modules can be plugged into the card. These include an OC-48/STM 16 SR-1 interface with a
7-km (4.3-mile) nominal range (for short range and intra-office applications) and an IR-1 interface with
a range up to 40 km (24.9 miles). SR-1 is defined in Telcordia GR-253-CORE and in I-16 (ITU-TG.957).
IR-1 is defined in Telcordia GR-253-CORE and in S-16-1 (ITU-T G.957).
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• High level provisioning support: TheMXP_2.5G_10E card is initially provisioned using CiscoTransport
Planner software. Subsequently, the card can be monitored and provisioned using CTC software.

• Link monitoring and management: TheMXP_2.5G_10E card uses standard OC-48 OH (overhead) bytes
to monitor and manage incoming interfaces. The card passes the incoming SDH/SONET data stream
and its overhead bytes transparently.

• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate regenerator
section overhead. This is used to eliminate forwarding of unneeded layer overhead. It can help reduce
the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: TheMXP_2.5G_10E normally synchronizes from the control
card. If for some reason, such as maintenance or upgrade activity, the control card is not available, the
MXP_2.5G_10E automatically synchronizes to one of the input client interface clocks.

• Configurable squelching policy: The card can be configured to squelch the client interface output if there
is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the card manages
multiplex section alarm indication signal (MS-AIS) insertion.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

MXP_2.5G_10E Functions
The following functions of the MXP_2.5G_10E card are explained in "Card Features" chapter:

• Client Interface

• DWDM Interface

• Multiplexing Function

• Timing Synchronization

• FEC

• SONET/SDH Overhead Byte Processing

• Card-Level Indicators

• Client Interface Monitoring

• Jitter

• Lamp Test

• Onboard Traffic Generation

Wavelength Identification
The card uses trunk lasers that are wave-locked, which allows the trunk transmitter to operate on the ITU grid
effectively. The laser is tunable over eight wavelengths at 50-GHz spacing or four at 100-GHz spacing.
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Table 77: MXP_2.5G_10E Trunk Wavelengths

Wavelength
(nm)

BandWavelength
(nm)

Band

1546.1246.11530.3330.3

1546.9246.11531.1230.3

1547.7246.11531.9030.3

1548.5146.11532.6830.3

1550.1250.11534.2534.2

1550.9250.11535.0434.2

1551.7250.11535.8234.2

1552.5250.11536.6134.2

1554.1354.11538.1938.1

1554.9454.11538.9838.1

1555.7554.11539.7738.1

1556.5554.11540.5638.1

1558.1758.11542.1442.1

1558.9858.11542.9442.1

1559.7958.11543.7342.1

1560.6158.11544.5342.1

For more information about the MXP_2.5G_10E card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd801018ac.html.

Related Procedures for MXP_2.5G_10E Card
The following is the list of procedures and tasks related to the configuration of MXP_2.5G_10E Card:

• NTP-G97Modifying the 4x2.5GMuxponder Card Line Settings and PM Parameter Thresholds, on page
426

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance
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MXP_2.5G_10E_C and MXP_2.5G_10E_L Cards
The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards are DWDM muxponders that support transparent
termination mode on the client side. The faceplate designation of the cards is “4x2.5G 10E MXP C” for the
MXP_2.5G_10E_C card and “4x2.5G 10E MXP L” for the MXP_2.5G_10E_L card. The cards multiplex
four 2.5-Gbps client signals (4 x OC48/STM-16 SFP) into a single 10-Gbps DWDM optical signal on the
trunk side. The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards provide wavelength transmission service
for the four incoming 2.5 Gbps client interfaces. TheMXP_2.5G_10E_C andMXP_2.5G_10E_Lmuxponders
pass all SONET/SDH overhead bytes transparently.

The digital wrapper function (ITU-T G.709 compliant) formats the DWDMwavelength so that it can be used
to set up GCCs for data communications, enable FEC, or facilitate PM.

The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards work with OTN devices defined in ITU-T G.709. The
cards support ODU1 to OTU2 multiplexing, an industry standard method for asynchronously mapping a
SONET/SDH payload into a digitally wrapped envelope. See the "Multiplexing Function” section.

The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards are not compatible with the MXP_2.5G_10G card,
which does not support transparent termination mode.

You can install MXP_2.5G_10E_C and MXP_2.5G_10E_L cards in Slots 1 to 6 and 12 to 17 in ONS 15454
DWDM chassis, Slots 2 and 3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6. You can provision
a card in a linear configuration, as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. The cards
can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the cards are configured for transparent
termination mode.

The MXP_2.5G_10E_C card features a tunable 1550-nm C-band laser on the trunk port. The laser is tunable
across 82 wavelengths on the ITU grid with 50-GHz spacing between wavelengths. The MXP_2.5G_10E_L
features a tunable 1580-nm L-band laser on the trunk port. The laser is tunable across 80 wavelengths on the
ITU grid, also with 50-GHz spacing. Each card features four 1310-nm lasers on the client ports and contains
five transmit and receive connector pairs (labeled) on the card faceplate. The cards uses dual LC connectors
on the trunk side and use SFP modules on the client side for optical cable termination. The SFP pluggable
modules are SR or IR and support an LC fiber connector.

When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is necessary to provision a
4xOC-48 OCHCC circuit.

Note

Key Features
The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards have the following high level features:

• Four 2.5 Gbps client interfaces (OC-48/STM-16) and one 10 Gbps trunk. The four OC-48 signals are
mapped into a ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the transmission
range on these interfaces. The E-FEC functionality increases the correction capability of the transponder
to improve performance, allowing operation at a lower OSNR compared to the standard RS (255,239)
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correction algorithm. A new BCH algorithm implemented in E-FEC allows recovery of an input BER
up to 1E-3.

• Pluggable client interface optic modules: The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards have
modular interfaces. Two types of optics modules can be plugged into the card. These include an
OC-48/STM 16 SR-1 interface with a 7-km (4.3-mile) nominal range (for short range and intra-office
applications) and an IR-1 interface with a range up to 40 km (24.9 miles). SR-1 is defined in Telcordia
GR-253-CORE and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in S-16-1
(ITU-T G.957).

• High level provisioning support: The cards are initially provisioned using Cisco TransportPlanner software.
Subsequently, the card can be monitored and provisioned using CTC software.

• Link monitoring and management: The cards use standard OC-48 OH (overhead) bytes to monitor and
manage incoming interfaces. The cards pass the incoming SDH/SONET data stream and its overhead
bytes transparently.

• Control of layered SONET/SDH transport overhead: The cards are provisionable to terminate regenerator
section overhead. This is used to eliminate forwarding of unneeded layer overhead. It can help reduce
the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: TheMXP_2.5G_10E_C andMXP_2.5G_10E_L cards normally
synchronize from the control card. If for some reason, such as maintenance or upgrade activity, the
control card is not available, the cards automatically synchronize to one of the input client interface
clocks.

• Configurable squelching policy: The cards can be configured to squelch the client interface output if
there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the card
manages MS-AIS insertion.

• The cards are tunable across the full C band (MXP_2.5G_10E_C) or full L band (MXP_2.5G_10E_L),
thus eliminating the need to use different versions of each card to provide tunability across specific
wavelengths in a band.

For information about safety labels for the cards, see the "Class 1 Laser Product Cards” section.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

MXP_2.5G_10E_C and MXP_2.5G_10E_L Functions
The following functions of the MXP_2.5G_10E_C and MXP_2.5G_10E_L cards are explained in the"Card
Features" chapter:

• Client Interface

• DWDM Interface

• Multiplexing Function

• Timing Synchronization

• FEC

• SONET/SDH Overhead Byte Processing

• Client Interface Monitoring
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• Automatic Laser Shutdown

• Jitter

• Lamp Test

• Onboard Traffic Generation

• Card level indicators

• Port level indicators

Wavelength Identification
The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU grid
effectively. Both the MXP_2.5G_10E_C and MXP_2.5G_10E_L cards implement the UT2 module. The
MXP_2.5G_10E_C card uses a C-band version of the UT2 and the MXP_2.5G_10E_L card uses an L-band
version. For MXP_2.5G_10E_C card, the laser is tunable over 82 wavelengths in the C band at 50-GHz
spacing on the ITU grid.

Table 78: MXP_2.5G_10E_C Trunk Wavelengths

Wavelength (nm)Frequency (THz)Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1545.72193.95421529.55196.001

1546.119193.90431529.94195.952

1546.518193.85441530.334195.903

1546.917193.80451530.725195.854

1547.316193.75461531.116195.805

1547.715193.70471531.507195.756

1548.115193.65481531.898195.707

1548.515193.60491532.290195.658

1548.915193.55501532.681195.609

1549.32193.50511533.073195.5510

1549.71193.45521533.47195.5011

1550.116193.40531533.86195.4512

1550.517193.35541534.250195.4013

1550.918193.30551534.643195.3514

1551.319193.25561535.036195.3015

1551.721193.20571535.429195.2516
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Wavelength (nm)Frequency (THz)Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1552.122193.15581535.822195.2017

1552.524193.10591536.216195.1518

1552.926193.05601536.609195.1019

1553.33193.00611537.003195.0520

1553.73192.95621537.40195.0021

1554.134192.90631537.79194.9522

1554.537192.85641538.186194.9023

1554.940192.80651538.581194.8524

1555.343192.75661538.976194.8025

1555.747192.70671539.371194.7526

1556.151192.65681539.766194.7027

1556.555192.60691540.162194.6528

1556.959192.55701540.557194.6029

1557.36192.50711540.953194.5530

1557.77192.45721541.35194.5031

1558.173192.40731541.75194.4532

1558.578192.35741542.142194.4033

1558.983192.30751542.539194.3534

1559.389192.25761542.936194.3035

1559.794192.20771543.333194.2536

1560.200192.15781543.730194.2037

1560.606192.10791544.128194.1538

1561.013192.05801544.526194.1039

1561.42192.00811544.924194.0540

1561.83191.95821545.32194.0041

For MXP_2.5G_10E_L card, the laser is fully tunable over 80 wavelengths in the L band at 50-GHz spacing
on the ITU grid.
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Table 79: MXP_2.5G_10E_L Trunk Wavelengths

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1587.46188.85411570.83190.851

1587.88188.8421571.24190.82

1588.30188.75431571.65190.753

1588.73188.7441572.06190.74

1589.15188.65451572.48190.655

1589.57188.6461572.89190.66

1589.99188.55471573.30190.557

1590.41188.5481573.71190.58

1590.83188.45491574.13190.459

1591.26188.4501574.54190.410

1591.68188.35511574.95190.3511

1592.10188.3521575.37190.312

1592.52188.25531575.78190.2513

1592.95188.2541576.20190.214

1593.37188.15551576.61190.1515

1593.79188.1561577.03190.116

1594.22188.05571577.44190.0517

1594.64188581577.8619018

1595.06187.95591578.27189.9519

1595.49187.9601578.69189.920

1595.91187.85611579.10189.8521

1596.34187.8621579.52189.822

1596.76187.75631579.93189.7523

1597.19187.7641580.35189.724

1597.62187.65651580.77189.6525

1598.04187.6661581.18189.626
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1598.47187.55671581.60189.5527

1598.89187.5681582.02189.528

1599.32187.45691582.44189.4529

1599.75187.4701582.85189.430

1600.17187.35711583.27189.3531

1600.60187.3721583.69189.332

1601.03187.25731584.11189.2533

1601.46187.2741584.53189.234

1601.88187.15751584.95189.1535

1602.31187.1761585.36189.136

1602.74187.05771585.78189.0537

1603.17187781586.2018938

1603.60186.95791586.62188.9539

1604.03186.9801587.04188.940

Related Procedures for MXP_2.5G_10E_C and MXP_2.5G_10E_L Cards
The following is the list of procedures and tasks related to the configuration of MXP_2.5G_10E_C and
MXP_2.5G_10E_L cards:

• NTP-G97 Modifying the 4x2.5G Muxponder Card Line Settings and PM Parameter Thresholds

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance

MXP_MR_2.5G and MXPP_MR_2.5G Cards
The MXP_MR_2.5G card aggregates a mix and match of client Storage Area Network (SAN) service client
inputs (GE, FICON, Fibre Channel, and ESCON) into one 2.5 Gbps STM-16/OC-48 DWDM signal on the
trunk side. It provides one long-reach STM-16/OC-48 port per card and is compliant with Telcordia
GR-253-CORE.
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In Software Release 7.0 and later, two additional operating modes have been made available to the user: pure
ESCON (all 8 ports running ESCON), and mixed mode (Port 1 running FC/GE/FICON, and Ports 5 through
8 running ESCON). When the card is part of a system running Software Release 6.0 or below, only one
operating mode, (FC/GE) is available for use.

Note

The 2.5-GbpsMultirateMuxponder–Protected–100GHz–Tunable 15xx.xx-15yy.yy (MXPP_MR_2.5G) card
aggregates various client SAN service client inputs (GE, FICON, Fibre Channel, and ESCON) into one
2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides two long-reach STM-16/OC-48 ports
per card and is compliant with ITU-T G.957 and Telcordia GR-253-CORE.

Because the cards are tunable to one of four adjacent grid channels on a 100-GHz spacing, each card is available
in eight versions, with 15xx.xx representing the first wavelength and 15yy.yy representing the last wavelength
of the four available on the card. In total, 32 DWDM wavelengths are covered in accordance with the ITU-T
100-GHz grid standard, G.692, and Telcordia GR-2918-CORE, Issue 2.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Table 80: Card Versions

Frequency Channels at 100 GHz (0.8 nm) SpacingCard Version

1532.68 nm1531.90 nm1531.12 nm1530.33 nm1530.33–1532.68

1536.61 nm1535.82 nm1535.04 nm1534.25 nm1534.25–1536.61

1540.56 nm1539.77 nm1538.98 nm1538.19 nm1538.19–1540.56

1544.53 nm1543.73 nm1542.94 nm1542.14 nm1542.14–1544.53

1548.51 nm1547.72 nm1546.92 nm1546.12 nm1546.12–1548.51

1552.52 nm1551.72 nm1550.92 nm1550.12 nm1550.12–1552.52

1556.55 nm1555.75 nm1554.94 nm1554.13 nm1554.13–1556.55

1560.61 nm1559.79 nm1558.98 nm1558.17 nm1558.17–1560.61

The muxponders are intended to be used in applications with long DWDM metro or regional unregenerated
spans. Long transmission distances are achieved through the use of flat gain optical amplifiers.

The client interface supports the following payload types:

• 2G FC

• 1G FC

• 2G FICON

• 1G FICON

• GE

• ESCON
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Because the client payload cannot oversubscribe the trunk, a mix of client signals
can be accepted, up to a maximum limit of 2.5 Gbps.

Note

The current version of the ITU-T Transparent Generic Framing Procedure (GFP-T) G.7041 supports transparent
mapping of 8B/10B block-coded protocols, including Gigabit Ethernet, Fibre Channel, and FICON.

In addition to the GFPmapping, 1-Gbps traffic on Port 1 or 2 of the high-speed serializer/deserializer (SERDES)
is mapped to an STS-24c channel. If two 1-Gbps client signals are present at Port 1 and Port 2 of the SERDES,
the Port 1 signal is mapped into the first STS-24c channel and the Port 2 signal into the second STS-24c
channel. The two channels are then mapped into an OC-48 trunk channel.

Table 81: MXP_MR_2.5G and MXPP_MR_2.5G Client Interface Data Rates and Encapsulation

ITU-T GFP-T G.7041 EncapsulationInput Data RateClient Interface

Yes2.125 Gbps2G FC

Yes1.06 Gbps1G FC

Yes2.125 Gbps2G FICON

Yes1.06 Gbps1G FICON

Yes1.25 GbpsGE

Yes0.2 GbpsESCON

Table 82: Client Data Rates and Ports

Aggregate Data RatePort(s)Mode

2.125 Gbps12G FC

2.125 Gbps1, 21G FC

2.125 Gbps12G FICON

2.125 Gbps1, 21G FICON

2.5 Gbps1, 2GE

1.06 Gbps 0.8 Gbps

1.86 Gbps total

1 ,5, 6, 7, 81G FC -ESCON (mixed mode)

1.06 Gbps 0.8 Gbps

1.86 Gbps total

1 ,5, 6, 7, 81G FICON -ESCON (mixed mode)

1.25 Gbps 0.8 Gbps

Total 2.05 Gbps

1 ,5, 6, 7, 8GE -ESCON (mixed mode)

1.6 Gbps1, 2, 3, 4, 5, 6, 7, 8ESCON
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Faceplates and Block Diagram
Figure 13: MXP_MR_2.5G and MXPP_MR_2.5G Faceplates

For information about safety labels for the cards, see the "Class 1M Laser Product Cards” section.

The card has eight SFP client interfaces. Ports 1 and 2 can be used for GE, FC, FICON, or ESCON. Ports 3
through 8 are used for ESCON client interfaces. There are two SERDES blocks dedicated to the high-speed
interfaces (GE, FC, FICON, and ESCON) and two SERDES blocks for the ESCON interfaces. A FPGA is
provided to support different configurations for different modes of operation. This FPGA has a Universal
Test and Operations Physical Interface for ATM (UTOPIA) interface. A transceiver add/drop multiplexer
(TADM) chip supports framing. Finally, the output signal is serialized and connected to the trunk front end
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with a direct modulation laser. The trunk receive signal is converted into an electrical signal with an avalanche
photodiode (APD), is deserialized, and is then sent to the TADM framer and FPGA.

The MXPP_MR_2.5G is the same, except a 50/50 splitter divides the power at the trunk interface. In the
receive direction, there are two APDs, two SERDES blocks, and two TADM framers. This is necessary to
monitor both the working and protect paths. A switch selects one of the two paths to connect to the client
interface.

Figure 14: MXP_MR_2.5G and MXPP_MR_2.5G Block Diagram

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G and
MXPP_MR_2.5G cards in a loopback configuration on the trunk port. Do not use direct fiber loopbacks with
the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to
the MXP_MR_2.5G and MXPP_MR_2.5G cards.

Caution

MXP_MR_2.5G and MXPP_MR_2.5G Functions
The following functions of the MXP_MR_2.5G and MXPP_MR_2.5G cards are explained in the "Card
Features" chapter:

• Performance Monitoring

• Distance Extension

• Slot Compatibility

• Interoperability with Cisco MDS Switches

• Client and Trunk Ports
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• Automatic Laser Shutdown

• Card level indicators

• Port level indicator

Related Procedures for MXP_MR_2.5G and MXPP_MR_2.5G Cards
The following is the list of procedures and tasks related to the configuration of MXP_MR_2.5G and
MXPP_MR_2.5G cards:

• NTP-G99 Modifying the 2.5G Data Muxponder Card Line Settings and PM Parameter Thresholds, on
page 447

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance

MXP_MR_10DME_C and MXP_MR_10DME_L Cards
The MXP_MR_10DME_C and MXP_MR_10DME_L cards aggregate a mix of client SAN service client
inputs (GE, FICON, and Fibre Channel) into one 10.0 Gbps STM-64/OC-192 DWDM signal on the trunk
side. It provides one long-reach STM-64/OC-192 port per card and is compliant with Telcordia GR-253-CORE
and ITU-T G.957.

The cards support aggregation of the following signal types:

• 1-Gigabit Fibre Channel

• 2-Gigabit Fibre Channel

• 4-Gigabit Fibre Channel

• 1-Gigabit Ethernet

• 1-Gigabit ISC-Compatible (ISC-1)

• 2-Gigabit ISC-Peer (ISC-3)

On the card faceplates, the MXP_MR_10DME_C and MXP_MR_10DME_L
cards are displayed as 10DME_C and 10DME_L, respectively.

Note

The card can be damaged by dropping it. Handle it safely.Caution

Because the client payload cannot oversubscribe the trunk, a mix of client signals
can be accepted, up to a maximum limit of 10 Gbps.

Note
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The MXP_MR_10DME_C card can be installed in Slots 2 to 7 in Cisco NCS 2015 chassis. This card
upgrades to a new bootcode automatically when it is installed between slots 2 and 7. After the bootcode
upgrade, the card can be installed in Slots 2 to 16 of the Cisco NCS 2015 chassis.

The MXP_MR_10DME_C and MXP_MR_10DME_L cards are not compatible
with the MXP_2.5G_10G card, which does not support transparent termination
mode.

Note

TheMXP_MR_10DME_C card features a tunable 1550-nmC-band laser on the trunk port. The laser is tunable
across 82 wavelengths on the ITU grid with 50-GHz spacing betweenwavelengths. TheMXP_MR_10DME_L
features a tunable 1580-nm L-band laser on the trunk port. The laser is tunable across 80 wavelengths on the
ITU grid, also with 50-GHz spacing. Each card supports eight SFP based client ports and one trunk port. The
cards uses dual LC connectors on the trunk side and use SFP modules on the client side for optical cable
termination. The SFP pluggable modules are SR or IR and support an LC fiber connector.

The current version of the GFP-T G.7041 supports transparent mapping of 8B/10B block-coded protocols,
including Gigabit Ethernet, Fibre Channel, ISC, and FICON.

Table 83: MXP_MR_10DME_C and MXP_MR_10DME_L Client Interface Data Rates and Encapsulation

GFP-T G.7041 EncapsulationInput Data RateClient Interface

Yes2.125 Gbps2G FC

Yes1.06 Gbps1G FC

Yes2.125 Gbps2G FICON/2G ISC-Compatible (ISC-1)/
2G ISC-Peer (ISC-3)

Yes1.06 Gbps1G FICON/1G ISC-Compatible (ISC-1)/
1G ISC-Peer (ISC-3)

Yes1.25 GbpsGigabit Ethernet

There are two FPGAs on each MXP_MR_10DME_C and MXP_MR_10DME_L, and a group of four ports
is mapped to each FPGA. Group 1 consists of Ports 1 through 4, and Group 2 consists of Ports 5 through 8.
The following table shows some of the mix and match possibilities on the various client data rates for Ports
1 through 4, and Ports 5 through 8. An X indicates that the data rate is supported in that port.

Table 84: Supported Client Data Rates for Ports 1 through 4 and Ports 5 through 8

4G FC2G FC1G FCGigabit EthernetPort (Group 2)Port (Group 1)

XXXX51

——XX62

—XXX73

——XX84
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GFP-T PM is available through RMON and trunk PM is managed according to Telcordia GR-253-CORE and
ITU G.783/826. Client PM is achieved through RMON for FC and GE.

A buffer-to-buffer credit management scheme provides FC flow control. With this feature enabled, a port
indicates the number of frames that can be sent to it (its buffer credit), before the sender is required to stop
transmitting and wait for the receipt of a “ready” indication The MXP_MR_10DME_C and
MXP_MR_10DME_L cards support FC credit-based flow control with a buffer-to-buffer credit extension of
up to 1600 km (994.1 miles) for 1G FC, up to 800 km (497.1 miles) for 2G FC, or up to 400 km (248.5 miles)
for 4G FC. The feature can be enabled or disabled.

The MXP_MR_10DME_C and MXP_MR_10DME_L cards feature a 1550-nm laser for the trunk/line port
and a 1310-nm or 850-nm laser (depending on the SFP) for the client ports. The cards contains eight 12.5
degree downward tilt SFP modules for the client interfaces. For optical termination, each SFP uses two LC
connectors, which are labeled TX and RX on the faceplate. The trunk port is a dual-LC connector with a 45
degree downward angle.

The throughput of the MXP_MR_10DME_C and MXP_MR_10DME_L cards is affected by the following
parameters:

• Distance extension—If distance extension is enabled on the card, it provides more throughput but more
latency. If distance extension is disabled on the card, the buffer to buffer credits on the storage switch
affects the throughput; higher the buffer to buffer credits higher is the throughput.

For each link to operate at the maximum throughput, it requires a minimum
number of buffer credits to be available on the devices which the link connects
to. The number of buffer credits required is a function of the distance between
the storage switch extension ports and the link bandwidth, that is, 1G, 2G, or 4G.
These buffer credits are provided by either the storage switch (if distance extension
is disabled) or by both the storage switch and the card (if distance extension is
enabled).

Note

• Forward Error Correction (FEC)—If Enhanced FEC (E-FEC) is enabled on the trunk port of the card,
the throughout is significantly reduced in comparison to standard FEC being set on the trunk port.

If distance extension is enabled on the card, the FEC status does not usually affect
the throughput of the card.

Note

• Payload size—The throughput of the card decreases with decrease in payload size.

The resultant throughput of the card is usually the combined effect of the above parameters.

Key Features
The MXP_MR_10DME_C and MXP_MR_10DME_L cards have the following high-level features:

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the transmission
range on these interfaces. The E-FEC functionality increases the correction capability of the transponder
to improve performance, allowing operation at a lower OSNR compared to the standard RS (255,239)
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correction algorithm. A new BCH algorithm implemented in E-FEC allows recovery of an input BER
up to 1E-3.

• Pluggable client interface optic modules: The MXP_MR_10DME_C and MXP_MR_10DME_L cards
have modular interfaces. Two types of optics modules can be plugged into the card. These include an
OC-48/STM 16 SR-1 interface with a 7-km (4.3-mile) nominal range (for short range and intra-office
applications) and an IR-1 interface with a range up to 40 km (24.9 miles). SR-1 is defined in Telcordia
GR-253-CORE and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in S-16-1
(ITU-T G.957).

• Y-cable protection: Supports Y-cable protection between the same card type only, on ports with the same
port number and signal rate. See the "Y-Cable Protection Availability on TXP,MXP, and Xponder Cards”
section for more detailed information.

• High level provisioning support: The cards are initially provisioned using Cisco TransportPlanner software.
Subsequently, the card can be monitored and provisioned using CTC software.

• ALS: A safety mechanism used in the event of a fiber cut. For details regarding ALS provisioning for
the MXP_MR_10DME_C and MXP_MR_10DME_L cards, see the NTP-G162 Changing the ALS
Maintenance Settings section.

• Link monitoring and management: The cards use standard OC-48 OH bytes to monitor and manage
incoming interfaces. The cards pass the incoming SDH/SONET data stream and its OH bytes transparently.

• Control of layered SONET/SDH transport overhead: The cards are provisionable to terminate regenerator
section overhead. This is used to eliminate forwarding of unneeded layer overhead. It can help reduce
the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_MR_10DME_C and MXP_MR_10DME_L cards
normally synchronize from the control card. If for some reason, such as maintenance or upgrade activity,
the control card is not available, the cards automatically synchronize to one of the input client interface
clocks.

MXP_MR_10DME_C and MXP_MR_10DME_L cards cannot be used for line
timing.

Note

• Configurable squelching policy: The cards can be configured to squelch the client interface output if
there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the card
manages MS-AIS insertion.

• The cards are tunable across the full C band (MXP_MR_10DME_C) or full L band
(MXP_MR_10DME_L), thus eliminating the need to use different versions of each card to provide
tunability across specific wavelengths in a band.

• You can provision a string (port name) for each fiber channel/FICON interface on the
MXP_MR_10DME_C and MXP_MR_10DME_L cards, which allows the MDS Fabric Manager to
create a link association between that SAN port and a SAN port on a Cisco MDS 9000 switch.

• From Software Release 9.0, the fast switch feature of MXP_MR_10DME_C and MXP_MR_10DME_L
cards along with the buffer-to-buffer credit recovery feature of MDS switches, prevents reinitialization
of ISL links during Y-cable switchovers.
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For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

MXP_MR_10DME_C and MXP_MR_10DME_L Functions
The following functions of the MXP_MR_10DME_C and MXP_MR_10DME_L cards are explained in the
"Card Features" chapter:

• Card level indicators

• Port level indicators

Wavelength Identification

The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU grid
effectively. Both the MXP_MR_10DME_C and MXP_MR_10DME_L cards implement the UT2 module.
The MXP_MR_10DME_C card uses a C-band version of the UT2 and the MXP_MR_10DME_L card uses
an L-band version.

The MXP_MR_10DME_C card is tunable over 82 wavelengths in the C band at 50-GHz spacing on the ITU
grid.

Table 85: MXP_MR_10DME_C Trunk Wavelengths

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1545.72193.95421529.55196.001

1546.119193.90431529.94195.952

1546.518193.85441530.334195.903

1546.917193.80451530.725195.854

1547.316193.75461531.116195.805

1547.715193.70471531.507195.756

1548.115193.65481531.898195.707

1548.515193.60491532.290195.658

1548.915193.55501532.681195.609

1549.32193.50511533.073195.5510

1549.71193.45521533.47195.5011

1550.116193.40531533.86195.4512

1550.517193.35541534.250195.4013

1550.918193.30551534.643195.3514

1551.319193.25561535.036195.3015
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1551.721193.20571535.429195.2516

1552.122193.15581535.822195.2017

1552.524193.10591536.216195.1518

1552.926193.05601536.609195.1019

1553.33193.00611537.003195.0520

1553.73192.95621537.40195.0021

1554.134192.90631537.79194.9522

1554.537192.85641538.186194.9023

1554.940192.80651538.581194.8524

1555.343192.75661538.976194.8025

1555.747192.70671539.371194.7526

1556.151192.65681539.766194.7027

1556.555192.60691540.162194.6528

1556.959192.55701540.557194.6029

1557.36192.50711540.953194.5530

1557.77192.45721541.35194.5031

1558.173192.40731541.75194.4532

1558.578192.35741542.142194.4033

1558.983192.30751542.539194.3534

1559.389192.25761542.936194.3035

1559.794192.20771543.333194.2536

1560.200192.15781543.730194.2037

1560.606192.10791544.128194.1538

1561.013192.05801544.526194.1039

1561.42192.00811544.924194.0540

1561.83191.95821545.32194.0041
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The MXP_MR_10DME_L card is fully tunable over 80 wavelengths in the L band at 50-GHz spacing on the
ITU grid.

Table 86: MXP_MR_10DME_L Trunk Wavelengths

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1587.46188.85411570.83190.851

1587.88188.8421571.24190.82

1588.30188.75431571.65190.753

1588.73188.7441572.06190.74

1589.15188.65451572.48190.655

1589.57188.6461572.89190.66

1589.99188.55471573.30190.557

1590.41188.5481573.71190.58

1590.83188.45491574.13190.459

1591.26188.4501574.54190.410

1591.68188.35511574.95190.3511

1592.10188.3521575.37190.312

1592.52188.25531575.78190.2513

1592.95188.2541576.20190.214

1593.37188.15551576.61190.1515

1593.79188.1561577.03190.116

1594.22188.05571577.44190.0517

1594.64188581577.8619018

1595.06187.95591578.27189.9519

1595.49187.9601578.69189.920

1595.91187.85611579.10189.8521

1596.34187.8621579.52189.822

1596.76187.75631579.93189.7523

1597.19187.7641580.35189.724

1597.62187.65651580.77189.6525
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1598.04187.6661581.18189.626

1598.47187.55671581.60189.5527

1598.89187.5681582.02189.528

1599.32187.45691582.44189.4529

1599.75187.4701582.85189.430

1600.17187.35711583.27189.3531

1600.60187.3721583.69189.332

1601.03187.25731584.11189.2533

1601.46187.2741584.53189.234

1601.88187.15751584.95189.1535

1602.31187.1761585.36189.136

1602.74187.05771585.78189.0537

1603.17187781586.2018938

1603.60186.95791586.62188.9539

1604.03186.9801587.04188.940

For more information about the MXP_MR_10DME_C and MXP_MR_10DME_L cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/ps5320/product_data_sheet0900aecd803fc51a.html.

Related Procedures for MXP_MR_10DME_C and MXP_MR_10DME_L Cards
The following is the list of procedures and tasks related to the configuration of MXP_MR_10DME_C and
MXP_MR_10DME_L cards:

• NTP-G148 Modifying the 10G Data Muxponder Card Line Settings and PM Parameter Thresholds, on
page 469

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance

40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards
The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards aggregate a variety of client service inputs (Gigabit
Ethernet, Fibre Channel, OTU2, OTU2e, and OC-192) into a single 40-Gbps OTU3/OTU3e signal on the
trunk side.
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In CTC, the 40E-MXP-C and 40ME-MXP-C card is displayed with the same card name, 40E-MXP-C.Note

The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards support aggregation of the following signals:

• With overclock enabled on the trunk port:

• OC-192/STM-64 (only on 40E-MXP-C and 40ME-MXP-C cards)

• 10 Gigabit Fibre Channel

• OTU2e

• 10 Gigabit Ethernet LAN-Phy (CBR mapping) (only on 40E-MXP-C and 40ME-MXP-C cards)

• With overclock disabled on the trunk port:

• 8 Gigabit Fibre Channel

• 10 GigabitEthernet LAN-Phy (GFP framing)

• 10 GigabitEthernet LAN-Phy (WIS framing)

• OC-192/STM-64

• OTU2

Handle the card with care. Dropping or misuse of the card could result in
permanent damage.

Caution

You can install and provision the 40G-MXP-C, cards in a linear configuration in:

• Slots 1 to 5 and 12 to 16 in ONS 15454 DWDM chassis

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 15 in Cisco NCS 2015 chassis (for 40E-MXP-C card)

The client ports of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards interoperates with all the existing
TXP/MXP (OTU2 trunk) cards.

The auto negotiation is not supported on the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards in 8G FC
client mode. Hence, during interoperation, the auto negotiation of the 8G-FC client port of the other device
connected to 8G-FC client port on 40G-MXP-C, 40E-MXP-C, or 40ME-MXP-C card must be set to
Fixed/Disabled.

The client port of 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards do not interoperate with OTU2_XP
card when the signal rate is OTU1e (11.049 Gbps) and the “No Fixed Stuff” option is enabled on the trunk
port of OTU2_XP card.

For OTU2 and OTU2e client protocols, Enhanced FEC (EFEC) is not supported on Port 1 of the 40G-MXP-C,
40E-MXP-C, and 40ME-MXP-C cards.
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Table 87: Client Interface Data Rates for 40G-MXP-C, 40E-MXP-C and 40ME-MXP-C Cards

FEC Configuration Supported on OTU2/OTU2e
Client Protocol

40G-MXP-C, 40E-MXP-C
and 40ME-MXP-C Client
Port

Only Standard FECPort 1

Standard and Enhanced FECPort 2

Standard and Enhanced FECPort 3

Standard and Enhanced FECPort 4

When setting up the card for the first time, or when the card comes up after clearing the LOS-P condition due
to fiber cut, the trunk port of the 40G-MXP-C card takes about 6 minutes to lock a signal. The trunk port of
the 40G-MXP-C card raises an OTUK-LOF alarm when the card is comes up. The alarm clears when the
trunk port locks the signal.

When a protection switch occurs on the 40E-MXP-C and 40ME-MXP-C cards, the recovery from
PSM protection switch takes about 3 to 4 minutes.

Key Features
The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards provides the following key features:

• The 40G-MXP-C card uses the RZ-DQPSK 40G modulation format.

• The 40E-MXP-C and 40ME-MXP-C cards uses the CP-DQPSK modulation format.

• Onboard E-FEC processor—The E-FEC functionality improves the correction capability of the transponder
to improve performance, allowing operation at a lower OSNR compared to the standard RS (239,255)
correction algorithm. A new BCH algorithm implemented (according to G.975.1 I.7) in E-FEC allows
recovery of an input BER up to 1E-3. The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards support
both the standard RS (specified in ITU-T G.709) and E-FEC standard, which allows an improved gain
on trunk interfaces with a resultant extension of the transmission range on these interfaces.

• Y-cable protection—Supports Y-cable protection only between the same card type on ports with the
same port number and signal rate. For more information onY-cable protection, see the "Y-Cable Protection
Availability on TXP, MXP, and Xponder Cards" section.

Y-cable cannot be created on a 10 GE port when WIS framing is enabled on the
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards.

Note

• Unidirectional regeneration—The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards supports
unidirectional regeneration configuration. Each 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C card in
the configuration regenerates the signal received from another 40G-MXP-C, 40E-MXP-C, and
40ME-MXP-C card in one direction.
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When you configure the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards
in the Unidirectional Regen mode, ensure that the payload is not configured on
the pluggable port modules of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C
card.

Note

Figure 15: 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards in Unidirectional Regeneration Configuration

• High level provisioning support—The cards are initially provisioned using Cisco Transport Planner
software. Subsequently, the card can be monitored and provisioned using CTC software.

• Automatic Laser Shutdown (ALS)—A safety mechanism, Automatic Laser Shutdown (ALS), is used in
the event of a fiber cut. The Auto Restart ALS option is supported only for OC-192/STM-64 and OTU2
payloads. The Manual Restart ALS option is supported for all payloads. For more information on
provisioning ALS for the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards, see the NTP-G162
Changing the ALS Maintenance Settings section.

• Control of layered SONET/SDH transport overhead—The cards are provisionable to terminate regenerator
section overhead. This is used to eliminate forwarding of unneeded layer overhead. It can help reduce
the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization—The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards
synchronize to the card cards. Because of a maintenance or upgrade activity, if the control cards are not
available, the cards automatically synchronize to one of the input client interface clocks.

• Squelching policy—The cards are set to squelch the client interface output if there is LOS at the DWDM
receiver, or if there is a remote fault. In the event of a remote fault, the card manages MS-AIS insertion.

• The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards are tunable across the full C-band wavelength.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Wavelength Identification
The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards use trunk lasers that are wavelocked, which allows
the trunk transmitter to operate on the ITU grid effectively. These cards implement the UT2 module; they use
a C-band version of the UT2. The laser is tunable over 82 wavelengths in the C-band at 50-GHz spacing on
the ITU grid.
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Table 88: 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Trunk Wavelengths

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1545.72193.95421529.55196.001

1546.119193.90431529.94195.952

1546.518193.85441530.334195.903

1546.917193.80451530.725195.854

1547.316193.75461531.116195.805

1547.715193.70471531.507195.756

1548.115193.65481531.898195.707

1548.515193.60491532.290195.658

1548.915193.55501532.681195.609

1549.32193.50511533.073195.5510

1549.71193.45521533.47195.5011

1550.116193.40531533.86195.4512

1550.517193.35541534.250195.4013

1550.918193.30551534.643195.3514

1551.319193.25561535.036195.3015

1551.721193.20571535.429195.2516

1552.122193.15581535.822195.2017

1552.524193.10591536.216195.1518

1552.926193.05601536.609195.1019

1553.33193.00611537.003195.0520

1553.73192.95621537.40195.0021

1554.134192.90631537.79194.9522

1554.537192.85641538.186194.9023

1554.940192.80651538.581194.8524

1555.343192.75661538.976194.8025

1555.747192.70671539.371194.7526
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1556.151192.65681539.766194.7027

1556.555192.60691540.162194.6528

1556.959192.55701540.557194.6029

1557.36192.50711540.953194.5530

1557.77192.45721541.35194.5031

1558.173192.40731541.75194.4532

1558.578192.35741542.142194.4033

1558.983192.30751542.539194.3534

1559.389192.25761542.936194.3035

1559.794192.20771543.333194.2536

1560.200192.15781543.730194.2037

1560.606192.10791544.128194.1538

1561.013192.05801544.526194.1039

1561.42192.00811544.924194.0540

1561.83191.95821545.32194.0041

For more information on 40G-MXP-C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/datasheet_c78-598898.html.

For more information on 40E-MXP-C and 40ME-MXP-C cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-606950.html.

Related Procedures for 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards
The following is the list of procedures and tasks related to the configuration of 40G-MXP-C, 40E-MXP-C,
and 40ME-MXP-C cards:

• NTP-G293 Modifying the 40G Muxponder Card Line Settings and PM Parameter Thresholds, on page
479

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G75 Monitor Transponder and Muxponder Performance
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GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards

GE_XPE card is the enhanced version of the GE_XP card and 10GE_XPE card is the enhanced version of
the 10GE_XP card.

Note

The cards aggregate Ethernet packets received on the client ports for transport on C-band trunk ports that
operate on a 100-GHz grid. The trunk ports operate with ITU-T G.709 framing and either FEC or E-FEC.
The GE_XP and 10GE_XP cards are designed for bulk point-to-point transport over 10GE LAN PHY
wavelengths for Video-on-Demand (VOD), or broadcast video across protected 10GE LANPHYwavelengths.
The GE_XPE and 10GE_XPE cards are designed for bulk GE_XPE or 10GE_XPE point-to-point,
point-to-multipoint,multipoint-to-multipoint transport over 10GELANPHYwavelengths for Video-on-Demand
(VOD), or broadcast video across protected 10GE LAN PHY wavelengths.

When all the cards in the chassis are simultaneously reset by the user, the GE_XP and 10GE_XP cards undergo
a hard reset instead of a soft reset. This causes traffic loss for traffic going through these cards.

Note

You can install and provision the GE_XP, and GE_XPE cards in a linear configuration in:

• Slots 1 to 5 and 12 to 16 in ONS 15454 DWDM chassis

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 6 in ONS 15454 M6 chassis

• Slots 2 to 7 in Cisco NCS 2015 chassis. These cards upgrade to a new bootcode automatically when they
are installed between slots 2 and 7.

After the bootcode upgrade, the cards can be installed in Slots from 2 to 16 in Cisco NCS 2015 chassis.

The 10GE_XP and 10GE_XPE cards can be installed in Slots 1 through 6 or 12 through 17. The GE_XP and
GE_XPE are double-slot cards with twenty Gigabit Ethernet client ports and two 10 Gigabit Ethernet trunk
ports. The 10GE_XP and 10GE_XPE are single-slot cards with two 10 Gigabit Ethernet client ports and two
10 Gigabit Ethernet trunk ports. The client ports support SX, LX, and ZX SFPs and SR and 10GBASE-LR
XFPs. (LR2 XFPs are not supported.) The trunk ports support a DWDM XFP.

The RAD pluggables (ONS-SC-E3-T3-PW= and ONS-SC-E1-T1-PW=) do not support:

• No loopbacks (Terminal or Facility)

• RAI (Remote Alarm Indication) alarm

• AIS and LOS alarm

A fan-tray assembly (15454E-CC-FTA for the ETSI shelf, or 15454-CC-FTA
for the ANSI shelf) must be installed in a shelf where a GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card is installed.

Caution
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GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards can be provisioned to perform different Gigabit Ethernet
transport roles. All the cards can work as Layer 2 switches. However, the 10GE_XP and 10GE_XPE cards
can also perform as a 10 Gigabit Ethernet transponders (10GE TXP mode), and the GE_XP and GE_XPE
can perform as a 10 Gigabit Ethernet or 20 Gigabit Ethernet muxponders (10GE MXP or 20GEMXP mode).

Changing the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cardmode requires the ports to be in a OOS-DSBL
(ANSI) or Locked, disabled (ETSI) service state. In addition, no circuits can be provisioned on the cards when
the mode is being changed.

Note

Table 89: GE_XP, 10GE_XP, GE_XPE, and 10GE_XPECard Modes

DescriptionCardsCard Mode

Provides capability to switch between any two ports irrespective of client
or trunk port. Supported Ethernet protocols and services include 1+1
protection, QoS (Quality of Service), CoS (Class of Service), QinQ,MAC
learning, MAC address retrieval, service provider VLANs (SVLANs),
IGMP snooping and Multicast VLAN Registration (MVR), link integrity,
and other Ethernet switch services.

GE_XP

10GE_XP

GE_XPE

10GE_XPE

Layer 2
Ethernet
switch

Provides a point-to-point application in which each 10 Gigabit Ethernet
client port is mapped to a 10 Gigabit Ethernet trunk port.

10GE_XP

10GE_XPE

10GE TXP

Provides the ability to multiplex the twenty Gigabit Ethernet client ports
on the card to one or both of its 10 Gigabit Ethernet trunk ports. The card
can be provisioned as a single MXP with twenty Gigabit Ethernet client
ports mapped to one trunk port (Port 21) or as twoMXPs with ten Gigabit
Ethernet client ports mapped to a trunk port (Ports 1 to 10 mapped to Port
21, and Ports 11-20 mapped to Port 22).

GE_XP

GE_XPE

10GE MXP

20GE MXP

Key Features
The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards have the following high-level features:

• Link Aggregation Control Protocol (LACP) that allows you to bundle several physical ports together to
form a single logical channel.

• Ethernet Connectivity FaultManagement (CFM) protocol that facilitates proactive connectivitymonitoring,
fault verification, and fault isolation.

• Ethernet Operations, Administration, and Maintenance (OAM) protocol that facilitates link monitoring,
remote failure indication, and remote loopback.

• Resilient Ethernet Protocol (REP) that controls network loops, handles link failures, and improves
convergence time.

• Configurable service VLANs (SVLANs) and customer VLANs (CVLANs).

• Ingress rate limiting that can be applied on both SVLANs and CVLANs. You can create SVLAN and
CVLAN profiles and can associate a SVLAN profile to both UNI and NNI ports; however, you can
associate a CVLAN profile only to UNI ports.
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• CVLAN rate limiting that is supported for QinQ service in selective add mode.

• Differentiated Services Code Point (DSCP) to class of service (CoS) mapping that you can configure for
each port. You can configure the CoS of the outer VLAN based on the incoming DSCP bits. This feature
is supported only on GE_XPE and 10GE_XPE cards.

• Ports, in Layer 2 switchmode, can be provisioned as network-to-network interfaces (NNIs) or user-network
interfaces (UNIs) to facilitate service provider to customer traffic management.

• Broadcast drop-and-continue capability for VOD and broadcast video applications.

• Gigabit Ethernet MXP, TXP, and Layer 2 switch capability.

• Far-End Laser Control (FELC) that is supported on copper SFPs from Release 8.52 and later releases.
For more information on FELC, see the "Far-End Laser Control” section.

• Layer 2 switch mode that provides VLAN translation, QinQ, ingress CoS, egress QoS, Fast Ethernet
protection switching, and other Layer 2 Ethernet services.

• Interoperable with TXP_MR_10E and TXP_MR_10E_C cards. Also interoperable with Cisco Catalyst
6500 and Cisco 7600 series Gigabit Ethernet, 10 GE interfaces and CRS-1 10GE interfaces.

• The GE_XP and GE_XPE cards have twenty Gigabit Ethernet client ports and two 10 Gigabit Ethernet
trunk ports. The 10GE_XP and 10GE_XPE cards have two 10 Gigabit Ethernet client ports and two 10
Gigabit Ethernet trunk ports. The client Gigabit Ethernet signals are mapped into an ITU-T G.709 OTU2
signal using standard ITU-TG.709multiplexingwhen configured in one of theMXPmodes (10GEMXP
or 20GE MXP).

• ITU-T G.709 framing with standard Reed-SoloMon (RS) (255,239) FEC. Performance monitoring and
ITU-T G.709 Optical Data Unit (ODU) synchronous and asynchronous mapping. E-FEC with ITU-T
G.709 ODU and 2.7 Gbps with greater than 8 dB coding gain.

• IEEE 802.3 frame format that is supported for 10 Gigabit Ethernet interfaces. The minimum frame size
is 64 bytes. The maximum frame size is user-provisionable.

• MAC learning capability in Layer 2 switch mode.

• MAC address retrieval in cards provisioned in the L2-over-DWDM mode.

• When a port is in UNI mode, tagging can be configured as transparent or selective. In transparent mode,
only SVLANs in the VLAN database of the node can be configured. In selective mode, a CVLAN-
to-SVLAN relationship can be defined.

• Layer 2 VLAN port mapping that allows the cards to be configured as multiple Gigabit Ethernet TXPs
and MXPs.

• Y-cable protection is configurable in TXP and MXP modes.

• Two protection schemes are available in Layer 2 mode. They are:

• 1+1 protection—Protection scheme to address card, port, or shelf failures for client ports.

• Fast Automatic Protection—Protection scheme to address card, port, or shelf failures for trunk ports.

• End-to-end Ethernet link integrity.

• Pluggable client interface optic modules (SFPs and XFPs)—Client ports support tri-rate SX, LX, and
ZX SFPs, and 10-Gbps SR1 XFPs.
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• Pluggable trunk interface optic modules; trunk ports support the DWDM XFP.

• Internet Group Management Protocol (IGMP) snooping that restricts the flooding of multicast traffic by
forwarding multicast traffic to those interfaces where a multicast device is present.

• Multicast VLAN Registration (MVR) for applications using wide-scale deployment of multicast traffic
across an Ethernet ring-based service provider network.

• Ingress CoS that assigns a CoS value to the port from 0 (highest) to 7 (lowest) and accepts CoS of
incoming frames.

• Egress QoS that defines the QoS capabilities for the egress port.

• MAC address learning that facilitates switch processing.

• Storm Control that limits the number of packets passing through a port. You can define the maximum
number of packets allowed per second for the following types of traffic: Broadcast, Multicast, and Unicast.
The threshold for each type of traffic is independent and the maximum number of packets allowed per
second for each type of traffic is 16777215.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Protocol Compatibility list
Table 90: Protocol Compatibility List for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards

EFMCFMLACPREPIGMPFAPS1+1LIProtocol

NoYesNoNoYesYesNoLI

NoYesNoNoYesYesNo1+1

NoYesNoNoYesYesYesFAPS

NoYesNoYesYesYesYesIGMP

NoYesNoYesNoNoNoREP

NoNoNoNoNoNoNoLACP

NoNoYesYesYesYesYesCFM

NoNoNoNoNoNoNoEFM

The 10GE_XP and 10GE_XPE card trunk ports are displayed as follows:

• Trunk 1 and Trunk 2 on the faceplate

• 3-1 and 4-1 on CTC

• 3 (Trunk) and 4 (Trunk) on the Optics Thresholds table
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Client Interface
The client interface is implemented with separately orderable SFP or XFP modules. The client interfaces
support the following tri-rate SFPs and XFPs using dual LC connectors and multimode fiber:

• SFP - GE/1G-FC/2G-FC - 850 nm - MM - LC (PID ONS-SE-G2F-SX)

• SFP - GE/1G-FC/2G-FC 1300 nm - SM - LC (PID ONS-SE-G2F-LX)

• SFP - GE/1G-FC/2G-FC 1300 nm - SM - LC (PID ONS-SE-G2F-ZX)

• SFP - 10/100/1000Base-T - Copper (PID ONS-SE-ZE-EL) Intra office up to 100; Cable: RJ45 STP
CAT5, CAT5E, and CAT6

• SFP - 1000Base BX D/Gigabit Ethernet 1550 nm - SM - LC (PID ONS-SE-GE-BXD)

• SFP - 1000Base BX U/Gigabit Ethernet 1550 nm - SM - LC (PID ONS-SE-GE-BXU)

• SFP - Fast Ethernet 1310 nm - SM - LC (PID ONS-SI-100-LX10)

• SFP - Fast Ethernet 1310 nm - MM - LC (PID ONS-SI-100-FX)

• SFP - Fast Ethernet over DS1/E1 - SM - LC (PID ONS-SC-EOP1)

• SFP - Fast Ethernet over DS3/E3 - SM - LC (PID ONS-SC-EOP3)

• SFP - E1/DS1 over Fast Ethernet - SM - LC (PID ONS-SC-E1-T1-PW)

• SFP - E3/DS3 PDH over Fast Ethernet - SM - LC (PID ONS-SC-E3-T3-PW)

Figure 16: Recommended Topology for Using ONS-SC-E1-T1-PW and ONS -SC-E3-T3-PW SFPs

The client interfaces support the following dual-rate XFP using dual LC connectors and single-mode fiber:

• XFP - OC-192/STM-64/10GE/10-FC/OTU2 - 1310 SR - SM LC (PID: ONS-XC-10G-S1)

• XFP - 10GE - 1550 nm - SM - LC (PID ONS-XC-10G-L2)

• XFP - 10GE - 1550 nm - SM - LC (PID ONS-XC-10G-C)

If ONS-XC-10G-CXFP is used onGE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards on client port 1, the maximum temperature at which the system qualifies
is +45 degree Celsius.

Note
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The client interfaces support the following multimode XFP using dual LC connectors and multi-mode fiber:

• XFP - OC-192/10GFC/10GE - 850 nm MM LC (PID ONS-XC-10G-SR-MM)

DWDM Trunk Interface
The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards have two 10 Gigabit Ethernet trunk ports operating
at 10 Gigabit Ethernet (10.3125 Gbps) or 10 Gigabit Ethernet into OTU2 (nonstandard 11.0957 Gbps). The
ports are compliant with ITU-T G.707, ITU-T G.709, and Telcordia GR-253-CORE standards. The ports are
capable of carrying C-band and L-band wavelengths through insertion of DWDM XFPs. Forty channels are
available in the 1550-nm C band 100-GHz ITU grid, and forty channels are available in the L band.

The maximum system reach in filterless applications without the use of optical amplification or regenerators
is nominally rated at 23 dB over C-SMF and NZ-DS SMF fibers. This rating is not a product specification,
but is given for informational purposes. It is subject to change.

Configuration Management
The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards support the following configuration management
parameters:

• Port name—User-assigned text string.

• Admin State/Service State—Administrative and service states to manage and view port status.

• MTU—Provisionable maximum transfer unit (MTU) to set the maximum number of bytes per frames
accepted on the port.

• Mode—Provisional port mode, either Autonegotiation or the port speed.

• Flow Control—Flow control according to IEEE 802.1x pause frame specification can be enabled or
disabled for TX and RX ports.

• Bandwidth—Provisionable maximum bandwidth allowed for the port.

• Ingress CoS—Assigns a CoS value to the port from 0 (highest) to 7 (lowest) and accepts CoS of incoming
frames.

• Egress QoS—Defines the QoS capabilities at the egress port.

• NIM—Defines the port network interfacemanagement type based onMetro Ethernet Forum specifications.
Ports can be defined as UNI or NNI.

• MAC Learning—MAC address learning to facilitate switch processing.

• VLAN tagging provided according to the IEEE 802.1Q standard.

When the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards are provisioned
in a MXP or TXPmode, only the following parameters are available: Port Name,
State, MTU, Mode, Flow control, and Bandwidth.

Note
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Security
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card ports can be provisioned to block traffic from a user-defined
set ofMAC addresses. The remaining traffic is normally switched. You canmanually specify the set of blocked
MAC addresses for each port. Each port of the card can receive traffic from a limited predefined set of MAC
addresses. The remaining traffic will be dropped. This capability is a subset of the Cisco IOS “Port Security”
feature.

Card Protection
The following card protection schemes are available for the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards.

• Y-Cable protection

• 1+1 protection

• L2 over DWDM protection- Fast Automatic Protection Switch (FAPS)

Related Procedures for Card Protection
The following are the related procedures for creating card protection on GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards:

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G198 Creating 1+1 Protection for Cards, on page 342

• DLP-G381 Provisioning Layer 2 Protection Settings, on page 554

IGMP Snooping
As networks increase in size, multicast routing becomes critically important as a means to determine which
segments require multicast traffic and which do not. IP multicasting allows IP traffic to be propagated from
one source to a number of destinations, or from many sources to many destinations. Rather than sending one
packet to each destination, one packet is sent to the multicast group identified by a single IP destination group
address. GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards can learn up to a maximum of 1024 multicast
groups. This includes groups on all the VLANs.

Internet GroupManagement Protocol (IGMP) snooping restricts the flooding of multicast traffic by forwarding
multicast traffic to those interfaces where a multicast device is present.

When the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card receives an IGMP leave group message from a
host, it removes the host port from the multicast forwarding table after generating group specific queries to
ensure that no other hosts interested in traffic for the particular group are present on that port. Even in the
absence of any “leave” message, the cards have a timeout mechanism to update the group table with the latest
information. After a card relays IGMP queries from the multicast router, it deletes entries periodically if it
does not receive any IGMP membership reports from the multicast clients.

In a multicast router, general queries are sent on a VLAN when Protocol Independent Multicast (PIM) is
enabled on the VLAN. The GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card forwards queries to all ports
belonging to the VLAN. All hosts interested in this multicast traffic send Join requests and are added to the
forwarding table entry. The Join requests are forwarded only to router ports. By default, these router ports are
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learned dynamically. However, they can also be statically configured at the port level in which case the static
configuration overrides dynamic learning.

For information about interaction of IGMP with other protocols, see the Protocol Compatibility list.

IGMP Snooping Guidelines and Restrictions
The following guidelines and restrictions apply to IGMP snooping on GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards:

• IGMP snooping V2 is supported as specified in RFC 4541.

• IGMP snooping V3 is not supported and the packets are flooded in the SVLAN.

• Layer 2 multicast groups learned through IGMP snooping are dynamic.

• GE_XP and 10GE_XP cards support IGMP snooping on 128 stacked VLANs and GE_XPE and
10GE_XPE cards support up to 256 stacked VLANs that are enabled.

• IGMP snooping can be configured per SVLAN or CVLAN. By default, IGMP snooping is disabled on
all SVLANs and CVLANs.

• IGMP snooping on CVLAN is enabled only when:

• MVR is enabled.

• UNI ports are in selective add and selective translate modes. For each UNI port, a CVLAN must
be specified for which IGMP snooping is to be enabled.

• IGMP snooping can be enabled only on one CVLAN per port. If you enable IGMP snooping on CVLAN,
you cannot enable IGMP snooping on the associated SVLAN and vice versa. The number of VLANs
that can be enabled for IGMP snooping cannot exceed 128.

• When IGMP snooping is enabled on double-tagged packets, CVLAN has to be the same on all ports
attached to the same SVLAN.

• When IGMP snooping is working with the Fast Automatic Protection Switch (FAPS) in a ring-based
setup, it is advisable to configure all NNI ports as static router ports. This minimizes the multicast traffic
hit when a FAPS switchover occurs.

The following conditions are raised from IGMP snooping at the card:

• MCAST-MAC-TABLE-FULL—This condition is raised when the multicast table is full and a new join
request is received. This table is cleared when at least one entry gets cleared from the multicast table
after the alarm is raised.

• MCAST-MAC-ALIASING—This condition is raised when there are multiple L3 addresses that map to
the same L2 address in a VLAN. This is a transient condition.

For more information on severity level of these conditions and procedure to clear these alarms, refer to the
Cisco ONS 15454 DWDM Troubleshooting Guide.
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Fast-Leave Processing

Fast-Leave processing is also known as Immediate-Leave.Note

IGMP snooping Fast-Leave processing allows the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE to remove
an interface that sends a leave message from the forwarding table without first sending group specific queries
to the interface. When you enable IGMP Fast-Leave processing, the card immediately removes a port from
the IP multicast group when it detects an IGMP, version 2 (IGMPv2) leave message on that port.

Static Router Port Configuration
Multicast-capable ports are added to the forwarding table for every IP multicast entry. The card learns of such
ports through the PIM method.

Report Suppression
Report suppression is used to avoid a storm of responses to an IGMP query. When this feature is enabled, a
single IGMP report is sent to each multicast group in response to a single query. Whenever an IGMP snooping
report is received, report suppression happens if the report suppression timer is running. The Report suppression
timer is started when the first report is received for a general query. Then this time is set to the response time
specified in general query.

IGMP Statistics and Counters
An entry in a counter contains multicasting statistical information for the IGMP snooping capable GE_XP,
10GE_XP, GE_XPE, or 10GE_XPE card. It provides statistical information about IGMP messages that have
been transmitted and received. IGMP statistics and counters can be viewed via CTC from the Performance >
Ether Ports > Statistics tab.

This information can be stored in the following counters:

• cisTxGeneralQueries—Number of general queries transmitted through an interface.

• cisTxGroupSpecificQueries—Total group specific queries transmitted through an interface.

• cisTxReports—Total membership reports transmitted through an interface.

• cisTxLeaves—Total Leave messages transmitted through an interface.

• cisRxGeneralQueries—Total general queries received at an interface.

• cisRxGroupSpecificQueries—Total Group Specific Queries received at an interface.

• cisRxReports—Total Membership Reports received at an interface.

• cisRxLeaves—Total Leave messages received at an interface.

• cisRxValidPackets—Total valid IGMP packets received at an interface.

• cisRxInvalidPackets—Total number of packets that are not valid IGMPmessages received at an interface.
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Related Procedure for Enabling IGMP Snooping
To enable IGMP snooping on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the NTP-G204
Enabling IGMP Snooping on a Card, on page 572.

Multicast VLAN Registration
Multicast VLAN Registration (MVR) is designed for applications using wide-scale deployment of multicast
traffic across an Ethernet-ring-based service provider network (for example, the broadcast of multiple television
channels over a service-provider network). MVR allows a subscriber on a port to subscribe and unsubscribe
to a multicast stream on the network-wide multicast VLAN. It allows the single multicast VLAN to be shared
in the network while subscribers remain in separate VLANs. MVR provides the ability to continuously send
multicast streams in the multicast VLAN, but to isolate the streams from the subscriber VLANs for bandwidth
and security reasons.

MVR assumes that subscriber ports subscribe and unsubscribe (“Join” and “Leave”) these multicast streams
by sending out IGMP Join and Leave messages. These messages can originate from an IGMP
version-2-compatible host with an Ethernet connection.MVR operates on the underlying mechanism of IGMP
snooping. MVR works only when IGMP snooping is enabled.

The card identifies the MVR IP multicast streams and their associated MAC addresses in the card forwarding
table, intercepts the IGMP messages, and modifies the forwarding table to include or remove the subscriber
as a receiver of the multicast stream, even though the receivers is in a different VLAN than the source. This
forwarding behavior selectively allows traffic to cross between different VLANs.

When MVR is configured, the port facing the router must be configured as NNI in order to allow the router
to generate or send multicast stream to the host with the SVLAN. If router port is configured as UNI, the
MVR will not work properly.

Note

Related Procedure for Enabling MVR
To enable MVR on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the NTP-G206 Enabling
MVR on a Card, on page 574.

MAC Address Learning
The GE_XPE and 10 GE_XPE cards support 32K MAC addresses. MAC address learning can be enabled or
disabled per SVLAN on GE_XPE and 10 GE_XPE cards. The cards learn the MAC address of packets they
receive on each port and add the MAC address and its associated port number to the MAC address learning
table. As stations are added or removed from the network, the GE_XPE and 10 GE_XPE cards update the
MAC address learning table, adding new dynamic addresses and aging out those that are currently not in use.

MAC address learning can be enabled or disabled per SVLAN. When the configuration is changed from
enable to disable, all the related MAC addresses are cleared. The following conditions apply:

• If MAC address learning is enabled on per port basis, the MAC address learning is not enabled on all
VLANs, but only on VLANs that have MAC address learning enabled.

• If per port MAC address learning is disabled then the MAC address learning is disabled on all VLANs,
even if it is enabled on some of the VLAN supported by the port.
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• If the per port MAC address learning is configured on GE-XP and 10 GE-XP cards, before upgrading
to GE-XPE or 10 GE-XPE cards, enable MAC address learning per SVLAN. Failing to do so disables
MAC address learning.

Related Procedure for MAC Address Learning
To enable MAC address learning on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the
DLP-G221 Enabling MAC Address Learning on SVLANs, on page 561.

MAC Address Retrieval
MAC addresses learned can be retrieved or cleared on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards
provisioned in L2-over-DWDMmode. The MAC addresses can be retrieved using the CTC or TL1 interface.

GE_XPE and 10GE_XPE cards support 32K MAC addresses and GE_XP and 10GE_XP cards support 16K
MAC addresses. To avoid delay in processing requests, the learned MAC addresses are retrieved using an
SVLAN range. The valid SVLAN range is from 1 to 4093.

The MAC addresses of the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards can also be retrieved. The
card MAC addresses are static and are used for troubleshooting activities. One MAC address is assigned to
each client, trunk, and CPU ports of the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card. These internal
MAC addresses can be used to determine if the packets received on the far-end node are generated by GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

For MAC address retrieval, the following conditions apply:

• The cards must be provisioned in L2-over-DWDM mode.

• MAC address learning must be enabled per SVLAN on GE_XPE or 10 GE_XPE cards.

• MAC address learning must be enabled per port on GE_XP or 10 GE_XP cards.

Related Procedure for MAC Address Retrieving
To retrieve and clear MAC addresses on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the
NTP-G237 Retrieving and Clearing MAC Addresses on SVLANs, on page 564.

Link Integrity
The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card support end-to-end Ethernet link integrity. This
capability is integral to providing an Ethernet private line service and correct operation of Layer 2 and Layer
3 protocols on the attached Ethernet devices.

The link integrity feature propagates a trunk fault on all the affected SVLAN circuits in order to squelch the
far end client interface. Ethernet-Advanced IP Services (E-AIS) packets are generated on a per-port/SVLAN
basis. An E-AIS format is compliant with ITU Y.1731.

E-AIS packets are marked with a CoS value of 7 (also called .1p bits). Ensure that the network is not overloaded
and there is sufficient bandwidth for this queue in order to avoid packet drops.

Note
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When link integrity is enabled on a per-port SVLAN basis, E-AIS packets are generated when the following
alarms are raised;

• LOS-P

• OTUKLOF/LOM

• SIGLOSS

• SYNCHLOSS

• OOS

• PPM not present

When link integrity is enabled, GE_XP and 10 GE_XP card supports up to128 SVLANs and GE_XPE, 10
GE_XPE can support up to 256 SVLANs.

Related Procedure for Enabling Link Integrity
To enable link integrity on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the NTP-G205
Enabling Link Integrity on a Card, on page 567.

Ingress CoS
Ingress CoS functionality enables differentiated services across the GE_XPE and 10GE_XPE cards. A wide
range of networking requirements can be provisioned by specifying the class of service applicable to each
transmitted traffic.

When a CVLAN is configured as ingress CoS, the per-port settings are not considered. A maximum of 128
CVLAN and CoS relationships can be configured.

Related Procedure for Enabling Ingress CoS
To enable Ingress CoS on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the:

• DLP-G380 Provisioning Ethernet Settings, on page 542

• DLP-G612 Modifying the Parameters of the Channel Group Using CTC, on page 508

CVLAN Rate Limiting
CVLAN rate limiting is supported on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards. CVLAN rate
limiting is supported for QinQ service in selective add mode. The following limitations and restrictions apply
to CVLAN rate limiting:

• CVLAN rate limiting is not supported for the following service types:

• Selective translate mode

• Transparent mode

• Selective double add mode

• Selective translate add mode
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• Untagged packets

• CVLAN range

• Services associated with the channel group

• CVLAN rate limiting and SVLAN rate limiting cannot be applied to the same service instance.

• Pseudo-IOS command line interface (PCLI) is not supported for CVLAN rate limiting.

• A VLAN profile with Link Integrity option enabled cannot be used to perform CVLAN rate limiting.

• On GE_XP and 10 GE_XP cards, CVLAN rate limiting can be applied to up to 128 services. However,
the number of provisionable CVLAN rate limiting service instances is equal to 192 minus the number
of SVLAN rate limiting service instances present on the card (subject to a minimum of 64 CVLAN rate
limiting service instances).

• On GE_XPE and 10 GE_XPE cards, CVLAN rate limiting can be applied to up to 256 services. However,
the number of provisionable CVLAN rate limiting service instances is equal to 384 minus the number
of SVLAN rate limiting service instances present on the card (subject to a minimum of 128 CVLAN rate
limiting service instances).

Related Procedure for Provisioning CVLAN Rate
To provision CVLAN rate on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the DLP-G289
Provisioning CVLAN Rate Limiting on a Card, on page 569.

DSCP to CoS Mapping
DSCP to CoS mapping can be configured for each port. You can configure the CoS of the outer VLAN based
on the incoming DSCP bits. This feature is supported only on GE_XPE and 10GE_XPE cards. PCLI is not
supported for DSCP to CoS mapping.

DSCP to CoS mapping is supported for the following service types:

• Selective add mode

• Selective translate mode

• Transparent mode

• Selective double add mode

• Selective translate add mode

• Untagged packets

• CVLAN range

• Services associated with the channel group

Related Procedure for Provisioning CoS Based on DSCP
To provision CoS based on DSCP on the GE_XPE and 10GE_XPE cards, see the DLP-G384 Provisioning
the QinQ Settings, on page 559.
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Link Aggregation Control Protocol
Link Aggregation Control Protocol (LACP) is part of the IEEE802.3ad standard that allows you to bundle
several physical ports together to form a single logical channel. LACP allows a network device such as a
switch to negotiate an automatic bundling of links by sending LACP packets to the peer device.

LACP allows you to form a single Layer 2 link automatically from two or more Ethernet links. This protocol
ensures that both ends of the Ethernet link are functional and agree to be members of the aggregation group
before the link is added to the group. LACP must be enabled at both ends of the link to be operational.

For more information on LACP, refer to the IEEE802.3ad standard. For information about interaction of
LACP with other protocols, see the Protocol Compatibility list.

Advantages of LACP
LACP provides the following advantages:

• High-speed network that transfers more data than any single port or device.

• High reliability and redundancy. If a port fails, traffic continues on the remaining ports.

• Hashing algorithm that allows to apply load balancing policies on the bundled ports.

Functions of LACP
LACP performs the following functions in the system:

• Maintains configuration information to control aggregation.

• Exchanges configuration information with other peer devices.

• Attaches or detaches ports from the link aggregation group based on the exchanged configuration
information.

• Enables data flow when both sides of the aggregation group are synchronized.

Modes of LACP
LACP can be configured in the following modes:

• On — Default. In this mode, the ports do not exchange LACP packets with the partner ports.

• Active — In this mode, the ports send LACP packets at regular intervals to the partner ports.

• Passive— In this mode, the ports do not send LACP packets until the partner sends LACP packets. After
receiving the LACP packets from the partner ports, the ports send LACP packets.

Parameters of LACP
LACP uses the following parameters to control aggregation:

• System Identifier—A unique identification assigned to each system. It is the concatenation of the system
priority and a globally administered individual MAC address.

• Port Identification—A unique identifier for each physical port in the system. It is the concatenation of
the port priority and the port number.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
189

Provisioning Transponder and Muxponder Cards
Link Aggregation Control Protocol



• Port Capability Identification—An integer, called a key, that identifies the capability of one port to
aggregate with another port. There are two types of keys:

• Administrative key—The network administrator configures this key.

• Operational key—The LACP assigns this key to a port, based on its aggregation capability.

• Aggregation Identifier—A unique integer that is assigned to each aggregator and is used for identification
within the system.

Unicast Hashing Schemes
LACP supports the following unicast hashing schemes:

• Ucast SA VLAN Incoming Port

• Ucast DA VLAN Incoming Port

• Ucast SA DA VLAN Incoming port

• Ucast Src IP TCP UDP

• Ucast Dst IP TCP UDP

• Ucast Src Dst IP TCP UDP

Unicast hashing schemes apply to unicast traffic streams only when the destination
MAC address is already learned by the card. Hence, MAC learning must be
enabled to support load balancing as per the configured hashing scheme. If the
destination MAC address is not learned, the hashing scheme is Ucast Src Dst IP
TCP UDP.

Note

LACP Limitations and Restrictions
The LACP on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following limitations and
restrictions:

• Hot standby link state is not supported on the channel group.

• Marker protocol generator is not supported.

• ALS cannot be configured on the channel group.

• Loopback configuration cannot be applied on the channel group.

Related Procedure for LACP
To provision Channel Group using LACP, see the NTP-G281 Managing the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE Card Channel Group Settings, on page 506.
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Ethernet Connectivity Fault Management
Ethernet Connectivity Fault Management (CFM) is part of the IEEE 802.1ag standard. The Ethernet CFM is
an end-to-end per service instance that supports the Ethernet layer Operations, Administration, andManagement
(OAM) protocol. It includes proactive connectivity monitoring, link trace on a per service basis, fault
verification, and fault isolation for large Ethernet metropolitan-area networks (MANs) and WANs.

CFM is disabled on the card by default. CFM is enabled on all the ports by default.

For more information on CFM, refer to the IEEE 802.1ag standard. For information about interaction of CFM
with other protocols, see the Protocol Compatibility list. The following sections contain conceptual information
about Ethernet CFM.

Maintenance Domain
A maintenance domain is an administrative domain that manages and administers a network. You can assign
a unique maintenance level (from 0 to 7) to define the hierarchical relationship between domains. The larger
the domain, the higher the maintenance level for that domain. For example, a service provider domain would
be larger than an operator domain and might have a maintenance level of 6, while the operator domain
maintenance level would be 3 or 4.

Maintenance domains cannot intersect or overlap because that would require more than one entity to manage
it, which is not allowed. Domains can touch or nest if the outer domain has a higher maintenance level than
the nested domain. Maintenance levels of nesting domains must be communicated among the administrating
organizations. For example, one approach would be to have the service provider assign maintenance levels
to operators.

The CFMprotocol supports up to eight maintenance domains onGE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards.

Maintenance Association
A maintenance association identifies a service within the maintenance domain. You can have any number of
maintenance associationswithin eachmaintenance domain. The CFMprotocol supports up to 1500maintenance
associations on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Each maintenance association is mapped to a maintenance domain. This mapping is done to configure a
Maintenance End Point (MEP). The CFM protocol supports up to 1000 mappings on GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards.

Note

Maintenance End Points
Maintenance End Points (MEPs) reside at the edge of the maintenance domain and are active elements of the
Ethernet CFM. MEPs transmit Continuity Check messages at periodic intervals and receive similar messages
from other MEPs within a domain. MEPs also transmit Loopback and Traceroute messages at the request of
the administrator. MEPs confine CFM messages within the boundary of a maintenance domain through the
maintenance level. There are two types of MEPs:

• Up (Inwards, towards the bridge)

• Down (Outwards, towards the wire).
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You can create up to 255 MEPs and MIPs together on GE_XP and 10GE_XP cards. You can create up to 500
MEPs and MIPs together on GE_XPE and 10GE_XPE cards.

The MEP continuity check database (CCDB) stores information that is received from other MEPs in the
maintenance domain. The card can store up to 4000 MEP CCDB entries.

Maintenance Intermediate Points
Maintenance Intermediate Points (MIPs) are internal to the maintenance domain and are passive elements of
the Ethernet CFM. They store information received fromMEPs and respond to Linktrace and Loopback CFM
messages. MIPs forward CFM frames received from MEPs and other MIPs, drop all CFM frames at a lower
level, and forward all CFM frames at a higher level.

You can create up to 255 MEPs and MIPs together on GE_XP and 10GE_XP cards. You can create up to 500
MEPs and MIPs together on GE_XPE and 10GE_XPE cards.

The MIP CCDB maintains the information received for all MEPs in the maintenance domain. The card can
store up to 4000 MIP CCDB entries.

CFM Messages
The Ethernet CFM on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards supports the following messages:

• Continuity Check—These messages are exchanged periodically among MEPs. They allow MEPs to
discover other MEPs within a domain and allow MIPs to discover MEPs. These messages are confined
to a domain.

• Loopback—Thesemessages are unicast messages that aMEP transmits, at the request of an administrator,
to verify connectivity to a specific maintenance point. A reply to a loopback message indicates whether
a destination is reachable.

• Traceroute—These messages are multicast messages that a MEP transmits, at the request of an
administrator, to track the path to a destination MEP.

CFM Limitations and Restrictions
The CFM on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following limitations and
restrictions:

• CFM is not supported on channel groups.

• CFM is not enabled on protected ports running REP, FAPS, and 1+1.

• Y.1731 enhancements including AIS, LCK, and performance monitoring messages along with CFM are
not supported.

• IEEE CFM MIB is not supported.

• L1 and CFM are mutually exclusive on a SVLAN because LI and CFM use the same MAC address.

• MAC security and CFM are mutually exclusive on the card due to hardware resource constraints.

Related Procedure for Ethernet CFM
For information about the supported Ethernet CFM features on the GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards, see the NTP-G283 Managing the Card CFM Settings, on page 517.
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Ethernet OAM
The Ethernet OAM protocol is part of the IEEE 802.3ah standard and is used for installing, monitoring, and
troubleshooting Ethernet MANs and Ethernet WANs. This protocol relies on an optional sublayer in the data
link layer of the OSI model. The Ethernet OAM protocol was developed for Ethernet in the First Mile (EFM)
applications. The terms Ethernet OAM and EFM are interchangeably used and both mean the same.

Normal link operation does not require Ethernet OAM. You can implement Ethernet OAM on any full-duplex
point-to-point or emulated point-to-point Ethernet link for a network or part of a network (specified interfaces).
OAM frames, called OAMProtocol Data Units (OAMPDUs), use the slow protocol destinationMAC address
0180.c200.0002. OAM PDUs are intercepted by the MAC sublayer and cannot propagate beyond a single
hop within an Ethernet network.

Ethernet OAM is disabled on all interfaces by default. When Ethernet OAM is enabled on an interface, link
monitoring is automatically turned on.

For more information on Ethernet OAM protocol, refer to IEEE 802.3ah standard. For information about
interaction of Ethernet OAM with other protocols, see the Protocol Compatibility list.

Components of the Ethernet OAM
Ethernet OAM consists of two major components, the OAM Client and the OAM Sublayer.

OAM Client

The OAM client establishes and manages the Ethernet OAM on a link. The OAM client also enables and
configures the OAM sublayer. During the OAM discovery phase, the OAM client monitors the OAM PDUs
received from the remote peer and enables OAM functionality. After the discovery phase, the OAM client
manages the rules of response to OAM PDUs and the OAM remote loopback mode.

OAM Sublayer

The OAM sublayer presents two standard IEEE 802.3 MAC service interfaces:

• One interface facing toward the superior sub-layers, which include the MAC client (or link aggregation).

• Other interface facing toward the subordinate MAC control sublayer.

The OAM sublayer provides a dedicated interface for passing OAM control information and OAM PDUs to
and from the client.

Benefits of the Ethernet OAM
Ethernet OAM provides the following benefits:

• Competitive advantage for service providers

• Standardized mechanism to monitor the health of a link and perform diagnostics

Features of the Ethernet OAM
The Ethernet OAM protocol has the following OAM features:

• Discovery—Identifies devices in the network and their OAM capabilities. The Discovery feature uses
periodic OAM PDUs to advertise the OAM mode, configuration, and capabilities. An optional phase
allows the local station to accept or reject the configuration of the peer OAM entity.
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• Link Monitoring—Detects and indicates link faults under a variety of conditions. It uses the event
notification OAM PDU to notify the remote OAM device when it detects problems on the link.

• Remote Failure Indication—Allows an OAM entity to convey the failure conditions to its peer through
specific flags in the OAM PDU.

• Remote Loopback—Ensures link quality with a remote peer during installation or troubleshooting.

Ethernet OAM Limitations and Restrictions
The Ethernet OAM on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following limitations
and restrictions:

• CFM, REP, link integrity, LACP, FAPS, IGMP on SVLAN and L2 1+1 protection are not supported
with EFM.

• IEEE EFM MIB is not supported.

• EFM cannot be enabled or disabled at the card level.

• Unidirectional functionality is not supported.

• Errored Symbol Period, Rx CRC errors, Tx CRC errors are not supported.

• OAM PDUs are limited to 1 frame per second.

• Dying Gasp and critical events are not supported.

Dying Gasp RFI is not generated on GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards. However, if the peer device sends a dying gasp RFI, the card
detects it and raises an alarm.

Note

Related Procedure for Ethernet OAM
For information about the supported Ethernet OAM features on the GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards, see the NTP-G285 Managing the Card EFM Settings, on page 529.

Resilient Ethernet Protocol
The Resilient Ethernet Protocol (REP) is a protocol used to control network loops, handle link failures, and
improve convergence time.

REP performs the following tasks:

• Controls a group of ports connected in a segment.

• Ensures that the segment does not create any bridging loops.

• Responds to link failures within the segment.

• Supports VLAN load balancing.

For information about interaction of REP with other protocols, see the Protocol Compatibility list.
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REP Segments
A REP segment is a chain of ports connected to each other and configured with a segment ID. Each segment
consists of regular segment ports and two edge ports. A GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card
can have up to 2 ports that belong to the same segment, and each segment port can have only one external
neighbor port.

A segment protects only against a single link failure. Any more failures within the segment result in loss of
connectivity.

Characteristics of REP Segments
REP segments have the following characteristics:

• If all the ports in the segment are operational, one port blocks traffic for each VLAN. If VLAN load
balancing is configured, two ports in the segment control the blocked state of VLANs.

• If any port in the segment is not operational, all the other operational ports forward traffic on all VLANs
to ensure connectivity.

• In case of a link failure, the alternate ports are immediately unblocked. When the failed link comes up,
a logically blocked port per VLAN is selected with minimal disruption to the network.

REP Port States
Ports in REP segments take one of three roles or states: Failed, Open, or Alternate.

• A port configured as a regular segment port starts as a failed port.

• When the neighbor adjacencies are determined, the port transitions to the alternate port state, blocking
all the VLANs on the interface. Blocked port negotiations occur and when the segment settles, one
blocked port remains in the alternate role and all the other ports become open ports.

• When a failure occurs in a link, all the ports move to the failed state. When the alternate port receives
the failure notification, it changes to the open state, forwarding all VLANs.

Link Adjacency
Each segment port creates an adjacency with its immediate neighbor. Link failures are detected and acted
upon locally. If a port detects a problem with its neighbor, the port declares itself non-operational and REP
converges to a new topology.

REP Link Status Layer (LSL) detects its neighbor port and establishes connectivity within the segment. All
VLANs are blocked on an interface until the neighbor port is identified. After the neighbor port is identified,
REP determines the neighbor port that must be the alternate port and the ports that must forward traffic.

Each port in a segment has a unique port ID. When a segment port starts, the LSL layer sends packets that
include the segment ID and the port ID.

A segment port does not become operational if the following conditions are satisfied:

• No neighbor port has the same segment ID or more than one neighbor port has the same segment ID.

• The neighbor port does not acknowledge the local port as a peer.
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Fast Reconvergence
REP runs on a physical link and not on per VLAN. Only one hello message is required for all VLANs that
reduces the load on the protocol.

REP Hardware Flood Layer (HFL) is a transmission mechanism that floods packets in hardware on an admin
VLAN. HFL avoids the delay that is caused by relaying messages in software. HFL is used for fast
reconvergence in the order of 50 to 200 milliseconds.

VLAN Load Balancing
You must configure two edge ports in the segment for VLAN load balancing. One edge port in the REP
segment acts as the primary edge port; the other edge port as the secondary edge port. The primary edge port
always participates in VLAN load balancing in the segment. VLAN load balancing is achieved by blocking
certain VLANs at a configured alternate port and all the other VLANs at the primary edge port.

REP Configuration Sequence
You must perform the following tasks in sequence to configure REP:

• Configure the REP administrative VLAN or use the default VLAN 1. The range of REP admin VLAN
is 1 to 4093. VLAN 4094 is not allowed.

• Add ports to the segment in interface configuration mode.

• Enable REP on ports and assign a segment ID to it. REP is disabled on all ports by default. The range
of segment ID is 1 to 1024.

• Configure two edge ports in the segment; one port as the primary edge port and the other as the secondary
edge port.

• If you configure two ports in a segment as the primary edge port, for example, ports on different switches,
REP selects one of the ports to serve as the primary edge port based on port priority. The Primary option
is enabled only on edge ports.

• Configure the primary edge port to send segment topology change notifications (STCNs) and VLAN
load balancing to another port or to other segments. STCNs and VLAN load balancing configurations
are enabled only for edge ports.

A port can belong to only one segment. Only two ports can belong to the same
segment. Both the ports must be either regular ports or edge ports. However, if
the No-neighbor port is configured, one port can be an edge port and another port
can be a regular port.

Note

REP Supported Interfaces
REP supports the following interfaces:

• REP is supported on client (UNI) and trunk (NNI) ports.

• Enabling REP on client ports allows protection at the access or aggregation layer when the cards are
connected to the L2 network.
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• Enabling REP on trunk ports allows protection at the edge layer when the cards are connected in a ring.

REP Limitations and Restrictions
The REP on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following limitations and
restrictions:

• Fast re-convergence and VLAN load balancing are not supported on UNI ports in transparent mode.

• Native VLAN is not supported.

• CFM, EFM, link integrity, LACP, FAPS, and L2 1+1 protection are not supported on ports that are
configured as part of REP segment and vice versa.

• When a node installed with GE_XP, GE_XPE, 10GE_XP, or 10GE_XPE cards configured with REP or
LACP is upgraded, traffic loss may occur. This traffic loss is due to reconvergence when the cards soft
reset during the upgrade process.

• NNI ports cannot be configured as the primary edge port or blocking port at the access or aggregation
layer.

• Only three REP segments can be configured on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

• Consider the following configuration:

More than one REP closed segment is configured on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards and the same HFL admin VLAN is enabled on the switches.

If two different segments are configured on more than one common switch, the following consequences
happen.

• Layer 1 loop

• Flooding of HFL packets across segments if one REP segment fails

• Segment goes down due to LSL time out even if the segment does not have faults

Hence, it is recommended not to configure two different segments onmore than one common switch.

• Consider the following configuration:

• VLAN Load Balancing is configured on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards by
specifying the VLB preempt delay.

• Primary and secondary edge ports are configured on the same switch.

• HFL or LSL is activated.

This configuration leads to high convergence time during manual premption, VLB activation, and
deactivation (400 to 700 milliseconds).

Related Procedure for Managing the REP Settings
To manage the REP settings on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the NTP-G287
Managing the Card REP Settings, on page 534.

For more information about the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see:
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• http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd805ebef7.html

• http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/product_data_sheet0900aecd805ec093.html

Related Procedures for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards
The following is the list of procedures and tasks related to the configuration of the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards:

• NTP-G165 Modifying the Ethernet, Line and PM Thresholds, on page 540

• NTP-G311 Provisioning the Storm Control Settings, on page 566

• NTP-G208 Provisioning SVLAN Rate Limiting on a Card, on page 569

• NTP-G314 Adding a Card on FAPS Ring, on page 585

• NTP-G75 Monitor Transponder and Muxponder Performance

ADM-10G Card
The ADM-10G card operates on ONS 15454 SONET, ONS 15454 SDH, ONS 15454 M2, ONS 15454 M6,
and DWDM networks to carry optical signals and Gigabit Ethernet signals over DWDM wavelengths for
transport. The card aggregates lower bit-rate client SONET or SDH signals (OC-3/STM-1, OC-12/STM-4,
OC-48/STM-16, or Gigabit Ethernet) onto a C-band tunable DWDM trunk operating at a higher
OC-192/STM-64 rate. In a DWDM network, the ADM-10G card transports traffic over DWDM by mapping
Gigabit Ethernet and SONET or SDH circuits onto the same wavelength with multiple protection options.

You can install and provision the ADM-10G card in a linear configuration in:

• Slots 1 to 5 and 12 to 16 in standard and high-density ONS 15454 ANSI shelves (15454-SA-ANSI or
15454-SA-HD), the ETSI ONS 15454 standard shelf assembly, or the ONS 15454 ETSI high-density
shelf assembly

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 6 in ONS 15454 M6 chassis

Fan-tray assembly 15454E-CC-FTA (ETSI shelf)/15454-CC-FTA (ANSI shelf)
must be installed in a shelf where the ADM-10G card is installed.

Caution

The card is compliant with ITU-T G.825 and ITU-T G.783 for SDH signals. It supports concatenated and
non-concatenated AU-4 mapped STM-1, STM-4, and STM-16 signals as specified in ITU-T G.707. The card
also complies with Section 5.6 of Telcordia GR-253-CORE and supports synchronous transport signal (STS)
mapped OC-3, OC-12, and OC-48 signals as specified in the standard.

The client SFP and trunk XFP are compliant with interface requirements in Telcordia GR-253-CORE,
ITU-T G.957 and/or ITU-T G.959.1, and IEEE 802.3.
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Key Features
The ADM-10G card has the following high-level features:

• Operates with the control card.

• Interoperable with TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10EX_C, and OTU2_XP cards.

• Has built-in OC-192/STM-64 add/drop multiplexing function including client, trunk, and STS
cross-connect.

• Supports both single-card and double-card (ADM-10G peer group) configuration.

• Supports path protection/SNCP on client and trunk ports for both single-card and double-card
configuration. The card does not support path protection/SNCP between a client port and a trunk port.
Path protection/SNCP is supported only between two client ports or two trunk ports.

• Supports 1+1 protection on client ports for double-card configuration only.

• Supports SONET, SDH, and Gigabit Ethernet protocols on client SFPs.

• Supports XFP DWDM trunk interface single wavelengths.

• Returns zero bit errors when a control card switches from active to standby or when manual or forced
protection switches occur.

• Has 16 SFP-based client interfaces (gray, colored, coarse wavelength division multiplexing (CWDM),
and DWDM optics available).

• Supports STM1, STM4, STM16, and Gigabit Ethernet client signals (8 Gigabit Ethernet maximum).

• Has one XFP-based trunk interface supporting E-FEC/FEC and ITU-T G.709 for double-card
configuration.

• Has twoXFP-based trunk interface supporting E-FEC/FEC and ITU-TG.709 for single-card configuration.

• Has two SR XFP interlink interfaces supporting redundancy connection with protection board and
pass-through traffic for double-card configuration.

• Supports frame-mapped generic framing procedure (GFP-F) and LEXmapping for Ethernet over SONET
or SDH.

• Can be installed or pulled from operation, in any slot, without impacting other service cards in the shelf.

• Supports client to client hairpinning, that is, creation of circuits between two client ports for both
single-card and double-card configuration. See the Circuit Provisioning for more detailed information.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

ADM-10G POS Encapsulation, Framing, and CRC
The ADM-10G card supports Cisco EoS LEX (LEX) and generic framing procedure framing (GFP-F)
encapsulation on 8 POS ports corresponding to 8 GigE ports (Port 1 to Port 8) in both single-card and
double-card (ADM-10G peer group) configuration.

You can provision framing on the ADM-10G card as either the default GFP-F or LEX framing. With GFP-F
framing, you can configure a 32-bit cyclic redundancy check (CRC) or none (no CRC) (the default). LEX
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framing supports 16-bit or 32-bit CRC configuration. The framing type cannot be changed when there is a
circuit on the port.

On the CTC, navigate to card view and click the Provisioning > Line> Ethernet Tab. To see the various
parameters that can be configured on the ethernet ports, see the “CTC Display of ethernet Port Provisioning
Status” section in the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature and
Configuration Guide. Parameters such as, admin state, service state, framing type, CRC, MTU and soak time
for a port can be configured.

It is possible to create an end-to-end circuit between equipment supporting different kinds of encapsulation
(for example, LEX on one side and GFP-F on other side). But, under such circumstances, traffic does not pass
through, and an alarm is raised if there is a mismatch.

POS Overview
Ethernet data packets need to be framed and encapsulated into a SONET/SDH frame for transport across the
SONET/SDH network. This framing and encapsulation process is known as packet over SONET/SDH (POS).

The Ethernet frame comes into the ADM-10G card on a standard Gigabit Ethernet port and is processed
through the card’s framing mechanism and encapsulated into a POS frame. When the POS frame exits, the
ADM-10G card is in a POS circuit, and this circuit is treated as any other SONET circuit (STS) or SDH circuit
(VC) in the node. It is cross-connected and rides the SONET/SDH signal out the port of an optical card and
across the SONET/SDH network.

The destination of the POS circuit is a card or a device that supports the POS interface. Data packets in the
destination card frames are removed and processed into ethernet frames. The Ethernet frames are then sent
to a standard Ethernet port of the card and transmitted onto an Ethernet network.

POS Framing Modes
A POS framing mode is the type of framing mechanism employed by the ADM-10G card to frame and
encapsulate data packets into a POS signal. These data packets were originally encapsulated in Ethernet frames
that entered the standard Gigabit Ethernet interface of the ADM-10G card.

GFP-F Framing

The GFP-F framing represent standard mapped Ethernet over GFP-F according to ITU-T G.7041. GFP-F
defines a standard-based mapping of different types of services onto SONET/SDH. GFP-F maps one variable
length data packet onto one GFP packet. GFP-F comprises of common functions and payload specific functions.
Common functions are those shared by all payloads. Payload-specific functions are different depending on
the payload type. GFP-F is detailed in the ITU recommendation G.7041.

LEX Framing

LEX encapsulation is a HDLC frame based Cisco Proprietary protocol, where the field is set to values specified
in Internet Engineering Task Force (IETF) RFC 1841. HDLC is one of the most popular Layer 2 protocols.
The HDLC frame uses the zero insertion/deletion process (commonly known as bit stuffing) to ensure that
the bit pattern of the delimiter flag does not occur in the fields between flags. The HDLC frame is synchronous
and therefore relies on the physical layer to provide a method of clocking and synchronizing the transmission
and reception of frames. The HDLC framing mechanism is detailed in the IETF’s RFC 1662, “PPP in
HDLC-like Framing.”
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GFP Interoperability
The ADM-10G card defaults to GFP-F encapsulation that is compliant with ITU-T G.7041. This mode allows
the card to operate with ONS 15310-CL, ONS 15310-MA, ONS 15310-MA SDH, or ONS 15454 data cards
(for example, ONS 15454 CE100T-8 or ML1000-2 cards). GFP encapsulation also allows the ADM-10G
card to interoperate with other vendors Gigabit Ethernet interfaces that adhere to the ITU-T G.7041 standard.

LEX Interoperability
The LEX encapsulation is compliant with RFC 1841. Thismode allows the card to operate with ONS 15310-CL,
ONS 15310-MA, ONS 15310-MA SDH, or ONS 15454 data cards (for example, G1000-4/G1K-4 cards,
CE-1000-4, ONS 15454 CE100T-8 or ML1000-2 cards).
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Faceplate and Block Diagram
Figure 17: ADM-10G Card Faceplate and Block Diagram
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Port Configuration Rules
Figure 18: ADM-10G Card Port Capacities

Port 17 acts as trunk2 or ILK1 interface based on single-card or double-card configuration.

Client Interfaces
The ADM-10G card uses LC optical port connectors supports up to 16 SFPs that can be utilized for
OC-N/STM-N traffic. Eight of the SFPs can be used for Gigabit Ethernet. The interfaces can support any mix
of OC-3/STM-1, OC-12/STM-4, OC-48/STM-16, or Gigabit Ethernet of any reach, such as SX, LX, ZX, SR,
IR, or LR. The interfaces support a capacity of:

• 4 x OC-48/STM-16

• 16 x OC-12/STM-4

• 16 x OC-3/STM-1

• 8 x GE

The supported client SFPs and XFPs are:

• Gray SFPs

• 1000Base-SX SFP 850 nm (ONS-SE-G2F-SX=)

• 1000Base-LX SFP 1310 nm (ONS-SE-G2F-LX=)

• OC48/STM16 IR1, OC12/STM4 SR1, OC3/STM1 SR1, GE-LX multirate SFP 1310 nm
(ONS-SE-Z1=)

• OC3/STM1 IR1, OC12/STM4 IR1 multirate SFP 1310 nm (ONS-SI-622-I1=)

• OC48/STM16 SR1 SFP 1310 nm (ONS-SI-2G-S1=)

• OC48/STM16 IR1 SFP 1310 nm (ONS-SI-2G-I1=)

• OC48/STM16, 1550 LR2, SM LC (ONS-SE-2G-L2=)

• Colored DWDM SFPs

• 1000Base-ZX SFP 1550 nm (ONS-SI-GE-ZX=)

• OC3/STM1 LR2 SFP 1550 nm (ONS-SI-155-L2=)
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• OC48/STM16 LR2 SFP 1550 nm (ONS-SI-2G-L2=)

• OC48/STM16 SFP (ONS-SC-2G-xx.x)

xx.x = 28.7 to 60.6. ONS-SC-2G-28.7, ONS-SC-2G-33.4, ONS-SC-2G-41.3,
ONS-SC-2G-49.3, and ONS-SC-2G-57.3 are supported from Release 8.5 and
later.

Note

• CWDM SFPs

• OC48/STM16/GE CWDM SFP (ONS-SC-Z3-xxxx)

• XFPs

• OC-192/STM-64/10GE XFP 1550 nm (ONS-XC-10G-I2)

Interlink Interfaces
Two 2R interlink interfaces, called ILK1 (Port 17) and ILK2 (Port 18), are provided for creation of ADM-10G
peer groups in double-card configurations. In a single-card configuration, Port 17 (OC-192/STM-64) and Port
18 (OC-192/STM-64 or OTU2 payload) must be configured as trunk interfaces. In a double-card configuration
(ADM-10G peer group), Ports 17 and 18 must be configured as ILK1 and ILK2 interfaces, respectively.
Physically cabling these ports between twoADM-10G cards, located on the same shelf, allows you to configure
them as an ADM-10G peer group.The ILK ports carry 10 Gb of traffic each.

The interlink interfaces support STM64 SR1 (ONS-XC-10G-S1=) XFP and 10GE BASE SR
(ONS-XC-10G-SR-MM=) XFPs.

DWDM Trunk Interface
The ADM-10G card supports OC-192/STM-64 signal transport and ITU-T G.709 digital wrapping according
to the ITU-T G.709 standard.The ADM-10G card supports three trunk XFPs:

• Two DWDM trunks, and one trunk interface in a single-card configuration.

• One DWDM trunk XFP in a double-card configuration.

The supported DWDM trunk XFPs are:

• 10G DWDM (ONS-XC-10G-xx.x=) (colored XFP)

• STM64 SR1 (ONS-XC-10G-S1=) (gray XFP)

Configuration Management
When using OC-48/STM-16 traffic, some contiguous port configurations are unavailable due to hardware
limitations. This limitation does not impact the Gigabit Ethernet payload.
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The ADM-10G card cannot be used in the same shelf with SONET or SDH cross-connect cards.Note

Table 91: OC-48/STM-16 Configuration Limitations

Ports Restricted from Optical TrafficOC-48/STM-16 Port Number

No OC-N/STM-N on Port 1 through Port 3OC-48/STM-16 on Port 13

No OC-N/STM-N on Port 4 through Port 6OC-48/STM-16 on Port 14

No OC-N/STM-N on Port 7 through Port 9OC-48/STM-16 on Port 15

No OC-N/STM-N on Port 10 through Port 12OC-48/STM-16 on Port 16

The total traffic rate for each trunk cannot exceed OC-192/STM-64 on each ADM-10G card, or for each
ADM-10G peer group.

Note

Gigabit Ethernet is supported on Ports 1 through 8. Ports 9 through Port 12 support only OC-3/STM-1 or
OC-12/STM-4.

Note

Additionally, the following guidelines apply to the ADM-10G card:

• Trunk Port 17 supports OC-192/STM-64.

• Trunk Ports 18 and 19 support OC-192/STM-64 and OTU2.

• The interlink port supports OC-192/STM-64.

• Up to six ADM-10G cards can be installed in one shelf.

• Up to 24 ADM-10G cards can be installed per network element (NE) regardless of whether the card is
installed in one shelf or in multiple shelves.

• The card can be used in all 15454-SA-ANSI and 15454-SA-HD shelves as well as ETSI ONS 15454
standard and high-density shelves.

• A lamp test function can be activated from CTC to ensure that all LEDs are functional.

• The card can operate as a working protected or working non-protected card.

• In a redundant configuration, an active card hardware or software failure triggers a switch to the standby
card. This switch is detected within 10 ms and is completed within 50 ms.

• ADM-10G cards support jumbo frames with MTU sizes of 64 to 9,216 bytes; the maximum is 9,216.

• After receiving a link or path failure, the ADM-10G card can shut down only the downstream Gigabit
Ethernet port.
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In ADM-10G cards, the Gigabit Ethernet port does not support flow control.Note

Security
The ADM-10G card that an SFP or XFP is plugged into implements the Cisco Standard Security Code Check
Algorithm that keys on the vendor ID and serial number.

If a pluggable port module (PPM) is plugged into a port on the card but fails the security code check because
it is not a Cisco PPM, a minor NON-CISCO-PPM alarm is raised.

If a PPM with an unqualified product ID is plugged into a port on this card—that is, the PPM passes the
security code as a Cisco PPM but it has not been qualified for use on the ADM-10G card— a minor
UNQUAL-PPM alarm is raised.

Protection
The ADM-10G card supports 1+1 and SONET path protection and SDH SNCP protection architectures in
compliance with Telcordia GR-253-CORE, Telcordia GR-1400-CORE, and ITU-T G.841 specifications.

Circuit Protection Schemes
The ADM-10G card supports path protection/SNCP circuits at the STS/VC4 (high order) level and can be
configured to switch based on signal degrade calculations. The card supports path protection/SNCP on client
and trunk ports for both single-card and double-card configuration.

The ADM-10G card supports path protection/SNCP between client ports and trunk port 17. The card does
not support path protection/SNCP between client ports and trunk ports 18 or 19. The card does not support
path protection/SNCP between port 17 and trunk ports 18 and 19.

Note

The card allows open-ended path protection/SNCP configurations incorporating other vendor equipment. In
an open-ended path protection/SNCP, you can specify one source point and two possible endpoints (or two
possible source points and one endpoint) and the legs can include other vendor equipment. The source and
endpoints are part of the network discovered by CTC.

Port Protection Schemes
The ADM-10G card supports unidirectional and bidirectional 1+1 APS protection schemes on client ports
for double-card configuration (ADM-10G peer group) only. 1+1 APS protection scheme is not supported in
single-card configuration. For 1+1 optical client port protection, you can configure the system to use any pair
of like facility interfaces that are on different cards of the ADM-10G peer group.

Circuit Provisioning
The ADM-10G card supports STS circuit provisioning both in single-card and double-card (ADM-10G peer
group) configuration. The card allows you to create STS circuits between:
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• Client and trunk ports

• Two trunk ports

• Two client ports (client-to-client hairpinning)

Circuits between two trunk ports are called pass-through circuits.Note

For an ADM-10G card in single-card configuration, if you are creating STS circuits between two client ports,
the following limitation must be considered:

• Gigabit Ethernet to Gigabit Ethernet connections are not supported.

For an ADM-10G card that is part of an ADM-10G peer group, if you are creating STS circuits between two
client ports or between client and trunk ports, the following limitations must be considered:

• Gigabit Ethernet to Gigabit Ethernet connections are not supported.

• Optical channel (OC) to OC, OC to Gigabit Ethernet, and Gigabit Ethernet to OC connections between
two peer group cards are supported. Peer group connections use interlink port bandwidth, hence, depending
on the availability/fragmentation of the interlink port bandwidth, it may not be possible to create an STS
circuit from the Gigabit Ethernet/OC client port to the peer card trunk port. This is because, contiguous
STSs (that is, STS-3c, STS-12c, STS-24c, and so on) must be available on the interlink port for circuit
creation.

An alarm is raised on the port having the STS circuit created on the port of the ADM-10G card. Right
click the alarm and choose Select Affected Circuits to view the circuits affected by this alarm. CTC
informs that no STS circuits are affected by the alarm instead of highlighting the circuit passing over
that port in Circuits pane.

There are no limitations to create an STS circuit between two trunk ports.Note

The two ADM-10G cards used in a paired mode use interlink ports ILK1 (Port 17) and ILK2 (Port 18). A
CCAT or VCAT circuit created between the peer ADM-10G cards uses the ILK1 port if the source or destination
is Port 19. The circuits created with a single ADM-10G card uses the ILK2 port.

If the circuit is of type STS-nc (where n is an integer and can take values 3,6,9,12,18,24,36,48,96) and uses
the ILK2 port, then the starting timeslot needs to use specific timeslots for traffic to flow. The timeslots can
be 12m+1 for STS-12c circuits and 48m+1 (where m is an integer and can take values 0,1,2,3...) for STS-48c
circuits. The timeslots can be 3m+1 for the other STS-nc circuits.

The following example illustrates how to use the correct timeslot for an ILK2 port:

If there is no circuit on the ILK2 port and a STS-3c circuit is created, the circuit uses timeslots 1 to 3. An
STS-12c circuit must be created on the ILK2 port later. The STS-12c circuit must have used timeslots 4 to
15. However, the STS-12c circuit uses timeslots starting from 12m+1 (1, 13, 25, and so on) as defined in the
above rule. Therefore, before creating the STS-12c circuit, dummy circuits must be created in CTC that
consumes STS-9 bandwidth.
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ADM-10G CCAT and VCAT Characteristics
TheADM-10G card supports high-order (HO) contiguous concatenation (CCAT) andHO virtual concatenation
(VCAT) circuits on 8 GigE ports (Port 1 to Port 8) in both single-card and double-card (ADM-10G peer group)
configuration.

To enable end-to-end connectivity in a VCAT circuit that traverses through a third-party network, you can
use Open-Ended VCAT circuit creation.

The ADM-10G card supports flexible non-LCASVCAT groups (VCGs). With flexible VCGs, the ADM-10G
can perform the following operations:

• Add or remove members from groups

• Put members into or out of service, which also adds/removes them from the group

• Add or remove cross-connect circuits from VCGs

Any operation on the VCG member is service effecting (for instance, adding or removing members from the
VCG). Adding or removing cross-connect circuits is not service-affecting, if the associated members are not
in the group

The ADM-10G card allows independent routing and protection preferences for each member of a VCAT
circuit. You can also control the amount of VCAT circuit capacity that is fully protected, unprotected, or uses
Protection Channel Access (PCA) (when PCA is available). Alarms are supported on a per-member as well
as per virtual concatenation group (VCG) basis.

The ADM-10G card supports both automatic and manual routing for VCAT circuit, that is, all members are
manually or automatically routed. Bidirectional VCAT circuits are symmetric, which means that the same
number of members travel in each direction. With automatic routing, you can specify the constraints for
individual members; with manual routing, you can select different spans for different members. Two types
of automatic and manual routing are available for VCAT members: common fiber routing and split routing.

The ADM-10G card supports VCAT common fiber routing and VCAT split fiber (diverse) routing. With
VCAT split fiber routing, each member can be routed independently through the SONET or SDH or DWDM
network instead of having to follow the same path as required by CCAT and VCAT common fiber routing.
This allows a more efficient use of network bandwidth, but the different path lengths and different delays
encountered may cause slightly different arrival times for the individual members of the VCG. The VCAT
differential delay is this relative arrival timemeasurement betweenmembers of a VCG. Themaximum tolerable
VCAT split fiber routing differential delay for the ADM-10G card is approximately 55 milliseconds. A loss
of alignment alarm is generated if the maximum differential delay supported is exceeded.

The differential delay compensation function is automatically enabled when you choose split fiber routing
during the CTC circuit configuration process. CCAT and VCAT common fiber routing do not enable or need
differential delay support.

Protection switches with switching time of less than 60 milliseconds are not guaranteed with the differential
delay compensation function enabled. The compensation time is added to the switching time.

Caution

For TL1, EXPBUFFERS parameter must be set to ON in the ENT-VCG command to enable support for split
fiber routing.

Note
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Available Circuit Sizes

Table 92: Supported SONET Circuit Sizes of ADM-10G card

VCAT High OrderCCAT

STS-1-1nV (n= 1 to 21)STS-1

STS-3c-mv (m= 1 to 7)STS-3c

STS-6c

STS-9c

STS-12c

STS-24c

Table 93: Supported SDH Circuit Sizes of ADM-10G card

VCAT High OrderCCAT

VC-4-mv (m= 1 to 7)VC-4

VC-4-2c

VC-4-3c

VC-4-4c

VC-4-8c

In ADM-10G cards, the Gigabit Ethernet port does not support flow control. When less than seven VC-4s are
configured for the port, with the client traffic expected to be below the line rate, a burst in traffic beyond the
supposed bandwidth leads to packet loss. It is, therefore, recommended to use an external flow control
mechanism with less than seven VC-4s configured. Connecting a GE-XP or GE-XPE card between the client
traffic and the ADM-10G Gigabit Ethernet interface enables such flow control.

Note

Related Procedure for VCAT Circuit
The following is the list of procedures related to creating VCAT circuits:

• NTP-G245 Creating an Automatically Routed VCAT Circuit

• NTP-G246 Creating a Manually Routed VCAT Circuit
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Intermediate Path Performance Monitoring
Intermediate path performance monitoring (IPPM) allows a node to monitor the constituent channel of an
incoming transmission signal. You can enable IPPM for STS/VC-4s payload on OCn and Trunk ports of
ADM-10G card. The IPPM is complaint with GR253/G.826.

Software Release 9.2 and higher enables the ADM-10G card to monitor the near-end and far-end PM data on
individual STS/VC-4 payloads by enabling IPPM. After provisioning IPPM on the card, service providers
can monitor large amounts of STS/VC-4 traffic through intermediate nodes, thus making troubleshooting and
maintenance activities more efficient. IPPM occurs only on STS/VC-4 paths that have IPPM enabled, and
TCAs are raised only for PM parameters on the selected IPPM paths.

For a CCAT circuit, you can enable IPPM only on the first STS/VC-4 of the concatenation group. For a VCAT
circuit, you can enable IPPM independently on each member STS/VC-4 of the concatenation group.

Related Procedure for IPPM
To enable IPPM on the ADM-10G card, see:

• NTP-G247 Enabling or Disabling Path Performance Monitoring on Intermediate Nodes

Pointer Justification Count Performance Monitoring
Pointers are used to compensate for frequency and phase variations. Pointer justification counts indicate timing
errors on SONET networks. When a network is out of synchronization, jitter and wander occur on the
transported signal. Excessive wander can cause terminating equipment to slip.

Slips cause different effects in service. Voice service has intermittent audible clicks. Compressed voice
technology has short transmission errors or dropped calls. Fax machines lose scanned lines or experience
dropped calls. Digital video transmission has distorted pictures or frozen frames. Encryption service loses the
encryption key, causing data to be transmitted again.

Pointers provide a way to align the phase variations in STS and VC4 payloads. The STS payload pointer is
located in the H1 and H2 bytes of the line overhead. Clocking differences are measured by the offset in bytes
from the pointer to the first byte of the STS synchronous payload envelope (SPE) called the J1 byte. Clocking
differences that exceed the normal range of 0 to 782 can cause data loss.

There are positive (PPJC) and negative (NPJC) pointer justification count parameters. PPJC is a count of
path-detected (PPJC-PDET-P) or path-generated (PPJC-PGEN-P) positive pointer justifications. NPJC is a
count of path-detected (NPJC-PDET-P) or path-generated (NPJC-PGEN-P) negative pointer justifications
depending on the specific PM name. PJCDIFF is the absolute value of the difference between the total number
of detected pointer justification counts and the total number of generated pointer justification counts.
PJCS-PDET-P is a count of the one-second intervals containing one or more PPJC-PDET or NPJC-PDET.
PJCS-PGEN-P is a count of the one-second intervals containing one or more PPJC-PGEN or NPJC-PGEN.

A consistent pointer justification count indicates clock synchronization problems between nodes. A difference
between the counts means that the node transmitting the original pointer justification has timing variations
with the node detecting and transmitting this count. Positive pointer adjustments occur when the frame rate
of the SPE is too slow in relation to the rate of the STS-1.

You must enable PPJC and NPJC performance monitoring parameters for ADM-10Gcard. In CTC, the count
fields for PPJC and NPJC PMs appear white and blank unless they are enabled on the card view Provisioning
tab.
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Performance Monitoring Parameter Definitions
This section describes the STS and VC-4 path performance monitoring parameters that ADM-10G card
support.

Table 94: STS Near-end Path Performance Monitoring Parameters

DefinitionParameter

Near-End STS Path Coding Violations (CV-P) is a count of BIP errors detected
at the STS path layer (that is, using the B3 byte). Up to eight BIP errors can be
detected per frame; each error increments the current CV-P second register.

CV-P

Near-End STS Path Errored Seconds (ES-P) is a count of the seconds when at
least one STS path BIP error was detected. An AIS Path (AIS-P) defect (or a
lower-layer, traffic-related, near-end defect) or a Loss of Pointer Path (LOP-P)
defect can also cause an ES-P.

ES-P

Near-End STS Path Severely Errored Seconds (SES-P) is a count of the seconds
when K (2400) or more STS path BIP errors were detected. An AIS-P defect (or
a lower-layer, traffic-related, near-end defect) or an LOP-P defect can also cause
an SES-P.

SES-P

Near-End STS Path Unavailable Seconds (UAS-P) is a count of the seconds when
the STS path was unavailable. An STS path becomes unavailable when ten
consecutive seconds occur that qualify as SES-Ps, and continues to be unavailable
until ten consecutive seconds occur that do not qualify as SES-Ps.

UAS-P

Near-End STS Path Failure Counts (FC-P) is a count of the number of near-end
STS path failure events. A failure event begins when an AIS-P failure, an LOP-P
failure, a UNEQ-P failure, or a Section Trace Identifier Mismatch Path (TIM-P)
failure is declared. A failure event also begins if the STS PTE that is monitoring
the path supports Three-Bit (Enhanced) Remote Failure Indication Path
Connectivity (ERFI-P-CONN) for that path. The failure event ends when these
failures are cleared.

FC-P

Positive Pointer Justification Count, STS Path Detected (PPJC-PDET-P) is a
count of the positive pointer justifications detected on a particular path in an
incoming SONET signal.

PPJC-PDET-P

Positive Pointer Justification Count, STS Path Generated (PPJC-PGEN-P) is a
count of the positive pointer justifications generated for a particular path to
reconcile the frequency of the SPE with the local clock.

PPJC-PGEN-P

Negative Pointer Justification Count, STS Path Detected (NPJC-PDET-P) is a
count of the negative pointer justifications detected on a particular path in an
incoming SONET signal.

NPJC-PDET-P

Negative Pointer Justification Count, STS Path Generated (NPJC-PGEN-P) is a
count of the negative pointer justifications generated for a particular path to
reconcile the frequency of the SPE with the local clock.

NPJC-PGEN-P
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DefinitionParameter

Pointer Justification Count Difference, STS Path (PJCDIFF-P) is the absolute
value of the difference between the total number of detected pointer justification
counts and the total number of generated pointer justification counts. That is,
PJCDiff-P is equal to (PPJC-PGEN-P - NPJC-PGEN-P) - (PPJC-PDET-P -
NPJC-PDET-P).

PJCDIFF-P

Pointer Justification Count Seconds, STS Path Detect (NPJCS-PDET-P) is a
count of the one-second intervals containing one or more PPJC-PDET or
NPJC-PDET.

PJCS-PDET-P

Pointer Justification Count Seconds, STS Path Generate (PJCS-PGEN-P) is a
count of the one-second intervals containing one or more PPJC-PGEN or
NPJC-PGEN.

PJCS-PGEN-P

Table 95: VC-4 Near-end Path Performance Monitoring Parameters

DefinitionParameter

High-Order Path Errored Block (HP-EB) indicates that one or more bits are in
error within a block.

HP-EB

High-Order Path Background Block Error (HP-BBE) is an errored block not
occurring as part of an SES.

HP-BBE

High-Order Path Errored Second (HP-ES) is a one-second period with one or
more errored blocks or at least one defect.

HP-ES

High-Order Path Severely Errored Seconds (HP-SES) is a one-second period
containing 30 percent or more errored blocks or at least one defect. SES is a
subset of ES.

HP-SES

High-Order Path Unavailable Seconds (HP-UAS) is a count of the seconds when
the VC path was unavailable. A high-order path becomes unavailable when ten
consecutive seconds occur that qualify as HP-SESs, and it continues to be
unavailable until ten consecutive seconds occur that do not qualify as HP-SESs.

HP-UAS

High-Order Path Background Block Error Ratio (HP-BBER) is the ratio of BBE
to total blocks in available time during a fixed measurement interval. The count
of total blocks excludes all blocks during SESs.

HP-BBER

High-Order Path Errored Second Ratio (HP-ESR) is the ratio of errored seconds
to total seconds in available time during a fixed measurement interval.

HP-ESR

High-Order Path Severely Errored Second Ratio (HP-SESR) is the ratio of SES
to total seconds in available time during a fixed measurement interval.

HP-SESR

High-Order, Positive Pointer Justification Count, Path Detected (HP-PPJC-Pdet)
is a count of the positive pointer justifications detected on a particular path on
an incoming SDH signal.

HP-PPJC-PDET
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DefinitionParameter

High-Order, Negative Pointer Justification Count, Path Detected (HP-NPJC-Pdet)
is a count of the negative pointer justifications detected on a particular path on
an incoming SDH signal.

HP-NPJC-PDET

High-Order, Positive Pointer Justification Count, Path Generated (HP-PPJC-Pgen)
is a count of the positive pointer justifications generated for a particular path.

HP-PPJC-PGEN

High-Order, Negative Pointer Justification Count, Path Generated
(HP-NPJC-Pgen) is a count of the negative pointer justifications generated for a
particular path.

HP-NPJC-PGEN

High-Order Path Pointer Justification Count Difference (HP-PJCDiff) is the
absolute value of the difference between the total number of detected pointer
justification counts and the total number of generated pointer justification counts.
That is, HP-PJCDiff is equal to (HP-PPJC-PGen - HP-NPJC-PGen) -
(HP-PPJC-PDet - HP-NPJC-PDet).

HP-PJCDIFF

High-Order Path Pointer Justification Count Seconds (HP-PJCS-PDet) is a count
of the one-second intervals containing one or more HP-PPJC-PDet or
HP-NPJC-PDet.

HP-PJCS-PDET

High-Order Path Pointer Justification Count Seconds (HP-PJCS-PGen) is a count
of the one-second intervals containing one or more HP-PPJC-PGen or
HP-NPJC-PGen.

HP-PJCS-PGEN

ADM-10G Functions
The following functions of the ADM-10G card are explained in the "Card Features" chapter:

• Automatic Laser Shutdown

• Card level indicators

• Port level indicators

Related Procedures for ADM-10G Card
The following is the list of procedures and tasks related to the configuration of the ADM-10G card:

• NTP-G170 Provisioning theADM-10GCard Peer Group, Ethernet Settings, Line Settings, PMParameters,
and Thresholds, on page 400

• NTP-G200 Creating, Deleting, and Managing STS or VC Circuits for the ADM-10G Card

• NTP-G75 Monitor Transponder and Muxponder Performance

• NTP-G333 Adding an ADM-10G Card to an Existing Topology, on page 425
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DLP-G775 Displaying the Bandwidth Usage of the STS Timeslots
This task displays the bandwidth usage of the STS timeslots on the interlink
interfaces, ILK1 (Port 17) and ILK2 (Port 18), in ADM-10G double-card
configuration.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• DLP-G403 Creating the ADM-10G Peer Group, on page 401

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to display the bandwidth usage of the STS timeslots on the interlink interfaces.

Step 2 Click the Maintenance > ILK Utilization tabs.
Step 3 In the Interlink Ports drop-down list, choose the interlink port for which you want to display the bandwidth

usage and click Refresh.

The bandwidth usage of STS 1 to 192 timeslots are displayed in the Free/Occupied column. The bandwidth
usage values are updated only after clicking the Refresh button.

Step 4 Return to your originating procedure (NTP).

OTU2_XP Card
The OTU2_XP card is a single-slot card with four ports with XFP-based multirate (OC-192/STM-64, 10GE,
10G FC, IB_5G) Xponder. The OTU2_XP card supports multiple configurations.

Table 96: OTU2_XP Card Configurations and Ports

Port 4Port 3Port 2Port 1Configuration

Trunk port 2Trunk port 1Client port 2Client port 12 x 10G transponder

Trunk port 2Trunk port 1Trunk port 2Trunk port 12 x 10G standard regenerator (with
enhanced FEC (E-FEC) only on
one port)
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Port 4Port 3Port 2Port 1Configuration

Trunk port in
transponder or
regenerator
configuration

Trunk portClient port in
transponder or
trunk port in
regenerator
configuration

Client port10 GE LAN Phy to WAN Phy

Trunk portTrunk portNot usedNot used1 x 10G E-FEC regenerator (with
E-FEC on two ports)

Trunk port
(protect)

Trunk port
(working)

Not usedClient port1 x 10G splitter protected
transponder

All the four ports are ITU-T G.709 compliant and support 40 channels (wavelengths) at 100-GHz channel
spacing in the C-band (that is, the 1530.33 nm to 1561.42 nm wavelength range).

The OTU2_XP card can be installed in Slots 1 to 6 and 12 to 17 in ONS 15454 DWDM chassis, Slots 2 and
3 in ONS 15454 M2, Slots 2 to 7 in ONS 15454 M6, Slots 2 to 16 in Cisco NCS 2015 chassis. The OTU2_XP
card supports SONET SR1, IR2, and LR2 XFPs, 10GE BASE SR, SW, LR, LW, ER, EW, and ZR XFPs, and
10G FC MX-SN-I and SM-LL-L XFPs.

Fan-tray assembly 15454E-CC-FTA (ETSI shelf)/15454-CC-FTA (ANSI shelf) must be installed in a shelf
where the OTU2_XP card is installed.

Caution

Key Features
The OTU2_XP card has the following high-level features:

• 10G transponder, regenerator, and splitter protection capability.

• Compatible with the ONS 15454 ANSI high-density shelf assembly, the ETSI ONS 15454 shelf assembly,
and the ETSI ONS 15454 high-density shelf assembly. Compatible with TCC2/TCC2P/
TCC3/TNC/TNCE/TSC/TSCE cards.

Due to memory limitations, TCC2/TCC2P cards are not supported from Release
10.5.2 onwards. As a result, in a multishelf configuration, the TCC2/TCC2P card
cannot be a node controller or a shelf controller. Upgrade the TCC2/TCC2P card
to a TCC3 card

Note

• Interoperable with TXP_MR_10E and TXP_MR_10E_C cards.

• Four port, multirate (OC-192/STM-64, 10G Ethernet WAN Phy, 10G Ethernet LAN Phy, 10G Fibre
Channel, IB_5G) client interface. The client signals are mapped into an ITU-T G.709 OTU2 signal using
standard ITU-T G.709 multiplexing.

• ITU-T G.709 framing with standard Reed-SoloMon (RS) (255,239) FEC. Performance monitoring and
ITU-TG.709Optical Data Unit (ODU) synchronousmapping. Enhanced FEC (E-FEC)with ITU-TG.709
ODU with greater than 8 dB coding gain.
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• The trunk rate remains the same irrespective of the FEC configuration. The error coding performance
can be provisioned as follows:

• FEC—Standard ITU-T G.709.

• E-FEC—Standard ITU-T G.975.1 (subclause I.7)

• IEEE 802.3 frame format supported for 10 Gigabit Ethernet interfaces. The minimum frame size is 64
bytes. The maximum frame size is user-provisionable.

• Supports fixed/no fixed stuff mapping (insertion of stuffing bytes) for 10G Ethernet LAN Phy signals
(only in transponder configuration).

• Supports 10G Ethernet LAN Phy to 10G Ethernet WAN Phy conversion on Ports 1 (client port) and 3
(trunk port).

• Supports 10G Ethernet LAN Phy to WAN Phy conversion using CTC and TL1. When enabled on the
OTU2_XP card, the first Channel (Ports 1 and 3) supports LAN toWAN conversion. The second channel
carries normal 10GE, 10G FC, and OC192/STM64 traffic.

• The LAN Phy to WAN Phy conversion functions in accordance to WAN Interface Sublayer (WIS)
mechanism as defined by IEEE802.3ae (IEEE Std 802.3ae-2002, Amendment to CSMA/CD).

• Default configuration is transponder, with trunk ports configured as ITU-T G.709 standard FEC.

• In transponder or regenerator configuration, if one of the ports is configured the corresponding port is
automatically created.

• In regenerator configuration, only Ports 3 and 4 can be configured as E-FEC. Ports 1 and 2 can be
configured only with standard FEC.

• When port pair 1-3 or 2-4 is configured as regenerator (that is, card mode is standard regenerator), the
default configuration on Ports 3 and 4 is automatically set to standard FEC.

• When Ports 3 and 4 are configured as regenerator (that is, card mode is E-FEC regenerator), the default
configuration on both these ports is automatically set to E-FEC.

• In a splitter-protected transponder configuration, the trunk ports (Port 3 and Port 4) are configured as
ITU-TG.709 standard FEC or E-FEC. OCHCC circuits with different trunkwavelengths can be configured
for the working and protect paths. The process of setting the trunkwavelengths is similar to the “DLP-G367
Change the 2.5G Multirate Transponder Trunk Wavelength Settings” task on page 11-175. OCHCC
circuits having different trunk wavelengths on the working and protect paths can be upgraded to GMPLS
circuits.

• Supports protection through Y-cable protection scheme.

When enabled, the 10G Ethernet LAN Phy to WAN Phy conversion feature does
not support Y-cable protection on the LAN to WAN interface (ports 1 and 3).

Note

• Client ports support SONET SR1, IR2, and LR2 XFPs, 10GE BASE SR, SW, LR, LW, ER, EW, and
ZR XFPs, and 10G FC MX-SN-I and SM-LL-L XFPs.

• Following are the OTU2 link rates that are supported on the OTU2_XP trunk port:
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• Standard G.709 (10.70923 Gbps) when the client is provisioned as “SONET” (including 10G
Ethernet WAN PHY) (9.95328 Gbps).

• G.709 overclocked to transport 10GE as defined by ITU-T G. Sup43 Clause 7.2 (11.0491 Gbps)
when the client is provisioned as “10G Ethernet LAN Phy” (10.3125 Gbps) with “No Fixed Stuff”
enabled.

• G.709 overclocked to transport 10GE as defined by ITU-T G. Sup43 Clause 7.1 (11.0957 Gbps)
when the client is provisioned as “10G Ethernet LAN Phy” (10.3125 Gbps) with “No Fixed Stuff”
disabled.

• G.709 proprietary overclocking mode to transport 10G FC (11.3168 Gbps) when the client is
provisioned as “10G Fiber Channel” (10.518 Gbps).

• Proprietary rate at the trunk when the client is provisioned as IB_5G.

• The MTU setting is used to display the OverSizePkts counters on the receiving Gigabit Ethernet client
port interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client
port to the trunk port irrespective of the MTU setting.

• The OTU2_XP card configured in the Transponder or Mixed mode does not support egress Ethernet
variables such as ifOutOctets, ifOutDiscards, ifOutMulticastPkts, and ifOutBroadcastPkts.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

OTU2_XP Card Interface
The OTU2_XP card is a multi-functional card that operates in different configurations, such as transponder,
standard regenerator, E-FEC regenerator, and 10G Ethernet LAN Phy to WAN Phy conversion mode. The
OTU2_XP card acts as a protected transponder, when the 10G Ethernet LAN Phy to WAN Phy is in splitter
protected transponder configuration mode.

Depending on the configuration of the OTU2_XP card, the ports act as client or trunk ports (see Table 96:
OTU2_XPCard Configurations and Ports). The following section describes the client and trunk rates supported
on the OTU2_XP card for different card configurations:

Client Interface
In transponder and 10G Ethernet LAN Phy to WAN Phy card configurations, Ports 1 and 2 act as client ports
and in splitter protected transponder configuration, Port 1 acts as a client port. For these card configurations,
the client rates supported are:

• OC-192/STM-64

• 10G Ethernet WAN Phy

• 10G Ethernet LAN Phy

• 10G Fibre Channel

• IB_5G
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Trunk Interface
In transponder, 10G Ethernet LAN Phy to WAN Phy, and splitter protected transponder card configurations,
Ports 3 and 4 act as trunk ports. For these card configurations, the trunk rates supported are:

• OC-192/STM-64

• 10G Ethernet WAN Phy

• 10G Ethernet LAN Phy

• 10G Fibre Channel

• OTU2 with ITU-T G.709 for OC-192 client interface

• OTU2e with ITU-T G.709 for 10G Ethernet LAN Phy client interface

• Proprietary rate at the trunk when the client is provisioned as IB_5G

In standard regenerator card configuration, all four ports act as trunk ports and in E-FEC regenerator
configuration, Ports 3 and 4 act as the trunk ports. For these card configurations, the trunk rate supported is
OTU2 G.709

The above mentioned OTU2 signal must be an OC-192/STM-64, 10G EthernetWAN Phy, 10G Ethernet LAN
Phy, or 10G Fibre Channel signal packaged into an OTU2G.709 frame. Additionally, the standard regenerator
and E-FEC regenerator configuration supports an OTU2 signal that is OTU2 has been generated bymultiplexing
four ODU1 signals.

Note

Configuration Management
The OTU2_XP card supports the following configuration management parameters:

• Card Configuration—Provisionable card configuration: Transponder, Standard Regen, Enhanced FEC,
or Mixed, or 10G Ethernet LAN Phy to WAN Phy.

• Port Mode—Provisionable port mode when the card configuration is set as Mixed. The port mode can
be chosen as either Transponder or Standard Regen for each port pair (1-3 and 2-4). For card configurations
other than Mixed, CTC automatically sets the port mode depending on the selected card configuration.
For 10G Ethernet LAN Phy to WAN Phy mode, CTC automatically selects the port pair (1-3) as 10G
Ethernet LAN Phy to WAN Phy. Port pair (2-4) in 10G Ethernet LAN Phy to WAN Phy mode is selected
as Transponder or Standard Regen.

• Termination Mode—Provisionable termination mode when the card configuration is set as either
Transponder orMixed. The terminationmode can be chosen as Transparent, Section, or Line. For Standard
Regen and Enhanced FEC card configurations, CTC automatically sets the termination mode as
Transparent. For 10G Ethernet LAN Phy toWAN Phy mode, CTC automatically selects the Termination
Mode of port pair (1-3) as Line. You cannot provision the Termination Mode parameter.

• Fault Signalling—Provisionable Fault Signaling mode configuration when the card configuration is set
as either Transponder, Mixed, or Standard Regen. The Fault Signaling mode configuration can be chosen
as AIS/Send Local Fault or Squelch/Laser-Off. For Enhanced FEC card configuration, CTC automatically
sets the AIS/Send Local Fault or Squelch/Laser-Off mode configuration as AIS/Send Local Fault. For
10G Ethernet LAN Phy to WAN Phy mode, the CTC automatically selects the AIS/Send Local Fault or
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Squelch/Laser-Off of port pair (1-3) as Squelch/Laser-Off. You cannot provision the AIS/Send Local
Fault or Squelch/Laser-Off parameter.

When Fault Signaling is enabled in Standard Regen configuration with port pairs
(1-3) and (2-4), Squelch/Laser-Off is supported on ports 1 and 2 and AIS/Send
Local Fault on ports 3 and 4.

Note

When you choose the 10G Ethernet LAN Phy to WAN Phy conversion, the
Termination mode is automatically set to LINE. The AIS/Squelch is set to
Squelch/Laser-Off and ODUTransparency is set to Cisco Extended Use for Ports
1 and 3.

Note

• Regen Line Name—User-assigned text string for regeneration line name.

• ODU Transparency—Provisionable ODU overhead byte configuration, either Transparent Standard Use
or Cisco Extended Use. See the ODU Transparency for more detailed information. For 10G Ethernet
LAN Phy toWAN Phy mode, CTC automatically selects the ODU Transparency as Cisco Extended Use.
You cannot provision the ODU Transparency parameter.

• Port name—User-assigned text string.

• Admin State/Service State—Administrative and service states to manage and view port status.

• ALS Mode—Provisionable ALS function.

• Reach—Provisionable optical reach distance of the port.

• Wavelength—Provisionable wavelength of the port.

• AINS Soak—Provisionable automatic in-service soak period.

OTU2_XP Card Configuration Rules
The following rules apply to OTU2_XP card configurations:

• When you preprovision the card, port pairs 1-3 and 2-4 come up in the default Transponder configuration.

• The port pairs 1-3 and 2-4 can be configured in different modes only when the card configuration is
Mixed. If the card configuration is Mixed, you must choose different modes on port pairs 1-3 and 2-4
(that is, one port pair in Transponder mode and the other port pair in Standard Regen mode).

• If the card is in Transponder configuration, you can change the configuration to Standard Regen or
Enhanced FEC.

• If the card is in Standard Regen configuration and you have configured only one port pair, then configuring
payload rates for the other port pair automatically changes the card configuration to Mixed, with the new
port pair in Transponder mode.

• If the card is in Standard Regen configuration, you cannot directly change the configuration to Enhanced
FEC. You have to change to Transponder configuration and then configure the card as Enhanced FEC.
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• If the card is in Enhanced FEC configuration, Ports 1 and 2 are disabled. Hence, you cannot directly
change the configuration to Standard Regen or Mixed. You must remove the Enhanced FEC group by
moving the card to Transponder configuration, provision PPM on Ports 1 and 2, and then change the
card configuration to Standard Regen or Mixed.

• If the card is in Standard Regen or Enhanced FEC configuration, you cannot change the payload rate of
the port pairs. You have to change the configuration to Transponder, change the payload rate, and then
move the card configuration back to Standard Regen or Enhanced FEC.

• If any of the affected ports are in IS (ANSI) or Unlocked-enabled (ETSI) state, you cannot change the
card configuration.

• If IB_5G payload has to be provisioned, the NE Default should match the values. For more information
on editing the NE Default values, see the "NTP-G135 Edit Network Element Defaults” task.

Table 97: OTU2_XP Card Configuration for IB_5G Payload Provisioning

ValueNE Default NameParameter

StandardOTU2-XP.otn.otnLines.FECFEC

EnableOTU2-XP.otn.otnLines.G709OTNITU-T G.709 OTN

TransparentOTU2-XP.config.port.TerminationModeTermination Mode

Cisco Extended UseOTU2-XP.config.port.OduTransparencyODU Transparency

SquelchOTU2-XP.config.port.AisSquelchModeAIS/Squelch

• If the card is changed to 10G Ethernet LAN Phy to WAN Phy, the first PPM port is deleted and replaced
by a 10G Ethernet port; the third PPM port is deleted and automatically replaced with OC192/STM64
(SONET/SDH) port. The third PPM port is automatically deleted and the third PPM port is replaced with
OC192/STM64 (SONET/SDH).

Table 98: Card Configuration Transition Summary

Transition ToCard
Configuration

10G Ethernet LAN Phy
to WAN Phy

MixedEnhanced FECStandard RegenTransponder

YesYesYesYes—Transponder

YesYesNo—YesStandard Regen

NoNo—NoYesEnhanced FEC

Yes—NoYesYesMixed
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Transition ToCard
Configuration

10G Ethernet LAN Phy
to WAN Phy

MixedEnhanced FECStandard RegenTransponder

—The 10G Ethernet
LAN Phy to WAN
Phy to Mixed is
supported if the
Port pair 1-3 is
chosen as
Transponder.

The 10G Ethernet
LAN Phy to WAN
Phy toMixed is not
supported if the
Port pair 1-3 is
chosen as Standard
Regen.

NoYesYes10G Ethernet
LAN Phy to
WAN Phy

Security
The OTU2_XP card, when an XFP is plugged into it, implements the Cisco Standard Security Code Check
Algorithm that keys on vendor ID and serial number.

If a PPM is plugged into a port on the card but fails the security code check because it is not a Cisco PPM, a
NON-CISCO-PPM Not Reported (NR) condition occurs.

If a PPM with a non-qualified product ID is plugged into a port on this card, that is, the PPM passes the
security code as a Cisco PPM but it has not been qualified for use on the OTU2_XP card, a UNQUAL-PPM
NR condition occurs.

ODU Transparency
A key feature of the OTU2_XP card is the ability to configure the ODU overhead bytes (EXP bytes and RES
bytes 1 and 2) using the ODU Transparency parameter. The two options available for this parameter are:

• Transparent Standard Use—ODU overhead bytes are transparently passed through the card. This option
allows the OTU2_XP card to act transparently between two trunk ports (when the card is configured in
Standard Regen or Enhanced FEC).

• Cisco ExtendedUse—ODUoverhead bytes are terminated and regenerated on both ports of the regenerator
group.

The ODU Transparency parameter is configurable only for Standard Regen and Enhanced FEC card
configuration. For Transponder card configuration, this parameter defaults to Cisco Extended Use and cannot
be changed.
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The Forward Error Correction (FEC) Mismatch (FEC-MISM) alarm will not be raised on OTU2_XP card
when you choose Transparent Standard Use.

Note

For more information about the OTU2_XPcard, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-500937.html

Related Procedures for OTU2_XP Card
The following is the list of procedures and tasks related to the configuration of the OTU2_XP card:

• NTP-G33 Creating a Y-Cable Protection Group, on page 334

• NTP-G199 Creating a Splitter Protection Group, on page 340

• NTP-G75 Monitor Transponder and Muxponder Performance

TXP_MR_10EX_C Card
The TXP_MR_10EX_C card is a multirate transponder card. The card is fully backward compatible with
TXP_MR_10E_C cards (only when the error decorrelator is disabled in the CTC on the TXP_MR_10EX_C
card). It processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side).
The TXP_MR_10EX_C card is tunable over the 82 channels of C-band (82 channels spaced at 50 GHz on
the ITU grid).

You can install TXP_MR_10EX_C card in Slots 1 to 6 and 12 to 17 in ONS 15454 DWDM chassis, Slots 2
and 3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6. The card can be provisioned in linear,
BLSR/MS-SPRing, path protection/SNCP configurations or as a regenerator. The card can be used in the
middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent termination mode. The
TXP_MR_10EX_C card features an MLSE-based Universal Transponder 1550-nm tunable laser and a
separately orderable ONS-XC-10G-S1 1310-nm or ONS-XC-10G-L2 1550-nm laser XFP module for the
client port.

The PRE FEC BER performance of the TXP_MR_10EX_C card may be significantly low when compared
to the TXP_MR_10E card. However, this does not affect the Post FEC BER performance, but could possibly
affect any specific monitoring application that relies on the PRE FEC BER value (for example, protection
switching). In this case, the replacement of TXP_MR_10E card with the TXP_MR_10EX_C may not work
properly.

Note

When the ONS-XC-10G-L2 XFP is installed, the TXP_MR_10EX_C card must be installed in a high-speed
slot (slot 6, 7, 12, or 13)

Note
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Key Features
The key features of the TXP_MR_10EX_C card are:

• A multi-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately):

• OC-192 (SR1)

• 10GE (10GBASE-LR)

• 10G-FC (1200-SM-LL-L)

• (ONS-XC-10G-S1 version 3 only) IB_5G

• AnMLSE-based UTmodule tunable through 82 channels of C-band. The channels are spaced at 50 GHz
on the ITU grid.

• OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping.

• Proprietary rate at the trunk when the client is provisioned as IB_5G.

• The MTU setting is used to display the OverSizePkts counters on the receiving Gigabit Ethernet client
port interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client
port to the trunk port irrespective of the MTU setting.

For information about safety labels for the card, see the "Class 1M Laser Product Cards” section.

You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10EX_C card in a
loopback on the trunk port. Do not use direct fiber loopbacks with this card, because they can cause irreparable
damage to the card.

Caution

For more information about the TXP_MR_10EX_C card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-580763.html

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Related Procedures for TXP_MR_10EX_C Card
The following is the list of procedures and tasks related to the configuration of the TXP_MR_10EX_C card:

• NTP-G96 Provisioning the 10GMultirate Transponder Card Line Settings, PMParameters, and Thresholds,
on page 368

• NTP-G75 Monitor Transponder and Muxponder Performance

MXP_2.5G_10EX_C card
The MXP_2.5G_10EX_C card is a DWDM muxponder supports transparent termination mode on the client
side. The faceplate designation of the card is “4x2.5G 10EXMXP.” The card multiplexes four 2.5-Gbps client
signals (4xOC48/STM-16 SFP) into a single 10-Gbps DWDM optical signal on the trunk side. The card
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provides wavelength transmission service for the four incoming 2.5-Gbps client interfaces. The
MXP_2.5G_10EX_C muxponder passes all SONET/SDH overhead bytes transparently.

The digital wrapper function (ITU-T G.709 compliant) formats the DWDMwavelength so that it can be used
to set up GCCs for data communications, enable FEC, or facilitate PM.

The MXP_2.5G_10EX_C card works with OTN devices defined in ITU-T G.709. The card supports ODU1
to OTU2 multiplexing, an industry standard method for asynchronously mapping a SONET/SDH payload
into a digitally wrapped envelope. See the "Multiplexing Function” section.

The MXP_2.5G_10EX_C card is not compatible with the MXP_2.5G_10G card, which does not support
transparent termination mode.

You can install the MXP_2.5G_10EX_C card in Slots 1 to 6 and 12 to 17 in ONS 15454 DWDM chassis,
Slots 2 and 3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6. You can provision a card in a linear
configuration, a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. The card can be used in the
middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent termination mode.

TheMXP_2.5G_10EX_C card features a tunable 1550-nmC-band laser on the trunk port. The laser is tunable
across 82 wavelengths on the ITU grid with 50-GHz spacing between wavelengths. The card features four
1310-nm lasers on the client ports and contains five transmit and receive connector pairs (labeled) on the card
faceplate. The card uses dual LC connectors on the trunk side and SFP modules on the client side for optical
cable termination. The SFP pluggable modules are SR or IR and support an LC fiber connector.

When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode, which are necessary to provision
the 4xOC-48 OCHCC circuit.

Note

Key Features
The MXP_2.5G_10EX_C card has the following high-level features:

• Four 2.5-Gbps client interfaces (OC-48/STM-16) and one 10-Gbps trunk. The four OC-48 signals are
mapped into an ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the transmission
range on these interfaces. The E-FEC functionality increases the correction capability of the transponder
to improve performance, allowing operation at a lower OSNR compared to the standard RS (255,239)
correction algorithm.

• Pluggable client-interface optic modules: The MXP_2.5G_10EX_C card has modular interfaces. Two
types of optic modules can be plugged into the card. These modules include an OC-48/STM-16 SR-1
interface with a 7-km (4.3-mile) nominal range (for short range and intra-office applications) and an IR-1
interface with a range of up to 40 km (24.9 miles). SR-1 is defined in Telcordia GR-253-CORE and in
I-16 (ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in S-16-1 (ITU-T G.957).

• High-level provisioning support: The card is initially provisioned using Cisco TransportPlanner software.
Subsequently, the card can be monitored and provisioned using CTC software.

• Link monitoring and management: The card uses standard OC-48 OH (overhead) bytes to monitor and
manage incoming interfaces. The card passes the incoming SDH/SONET data stream and its overhead
bytes transparently.
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• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate regenerator
section overhead, which eliminates forwarding of unneeded layer overhead. It can help reduce the number
of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_2.5G_10EX_C card normally synchronizes from
the control card. If for some reason, such as maintenance or upgrade activity, the control card is not
available, the card automatically synchronize to one of the input client-interface clocks.

• Configurable squelching policy: The card can be configured to squelch the client interface output if LOS
occurs at the DWDM receiver or if a remote fault occurs. In the event of a remote fault, the card manages
MS-AIS insertion.

• The card is tunable across the full C-band, thus eliminating the need to use different versions of each
card to provide tunability across specific wavelengths in a band.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Faceplate and Block Diagram
Figure 19: MXP_2.5G_10EX_C Faceplate and Block Diagram
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For information about safety labels for the card, see the "Class 1 Laser Product Cards” section.

MXP_2.5G_10EX_C Functions
The following functions of the MXP_2.5G_10EX_C card are explained in the "Card Features" chapter:

• Client Interface

• DWDM Interface

• FEC

• Multiplexing Function

• Timing Synchronization

• SONET/SDH Overhead Byte Processing

• Client Interface Monitoring

• Automatic Laser Shutdown

• Jitter

• Lamp Test

• Onboard Traffic Generation

• Card level indicators

• Port level indicators

Wavelength Identification
The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU grid
effectively. TheMXP_2.5G_10EX_C card implements theMLSE-basedUTmodule. TheMXP_2.5G_10EX_C
card uses a C-band version of the UT2.

The MXP_2.5G_10EX_C card is tunable over 82 wavelengths in the C-band at 50-GHz spacing on the ITU
grid.

Table 99: MXP_2.5G_10EX_C Trunk Wavelengths

Wavelength (nm)Frequency (THz)Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1545.72193.95421529.55196.001

1546.119193.90431529.94195.952

1546.518193.85441530.334195.903

1546.917193.80451530.725195.854

1547.316193.75461531.116195.805

1547.715193.70471531.507195.756
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Wavelength (nm)Frequency (THz)Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1548.115193.65481531.898195.707

1548.515193.60491532.290195.658

1548.915193.55501532.681195.609

1549.32193.50511533.073195.5510

1549.71193.45521533.47195.5011

1550.116193.40531533.86195.4512

1550.517193.35541534.250195.4013

1550.918193.30551534.643195.3514

1551.319193.25561535.036195.3015

1551.721193.20571535.429195.2516

1552.122193.15581535.822195.2017

1552.524193.10591536.216195.1518

1552.926193.05601536.609195.1019

1553.33193.00611537.003195.0520

1553.73192.95621537.40195.0021

1554.134192.90631537.79194.9522

1554.537192.85641538.186194.9023

1554.940192.80651538.581194.8524

1555.343192.75661538.976194.8025

1555.747192.70671539.371194.7526

1556.151192.65681539.766194.7027

1556.555192.60691540.162194.6528

1556.959192.55701540.557194.6029

1557.36192.50711540.953194.5530

1557.77192.45721541.35194.5031

1558.173192.40731541.75194.4532

1558.578192.35741542.142194.4033
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Wavelength (nm)Frequency (THz)Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1558.983192.30751542.539194.3534

1559.389192.25761542.936194.3035

1559.794192.20771543.333194.2536

1560.200192.15781543.730194.2037

1560.606192.10791544.128194.1538

1561.013192.05801544.526194.1039

1561.42192.00811544.924194.0540

1561.83191.95821545.32194.0041

Related Procedures for MXP_2.5G_10EX_C Card
The following is the list of procedures and tasks related to the configuration of the MXP_2.5G_10EX_C card:

• NTP-G97Modifying the 4x2.5GMuxponder Card Line Settings and PM Parameter Thresholds, on page
426

• NTP-G75 Monitor Transponder and Muxponder Performance

MXP_MR_10DMEX_C Card
The MXP_MR_10DMEX_C card aggregates a mix of client SAN service-client inputs (GE, FICON, and
Fibre Channel) into one 10-Gbps STM-64/OC-192 DWDM signal on the trunk side. It provides one long-reach
STM-64/OC-192 port per card and is compliant with Telcordia GR-253-CORE and ITU-T G.957.

The card supports aggregation of the following signal types:

• 1-Gigabit Fibre Channel

• 2-Gigabit Fibre Channel

• 4-Gigabit Fibre Channel

• 1-Gigabit Ethernet

• 1-Gigabit ISC-Compatible (ISC-1)

• 2-Gigabit ISC-Peer (ISC-3)

The card can be damaged by dropping it. Handle it carefully.Caution

The MXP_MR_10DMEX_C muxponder passes all SONET/SDH overhead bytes transparently.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
228

Provisioning Transponder and Muxponder Cards
Related Procedures for MXP_2.5G_10EX_C Card

http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_ABA5BDBA34684C40A1F2B60AFA862C21


The digital wrapper function (ITU-T G.709 compliant) formats the DWDMwavelength so that it can be used
to set up GCCs for data communications, enable FEC, or facilitate PM. The MXP_MR_10DMEX_C card
works with the OTN devices defined in ITU-T G.709. The card supports ODU1 to OTU2 multiplexing, an
industry standard method for asynchronously mapping a SONET/SDH payload into a digitally wrapped
envelope. See the "Multiplexing Function” section.

You cannot disable ITU-T G.709 on the trunk side. If ITU-T G.709 is enabled, then FEC cannot be disabled.Note

Because the client payload cannot oversubscribe the trunk, a mix of client signals can be accepted, up to a
maximum limit of 10 Gbps.

Note

You can install the MXP_MR_10DMEX_C card in Slots 1 to 6 and 12 to 17 in ONS 15454 DWDM chassis,
Slots 2 and 3 in ONS 15454 M2 chassis, Slots 2 to 7 in ONS 15454 M6.

The MXP_MR_10DMEX_C card is not compatible with the MXP_2.5G_10G card, which does not support
transparent termination mode.

Note

The MXP_MR_10DMEX_C card features a tunable 1550-nm C-band laser on the trunk port. The laser is
tunable across 82 wavelengths on the ITU grid with 50-GHz spacing between wavelengths. Each card features
four 1310-nm lasers on the client ports and contains five transmit and receive connector pairs (labeled) on the
card faceplate. The card uses dual LC connectors on the trunk side and SFP modules on the client side for
optical cable termination. The SFP pluggable modules are SR or IR and support an LC fiber connector.

The current version of the GFP-T G.7041 supports transparent mapping of 8B/10B block-coded protocols,
including Gigabit Ethernet, Fibre Channel, ISC, and FICON.

In addition to the GFP mapping, 1-Gbps traffic on Port 1 or 2 of the high-speed SERDES is mapped to an
STS-24c channel. If two 1-Gbps client signals are present at Port 1 and Port 2 of the high-speed SERDES,
the Port 1 signal is mapped into the first STS-24c channel and the Port 2 signal into the second STS-24c
channel. The two channels are then mapped into an OC-48 trunk channel.

Table 100: MXP_MR_10DMEX_C Client Interface Data Rates and Encapsulation

GFP-T G.7041 EncapsulationInput Data RateClient Interface

Yes2.125 Gbps2G FC

Yes1.06 Gbps1G FC

Yes2.125 Gbps2G FICON/2G ISC-Compatible (ISC-1)/
2G ISC-Peer (ISC-3)

Yes1.06 Gbps1G FICON/1G ISC-Compatible (ISC-1)/
1G ISC-Peer (ISC-3)

Yes1.25 GbpsGigabit Ethernet
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The MXP_MR_10DMEX_C card includes two FPGAs, and a group of four ports is mapped to each FPGA.
Group 1 consists of Ports 1 through 4, and Group 2 consists of Ports 5 through 8. The following table shows
some of the mix and match possibilities on the various client data rates for Ports 1 through 4, and Ports 5
through 8. An X indicates that the data rate is supported in that port.

Table 101: Supported Client Data Rates for Ports 1 through 4 and Ports 5 through 8

4G FC2G FC1G FCGigabit EthernetPort (Group 2)Port (Group 1)

XXXX51

——XX62

—XXX73

——XX84

GFP-T PM is available through RMON and trunk PM is managed according to Telcordia GR-253-CORE and
ITU G.783/826. Client PM is achieved through RMON for FC and GE.

A buffer-to-buffer credit management scheme provides FC flow control. With this feature enabled, a port
indicates the number of frames that can be sent to it (its buffer credit), before the sender is required to stop
transmitting and wait for the receipt of a “ready” indication. The MXP_MR_10DMEX_C card supports FC
credit-based flow control with a buffer-to-buffer credit extension of up to 1600 km (994.1 miles) for 1G FC,
up to 800 km (497.1 miles) for 2G FC, or up to 400 km (248.5 miles) for 4G FC. The feature can be enabled
or disabled.

The MXP_MR_10DMEX_C card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm
laser (depending on the SFP) for the client ports. The card contains eight 12.5-degree downward-tilt SFP
modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are labeled
TX and RX on the faceplate. The trunk port is a dual-LC connector with a 45-degree downward angle.

Key Features
The MXP_MR_10DMEX_C card has the following high-level features:

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the transmission
range on these interfaces. The E-FEC functionality increases the correction capability of the transponder
to improve performance, allowing operation at a lower OSNR compared to the standard RS (255,239)
correction algorithm.

• Pluggable client-interface optic modules: TheMXP_MR_10DMEX_C card has modular interfaces. Two
types of optics modules can be plugged into the card. These modules include an OC-48/STM-16 SR-1
interface with a 7-km (4.3-mile) nominal range (for short range and intra-office applications) and an IR-1
interface with a range of up to 40 km (24.9 miles). SR-1 is defined in Telcordia GR-253-CORE and in
I-16 (ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in S-16-1 (ITU-T G.957).

• Y-cable protection: The card supports Y-cable protection between the same card type only, on ports with
the same port number and signal rate. See the "Y-Cable Protection Availability on TXP, MXP, and
Xponder Cards" section for more detailed information.

• High-level provisioning support: The card is initially provisioned using Cisco TransportPlanner software.
Subsequently, the card can be monitored and provisioned using CTC software.
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• ALS: This safety mechanism is used in the event of a fiber cut. For details regarding ALS provisioning
for theMXP_MR_10DMEX_C card, see the NTP-G162 Changing the ALSMaintenance Settings section.

• Link monitoring and management: The card uses standard OC-48 OH (overhead) bytes to monitor and
manage incoming interfaces. The card passes the incoming SDH/SONET data stream and its OH
(overhead) bytes transparently.

• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate regenerator
section overhead, which eliminates forwarding of unneeded layer overhead. It can help reduce the number
of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_MR_10DMEX_C card normally synchronizes
from the control card. If for some reason, such as maintenance or upgrade activity, the control card is
not available, the card automatically synchronizes to one of the input client-interface clocks.

MXP_MR_10DMEX_C card cannot be used for line timing.Note

• Configurable squelching policy: The card can be configured to squelch the client-interface output if LOS
occurs at the DWDM receiver or if a remote fault occurs. In the event of a remote fault, the card manages
MS-AIS insertion.

• The card is tunable across the full C-band, thus eliminating the need to use different versions of each
card to provide tunability across specific wavelengths in a band.

• You can provision a string (port name) for each fiber channel/FICON interface on the
MXP_MR_10DMEX_C card, which allows theMDS FabricManager to create a link association between
that SAN port and a SAN port on a Cisco MDS 9000 switch.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html
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Faceplate and Block Diagram
Figure 20: MXP_MR_10DMEX_C Faceplate and Block Diagram

For information about safety labels for the card, see the "Class 1M Laser Product Cards” section.

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the card in a loopback on the trunk
port. Do not use direct fiber loopbacks with the card, because they can cause irreparable damage to the
MXP_MR_10DMEX_C card.

Caution

MXP_MR_10DMEX_C Functions
The following functions of the MXP_MR_10DMEX_C card are explained in the "Card Features" chapter:

• Card level indicators
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• Port level indicators

Wavelength Identification
The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU grid
effectively. The MXP_MR_10DMEX_C card uses a C-band version of the MLSE-based UT module.

The MXP_MR_10DMEX_C card is tunable over 82 wavelengths in the C-band at 50-GHz spacing on the
ITU grid.

Table 102: MXP_MR_10DMEX_C Trunk Wavelengths

Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1545.72193.95421529.55196.001

1546.119193.90431529.94195.952

1546.518193.85441530.334195.903

1546.917193.80451530.725195.854

1547.316193.75461531.116195.805

1547.715193.70471531.507195.756

1548.115193.65481531.898195.707

1548.515193.60491532.290195.658

1548.915193.55501532.681195.609

1549.32193.50511533.073195.5510

1549.71193.45521533.47195.5011

1550.116193.40531533.86195.4512

1550.517193.35541534.250195.4013

1550.918193.30551534.643195.3514

1551.319193.25561535.036195.3015

1551.721193.20571535.429195.2516

1552.122193.15581535.822195.2017

1552.524193.10591536.216195.1518

1552.926193.05601536.609195.1019

1553.33193.00611537.003195.0520

1553.73192.95621537.40195.0021
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Wavelength (nm)Frequency
(THz)

Channel
Number

Wavelength
(nm)

Frequency
(THz)

Channel
Number

1554.134192.90631537.79194.9522

1554.537192.85641538.186194.9023

1554.940192.80651538.581194.8524

1555.343192.75661538.976194.8025

1555.747192.70671539.371194.7526

1556.151192.65681539.766194.7027

1556.555192.60691540.162194.6528

1556.959192.55701540.557194.6029

1557.36192.50711540.953194.5530

1557.77192.45721541.35194.5031

1558.173192.40731541.75194.4532

1558.578192.35741542.142194.4033

1558.983192.30751542.539194.3534

1559.389192.25761542.936194.3035

1559.794192.20771543.333194.2536

1560.200192.15781543.730194.2037

1560.606192.10791544.128194.1538

1561.013192.05801544.526194.1039

1561.42192.00811544.924194.0540

1561.83191.95821545.32194.0041

Related Procedures for MXP_MR_10DMEX_C Card
The following is the list of procedures and tasks related to the configuration of the MXP_MR_10DMEX_C
card:

• NTP-G148 Modifying the 10G Data Muxponder Card Line Settings and PM Parameter Thresholds, on
page 469

• NTP-G75 Monitor Transponder and Muxponder Performance
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AR_MXP, AR_XP, and AR_XPE Cards
The AR_MXP (Any-Rate Muxponder), AR_XP (Any-Rate Xponder), and AR_XPE (Any-Rate Enhanced
Xponder) cards are supported onONS 15454DWDMplatform. TheAR_MXP card supports a trunk bandwidth
of up to 10 Gbps. The AR_XP andAR_XPE cards support a trunk bandwidth of up to 20 Gbps. The AR_MXP,
AR_XP, and AR_XPE cards aggregate a mix of client SAN services (FC or FICON 1G/2G/4G/8G, ESCON
and ISC3-STP 1G/2G), Ethernet (FE, GE, 10GELAN), OCn (OC3/STM-1, OC12/STM-4, andOC48/STM-16),
OTU (OTU1, OTU2e/1e), and Video (SD-SDI, HD-SDI, and 3G-SDI) into one 10 Gbps signal on the trunk
side.

• When all the cards in the chassis are simultaneously reset by the user, the AR_XP card undergoes a hard
reset instead of a soft reset. This causes traffic loss for traffic going through these cards.

• The AR-XP card can only create four HD_SDI circuits at any given time. If you attempt to create more
than four HD_SDI circuits, when the protection is enabled on the trunk ports, it will lead to errors and
the circuit creation fails.

Note

Table 103: AR_MXP, AR_XP, and AR_XPE Client Interface Data Rates and Encapsulation

GFP EncapsulationInput Data RateClient Interface

—155.52 MbpsOC3/ STM1

—622.08 MbpsOC12/STM4

—2.488 GbpsOC48/STM16

GFP-F100 MbpsFE

GFP-F GFP-T (as per G.709 mentioned in
17.7.1.1 1000BASE-X transcoding) for
AR_XPE card

1.125 GbpsGE

—10.31 Gbps10GE LAN

GFP-T1.06 Gbps1GFC

GFP-T2.125 Gbps2GFC

GFP-T4.25 Gbps4GFC

GFP-T for AR_MXP and AR_XP cards
GMP for AR_XPE card

8.5 Gbps8GFC

—2.66 GbpsOTU1

—10.7 GbpsOTU2

GFP-T200 MbpsESCON
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GFP EncapsulationInput Data RateClient Interface

GFP-T1.06 Gbps1G ISC3-STP

GFP-T2.125 Gbps2G ISC3-STP

GFP-F1.485 GbpsHD-SDI

GFP-F270 MbpsSD-SDI

GFP-F2.970 Gbps3G-SDI

Key Features
The AR_MXP, AR_XP, and AR_XPE cards support the following key features:

• Multiple Operating Modes—The AR_MXP, AR_XP, or AR_XPE card can be configured into multiple
operating modes. The cards are equipped with pluggables for client and trunk options, and offer a large
variety of configurations. For more information about multiple operating modes, see 11.0.3 Multiple
Operating Modes, page 11-105.

• Operating Mode to Client Payload Mapping—Each operating mode supports a specific set of client
payloads.

Table 104: AR_MXP, AR_XP, and AR_XPE Card Supported Client-Payload Mapping—SONET/SDH, Ethernet, OTU1, and FC

FCOTUEthernetSONET/SDHRateCard Mode

ESCONFICON8G/FC8GFICON4G/FC4GFICON2G/FC2GFICON1G/FC1GOTU2eOTU110GEGEFEOC48/STM16OC12/STM4OC3/STM1

YesNoYesYesYesNoNoN/AYesYesYesYesYesLOWTXP_MR

NoYesNoNoNoYesNoYesNoNoNoNoNoHIGH

YesNoYesYesYesNoNoN/AYesYesYesYesYesLOWTXPP_MR

N/AN/AN/AN/AN/AN/AN/AN/AN/AN/AN/AN/AN/AHIGH

NoNoYesYesYesNoNoN/AYesNoNoNoNoHIGHMXP_DME

NoNoYesYesYesNoNoN/AYesNoNoNoNoHIGHMXPP_DME

YesNoNoNoYesNoNoN/AYesYesNoYesYesLOWMXP_MR

YesNoYesYesYesNoYesN/AYesYesYesYesYesHIGH

YesNoNoNoYesNoNoN/AYesYesNoYesYesLOWMXPP_MR

YesNoYesYesYesNoYesN/AYesYesYesYesYesHIGH

NoNoNoNoNoNoYesN/ANoNoYesNoNoHIGHMXP-4x2.5-10G

NoNoNoNoNoNoYesN/ANoNoYesNoNoHIGHMXPP-4x2.5-10G
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FCOTUEthernetSONET/SDHRateCard Mode

ESCONFICON8G/FC8GFICON4G/FC4GFICON2G/FC2GFICON1G/FC1GOTU2eOTU110GEGEFEOC48/STM16OC12/STM4OC3/STM1

NoNoNoNoNoNoNoN/ANoNoNoNoNoHIGHMXP-VD-10G

NoNoNoNoNoYesNoN/ANoNoNoNoNoHIGHRGN

NoNoNoNoNoNoYesN/ANoNoNoNoNoLOW

Table 105: AR_MXP, AR_XP, and AR_XPE Card Supported Client-Payload Mapping—ISC and Video

VideoISC

3G-SDIHD-SDISD-SDIISC3_STP_2GISC3_STP_1GISC-1RateCard Mode

NoNoNoYesYesNoLOWTXP_MR

NoNoNoNoNoNoHIGH

NoNoNoN/ANoNoLOWTXPP_MR

N/AN/AN/AN/AN/AN/AHIGH

NoNoNoNoNoNoHIGHMXP_DME

NoNoNoNoNoNoHIGHMXPP_DME

NoNoNoNoNoNoLOWMXP_MR

NoYesYesNoNoNoHIGH

NoNoNoNoNoNoLOWMXPP_MR

NoYesYesNoNoNoHIGH
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• Auto Sensing—The AR_MXP, AR_XP, and AR_XPE cards support auto sensing of client payloads.
The line card analyzes the received client signal and configures the payload on the client port automatically
without user intervention.

Auto sensing feature is supported on the Gigabit Ethernet, OC-3/STM-1, OC-12/STM-4, and
OC-48/STM-16 payloads. Following operating card modes support the autosensing feature:

• TXP (low rate)

• TXPP (low rate)
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• MXP_MR (low and high Rate)

• MXPP_MR (low and high rate)

CTC supports the configuration of all the provisioning parameters supported by the autosensed
payload. However, creation and deletion of the

circuits are the only configurations supported on the “AUTO” payload.

• Video Multiplexing—The AR_XP and AR_XPE cards support the capability to multiplex SD-SDI,
HD-SDI, and 3G-SDI signals over the OTU2 trunk interface allowing to maximize the wavelength
bandwidth, maintain full transparency for uncompressed signals, and reduce latency. The video
multiplexing of 3G-SDI signal is not supported on the AR_MXP card.

• Regenerator Mode—This mode regenerates the OTU2e or OTU1 signals with ODU transparent or
CISCO Extended Use options. For OTU2e, FEC can be Disabled, Standard G.975, EFEC I.4 or EFEC
I.7, and for OTU1, FEC can be Standard G.975 or Disabled.

• High Speed GCCs—The AR_MXP, AR_XP, and AR_XPE cards support the provisioning of GCC
channel on OTN (OTU1/OTU2) enabled client and trunk ports. A maximum of five GCC channels on
the Cisco ONS 15454 shelften GCC channels on Cisco ONS 15454 M2 or Cisco ONS 15454 M6 shelf
can be created. The high speed GCC enables you to create the GCC when both the NE and FE line cards
are in Cisco ONS 15454M2 or Cisco ONS 15454M6 shelf. The legacy GCC on Cisco ONS 15454 shelf
can be selected on one side and the Cisco ONS 15454, Cisco ONS 15454 M2 or Cisco ONS 15454 M6
shelf on the other side.

• Y-cable protection—Y-cable protection between the same card type is supported only on ports with the
same port number and signal rate. Switching time is high between two AR_XPE cards when auto
negotiation is enabled. Hence, if Y-cable protection is configured on AR_XPE cards, auto-negotiation
must be disabled on the client ports so that the switching time is less than 50 ms. For more detailed
information, see "Y-Cable Protection Availability on TXP, MXP, and Xponder Cards" section.

• Splitter protection—For splitter protection, OCHCC circuits with different trunk wavelengths for the
working and protect paths can be configured. The process of setting the trunk wavelengths is similar to
the “DLP-G367 Change the 2.5GMultirate Transponder TrunkWavelength Settings” task on page 11-175.
OCHCC circuits having different trunk wavelengths on the working and protect paths can be upgraded
to GMPLS circuits.

• SyncE Support—Customers using a packet network find it difficult to provide timing to multiple remote
network elements (NEs) through an external time division multiplexed (TDM) circuit. The SyncE feature
helps to overcome this problem by providing effective timing to the remote NEs through a packet network.
SyncE leverages the physical layer of the Ethernet to transmit frequency to the remote sites. SyncE's
functionality and accuracy resemble the SONET/SDH network because of its physical layer characteristic.
The SyncE feature provides the required synchronization at the physical level. Operation messages
maintain SyncE links and ensure that a node always derives timing from the most reliable source. SyncE
uses the Ethernet Synchronization Message Channel (ESMC) to enable traceability of the best clock
source to correctly define the timing source and prevent a timing loop. SyncE is not supported on the
AR_XPE card.

• Licensing—The AR_MXP and AR_XP cards offer you an unprecedented flexibility. The cards support
a wide range of different applications and configurations. To help you take advantage of such flexibility
to lower capital expenditures (CapEx) on your network, Cisco provides a licensing model for AR_MXP
and AR_XP cards. Licensing is not supported on the AR_XPE card. For more information on licensing,
see the Licensing Configuration Guide.
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• GFP-T Mapping— The GFP-T framing mode can be provisioned on the AR_XP and AR_MXP cards
in the CTC card view > Provisioning > Line tab. The AR_XP and AR_MXP cards must be configured
in the high-rateMXP_DMEmode.When GFP-T framingmode is provisioned, autonegotiation is enabled
but does not impact traffic.

When the software version of the node is changed from Release 10.6.2 to releases prior to 10.6.1, the AR_XP
card undergoes a hard reset. This is applicable for the ONS 15454, 15454 M2 and 15454 M6 chassis.

The AR_MXP, AR_XP, and AR_XPE cards can be installed in any service slots in the chassis. The AR_MXP,
AR_XP, and AR_XPE cards do not interoperate with all the existing TXP or MXP cards. The AR_MXP card
allows you to configure only one high rate XFP port. This can be a muxponder mode where N [N= 1 to 8]
client ports goes out via 1 trunk XFP port or in a transponder mode where client and trunk are XFP ports.
There is no limitation in the AR_XP and AR_XPE cards, where you can use both high rate trunk ports
simultaneously.

The AR_XPE card does not interoperate with AR_MXP and AR_XP cards.

The GE client interfaces on the AR-XPE card interoperate with NCS 4000 platform, whenODU2 is multiplexed
on a 100G trunk interface, with both 100GS-CK-LC and 200G-CK-LC cards, in MXP-10X10G operating
mode. The GE client mapping on AR-XPE cards must be performed directly on ODU0, and then on ODU2
not passing through the ODU1 container.

Multiple Operating Modes

A single AR_MXP, AR_XP, or AR_XPE card can be configured into multiple operating modes. Criteria for
selecting a particular operational mode are defined by the network level design. CTP helps you to choose the
appropriate operational mode. Each operating mode is divided into two categories based on the trunk rate:

• Low rate (trunk rate < 5G)

• High rate (trunk rate > 5G)

The AR_XP or AR_XPE card allows you to configure two high rate operational modes, where as you can
configure only one high rate operational mode on the AR_MXP card.

When you configure the AR_MXP, AR_XP, or AR_XPE card in to multiple operational modes, make sure
that the following tasks are completed:

• In order to make the ports operational and to correctly report alarms, OCHCC circuit must be created
for the following operating modes::

• Low-rate MXP_MR

• High-rate MXP_MR

• Low-rate MXPP_MR

• High-rate MXPP_MR

• Same operational mode is configured at both ends and ensure the port numbers are same on both ends.

• The OCHCC circuit should be created between the same client port numbers at the near and far end.

• Ensure ODU1 and timeslots are matching at both ends.

• For AR_XPE card that is configured with 1GE or 1GFC payload, ensure that ODU0 and ODU1 are
matching at both ends.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
239

Provisioning Transponder and Muxponder Cards
Key Features



• For auto sensing payloads created on auto ports, you should check the Auto Sensing checkbox in the
provisioning pane.

• GMPLS circuits can be created on AR_MXP, AR_XP, and AR_XPE cards.

• PPMs must be provisioned on all ports before configuring the operational mode.

• The following conditions determine the maximum bandwidth at the client side when a 4GFC payload is
configured in the TXP_MR or TXPP_MR mode:

• The maximum client bandwidth should not exceed 28G when TXP_MR or TXPP_MR operating
mode is configured on the AR_MXP, AR_XP, or AR_XPE card and other operating modes, like
low-rate or high-rate TXP_MR,TXPP_MR, MXP_DME, MXPP_DME, MXP_MR, MXPP_MR,
MXP-4X2.5G-10G, MXPP-4X2.5G-10G, and MXP-VDC-10G, are configured on the same card.

• The maximum client bandwidth should not exceed 20G when a TXP_MR or TXPP_MR operating
mode is configured on the AR_MXP, AR_XP, or AR_XPE card and if more than two or more
combinations of Low-rate or high-rate TXP_MR,TXPP_MR,MXP_DME,MXPP_DME,MXP_MR,
MXPP_MR, MXP-4X2.5G-10G, MXPP-4X2.5G-10G, and MXP-VDC-10G, operating modes are
configured on the same card.

• The utilized client bandwidth is 8G when the TXP_MR operating mode is configured with a 4GFC
as payload.

• The utilized client bandwidth is 12G when the TXPP_MR operating mode is configured with a
4GFC as payload.

• There is no restriction on the bandwidth if only TXP_MR or TXPP_MR operating mode with 4GFC
payload is configured on the card. For example, four instances of TXP_MR mode with 4GFC
payload on one AR_MPX, AR_XP, or AR_XPE card.

• The low-rate or high-rate RGN operating mode does not add to the client side bandwidth. For
example, four instances of TXP_MR mode with 4GFC and one instance of high-rate RGN mode
on same card.

For all the other payloads and operating modes, the client bandwidth utilized is the client payload
data rate.

• If you revert to a release earlier than Release 9.80, ensure that you delete the following card modes:

• Low-rate TXPP_MR if the client payload is 4GFC.

• High-rate TXP_MR if the client payload is 10 GE.

The AR_MXP, AR_XP, and AR_XPE cards support the following operating modes:

• TXP_MR (Unprotected Transponder)

• TXPP_MR (Protected Transponder)

• MXP_DME (Unprotected Data Muxponder)

• MXPP_DME (Protected Data Muxponder)

• MXP_MR (Unprotected Multirate Muxponder)

• MXPP_MR (Protected Multirate Muxponder)
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• MXP-4x2.5-10G (OC48/OTU1 Unprotected Muxponder)

• MXPP-4x2.5-10G (OC48/OTU1 Protected Muxponder)

• RGN (OTU1/OTU2 Regenerator)

• MXP-VD-10G (Video Muxponder)

TXP_MR (Unprotected Transponder)
The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or a high-rate TXP_MR card mode.

OTN cannot be enabled for 4GFC trunk ports.Note

• Low Rate—A maximum of four TXP_MR configurations can be provisioned on a single AR_MXP,
AR_XP, or AR_XPE card. The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate
TXP_MR card by adhering to the following provisioning rules:

1. Two SFP ports must be grouped. The allowed port pairs are 1-2, 3-4, 5-6, 7-8, 1-5, 2-6, 3-7, and/or
4-8.

2. Ports 2, 4, 5, 6, 7, or 8 can be configured as trunk ports.

3. Ports 1, 2, 3, 4, 5 or 7 can be configured as client ports.

The trunk port is not created when the low-rate TXP_MR card operating mode
is configured. It is created after the client payload is created.

Note

Figure 21: Low-Rate TXP_MR Card Operating Mode Configuration
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• High Rate—Only one TXP_MR configuration can be provisioned on a single AR_MXP, AR_XP, or
AR_XPE card. The AR_MXP, AR_XP, or AR_XPE card can be configured as a high-rate TXP_MR
card by adhering to the following provisioning rules:

1. XFP ports 9 and 10 must be grouped.

2. Port 10 must be configured as a trunk port.

3. Port 9 must be configured as a client port.

Figure 22: High-Rate TXP_MR Card Operating Mode Configuration

TXPP_MR (Protected Transponder)
The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate TXPP_MR card mode. Amaximum
of two TXPP_MR configurations can be provisioned on a single AR_MXP, AR_XP, or AR_XPE card. The
AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate TXPP_MR card by adhering to the
following provisioning rules:

1. Three SFP ports must be grouped. The allowed port pairs are 1-5-6 or 2-7-8, or both.

2. Ports 5 and 6, and 7 and 8 must be configured as trunk ports, where 6 and 8 are the protect trunk ports for
5 and 6 respectively.

3. Ports 1 and 2 must be configured as client ports.

Splitter protection is automatically created between ports 5-6 and 7-8.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
242

Provisioning Transponder and Muxponder Cards
TXPP_MR (Protected Transponder)



Figure 23: Low-Rate TXPP_MR Card Operating Mode Configuration

MXP_DME (Unprotected Data Muxponder)
TheAR_XP or AR_XPE card can be configured as a high-rate 4:1 or 8:1MXP_DME cardmode. TheAR_MXP
card can be configured as a high rate 8:1 MXP_DME card mode.

• 4:1 MXP_DME mode—A maximum of two MXP_DME configurations can be provisioned on a single
AR_XP or AR_XPE card. The AR_XP or AR_XPE card can be configured as a high-rate 4:1MXP_DME
card by adhering to the following provisioning rules:

1. Four SFP ports and one XFP port must be grouped. The allowed port pairs are 1-2-3-4-9 or 5-6-7-8-10,
or both.

2. Port 9 or 10 must be configured as a trunk port.

3. Ports 1, 2, 3, and 4, or 5, 6, 7, and 8 must be configured as client ports.

• 8:1 MXP_DME mode—Only one MXP_DME configuration can be provisioned on a single AR_MXP,
AR_XP, or AR_XPE card. The AR_MXP, AR_XP, AR_XPE card can be configured as a high-rate 8:1
MXP_DME card by adhering to the following provisioning rules:

1. Eight SFP ports and one XFP port must be grouped. The allowed port pairs are 1-2-3-4-5-6-7-8-9.

2. Port 9 must be configured as a trunk port.

3. Ports 1 to 8 must be configured as client ports.
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Figure 24: High-Rate MXP_DME Card Operating Mode Configuration

MXPP_DME (Protected Data Muxponder)
The AR_XP or AR_XPE card can be configured as a high-rate 4:2 or 8:2 MXPP_DME card mode.

• 4:2 MXP_DME mode—Only one MXPP_DME configuration can be provisioned on a single AR_XP
or AR_XPE card. The AR_XP or AR_XPE card can be configured as a high-rate 4:2 MXPP_DME card
by adhering to the following provisioning rules:

1. Four SFP ports and two XFP ports must be grouped. The allowed port pairs are 1-2-3-4-9-10 or
5-6-7-8-9-10.

2. Ports 9 and 10 must be configured as trunk ports.

3. Ports 1, 2, 3, and 4, or 5, 6, 7, and 8 must be configured as client ports.

Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk port
for port 9.

• 8:2 MXPP_DME mode—Only one MXPP_DME configuration can be provisioned on a single AR_XP
or AR_XPE card. The AR_XP or AR_XPE card can be configured as a high-rate 8:2 MXPP_DME card
by adhering to the following provisioning rules:

1. Eight SFP ports and twoXFP ports must be grouped. The allowed port pairs are 1-2-3-4-5-6-7-8-9-10.

2. Ports 9 and 10 must be configured as trunk ports.

3. Ports 1 to 8 must be configured as client ports.

Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk port
for port 9.
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Figure 25: High-Rate MXPP_DME Card Operating Mode Configuration

MXP_MR (Unprotected Multirate Muxponder)
The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or a high-rateMXP_MR card mode.

• LowRate—Amaximumof twoMXP_MR configurations can be provisioned depending on the availability
of client ports. The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate MXP_MR
card by adhering to the following provisioning rules:

1. N:1 muxponder must be created, where N varies from client ports 2 to 7.

2. Only ports 5, 6, 7, or 8 can be configured as trunk ports.

3. Ports 1 to 8 can be configured as client ports, if they are not configured as trunk ports.

Any client port can be added or deleted, if the trunk bandwidth supports the new payload without impacting
the traffic on the existing services. Minimum of two client ports should be part of the operational mode group.

On the AR_XPE card, 1GE or 1G FC payload cannot be configured with other payloads. When a 1GE or
1GFC payload is configured on a port of MXP_MR (low rate) mode, then only 1GE or 1GFC payload can
be configured on the other ports.
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Figure 26: Low-Rate MXP_MR Card Operating Mode Configuration

• High Rate—Amaximum of two MXP_MR configurations can be provisioned on a AR_XP or AR_XPE
card and only one such configuration can be provisioned on an AR_MXP card. The AR_MXP, AR_XP,
or AR_XPE card can be configured as a high-rateMXP_MR card by adhering to the following provisioning
rules:

1. N:1 muxponder must be created, where N varies from client ports 2 to 8.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1 to 8 can be configured as client ports.

Any client payload can be added or deleted, if the trunk bandwidth supports the new payload without impacting
the traffic on the existing services.

On the AR_XPE card, when you create a OCHCC circuit using 1GE or 1GFC payload, only ODU0 mapping
is supported and timeslot mapping is not supported. When a OCHCC circuit is created on a particular ODU1
timeslot with payloads using timeslot mapping, OCHCC circuits cannot be created on payloads using ODU0
mapping, but can be created on the other ODU1 timeslot. In MXP_MR (high-rate) mode, while creating a
OCHCC circuits on the GE or 1GFC client payload, you can select the ODU1 and ODU0 timeslots instead
of ODU1 and timeslot selection.
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Figure 27: High-Rate MXP_MR Card Operating Mode Configuration

MXPP_MR (Protected Multirate Muxponder)
The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or a high-rate MXPP_MR card
mode.

• Low Rate—A maximum of two MXPP_MR configurations can be provisioned depending on the
availability of client ports. Any client payload can be added or deleted, if the trunk bandwidth supports
the new payload without impacting the traffic on the existing services.

The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate MXPP_MR card by adhering to
the following provisioning rules:

1. N:2 muxponder must be created, where N varies from client ports 2 to 6.

2. Only ports 5 and 6 or 7 and 8, or both can be configured as trunk port.

3. Ports 1 to 8 can be configured as client ports, if ports are not configured as a trunk ports and are not part
of another muxponder.

Splitter protection is automatically created between ports 5 and 6 or 7 and 8.

On the AR_XPE card, 1GE or 1G FC payload cannot be configured with other payloads. When a 1GE or
1GFC payload is configured on a port of MXPP_MR (low rate) mode, then only 1GE or 1GFC payload can
be configured on the other ports.
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Figure 28: Low-Rate MXPP_MR Card Operating Mode Configuration

• High Rate—Amaximum of one MXPP_MR configuration can be provisioned on a AR_XP or AR_XPE
card. Any client payload can be added or deleted, if the trunk bandwidth supports the new payload without
impacting the traffic on the existing services.

The AR_XP or AR_XPE card can be configured as a high-rate MXPP_MR card by adhering to the following
provisioning rules:

1. N:2 muxponder must be created, where N varies from client ports 2 to 8.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1 to 8 can be configured as client ports.

Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk port
for port 9.

On the AR_XPE card, when you create a OCHCC circuit using 1GE or 1GFC payload, only ODU0 mapping
is supported and timeslot mapping is not supported. When a OCHCC circuit is created on a particular ODU1
timeslot with payloads using timeslot mapping, OCHCC circuits cannot be created on payloads using ODU0
mapping, but can be created on the other ODU1 timeslot.

When you create a OCHCC circuit between two nodes, with a Provisional Patch Cord (PPC) between the
trunks in splitter protection mode, then, while editing the OCHCC circuit, check the far-end and near-end
details. The near-end and far-end should either be the client and the trunk port respectively or vice-versa. The
client port cannot exist with the trunk port . In some cases, the client and the trunk ports are displayed together,
which is incorrect.
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Figure 29: High-Rate MXPP_MR Card Operating Mode Configuration

MXP-4x2.5-10G (OC48/OTU1 Unprotected Muxponder)
The AR_MXP, AR_XP, or AR_XPE card can be configured as a high-rate MXP-4x2.5-10G card mode. Only
one MXP-4x2.5-10G configuration can be provisioned on an AR_MXP card and a maximum of two on a
AR_XP or AR_XPE card.

The AR_MXP, AR_XP, or AR_XPE card can be provisioned as MXP-4x2.5-10G card by adhering to the
following provisioning rules:

1. The allowed port pairs are 1-2-3-4-9 or 5-6-7-8-10, or both.

2. Ports 9 and 10 can be configured as trunk ports.

3. Ports 1-2-3-4 or 5-6-7-8 can be configured as client ports.

Figure 30: High-Rate MXP-4x2.5-10G Card Operating Mode Configuration
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MXPP-4x2.5-10G (OC48/OTU1 Protected Muxponder)
The AR_XP or AR_XPE card can be configured as a high-rate MXPP-4x2.5-10G card mode. Only one
MXPP-4x2.5-10G configuration can be provisioned on a AR_XP or AR_XPE card.

The AR_XP or AR_XPE card can be configured as MXPP-4x2.5-10G card by adhering to the following
provisioning rules:

1. Four SFP ports and two XFP ports must be configured. The allowed port pair is 1-2-3-4-9-10 or
5-6-7-8-9-10, or both.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1-2-3-4 or 5-6-7-8 can be configured as client ports.

Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk port
for port 9.

Figure 31: High-Rate MXPP-4x2.5-10G Card Operating Mode Configuration

MXP_MR_S (Unprotected Multirate Muxponder-Static) and MXPP_MR_S (Protected Multirate
Muxponder-Static)

The MXP_MR_S and MXPP_MR_S operating modes are similar to the existing MXP_MR and MXPP_MR
operating modes except for static timeslot and ODU allocation. A specific set of client payloads or a mix of
client playloads can be used only if the trunk bandwidth and timeslot are available as per the static allocation
mapping.

For example, the MXP_MR_S and MXPP_MR_S modes can be used to provision a dual 4xOC-48 or a mix
of 2-OC-48 + 2-GE or 1-OC-48 + 6-GE into one OTU2 muxponder.

This works similar to traditional transponders/muxponders where operators can choose to use OCH-CC or
just provision OCH-Trail/OCH-NC for creating the circuits.

RGN (OTU1/OTU2 Regenerator)
The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or high-rate RGN card mode.
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• Low Rate—Amaximum of four RGN configurations can be provisioned on a single AR_MXP, AR_XP,
or AR_XPE card. The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate RGN card
by adhering to the following provisioning rules:

The allowed port pairs are 1-2, 3-4, 5-6, 7-8 or 1-5, 2-6, 3-7, 4-8.

Figure 32: Low-Rate RGN Card Operating Mode Configuration

• High Rate—Only one RGN configuration can be provisioned on a AR_MXP, AR_XP, or AR_XPE card.
The AR_MXP, AR_XP, or AR_XPE card can be configured as a high rate RGN card by adhering to the
following provisioning rules:

The allowed port pairs are 9-10.

Figure 33: High-Rate RGN Card Operating Mode Configuration

The 10 GE over OTU2e/OTU1e signal with disabled FEC, standard FEC, I.4 or I.7 EFEC mode can be
regenerated. The ODU transparency can either be Transparent Standard Use or Cisco Extended Use.
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Payload PMs are not supported in this operating mode.Note

MXP-VD-10G (Video Muxponder)
The AR_XP or AR_XPE card can be configured as a high-rate MXP-VD-10G card mode. A maximum of
two MXP-VD-10G configurations can be provisioned on a AR_XP or AR_XPE card.

The AR_XP or AR_XPE card can be configured as MXP-VD-10G card by adhering to the following
provisioning rules:

1. The allowed port pairs are 1-2-3-9 or 5-6-7-10.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1-2-3 and 5-6-7 can be configured as client ports.

Figure 34: High-Rate MXP-VD-10G Card Operating Mode Configuration

Scenarios of Different Operational mode Configurations on a AR_XP, or AR_XPE Card

The following section provides a few sample scenarios of different operational modes that can be configured
on an AR_XP or AR_XPE card:

Scenario 1
In this example, the following three operational modes are configured on the AR_XP or AR_XPE card:

• Low-rate TXP_MR (Cl=1;Tr=5)

• Low-rate MXP_MR (Cl=3,4;Tr=7)

• High-rate 3:1 MXP_MR (Cl=2,6,8;Tr=9)
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Figure 35: Scenario 1

Scenario 2
In this example, the following four operational modes are configured on the AR_XP or AR_XPE card:

• Low-rate TXP_MR (Cl=1;Tr=2)

• 8G FC TXP (Cl=9;Tr=10)

• Low-rate MR_MXP (Cl=4;TR=7,8)

• Low-rate MR_MXP (Cl=3,6;TR=5)

Figure 36: Scenario 2
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Scenario 3
In this example, the following two operational modes are configured on the AR_XP card:

• High-rate MXP-4x2.5-10G (Cl=1,2,3,4;Tr=9)

• High-rate 4:1 MXP_DME (Cl=5,6,7,8;Tr=10)

Figure 37: Scenario 3

Scenario 4
In this example, the following three operational modes are configured on the AR_XP or AR_XPE card:

• Low-rate MXP_MR (Cl=1,2,3;Tr=5)

• Low-rate MXP_MR (Cl=4,6,8; Tr=7)

• RGN(Cl=9;Tr=10)
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Figure 38: Scenario 4

Scenario 5
In this example, the following two operational modes are configured on the AR_XP or AR_XPE card:

• Low-rate MXPP_MR (Cl=1,3,4;Tr=5,6)

• High-rate MXPP_MR (Cl=2,7,8;Tr=9,10)

Figure 39: Scenario 5
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AR_MXP, AR_XP, and AR_XPE Functions and Features
The AR_MXP, AR_XP, and AR_XPE cards have the following functions and features are explained in the
"Card Features" chapter:

• Client Interface

• DWDM Interfac

• DWDM Trunk Interface

• Enhanced FEC (E-FEC) Feature

• Timing Synchronization

• Y-Cable Protection

• Jitter Consideration

For more information about the AR_MXP and AR_XPE cards, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-682432.html

For more information about the AR_XPE card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/datasheet_c78-726878.html

Related Procedures for AR_MXP, AR_XP, and AR_XPE Cards
The following is the list of procedures and tasks related to the configuration of the AR_MXP, AR_XP, and
AR_XPE cards:

• NTP-G321 Provisioning Multiple Operating Modes, on page 622

• NTP-G322 Modifying the Card Line Settings and PM Parameter Thresholds, on page 623

• NTP-G75 Monitor Transponder and Muxponder Performance

100G-LC-C, 100G-ME-C, 100G-CK-C, 100GS-CK-LC, 100ME-CKC,
and 200G-CK-LC Cards

The 100G-LC-C, 100G-ME-C, 100G-CK-C, and 100ME-CKC cards are tunable DWDM trunk cards, which
simplifies the integration and transport of 100 Gigabit Ethernet interfaces and services into enterprises or
service provider optical networks. The 100GS-CK-LC and 200G-CK-LC cards simplify the integration and
transport of 100 and 200 Gigabit Ethernet interfaces and services into enterprises or service provider optical
networks. These cards are supported on Cisco ONS 15454 M2, Cisco ONS 15454 M6, and Cisco NCS 2015
platforms.

The cards interoperate with 10x10G-LC and CFP-LC cards through a chassis backplane.

The 100GS-CK-LC and 200G-CK-LC cards do not operate with the CFP-LC card.Note

The cards provide the following benefits:
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• Provides 100 Gbps wavelengths transport over fully uncompensated networks, with more than 2,500 km
of unregenerated optical links.

• Enables 100-Gbps transport over very high Polarization Mode Dispersion (PMD).

• Improves overall system density of up to 100 Gbps per slot, which is five times greater than what can
be achieved with 40 Gbps units.

Up to six cards can be installed per ONS 15454M6 shelf, supporting up to 42 100-Gbps interfaces per 42-rack
units (RU) bay frame. It is possible to place up to two 100G TXPs, one 100 G Regen, or one 100 G MXP in
an ONS 15454 M6 shelf.

The fan-tray assembly 15454-M6-FTA2 (for the M6 chassis), 15454-M2-FTA2 (for the M2 chassis) must be
installed in the shelf where the cards are installed. When an ONS-SC+-10G-C pluggable is used along with
the 10x10G-LC card, the maximum operating temperature of the shelf must not exceed 50 degrees Celsius.

Note

100G-LC-C, 100G-CK-C, 100ME-CKC, and 100G-ME-C Cards

The 100G-CK-C card works similar to the 100G-LC-C card. The 100G-CK-C card has the new CPAK client
interface replacing the CXP client interface of the 100G-LC-C card. The CPAK client interface enables
different payload combinations such that this card can be used instead of the 100G-LC-C and CFP-LC cards.

The 100G-ME-C and 100ME-CKC cards aremetro edge versions of 100G-LC-C and 100G-CK-C respectively.
The metro edge cards have chromatic dispersion of +/-5000 ps/nm and does not support 20% FEC.

The 100G-CK-C and 100ME-CKC cards support the following pluggables:

• CPAK-100G-SR10 pluggable with 100GE/OTU4 and 40GE payloads

• CPAK-100G-LR4 pluggable with 100GE/OTU4 payloads

• CPAK-100G-SR4 pluggable with 100GE payloads

The 100G-LC-C and 100G-ME-C cards support these client signal types:

• 100GE/OTU4

• OTU4 from BP OTL4.10 (interconnect with CFP client)

• 100GE from BP CAUI (interconnect with CFP client)

• 3 x OTU3e(255/227) from BP OTL3.4 (interconnect with 10 x10G client)

• 2 x OTU3 from BP OTL3.4 (interconnect with CFP client)

• 2 x 40 GE from BP XLAUI (interconnect with CFP client)

In addition to the above, the 100G-CK-C and 100ME-CKC cards support these client signal types:

• 100GE/OTU4 for the CPAK-100G-SR10/CPAK-100G-LR4 client interface

• 40GE for the CPAK-100G-SR10 client interface

• The 100G-LC-C card and 100G-CK-C cards provide a 100 G DWDM trunk interface that supports up
to 70000 ps/nm of CD robustness.
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• The 100G-LC-C card and 100G-CK-C cards enables configuration of the CD dispersion tolerance to
50000 ps/nm and 30000 ps/nm to reduce power consumption.

100GS-CK-LC and 200G-CK-LC Cards

The 100GS-CK-LC and 200G-CK-LC cards are tunable DWDM trunk cards, which simplify the integration
and transport of 100 and 200 Gigabit Ethernet interfaces and services into enterprises or service provider
optical networks. The 200G-CK-LC card is an enhancement of the 100GS-CK-LC card.

The 100GS-CK-LC and 200G-CK-LC cards provide the following benefits:

• Allow choosing 16 QAM and QPSK as the modulation formats at the line side.

• Provide Standard G-FEC (Reed-Solomon), Soft Decision FEC (SD-FEC) encoding with 20% overhead,
and Hard Decision FEC (HD-FEC) encoding with 7% overhead.

• Provide Nyquist filtering for best performance and optimal band usage.

• Support gridless tunability.

• Allow client access either through the local 100G CPAK interface or through backplane lines.

• In MXP-10X10G operating mode, allow 10GE and OC-192 clients (multiplexed on 100G trunk) to
interoperate with NCS 4000 platform. The NCS 2000 line cards must fill the PT and MSI bytes to
interoperate with the supported NCS 4000 10G client. The interoperability applies for Hard Decision
FEC (HD-FEC) encoding with 7% overhead and GFEC trunk modes.

The 200G-CK-LC card also supports feature-based licensing. The 200G-CK-LIC is the licensed card version
of the 200G-CK-LC card. The licensed card version has only some basic functionality enabled while other
features can be enabled separately with specific licenses.

Key Features
The card key features are listed in the Key Features of 100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC,
10x10G-LC, 100GS-CK-LC, 200G-CK-LC, CFP-LC, and MR-MXP Cards.

The cards are single-slot cards and can be installed in Slot 2 to Slot 7 in the Cisco ONS 15454M6 chassis,Slot 2
and Slot 3 in the Cisco ONS 15454 M2 chassis. The 100G-LC-C and 100G-ME-C cards have one DWDM
port and one CXP port. The 100G-CK-C and 100ME-CK-C cards have one DWDM port and one CPAK port.

Operating Modes for 100G-LC-C, 100G-ME-C, 100G-CK-C, 100GS-CK-LC,
200G-CK-LC, and 100ME-CKC Cards

Each operating mode can be configured using the specific set of cards and client payloads. Key Features of
100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC, 10x10G-LC, 100GS-CK-LC, 200G-CK-LC, CFP-LC,
and MR-MXP Cards, on page 268 describes how each mode can be configured, the supported payloads, and
the valid port pair for a specific operating mode.

100G Operating Modes

The 100G-LC-C, 100G-ME-C, 100G-CK-C, 100GS-CK-LC, 100ME-CKC, and 200G-CK-LC cards support
the following 100G operating modes. The operating mode configuration for the 100G operating modes is
performed on the client card.
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• TXP-100G (Standalone 100GE Transponder)

• RGN-100G (100G Regenerator)

TXP-100G (Standalone 100GE Transponder)

The cards can be configured as a standalone 100 Gigabit Ethernet transponder. The 100 Gigabit Ethernet
traffic is supported on the CXP/CPAK and coherent optical trunk. The 100 Gigabit Ethernet or OTU4 payload
traffic is routed from the CXP/CPAK to the optical trunk, passing through the T100 framer and vice versa.
The supported client signals in this mode are 100 Gigabit Ethernet LAN-PHY or OTU4 data rates.

RGN-100G (100G Regenerator)

The cards can be configured as a regenerator. Two cards can be connected to work in a back-to-back mode
connecting through the chassis backplane in the same shelf. The allowed slot pairs are 2-3, 4-5, 6-7, 8-9,
10-11, 12-13, or 14-15.

The client signals supported are 100 Gigabit Ethernet or OTU4. Regeneration is performed leveraging on the
OTU4 backplane interconnection. OTU4 overhead is terminated, allowingODU4 to transparently pass through.
GCC0 is terminated, while GCC1 and GCC2 are allowed to pass through.

The CXP client is not required because communication between the two cards acting as a regeneration group
is supported through the chassis backplane.

MXP-2x40G

The 100G-CK-C and 100ME-CKC cards support the MXP-2x40G operating mode. The 100G-CK-C and
100ME-CKC cards can be configured as a 2-port 40 GE muxponder. Two 40 GE flows through the CPAK
client interface and are multiplexed in the 100G trunk interface. The traffic on the second client interface can
be configured only after the traffic is provisioned on the first client interface. This operating mode is not
supported on the 100GS-CK-LC card.

The synchronization for the 100G-CK-LC card is derived only from port 1. Hence, the traffic on port 2 must
originate from the same synchronization source as port 1. The two ports must carry traffic from the same
synchronization source.

Note

If ONS 15454 with the MXP-2x40G operating mode is connected to a NCS 6000 router, ensure that both the
40G ports are connected to the same group of six ports on the NCS 6000 router. The 40G ports 1 and 2 need
to connect to 1-6, 7-12, 13-18 ports on the NCS 6000 router.

200G Operating Modes

The 100GS-CK-LC and 200G-CK-LC cards also support the 200G operating modes. The operating mode
configuration for these modes is performed on the trunk card.

• MXP_200G

• MXP_10x10G_100G

• MXP_CK_100G

MXP_200G

Three cards, trunk card, peer card, and skip card are required to configure this operating mode. The skip card
is adjacent to the peer card.
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The trunk card is 100GS-CK-LC or 200G-CK-LC card; the peer card and skip cards are MR-MXP. The first
10x10G is taken from the two SFP and two QFSP+ ports of the peer MR-MXP card and the second 10x10G
is taken from the two SFP and two QFSP+ ports of the skip MR-MXP card.

200G-CK-LC card supports another configuration in the MXP_200G operating mode. In this configuration,
2x40GE clients on QSFP+ ports and 2x10GE clients on SFP+ ports of both the peer MR-MXP and skip
MR-MXP cards are multiplexed into 200G traffic on the trunk 200G-CK-LC card.

The operating mode can be provisioned on the following slots:

• ONS 15454 M6: 100GS-CK-LC or 200G-CK-LC card in slots 2 or 7, peer and skip MR-MXP cards in
adjacent slots 3, 4 or 5, 6

• NCS 2015: 100GS-CK-LC or 200G-CK-LC card in slots 2, 7, 8, 13, or 14, peer and skip MR-MXP cards
in adjacent slots.

MXP_10x10G_100G

Three cards, trunk card, peer card, and skip card are required to configure this operating mode.

The trunk card is 100GS-CK-LC or 200G-CK-LC card; the peer card is 10x10G-LC and the skip card is
MR-MXP . The first 10x10G is taken from the ten SFP ports of the peer 10x10G-LC card and the second
10x10G is taken from the two SFP and two QFSP+ ports of the skip MR-MXP card.

The operating mode can be provisioned on the following slots:

• ONS 15454 M6: 100GS-CK-LC or 200G-CK-LC card in slots 2 or 7, peer and skip MR-MXP cards in
adjacent slots 3, 4 or 5, 6

• NCS 2015: 100GS-CK-LC or 200G-CK-LC card in slots 2, 7, 8, 13, or 14, peer and skip MR-MXP cards
in adjacent slots.

MXP_CK_100G

Two cards, trunk and peer cards are required to configure this operatingmode. The trunk card is 100GS-CK-LC
or 200G-CK-LC; the peer card is MR-MXP . The first 100G is taken from the CPAK client port of the trunk
100GS-CK-LC or 200G-CK-LC card and the second 100G is taken from the CPAK client port of theMR-MXP
card.

200G-CK-LC card supports another configuration in theMXP_CK_100G operatingmode. In this configuration,
10x10GE clients on QSFP+ or SFP+ ports of the peer MR-MXP card and 100GE client on the CPAK port of
the 200G-CK-LC card are multiplexed into a 200G configuration on the trunk 200G-CK-LC card.

The operating mode can be provisioned on the following slots:

• ONS 15454M6: 100GS-CK-LC or 200G-CK-LC card and the peerMR-MXP card need to be in adjacent
slots 2-3, 4-5, 6-7

• NCS 2015: 100GS-CK-LC or 200G-CK-LC card and the peerMR-MXP card need to be in adjacent slots
2-3, 4-5, 6-7, 8-9, 10-11, 12-13, 14-15

For more information about the cards, see:

• http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-713298.html

• http://www.cisco.com/en/US/solutions/collateral/ns340/ns394/ns398/ns406/data_sheet_c78-729401.html

• http://www.cisco.com/c/en/us/products/collateral/optical-networking/
network-convergence-system-2000-series/datasheet-c78-733529.html
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• http://www.cisco.com/c/en/us/products/collateral/optical-networking/
network-convergence-system-2000-series/datasheet-c78-733699.html

10x10G-LC Card
In this chapter, "10x10G-LC" refers to the 15454-M-10x10G-LC card.

The 10x10G-LC card is a DWDM client card, which simplifies the integration and transport of 10 Gigabit
Ethernet interfaces and services to enterprises or service provider optical networks. The 10x10G-LC card is
supported on ONS 15454 M2 and ONS 15454 M6 platforms.

The 10x10G-LC card is a single-slot card and can be installed in any service slot of the chassis. The 10x10G-LC
card consists of a 10-port SFP+ based (with gray-colored, coarse wavelength divisionmultiplexing ([CWDM]
and DWDM optics available) and one 100 G CXP-based port.

The 10x10G-LC card interoperates with 100G-LC -C, 100G-CK-C, 100GS-CK-C, and 200G-CK-C cards
through a chassis backplane.

The fan-tray assembly 15454-M6-FTA2 (for the Cisco ONS 15454 M6 chassis) or 15454-M2-FTA2 (for the
Cisco ONS 15454 M2Cisco NCS 2002 chassis) must be installed in the shelf where a 10x10G-LC card is
installed. When an ONS-SC+-10G-C pluggable is used along with the 10x10G-LC card, the maximum
operating temperature of the shelf must not exceed 50 degrees Celsius.

Note

The 10x10G-LC card supports the following signal types:

• 10 Gigabit Ethernet LAN PHY (10.3125 Gbps)

• OTU-2

• G.709 overclocked to transport 10 Gigabit Ethernet as defined by ITU-T G. Sup43 Clause 7.1 (11.0957
Gbps)

• IB_5G (supported only in TXP-10G operating mode)

You may observe traffic glitches on the receiving direction of client ports 7, 8, 9, and 10 on the 400G-XP-LC
card that you connect to CXP port of a 10x10G-LC card in fanout mode. To bringup traffic in such cases,
change the admin state of the CXP port from OOS-DSBLD state to IS-NR state. Repeat the same action if
you continue to observe glitches.

Note

The key features of 10x10G-LC card are listed in .

Operating Modes for 10x10G-LC Card
The 10x10G-LC card supports the following operating modes:

• MXP-10x10G (10x10G Muxponder)

• RGN-10G (5x10G Regenerator)/TXP-10G (5x10G Transponder)
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• Low Latency

• Fanout-10X10G

• TXPP-10G

Each operating mode can be configured using specific set of cards and client payloads. lists the valid port pair
for a specific operating mode and the supported payloads, and describes how each mode can be configured.

MXP-10x10G (10x10G Muxponder)

The 10x10G muxponder mode supports client signals that are a combination of any
10 Gigabit Ethernet LAN-PHY or OTU2 data rates.

RGN-10G (5x10G Regenerator)/TXP-10G (5x10G Transponder)

The 10x10G-LC card works as a standalone card, supporting the multitransponder functionality. The 10 Gbps
SFP+ ports should be paired to provide the 10 G transponder functionality for each port of the port pair. By
using the grey optics SFP+ to provide the client equipment connectivity and DWDMSFP+ on theWDM side,
up to five 10 G transponders are supported by a single 10x10G-LC card. Up to six 10x10G-LC cards are
supported on the Cisco ONS 15454 M6 chassis allowing for 30 10 Gbps transponders in a single shelf.

All ports can be equipped with or without the G.709 Digital Wrapper function that provides wide flexibility
in terms of the supported services.

As the client and trunk ports are completely independent, it is also possible to equip both SFP+ of the same
pair of ports with the DWDM SFP+, thereby allowing them to function as a WDM regenerator. The CXP
pluggable is unused in this configuration.

Each of the SFP+ ports can be provisioned as a client or trunk. When one port is selected as a trunk, the other
port of the pair is automatically selected as the client port. The allowed port pairs are 1-2, 3-4, 5-6, 7-8, or
9-10.

For RGN-10G mode, both ports are trunk ports.

It is not a constraint to provision five pairs of TXP-10G mode or five pairs of RGN-10G mode. A mix of
TXP-10G and RGN-10G modes can be configured. For example, pairs 1-2 and 5-6 can be configured as
TXP-10G mode and the remaining pairs as RGN-10G mode.

Table 106: Supported Payload Mapping Between Two SFP+ Ports

SFP+ Payload (Peer -2)SFP+ Payload (Peer-1)

OTU2e or 10GE-LAN (CBR Mapped)10GE-LAN (CBR Mapped)

OC192 or OTU2OTU2

Low Latency

The 10x10G-LC card can be configured in low latency mode. This configuration minimizes the time spent
by the signal to cross the card during the regeneration process. Athough each SFP port functions as a
unidirectional regenerator, adjacent SFP ports must be selected while provisioning this mode. Both ports are
trunk ports. The allowed ports are 1-2, 3-4, 5-6, 7-8, or 9-10. A mix of TXP-10G, RGN-10G, and low latency
modes can be configured.

The low latency mode supports 10GE data rates. The same payload must be provisioned on both SFP ports
involved in this operating mode. GCC cannot be provisioned on the ports used in low latency mode. The low
latency mode does not support terminal and facility loopback.
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Fanout-10X10G

The 10x10G-LC card can be configured in the fanout-10x10Gmode. The fanout configuration configures the
CXP side as the client and SFP side as the trunk. This configuration functions as ten independent transponders.
The CXP lanes are managed independently and the payload for each CXP-lane-SPF+ pair is independent of
the other pairs.

The fanout configuration provides the following mapping for the port pairs:

• CXP lane 2-SFP1

• CXP lane 3-SFP2

• CXP lane 4-SFP3

• CXP lane 5-SFP4

• CXP lane 6-SFP5

• CXP lane 7-SFP6

• CXP lane 8-SFP7

• CXP lane 9-SFP8

• CXP lane 10-SFP9

• CXP lane 11-SFP10

CXP lane 1 and CXP lane 12 are not supported in this configuration.Note

The fanout configuration supports the following payload types and mapping modes:

• 10GE (CXP line), transparent (no mapping), 10GE (SFP)

• 10GE (CXP line), GFP mapping, OTU2 (SFP)

• 10GE (CXP line), CBR mapping, OTU2e (SFP)

TXPP-10G

Splitter protection can be implemented on the 10x10G-LC card in TXPP-10G mode. The 10x10G-LC card
supports up to two splitter protection groups with one client and two trunk ports. The client and trunk ports
on the two groups are:

• Port 3 (client), port 4, and port 6 (trunks) on the first protection group

• Port 7 (client), port 8, and port 10 (trunks) on the second protection group

Port 1 and port 2 are available for unprotected transponders and can be configured in the standard TXP-10G
mode, with the first port selected as the trunk and the other port selected as the client. Two ports, port 5 and
port 9, are left unused. A Y-Cable protection group cannot be defined on the same 10x10G-LC card when it
is provisioned in the TXPP-10G mode. The splitter protection is supported only for 10GE traffic, with trunk
ports set to disabled FEC, standard FEC, or enhanced FEC (E-FEC) mode.

The following figure shows the 10x10G-LC card configured for splitter protection.
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Figure 40: Splitter Protection on the 10x10G-LC card

For more information about the 10x10G-LC card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-713296.html.

CFP-LC Card
In this chapter, "CFP-LC" refers to the _15454-M-CFP-LC card.

The CFP-LC card is a client card, which simplifies the integration and transport of 40 GE and 100 GE interfaces
and services to enterprises or service provider optical networks. The CFP-LC card is supported on the Cisco
ONS 15454 M6 and NCS 2015 platform. The CFP-LC card provides 100 Gbps services to support 100 G
DWDMwavelengths generated by the 100G-LC-C card. The traffic coming from CFP interfaces is switched
to the trunk port through a cross-switch.

The CFP-LC card supports the following signal types:

• 100 Gigabit Ethernet

• 40 Gigabit Ethernet

• OTU-3

• OTU-4

Client ports can be equipped with a large variety of CFP pluggables.

Key Features
The key features of CFP-LC card are listed in .

The CFP-LC card is a double-slot card and can be installed in Slot 3 or Slot 5 in the Cisco ONS 15454 M6
chassis, and the 100G-LC-C peers cards must be placed in the adjacent slots (2 and 5 or 4 and 7). If the card
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is plugged in one of the unsupported slots or in a Cisco ONS 15454 M2 chassis, the system raises an
EQPT::MEA (Mismatch of Equipment Alarm) notification. Up to two CFP-LC cards per Cisco ONS 15454M6
shelf assembly can be installed, supporting up to 28x 40-Gbps or 14x 100 Gbps interfaces per 42-rack units
(RU) bay frame.

The CFP-LC card is equipped with two 100 G CFP pluggable modules and a cross-bar embedded switch
module. The CFP-LC card provides two backplane interfaces (working both at 100 Gb or 40 Gb) that are
suitable for the cross-switch application on the incoming CFP signals. The CFP-LC card can be configured
to send all client CFP services towards the backplane to be connected with up to two 100G-LC-C cards placed
in the two adjacent slots (upper and lower) of the Cisco ONS 15454 M6 chassis in order to provide two 100 G
transponders configurations.

The fan-tray assembly 15454-M6-FTA2 (for the M6 chassis) must be installed in the shelf where a CFP-LC
card is installed.

Note

Operating Modes for CFP-LC Card
The CFP-LC card supports the following operating modes:

• 2x40G Muxponder

• CFP-TXP (100G Transponder)

Each operating mode can be configured using the specific set of cards and client payloads. lists the valid port
pair for a specific operatingmode and the supported payloads, and describes how eachmode can be configured.

2x40G Muxponder CFP-TXP (100G Transponder)

The CFP-LC card can be connected through the Cisco ONS 15454 M6 backplane with up to two 100G-LC
cards placed in the upper or lower slot of the same shelf to provide the equivalent functionalities of two 100 G
LR4 transponders, leveraging on CFP pluggables as the client interface.

For more information about the CFP-LC card, see
http://www.cisco.com/en/US/prod/collateral/optical/ps5724/ps2006/data_sheet_c78-713295.html

MR-MXP Card
In this chapter, "MR-MXP" refers to the NCS2K-MR-MXP card.

TheMR-MXP card is a mixed rate 10G and 40G client muxponder that is supported on Cisco ONS 15454M2
and Cisco ONS 15454 M6 platforms. The card is equipped with one CPAK port, two SFP ports, and two
QSFP+ ports. The card can interoperate with and 10x10G-LC cards through a chassis backplane.

Key Features
The card key features are listed in the .

The MR-MXP card provides the following features:

• Termination point for a 100G client payload on the CPAK port. The aggregated payloads are forwarded
to a 200G companion trunk card.
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For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Operating Modes for MR-MXP Card
The MR-MXP card supports the following 200G operating modes:

• MXP-200G

• MXP-10x10G-100G

• MXP-CK-100G

Each operating mode can be configured using specific set of cards and client payloads. The operating mode
is configured on the companion trunk card (). For more information about these operating modes, see .

The MR-MXP card supports the following 100G operating modes:

• MXP-100G

• TXP-100G

• 100G-B2B

All 100G and 200G operating modes support the encryption feature except for the MXP-CK-100G mode.Note

MXP-100G

The MXP-100G operating mode is provisioned with MR-MXP card on the client side and the adjacent card
on the trunk side. The operating mode can be provisioned only from the client side but can be deleted from
both client and trunk sides. This mode supports 10GE as the payload. This mode uses the SFP+ and QSFP+
ports on MR-MXP client card and the DWDM port on the card. The aggregate signal from the client is sent
to trunk through the backplane.

The MXP-100G operating mode is also provisioned with MR-MXP card on the client side and the adjacent
card on the trunk side. The operating mode can be provisioned only from the client side but can be deleted
from both client and trunk sides. This mode supports 2X10GE+2X40GE as the payload. This mode uses the
SFP+ and QSFP+ ports on MR-MXP client card and the DWDM port on the card. The aggregate signal from
the client is sent to trunk through the backplane.

The operating mode can be provisioned on the following slots:

• ONS 15454 M6: Slots 2 and 3, 4 and 5, 6 and 7

• NCS 2015: Slots 2 and 3, 4 and 5, 6 and 7, 8 and 9, 10 and 11, 12 and 13, 14 and 15

TXP-100G

TXP-100G operating mode is provisioned with MR-MXP card on the client side and the adjacent card on the
trunk side. The operating mode can be provisioned only from the client side but can be deleted from both
client and trunk sides. This mode supports 100GE as the payload. This mode uses the CPAK port onMR-MXP
client card and the DWDM port on the card. The aggregate signal from client is sent to trunk through the
backplane.

The operating mode can be provisioned on the following slots:
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• ONS 15454 M6: Slots 2 and 3, 4 and 5, 6 and 7

• NCS 2015: Slots 2 and 3, 4 and 5, 6 and 7, 8 and 9, 10 and 11, 12 and 13, 14 and 15

100G-B2B

The 100G-B2B operating mode can be provisioned with MR-MXP card on the client side and the adjacent
MR-MXP card card on the trunk side. The operating mode performs encryption of an 100GE client signal
taken from the CPAK interface or 10x10GE client signal taken from the two QSFP and SFP interfaces of the
client MR-MXP card and maps it to an OTU4 signal with encryption. The OTU4 signal is passed to the trunk
MR-MXP card in the peer slot through the back plane. The trunk MR-MXP card converts the OTU4 signal
to grey wavelength with either an SR-10 or an LR-4 through the CPAK interface of the trunk card. The 100GE
client payload can be divided into either four or 10 sub-lanes.

The CPAK port or two QSFP and 2 SFP+ ports can be selected on the client card during the provisioning.
The operating mode can be provisioned from any MR-MXP card in the peer slot pair. When the operating
mode is created, the card that the user selects to create operating mode acts as the client card and the peer card
for that card acts as the trunk card.

The operating mode can be provisioned on the following slots:

• ONS 15454 M6: Slots 2 and 3, 4 and 5, 6 and 7

• NCS 2015: Slots 2 and 3, 4 and 5, 6 and 7, 8 and 9, 10 and 11, 12 and 13, 14 and 15

The provisioning operations like payload/operating mode creation and FEC settings in 100G-B2B operating
mode of MR-MXP card takes longer when compared to other operating modes.

Sub Operating Modes

The sub OpMode in MR-MXP cards determines the operating mode on the card client ports. For example,
the QSFP+ port can be provisioned either as a 40GE port or can be divided into four 10G ports. This
provisioning is controlled by the sub OpMode. The sub OpMode is created by default when the operating
mode is configured on the card.

• OPM_10x10G—This is the default subOpMode for theMXP-100G,MXP-200G, andMXP-10x10G-100G
operating modes. In this sub OpMode, the SFP and QSFP+ ports are divided in such a way that 10 10GE
payloads can be provisioned.When a PPM is provisioned on a QSFP+ port, four internal ports are created.
A 10 GE payload can be provisioned on each of these ports. The OPM-10x10G operating mode is
provisioned with MR-MXP card on the client side and the adjacent MR-MXP card on the trunk side.
The operating mode can be provisioned only from the client side but can be deleted from both client and
trunk sides. The aggregate signal from client is sent to trunk through the backplane.

• OPM_100G—This is the default sub OpMode for the MXP-CK-100G operating mode where the CPAK
port can be provisioned with a 100GE or OTU4 payload. The 100GE payload can be divided into either
four or ten sub-lanes. For 100GE payload, the OPM-100G operating mode is provisioned withMR-MXP
card on the client side and the adjacent MR-MXP card on the trunk side. For OTU4 payload, the
OPM-100G operating mode is provisioned with MR-MXP card on the client side and the adjacent card
on the trunk side.The operating mode can be provisioned only from the client side but can be deleted
from both client and trunk sides. The aggregate signal from client is sent to trunk through the backplane.

• OPM_2x40G_2x10G—This sub OpMode is provisioned for the MXP-100G operating mode to support
the 2X10GE+2X40GE payload. This operating mode is provisioned with MR-MXP card on the client
side and the adjacent card on the trunk side. The operating mode can be provisioned only from the client
side but can be deleted from both client and trunk sides. The aggregate signal from client is sent to trunk
through the backplane.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
267

Provisioning Transponder and Muxponder Cards
Operating Modes for MR-MXP Card



This sub OpMode is also provisioned for the MXP-200G operating mode to support the following sub
OpMode combinations on both peer and skip MR-MXP cards.

• OPM_10x10G and OPM_10x10G

• OPM_2x40G_2x10G and OPM_2x40G_2x10G

• OPM_2x40G_2x10G and OPM_10x10G

• OPM_10x10G and OPM_2x40G_2x10G

Limitations for MR-MXP Card
• Line timing is not supported.

• GCC0 communication channel is not supported.

• Overclocking of OTU2 payload is not supported.

• Y cable protection is not supported.

• Only G-FEC is supported on OTN payloads.

• The lanes in a QSFP+ port support only homogeneous payloads.

Key Features of 100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC,
10x10G-LC, 100GS-CK-LC, 200G-CK-LC, CFP-LC, and MR-MXP
Cards

Table 107: Feature History

Feature DescriptionRelease InformationFeature Name

This feature allows you to
dynamically allocate power based
on the line card operating mode.
This maximises the usage of the
NCS 2015 chassis slots in a 2+2
PSU configuration.This feature is
supported on the 200G-CK-LC and
400G-XP-LC cards.

Cisco NCS 2000 Release 11.12Dynamic Power Allocation on
200G-CK-LC and 400G-XP-LC
Cards

The 100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC, 10x10G-LC, 100GS-CK-LC, 200G-CK-LC,
CFP-LC, and MR-MXP cards support the following key features:

• OperatingModes—The cards can be configured into multiple operatingmodes. The cards can be equipped
with pluggables for client and trunk options, and offer a large variety of configurations. When you
configure the card into multiple operational modes, make sure that the following tasks are completed:
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• The card must be preprovisioned and the modes must be configured. None of the modes are
provisioned on the card by default. All operating modes are created on the card level. These are
card-specific provisioning, which decides the behavior of a particular card.

• Depending on the card mode selected, the supported payload for that particular card mode must be
provisioned on the PPMs.

• The payloads can be provisioned after configuring the operational mode on the card.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

Each operating mode can be configured using the specific set of cards and client payloads.

Table 108: Operating Modes and Supported Payloads for 100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC, 10x10G-LC, 100GS-CK-LC,
200G-CK-LC, CFP-LC, and MR-MXP Cards

Supported Client
Payloads

Peer Card (connected
through backplane)

Operational ModeCard
(provisioning
executed on this
card)

100GE, OTU4—TXP-100G (Standalone 100G
Transponder)

100G-LC-C,
100G-ME-C,
100G-CK-C,
100ME-CKC — Regeneration of any

100 G configuration
100G-LC-C,
100G-ME-C,
100G-CK-C,
100ME-CKC

RGN-100G (100GRegenerator)

40GE—MXP-2x40G (for 100G-CK-C,
100ME-CKC)
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Supported Client
Payloads

Peer Card (connected
through backplane)

Operational ModeCard
(provisioning
executed on this
card)

100GE and OTU4

OTU4 is supported only
for the 200G-CK-LC
card.

—TXP-100G (Standalone 100G
Transponder)

100GS-CK-LC
and200G-CK-LC

Regeneration of any
100 G configuration

100GS-CK-LC or
200G-CK-LC

RGN-100G (100GRegenerator)

10GE and OTU2

OTU2 payloads are
supported only when
the sub OpMode in
MR-MXP is
OPM_10x10G.

MR-MXP

Skip card is MR-MXP

OC192/SMT64, and
OTU2 payloads are
supported in MLR
QSFP+

MXP-200G

10GE and OTU2

OTU2 payloads are
supported only when
the sub OpMode in
MR-MXP is
OPM_10x10G.

10x10G-LC

Skip card is MR-MXP

MXP-10x10G-100G

MR-MXPMXP-CK-100G
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Supported Client
Payloads

Peer Card (connected
through backplane)

Operational ModeCard
(provisioning
executed on this
card)

10GE, 100GE and
OTU2

10GE, OC192/STM64,
and OTU2 payloads are
supported only when
the sub OpMode in
MR-MXP is
OPM_10x10G.

OTU4 (only with
200G-CK-LC card)

When 200G-CK-LC
andMR-MXP cards are
provisioned in
MXP-CK-100G
operating mode with
OTU4 payload, the
FEC parameter on the
200G-CK-LC client can
be set only to Standard
and cannot be changed
to Disable or Enhanced.

100GE and OTU4
payloads are supported
only when the sub
OpMode in MR-MXP
is OPM_100G.
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Supported Client
Payloads

Peer Card (connected
through backplane)

Operational ModeCard
(provisioning
executed on this
card)

10GE-LAN Phy,
10GE-WANPhy (using
OC192), OTU2,
OTU2e

10GE are supported
when the 10x10G-LC
card is connected with
the 100GS-CK-LC
card.

10GE, and OTU2 are
supported when the
10x10G-LC card is
connected with the
200G-CK-LC card.

100G-LC-C,
100G-ME-C,
100G-CK-C,
100ME-CKC, ,
100GS-CK-LC
200G-CK-LC

MXP-10x10G (10x10G
Muxponder)

10x10G-LC

10GE-LANPhy, OTU2—RGN-10G (5x10GRegenerator)

10GE-LAN Phy,
OTU2e, OTU2, IB_5G

—TXP-10G (5x10GTransponder)

10GE—Low Latency

10GE—Fanout-10X10G

10GE—TXPP-10G

OTU3/40GE-LAN Phy100G-LC-C or
100G-CK-C card

2x40G MuxponderCFP-LC

OTU4, 100GE100G-LC-C or
100G-CK-C card

CFP-TXP (100G
Transponder)—One port

CFP-TXP (100G
Transponder)—Two ports

OTU4, 100GETwo 100G-LC-C or
100G-CK-C cards
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Supported Client
Payloads

Peer Card (connected
through backplane)

Operational ModeCard
(provisioning
executed on this
card)

10GE and OTU2

OTU2 payloads are
supported only when
the sub OpMode in
MR-MXP is
OPM_10x10G.

200G-CK-LC card or
100GS-CK-LC card

MXP-100GMR-MXP

2X10GE+2X40GE

This payload is
supported only when
the sub OpMode in
MR-MXP is
OPM_2x40G_2x10G.

200G-CK-LC cardMXP-100G

100GE200G-CK-LC card or
100GS-CK-LC card

TXP-100G

100GE, 10x10GEMR-MXP100G-B2B

10GE, 40G, and OTU2200G-CK-LC card or
100GS-CK-LC card

Skip card is MR-MXP

MXP-200G

100GE,10GE, and
OTU2

200G-CK-LC card or
100GS-CK-LC card

MXP-CK-100G

OTU4

This payload is
supported only when
the sub OpMode in
MR-MXP is
OPM_100G.

200G-CK-LCMXP-CK-100G

10GE and OTU2200G-CK-LC card or
100GS-CK-LC card

MXP-10X10G-100G

For operating modes of the respective cards, see the Operating Modes for 100G-LC-C, 100G-ME-C,
100G-CK-C, 100GS-CK-LC, 200G-CK-LC, and 100ME-CKCCards, OperatingModes for 10x10G-LCCard,
Operating Modes for CFP-LC Card, and Operating Modes for MR-MXP Card, on page 266.

• Protocol Transparency—The 100G-LC-C, 100G-ME-C, 100G-CK-C, 100ME-CKC, 100GS-CK-LC,
and 200G-CK-LC cards deliver any 100 Gbps services for cost-effective, point-to-point networking. The
10x10G-LC card delivers any 10 Gbps services for cost-effective, point-to-point networking. In case of
100 G muxponder clients that are mapped into OTU4 DWDM wavelength.
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Table 109: Transponder Client Configurations and Mapping for 100G-LC-C and 100G-CK-C Cards

TrunkClient

Rate with 7%
GFEC, 20%
GFEC, or
EFEC OH
(Gbps)

FormatMappingRate (Gbps)Format

OTU4 111.809Bit transparent
through standard
G.709v3 mapping

101.125100GE LAN-PHY

Transparent G.709
standard

111.809OTU4

Table 110: Client Configurations and Mapping for CFP-LC Card

TrunkClient

Rate with
7% GFEC
or EFEC
OH (Gbps)

FormatMappingRate (Gbps)Format

OTU4 111.809Bit transparent
through standard
G.709v3 mapping

101.125100GE LAN-PHY

Transparent G.709
standard

111.809OTU4

1024b/1027b transc
+ OPU4 GMP
G709 Appendix
VIII

41.25040GE LAN-PHY

Transparent G.709
standard

43.018OTU3

• Flow-Through Timing—The cards allow the timing to flow through from client to line optical interface.
The received timing from client interface is used to time the line transmitter interface. This flow-through
timing allows multiple cards to be placed in the same shelf but be fully independently timed, independent
of the NE timing.

• Far-End Laser Control (FELC)—FELC is supported on the cards. For more information on FELC, see
"Far-End Laser Control" section.

• Performance Monitoring—The 100-Gbps DWDM trunk provides support for both transparent and
non-transparent signal transport performance monitoring. The Digital Wrapper channel is monitored
according to G.709 (OTN) and G.8021 standards. Performance Monitoring of optical parameters on the
client and DWDM line interface include Loss Of Signal (LOS), Laser Bias Current, Transmit Optical
Power, and Receive Optical Power. Calculation and accumulation of the performance monitoring data
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are supported in 15-minute and 24-hour intervals as per G.7710. Physical system parameter measured
at the wavelength level like Mean PMD, accumulated Chromatic Dispersion, or Received OSNR are
also included in the set of performancemonitoring parameters. These can greatly simplify troubleshooting
operations and enhance the set of data which can be collected directly from the equipment. The
performance monitoring for the CFP-LC card takes into account that the two CFP-LC cards are an host
board supporting CFP client equipment, while the digital monitoring if the incoming client is implemented
on the 100G cards. There is a virtual port connection that displays the Digital Wrapper monitoring
according to G.709 (OTN) as well as the RMON for Ethernet signals, while the optical performance
monitoring is directly available on the twoCFP-LC cards. Calculation and accumulation of the performance
monitoring data are supported in 15-minute and 24-hour intervals as per G.7710.

• Loopback—The terminal, facility, or backplane loopback can be provisioned on all the ports of the
100G-LC-C, 100G-CK-C, 100G-ME-C, 100ME-CKC, 10x10G-LC, 100GS-CK-LC, and 200G-CK-LC
cards configured in any operating mode except for the low latency mode. The backplane facility loopback
cannot be configured on the 10x10G -LC card configured in the MXP-10x10G mode. The loopback can
be provisioned only when the port is in OOS-MT state. A new port cannot be provisioned when the
backplane loopback is configured on the 10x10G-LC card. For the CFP-LC card configured in the
CFP-TXP or CFP-MXP mode, the facility or terminal loopback can be configured on the backplane of
the peer 100G-LC-C, 100G-CK-C, 100G-ME-C, 100ME-CKC, 100GS-CK-LC, and 200G-CK-LC cards.
Terminal and facility loopback can be provisioned onMR-MXP cards configured in any operating mode.

In Release 10.0.2, the facility loopback and drop feature can be provisioned on the client, trunk, and
backplane interfaces of the 100G-LC-C, 10x10G-LC, CFP-LC, and 100G-CK-C cards as follows:

• Trunk facility loopback (drop) and client facility loopback (drop) is supported on:

• 100G-LC-C cards configured in the TXP mode (with CXP client pluggable) for OTU4 and
100GE client payloads.

• 100G-CK-LC configured in the TXPmode (with CPAK client pluggable) for OTU4 and 100GE
client payloads.

When facility loopback (drop) is provisioned on the trunk interface, the trunk RX signal is sent back
to the trunk TX port and an ODUk-AIS (for OTU4 payloads) or an LF (for 100GE payloads) signal
is fowarded to the client port in the downstream direction for any of the squelch settings. When
facility loopback (drop) is provisioned on the client interface, the client RX signal is sent back to
the client TX port and an ODUk-AIS signal is forwarded to the trunk port in the downstream direction
for any of the squelch settings.

• Backplane facility loopback (drop) is supported on:

• 100G-LC-C and CFP-LC configured in the TXP mode (with CFP client pluggable) for OTU4
and 100GE client payloads.

• 100G-CK-C and CFP-LC configured in the TXP mode (with CFP client pluggable) for OTU4
and 100GE client payloads.

When facility loopback (drop) is provisioned on the backplane interface, the client RX signal is sent
back to the client TX port and an ODUk-AIS signal is forwarded to the trunk port in the downstream
direction for any of the squelch settings.

• Fault propagation on 10GE, 40GE, and 100GE clients— In R 10.3, a new squelch option named LF is
supported for GigE payloads. A local fault (LF) indication is fowarded to the client port in the downstream
direction when a failure on the trunk port occurs. The LF option is supported for :
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10GE payloads on 10x10G-LC cards configured in the:•

• RGN-10G or TXP-10G mode

• MXP-10x10G mode (paired with 100G-LC-C, 100G-CK-C, or 100GS-CK-LC card)

• MXP-10x10G-100G mode ( paired with a 100GS-CK-LC or 200G-CK-LC card)

• 100GE payloads on:

• 100G-LC-C, 100G-CK-LC, 100GS-CK-LC, or 200G-CK-LC cards configured in the TXP-100G
mode

• CFP-LC cards configured in the CFP-TXP mode (paired with 100G-LC-C or 100G-CK-C
card)

• 40GE payloads on:

• CFP-LC card configured in the 2x40G Muxponder mode (paired with a 100G-LC-C or
100G-CK-C card)

• 100G-CK-C card configured in the MXP-2x40G mode

• Trail Trace Identifier—In R 10.3, the Trail Trace Identifier (TTI) in the path monitoring overhead is
supported in OTU, and ODU OTN frames. It is possible to to individually manage the Source Access
Point Identifer (SAPI), Destination Access Point Identifer (DAPI), and User Operator Data fields on
VTXP. This feature is also supported on these cards.

• 10x10G-LC— OTU4 and ODU4 payloads

• CFP-LC— OTU4, ODU4, OTU3, and ODU3 payloads

• 100G-LC-C, 100G-CK-LC, 100GS-CK-LC, 200G-CK-LC— OTU4 and ODU4 payloads

The Trail Trace Identifier Mismatch (TTIM) alarm is raised after comparing only the SAPI bytes.

TTI monitoring is not supported between two nodes (node 1, node 2) in the following conditions:

• Node 1 and node 2 are installed with a release earlier to R10.3. Node 2 is upgraded to R 10.3. New
TTI strings provisioned at either node1 or node 2 raises the TTIM alarm.

• Node 1 is installed with the R 10.3 software. Node 2 is installed with a release earlier to R10.3. New
TTI strings provisioned at either node1 or node 2 raises the TTIM alarm.

• Node 1 is installed with R 10.3 software and TTI settings are configured. Node 2 is installed with
the R10.3 software but the database is loaded from a release earlier to R10.3.

• GeneralizedMultiprotocol Label Switching—TheGeneralizedMultiprotocol Label Switching (GMPLS)
circuit can be created on the 100G-LC-C, 100G-CK-C, 10 x10G-LC, 100GS-CK-LC, and 200G-CK-LC
cards. However, this circuit cannot be created when the card is in 100G regenerator mode. When the
card is configured in MXP-10 x10G card mode, only GMPLS Optical Channel Network Connections
(OCHNCs) can be created.

• Automatic Laser Shutdown (ALS) can be configured on all the ports. ALS is supported only on the ports
that are configured with OC192/STM64, OTU2, and OTU4 payloads.
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• GCC channels—can be provisioned on the OTU2 client and trunk ports of the 10 x10G-LC card, OTU3
port (virtual port on the peer 100G-LC-C or 100G-CK-C card) of the CFP-LC card, and the OTU4 client
and trunk ports of the 100G-LC-C or 100G-CK-C card.

• 50 ms switching with PSM—A protection switch time of less than 50 ms can be achieved with two
CFP-LC cards on their 100GE client ports using a PSM card that is configured in the standalone mode.
The client ports of the CFP-LC cards are connected to the working and protect ports of the PSM card.
AnOCHCC circuit must be created between the two client ports. PSM is also supported on 100GS-CK-LC
or 200G-CK-LC cards on their trunk ports where the protection switch time of 50 ms is achieved in the
TXP-100G configuration with 20%SD FEC.

• The optical TX power can be set to a value from -10.0 to +0.25 dBm on the trunk port of the 100G-LC-C,
100G-CK-C card, or 200G-CK-LC card -10.0 to -0.5 dBm for 100GS-CK-LC card; to enable it to
interoperate with ASR 9000 series routers and Cisco CRS-3 routers. The TX shutdown feature allows
you to turn off the TX power on the 100G-LC-C, 100G-CK-C, or 200G-CK-LC cards when the trunk
port in out of service or in maintenance. The 100G-LC-C, 100G-CK-C, and 200G-CK-LC cards have
the ability to receive optical signals even when the TX power is turned off.

• Pseudo Random Binary Sequence (PRBS)—For 100G-CK-C and 100G-LC-C cards, the trunk ports can
generate PRBS_31 pattern and detect PRBS_11, PRBS_23, and PRBS_31 patterns. Only PRBS_31 is
supported on the 100GS-CK-LC card. The detection is always on and does not need to be enabled. The
generation can be enabled that prompts the card to fulfill the OPU with PRBS_31 pattern.

• Multivendor Interoperability - From Release 10.6.2, the 200G-CK linecard can be configured to
inter-operate with other vendor interfaces. A new option called, InteropMode is available to disable/enable
interoperability. This option is available, when, the:

• Modulation format is 100G-QPSK

• FEC is set to 7% High Gain FEC

• Admin state of the trunk port is set to OOS-DSBLD (Out of service and disabled).

The behavior and performance of the card configured with HG-FEC Multivendor FEC, is the same as
the old HG-FEC mode (no optical performance variation). The only difference is that the DGD data
retrieved form the CTC PM tab has a reduced accuracy.

• 200G-CK-LC and 10x10G-LC cards—Supports protection through Y-cable protection scheme.

Y-cable protection is supported when the 200G-CK-LC card is configured in TXP-100G operating mode
and the 100G client CPAK ports are provisioned with 100GE payload. This configuration uses the
CPAK-100G-LR4 pluggable.

Y-cable protection is supported when the 10x10G-LC card is configured in MXP-10x10G operating
mode with 200G-CK-LC card and the 10x10G-LC card is provisioned with 10GE payloads. This
configuration uses the ONS-SC+-10G-LR and ONS-SC+-10G-SR pluggables.

Functions and Features
The cards have the following functions and features, explained in the Card Features, on page 739 chapter:

• Enhanced FEC (E-FEC) Feature

• Timing Synchronization
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• Jitter Considerations

• Card level indicators

• Port level indicators

Related Procedures for 100G-LC-C, 100G-ME-C, 100G-CK-C,
100ME-CKC, 10x10G-LC, CFP-LC, 100GS-CK-LC, 200G-CK-LC, and
MR-MXP Cards

• NTP-G235 Provisioning an Operating Mode, on page 652

• NTP-G236 Modifying the 100G-LC-C, 100G-CK-C, 100G-ME-C, 100ME-CKC, 10x10G-LC,
100GS-CK-LC, , 200G-CK-LC, CFP-LC,WSE, MR-MXP, or 400G-XP-LC Card Line Settings and PM
Parameter Thresholds, on page 662

• NTP-G75 Monitor Transponder and Muxponder Performance

400G-XP-LC Card
The 400G-XP-LC card is a tunable DWDM trunk card that simplifies the integration and transport of 10
Gigabit and 100 Gigabit Ethernet interfaces and services to enterprises and service provider optical networks.
The card is a double-slot unit that provides 400 Gbps of client and 400 Gbps of trunk capacity. The card
supports six QSFP+ based client ports that can be equipped with 4x 10 Gbps optics and four QSFP28 or
QSFP+ based client ports that can be equipped with 100 Gbps QSFP28 and 4x 10 Gbps QSFP+ optics. The
card is capable of aggregating client traffic to either of the two 200 Gbps coherent CFP2 trunk ports. The
CFP2 - 11 trunk port of the 400G-XP-LC card can interoperate with the 10x10G-LC card through the chassis
backplane. To enable this interoperability between the 400G-XP-LC and 10x10G-LC cards, the
OPM_PEER_ODU2 and OPM_PEER_ODU2e slice modes are supported on Slice 2 when the 400G-XP-LC
card is configured in the MXP mode.

The table below details the layout constraints when the 400G-XP-LC card is paired with the 10x10G-LC card
in the Cisco ONS 15454 M6 and Cisco NCS 2015 chassis.

Table 111: Slot Constraints for the 400G-XP-LC and 10x10G-LC Cards

NotesSlot (400G-XP)Slot (10x10G-LC)Chassis

Only one of these two
combinations can be
deployed at a time.

3-42Cisco ONS 15454 M6

5-64
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NotesSlot (400G-XP)Slot (10x10G-LC)Chassis

A maximum of four of
these combinations can be
deployed at a time.

3-42NCS 2015

5-64

7-86

9-108

11-1210

13-1412

15-1614

The 400G-XP-LC card supports the following client signals:

• 10 GE: The payload can be provisioned for the OPM_10x10G, OPM_PEER_ODU2, or
OPM_PEER_ODU2e slice mode for any trunk configuration. 10GE is provisioned for the
OPM_PEER_ODU2 and OPM_PEER_ODU2e slice modes in the GFP and CBR mapping modes
respectively. The cross-connect circuit bandwidth is ODU2e.

• 100 GE: The payload can be provisioned for the OPM_100G slice mode for any trunk configuration.
The cross-connect circuit bandwidth is ODU4.

• OTU2: This payload is supported only on the QSFP-4X10G-MLR pluggable. The payload can be
provisioned for the OPM_10x10G or OPM_PEER_ODU2 slice mode for any trunk configuration. The
cross-connect circuit bandwidth is ODU2.

• OTU2e: This payload is supported only on the QSFP-4X10G-MLR pluggable. The payload can be
provisioned for the OPM_10x10G or OPM_PEER_ODU2e slice mode for any trunk configuration. The
cross-connect circuit bandwidth is ODU2e.

• OC192/STM64: This payload is supported only on the QSFP-4X10G-MLR pluggable. The payload can
be provisioned for the OPM_10x10G or OPM_PEER_ODU2 slice mode for any trunk configuration.
The cross-connect circuit bandwidth is ODU2.

• OTU4: This payload is supported only on the ONS-QSFP28-LR4 pluggable. The payload can be
provisioned for the OPM_100G slice mode for any trunk configuration. The cross-connect circuit
bandwidth is ODU4.

For any cardmode except REGENwith slide mode as OPM-10x10G, you can configure a mix of 10G payloads
( OTU2, 10GE) on the same slice or client port with the exception of CDR ports (7, 8, 9, and 10). On CDR
ports, the first configured 10G lane would determine the configurable payloads for the other three port lanes.

Note

If a slice is configured using the OPM_10x10G slice mode, it can be used only for 10G circuit creation whereas
if a slice is configured using the OPM_100G slice mode, it can be used only for 100G circuit creation.

Note
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GCC Rate in the Edit GCC Termination Window is shown as 192K instead of the supported 1200K. This is
a known behavior.

Note

The 400G-XP-LC card is supported on Cisco ONS 15454 M2, Cisco ONS 15454 M6, and Cisco NCS 2015
platforms.

One 400G-XP-LC card can be installed in the Cisco ONS 15454 M2 DC chassis that is powered by
15454-M2-DC or 15454-M2-DC–E. Three 400G-XP-LC cards can be installed in the Cisco ONS 15454 M6
chassis that is powered by 15454-M6-DC, 15454-M6-DC40, or 15454-M6-AC2 (180V AC to 264V AC).
Seven 400G-XP-LC cards can be installed in the Cisco NCS 2015 chassis that is powered by DC 2 + 2, DC
3 + 1, or AC 2 + 2 PSU.

Limitations

Themaximum short term operating temperature of the Cisco ONS 15454M2 shelf must not exceed 50 degrees
when the card is installed.

Note

You may observe traffic glitches on the receiving direction of client ports 7, 8, 9, and 10 on the 400G-XP-LC
card that you connect to CXP port of a 10x10G-LC card in fanout mode. To bringup traffic in such cases,
change the admin state of the CXP port from OOS-DSBLD state to IS-NR state. Repeat the same action if
you continue to observe glitches.

Note

For more information about the card, see http://www.cisco.com/c/en/us/products/collateral/optical-networking/
network-convergence-system-2000-series/datasheet-c78-736916.html.

Key Features
The card supports the following key feature:

• Operating Modes—The card can be configured in various operating modes. The cards can be
equipped with pluggables for client and trunk ports, and offer a large variety of configurations.
When you configure the card, make sure that the following tasks are completed:

•

• The trunk port PPMs must be preprovisioned before configuring the card operating mode.
When the card is paired with the 10x10G-LC card, all the operating mode provisioning must
performed on the card. The client payloads can be provisioned after configuring the operational
mode on the card.

The table below details the configurations supported on the card for the supported card modes.

Table 112: Configuration Options for the Card Modes

OptionsConfiguration

MXP_2x150G
(8QAM)

REGENOTNXCMXPCard
configuration
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OptionsConfiguration

M_150GNoneNoneNoneTrunk
configuration
( per trunk) M_100GM_100GM_100G

M_200GM_200GM_200G

NoneSlice
configuration
is not
supported

NoneNoneSlice
configuration

OPM_100GOPM_100GOPM_2x40G_2x10G

OPM_10x10GOPM_10x10GOPM_100G

OPM_6x16G_FCOPM_10x10G

OPM_6x16G_FC

OPM_PEER_ODU2
(Available only for
Slice 2 when is
paired with
10x10G-LC)

OPM_PEER_ODU2e
(Available only for
Slice 2 when is
paired with
10x10G-LC)

For more information about the trunk and slice configuration, see Slice Definition and Line Card
Configuration for Card, on page 288.

• Each trunk port functions as a muxponder instance has the following features:

• The trunk port supports Analog Coherent Optical (ACO) CFP2 coherent pluggable.

Before removing the CFP2 pluggable from any of two trunk ports, ensure that
the relevant trunk port is set to the OOS (Out-of-service) state. Wait until the
trunk port LED turns off. Wait for a further 120 seconds before extracting the
CFP2 pluggable.

Note

• Configurable trunk capacity:

• 100Gbps coherent DWDM transmissionwith quadrature phase shift keying (QPSK )modulation.

• 200 Gbps coherent DWDM transmission with 16-state quadrature amplitude modulation
(16-QAM) modulation.

• Configurable trunk FEC: SD-FEC with 15% or 25% overhead.

• Configurable differential/non-differential line encoding.
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• Nyquist shaping if channels at trunk TX.

• Flex spectrum tunability over the full extended C-Band.

• 100 Gbps through 100 Gbps QSFP28 client ports.

• 10 Gbps through 4x 10 Gbps QSFP+ client ports.

• 16 Gbps through 4 x 16 Gbps QSFP+ client ports.

• The supported CD ranges are detailed in the table below:

Table 113: CD Range for Card

100G QPSK200G 16-QAM

HighLowHighLow

90000-2000050000-10000Default Working
CD Range

72000-1800045000-9000Default CD
Thresholds

280000-28000060000-60000AllowedCDRange
( Working and
Thresholds)

• Loopback—The following loopback types are supported:

• Client ports - Terminal (Inward), Facility (Line)

• Trunk ports - Terminal (Inward)

• Iports - Facility (Line), Terminal loopback (Drop)

Before you provision loopback on the iports, place the relevant trunk ports in the
OOS-MT state. This causes the iports to move to the OOS-MT state.

Note

• Automatic Laser Shutdown (ALS) can be configured on all the ports.

• 100GE ethernet client ports can be provisioned with or without IEEE 802.3 bj FEC. The options are
Auto, Force-Fec-On, Force-Fec-Off.

• Trail Trace Identifier (TTI)—TTI in the section monitoring overhead is supported . Source Access Point
Identifer (SAPI), Destination Access Point Identifer (DAPI), and User Operator Data fields are supported
in Release 10.6.2 and later releases.

• Trunk Port Interworking—The two CFP2 trunk ports can interoperate with each other when the source
and destination cards have the same trunk mode and slice mode configuration. For more information,
see Trunk Port Interworking in Cards, on page 292.

• GCC0 Support—The card supports provision of GCC0 channel on the trunk port. For more information,
see GCC0 Support on the Card, on page 297.
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• Interoperability—The card is interoperable with the NC55-6X200-DWDM-S card supported on NCS
5500 and the NCS4K-4H-OPW-QC2 Card supported on NCS 4000.

The following table describes the configurations, payload types, and pluggables supported for
interoperability between the card and the NCS4K-4H-OPW-QC2 card.

Table 114: Interoperability with the NCS4K-4H-OPW-QC2 card.

Pluggables for
client ports on
4H-OPW-QC2

Pluggables for
trunk ports on
4H-OPW-QC2

Pluggables for
client ports on

Pluggables for
trunk ports on

Trunk
configuration

Payload type

QSFP-100G-SR4-SCFP2QSFP-100G-SR4-SCFP2OTU4100GE

QSFP-100G-SR4-SCFP2QSFP-100G-SR4-SCFP2OTU4C2100GE

ONS-QSFP28-LR4CFP2ONS-QSFP-4X10
MLR

CFP2OTU4OTU2

ONS-QSFP28-LR4CFP2ONS-QSFP-4X10
MLR

CFP2OTU4C2OTU2

ONS-QSFP-4X10
MLR

CFP2ONS-QSFP-4X10
MLR

CFP2OTU410GE

ONS-QSFP-4X10
MLR

CFP2ONS-QSFP-4X10
MLR

CFP2OTU4C210GE

The following table describes the configurations, payload types, and pluggables supported for
interoperability between the card and the NC55-6X200-DWDM-S card.

Table 115: Interoperability with the NC55-6X200-DWDM-S card.

Pluggables for
client ports on
6X200-DWDM-S

Pluggables for
trunk ports on
6X200-DWDM-S

Pluggables for
client ports on

Pluggables for
trunk ports on

Trunk
configuration

Payload type

QSFP-100G-SR4-SCFP2QSFP-100G-SR4-SCFP2OTU4100GE

QSFP-100G-SR4-SCFP2QSFP-100G-SR4-SCFP2OTU4C2100GE

For a detailed list of the supported pluggables, see http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html.

OTN Cross-connect Capability on 400G-XP-LC Cards
The 400G-XP-LC card supports a new OTN cross-connect (OTNXC) operating mode. You cannot edit the
trunk and slice mode after the 400G-XP-LC card is configured in OTNXC mode. This mode allows ODU2e
switching between client to trunk ports or trunk to trunk ports within a single 400G-XP-LC card for 100G
and 200G trunk rates. Both trunk ports are configured with the same rate (100G or 200G).

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
283

Provisioning Transponder and Muxponder Cards
OTN Cross-connect Capability on 400G-XP-LC Cards

http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/guides/b_ons_pluggables.html
http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/guides/b_ons_pluggables.html


Only 10GE client payloads are supported in Release 10.x.x. Each 10GE is mapped to an ODU2e channel.
Each 10G client port of the 400G-XP-LC card consists of only one ODU2e and each OTU4C2 ( 200G) trunk
port of the 400G-XP-LC card consists of 20 ODU2es.

You can create 20xODU2e trunk-to-trunk cross-connections or up to 40x10GE client-to-trunk cross-connections.
Client-to-trunk cross-connections can be protected or unprotected. The card supports up to 20x10GE circuits
with SNC-N 1+1 bidirectional protection.

The OTNXC card mode requires a new trunk FPGA image. The 400G-XP LC card should be running on
firmware (SCP) version 5.24 or above. A Condition message warns the user about availability of a new image.
To upgrade the FPGA image, see NTP-G362Manual FPGAUpgrade on the 400G-XP-LC Card, on page 655.

You can create single card cross-connects or end-to-end cross-connects in an OTN ring. Before you create
an end-to-end ODU circuit, WSON OCH trails or SSON trails must be configured between the nodes that
help discover the topology.

OTNXC Constraints
The following constraints apply to ODU circuit creation between 400G-XP-LC cards configured in the OTNXC
mode.

• Both trunk ports of the 400G-XP-LC card are configured with the same rate (100G or 200G)

• (Applies to R10.8) Only 10GE payloads are supported on the client ports.

• An ODU circuit cannot be created between two client ports of the 400G-XP-LC card.

• Each client port belongs to one of the four card slices. Slice 1 and Slice 2 are linked to the first trunk
port and Slice 3 and Slice 4 are linked to the second trunk port. Cross-connecting between slices of the
same trunk is not allowed. The possible cross-connections that can be created are within the same client
slice or between the client slice and any of the other trunk slices.

• There is a bandwidth limitation between the two internal ASICs of the 400G-XP-LC card due to which
a maximum of 20x10G interlink connections can be defined. These resources are consumed by either
trunk-to-trunk cross-connects or client-to-trunk cross-connects when the client does not belong to the
trunk slice.

• Protected cross-connects are restricted to client ports 1, 2, 3, 7, and 8 belonging to slices 1and 2.

• Do not provision more than one path for nonprotected circuits.

• The NE defaults thresholds for ODU interfaces cannot be set for cross-connected ODUs.

•

ODU Utilization Panes
There are three utilization panes that display the ODU utilization for the 400G-XP-LC card at the card level,
network level, and cross-connect level. To view the ODU utilization, see NTP-G366 Viewing the ODU
Utilization for ODU Circuits, on page 656.
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OTNXC Exceptions
The following exceptions apply to ODU circuits between 400G-XP-LC cards configured in the OTNXC
mode:

• WSON OCH trail creation is allowed between the trunks ports of 400G-XP-LC cards configured in
different operating modes (MXP and OTNXC)

• Downgrading WSON OCH trails to non-WSON OCH trails is allowed even though OTN circuits exist.

• OCH trail deletion is allowed if though the trunk port has an ODU cross-connect passing through it.

• Restoration and revert operations are allowed on an OCH trail when the 400G-XP-LC card is configured
in OTNXC mode.

• If the circuit protection type is SNC-N, the circuit service state is OOS-PARTIAL (Locked-partial) if
the source or destination nodes have a fault on both the trunk ports causing the port service state to change
to OOS-AU,FLT (ANSI) or Unlocked-disabled,failed (ETSI)) or if three or more intermediate nodes
have the service state as FLT.

If the circuit protection type is None, the circuit service state is OOS-PARTIAL (Locked-partial) if the
source or intermediate nodes have the service state as FLT.

• When the traffic is manually switched to the protect path in a protected revertive ODU circuit, the
WKSWPR alarm is raised on the node. The alarm may not persist after a control card reset.

• Performing a database restore operation, may not clear the WKSWPR alarm.

• Single card cross-connects may persist in CTC for some time even after the node is disconnected.

Interoperability
The card has two trunk ports, each supporting up to 20 ODU2es. These ODU2es are numbered from 1 through
20. ODU2es 1 through 10 belong to the first ODU4 slice and ODU2es 11 through 20 belong to the second
ODU4 slice. Each ODU number has a pre-defined group of timeslots as seen in the following table.

TimeslotsTributary Port
Number

ODU Trunk FACODU Trunk
Number

ODU4 SliceTrunk Port

1 11 21 31 41 51
61 71

1961Slice 1Trunk 1

(FAC 10)

2 12 22 32 42 52
62 72

2972

3 13 23 33 43 53
63 73

3983

4 14 24 34 44 54
64 74

4994

5 15 25 35 45 55
65 75

51005
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TimeslotsTributary Port
Number

ODU Trunk FACODU Trunk
Number

ODU4 SliceTrunk Port

6 16 26 36 46 56
66 76

61016

7 17 27 37 47 57
67 77

71027

8 18 28 38 48 58
68 78

81038

9 19 29 39 49 59
69 79

91049

10 20 30 40 50
60 70 80

1010510

1 11 21 31 41 51
61 71

110611Slice 2

2 12 22 32 42 52
62 72

210712

3 13 23 33 43 53
63 73

310813

4 14 24 34 44 54
64 74

410914

5 15 25 35 45 55
65 75

511015

6 16 26 36 46 56
66 76

611116

7 17 27 37 47 57
67 77

711217

8 18 28 38 48 58
68 78

811318

9 19 29 39 49 59
69 79

911419

10 20 30 40 50
60 70 80

1011520

1 11 21 31 41 51
61 71

11161Slice 1Trunk 2

(FAC 11)

2 12 22 32 42 52
62 72

21172
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TimeslotsTributary Port
Number

ODU Trunk FACODU Trunk
Number

ODU4 SliceTrunk Port

3 13 23 33 43 53
63 73

31183

4 14 24 34 44 54
64 74

41194

5 15 25 35 45 55
65 75

51205

6 16 26 36 46 56
66 76

61216

7 17 27 37 47 57
67 77

71227

8 18 28 38 48 58
68 78

81238

9 19 29 39 49 59
69 79

91249

10 20 30 40 50
60 70 80

1012510

1 11 21 31 41 51
61 71

112611Slice 2

2 12 22 32 42 52
62 72

212712

3 13 23 33 43 53
63 73

312813

4 14 24 34 44 54
64 74

412914

5 15 25 35 45 55
65 75

513015

6 16 26 36 46 56
66 76

613116

7 17 27 37 47 57
67 77

713217

8 18 28 38 48 58
68 78

813318

9 19 29 39 49 59
69 79

913419
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TimeslotsTributary Port
Number

ODU Trunk FACODU Trunk
Number

ODU4 SliceTrunk Port

10 20 30 40 50
60 70 80

1013520

When the card interoperates with the NCS4K-4H-OPW-QC2 card, the first ODU4 slice of the trunk is connected
to the second ODU4 slice of the same NCS4K-4H-OPW-QC2 trunk.

The ODU circuit between the and NCS4K-4H-OPW-QC2 cards is created even when the ODU number is
incorrect. Please ensure that the correct source and destination ODU numbers are selected.

Note

Regeneration Mode for
From Release 10.8.0, the can be configured as a regenerator. The regeneration functionality is available only
on the trunk ports. A new card operating mode, REGEN, is available. No client ports are involved. The two
trunk ports must have the same rate to achieve regeneration (wavelengths and FEC of the trunks can vary).

For traffic to flow in the REGENmode, it is mandatory that the should be running on firmware (SCP) version
5.24 or later.

We recommend that you use the REGENmode only with the MXP operating mode (the output from the MXP
trunk of a can be connected to trunk ports in REGEN mode).

Note

Slice Definition and Line Card Configuration for Card
The image below displays the client and trunk ports of the card.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
288

Provisioning Transponder and Muxponder Cards
Regeneration Mode for



Figure 41: Card

The client to trunk port mapping is fixed in the card as detailed in this table:

Table 116: Trunk -Client Port Mapping on the Card

Pluggable TypeClient PortTrunk

QSFP+Ports 1, 2, 3Trunk 1 (CFP2-11)- Slice 1 and
Slice 2

QSFP+ or QSFP28 7Ports 7, 8

QSFP+Ports 4, 5, 6Trunk 2 (CFP2-12) - Slice 3 and
Slice 4

QSFP+ or QSFP28Ports 9, 10

7 QSFP+ and QSFP28 share the same form factor.

The trunk ports can be configured with either 100G or 200G rates. The client ports are grouped into four
slices. The slice mode defines the aggregation capacity and can be configured independently.

The configuration of each of the two trunk ports is independent of the configuration of the other and is done
using either one of the two trunk operating modes.

Trunk Operating Modes (trunk capacity)

• M-100G: 100G QPSK. One slice is enabled on the trunk. Slice 2 is enabled for Trunk 1 and Slice 4 is
enabled on Trunk 2.
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• M-200G: 200G 16 QAM. Two slices are enabled on the trunk.

• provision a ONS-QC-16GFC-SW= pluggable on the shared ports and have 6x 16G-FC payloads and 8x
10G payloads (10GE or OTU2)

• provision a QSFP-4X10G-MLR (or ONS-QSFP-4X10G-LR-S) pluggable on the shared ports and have
4x 16G-FC + 10x 10G payloads (10GE and/or OTU2)

Slice Mode:

• OPM-100G: Enables 100G client on the QSFP 28 port.

• OPM-10x10G: Enables 10G client over a set of QSFP+ ports.

• OPM_2x40G_2x10G: Enables 40G client over a set of QSFP+ ports.

Traffic from the client ports are aggregated on the 100G or 200G trunk at the intermediate ports. There are
four intermediate ports (iports), two per trunk. The iports are automatically configured when the slices are
configured.

The relation between the two trunk ports (Ports 11 and 12), client ports (Ports 1 through 10) and the four slices
are represented in the tables below.

The OPM-6x16G_FC mode is referred to as 6x16G_FC and OPM_2x40G_2x10G mode is referred to as
2x40G_2x10G in this table.

Table 117: Trunk, Slice, and Port Configuration for Trunk 1 of the Card

Client PortsTrunk 1

8732 81Slice Operation ModeTrunk
Mode

Port LanesSlice 2Slice 1
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4x4x 9---OPM-100GOPM-100GM-200G

1 to 44x1 to 43,4-OPM-10x10GOPM-100G

4x1 to 4-1, 21 to 4OPM-100GOPM-10x10G

1 to 41 to 41 to 41 to 41 to 4OPM-10x10GOPM-10x10G

4x1,21 to 4OPM-100G6x16G_FC

1 to 41 to 41,2 or 3,4
10

1 to 4OPM-10x10G6x16G_FC

4x1 to 43,4-6x16G_FCOPM-100G

1 to 41 to 41,2 or
3,411

1 to 4OPM-6x16GOPM-10x10G

1 to 41,2 and
3,4

1 to 46x16G_FCOPM-6x16G

40G40G40G1,2 + 3,440G2x40G_2x10G2x40G_2x10G

1 to 440G1 to 41,2 + 3,440GOPM-10x10G2x40G_2x10G

4x40G-1,240GOPM_100G2x40G_2x10G

40G1 to 440G1,2 + 3,41 to 42x40G_2x10GOPM-10x10G

40G4x40G3,4-2x40G_2x10GOPM_100G

4x--OPM-100GNAM-100G

1 to 41 to 43,4OPM-10x10G

1 to 43,46x16G_FC

40G-40G3,4-2x40G_2x10G

8 Port 2 is shared between Slice 1 and Slice 2.
9 4x refers to all four lanes of the QSFP28 pluggable.
10 Depending on the PPM provisioned, ports 1 and 2 can be 16G FC or ports 3 and 4 can be 10GE/OTU2.
11 Depending on the PPM provisioned, ports 3 and 4 can be 16G FC or ports 1 and 2 can be 10GE/OTU2.

The OPM-6x16G_FC mode is referred to as 6x16G_FC and OPM_2x40G_2x10G mode is referred to as
2x40G_2x10G in this table.

Table 118: Trunk, Slice, and Port Configuration for Trunk 2 of the Card

Client PortsTrunk 2

10965
12

4Slice Operation ModeTrunk
Mode

Port LanesSlice 4Slice 3
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4x4x---OPM-100GOPM-100GM-200G

1 to 44x1 to 43,4-OPM-10x10GOPM-100G

4x1 to 4-1, 21 to 4OPM-100GOPM-10x10G

1 to 41 to 41 to 41 to 41 to 4OPM-10x10GOPM-10x10G

4x--1,21 to 4OPM-100G6x16G_FC

1 to 4-1 to 41,2 or 3,4
13

1 to 4OPM-10x10G6x16G_FC

-4x1 to 43,4-6x16G_FCOPM-100G

-1 to 41 to 41,2 or 3,4
14

1 to 46x16G_FCOPM-10x10G

-1 to 41 to 41,2 and
3,4

1 to 46x16G_FC6x16G_FC

40G40G40G1,2 + 3,440G2x40G_2x10G2x40G_2x10G

1 to 440G1 to 41,2 + 3,440GOPM-10x10G2x40G_2x10G

4x40G-1,240GOPM_100G2x40G_2x10G

40G1 to 440G1,2 + 3,41 to 42x40G_2x10GOPM-10x10G

40G4x40G3,4-2x40G_2x10GOPM_100G

1 to 4----OPM-100GNAM-100G

1 to 41 to 43,4OPM-10x10G

1 to 43,4

40G-40G3,4-2x40G_2x10G

12 Port 5 is shared between Slice 3 and Slice 4.
13 Depending on the PPM provisioned, ports 1 and 2 can be 16G FC or ports 3 and 4 can be 10GE/OTU2.
14 Depending on the PPM provisioned, ports 3 and 4 can be 16G FC or ports 1 and 2 can be 10GE/OTU2.

Trunk Port Interworking in Cards
To provide greater flexibility on the network design and deployment, the two CFP2 trunk ports of the card
can interoperate with each other when the same trunk operating mode and slice configurations exist on both
source and destination cards.

OCHCC circuits can be created between compatible client ports as detailed in the tables below.
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Table 119: Compatible Client Ports for M-100G Trunk Port Configuration

Trunk 2 - CFP2 Port 12Source/Destination
Client Ports

Source/Destination
Client Ports

Trunk 1 - CFP2 Port 11

Slice
configuration 1

Slice 4:
OPM_100G

108Slice 2:
OPM_100G

Slice
configuration 1

Slice
configuration 2

Slice 4:
OPM_10x10G

5-32-3Slice 2:
OPM_10x10G

Slice
configuration 2

5-42-4

6-13-1

6-23-2

6-33-3

6-43-4

10-18-1

10-28-2

10-38-3

10-48-4

Slice
configuration 2

Slice 4:
OPM_6x16G_FC

5-32-3Slice 2:
OPM_6x16G_FC

Slice
configuration 2

5-42-4

6-13-1

6-23-2

6-33-3

6-43-4

Table 120: Compatible Client Ports for M-200G Trunk Port Configuration

Trunk 2 - CFP2 Port 12Source/Destination
Client Ports

Source/Destination
Client Ports

Trunk 1 - CFP2 Port 11

Slice
configuration 1

Slice 3:
OPM_100G

97Slice1:
OPM_100G

Slice
configuration 1

Slice 4:
OPM_10x10G

5-32-3Slice 2:
OPM_10x10G

Slice 3:
OPM_100G

97Slice 1:
OPM_100G
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Trunk 2 - CFP2 Port 12Source/Destination
Client Ports

Source/Destination
Client Ports

Trunk 1 - CFP2 Port 11

Slice
configuration 2

Slice 4:
OPM_10x10G

5-32-3Slice 2:
OPM_10x10G

Slice
configuration 2

5-42-4

6-13-1

6-23-2

6-33-3

6-43-4

10-18-1

10-28-2

10-38-3

10-48-4

Slice
configuration 3

Slice 3:
OPM_10x10G

4-11-1Slice 1:
OPM_10x10G

Slice
configuration 3

4-21-2

4-31-3

4-41-4

5-12-1

5-22-2

9-17-1

9-27-2

9-37-3

9-47-4

Slice 4:
OPM_100G

108Slice 2:
OPM_100G
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Trunk 2 - CFP2 Port 12Source/Destination
Client Ports

Source/Destination
Client Ports

Trunk 1 - CFP2 Port 11

Slice
configuration 4

Slice 3:
OPM_10x10G

4-11-1Slice 1:
OPM_10x10G

Slice
configuration 4

4-21-2

4-31-3

4-41-4

5-12-1

5-22-2

9-17-1

9-27-2

9-37-3

9-47-4

Slice 4:
OPM_10x10G

5-32-3Slice 2:
OPM_10x10G

5-42-4

6-13-1

6-23-2

6-33-3

6-43-4

10-18-1

10-28-2

10-38-3

10-48-4

Slice
configuration 3

Slice 3:
OPM_6x16G_FC

4-11-1Slice
1:OPM_6x16G_FC

Slice
configuration 1

4-21-2

4-31-3

4-41-4

5-12-1

5-22-2
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Trunk 2 - CFP2 Port 12Source/Destination
Client Ports

Source/Destination
Client Ports

Trunk 1 - CFP2 Port 11

Slice
configuration 4

Slice 4:
OPM_6x16G_FC

5-32-3Slice 2:
OPM_6x16G_FC

Slice
configuration 2

5-42-4

6-13-1

6-23-2

6-33-3

6-43-4

Enable PRBS Support on the 400G-XP-LC Card
The ODU4 internal ports on the 400G-XP-LC card support configuration of PRBS with all operating modes.

Before you begin

Pseudo Random Binary Sequence (PRBS) feature allows users to perform data integrity checks on their
encapsulated packet data payloads using a pseudo-random bit stream pattern. PRBS generates a bit pattern
and sends it to the peer router that uses this feature to detect if the sent bit pattern is intact or not.

Procedure

Step 1 In the node view, double-click the card where you want to provision PRBS. The card view appears.
Step 2 Set the admin state to OOS, MT for the source and destination trunk ports. Which in turn puts corresponding

IPorts in OOS, MT state.

The PRBS configuration supports the 400G-XP-LC card only when the port is in Maintenance
State. In case the port is in In-Service or Out-of-Service, PRBS is disabled.

Note

Step 3 Click the Maintenance > PRBS Configuration tabs.
Step 4 From the Generator Pattern drop-down list, choose a pattern.The supported patterns are None, PRBS_11,

PRBS_31, and INVERTEDPRBS_31.

You must apply the same pattern in both source and destination Internal Ports (IPorts).Note

Step 5 Click Apply.

The 400G-XP-LC card provides a PRBS sync status with the following values:

• PATTERN_OK: When the IPort is receiving one of the recognized patterns.

• PATTERN_ERROR: When the IPort is receiving a recognized pattern but the pattern contains errors.
This also occurs when there is a pattern mismatch.

• PATTERN_NONE: When the IPort is not receiving a recognized PRBS pattern.
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In case of pattern errors, the card provides a PRBS error counter. The counter zeroes itself when the PRBS
is disabled.

Step 6 Click Refresh in the PRBS window under Maintenance to check the pattern sync status on the IPorts.

If cross-connections or clients are not created, the pattern shows PATTERN_OKwith mismatch
configurations.

The mismatch configurations are:

• PRBS is enabled on one end and disabled on the other end.

• One pattern is enabled on one end and other pattern is enabled on the other end (Pattern
Mismatch).

Note

Limitations of PRBS Support on 400G-XP-LC card
• PRBS cannot be enabled on IPorts if corresponding client payloads are not provisioned.

• Client payloads cannot be provisioned if PRBS is enabled on the corresponding IPorts.

• CPRBS pattern shows OK even with mismatch configuration if no cross connections or clients are
created.

• PRBS is supported when the source and destination 400G-XP-LC cards are configured with the same
operating mode.

• PRBS for OTU4 clients is not available on 400G-XP-LC card in Release 11.0 or earlier releases.

• PRBS shall be supported when two IPorts carry similar client rates.

GCC0 Support on the Card
• The card supports provision of one GCC0 channel for each of the trunk ports on the operatingmodes-MXP,
and MXP-2x150G(8QAM).

• In case of the OTU4C3 (8QAM) payload, only one GCC0 channel is configurable on the first trunk port
(Port-11). The configuration on the second trunk port (Port-12) is automatically blocked.

• In case of the MXP-2x150G(8QAM) payload, the GCC0 channel is configurable only on the second
trunk port (Port-12); no GCC0 channel configuration is supported on the first trunk port (Port-11).

• The OTU4 and OTU2 client ports do not support GCC0 channels on the card.

• The card supports a maximum of two GCC0 channels on each trunk port.

• The OTU4C2 trunk port supports the Low Speed GCC 196K and High Speed GCC 1200K. The card
supports only the High Speed GCC rate, 1200K. So, GCC0 channels provisioning on cards, which are
part of 15454-M12 as Node Controller (NC) configurations, is not supported.

• The OTNXC or OCHTRAIL circuits are not supported over the direct GCC0 link on the card.

• The GCC0 channel provisioning is not supported on REGEN card mode on the 400G-XP-LC card.
However, GCC0 tunneling is enabled.
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•
• GCC0 channels provisioning is supported with hardware FPGA image version > 0.28. GCC provisioning
will fail with a deny error message if FPGA version is = < 0.28.

• In presence of the TIM-SM alarm, GCC0 link remains down.

2x150G Support on the Card
From Release 10.9, the card supports the configuration of 2x150G mode in 8QAM modulation format. It is
configurable on the trunk ports of the card by selecting M_150G as the Trunk Operating mode.

The M_150G mode does not support muxponder, cross connection, and regeneration configurations.

The M_150G trunk mode configuration supports client slices 1, 3 and 4. The available ports 1[1:4], 2[1:2],
4[1:4], 5[1:4], 6[1:4], 7[1:4], 9[1:4], 10[1:4]. When the M_150G trunk mode in configured, the slices 1, 3
and 4 are independently configurable as OPM_100G, OPM_10x10G or OPM_6x16G-FC. It is possible to
change a slice mode without it being traffic affecting on the other provisioned slices. The admin state of both
trunk ports are aligned.

On a M_150G configured trunk mode, all client payloads or options are the same as the standard M_200G
MXP mode.

The M_150G trunk mode is applicable to both trunk ports. This is required because this mode splits the
ODU4line frames into two interleaved 150G signals transported separately by the two trunk ports.

The trunk ports configured as M_150G support the same optical and FEC alarms or monitors provided by the
M_200Gmode. An LOS-P or LOF alarm on any of the two trunk ports of M_150G correlates all the OTU4C3
container OTN alarms.

The Line OTNAlarms and PerformanceMonitors of the 2x150Gmode container frame (OTU4C3) is evaluated
as the summarization of the Alarms or PMs related to the 3 embedded ODU4 internal ports 1, 3, and 4. The
resulting values are available at the OTN layer of Trunk12.

Limitations of 2x150G Support on the Card
• The trunk ports are put in the Out-of-Service state before unplugging any CFP2 trunk. Extracting an
In-Service CFP2 trunk results in shutting down of the other trunk.

• The loopback setting of both M_150G trunks are aligned. However, the internal loopback ports are
configurable independently with the same limitations as that of M_100G and the M_200G modes.

• The TTI-SM of the OTU4C3 container is configurable and is monitored only on Trunk 12.

• The GCC0 provisioning is supported only for Trunk-12.

• The FEC setting of both M_150G trunks are aligned.

Related Procedures for 400G-XP-LC Cards
• NTP-G361 Provisioning an Operating Mode on the 400G-XP-LC Card, on page 653

• NTP-G236 Modifying the 100G-LC-C, 100G-CK-C, 100G-ME-C, 100ME-CKC, 10x10G-LC,
100GS-CK-LC, , 200G-CK-LC, CFP-LC,WSE, MR-MXP, or 400G-XP-LC Card Line Settings and PM
Parameter Thresholds, on page 662
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• NTP-G362 Manual FPGA Upgrade on the 400G-XP-LC Card, on page 655

• NTP-G75 Monitor Transponder and Muxponder Performance

• Enable PRBS Support on the 400G-XP-LC Card, on page 296

Supported MSM Configurations
The following configurations are supported :

Total Client InterfacesPayloadCard ConfigurationConfiguration

160010 GE40 400G-XP-LC cards1

152010 GE20 400G-XP-LC cards

36 200G-CK-LC cards

72 MR-MXP cards

2

280100 GE70 400G-XP-LC cards3

800100 GE20 400G-XP-LC cards4

10 GE36 200G-CK-LC cards

72 MR-MXP cards

Recommendations

Ensure you follow the recommendations stated below for optimum system performance.

• Five CTC sessions can run concurrently.

• Only one TL1 session can run at a time when TL1 scripts are run continuously for monitoring on a node.

• Only one OTDR scan can be run at a time.

• Only one EPNM session can run at a time.

• Two SNMP traps can be configured.

• Performing software downloads, database backup, and database restore operations must not be performed
when the system is synchronizing with EPNM or when TL1 sessions are running.

• Software upgrade must not be run with the recommended environment (five CTC sessions, one OTDR
scan, one TL1 session, one EPNM session, and two SNMP traps) enabled as it impacts the upgrade
operation.

• The following operations may cause degradation of system performance:

• Retrieving performance monitoring values using HTTP in a browser.

• Performing a full SNMP walk.

• Running parallel sessions of EPNM and TL1.
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WSE Card
TheWire Speed Encryption (WSE) card is an optical line card that provides encryption capability, at the OTN
layer, to the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms. This card provides confidentiality
of the data, which is sent over a fiber optic communication channel, using Next Generation Cryptography. In
addition to providing encryption, this card also provides integrated transponder functionality.

The WSE card supports these client signals:

• 10GE LAN PHY mapped to OTU2e

• OTU2

• OTU2e

• OTU1e

• OC-192/STM-64

• 10GE WAN

• 10GE LAN mapped to OTU2

• 8G FC/10G FC

TheWSE card does not support auto negotiation for SAN protocols (10GFC/8GFC). The WSE card supports
only speed lock for SAN protocols.

The WSE card is tunable on 96 wavelength channels, spaced at 50-GHz over the entire C-band. The digital
wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be used to set up
GCCs for data communications, enable FEC, or facilitate PM. The WSE card works with the OTN devices
defined in ITU-T G.709. The OTN client can be FEC, standard G.975 FEC, or disabled FEC.

For information on safety labels for the cards, see the "Class 1M Laser Product Cards” section.

A 15 to 20 dB fiber attenuator must be used when working with the cards in a loopback on the trunk port. Do
not use direct fiber loopbacks with the cards. Using direct fiber loopbacks causes irreparable damage to the
DWDM/CWDM XFP/SFPs plugged in WSE card.

Caution

The WSE card is a single-slot card and can be installed in any service slots in the chassis. The card has 10
SFP+ ports. The trunk and client ports are fixed. The trunk ports are 2, 4, 6, 8, and 10; the client ports are 1,
3, 5, 7, and 9. The trunk SFP+ can be grey or DWDM. The trunks include FEC and EFEC for longer reach.
Depending on the traffic pattern, the WSE card provides per port flexibility.

Up to sixWSE cards can be installed per Cisco ONS 15454M6 shelf assembly, supporting up to 30 encrypted
streams in a 2-rack unit (RU) bay frame. Up to two WSE cards can be installed per Cisco ONS 15454 M2
shelf assembly, supporting up to 10 encrypted streams in a 6-rack unit (RU) bay frame. It is possible to
aggregate the wavelength required with 40G and 100G cards in the same chassis. Up to 15 WSE cards can
be installed per Cisco NCS 2015 shelf assembly.

When the software version of the node is changed from Release 10.6.2 to releases prior to 10.6.1, the WSE
card undergoes a hard reset. This is applicable for the ONS 15454, 15454 M2, 15454 M6 chassis.

When the node is upgraded followed by reset of the active control card, FPGA upgrade of the WSE card fails.
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Perform the following steps to upgrade FPGA successfully.

• Soft reset the WSE card.

• In the Card view, go to Provisioning > Card.

• Click FPGA/FIRMWARE Upgrade/Traffic Affecting Reset to upgrade FPGA.

Firmware upgrade is allowed only when the ports are in OOS (out-of-service) or
Maintenance service state.

Note

Key Features
The WSE card supports these key features:

• Operating Modes—The WSE card can be configured into multiple operating modes. The card can be
equipped with pluggables for client and trunk options, and offers a large variety of configurations. For
more information about multiple operating modes, see Multiple Operating Modes.

• Security Features

• Secure Boot—This feature does a boot verification in hardware. It ensures that only authentic Cisco
software boots up on the Cisco platform, and provides tamper and cloning resistance.

• Digital Image Signing—After the secure boot, the Digital Image Signing ensures that the software
that runs on Cisco devices is authentic. This maintains the integrity of the image that is loaded on
the WSE card.

• Key Exchange—Key exchange between authenticated peer cards happens over the GCC2 channel
that is secured using Transport Layer Security (TLS). The Elliptic Curve Diffie Hellman Ephemeral
(ECDHE) algorithm is used for key exchange.

• Confidentiality of Data—TheWSE card protects against ciphertext manipulation and cut-and-paste
attempts. AES algorithm in XTS mode of operation.

• Role Based Access Control—Access control is enforced to ensure that there is complete separation
in managing the transport (provisioning) and the security functionalities. As a result, depending on
the role assigned to a user, only certain operations can be performed by that user.

• Card Authentication—The Secure Unique Device Identification (SUDI) certificate that is formatted as
an X.509 certificate and conforms to the IEEE 802.1 AR standard. It is signed using Cisco's Root
Certificate Authority. This certificate carries a unique identifier used to authenticate the peer card as
being a WSE card before the data is exchanged. Information cannot be exchanged with a card that is not
authenticated.

• High Speed GCCs—TheWSE card supports the provisioning of GCC channel on OTN (OTU2/OTU2e)
enabled client and trunk ports. Amaximum of ten GCC0 channels can be created perWSE card, on Cisco
ONS 15454 M2 or Cisco ONS 15454 M6, or Cisco NCS 2015 shelf, and a maximum of five GCC2
channels can be created per WSE card, on Cisco ONS 15454 M2 or Cisco ONS 15454 M6, or Cisco
NCS 2015 shelf.

• OCH-trail Protection—Provides protection for the DWDM signals through external optical switch units
(Protection Switch Module [PSM]).
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• Licensing—A licensed version of the card provides a cost-effective solution for customers who do not
need to encrypt data on all five streams from day one itself. The licensed WSE card provides single
stream encryption as a base functionality. When an additional encrypted stream is required, you need to
purchase a software ugrade license. Licensing is required for only security features. AWSE card without
a license acts as for transponder. For more information on licensing, see the Licensing Configuration
Guide.

• Third Party Certificates—TheWSE card supports the generation of a Certificate Signing Request (CSR)
and installation of Locally Significant Certificates (LSCs) that can be used to authenticate the peer card
connection.

For information on safety labels for the cards, see the "Class 1M Laser Product Cards” section.

For a detailed list of the supported pluggables, see, http://www.cisco.com/c/en/us/td/docs/optical/spares/gbic/
guides/b_ons_pluggables.html

WSE Workflow Diagram
The following figure shows the workflow diagram of the WSE card. The diagram provides information on
the tasks required to configure the WSE card.
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Multiple Operating Modes
A single WSE card can be configured into multiple operating modes. The criteria for selecting a particular
operating mode are defined by the network level design. CTP helps you to choose the appropriate operating
mode. When you configure the WSE card into multiple operating modes, make sure that these tasks are
completed:

• The PPMs must be configured on the card, and then the operating modes. None of the modes are
provisioned on the card by default. All operatingmodes are created on a per port basis. This is card-specific
provisioning, which decides the behavior of a particular card.

• Depending on the card mode selected, the supported payload for that particular card mode must be
provisioned on the PPMs.

The WSE card supports these operating modes:

• TXP-10G

• RGN-10G

A mix of TXP-10G and RGN-10G modes can be configured on the WSE card.

TXP-10G
A maximum of five TXP-10G configurations can be provisioned on a single WSE card. When the card is
configured in this mode, these features are supported:

• Enable or disable card authentication

• Enable or disable payload encryption

OTN cannot be disabled on the trunk port.

Table 121: Supported Payload Mapping in TXP-10G Mode

Trunk MappingClient Payload

OTU2e10GE LAN PHY-CBR

OTU2OTU2

OTU2eOTU2e

OTU28G FC

OTU210G FC

OTU210GE LAN PHY-GFP

OTU1eOTU1e
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RGN-10G
In the RGN-10G mode, the card behaves as a standard regenerator with DWDM SFP+ on both the client and
trunk ports. The card supports OTU1e, OTU2, and OTU2e regeneration on all the client and trunk pairs.When
theWSE card is configured in this mode, card authentication and payload encryption features are not supported.

The OTN cannot be disabled when the card is configured in RGN-10G mode.

Card Authentication
The WSE cards provide TLS 1.2 based card-to-card authentication per port. An authentication failure on one
trunk port does not affect the traffic on any other trunk port. The card authentication must be enabled to
configure encryption on the card.

Cisco Signed certificates are installed on the WSE card by default. These certificates are exchanged between
the cards during card authentication.

All ports are re-authenticated upon a soft-reset of the card.

In case of TLS or SSL authentication failure, the KEY_EX_FAIL alarm is raised on the particular trunk port.

Key Management
A single key, called a primary key, is exchanged for each TLS session. It is exchanged using an asymmetric
key algorithm (Elliptic Curve Diffie Hellman). The primary key is used to derive a set of symmetric keys for
payload encryption.

The user can change the primary key at anytime from CTC, which initiates another DH exchange between
the sender and the receiver. The user can also specify the time when the primary key is periodically reset.

The keys used for encryption of data are never stored in plaintext on the card. All keys are deleted when the
card reboots or is removed from the chassis. The key changes do not affect the traffic.

Important Notes on KEY-EX-FAIL Alarm

• After an upgrade of a software version, KEY-EX-FAIL alarm may be raised due to soft reset of the card.
However, the traffic is not impacted, and the alarm will be cleared in the next exchange interval of the
primary key

• When the MANRESET alarm (Manual System Reset alarm) is cleared on a client WSE card, the
KEY-EX-FAIL alarm might be raised due to soft reset of the card. The alarm is raised when the server
exits the existing connection and establishes a new connection during this period. However, the traffic
is not impacted.

Payload Encryption
The payload on each port can be encrypted independent of the other streams. NIST approved Advanced
Encryption Standard (AES) AES-256, a symmetric key cryptographic algorithm in XTS mode of operation,
is used to encrypt the OTN payload. The payload encryption needs to be enabled at both source and destination
trunk ports; otheriwse, it is traffic affecting.
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AES Secure Packet
The concept of a packet does not exist within OTN; however, packet-based traffic is necessary for encryption
using XTS-AES algorithm. A single OTN frame cannot be tagged with the necessary Encapsulating Security
Payload (ESP) header, which carry the information necessary for encryption and decryption of payloads. The
ESP header and trailer require a total of 32 bytes within the OTN overhead.

The AES secure packet for each port can be made up of four or eight OTN frames. In CTC, the user can
choose from these two options for transporting the ESP header and trailer:

• Four OTN frame based AES secure packet—The four OTN frame-based AES secure packet transports
four ESP header and four ESP trailer bytes within each OTN frame. In the four OTN frame-based AES
secure packet, eight overhead bytes are utilized in each OTN frame in order to transport all 32 bytes of
ESP header and trailer within a single AES secure packet. Each location is four bytes wide, therefore
two locations from each OTN frame are utilized, one for the ESP header and one for the ESP trailer.

• Eight OTN frame based AES secure packet— The eight OTN frame-based AES secure packet transports
two ESP header and two ESP trailer bytes within each OTN frame. In the eight OTN frame-based AES
secure packet, four overhead bytes are utilized in each OTN frame in order to transport all 32 bytes of
ESP header and trailer within a single AES secure packet. Each location is four bytes wide; therefore,
only one location from each OTN is utilized. Within the selected location, two bytes are used for the
ESP header, and two bytes for the ESP trailer.

Pseudo Random Binary Sequence (PRBS) testing is used to ensure that the selected overhead bytes can be
used to transport the ESP header and trailer safely. Both the transmitting node and receiving node must be
aware that PRBS testing is taking place. Each node must also know which bytes are to be tested.

Functions and Features
The cards have the following functions and features, explained in the "Card Features" chapter:

• Enhanced FEC (E-FEC) Feature

• Timing Synchronization

• Card level indicators

• Port level indicators

Scenarios that Affect Traffic

Scenario 1: Traffic in a Stacked Topology

Consider an example where the WSE cards are connected in a stacked topology:

Client:WSE1:Trunk===Trunk:WSE2:Client===Client:WSE3:Trunk===Trunk:WSE4:Client

where WSE:Trunk represents OTU2e payload and WSE:Client represents 10GE signal.

In this scenario, card-to-card authentication and payload encryption are enabled on all the trunk ports, and
loopback is not configured. In this stacked topology, theWSE2 andWSE3 client will report a synchronization
loss since the keys are different, and an ODUk-AIS is raised on the trunk ports. The key is not exchanged
between WSE1 and WSE2 cards, and WSE 3 and WSE4 cards. This creates a deadlock and the traffic does
not recover.
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Scenario 2: Traffic in a Far-end and Near-end Client Loopback

Consider an example where loopback is configured on the WSE cards:

TS(10GE): near-end WSE1(client):(trunk)=== far-end WSE2(trunk):(client loopback)

where the trunk represents OTU2e payload and client represents 10GE signal.

InWSE card, do not enable encryption with far-end or near-end client loopback as this results in synchronization
loss at the client, and an ODUk-AIS is raised on the trunk port. The key is exchanged only after the ODUk-AIS
on the trunk is cleared. This forms a deadlock and the traffic does not recover.

Scenario 3: Traffic After Enabling PRBS Ingress and Egress

In a scenario when WSE cards are connected in a point-to-point setup:

10GE(client)===OTU2e(trunk)----OTU2e(trunk)===10GE(client-loopback)

When PRBS Ingress and Egress are enabled at both ends of the setup, the traffic will go down. When PRBS
Ingress and Egress are enabled at both ends of the setup, the traffic will go down.

When software version is downgraded to a previous version, the traffic may be affected with frame loss and
BIP errors.

Note

Related Procedures for WSE Card
• NTP-G338 Provisioning an Operating Mode on the WSE Card, on page 702

• NTP-G339 Modifying the WSE Card Line Settings and PM Parameter Thresholds, on page 703

• NTP-G340 Provisioning Encryption on the WSE and MR-MXP Cards, on page 718

• NTP-G342 Provisioning FIPS and CC Mode, on page 726

• DLP-G803 Installing Locally Significant Certificates on Cards, on page 730

MLSE UT
The maximum likelihood sequence estimation (MLSE) based universal transponder (UT) modules are added
to the TXP_MR_10EX_C, MXP_2.5G_10EX_C, and MXP_MR_10DMEX_C cards to support the error
decorrelator functionality to enhance system performance.

Error Decorrelator
The MLSE feature uses the error decorrelator functionality to reduce the chromatic dispersion (CD) and
polarization mode dispersion (PMD), thereby extending the transmission range on the trunk interface. You
can enable or disable the error decorrelator functionality using CTC or TL1. The dispersion compensation
unit (DCU) is also used to reduce CD and PMD. The MLSE-based UT module helps to reduce CD and PMD
without the use of a DCU.
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SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK Modules
Small Form-factor Pluggable (SFP), Enhanced Small-Form-factor Pluggable (SFP+), Quad Small-Form-factor
Pluggable Plus (QSFP+), 10-Gbps SFP (XFP), CXP, and C Form-factor pluggable (CFP and CPAK) modules
are integrated fiber optic transceivers that provide high-speed serial links from a port or slot to the network.
For more information on SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK modules and for a list of
SFP, SFP+, XFP, CXP, CFP, CFP2 and CPAK modules supported by the transponder and muxponder cards,
see the Installing the GBIC, SFP, SFP+, XFP, CXP, CFP, and CFP2 Optical Modules in Cisco ONS Platforms.

In CTC, SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK modules are called pluggable port modules
(PPMs). To provision SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 or CPAK module and change the line rate
for multirate PPMs, see the DLP-G726 Preprovisioning a Multirate PPM task.

NTP-G128 Managing Pluggable Port Modules
Complete this procedure to provision a multirate PPM, provision the optical
line rate of a multirate PPM, or delete a single-rate or multirate PPM.

Purpose

NoneTools/Equipment

• DLP-G723 Install PPM on a Line Card

• DLP-G46 Log into CTC

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

If a single-rate PPM is installed, the PPM screen will autoprovision and no further steps are necessary.Note

When you autoprovision a PPM, initial alarm and TCA defaults are supplied by Cisco Transport Controller
(CTC) depending on your port and rate selections and the type of PPM. These default values can be changed
after you install the PPM.

Note
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The hardware device that plugs into a TXP, MXP, AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC,
CFP-LC, 100G-CK-C, 100G-ME-C, 100GS-CK-LC, 200G-CK-LC, 400G-XP-LC, 100ME-CKC, WSE,
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP card faceplate to provide a fiber interface
to the card is called a Small Form-factor Pluggable (SFP, SFP+, XFP, or CXP) or C Form-factor pluggable
(CFP, CFP2). In CTC, SFPs, XFPs, CXPs, and CFPs are called pluggable port modules (PPMs).
SFPs/XFPs/CXPs/CFPs/CFP2s are hot-swappable I/O devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more information about
SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK Modules, on page 307.

Note

Procedure

Step 1 Click the Alarms tab:
a) Verify that the alarm filter is not turned on. See the "DLP-G128 Disable Alarm Filtering" as necessary.
b) Verify that no unexplained conditions appear. If unexplained conditions appear, resolve them before

continuing. Refer to the Troubleshooting Guide.

Step 2 If you are provisioning a MXP_MR_2.5G or MXPP_MR_2.5G card, complete the DLP-G235 Changing the
2.5G Data Muxponder Card Mode. If not, continue with Step 3

Step 3 If you are provisioning a MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C card,
complete the DLP-G332 Changing the 10G Data Muxponder Port Mode. If not, continue with Step 4.

Step 4 If you are provisioning a GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card, complete the DLP-G379
Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode. If not, continue with Step 5.

Step 5 If you are provisioning a OTU2_XP card, complete the DLP-G452 Changing the OTU2_XP Card Mode. If
not, continue with Step 6.

Step 6 If you are provisioning a PPM on an ADM-10G card, complete the DLP-G411 Provisioning an ADM-10G
PPM and Port. If not, continue with Step 10.

Step 7 If you are provisioning a PPM on an AR_MXP, AR_XP, or AR_XPE card, complete the NTP-G321
Provisioning Multiple Operating Modes, on page 622. If not, continue with Step 10.

Step 8 If you are provisioning a PPM on an 100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100G-ME-C, or
100ME-CKC card, complete the NTP-G235 Provisioning an Operating Mode, on page 652. If not, continue
with Step 10.

Step 9 If you are provisioning a PPM on an 400G-XP-LC card, complete the NTP-G361 Provisioning an Operating
Mode on the 400G-XP-LC Card, on page 653. If not, continued with Step 10.

Step 10 If you are provisioning a PPM on a WSE card, complete the NTP-G338 Provisioning an Operating Mode on
the WSE Card, on page 702. If not, continue with Step 10.

Step 11 Complete the DLP-G726 Preprovisioning aMultirate PPM task for TXP,MXP, AR_MXP, AR_XP, AR_XPE,
100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100G-ME-C, 100GS-CK-LC, , 200G-CK-LC, 100ME-CKC,
400G-XP-LC, WSE, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP ports with multirate PPMs.
If you already preprovisioned the multirate PPM, skip this step and continue with Step 11.

Step 12 If you are provisioning an IBMETR_CLO (External Time Reference – Control Link Oscillator) or InterSystem
Coupling Link (ISC) service on the PPM, complete DLP-G274 Verifying Topologies for ETR_CLO and ISC
Services. Otherwise, continue with Step 12.

Step 13 Complete the DLP-G278 Provisioning the Optical Line Rate to assign a line rate to a TXP, MXP, AR_MXP,
AR_XP, AR_XPE, WSE, 100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100G-ME-C, 100GS-CK-LC,

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
308

Provisioning Transponder and Muxponder Cards
NTP-G128 Managing Pluggable Port Modules

http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_alarm_tca_monitoring.html#task_4B9E3FA74B7D4D759A8BB5CED1311F46
http://www.cisco.com/en/US/docs/optical/spares/gbic/guides/b_ons_pluggables.html#task_87FDF5F52722407DA4C3E0CAE6C9D3B5


200G-CK-LC, 100ME-CKC, 400G-XP-LC, or OTU2_XP port after the PPM is provisioned. (This task is not
performed for GE_XP, 10GE_XP, GE_XPE, and 10GE _XPE cards.)

Step 14 If you need to delete a PPM at any point in this procedure, complete the DLP-G727 Delete PPM Provisioning
task.
Stop. You have completed this procedure.

DLP-G235 Changing the 2.5G Data Muxponder Card Mode
This task changes the card mode for MXP_MR_2.5G and MXPP_MR_2.5G
muxponder cards. The card mode determines which PPMs can be provisioned
for the card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or
MXPP_MR_2.5G card where you want to change the card settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs.
Step 3 Locate the Trunk port table row and verify that the Service State column value is OOS-MA,DSBLD (ANSI)

or Locked-enabled,disabled (ETSI). If the service state is correct, continue with Step 6. If not, complete the
following steps:
a) Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Maintenance (ETSI).
b) Click Apply, then Yes.

Step 4 Click the Provisioning > Line > Client tabs.
Step 5 Locate the Trunk port table row and verify that the Service State column value is OOS-MA,DSBLD (ANSI)

or Locked-enabled,disabled (ETSI). If the service state is correct, continue with Step 6. If not, complete the
following steps:
a) Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Maintenance (ETSI).
b) Click Apply, then Yes.

Step 6 Click the Provisioning > Card tabs.
Step 7 Change the Card Mode as needed:

• FC-GE—Choose this option if you will provision any of the following PPM port rates: FC1G (Ports 1-1
and 2-1 only), FC2G (Port 1-1 only), FICON1G (Ports 1-1 and 2-1 only), FICON2G (Port 1-1 only),
and ONE_GE (Ports 1-1 through 8-1).
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• Mixed—Choose this option if youwill provision any of the following PPMport rates: FC1G andONE_GE
(Port 1–1 only), ESCON (Ports 5–1 through 8-1 only)

• ESCON—Choose this option if you will provision the ESCON PPM on Ports 1-1 through 8-1.

The Provisioning > Card tab also has the display-only TunableWavelengths field. This field
shows the supported wavelengths of the trunk port after the card is installed in the format:
first wavelength-last wavelength-frequency spacing-number of supported wavelengths. For
example, 1529.55nm-1561.83nm-50gHz-82.

Note

Step 8 Click Apply.
Step 9 Return to your originating procedure (NTP).

DLP-G332 Changing the 10G Data Muxponder Port Mode
This task changes the port mode for the MXP_MR_10DME_C,
MXP_MR_10DME_L, and MXP_MR_10DMEX_C muxponder cards. The
port mode determines which PPMs can be provisioned on the ports.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

The MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C cards have two port mode
groups, one for Ports 1 through 4, and the second for Ports 5 through 8. To change the port mode, all ports
within the selected port group must be in OOS (out-of-service) service state. Ports in the second port group
do not need to be in OOS service state if you are not changing the port mode for the second port group. Before
you change the port mode, you must also ensure that any PPM port rate provisioned for the selected port group
is deleted (see the DLP-G727 Delete PPM Provisioning).

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_10DME_C,
MXP_MR_10DME_L, or MXP_MR_10DMEX_C card where you want to change the port mode.

Step 2 Click the Provisioning > Card tabs.
Step 3 Change the port mode as described in Table 122: 10G Data Muxponder Card Port Modes.

The PPM port rates are provisioned in the DLP-G726 Preprovisioning a Multirate PPM task.Note

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
310

Provisioning Transponder and Muxponder Cards
DLP-G332 Changing the 10G Data Muxponder Port Mode

http://www.cisco.com/c/en/us/td/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/spares/gbic/guides/b_ons_pluggables.html#task_E7AA0584CA34411B9C66DA55E490850B
http://www.cisco.com/en/US/docs/optical/spares/gbic/guides/b_ons_pluggables.html#task_87FDF5F52722407DA4C3E0CAE6C9D3B5


Table 122: 10G Data Muxponder Card Port Modes

OptionsDescriptionParameter

Chose one of the following:

• FC-GE_ISC—Choose this option if you will provision any of
the following PPM port rates: FC1G (Ports 1-1 through 4-1),
FC2G (Ports 1-1 and 3-1 only), FICON1G (Ports 1-1 through
4-1), FICON2G (Ports 1-1 and 3-1 only), ONE_GE (Ports 1-1
through 4-1), ISC3 COMPAT (Ports 1-1 through 4-1), ISC3
PEER 1G (Ports 1-1 through 4-1), and ISC3 PEER 2G (Ports
1-1 and 3-1 only).

• FC4G—Choose this option if you will provision an FC4G or
FICON4G PPM (Port 1-1 only).

Sets the mode of
operation for Ports 1-1
through 4-1.

Port 1-4 Mode

Chose one of the following:

• FC-GE_ISC—choose this option if you will provision any of
the following PPM port rates: FC1G (Ports 5-1 through 8-1),
FC2G (Ports 5-1 and 7-1 only), FICON1G (Ports 5-1 through
8-1), FICON2G (Ports 5-1 and 7-1 only), ONE_GE (Ports 5-1
through 8-1), ISC3 COMPAT (Ports 5-1 through 8-1), ISC3
PEER 1G (Ports 5-1 through 8-1), and ISC3 PEER 2G (Ports
5-1 and 7-1 only).

• FC4G—choose this option if you will provision an FC4G or
FICON4G PPM port rate (Port 5-1 only).

Sets the mode of
operation for Ports 5-1
through 8-1.

Port 5-8 Mode

The Provisioning > Cards tab also has a display-only Tunable Wavelengths field which shows
the wavelengths supported by the card. If aMXP_MR_10DME_C card is installed, the 32 C-band
wavelengths appear. If the MXP_MR_10DME_L card is installed, the 32 L-band wavelengths
appear. If the MXP_MR_10DMEX_C card is installed, the 82 C-band wavelengths appear.

Note

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

Loopbacks on MXP-MR-10DME are not applicable when Fiber Channel switches are present.Note

If the Fiber Channel switch version is not present then the Distance Extension settings are not
supported.

Note

DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode
This task changes the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card
mode. 10GE_XP and 10GE_XPE cards can be provisioned as a Layer 2 Ethernet
switch or a 10G Ethernet TXP. GE_XP and GE_XPE cards can be provisioned
as a Layer 2 Ethernet switch, 10G Ethernet MXP, or 20G Ethernet MXP.

Purpose
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NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the card mode.

Step 2 In card view, click Provisioning > Ether Ports > Ports.
Step 3 Verify that any provisioned client or trunk ports have an OOS-MA,DSBLD (ANSI) or

Locked-enabled,disabled(ETSI) service state in the Service State column. If so, continue with Step 4. If not,
complete the following substeps.
a) For the first port that is not out of service, in the Admin State column, choose OOS-MA,DSBLD (ANSI)

or Locked-enabled,disabled (ETSI).
b) Repeat Step a for each port that is not out of service.
c) Click Apply.

Step 4 Click the Provisioning > Card tabs.
Step 5 Choose one of the following card modes:

Table 123: GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Modes

DescriptionCardsMode

Provisions the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE as a
Layer 2 switch.

GE_XP

10GE_XP

GE_XPE

10GE_XPE

L2 over DWDM

Provisions the 10GE_XP or 10GE_XPE as a 10 Gigabit Ethernet
transponder. Traffic received on the 10GE client Port 1-1 is sent
to 10 Gigabit Ethernet trunk Port 3-1, and traffic received on 10
Gigabit Ethernet client Port 2-1 is sent to 10 Gigabit Ethernet trunk
Port 4-1.

10GE_XP

10GE_XPE

10GE TXP

Provisions the GE_XP or GE_XPE as a 10 Gigabit Ethernet
muxponder. Traffic received on Gigabit Ethernet client Ports 1-1
through 10-1 is multiplexed and sent to 10 Gigabit Ethernet trunk
Port 21-1, and traffic received on Gigabit Ethernet client Ports
11-1 through 20-1 is multiplexed and sent to 10 Gigabit Ethernet
trunk Port 22-1.

GE_XP

GE_XPE

10GE MXP
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DescriptionCardsMode

Provisions the GE_XP or GE_XPE as a 20 Gigabit Ethernet
muxponder. Traffic received on Gigabit Ethernet client Ports 1-1
through 20-1 is multiplexed and sent to 10 Gigabit Ethernet trunk
Port 21-1. Trunk port 22-1 is not used.

GE_XP

GE_XPE

20GE MXP

The GE-XP and GE-XPE cards operating in 10GE MXP mode and configured for 100% traffic flow, do not
drop frames when up to nine ports are in use. However, when all the ten ports are in use, some frames are
dropped. When the tenth port is to be used, configure the Committed Info Rate (CIR) at 55% on any one of
the ports. For more information about configuring the CIR, see DLP-G380 Provisioning Ethernet Settings.

Step 6 Click Apply, then click Yes in the confirmation dialog box.
Step 7 Return to your originating procedure (NTP).

DLP-G411 Provisioning an ADM-10G PPM and Port
This task provisions a fixed-rate PPM and port on an ADM-10G PPM card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to provision PPM settings.

Step 2 Click the Provisioning > Pluggable Port Modules tabs.
Step 3 In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.
Step 4 In the Create PPM dialog box, complete the following:

• PPM—Choose the SFP you want to install from the drop-down list.

• PPM Type—Choose the number of ports supported by your SFP from the drop-down list. If only one
port is supported,PPM (1 port) is the only option.

Step 5 Click OK. The newly created PPM appears in the Pluggable Port Modules area. The row in the Pluggable
Port Modules area turns white and the Actual Equipment Type column lists the equipment name.

Step 6 In the Pluggable Ports area, click Create. The Create Ports dialog box appears.
Step 7 In the Create Ports dialog box, complete the following:

• Port—Choose the port you want to configure from the drop-down list.
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• Port Type—Choose the port type, such as OC-3, OC-12, OC-48, or ONE-GE from the drop-down list.

• Ports 1 - 8 can only be OC-3, OC-12, or ONE_GE

• Ports 9 - 12 can on be OC-3 or OC-12

• Ports 13 - 16 can only be OC-3, OC-12, or OC-48

Step 8 ClickOK. The newly created port appears in the Pluggable Ports area. The port type you provisioned is listed
in the Rate column.

Step 9 If you want to provision a PPM or another port, repeat Steps 4 through 8.
Step 10 Return to your originating procedure (NTP).

DLP-G452 Changing the OTU2_XP Card Mode
This task changes the OTU2_XP card mode. The card mode determines which
PPMs can be provisioned for the card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Changing the card configuration to 10G Ethernet LAN Phy to WAN Phy automatically replaces the current
port configurations (Ports 1 and 3) to 10G Ethernet and OC192. This resets and reboots the OTU2_XP card.

Caution

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the card mode.

Step 2 In card view, click the Provisioning > Line > Ports tabs.
Step 3 Verify that all provisioned client or trunk ports have an OOS-MA, DSBLD (ANSI) or Locked-enabled,

disabled (ETSI) service state in the Service State column. If so, continue with Step 4. If not, complete the
following substeps.
a) For the first port that is not out of service, in the Admin State column, choose OOS, DSBLD > Locked,

disabled (ANSI) or (ETSI).
b) Repeat Step a for each port that is not out of service.
c) Click Apply.

Step 4 Click the Provisioning > Card tabs.
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Step 5 Change the Card Configuration as needed:

• Transponder—Choose this option to provision the OTU2_XP card as a transponder. Port pairs 1-3 and
2-4 are both configured as transponders. This is the default card configuration.

• Standard Regen—Choose this option to provision the OTU2_XP card as a standard regenerator (with
E-FEC only on one port). Port pairs 1-3 and 2-4 are both configured as regenerators.

• Enhanced FEC—Choose this option to provision the OTU2_XP card as an E-FEC regenerator (with
E-FEC on two ports). Port pair 3-4 is configured as enhanced regenerator. Ports 1 and 2 are not used.

• Mixed—Choose this option to provision the OTU2_XP card as a transponder and a standard regenerator
(mixed configuration). One of the port pair (1-3 or 2-4) is configured as a transponder and the other port
pair as a standard regenerator.

• 10G Ethernet LAN Phy to WAN Phy—Choose this option to provision the OTU2_XP card to enable
the 10G Ethernet LAN Phy to WAN Phy conversion. Port pair 1-3 supports LAN Phy to WAN Phy
conversion. Port pair 2-4 can be configured either as a transponder or a standard regenerator.

If you revert to the previous release (release earlier than 9.10), be sure to disable the 10G
Ethernet LAN Phy to WAN Phy conversion feature. If you do not disable the 10G Ethernet
LAN Phy to WAN Phy feature, an error message stating that the user needs to disable 10G
Ethernet LAN Phy toWAN Phy feature before reverting to the previous release is displayed.

Note

Table 11-188 on page 11-439 lists the Ethernet variables supported on Ports 1 and 3 of the
OTU2_XP card that has the 10G Ethernet LAN Phy to WAN Phy enabled. When the card
is in the 10G Ethernet LAN Phy to WAN Phy mode, no 10G FC RMONS are supported on
Ports 2 and 4.

For more information on OTU2_XP card configuration rules, see the OTU2_XP Card
Configuration Rules section.

Note

Step 6 Click Apply. Then click Yes in the confirmation dialog box.
Step 7 Return to your originating procedure (NTP).

DLP-G274 Verifying Topologies for ETR_CLO and ISC Services
This task verifies that the DWDM network topology can support the IBM
ETR_CLO and ISC services.

Purpose

Cisco TransportPlanner site planTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 Display your site plan in Cisco TransportPlanner.
Step 2 Verify that the topology where you plan to run the ETR_CLO or ISC service can support the service. The

following topologies support ETR_CLO or ISC:

• Single span—Two terminal sites with no intermediate sites in between and one of the following sets of
cards installed:

• 32MUX-O and 32DMX-O cards

• 32WSS and 32DMX cards

• 32WSS and 32-DMX-O cards

• 40-MUX-C and 40-DMX-C/40-DMX-CE cards

• 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards

Figure 42: Single-Span Topology

• Point-to-Point—Two terminal sites with one of the following sets of cards installed:

• 32MUX-O and 32DMX-O cards

• 32WSS and 32DMX cards

• 32WSS and 32-DMX-O cards

• 40-MUX-C and 40-DMX-C/40-DMX-CE cards

• 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards

Line amplifiers can be installed between the terminal sites, but intermediate (traffic terminating)
sites cannot be installed.

Figure 43: Point-to-Point Topology

• Two hubs—Two hub nodes in a ring with one of the following sets of cards installed:

• 32MUX-O and 32DMX-O cards

• 32WSS and 32DMX cards

• 32WSS and 32-DMX-O cards
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• 40-MUX-C and 40-DMX-C/40-DMX-CE cards

• 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards

Line amplifiers can be installed between the hubs.

Figure 44: Hubs with No Line Amplifiers

Figure 45: Hubs with Line Amplifiers

Step 3 Return to your originating procedure (NTP).

DLP-G278 Provisioning the Optical Line Rate
This task provisions the line rate for TXP, MXP, AR_MXP, AR_XP, AR_XPE,
100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100G-ME-C, 100ME-CKC,
100GS-CK-LC, 200G-CK-LC, WSE, 400G-XP-LC, GE_XP, 10GE_XP,
GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP cards.

Purpose

NoneTools/Equipment
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• DLP-G46 Log into CTC

• DLP-G726 Preprovisioning a Multirate PPM

• DLP-G274 Verifying Topologies for ETR_CLO and ISC Services, on
page 315

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

The optical line rate for cards with single-rate PPMs is provisioned automatically when you complete the
"DLP-G726 Preprovisioning a Multirate PPM" task if the trunk port is out of service. If the optical line rate
was provisioned automatically, you do not need to complete this task for theMXP_2.5G_10G,MXP_2.5G_10E,
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10EX_C, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or OTU2_XP card. If the trunk port was in-service when you provisioned the PPM, complete this task to
provision the optical line rate manually for those cards.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
provision PPM ports. If the data rate that you are provisioning is DV-6000, HDTV, ESCON, SDI/D1 Video,
ISC1, ISC3 (for TXP_MR_2.5G and TXPP_MR_2.5G cards), or ETR_CLO, complete the following steps.
Otherwise, continue with Step 4.
a) Click the Provisioning > OTN > OTN Lines tabs.
b) In the ITU-T G.709 OTN field for the respective PPM, choose Disable.
c) In the FEC field for the respective PPM, choose Disable.
d) Click Apply.

Step 2 For the TXP_MR-10G card, click the Provisioning > Data Rate Selection tabs. For all other cards, go to
Step 4.

Step 3 In the Data Rate Selection area, clickCreate and choose the type of port from the drop-down list. The supported
port types are SONET (including 10G Ethernet WAN Phy) and 10G Ethernet LAN Phy.

Step 4 Click the Provisioning > Pluggable Port Modules tabs.
Step 5 In the Pluggable Ports area, click Create. The Create Port dialog box appears.
Step 6 In the Create Port dialog box, complete the following:

• Port—Choose the port and port number from the drop-down list. The first number indicates the PPM in
the Pluggable Port Modules area, and the second number indicates the port number on the PPM. For
example, the first PPM with one port appears as 1-1 and the second PPM with one port appears as 2-1.
The PPM number can be 1 to 4, but the port number is always 1.

• Port Type—Choose the type of port from the drop-down list. The port type list displays the supported
port rates on your PPM. See table "PPM Port Types" for definitions of the supported rates.
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Step 7 Click OK. The row in the Pluggable Ports area turns white if the physical SFP is installed and light blue if
the SFP is not installed. If the optical parameter values differ from the NE Default settings, change the port
state to In-Service (for ANSI) or Unlocked (for ETSI) to synchronize the values with the NE Default settings.

Step 8 Repeat Step 5 through Step 7 to configure the rest of the port rates as needed.

Table 124: PPM Port Types

Port TypeCard

• OC-3/STM1—155 Mbps

• OC-12/STM4—622 Mbps

• OC-48/STM16—2.48 Gbps

• ONE_GE—One Gigabit Ethernet 1.125 Gbps

• ESCON—Enterprise System Connection 200 Mbps (IBM signal)

• DV6000—Proprietary signal from video vendor

• SDI_D1_VIDEO—Serial Digital Interface andDigital Video signal
type 1

• HDTV—High Definition Television

• PASS-THRU—Not specified

• FC1G—Fibre Channel 1.06 Gbps

• FC2G—Fibre Channel 2.125 Gbps

• FICON1G—Fiber connectivity1.06 Gbps (IBM signal)

• FICON2G—Fiber connectivity 2.125 Gbps (IBM signal)

• ETR_CLO—External Time Reference–Control Link Oscillator

• ISC compat—InterSystem Coupling Link 1 (ISC1)

• ISC peer—InterSystem Coupling Link 3 (ISC3)

• DVB-ASI — Proprietary signal from video vendor. Digital Video
Broadcast - Asynchronous Serial Interface

• ISC1— InterSystem Channel 1 Gbps (IBM signal)

TXP_MR_2.5G

TXPP_MR_2.5G

• OC-48/STM16—2.48 Gbps

Automatically provisioned when the PPM is created if the trunk
port is out of service.

MXP_2.5G_10G

MXP_2.5G_10E

MXP_2.5G_10E_C

MXP_2.5G_10E_L

MXP_2.5G_10EX_C
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Port TypeCard

• SONET (OC-192)/SDH (STM-64) including 10G Ethernet WAN
Phy

• 10G Ethernet LAN Phy

TXP_MR_10G

Provisioned on the Data
Rate Selection tab.

• SONET (OC-192)/SDH (STM-64) including 10G Ethernet WAN
Phy—10 Gbps

• 10G Ethernet LAN Phy—10 Gbps Ethernet

• 10G Fibre Channel—10 Gbps Fibre Channel

• (TXP_MR_10EX_C only) IB_5G

TXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_10EX_C

• SONET (OC-768)/SDH (STM-256)

• 40G Ethernet LAN Phy

• OTU3

40E-TXP-C 40ME-TXP-C

If the card mode is FC_GE:

• FC1G ISL—Fibre Channel 1.06 Gbps (Ports 1-1 and 2-1)

• FC2G ISL—Fibre Channel 2.125 Gbps (Port 1-1 only)

• FICON1G ISL—Fiber connectivity 1.06 Gbps (IBM signal) (Ports
1-1 and 2-1)

• FICON2G ISL—Fiber connectivity 2.125 Gbps (IBM signal) (Port
1-1 only)

• ONE_GE—One Gigabit Ethernet 1.125 Gbps (Ports 1-1 and 2-1
only)

If the card mode is Mixed:

• FC1G ISL—Fibre Channel 1.06 Gbps (Port 1-1 only)

• FICON1G ISL—Fiber connectivity 1.06 Gbps (IBM signal)
(Port1-1 only)

• ONE_GE—One Gigabit Ethernet 1.125 Gbps (Port 1-1 only)

• ESCON—Enterprise System Connection 200 Mbps (IBM signal)
(Ports 5-1 through 8-1)

If the card mode is ESCON:

• ESCON—Enterprise System Connection 200 Mbps (IBM signal)
(Ports 1-1 through 8-1)

MXP_MR_2.5G

MXPP_MR_2.5G
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Port TypeCard

If the port mode is FC_GE_ISC:

• FC1G—Fibre Channel 1.06 Gbps (Ports 1-1 through 8-1)

• FC2G—Fibre Channel 2.125 Gbps (Ports 1-1, 3-1, 5-1, and 7-1
only; ports are not available if the port that follows—2-1, 4-1, 6-1,
or 8-1—has a PPM provisioned.)

• FICON1G—Fiber connectivity 1.06 Gbps (IBM signal)
FICON2G—Fiber connectivity 2.125 Gbps (IBM signal) (Ports
1-1, 3-1, 5-1, and 7-1 only; ports are not available if the port that
follows—2-1, 4-1, 6-1, or 8-1—has a PPM provisioned.)

• ONE_GE—One Gigabit Ethernet 1.125 Gbps (Ports 1-1 through
8-1)

• ISC COMPAT (Ports 1-1 through 8-1)

• ISC3 PEER 1G (Ports 1-1 through 8-1)

• ISC3 PEER 2G (Ports 1-1, 3-1, 5-1, and 7-1 only; ports are not
available if the port that follows—2-1, 4-1, 6-1, or 8-1—has a PPM
provisioned.)

If the port mode is FC4G:

• FC4G—Fibre Channel 4.25 Gbps (Ports 1-1 or 5-1 only; ports are
not available if any of the three ports that follow has a PPM
provisioned.)

• FICON4G—Fiber connectivity 4.25 Gbps (IBM signal) (Ports 1-1
or 5-1 only; ports are not available if any of the three ports that
follow has a PPM provisioned.)

MXP_MR_10DME_C

MXP_MR_10DME_L

MXP_MR_10DMEX_C

• SONET (OC-192)/SDH (STM-64)

• FC8G

• FC10G

• TEN_GE

• OTU2

40G-MXP-C 40E-MXP-C
40ME-MXP-C

• GE_XP and GE_XPE client ports1

• 10GE_XP and 10GE_XPE client and trunk ports; GE_XP and
GE_XPE trunk ports1

GE_XP

10GE_XP

GE_XPE

10GE_XPE
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Port TypeCard

• SONET (including 10G Ethernet WAN Phy)—10 Gbps

• 10G Ethernet LAN Phy—10 Gbps Ethernet

• 10G Fiber Channel—10 Gbps Fibre Channel

• IB_5G—InfiniBand 5 Gbps

If you have an OTU2 signal in which the OPU2 has
been generated by multiplexing four ODU1 signals,
choose SONET as the port rate. This allows the OTU2
signal to be transported transparently in standard or
E-FEC regenerator configuration.

Note

OTU2_XP

• OC-3/STM1—155 Mbps

• OC-12/STM4—622 Mbps

• OC-48/STM16—2.48 Gbps

• Gigabit Ethernet—1.125 Gbps

• Fast Ethernet—100 Mbps

• ESCON-Enterprise System Connection 200 Mbps (IBM signal)

• FC1G—Fibre Channel 1.06 Gbps

• FC2G—Fibre Channel 2.125 Gbps

• FC4G—Fibre Channel 4.25 Gbps

• FC8G—Fibre Channel 8.5 Gbps

• FICON1G—Fiber connectivity1.06 Gbps (IBM signal)

• FICON2G—Fiber connectivity 2.125 Gbps (IBM signal)

• FICON4G—Fiber connectivity 4.25 (IBM signal)

• FICON8G—Fiber connectivity 8.5 Gbps (IBM signal)

• SD-SDI—270 Mbps

• HD-SDI—1.485 Gbps

• Third-generation SDI (3G-SDI)—2.970 Gbps

• OTU2E —11.09 Gbps

• OTU1—2.66 Gbps

AR_MXP

AR_XP

AR_XPE
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Port TypeCard

• SONET (OC-192)/SDH (STM-64)

• 10G Ethernet LAN Phy

• 40G Ethernet LAN Phy

• 100 GE

• FC 8G

• FC 10G

• OTU2

• OTU3

• OTU4

• IB_5G

100G-LC-C

10x10G-LC

CFP-LC

100G-CK-C

100G-ME-C

100ME-CKC

400G-XP-LC

• 10GE LAN PHY

• 8G FC

• 10G FC

• SONET (OC-192)/SDH (STM-64)

• OTU2

• OTU2e

WSE

Step 9 Return to your originating procedure (NTP).

Transponder and Muxponder Protection Topologies
The ONS 15454 supports Y-cable and splitter protection for transponder (TXP) and muxponder (MXP) cards.
The following figure shows Y-cable and splitter protection.
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Figure 46: Y-Cable and Splitter Protection

Y-Cable Protection
TheY-cable protection scheme employs twoY cables, which are hardware combiner/splitters. A signal injected
into the stem of the Y is duplicated into both arms of the Y with 50 percent attenuation in each arm. Signals
injected into the arms of the Y are summed into the stem of the Y.

A Y-cable protection group requires two DWDM cards with the arms of the Y-cables connected to the client
ports on the DWDM cards, and the stems of the Y-cables connected to the client source, such as an OC-N
card. When a TXP Y-cable protection group is required, the two TXP cards must be installed in the same
shelf assembly in adjacent slots.

The following figure shows a functional block diagram of Y-cable protection.
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Figure 47: Y-Cable Protection

A Y-cable protection group has two paths:

• Transmit (TX) path, defined as the client RX and the trunk TX
• Receive (RX) path, defined as the trunk RX and the client TX

The basic behavior of the Y-cable group is that an incoming client signal is bridged to the two TX paths, and
one RX path is selected for the outgoing client signal. Thus, a Y-cable protection group only protects against
defects in the RX path. The following figure shows the RX path for the near-end Y-cable protection group.

Figure 48: Rx Path for Near-End Y-Cable Protection

To protect against all defects, a pair of Y-cable protection groups is required. Each protects against defects
in its own RX path. The following figure shows how the near-end and the far-end jointly protect against
defects.
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Figure 49: Near-End and Far-End Y-Cable Protection

AY-cable protection group is defined by two client ports on two different cards. One client port is designated
as working and the other is designated as protect. Some of the rules in a Y-cable protection are as follows:

• The cards must have the same equipment type.
• The cards must have the same payload data type.
• The cards must have the same termination mode.
• The client ports must have the same payload type.
• The client ports must have the same facility number.
• The cards must have the same operating mode.

For example, a Y-cable protection group can include MXP Client 2 on the working and protect cards, but
cannot include Client 2 on the working card if Client 3 is on the protect card. TXP cards have a single client
(facility 1), so this requirement is satisfied by default.

Zero, one, two, or all of the client ports on an MXP card can be in Y-cable protection groups. Some clients
can be in a protection group while others are unprotected.

The client ports on a card that are in Y-cable protection groups are either all working or all protect. You cannot
mix working and protect client ports on the same card. For convenience, the trunk ports adopt the designation
(working or protect) of the client ports.

The Y-cable protection groups on an MXP card switch independently. A Y-cable protection group performs
protection switching by disabling the transmitter on the standby client port and enabling the active client port.

The protection group does not enable the active transmitter, because the active transmitter may have been
disabled for other reasons. The port is disabled if it has an OOS-DBLD service state, is squelched, or is
shutdown by automatic laser shutdown (ALS). The protection group releases a signal that the active transmitter
is disabled. This activity changes the RX path but not the TX path. A Y-cable protection group can only
protect its RX path.

A Y-cable protection group enables its client receivers unless the client facilities have an OOS-DSBLD service
state. This means that client receivers (and trunk transmitters) are operational regardless of the active/standby
status of the card. Traffic might not be lost if both client lasers in a Y-cable protection group are enabled. If
the output powers of the two lasers are not identical, then the receiver at the stem of the Y-cable can opt for
the stronger client laser and ignore the weaker signal.
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Splitter Protection
The protection group is defined by the two trunk ports on the splitter card. One trunk port is designated working
and the other is designated as protect. A splitter card has a single trunk laser and a hardware splitter that
duplicates the trunk signal out of the card’s two trunk ports. The switch in the card receives one of the two
trunk input signals and the received signal is connected to the client ports.

A splitter protection group has two TX paths and two RX paths on the same card; the paths share client ports.
The TX path is defined as the client RX and the trunk TX, and the RX path is defined as the trunk RX and
the client TX. In a splitter group, an incoming client signal is bridged to the TX paths, and one RX path is
selected for the outgoing client signal.

A splitter protection group performs switching by enabling the receiver of the active trunk port and then
routing the active trunk traffic to the client ports. The protection group does not disable the transmitter on the
standby trunk port.

Splitter protection is supported in AR_MXP, AR_XP, AR_XPE, and 10x10G-LC cards by configuring the
operating mode.

When any client port of the 10x10G-LC card is involved in Y-cable protection group, then splitter protection
must not be allowed in that card.

Switch Criteria
Cisco Transport Controller (CTC), the ONS 15454 software interface, performs protection switches based on
priority, trunk and client line conditions, switch commands, unidirectional/bidirectional switching, and other
criteria.

Switch Priority
Switch priorities are defined in the following table.

Table 125: Switch Priorities

PriorityAbbreviationRequest/State

8
(highest)

LOLockout of Protection

7FSForced Switch

6SFSignal Fail

5SDSignal Degrade

4MSManual Switch

3WTRWait to Restore

2DNRDo Not Revert

1 (lowest)NRNo Request

All switch criteria are assigned a numerical priority, which is reversed from ITU-TG.873.1 to avoid confusion
when comparing priorities. In this document, a higher priority is numerically greater than a lower priority.
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If the protection channel and the working channel have conditions with the same priority, and the priority is
greater than Do Not Revert (DNR), then the condition on the protection channel takes precedence.

In practice, only two priorities can exist independently and simultaneously on the working and protection
channels: signal fail (SF) and signal degrade (SD). This requirement means that if both channels have, for
example, an SF condition without any higher conditions present, then the protection group chooses the working
channel. Traffic switches away from the highest-priority condition.

Line Conditions on the Trunk
The following line conditions on the trunk generate the priorities given:

• OTUn-LOS on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• OTUn-LOF on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• OTUn-LOM on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• OTUn-AIS on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• ODUn-AIS on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• OTU BER SF on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• OTU BER SD on a trunk, if ITU-T G.709 is enabled, has an SD priority.
• TIM on OTU SM TTI on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• TIM on ODU PM TTI on a trunk, if ITU-T G.709 is enabled, has an SF priority.
• S-LOF on a trunk, if ITU-T G.709 is disabled and the trunk is OCn, has an SF priority.
• S-LOS on a trunk, if ITU-T G.709 is disabled and the trunk is OCn, has an SF priority.
• SF on a trunk, if ITU-T G.709 is disabled and the trunk is OCn, has an SF priority.
• SD on a trunk, if ITU-T G.709 is disabled and the trunk is OCn, has an SD priority.
• AIS-L on a trunk, if ITU-T G.709 is disabled and the trunk is OCn, has an SF priority.
• RS-LOF on a trunk, if ITU-T G.709 is disabled and the trunk is STMn, has an SF priority.
• RS-LOS on a trunk, if ITU-T G.709 is disabled and the trunk is STMn, has an SF priority.
• SF on a trunk, if ITU-T G.709 is disabled and the trunk is STMn, has an SF priority.
• SD on a trunk, if ITU-T G.709 is disabled and the trunk is STMn, has an SD priority
• MS-AIS on a trunk, if ITU-T G.709 is disabled and the trunk is STMn, has an SF priority.
• TIMS-S on J0 on a trunk, if ITU-T G.709 is disabled and TIM is enabled, has an SF priority.
• RS-TIM-S on J0 on a trunk, if ITU-T G.709 is disabled and TIM is enabled, has an SF priority.
• CARLOSS on a trunk, if ITU-T G.709 is disabled and the payload is GigE, has an SF priority.
• SIGLOSS on a trunk, if ITU-T G.709 is disabled and the payload is Fibre Channel (any speed), has an
SF priority.

• GE-OOSYNC on a trunk, if ITU-T G.709 is disabled and the payload is 10GigE, has an SF priority.
• OOS on a trunk, if ITU-T G.709 is disabled and the payload is GigE, has an SF priority.
• OOS on a trunk, if ITU-T G.709 is disabled and the payload is Fibre Channel, has an SF priority.
• SYNCLOS on a trunk, if ITU-T G.709 is disabled and the payload is Fibre Channel, has an SF priority.

Line Conditions on the Client
Most of the defects on client ports are corrected by switching at the far-end protection group.

In a Y-cable protection group, a line alarm indication signal (AIS-L) on the client signal has an SF priority if
generic framing procedure (GFP) is not used and the client framing is SONET.
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Switch Commands
Switch commands have the following priorities:

• A Lockout of Protect (Lockon Working) switch command has an LO priority on the protect port.
• A Force From Working (Force to Protect) switch command has an FS priority on the working port.
• A Force From Protect (Force To Working) switch command has an FS priority on the protect port.
• A Manual FromWorking (Manual To Protect) switch command has an MS priority on the working port.
• A Manual From Protect (Manual To Working) switch command has an MS priority on the protect port.
• A Clear command cancels (unlocks) any switch command.

Unidirectional and Bidirectional Switching
Y-cable and splitter protection support unidirectional switching. In unidirectional switching, the near-end
protection group switches without regard for the status of the far-end protection group.

Therefore, the near-end working facilities can be active at the same time the far-end protection facilities are
in standby. This does not mean that a defect at the far end will not cause a near-end switch. A defect at the
far end might result in a condition at the near end, which then causes a switch, but the switch is caused by the
near-end condition.

Bidirectional protection cannot be provisioned unless the near end and far end have the same hardware and
data modes and the trunks are connected as working-to-working and protect-to-protect.

Any other configuration results in an undefined behavior. Y-cable and splitter protection groups are not
required to detect misconfigured bidirectional protection.

A Y-cable or splitter protection group switches unidirectionally unless at least one trunk signal is intact and
there is an operational card terminating the trunk signal at the far end.

Other Switch Criteria
This section details switch criteria other than line conditions. A card is said to become operational after it has
received and processed the first provisioningmessage after a warm or cold boot. A card ceases to be operational
when it is reset, either with a soft reset request or a hardware reset.

A soft reset of a card does not cause a protection switch or a traffic disruption greater than the disruption
induced by the soft reset of an unprotected card. If one or both cards are not operational, then any disruption
of traffic on the active card will cause traffic loss until both cards have become operational again.

Switch conditions with a priority lower than FS are ignored by a Y-cable protection group unless both cards
are operational. Switch conditions cannot be used to restore traffic while one member of the protection group
is reset. For instance, if the working/active card is soft reset and a Forced Switch to the protect card is issued,
the protect client laser will turn on but the working client laser will not turn off. Traffic will be lost until the
working card becomes operational and can process the Forced Switch request.

The LO and FS switch conditions are accepted by the shelf regardless of the operational status of the cards
in a Y-cable protection group or a splitter protection group. A nonoperational card cannot process the switch
condition; the provisioning has been accepted by the shelf controller and will be issued to the cards when it
becomes operational.

The LO and FS switch conditions are implemented immediately by the operational cards in a Y-cable protection
group even if one card is nonoperational. This might cause traffic loss.

Y-cable protection switching is inhibited during a shelf controller reset. Protection switching does not resume
until the cards receive their first provisioning message from the active shelf controller.
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Each card in a Y-cable protection group begins its provisioning hold-off timer after processing the first
provisioning message. For proper behavior, both cards should be provisioned within the provisioning hold-off
timer interval. A card missing condition has an SF+ priority. This gives the card missing condition a higher
priority than any span alarm.

• A card MEA condition has an SF priority.
• An SFP failure condition has an SF priority.
• An SFP mismatch (failure to support the data rate or mode) condition has an SF priority.
• An SFP missing condition has an SF priority.
• A wavelength mismatch condition has an SF priority.
• A port that is OOS-DSBLD has an SF+ priority.
• The OOS-DSBLD condition has a higher priority than any span alarm.
• A port that is shutdown by ALS has an SF priority.

The hold-off timer interval is not applicable forWSE, 10x10G-LC, 100G-LC-C, 100G-CK-C, 100GS-CK-LC,
and 200G-CK-LC cards.

Switch Stability
Y-cable and splitter protection groups use a variety of timers to prevent oscillation, as detailed in the following
requirements. No timer is provisionable.

The protection groups implement soak-to-clear timers. A soak-to-clear timer starts when a switch condition
clears. While the timer is running, the protection group behaves as though the switch condition is still present.
If the switch condition recurs before the timer has expired, the timer is canceled. When the switch condition
clears, the timer is restarted.

The durations of soak-to-clear timers are not user-provisionable and are unrelated to the soak times for alarms
and conditions. A soak-to-clear timer is not started when a switch condition clears if the switch condition has
a lower priority than the currently active switch condition For example, an SD BER soak-to-clear timer will
not start if SD BER clears while AIS is present, since AIS has a higher priority than SD BER. All line defects
with an SF priority, except for SF BER, share a single one-second soak-to-clear timer. SF BER and SD BER
line conditions have a 10-second soak-to-clear timer.

The protection group does not switch sooner than 1.5 seconds after the last switch (the switch hold-off timer).
This timer prevents rapid oscillation of the protection group.

A Y-cable protection group does not switch for the first 5 seconds after it is created unless both cards in the
protection group become active before 5 seconds elapses.This delay allows both cards in the protection group
to be provisioned before any switching decisions are made.

A Y-cable protection group does not switch sooner than 0.5 seconds after a client or trunk facility moves from
the OOS-SDBLD state. This hold-off timer allows the cards to ignore transients caused by a port going
in-service. The ALS condition has a 3 second soak-to-clear timer.

Revertive and Nonrevertive Attributes
Both revertive and nonrevertive switching is supported; the default switch mode is nonrevertive.

Network element (NE) defaults contain a revertive attribute for Y-cable and splitter protection.When applicable
in revertive mode, the revert delay timer, also called the Wait-To-Restore (WTR) timer, is software
provisionable for Y-cable and splitter protection. TheWTR timer is provisionable between 0.5 and 12minutes,
in 0.5 minute increments, and it has a default value of 5 minutes.
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When applicable, the NE defaults contain aWTR attribute for Y-cable and splitter protection.When a Y-cable
protection group is deleted, a dialog box will appear warning of possible traffic loss.

Communications Channels
In a Y-cable protection group, only the working client cam be provisioned with a section data communications
channel (SDCC) or line data communications channel (LDCC), and only the working client port can be
provisioned as a timing reference (as permitted by payload). The working and protect trunks can be provisioned
separately with communication channels (SDCC, LDCC, or generic communications channel [GCC], as
permitted by payload type). The communication channels are not protected.

Inherited Port Properties
Selected port properties of the protection port are inherited from the working port. In this section, the word
port refers to a Y-cable client port or a splitter trunk port:

• The maximum Ethernet Frame Size of the protect port is inherited from the working port.
• The Port Type (SONET or SDH) of the protect port is inherited from the working port.
• The Termination Mode of the protect port is inherited from the working port.
• The SF BER threshold of the protect port is inherited from the working port.
• The SD BER threshold of the protect port is inherited from the working port.
• The SyncMsgIn and SendDoNotUse attributes of the protect port are inherited from the working port.
• Section trace provisioning of the protect port is inherited from the working port.
• The line thresholds of the protect port are inherited from the working port.
• The SDCC/LDCC/GCC provisioning of the protect port is inherited from the working port.
• The ALS provisioning of the protect port is inherited from the working port.

ALS is not permitted on the client ports of Y-cable protection groups. This requirement applies only to splitter
protection groups.

Switch Status Reporting
Y-cable and splitter protection groups indicate to management software the active/standby status of facilities
and cards involved in the protection group. A facility has an active/standby status within the protection group
and it has a status that is reported to the management software. These two do not always coincide. Internally,
the protection group always has one active facility and one standby facility. In some circumstances, the
protection group reports both facilities as standby.

The reported status of any port on a nonoperational card is undefined. While a card is reset, its status might
or might not be reported properly. Because the card does not report any status, the report to the user is a
function of the management software, not the protection group.

A Y-cable protection group reports a separate status for the TX path and the RX path, for every facility. The
active/standby status of the protection group is reported as the status of the RX path. If the status of the far-end
protection group is known, then the status of the far-end protection group is reported as the status of the
near-end TX path.

The ability of a protection group to know the status of the far-end protection group is a function of the equipment
type and the trunk type. If the status of the far-end protection group is not known, the status of the near-end
protection group shall be reported as the status of the TX path.

A Y-cable protection group has at most one active client port. A port in a Y-cable or splitter protection group
is reported as standby if it has an OOS-DSBLD service state, regardless of its status within the protection
group. A port in a Y-cable or splitter protection group is reported as active if it does not have an OOS-DSBLD
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state and if it carries overhead traffic (GCC, SDCC, LDCC, or E1 bytes), regardless of its status within the
protection group.

A client port in a Y-cable protection group is reported as active if it does not have an OOS-DSBLD service
state and if it is active within the protection group. A trunk port in a Y-cable protection group is reported as
active if it does not have an OOS-DSBLD service state and if any client port on the same card is active.

Transponders have exactly one client port, and the relationship of client to trunk is clear. Muxponder cards
have multiple client ports, which means that multiple protection groups are present. If any client port on a
muxponder is active, and if the trunk is in-service, the trunk is also reported as active.

Client ports and trunk ports on unprotected cards (cards not part of any protection group) are reported as active
if they do not have an OOS-DSBLD service state.

Switch Conditions
Protection groups generate conditions and transient conditions to provide a status to the node management
software. Common conditions include:

• The protection group raises a MAN-REQ condition against the working facility while a Manual Switch
to Protection switch command is in effect.

• The protection group raises aMAN-REQ condition against the protection facility while aManual Switch
to Working switch command is in effect.

• The protection group raises a FORCED-REQ condition against the working facility while a Forced
Switch to Protection switch command is in effect.

• The protection group raises a FORCED-REQ condition against the protection facility while a Forced
Switch to Working switch command is in effect.

• The protection group raises a LOCKOUT-REQ condition against the protection facility while a Lockout
of Protection switch command is in effect.

• The protection group signals an APS-CLEAR condition when a switch command is preempted by a
higher-priority switch condition.

• The protection group signals a FAILTOSW condition while a switch command is inhibiting a protection
switch due to a lower-priority line condition.

• The protection group raises a WTR condition against the working facility while the Wait To Restore
timer is running.

• The protection group, if it is in revertive mode, raises a WKSWPR condition against the working facility
while the protection facility is active.

• The protection group, if it is in nonrevertive mode, signals a WKSWPR condition against the working
facility when the protection facility becomes active.

• The protection group, if it is nonrevertive, signals a WKSWBK condition against the working facility
when the working facility becomes active.

Protection Switching Performance Requirements
Protection switching is executed within 50 ms of a defect appearing at the near end. Loss of light on the client
outputs of a Y-cable protection group does not exceed 20 ms during a switch.

During a protection switch, the standby client transmitter turns off, and the active client transmitter turns on.
If the standby transmitter turns off before the active transmitter is fully on, a loss of light occurs at the stem
of the Y-cable. This loss of light does not last longer than 20 ms. If a payload cannot tolerate a loss of light
less than 20 ms, then that payload cannot be used with Y-cable protection.
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Usability Requirements
The following section discusses regeneration groups, automatic laser shutdown, and client signal failures.

Regeneration Groups
A regeneration group boosts the power and improves the signal-to-noise (S/N) ratio in a DWDM signal. The
purpose is to extend the reach of a DWDM signal between two termination points. In an ideal condition,
regeneration is totally transparent to the endpoints. However, some regeneration techniques fall short of this
ideal condition and might modify, delay, or even drop overhead signals (ITU-T G.709, GFP, or other
section-level signaling protocols).

The behavior of Y-cable and splitter protection groups is unchanged by the presence of a single peer-to-peer
regeneration group in one or both of the DWDM spans. This requirement cannot be met if the regeneration
corrupts the overhead bytes that are necessary for protection switching.

Automatic Laser Shutdown
ALS disables the transmitter of a facility if the receiver of the same facility detects a loss of light. ALS exists
as a human-safety standard. After ALS shuts down the transmitter, it is not restarted until the loss of light
condition clears. To facilitate restarting lasers when both ends of a span are shut down by ALS, the facility
can be provisioned to send short test pulses of light. ALS is not permitted on the client ports of a Y-cable
protection group.

Client Signal Failures
Y-cable protection groups can protect against failures of the client RX signal at the end. The far-end client
RX failure can be in the fiber (in an “arm” of the Y), in the equipment (for example, the SFP), or in the
provisioning (client OOS-DSBLD). These failure types require special handling because they are out-of-band
with respect to the normal client payload. The term used for these failures is client signal fail (CSF). This has
the same meaning as GFP-CSF, but does not imply that GFP-CSF is used for the signaling. Client signal
failures include:

• An S-LOF on a client port, if the client is OC-N, is signaled to the downstream client port as a CSF.
• An S-LOS on a client port, if the client is OC-N, is signaled to the downstream client port as a CSF.
• An RS-LOF on a client port, if the client is STM-N, is signaled to the downstream client port as a CSF.
• An RS-LOS on a client port, if the client is STM-N, is signaled to the downstream client port as a CSF.
• A GE-OOSYNC on a client port, if the client is GigE or 10GigE, is signaled to the downstream client
port as a CSF.

• An SFP missing condition on a client port is signaled to the downstream silent port as a CSF.
• An SFP mismatch (failure to support client data rate) condition on a client port is signaled to the
downstream client port as a CSF.

• An SFP failure condition on a client port is signaled to the downstream client port as a CSF.
• An OOS-DSBLD condition on a client port is signaled to the downstream client port as a CSF.

In-service Upgrade
AY-cable group switches normally during a software activation or software revert if both cards in the Y-cable
group are running the same software release.

This behavior is different from that of OC-N 1+1 protection groups, which will not switch until the software
activation is complete. The Y-cable group is able to switch before either card has booted to the new release
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and after both cards have booted to the new release. This requirement does not preempt the other requirements
that both cards be operational and that an active TCC2/TCC2P be installed.

Path Diversion Support for Client Protection
The ONS 15454 DWDM system provides the capability to provision unprotected wavelengths on a
per-wavelength basis and supports the reuse of unprotected wavelengths on adjacent spans.

The following figure provides examples of unprotected wavelengths.

Figure 50: Example of Unprotected Wavelengths

NTP-G33 Creating a Y-Cable Protection Group
This procedure creates a Y-cable protection group between the client ports of
two TXP, MXP, AR_XP, AR_MXP, AR_XPE, 10x10G-LC, CFP-LC,
100G-CK-C, 100GS-CK-LC, 200G-CK-LC, GE_XP, 10GE_XP, GE_XPE,
10GE_XPE, or OTU2_XP cards when the cards are provisioned in the TXP or
MXP mode.

Purpose

• Installed TXP,MXP, AR_MXP, AR_XP, AR_XPE, 10x10G-LC, CFP-LC,
100G-CK-C, 100GS-CK-LC, 200G-CK-LC,GE_XP, 10GE_XP,GE_XPE,
10GE_XPE, or OTU2_XP card.

• Cisco TransportPlanner Traffic Matrix

Tools/Equipment
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• NTP-G15 Installing the Common Control Cards on ONS 15454 Shelf
• NTP-G14 Install DWDM Equipment
• DLP-G46 Log into CTC

• NTP-G139 Verifying Cisco Transport Planner Reports and Files

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Y-cable protection is available for the 100GS-CK-LC and 200G-CK-LC cards only in the MXP-10x10G
operating modes

Note

In the MXP-10x10G opmode, for the 200G-CK-LC and 10x10G-LC cards, Y-cable creation for OTU2 client
payload of 10x10G-LC is not supported in R10.70.

Note

In the MXP-10x10G-100G opmode, Y-cable creation for client ports of 10x10G-LC, for the combination of
200G-CK-LC and 100GS-CK-LC trunk cards is not supported in R10.70.

Note

Y-cable protection is available for the 10x10G-LC card when it is provisioned in one of the following modes:

• TXP-10Gmode—The client ports are provisioned with 10G Ethernet LAN Phy, 8G FC, 10G FC, OTU2,
and OC192/STM-64 payloads.

• MXP-10G mode—The client ports are provisioned with 10GE, 8G FC, 10G FC, OTU2, and
OC192/STM-64 payloads.

Note

Y-cable protection is available for the 100G-CK-C card for the CPAK-100G-LR4 pluggable with 100GE/OTU4
payloads.

Note
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Y-cable protection is available for the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards when they are
provisioned in the 10GE MXP, 20GE MXP, or 10GE TXP mode. If you are provisioning Y-cable protection
for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, the Ethernet mode must be set to 1000 and 10000
Mbps respectively. To provision the Ethernet mode, see the DLP-G380 Provisioning Ethernet Settings, on
page 542. Y-cable protection cannot be provisioned for the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards when they are provisioned in L2-over-DWDM mode.

Note

Y-cable protection is available for the OTU2_XP card when it is provisioned in the TXP card mode. The
OTU2-XP and 40E-MXP-C card cannot implement Y-cable protection for the client ports in 10 GE LAN
PHY mode. Hence, a pair of OTU2_XP cards is used at each end in pass-through mode (Transponder mode
with G.709 disabled) to implement Y-cable protection. The 40E-MXP-CE card can implement Y-cable
protection without the OTU2-XP card for the client ports in LANPHYGFPmode. However, the 40E-MXP-CE
card cannot implement Y-cable protection without the OTU2-XP card for the client ports in LAN PHYWIS
mode.

Note

For SONET or SDH payloads, Loss of Pointer Path (LOP-P) alarms can occur on a split signal if the ports
are not in a Y-cable protection group.

Note

Procedure

Step 1 View the Cisco Transport Planner Traffic Matrix (see the Cisco Transport Planner Node Setup Information
and Files table) for your site. Verify the cards that need Y-cable protection groups. (Cards requiring Y-cable
protection are indicated with “Y-Cable” in the Traffic Matrix table Protection Type column.) For more
information, see the Cisco Transport Planner DWDM Operations Guide.

Step 2 Verify that the cards are installed according to the requirements specified in Cable Connections for Y-Cable
Protection of One Client Signal. Protection Types, on page 338 lists the protection types available for DWDM
client cards.

Step 3 Verify that pluggable ports are provisioned for the same payload and payload rate on the cards where you
want to create the Y-cable protection group:
a) Display the card in card view.
b) Click the Provisioning > Pluggable Port Module tab.
c) Verify that a pluggable port is provisioned in the Pluggable Port Module area, and the payload type and

rate is provisioned for it in the Pluggable Ports area. If they are not the same, for example, if the pluggable
port and rate are not the same, you must either delete the provisioned rate and create a new rate to match
using the DLP-G725 Preprovisioning PPM Slot task or replace the pluggable port (SFP or XFP) using
the DLP-G728 Remove PPM from the Line Card task.

Step 4 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Protection tabs.
Step 5 In the Protection Groups area, click Create.
Step 6 In the Create Protection Group dialog box, enter the following:
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• Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 0-9)
characters. Special characters are permitted. For TL1 compatibility, do not use questionmark (?), backslash
(\), or double quote (“) characters.

• Type—Choose Y Cable from the drop-down list.

• Protect Port—From the drop-down list, choose the port that will be the standby or protection port to the
active port. The list displays the available transponder or muxponder ports. If transponder or muxponder
cards are not installed, no ports appear in the drop-down list.

After you choose the protect port, a list of available working ports appear in the Available Ports list. If no
cards are available, no ports appear. If this occurs, you can not complete this task until you install the physical
cards or preprovision the slots.

Step 7 From the Available Ports list, select the port that will be protected by the port you selected in Protect Ports.
Click the top arrow button to move the port to the Working Ports list.

Step 8 Complete the remaining fields:

• Revertive—Check this check box if you want traffic to revert to the working port after failure conditions
remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range is
0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will elapse
before the traffic reverts to the working card. The reversion timer starts after conditions causing the
switch are cleared.

The bidirectional switching option is available for Y-cable protection groups only in the following
cases:

• On theMXP_MR_10DMEcardwhen ISC3_PEER_1G/ISC3_PEER_2G is the client payload.

• On the MXP_MR_10DME and MXP_MR_2.5G cards when Fibre Channel is the client
payload. In this case bidirectional switching is:

• Automatically enabled when Distance Extension is enabled.

• Automatically disabled when Distance Extension is disabled.

The bidirectional switching option is available for all SONET and SDH 1+1 protection groups.

Note

Step 9 Click OK.
Step 10 Repeat this procedure for every Y-cable protection group indicated in the Cisco TransportPlanner Traffic

Matrix.

Stop. You have completed this procedure.
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Protection Types
Table 126: Protection Types

Description and Installation RequirementsCardsProtection Type

Pairs a working transponder or muxponder card or port with a protect
transponder or muxponder card or port. The protect port must be on a different
card than the working port and it must be the same card type as the working
port. The working and protect port numbers must be the same, that is, Port
1 can only protect Port 1, Port 2 can only protect Port 2, and so on.

The working and protect card must be in the same shelf for a
multishelf node.

Note

Y-cable
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Description and Installation RequirementsCardsProtection Type

MXP_2.5_10G

MXP_2.5_10E

MXP_2.5_10E_C

MXP_2.5_10E_L

TXP_MR_10EX_C

TXP_MR_10G

TXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_2.5G

40E-TXP-C

40ME-TXP-C

MXP_MR_2.5G

MXP_MR_10DME_C

MXP_MR_10DME_L

MXP_MR_10DMEX_C

40G-MXP-C

40E-MXP-C

40ME-MXP-C

GE_XP (when provisioned
in 10GE MXP or 20GE
MXP card mode)

10GE_XP (when
provisioned in 10GE TXP
card mode)

GE_XPE

10GE_XPE

OTU2_XP

AR_MXP

AR_XP

AR_XPE

10x10G-LC

CFP-LC

100G-CK-C
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Description and Installation RequirementsCardsProtection Type

A splitter protection group is automatically created when a TXPP_MR_2.5G,
MXPP_MR_2.5G, AR_MXP, AR_XP, AR_XPE, or 10x10G-LC card is
installed. You can edit the splitter protection group name.

TXPP_MR_2.5G

MXPP_MR_2.5G

AR_MXP

AR_XP

AR_XPE

10x10G-LC

Splitter

A splitter protection group is configurable for the OTU2_XP card. You can
create a splitter protection group on ports 3 and 4 of the OTU2_XP card using
the NTP-G199 Creating a Splitter Protection Group, on page 340.

OTU2_XP

In the Layer 2 (L2) card mode 1+1 protection is provided to protect the card
against client port and card failure.

GE_XP

10GE_XP

GE_XPE

10GE_XPE

1+1

NTP-G199 Creating a Splitter Protection Group
This procedure creates a splitter protection group between the trunk ports of
an OTU2_XP card. For additional information about splitter protection, see the
"Splitter Protection" section.

Purpose

Installed OTU2_XP card

Cisco TransportPlanner Traffic Matrix

Tools/Equipment

In the Hardware Installation Guide:

• NTP-G15 Install the Common Control Cards
• NTP-G14 Install DWDM Equipment

• DLP-G46 Log into CTC

• NTP-G139 Verifying Cisco Transport Planner Reports and Files

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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A splitter protection group is automatically created when a TXPP_MR_2.5G,MXPP_MR_2.5G, or PSM card
is installed. You can edit the splitter protection group name for these cards. The splitter protection group is
deleted when you delete the TXPP_MR_2.5G, MXPP_MR_2.5G, or PSM card.

Note

Splitter protection is available for the OTU2_XP card when it is provisioned in Transponder configuration
only. In a splitter-protected Transponder configuration, Port 1 is the client port, Port 3 is the working trunk
port, and Port 4 is the standby trunk port.

Note

For SONET or SDH payloads, Loss of Pointer Path (LOP-P) alarms can occur on a split signal if the ports
are not in a splitter protection group.

Note

Procedure

Step 1 View the Cisco TransportPlanner Traffic Matrix (see the Cisco Transport Planner Node Setup Information
and Files table) for your site. Verify which OTU2_XP card needs a splitter protection group. (Cards requiring
splitter protection are indicated with “Splitter” in the Traffic Matrix table Protection Type column. Refer to
the Cisco Transport Planner DWDM Operations Guide for more information.)

Step 2 Verify that the OTU2_XP card is installed according to the requirements specified in Cable Connections for
Y-Cable Protection of One Client Signal

Step 3 Verify that the pluggable port (SFP or XFP) slot is provisioned for the same payload rate as the pluggable
port on the OTU2_XP card where you will create the splitter protection group:
a) Display the OTU2_XP card in card view.
b) Click the Provisioning > Pluggable Port Module tabs.
c) Verify that a pluggable port (SFP or XFP) slot is provisioned in the Pluggable Port Module area, and that

the payload rate of the pluggable port (SFP or XFP) slot is same as the payload rate of the pluggable port
on the OTU2_XP card provisioned in the Pluggable Ports area. If they are not the same, you must either
delete the provisioned rate and create a new rate to match using the DLP-G725 Preprovisioning PPM Slot
task or replace the pluggable port (SFP or XFP) using the DLP-G728 Remove PPM from the Line Card
task.

Step 4 In node view (single-shelf mode) or shelf view (multishelf view), click the Provisioning > Protection tabs.
Step 5 In the Protection Groups area, click Create.
Step 6 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 0-9)
characters. Special characters are permitted. For TL1 compatibility, do not use questionmark (?), backslash
(\), or double quote (“) characters.

• Type—Choose Splitter from the drop-down list.

• Protect Card—From the drop-down list, choose the port that will be the standby or protection port to the
active port. The list displays the available OTU2_XP ports. If transponder or muxponder cards are not
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installed or if the trunk ports of the card are part of a regenerator group, no ports appear in the drop-down
list.

After you choose the protect port, a list of available working ports appear in the Available Cards list. If
no cards are available, no ports appear. If this occurs, you cannot complete this task until you install the
physical cards or preprovision the slots using the DLP-G353 Preprovisioning a Slot.

Step 7 From the Available Cards list, select the port that will be protected by the port you selected in Protect Cards.
Click the top arrow button to move the port to the Working Cards list.

Step 8 Complete the remaining fields:

• Revertive—Check this check box if you want traffic to revert to the working port after failure conditions
remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range is
0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will elapse
before the traffic reverts to the working card. The reversion timer starts after conditions causing the
switch are cleared.

The Bidirectional Switching option is not applicable for splitter protection groups.Note

Step 9 Click OK.
Step 10 Repeat this procedure for every splitter protection group indicated in the Cisco TransportPlanner Traffic

Matrix.

Stop. You have completed this procedure.

NTP-G198 Creating 1+1 Protection for Cards
This procedure creates a 1+1 protection group to protect against client port and
card failure of GE_XP, 10GE_XP, GE_XPE, 10GE_XPE cards.

Purpose

NoneTools/Equipment

In the Hardware Installation Guide:

• DLP-G46 Log into CTC

• NTP-G139 Verifying Cisco Transport Planner Reports and Files

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed according to the requirements
specified in Cable Connections for Y-Cable Protection of One Client Signal

Step 2 Complete the NTP-G242 Creating an Internal Patchcord Manually by selecting the Trunk to Trunk (L2)
option, at the trunk port where you want to create 1+1 protection.

Step 3 Complete the DLP-G461 Creating a 1+1 Protection Group for Cards, on page 343 to create a protection group.
Step 4 Configure the standby port behavior, by setting the Protection Action to None or Squelch. For detailed

information on how to configure the standby port behavior, see the DLP-G380 Provisioning Ethernet Settings,
on page 542 task.

Do not enable squelch in a 1 + 1 protection group, if the 100FX, 100LX SFP, andONS-SE-ZE-EL
SFP is used in the protection group and is connected to the peer via the parallel cable (not Y-cable)

Note

When you configure L2 1 + 1 protection on 10GE_XP and 10GE_XPE cards, set the Protection
Action to None on the client ports. Setting the Protection Action as Squelch results in unexpected
switching behavior.

Note

Step 5 Configure the standby and active port speed, by setting the mode parameter to Auto or 1000 or any other
values. For detailed information on how to configure the standby port behavior, see the DLP-G380 Provisioning
Ethernet Settings, on page 542 task.

Stop. You have completed this procedure.

DLP-G461 Creating a 1+1 Protection Group for Cards
This procedure creates a 1+1 protection group for GE_XP, 10GE_XP, GE_XPE,
or 10GE_XPE slots where internal patchcords were created.

Purpose

NoneTools/Equipment

DLP-G344 Verifying Provisionable and Internal PatchcordsPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > Protection
tabs.

Step 2 In the Protection Groups area, click Create.
Step 3 In the Create Protection Group dialog box, enter the following:
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• Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 0-9)
characters. Special characters are permitted. For TL1 compatibility, do not use questionmark (?), backslash
(\), or double quote (“) characters.

• Type—Choose L2 1+1 (port) from the drop-down list.

• Protect Port—From the drop-down list, choose the port that will be the standby or protection port for the
active port. The list displays the available transponder or muxponder ports. If transponder or muxponder
cards are not installed, no ports appear in the drop-down list.

After you choose the protect port, a list of available working ports appear in the Available Ports list. If no
cards are available, no ports appear. If this occurs, you cannot complete this task until you install the physical
cards or preprovision the slots using the DLP-G353 Preprovisioning a Slot task.

Step 4 From the Available Ports list, select the port that will be protected by the port you selected in the Protected
Port drop-down list. Click the top arrow button to move the port to the Working Ports list.

Step 5 Complete the remaining fields:

• Revertive—Check this check box if you want traffic to revert to the working port after failure conditions
remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range is
0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will elapse
before the traffic reverts to the working card. The reversion timer starts after conditions causing the
switch are cleared.

The bidirectional switching option is available for SONET and SDH 1+1 protection groups.

Step 6 Click OK.
Step 7 Repeat this procedure for every 1+1 protection group indicated in the Cisco TransportPlanner Traffic Matrix.
Step 8 Return to your originating procedure (NTP).

NTP-G98 Provisioning the 2.5G Multirate Transponder Card Line
Settings and PM Parameter Thresholds

This procedure changes the line and threshold settings for TXP_MR_2.5G and
TXPP_MR_2.5G transponder cards.

Purpose

NoneTools/Equipment

DLP-G723 Install PPM on a Line Card

DLP-G726 Preprovisioning a Multirate PPM (if necessary)

DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task to preserve the existing transmission
settings.

Step 2 Perform any of the following tasks as needed:

• DLP-G229 Changing the 2.5G or 10G Transponder Card Settings, on page 345

• DLP-G230 Changing the 2.5G Multirate Transponder Line Settings, on page 347

• DLP-G231 Changing the 2.5G Multirate Transponder Line Section Trace Settings, on page 349

• DLP-G232 Changing the Multirate Transponder SONET or SDH Line Threshold Settings, on page 353

• DLP-G320 Changing the 2.5G Multirate Transponder Line RMON Thresholds, on page 356

• DLP-G305 Provisioning the 2.5G Multirate Transponder Trunk Port Alarm and TCA Thresholds, on
page 357

• DLP-G306 Provisioning the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds, on
page 359

• DLP-G234 Changing the Multirate Transponder OTN Settings, on page 364

• DLP-G367 Changing the Multirate Transponder Trunk Wavelength Settings, on page 351

Stop. You have completed this procedure.

DLP-G229 Changing the 2.5G or 10G Transponder Card Settings
This task changes the card settings for TXP_MR_2.5G and TXPP_MR_2.5G,
TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and
TXP_MR_10EX_C transponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the card settings.

Step 2 Click the Provisioning > Card tabs.
Step 3 Modify any of the settings described in the following table.
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The Card subtab Framing Type and Tunable Wavelengths fields are display-only. Framing Type
shows the card framing type, either SONET or SDH, depending on whether the card is installed
in an ANSI or ETSI chassis. The Tunable Wavelengths field shows the tunable wavelengths for
the physical TXP_MR_2.5G or TXPP_MR_2.5G that is installed.

Note

Table 127: 2.5G or 10G Transponder Card Settings

OptionsDescriptionParameter

• Transparent

• Section (ANSI) or Regeneration Section
(ETSI) - Only for TXP_MR_2.5G,
TXPP_MR_2.5G, and TXP_MR_10E.

• Line (ANSI) or Multiplex Section
(ETSI)

Sets the mode of operation (option only
supported for SONET/SDH payloads).

Termination
Mode

• Squelch

• AIS

(TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, or TXP_MR_10EX_C
only) Sets the transparent termination mode
configuration.

AIS/Squelch
Configuration

• None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17

Sets the slot containing another multirate
card to create a regeneration peer group. A
regeneration peer group facilitates the
management of two multirate cards that are
needed to perform a complete signal
regeneration.

The regeneration peer group synchronizes
provisioning of the two cards. Payload type
and ITU-T G.709 optical transport network
(OTN) changes made on one multirate card
are reflected on the peer multirate card.

Y-cable protection groups
cannot be created on TXP
cards that are in a regeneration
peer group.

Note

Regeneration
Peer Slot

User definedSets the regeneration peer group name.Regeneration
Group Name
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OptionsDescriptionParameter

—(Only for 10G multirate transponder cards)
Shows the supported wavelengths of the
trunk port after the card is installed. For the
TXP_MR_10E_C, or TXP_MR_10E_L
cards, the first and last supported
wavelength, frequency spacing, and number
of supported wavelengths are shown in the
format: first wavelength-last
wavelength-frequency spacing-number of
supported wavelengths. For example, the
TXP_MR_10E_C card would show:
1529.55nm-1561.83nm-50gHz-82. The
TXP_MR_10E show the four wavelengths
supported by the card that is installed. The
TXP_MR_10G show the two wavelengths
supported by the card that is installed.

Tunable
Wavelengths

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G230 Changing the 2.5G Multirate Transponder Line Settings
This task changes the line settings for the client port of the TXP_MR_2.5G and
TXPP_MR_2.5G transponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or
TXPP_MR_2.5G card where you want to change the line settings.

Step 2 Click the Provisioning > Line > SONET tabs.
Step 3 Modify any of the settings described in the following table.

The 2.5G multirate transponder trunk settings are provisioned in the DLP-G305 Provisioning the
2.5G Multirate Transponder Trunk Port Alarm and TCA Thresholds, on page 357.

Note
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Table 128: TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings

OptionsDescriptionParameter

• 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G card only)

(Display only) Displays the port number.Port

User-defined. Name can be up to 80 alphanumeric/
special characters. Blank by default.

The user can assign a logical name for each of the ports
shown by filling in this field.

Port Name

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Sets the port service state unless network conditions
prevent the change. For more information about
administrative states, see the Administrative and Service
States document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or
Locked-enabled,maintenance (ETSI)

(Display only) Identifies the autonomously generated
state that gives the overall condition of the port. Service
states appear in the format: Primary State-Primary State
Qualifier, Secondary State. For more information about
service states, see the Administrative and Service States
document.

Service State

• 1E-3

• 1E-4

• 1E-5

(OC-N and STM-N payloads only) Sets the signal fail
bit error rate.

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

(OC-N and STM-N payloads only) Sets the signal
degrade bit error rate.

SD BER

• Disabled (default)

• Auto Restart

• Manual Restart

• Manual Restart for Test

Sets the automatic laser shutdown (ALS) function.ALS Mode
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OptionsDescriptionParameter

Options: ANSI/ETSI

• Autoprovision/Autoprovision (default)

• SR

• SR 1/I-1—Short reach up to 2-km distance

• IR 1/S1—Intermediate reach, up to 15-km distance

• IR 2/S2—Intermediate reach up to 40-km distance

• LR 1/L1—long reach, up to 40-km distance

• LR 2/L2—long reach, up to 80-km distance

• LR 3/L3—long reach, up to 80-km distance

Displays the optical reach distance of the client port.Reach

• First Tunable Wavelength

• Further wavelengths: 1310 nm through 1560.61 nm,
100-GHz ITU spacing; coarse wavelength division
multiplexing (CWDM) spacing

Note: supported wavelengths are marked by asterisks
(**)

Displays the wavelength of the client port.Wavelength

• Duration of valid input signal, in hh.mm format,
after which the card becomes in service (IS)
automatically

• 0 to 48 hours, 15-minute increments

(OC-N and STM-N payloads only) Sets the automatic
in-service soak period.

AINS Soak

• SONET

• SDH

(OC-N and STM-N payloads only) The optical transport
type.

Type

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G231Changingthe2.5GMultirateTransponderLineSectionTraceSettings
This task changes the section trace settings for TXP_MR_2.5G and
TXPP_MR_2.5G transponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed
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Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

This task only applies to SONET services.Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or
TXPP_MR_2.5G card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.
Step 3 Modify any of the settings described in the following table.

Table 129: TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Section Trace Settings

OptionsDescriptionParameter

• 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

(Display only) Port number.Port

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is not
disabled)

If an TIM on Section overhead alarm arises
because of a J0 overhead string mismatch,
no alarm indication signal is sent to
downstream nodes if this box is checked.

Disable
AIS/RDI on
TIM-S

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size

String of trace string sizeDisplays the current transmit string; sets a
new transmit string. You can click the button
on the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit
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OptionsDescriptionParameter

String of trace string sizeDisplays the current expected string; sets a
new expected string. You can click the
button on the right to change the display. Its
title changes, based on the current display
mode. Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec check box to keep
this display updated automatically.

Received

Checked/unchecked (default)If checked, automatically refreshes the
display every 5 seconds.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G367 Changing the Multirate Transponder Trunk Wavelength Settings
This task changes the trunk wavelength settings for the TXP_MR_2.5G and
TXPP_MR_2.5G, TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, and TXP_MR_10EX_C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Beforemodifying the wavelength settings, change the port state to OOS,DSBLD (for ANSI) or Locked,disabled
(for ETSI) and delete the circuit and patchcord provisioning present on the port. Payload or communication
channel provisioning can be retained.

Note
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the multirate card where you
want to change the trunk wavelength settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.
Step 3 Modify any of the settings as described in the following table.

Table 130: Multirate Transponder Card Wavelength Trunk Settings

OptionsDescriptionParameter

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

(Display only) Displays the port number.Port

• C—The C-band wavelengths are
available in the Wavelength field.

• L—The L-band wavelengths are
available in the Wavelength field.

Indicates the wavelength band that can be
provisioned. If the physical TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, and TXP_MR_10EX_C
is installed, this field is display-only.

Band

• Even—Displays evenC-band or L-band
wavelengths in the Wavelength field.

• Odd—Displays odd C-band or L-band
wavelengths in the Wavelength field.

Sets the wavelengths available for
provisioning for TXP_MR_10E_C, and
TXP_MR_10E_L cards.

Even/Odd

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU-T
C-band or L-band spacing, depending
on the card that is installed. For
TXP_MR_10G and TXP_MR_10E
cards, the wavelengths carried by the
card are identified with two asterisks.
The wavelengths supported by the
SFPs/XFPs plugged to the card are
identified with two asterisks. Other
wavelengths have a dark grey
background. If the card is not installed,
all wavelengths appear with a dark grey
background.

The wavelength provisioned for the trunk.Wavelength

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G232 Changing the Multirate Transponder SONET or SDH Line Threshold
Settings

This task changes the line threshold settings for TXP_MR_2.5G and
TXPP_MR_2.5G transponder cards carrying OC-3/STM-1, OC-12/STM-4,
and OC-48/STM-16 payloads. You can also use this task to change the line
threshold settings for TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, and TXP_MR_10EX_C transponder cards carrying SONET
or SDH payloads, including the physical 10G Ethernet WAN Phy payload.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the multirate transponder card
where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs.

You must modify Near End and Far End independently; 15 Min and 1 Day independently; and
Line and Section independently. To do so, choose the appropriate radio button and clickRefresh.

Note

Step 3 Modify any of the settings in the following table.

Some parameters and options in the following table do not apply to all the multirate cards. If a
parameter or option does not apply, that parameter or option does not appear in CTC.

Note

Table 131: Multirate Transponder Card Line Thresholds Settings

Options - ETSIOptions - ANSIDescriptionParameter

• 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

• 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

(Display only) Port
number

Port
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Options - ETSIOptions - ANSIDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Path Errored Block
indicates that one or
more bits are in error
within a block

EB

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Coding violationsCV

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Errored secondsES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Severely errored
seconds

SES
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Options - ETSIOptions - ANSIDescriptionParameter

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only) Failure
count

FC

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Near End Section or
Regeneration Section
only) Severely errored
framing seconds

SEFS

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)
for 2.5G cards and Multiplex Section
or Regeneration Section (near end only)
for 10G cards.

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)
for 2.5G cards and Line or Section (near
end only) for 10G cards.

Choose an option in each category and click
Refresh.

Unavailable secondsUAS

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)
for 2.5G cards and Multiplex Section
or Regeneration Section (near end only)
for 10G cards

Choose an option in each category and click
Refresh.

—Background block
errors

BBE
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Options - ETSIOptions - ANSIDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

—(Near End Section or
Regeneration Section
only) Out of frame
seconds

OFS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G320 Changing the 2.5G Multirate Transponder Line RMON Thresholds
This task changes the line remote monitoring (RMON) threshold settings for
TXP_MR_2.5G and TXPP_MR_2.5G transponder cards carrying the 1G
Ethernet or 1G FC/FICON payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In card view, display the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the line threshold
settings.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
Step 3 Click Create. The Create Threshold dialog box appears.
Step 4 From the Port drop-down list, choose the applicable port.
Step 5 From the Variable drop-down list, choose an Ethernet variable. See the following table for a list of available

Ethernet variables.

Table 132: TXP_MR_2.5G and TXPP_MR_2.5G Card 1G Ethernet and 1G FC/FICONThresholds

DescriptionVariable

Number of inbound packets that contained errors preventing them
from being delivered to a higher-layer protocol.

ifInErrors
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Total number of received packets.rxTotalPkts

Number of IETF 8b10b disparity violations on the Fibre Channel line
side.

8b10bStatsEncodingDispErrors

Number of received packets containing idle ordered sets.8b10bIdleOrderedSets

Number of received packets containing non-idle ordered sets.8b10bNonIdleOrderedSets

Number of received packets containing data ordered sets.8b10bDataOrderedSets

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, the
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold
to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total
number of occurrences, regardless of time period.

Step 8 Enter the appropriate number of seconds for the Sample Period.
Step 9 Enter the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.
A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.
Step 12 Return to your originating procedure (NTP).

DLP-G305 Provisioning the 2.5G Multirate Transponder Trunk Port Alarm and
TCA Thresholds

This task changes the TXP_MR_2.5G and TXPP_MR_2.5G trunk port alarm
and threshold crossing alert (TCA) thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Provisioning or higherSecurity Level

In this task, trunk port refers to Port 2 for TXP_MR_2.5G cards, and to Ports 2 and 3 for TXPP_MR_2.5G
cards.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or
TXPP_MR_2.5G card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Pluggable Port Modules tab. Under Pluggable Ports, record the Rate that is
provisioned.

Step 3 Look up the rate in the following table and note whether it is 2R or 3R.

Table 133: 2R and 3R Mode and ITU-T G.709 Compliance by Client Interface

ITU-T G.7093R vs. 2RInput Bit RateClient Interface

On or Off3R2.488 GbpsOC-48/STM-16

—2R2.38 GbpsDV-6000

On or Off3R (no
monitoring)

2.125 Gbps2 Gigabit Fibre Channel (2G-FC)/fiber connectivity
(FICON)

—2R1.48 GbpsHigh-Definition Television (HDTV)

On or Off3R1.25 GbpsGigabit Ethernet (GE)

On or Off3R1.06 Gbps1 Gigabit Fibre Channel (1G-FC)/FICON

On or Off3R622 MbpsOC-12/STM-4

On or Off3R155 MbpsOC-3/STM-1

—2R200 MbpsEnterprise System Connection (ESCON)

—2R270 MbpsSDI/D1 video

Off3R1.06 GbpsISC-1 Compact

—2R1.06 or
2.125 Gbps

ISC-3

—2R16 MbpsETR_CLO

Step 4 Click the Provisioning > Optics Thresholds tabs.
Step 5 Under Types, verify that the TCA radio button is checked. If not, check it and click Refresh.
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Step 6 Referring to the following table, verify the trunk port TCA thresholds for RX Power High and RX Power
Low depending on whether the rate is 2R or 3R. Provision new thresholds as needed by double-clicking the
threshold value you want to change, deleting it, entering a new value, and hitting Enter.

Do not modify the Laser Bias parameters.Note

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Table 134: TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port TCA Thresholds

TCA RX Power HighTCA RX Power LowSignal

–9 dBm–23 dBm3R

–9 dBm–24 dBm2R

Step 7 Click Apply.
Step 8 Under Types, click the Alarm radio button and click Refresh.
Step 9 Verify the trunk port Alarm thresholds for RX Power High is –7 dBm, and for RX Power Low is –26 dBm.

Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and hitting Enter.

Step 10 Click Apply.
Step 11 Return to your originating procedure (NTP).

DLP-G306 Provisioning the 2.5G Multirate Transponder Client Port Alarm and
TCA Thresholds

This task provisions the client port alarm and TCA thresholds for the
TXP_MR_2.5G and TXPP_MR_2.5G cards.

Purpose

NoneTools/Equipment

DLP-G278 Provisioning the Optical Line Rate, on page 317

DLP-G46 Log into CTC

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or
TXPP_MR_2.5G card where you want to change the client port alarm and TCA settings.
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Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Referring to the following table, verify the Port 1 (client) TCA thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low based on the client interface at the other end. Provision new
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a new
value, and hitting Enter.

Do not modify the Laser Bias parameters.Note

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK
Modules, on page 307.

Note

Table 135: TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds

TCA TX
Power High

TCA TX
Power Low

TCA RX
Power High

TCA RX
Power Low

Pluggable Port Module
(SFP)

Port Type (by
CTC)

–2–21–8–2315454-SFP3-1-IROC-3

–2–21–10–2415454E-SFP-L.1.1STM-1

–2–21–7–2815454-SFP12-4-IROC-12

–2–21–8–2815454E-SFP-L.4.1STM-4

3–16–3–18ONS-SE-2G-S1OC-48

6–110–1815454-SFP-OC48-IR

3–16–3–18ONS-SE-2G-S1

15454E-SFP-L.16.1

STM-16

3–160–1715454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

ONE_GE

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–8–35–14–2115454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

ESCON

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
360

Provisioning Transponder and Muxponder Cards
DLP-G306 Provisioning the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds



TCA TX
Power High

TCA TX
Power Low

TCA RX
Power High

TCA RX
Power Low

Pluggable Port Module
(SFP)

Port Type (by
CTC)

6–110–1815454-SFP-OC48-IRDV6000

3–16–3–1815454E-SFP-L.16.1

–2–21–7–2815454-SFP12-4-IRSDI_D1_
VIDEO

–2–21–8–2815454E-SFP-L.4.1

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

HDTV

————2R MODE (not
specified)

PASS-THRU

3–160–1715454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC1G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1515454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC2G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1715454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON1G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1515454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON2G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1715454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

ETR_CLO

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
361

Provisioning Transponder and Muxponder Cards
DLP-G306 Provisioning the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds



TCA TX
Power High

TCA TX
Power Low

TCA RX
Power High

TCA RX
Power Low

Pluggable Port Module
(SFP)

Port Type (by
CTC)

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

ISC compat

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

ISC peer

Step 4 Click Apply.
Step 5 Under Types, click the Alarm radio button and click Refresh.
Step 6 Referring to the following table, verify the Alarm thresholds for RX Power High, RX Power Low, TX Power

High, and TX Power Low based on the client interface that is provisioned. Provision new thresholds as needed
by double-clicking the threshold value you want to change, deleting it, entering a new value, and hittingEnter.

Table 136: TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm Thresholds

Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module
(SFP)

Port Type (by
CTC)

–6–17–5–2615454-SFP3-1-IROC-3

–6–17–7–2715454E-SFP-L.1.1STM-1

–6–17–4–3115454-SFP12-4-IROC-12

–6–17–5–3115454E-SFP-L.4.1STM-4

–1–120–21ONS-SE-2G-S1OC-48

2–73–2115454-SFP-OC48-IR

–1–120–21ONS-SE-2G-S1

15454E-SFP-L.16.1

STM-16

–2–123–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

ONE_GE

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–12–31–11–2415454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

ESCON

2–73–2115454-SFP-OC48-IRDV6000

–5–120–2115454E-SFP-L.16.1
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Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module
(SFP)

Port Type (by
CTC)

–6–17–4–3115454-SFP12-4-IRSDI_D1_
VIDEO

–6–17–5–3115454E-SFP-L.4.1

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

HDTV

————2R MODE (not
specified)

PASS-THRU

–2–123–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC1G

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–2–123–1815454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC2G

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–2–123–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON1G

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–2–123–1815454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON2G

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–2–123–2015454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

ETR_CLO

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

ISC compat
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Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module
(SFP)

Port Type (by
CTC)

–1–120–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

ISC peer

Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).

DLP-G234 Changing the Multirate Transponder OTN Settings
This task changes the OTN settings for the TXP_MR_2.5G, TXPP_MR_2.5G,
TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
TXP_MR_10EX_C, 40E-TXP-C, and 40ME-TXP-C transponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the OTN settings.

Step 2 Click the Provisioning >OTN tabs, then choose one of the following subtabs:OTN Lines,G.709 Thresholds,
FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in the following tables.

You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM settings
independently. To do so, choose the appropriate radio button and click Refresh.

Note

Table 137: Multirate Transponder Card OTN Line Settings

OptionsDescriptionParameter

• 1 (only when data rate is set to OTU3)

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

(Display only) Displays the port number.Port
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OptionsDescriptionParameter

• Enable

• Disable

Sets the OTN lines according to
ITU-TG.709. For TXP-MR-10EX_C cards,
the G.709 OTN should be enabled.

G.709 OTN

• Enable—FEC is on.

• Disable—FEC is off.

• Standard—(TXP_MR_10E,
40E-TXP-C, and 40ME-TXP-C only)
Standard FEC is on.

• Enhanced—(TXP_MR_10E,
40E-TXP-C, and 40ME-TXP-C only)
Enhanced FEC is on.

Sets the OTN lines to forward error
correction (FEC). FEC mode can be
Disabled, Enabled, or, Enhanced FECmode
can be enabled to provide greater range and
lower bit error rate. For TXP_MR_10E,
40E-TXP-C, and 40ME-TXP-C cards,
Standard is the same as enabling FEC. For
TXP-MR-10EX_C cards, the FEC should
be enabled.

FEC

• 1E-5(Display only) The signal fail bit error rate.SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• Asynch mapping

• Synch mapping

(TXP_MR_10E only) Sets how the ODUk
(client payload) is mapped to the optical
channel (OTUk).

Asynch/Synch
Mapping

Table 138: Multirate Transponder Card ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

(Display only) Port number.Port

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

SM (OTUk) is the ITU-T G.709 optical
channel transport unit order of k overhead
frame used for management and
performance monitoring. PM (ODUk) is
the ITU-T G.709 optical channel data unit
order of k overhead frame unit used for
path performance monitoring.

Note

Errored secondsES
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OptionsDescriptionParameter

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Severely errored secondsSES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Unavailable secondsUAS

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Background block errorsBBE

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Failure counterFC

Latency for a 1G-FC payload without ITU-T G.709 is 4 microseconds, and with ITU-T G.709 is
40 microseconds. Latency for a 2G-FC payload without ITU-T G.709 is 2 microseconds, and
with ITU-T G.709 is 20 microseconds. Consider these values when planning a FC network that
is sensitive to latency.

Note

Table 139: Multirate Transponder Card FEC Threshold Settings

OptionsDescriptionParameter

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

(Display only) Port number.Port

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for bit errors corrected during
the selected time period.

Bit Errors
Corrected

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for uncorrectable words during
the selected time period.

Uncorrectable
Words

Table 140: MultirateTransponder Card Trail Trace Identifier Settings

OptionsDescriptionParameter

• 1 (OTU3) for 40E-TXP-C and
40ME-TXP-C cards

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

(Display only) Port number.Port

• Section

• Path

Sets the level.Level
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OptionsDescriptionParameter

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is
enabled)

If a TIM on Section overhead alarm is raised
because of a J0 overhead string mismatch,
no alarm indication signal is sent to
downstream nodes if this box is checked.

Disable
AIS/RDI on
TIM-S

String of trace string size; trail trace
identifier is 64 bytes in length.

Displays the current transmit string; sets a
new transmit string. You can click the button
on the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex Mode).

Transmit

String of trace string sizeDisplays the current expected string; sets a
new expected string. You can click the
button on the right to change the display. Its
title changes, based on the current display
mode. Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex Mode).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec check box to keep
this panel updated.

Received

Checked/unchecked (default)If checked, automatically refreshes the
display every 5 minutes.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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NTP-G96 Provisioning the 10G Multirate Transponder Card Line
Settings, PM Parameters, and Thresholds

This procedure changes the line and threshold settings for 10G multirate
transponder cards including the TXP_MR_10G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

The TXP_MR_10G card does not support PPMs.Note

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database to preserve the existing transmission settings.
Step 2 If you are provisioning a TXP_MR_10G card, complete the DLP-G365 Provisioning the TXP_MR_10GData

Rate, on page 369, and if you are provisioning a TXP_MR_10E or TXP_MR_10EX_C card, complete the
DLP-G712 Provisioning the TXP_MR_10E or TXP_MR_10EX_C Data Rate, on page 369. If not, continue
with the next step.

Step 3 Perform any of the following tasks as needed:

• DLP-G229 Changing the 2.5G or 10G Transponder Card Settings, on page 345

• DLP-G217 Changing the 10G Multirate Transponder Line Settings, on page 370

• DLP-G218 Changing the 10G or 40G Multirate Transponder Line Section Trace Settings, on page 375

• DLP-G232 Changing the Multirate Transponder SONET or SDH Line Threshold Settings, on page 353

• DLP-G319 Changing the 10G Multirate Transponder Line RMON Thresholds for 10G Ethernet LAN
Phy Payloads, on page 377
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• DLP-G301 Provisioning the 10G Multirate Transponder Trunk Port Alarm and TCA Thresholds, on
page 380

• DLP-G302 Provisioning the 10G Multirate Transponder Client Port Alarm and TCA Thresholds, on
page 382

• DLP-G234 Changing the Multirate Transponder OTN Settings, on page 364

• DLP-G367 Changing the Multirate Transponder Trunk Wavelength Settings, on page 351

Stop. You have completed this procedure.

DLP-G365 Provisioning the TXP_MR_10G Data Rate
This task changes the TXP_MR_10G card data rate.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G card where
you want to change the card data rate settings.

Step 2 Click the Provisioning > Data Rate Selection tabs.
Step 3 Click Create.
Step 4 In the Create Port dialog box, choose one of the following data rates:

• SONET (ANSI) or SDH (ETSI) (including 10G Ethernet WAN Phy)

• 10G Ethernet LAN Phy

Step 5 Click Ok.
Step 6 Return to your originating procedure (NTP).

DLP-G712 Provisioning the TXP_MR_10E or TXP_MR_10EX_C Data Rate
This task changes the TXP_MR_10E or TXP_MR_10EX_C card data rate.Purpose

NoneTools/Equipment

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
369

Provisioning Transponder and Muxponder Cards
DLP-G365 Provisioning the TXP_MR_10G Data Rate

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10E or
TXP_MR_10EX_C card where you want to change the card data rate settings.

Step 2 Click the Provisioning > Pluggable Port Modules tabs.
Step 3 In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.
Step 4 In the Create PPM dialog box, complete the following:

• PPM—Choose the SFP you want to install from the drop-down list.

• PPM Type—Choose the number of ports supported by your SFP from the drop-down list. If only one
port is supported, PPM (1 port) is the only option.

Step 5 Click OK. The newly created PPM appears in the Pluggable Port Modules area. The row in the Pluggable
Port Modules area turns white and the Actual Equipment Type column lists the equipment name.

Step 6 In the Pluggable Ports area, click Create. The Create Ports dialog box appears.
Step 7 In the Create Port dialog box, choose one of the following data rates:

• SONET (ANSI) or SDH (ETSI) (including 10G Ethernet WAN Phy)

• 10G Ethernet LAN Phy

• 10G FIBER Channel

• (TXP-MR-10EX_C card only) IB_5G

Step 8 Click OK.
Step 9 Return to your originating procedure (NTP).

DLP-G217 Changing the 10G Multirate Transponder Line Settings
This task changes the line settings for TXP_MR_10G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to change
the line settings.

Step 2 Click the Provisioning > Line > SONET/SDH/Ethernet tabs. SONET is the option for ANSI shelves when
10G Ethernet WAN phy is the Pluggable Port Rate, SDH is the option for ETSI shelves when 10G Ethernet
WAN phy is the Pluggable Port Rate, and Ethernet is the option for ANSI or ETSI shelves when 10GE LAN
Phy is the Pluggable Port Rate.

Step 3 Modify any of the settings described in the following table.

In the following table, some parameter tabs do not always apply to all 10G multirate transponder
cards. If a tab does not apply, it will not appear in CTC.

Note

Table 141: TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Line Settings

ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• 1 (STM-64) (10G EthernetWANPhy)
(if TXP_MR_10G)

• 1 (TEN_GE) (if Ethernet LAN is
provisioned on the TXP_MR_10G
card)

• 1-1 (STM-64) (10G Ethernet WAN
Phy on the TXP_MR_10E card)

• 1-1 (TEN_GE) (if Ethernet LAN is
provisioned on the TXP_MR_10E
card)

• 1-1 (FC10G) (if 10G fiber channel is
provisioned on the TXP_MR_10E
card)

• 2 (Trunk)

• (TXP_MR_10EX_C only) IB_5G

• 1 (OC192) (10G EthernetWANPhy)
(if TXP_MR_10G)

• 1 (TEN_GE) (if Ethernet LAN is
provisioned on the TXP_MR_10G
card)

• 1-1 (OC192) (10G Ethernet WAN
Phy on the TXP_MR_10E card)

• 1-1 (TEN_GE) (if Ethernet LAN is
provisioned on the TXP_MR_10E
card)

• 1-1 (FC10G) (if 10G fiber channel is
provisioned on the TXP_MR_10E
card)

• 2 (Trunk)

• (TXP_MR_10EX_C only) IB_5G

(Display only) Displays
the port number.

Port

User-defined. Name can be up to
80 alphanumeric/special characters. Blank
by default.

User-defined. Name can be up to
80 alphanumeric/special characters. Blank
by default.

Provides the ability to
assign the specified
port a name.

Port Name
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• Unlocked

• Unlocked,automaticInService

• Locked,disabled

• Locked,maintenance

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

Sets the port service
state. For more
information about
administrative states,
see the Administrative
and Service States
document.

Admin State

• Unlocked-enabled

• Unlocked-disabled, automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenance

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

(Display only)
Identifies the
autonomously
generated state that
gives the overall
condition of the port.
Service states appear in
the format: Primary
State-Primary State
Qualifier, Secondary
State. For more
information about
service states, see the
Administrative and
Service States
document.

Service State

• 1E-3

• 1E-4

• 1E-5

• 1E-3

• 1E-4

• 1E-5

(SONET [ANSI] or
SDH [ETSI] including
10G Ethernet WAN
Phy only) Sets the
signal fail bit error rate.

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

(SONET [ANSI] or
SDH [ETSI] including
10G Ethernet WAN
Phy only) Sets the
signal degrade bit error
rate.

SD BER

• SONET

• SDH

• SONET

• SDH

(SONET [ANSI] or
SDH [ETSI] including
10G Ethernet WAN
Phy only) The optical
transport type.

Type
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• Disabled (default): ALS is off; the
laser is not automatically shut down
when traffic outages (LOS) occur.

• Auto Restart: ALS is on; the laser
automatically shuts down when traffic
outages (LOS) occur. It automatically
restarts when the conditions that
caused the outage are resolved.

• Manual Restart: ALS is on; the laser
automatically shuts down when traffic
outages (LOS) occur. However, the
laser must be manually restarted when
conditions that caused the outage are
resolved.

• Manual Restart for Test: Manually
restarts the laser for testing.

• Disabled (default): ALS is off; the
laser is not automatically shut down
when traffic outages (LOS) occur.

• Auto Restart: ALS is on; the laser
automatically shuts down when
traffic outages (LOS) occur. It
automatically restarts when the
conditions that caused the outage are
resolved.

• Manual Restart: ALS is on; the laser
automatically shuts down when
traffic outages (LOS) occur.
However, the laser must be manually
restarted when conditions that caused
the outage are resolved.

• Manual Restart for Test: Manually
restarts the laser for testing.

Sets the ALS function
mode. The DWDM
transmitter supports
ALS according to
ITU-T G.644 (06/99).
ALS can be disabled,
or it can be set for one
of three mode options.

ALS Mode

• Duration of valid input signal, in
hh.mm format, after which the card
becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments

• Duration of valid input signal, in
hh.mm format, after which the card
becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments

(SONET [ANSI] or
SDH [ETSI] including
10G Ethernet WAN
Phy only) Sets the
automatic in-service
soak period.
Double-click the time
and use the up and
down arrows to change
settings.

AINS Soak

Checked or uncheckedChecked or unchecked(TXP_MR_10E,
OC192 only) Sets the
ProvidesSync card
parameter. If checked,
the card is provisioned
as a network element
(NE) timing reference.

ProvidesSync

Checked or uncheckedChecked or unchecked(TXP_MR_10E,
OC192 only) Sets the
EnableSync card
parameter. Enables
synchronization status
messages (S1 byte),
which allow the node
to choose the best
timing source.

SyncMsgIn
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• 1548 bytes

• Jumbo (1518 to 9216 bytes)

• 1548 bytes

• Jumbo (1518 to 9216 bytes)

(TXP_MR_10E,
TXP_MR_10G LAN
Phy only) Sets the
maximum Ethernet
packet size.

Max Size

Value of MAC address. Six bytes in
hexadecimal format.

Value of MAC address. Six bytes in
hexadecimal format.

(TXP_MR_10E,
TXP_MR_10G LAN
Phy only) Sets the
incoming MAC
address.

IncomingMAC
Address

• First Tunable Wavelength

• Further wavelengths: 1310 nm through
1560.61 nm, 100-GHz ITU spacing;
coarse wavelength division
multiplexing (CWDM) spacing

Note: supported wavelengths are marked
by asterisks (**)

• First Tunable Wavelength

• Further wavelengths: 1310 nm
through 1560.61 nm, 100-GHz ITU
spacing; coarse wavelength division
multiplexing (CWDM) spacing

Note: supported wavelengths are marked
by asterisks (**)

Displays the
wavelength of the client
port.

Wavelength

The Reach options depend on the traffic
type that has been selected.

The Reach options depend on the traffic
type that has been selected.

Displays the optical
reach distance of the
client port.

Reach

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
374

Provisioning Transponder and Muxponder Cards
DLP-G217 Changing the 10G Multirate Transponder Line Settings



ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• Disable (0 ms) - Default value

• 50 ms

• 100 ms

• 250 ms

• 500 ms

• Disable (0 ms) - Default value

• 50 ms

• 100 ms

• 250 ms

• 500 ms

(Only for
TXP_MR_10E card)
Sets the period in
milliseconds that the
client interface waits
for resolution of issues
on the trunk side. The
client squelching starts
after this period.

The user can configure
the squelch hold off
timer in CTC only
under the following
conditions:

• The card must be
configured in TXP
or MXP operating
modes.

• The client payload
must be 10GE or
100GE.

• The Squelch
drop-down in
CTC must be set
to Squelch.

Squelch Hold
Off Timer

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G218 Changing the 10G or 40G Multirate Transponder Line Section Trace
Settings

This task changes the line section trace settings for the TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_10EX_C,
40E-TXP-C, and 40ME-TXP-C transponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.

The Section Trace tab is available for the 10G Multirate Transponder cards only if no PPMs are
provisioned, or the OC192 PPM is provisioned. The tab is not available if a 10G Ethernet LAN
Phy or 10G Fibre Channel PPM is provisioned.

Note

Step 3 Modify any of the settings described in the following table.

Table 142: 10G or 40G Card Section Trace Settings

SDH OptionsSONET OptionsDescriptionParameter

• 1-1 (STM64) and
2—Trunk for 10G cards

• 1 (STM-256) and 2
(STM-256) for 40G cards

• 1-1 (OC192) and
2—Trunk for 10G cards

• 1 (OC-768) and 2
(OC-768) for 40G cards

Sets the port number.Port

• Off/None

• Manual

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• 1 byte

• 16 byte

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size

String of trace string sizeString of trace string sizeDisplays the current transmit string; sets a new
transmit string. You can click the button on the
right to change the display. Its title changes,
based on the current display mode. In Transmit
String Type, click Hex Mode to change the
display to hexadecimal (button changes to
ASCII); click ASCII to change the display to
ASCII (button changes to Hex Mode).The
supported range for 1 bit Hex TX trace is 20
to 7E. If TX trace is provisioned outside this
range, client transmits 00.

Transmit

• Checked (AIS/RDI on
TIM-S is disabled)

• Unchecked (AIS/RDI on
TIM-S is not disabled)

• Checked (AIS/RDI on
TIM-S is disabled)

• Unchecked (AIS/RDI on
TIM-S is not disabled)

If an TIM on Section overhead alarm arises
because of a J0 overhead string mismatch, no
alarm indication signal is sent to downstream
nodes if this box is checked.

Disable
AIS/RDI on
TIM-S

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
376

Provisioning Transponder and Muxponder Cards
DLP-G218 Changing the 10G or 40G Multirate Transponder Line Section Trace Settings



SDH OptionsSONET OptionsDescriptionParameter

String of trace string sizeString of trace string sizeDisplays the current expected string; sets a new
expected string. You can click thebutton on the
right to change the display. Its title changes,
based on the current display mode. In Expected
String Type, click Hex Mode to change the
display to hexadecimal (button changes to
ASCII); click ASCII to change the display to
ASCII (button changes to Hex Mode).

Expected

String of trace string sizeString of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the Auto-refresh
every 5 sec check box to keep this panel
updated.

Received

Checked/unchecked (default)Checked/unchecked (default)If checked, automatically refreshes the display
every 5 seconds.

Auto-refresh

Step 4 Click Apply.
Step 5 Click Default to restore default values.
Step 6 Return to your originating procedure (NTP).

DLP-G319 Changing the 10G Multirate Transponder Line RMON Thresholds for
10G Ethernet LAN Phy Payloads

This task changes the line threshold settings for TXP_MR_10G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C transponder
cards carrying the physical 10G Ethernet LAN payload.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 Display the TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C
card where you want to change the line threshold settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
377

Provisioning Transponder and Muxponder Cards
DLP-G319 Changing the 10G Multirate Transponder Line RMON Thresholds for 10G Ethernet LAN Phy Payloads

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Step 3 Click Create. The Create Threshold dialog box appears.
Step 4 From the Port drop-down list, choose the applicable port.
Step 5 From the Variable drop-down list, choose an Ethernet variable. See the following table for a list of available

Ethernet variables.

Table 143: TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card GE LAN Phy Variables

DescriptionVariable

Total number of octets received on the interface, including framing
characters.

ifInOctets

Total number of received packets.rxTotalPkts

Number of multicast frames received error free.ifInMulticastPkts

Number of packets, delivered by a sublayer to an higher sublayer, that
were addressed to a broadcast address at this sublayer.

ifInBroadcastPkts

Number of inbound packets that contained errors preventing them from
being delivered to a higher-layer protocol.

ifInErrors

Number of receive error bytes.ifInErrorBytePkts (TXP_MR_10G
only)

Number of receive framing error counters.ifInFramingErrorPkts
(TXP_MR_10G only)

Number of receive interpacket junk counters.ifInJunkInterPkts (TXP_MR_10G
only)

Total number of octets transmitted out of the interface, including framing
characters.

ifOutOctets (TXP_MR_10G only)

Total number of transmit packets.txTotalPkts (TXP_MR_10G only)

Number of multicast frames transmitted error free.ifOutMulticastPkts (TXP_MR_10G
only)

Total number of packets that higher-level protocols requested be
transmitted, and that were addressed to a broadcast address at this
sublayer, including those that were discarded or not sent.

ifOutBroadcastPkts (TXP_MR_10G
only)

Number of frames with frame check errors, that is, there is an integral
number of octets, but an incorrect Frame Check Sequence (FCS).

dot3StatsFCSErrors

Number of received frames that were larger than the maximum size
permitted.

dot3StatsFrameTooLong
(TXP_MR_10G only)

Total number of packets received that were less than 64 octets long
(excluding framing bits, but including FCS octets) and were otherwise
well formed.

etherStatsUndersizePkts
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Total number of packets received that were less than 64 octets in length
(excluding framing bits but including FCS octets) and had either a bad
FCS with an integral number of octets (FCS Error) or a bad FCS with
a non-integral number of octets (Alignment Error). Note that it is entirely
normal for etherStatsFragments to increment. This is because it counts
both runts (which are normal occurrences due to collisions) and noise
hits.

etherStatsFragments

Total number of packets (including bad packets) received that were 64
octets in length (excluding framing bits but including FCS octets).

etherStatsPkts64Octets

Total number of packets (including bad packets) received that were
between 65 and 127 octets in length inclusive (excluding framing bits
but including FCS octets).

etherStatsPkts65to127Octets

The total number of packets (including bad packets) received that were
between 128 and 255 octets in length inclusive (excluding framing bits
but including FCS octets).

etherStatsPkts128to255Octets

Total number of packets (including bad packets) received that were
between 256 and 511 octets in length inclusive (excluding framing bits
but including FCS octets).

etherStatsPkts256to511Octets

Total number of packets (including bad packets) received that were
between 512 and 1023 octets in length inclusive (excluding framing bits
but including FCS octets).

etherStatsPkts512to1023Octets

Total number of packets (including bad packets) received that were
between 1024 and 1518 octets in length inclusive (excluding framing
bits but including FCS octets).

etherStatsPkts1024to1518Octets

Total number of good packets received that were directed to the broadcast
address. Note that this does not include multicast packets.

etherStatsBroadcastPkts

Total number of good packets received that were directed to a multicast
address. Note that this number does not include packets directed to the
broadcast address.

etherStatsMulticastPkts

The total number of packets received that were longer than 1518 octets
(excluding framing bits, but including FCS octets) and were otherwise
well formed.

etherStatsOversizePkts

Total number of packets received that were longer than 1518 octets
(excluding framing bits, but including FCS octets), and had either a bad
FCS with an integral number of octets (FCS Error) or a bad FCS with
a nonintegral number of octets (Alignment Error).

etherStatsJabbers

Total number of octets of data (including those in bad packets) received
on the network (excluding framing bits but including FCS octets).

etherStatsOctets
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Total number of packets received that had a length (excluding framing
bits, but including FCS octets) of between 64 and 1518 octets, inclusive,
but had either a bad FCS with an integral number of octets (FCS Error)
or a bad FCS with a non-integral number of octets (Alignment Error).

etherStatsCRCAlignErrors
(TXP_MR_10G only)

Number of received IETF 802.x pause frames.rxPauseFrames (TXP_MR_10G
only)

Number of MAC control frames passed by the MAC sublayer to the
MAC control sublayer.

rxControlFrames

Number of MAC control frames received that contain an opcode that is
not supported by the device.

rxUnknownOpcodeFrames
(TXP_MR_10G only)

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, the
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold
to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total
number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.
Step 9 Type in the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.

To view all RMON thresholds, click Show All RMON thresholds.Note

Step 12 Return to your originating procedure (NTP).

DLP-G301 Provisioning the 10G Multirate Transponder Trunk Port Alarm and
TCA Thresholds

This task provisions the TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, or TXP_MR_10EX_C trunk port alarm and threshold cross
alert (TCA) thresholds.

Purpose
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NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to change
the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.
Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.
Step 4 Referring to the following table, verify the trunk port (Port 2) TCA thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the
threshold value you want to change, deleting the existing value, and entering the new value. Hit Enter, then
click Apply.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

Table 144: 10G Multirate Transponder Trunk Port TCA Thresholds

TCA TX

Power Low

TCA TX

Power High

TCA RX

Power Low

TCA RX

Power High

Card

–1 dBm7 dBm–18 dBm–8 dBmTXP_MR_10G

0 dBm9 dBm–18 dBm–9 dBmTXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_10EX_C

Step 5 Click Apply.
Step 6 Under Types, click the Alarm radio button and click Refresh.
Step 7 Referring to the following table, verify the trunk port (Port 2) Alarm thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the
threshold value you want to change, deleting the existing value, and entering the new value. Hit Enter, then
click Apply.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note
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Table 145: 10G Multirate Transponder Trunk Port Alarm Thresholds

Alarm TX

Power Low

Alarm TX

Power High

Alarm RX

Power Low

Alarm RX

Power High

Card

2 dBm4 dBm–20 dBm–8 dBmTXP_MR_10G

3 dBm7 dBm–20 dBm–8 dBmTXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_10EX_C

Step 8 Click Apply.
Step 9 Return to your originating procedure (NTP).

DLP-G302 Provisioning the 10G Multirate Transponder Client Port Alarm and
TCA Thresholds

This task provisions the client port alarm and TCA thresholds for the
TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and
TXP_MR_10EX_C cards.

Purpose

NoneTools/Equipment

DLP-G278 Provisioning the Optical Line Rate, on page 317

DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to change
the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.
Step 4 Referring to the following table, verify the Port 1 (Client) TCA thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low based on the client interface at the other end. Provision new
thresholds as needed by double-clicking the threshold value you want to change, deleting the existing value,
and entering the new value. Hit Enter, then click Apply.
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You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK
Modules, on page 307.

Note

Table 146: TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card Client Interface TCA Thresholds

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port
Module (XFP)

Pluggable Port
Rate

–6–1–11–1TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G (XFP
not present)

SONET (or SDH)

–6–1–14.40.5TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G (XFP
not present)

10GEthernet LAN
Phy

–6–1–14.40.5TXP_MR_10E uses
ONS-XC-10G-S1

10G Fibre Channel

12.05.0–14.01.0TXP_MR_10EX_C
uses
ONS-XC-10G-S1
Version 3

IB_5G (Only the
TXP_MR_10EX_C
card supports
IB_5G)

Step 5 Click Apply.
Step 6 Under Types, click the Alarm radio button and click Refresh.
Step 7 Referring to the following table, provision the Port 1 (Client) Alarm thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low based on the client interface that is provisioned.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note
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Table 147: TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card Client Interface Alarm Thresholds

Alarm TX
Power Low

Alarm TX
Power High

Alarm RX
Power Low

Alarm RX
Power High

Pluggable Port
Module (XFP)

Pluggable Port
Rate

–81–163TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G (XFP
not present)

SONET (or SDH)

–81–163TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G (XFP
not present)

10GEthernet LAN
Phy

–81–163TXP_MR_10E uses
ONS-XC-10G-S1

10G Fibre Channel

–81.0–163.0TXP_MR_10EX_C
uses
ONS-XC-10G-S1
Version 3

IB_5G (Only the
TXP_MR_10EX_C
card supports
IB_5G)

Step 8 Click Apply.
Step 9 Return to your originating procedure (NTP).

NTP-G292 Provisioning the 40G Multirate Transponder Card
Line Settings, PM Parameters, and Thresholds

This procedure changes the line settings, PM parameters, and threshold settings
for 40G multirate transponder cards (40E-TXP-C, 40ME-TXP-C).

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
384

Provisioning Transponder and Muxponder Cards
NTP-G292 Provisioning the 40G Multirate Transponder Card Line Settings, PM Parameters, and Thresholds

http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_01110.html#ID1284
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/spares/gbic/guides/b_ons_pluggables.html#task_803FF34295774FFB888692369A11B34D
http://www.cisco.com/en/US/docs/optical/spares/gbic/guides/b_ons_pluggables.html#task_87FDF5F52722407DA4C3E0CAE6C9D3B5


Provisioning or higherSecurity Level

The 40E-TXP-C and 40ME-TXP-C cards do not support PPMs.Note

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task to preserve the existing transmission
settings.

Step 2 If you are provisioning a 40E-TXP-C or 40ME-TXP-C card, complete the DLP-G656 Provisioning the
40E-TXP-C and 40ME-TXP-C Data Rate, on page 385 task. If not, continue with the next step.

Step 3 Perform any of the following tasks as needed:

• DLP-G657 Changing the 40G Multirate Transponder Card Settings, on page 386

• DLP-G658 Changing the 40G Multirate Transponder Line Settings, on page 387

• DLP-G659 Changing the 40G Multirate Transponder SONET, SDH, or Ethernet Line Settings, on page
389

• DLP-G218 Changing the 10G or 40G Multirate Transponder Line Section Trace Settings, on page 375

• DLP-G661 Changing the 40GMultirate Transponder Line Thresholds for SONET or SDH Payloads, on
page 395

• DLP-G663 Provisioning the 40G Multirate Transponder Trunk Port Alarm and TCA Thresholds, on
page 397

• DLP-G664 Provisioning the 40G Multirate Transponder Client Port Alarm and TCA Thresholds, on
page 398

• DLP-G234 Changing the Multirate Transponder OTN Settings, on page 364

Stop. You have completed this procedure.

DLP-G656 Provisioning the 40E-TXP-C and 40ME-TXP-C Data Rate
This task changes the 40E-TXP-C and 40ME-TXP-C card data rate.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card where
you want to change the card data rate settings.

Step 2 Click the Provisioning > Data Rate Selection tabs.
Step 3 Click Create.
Step 4 In the Create Port dialog box, choose one of the following data rates:

• SONET (ANSI) OC-768 or SDH (ETSI) STM-256

• 40G Ethernet LAN Phy (only when overclock mode is ON)

• OTU3

Step 5 Click OK.
Step 6 Return to your originating procedure (NTP).

DLP-G657 Changing the 40G Multirate Transponder Card Settings
This task changes the card settings of the 40E-TXP-C and 40ME-TXP-C cards.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card where
you want to change the card settings.

Step 2 Click the Provisioning > Card tabs.
Step 3 Modify any of the settings described in the following table.
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Table 148: 40E-TXP-C and 40ME-TXP-C Card Settings

ETSI OptionsANSI OptionsDescriptionParameter

• None

• 1

• 2

• 3

• 4

• 5

• 12

• 13

• 14

• 15

• 16

• None

• 1

• 2

• 3

• 4

• 5

• 12

• 13

• 14

• 15

• 16

Sets the slot containing another 40E-TXP-C or
40ME-TXP-C card to create a regeneration peer
group. A regeneration peer group facilitates the
management of two 40E-TXP-Cor 40ME-TXP-C
cards that are needed to perform a complete
signal regeneration.

The regeneration peer group synchronizes
provisioning of the two cards. Payload type and
ITU-T G.709 optical transport network (OTN)
changes made on one 40E-TXP-C or
40ME-TXP-C card is reflected on the peer
40E-TXP-C or 40ME-TXP-C card.

Y-cable protection groups cannot
be created on TXP cards that are in
a regeneration peer group.

Note

Regeneration
Peer Slot

——(Display only) The regeneration peer group name.Regeneration
Group Name

——(Display only) Shows the supported wavelengths
of the trunk port after the card is installed. The
40E-TXP-C, or 40ME-TXP-C that is installed
shows the C-band wavelengths that it supports.

Trunk
Wavelengths

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G658 Changing the 40G Multirate Transponder Line Settings
This task changes the line settings of the 40E-TXP-C and 40ME-TXP-C cards.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card where
you want to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs.
Step 3 Modify any of the settings for the Client tab as described in the following table.

Table 149: Line Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

OptionsDescriptionParameter

1 and 2(Display only) Displays the port number.Port

User-defined. The port name can be up to 80 alphanumeric or
special characters, or both. The port name is blank by default.

Assigns a logical name for each of the ports
shown by filling in this field.

Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about service states, see the
Administrative and Service States document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)

(Display only) Identifies the autonomously
generated state that gives the overall condition
of the port. Service states appear in the format:
Primary State-Primary State Qualifier,
Secondary State. For more information about
service states, see the Administrative and
Service States document.

Service State

• Disabled (default)—ALS is off; the laser is not automatically
shut down when traffic outage or loss of signal (LOS) occurs.

• Auto Restart: (OC-768/STM-256/OTU-3 only) ALS is on;
the laser automatically shuts downwhen traffic outages (LOS)
occur. It automatically restarts when the conditions that caused
the outage are resolved.

• Manual Restart—ALS is on; the laser automatically shuts
down when traffic outage or LOS occurs. However, the laser
must be manually restarted when conditions that caused the
outage are resolved.

• Manual Restart for Test—Manually restarts the laser for
testing.

(Client port only) Sets the ALS functionmode.ALS Mode

• Autoprovision—(trunk port only) The system automatically
provisions the reach.

• VSR—(client port only) The system provisions very short
reach (VSR) for the port.

(Display only) Displays the optical reach
distance of the port.

Reach
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OptionsDescriptionParameter

• First Tunable Wavelength

• Further wavelengths: Further wavelengths in 100-GHz ITU-T
C-band spacing. The wavelengths carried by the card are
identified with two asterisks. If the card is not installed, all
wavelengths appear with a dark grey background.

Provisions the wavelength for the port.Wavelength

• Squelch/Laser-Off

• AIS/Send Local Fault

• Disable/Transparent

Both Squelch/Laser-Off and AIS/Send Local
Fault options are supported when the selected
Termination Mode is Transparent. If the
Termination Mode selected is Section or Line,
then only AIS/Send Local Fault is supported.
This is applicable for OC-192/STM-64 and
OC-768/STM-256. For OTN payloads, both
Squelch/Laser-Off and AIS/Send Local Fault
options are supported.

Note

(Display only) Applicable only to client port
1. When the termination mode is set to
transparent, Squelch/Laser-Off is enabled. For
section/line terminationmode, AIS/Send Local
Fault is enabled. For trunk port,
Squelch/Laser-Off is disabled.

Fault Signalling

• OFF (default)

• ON

Enables or disables overclock mode on trunk
port.

Overclock

• First Tunable Wavelength

• Further wavelengths: Further wavelengths in 100-GHz ITU-T
C-band spacing. The wavelengths carried by the card are
identified with two asterisks. If the card is not installed, all
wavelengths appear with a dark grey background.

Provisions the wavelength of the trunk port.Rx Wavelength

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G659 Changing the 40G Multirate Transponder SONET, SDH, or Ethernet
Line Settings

This task changes the SONET, SDH, or Ethernet line settings for 40E-TXP-C
and 40ME-TXP-C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card where
you want to change the SONET, SDH, or Ethernet line settings.

Step 2 Click the Provisioning > Line > SONET/SDH/Ethernet tabs.
Step 3 Modify any of the settings described in the following table.

In the following table, some parameter tabs do not always apply to all 40G multirate transponder
cards. If a tab does not apply, it will not appear in CTC.

Note

Table 150: SONET, SDH Line Settings of the 40E-TXP-C and 40ME-TXP-C Cards

ETSI OptionsANSI OptionsDescriptionParameter

• 1 (STM-256)

• 1 (40G Ethernet LAN
Phy)

• 1 (OTU3)

• 1 (OC-768)

• 1 (40G Ethernet LAN Phy)

• 1 (OTU3)

(Display only) Displays the port
number.

Port

• 1E-3

• 1E-4

• 1E-5

• 1E-3

• 1E-4

• 1E-5

(SONET [ANSI] or SDH [ETSI] only)
Sets the signal fail bit error rate.

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

(SONET [ANSI] or SDH [ETSI] only)
Sets the signal degrade bit error rate.

SD BER

Checked or uncheckedChecked or unchecked(OC-768/STM-256 only) Sets the
ProvidesSync card parameter. If
checked, the card is provisioned as a
network element (NE) timing
reference.

ProvidesSync
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ETSI OptionsANSI OptionsDescriptionParameter

Checked or uncheckedChecked or unchecked(OC-768/STM-256 only) Sets the
EnableSync card parameter. Enables
synchronization status messages (S1
byte), which allow the node to choose
the best timing source.

SyncMsgIn

• G811—Primary reference
clock

• STU—Sync traceability
unknown

• G812T—Transit node clock
traceable

• G812L—Local node clock
traceable

• SETS—Synchronous
equipment

• DUS—Do not use for timing
synchronization

• PRS—Primary Reference Source
(Stratum 1)

• STU—Sync traceability unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum clock

• ST4—Stratum 4

• DUS—Do not use for timing
synchronization

• RES—Reserved; quality level set by
user

Overrides the synchronization status
message (SSM) and the
synchronization traceability unknown
(STU) value. If the node does not
receive an SSM signal, it defaults to
STU.

Admin SSM In

Checked or uncheckedChecked or unchecked(OC-768/STM-256 only) Sets the
Send DoNotUse card state. When
checked, sends a do not use (DUS)
message on the S1 byte.

Send
DoNotUse

• SONET

• SDH

• SONET

• SDH

(SONET [ANSI] or SDH [ETSI] only)
Indicates the optical transport type.

Type

• Transparent

• Regeneration Section (RS)

• Multiplex Section (MS)

• Transparent

• Section

• Line

(OC-768/STM-256 only) Sets the
mode of operation.

This option is only
available for
SONET/SDH payloads.

Note

Termination
Mode
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Table 151: Ethernet Line Settings of the 40E-TXP-C and 40ME-TXP-C Cards

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1 to 1-16
(STM1/STM4/STM16/GE)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 17 and
Port 18 are
trunk ports
that support
STM64
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

• 1-1 to 1-16
(OC3/OC12/OC48/GE)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 17 and Port
18 are trunk ports
that support
OC192 payload in
a single-card
configuration.
These ports are
interlink ports in a
double-card
configuration
(ADM-10G peer
group).

Note

(Display only) Displays the port
number.

Port

User-defined. Name can be up to
80 alphanumeric/special
characters. Blank by default.

User-defined. Name can be up to
80 alphanumeric/special characters.
Blank by default.

Provides the ability to assign the
specified port a name.

Port Name

• Unlocked

• Unlocked,automaticInService

• Locked,disabled

• Locked,maintenance

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

Sets the port service state. For more
information about administrative
states, see the Administrative and
Service States document.

Admin State

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenance

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

(Display only) Identifies the
autonomously generated state that
gives the overall condition of the port.
Service states appear in the format:
Primary State-Primary State Qualifier,
Secondary State. Formore information
about service states, see the
Administrative and Service States
document.

Service State
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ETSI OptionsANSI OptionsDescriptionParameter

• Disabled (default): ALS is
off; the laser is not
automatically shut down
when traffic outages (LOS)
occur.

• Manual Restart: ALS is on;
the laser automatically shuts
down when traffic outages
(LOS) occur. However, the
laser must be manually
restarted when conditions
that caused the outage are
resolved.

• Manual Restart for Test:
Manually restarts the laser
for testing.

• Disabled (default): ALS is off;
the laser is not automatically
shut down when traffic outages
(LOS) occur.

• Manual Restart: ALS is on; the
laser automatically shuts down
when traffic outages (LOS)
occur. However, the laser must
be manually restarted when
conditions that caused the
outage are resolved.

• Manual Restart for Test:
Manually restarts the laser for
testing.

Sets the ALS function mode. The
DWDM transmitter supports ALS
according to ITU-T G.644 (06/99).
ALS can be disabled, or it can be set
for one of three mode options.

ALS Mode

• Duration of valid input
signal, in hh.mm format,
after which the card
becomes in service (IS)
automatically

• 0 to 48 hours, 15-minute
increments

The AINS
service state is
not supported
on interlink
ports.

Note

• Duration of valid input signal,
in hh.mm format, after which
the card becomes in service (IS)
automatically

• 0 to 48 hours, 15-minute
increments

The AINS service
state is not
supported on
interlink ports.

Note

Sets the automatic in-service soak
period. Double-click the time and use
the up and down arrows to change
settings.

AINS Soak

The Reach options depend on the
traffic type that has been selected.

The Reach options depend on the
traffic type that has been selected.

Displays the optical reach distance of
the client port.

Reach

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G692 Changing the 40G Multirate Transponder OTU Settings
This task changes the OTU settings of the 40E-TXP-C, and 40ME-TXP-C
transponder cards.

Purpose

NoneTools/Equipment
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DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C or 40ME-TXP-C
card where you want to change the OTU settings.

Step 2 Click the Provisioning > Line > OTU tabs.
Step 3 Modify any of the settings described in the following table.

Table 152: OTU Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

• 1-1

• 2-1

• 3-1

• 4-1

(Display only) Displays the port number
that is applicable only for
OC-192/STM-64 payloads.

Port

Checked or uncheckedChecked or unchecked(Display only) (OC-768/STM-256 only)
Sets the EnableSync card parameter.
Enables synchronization statusmessages
(S1 byte), which allow the node to
choose the best timing source.

SyncMsgIn

• G811—Primary reference clock

• STU—Sync traceability
unknown

• G812T—Transit node clock
traceable

• G812L—Local node clock
traceable

• SETS—Synchronous equipment

• DUS—Do not use for timing
synchronization

• PRS—Primary Reference
Source (Stratum 1)

• STU—Sync traceability
unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum
clock

• ST4—Stratum 4

• DUS—Do not use for timing
synchronization

• RES—Reserved; quality level
set by user

Overrides the synchronization status
message (SSM) and the synchronization
traceability unknown (STU) value. If
the node does not receive an SSM
signal, it defaults to STU.

Admin SSM
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ETSI OptionsANSI OptionsDescriptionParameter

Checked or uncheckedChecked or unchecked(Display only) (OC-768/STM-256 only)
Sets the ProvidesSync card parameter.
If checked, the card is provisioned as a
network element (NE) timing reference.

ProvidesSync

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G661 Changing the 40G Multirate Transponder Line Thresholds for SONET
or SDH Payloads

This task changes the line threshold settings of 40E-TXP-C and 40ME-TXP-C
transponder cards carrying SONET or SDH payloads, including the physical
40G Ethernet WAN Phy payload.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card where
you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) tabs.
Step 3 Modify any of the settings described in the following table.

Table 153: Line Threshold Settings for the 40E-TXP-C, and 40ME-TXP-C Cards

ETSI OptionsANSI OptionsDescriptionParameter

• 1 (STM-256)

• 2 (STM-256)

• 1 (OC-768)

• 2 (OC-768)

(Display only) Port
number

Port
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ETSI OptionsANSI OptionsDescriptionParameter

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Coding violationsCV

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Errored secondsES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Click Reset to Default to restore default
values.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Click Reset to Default to restore default
values.

Severely errored
seconds

SES

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Click Reset to Default to restore default
values.

(Line or Multiplex
Section only) Failure
count

FC
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ETSI OptionsANSI OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Click Reset to Default to restore default
values.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Click Reset to Default to restore default
values.

(Line or Multiplex
Section only)
Unavailable seconds

UAS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G663 Provisioning the 40G Multirate Transponder Trunk Port Alarm and
TCA Thresholds

This task provisions the 40E-TXP-C, and 40ME-TXP-C trunk port alarm and
threshold cross alert (TCA) thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card where
you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.
Step 3 Under Types area, verify that the TCA radio button is selected. If not, click it, then click Refresh.
Step 4 Referring to the following table, verify the trunk port (Port 2) TCA thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the
threshold value you want to change, deleting the existing value, and entering the new value. Press Enter, then
click Apply.

Step 5 Under Intervals area, select 15 Min or 1 Day, then click Refresh.
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Do not modify the Laser Bias parameters.Note

Table 154: Trunk Port TCA Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards

TCA TX Power
Low (dbm)

TCA TX Power
High (dbm)

TCA RX Power
Low (dbm)

TCA RX Power
High (dbm)

Card

0.09.0–22.0–9.040E-TXP-C
40ME-TXP-C

Step 6 Click Apply.
Step 7 Under Types area, click the Alarm radio button and click Refresh.
Step 8 Referring to the following table, verify the trunk port (Port 2) alarm thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the
threshold value you want to change, deleting the existing value, and entering the new value. Press Enter, then
click Apply.

Step 9 Under Intervals area, select 15 Min or 1 Day, then click Refresh.

Table 155: Trunk Port Alarm Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards

Alarm TX

Power Low

Alarm TX

Power High

Alarm RX

Power Low

Alarm RX

Power High

Card

0.09.0–22.0–9.040E-TXP-C
40ME-TXP-C

Step 10 Click Apply.
Step 11 Click Default to restore default values.
Step 12 Return to your originating procedure (NTP).

DLP-G664 Provisioning the 40G Multirate Transponder Client Port Alarm and
TCA Thresholds

This task provisions the client port alarm and TCA thresholds for the
40E-TXP-C, and 40ME-TXP-C cards.

Purpose

NoneTools/Equipment

DLP-G278 Provisioning the Optical Line Rate, on page 317

DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card where
you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Under Types area, verify that the TCA radio button is selected. If not, click it, then click Refresh.
Step 4 Referring to the following table, verify the client port (Port 1) TCA thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low based on the client interface at the other end. Provision new
thresholds as needed by double-clicking the threshold value you want to change, deleting the existing value,
and entering the new value. Press Enter, then click Apply.

Step 5 Under Intervals area, select 15 Min or 1 Day, then click Refresh.

Do not modify the Laser Bias parameters.Note

Table 156: Client Interface TCA Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Rate

–3.06.0–6.03.040G Ethernet LAN
Phy

–3.06.0–6.03.0OC-768/STM-256

–3.06.0–6.03.0OTU3

Step 6 Click Apply.
Step 7 Under Types area, click the Alarm radio button and click Refresh.
Step 8 Referring to the following table, provision the client port (Port 1) alarm thresholds for RX Power High, RX

Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.
Step 9 Under Intervals area, select 15 Min or 1 Day, then click Refresh.

Table 157: Card Client Interface Alarm Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards

Alarm TX
Power Low

Alarm TX
Power High

Alarm RX
Power Low

Alarm RX
Power High

Pluggable Port Rate

–1.04.0–8.05.040G Ethernet LAN
Phy

–1.04.0–8.05.0OC-768/STM-256

–1.04.0–8.05.0OTU3

Step 10 Click Apply.
Step 11 Return to your originating procedure (NTP).
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NTP-G170 Provisioning the ADM-10G Card Peer Group, Ethernet
Settings, Line Settings, PM Parameters, and Thresholds

This procedure creates an ADM-10G peer group and changes line settings, PM
parameters, and threshold settings for ADM-10G cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

DLP-G723 Install PPM on a Line Card

DLP-G411 Provisioning an ADM-10G PPM and Port, on page 313

DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task to preserve the existing transmission
settings.

Step 2 To provision a peer group, complete the DLP-G403 Creating the ADM-10G Peer Group, on page 401.
Step 3 To display the bandwidth usage of the STS timeslots, complete the DLP-G775 Displaying the Bandwidth

Usage of the STS Timeslots, on page 214.
Step 4 To provision Ethernet settings, complete the DLP-G469 Provisioning the ADM-10G Card Ethernet Settings,

on page 402.
Step 5 To change line settings, complete the following tasks as needed:

• DLP-G397 Changing the ADM-10G Line Settings, on page 403

• DLP-G398 Changing the ADM-10G Line Section Trace Settings, on page 408

• DLP-G399 Changing the ADM-10G Line Thresholds for SONET and SDH Payloads, on page 410

• DLP-G412 Changing the ADM-10G Line RMON Thresholds for the 1G Ethernet Payload, on page 414

Step 6 To change thresholds, complete the following tasks as needed:

• DLP-G400 Provisioning the ADM-10G Interlink or Trunk Port Alarm and TCAThresholds, on page 417

• DLP-G401 Provisioning the ADM-10G Client Port Alarm and TCA Thresholds, on page 419

• DLP-G402 Changing the ADM-10G OTN Settings, on page 420

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
400

Provisioning Transponder and Muxponder Cards
NTP-G170 Provisioning the ADM-10G Card Peer Group, Ethernet Settings, Line Settings, PM Parameters, and Thresholds

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/spares/gbic/guides/b_ons_pluggables.html#task_803FF34295774FFB888692369A11B34D
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#ID17


Stop. You have completed this procedure.

DLP-G403 Creating the ADM-10G Peer Group
This task creates peer group protection for two ADM-10G cards within the
same node, located on the same shelf. Perform this task on only one of the two
peer cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

You cannot perform this task on a single ADM-10G card; it is only available if a second ADM-10G card can
be accessed through the interlink ports (Port 17 and Port 18).

Note

Due to a hardware limitation, you cannot provision the SDCC/LDCC on Port 17.Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the card settings.

Step 2 Click the Provisioning > Card tabs.
Step 3 In the ADM Group Peer drop-down list, choose the slot number where the companion ADM-10G card is

located.
Step 4 In the ADM Peer Group field, enter a group name.
Step 5 Click Apply.

The Card Parameters TunableWavelengths area is read-only and does not contain any wavelengths
until circuits are separately provisioned for the card.

Note

Step 6 Return to your originating procedure (NTP).
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DLP-G469 Provisioning the ADM-10G Card Ethernet Settings
This task changes the Ethernet settings for the ADM-10G card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Line > Ethernet tabs.
Step 3 Modify any of the settings for the Ethernet tab as described in the following table. The parameters that appear

depend on the card mode.

Table 158: ADM-10G Card Ethernet Settings

OptionsDescriptionParameter

—(Display only) The Port number (n-n) and rate.Port

Jumbo. Default: 64 to 9216

Numeric: 1548

The maximum size of the Ethernet frames
accepted by the port.

MTU

• 1000 MbpsSets the Ethernet mode.Mode

• GFP-F

• HDLC

Sets the framing type.Framing

CRC encap value for GFP-F:

• None (default)

• 32-Bit

CRC encap value for HDLC:

• 16-Bit

• 32-Bit (default)

Sets the CRC encap values for the framing type.CRC Encap
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OptionsDescriptionParameter

• Duration of valid input signal, in hh.mm format, after which
the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments

Automatic in-service soak time. The duration of
time that must pass with an uninterrupted signal
before the traffic/termination transitions to the
IS-NR (ANSI) or unlocked-enabled (ETSI)
service state.

AINS Soak

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G397 Changing the ADM-10G Line Settings
This task changes the line settings for the ADM-10G card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs.
Step 3 Modify any of the settings described in the following table as needed.

In the following table, some parameter tabs do not always apply to all ADM-10G cards. If a tab
does not apply, it will not appear in CTC.

Note
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Table 159: ADM-10G Line Port Tab Settings

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1 to 1-16
(STM1/STM4/STM16/GE)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 17 and
Port 18 are
trunk ports
that support
STM64
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

• 1-1 to 1-16
(OC3/OC12/OC48/GE)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 17 and
Port 18 are
trunk ports
that support
OC192
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

(Display only) Displays
the port number.

Port

User-defined. Name can be up
to 80 alphanumeric/special
characters. Blank by default.

User-defined. Name can be up
to 80 alphanumeric/special
characters. Blank by default.

Provides the ability to
assign the specified port a
name.

Port Name

• Unlocked

• Unlocked,automaticInService

• Locked,disabled

• Locked,maintenance

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

Sets the port service state.
For more information
about administrative
states, see the
Administrative and
Service States document.

Admin State
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ETSI OptionsANSI OptionsDescriptionParameter

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenance

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

(Display only) Identifies
the autonomously
generated state that gives
the overall condition of
the port. Service states
appear in the format:
Primary State-Primary
State Qualifier, Secondary
State. For more
information about service
states, see the
Administrative and
Service States document.

Service State

• Disabled (default): ALS is
off; the laser is not
automatically shut down
when traffic outages
(LOS) occur.

• Auto Restart: (Not
applicable for Gigabit
Ethernet client interfaces)
ALS is on; the laser
automatically shuts down
when traffic outages
(LOS) occur. It
automatically restarts
when the conditions that
caused the outage are
resolved.

• Manual Restart: ALS is
on; the laser automatically
shuts down when traffic
outages (LOS) occur.
However, the laser must
be manually restarted
when conditions that
caused the outage are
resolved.

• Manual Restart for Test:
Manually restarts the laser
for testing.

• Disabled (default): ALS is
off; the laser is not
automatically shut down
when traffic outages
(LOS) occur.

• Auto Restart: (Not
applicable for Gigabit
Ethernet client interfaces)
ALS is on; the laser
automatically shuts down
when traffic outages
(LOS) occur. It
automatically restarts
when the conditions that
caused the outage are
resolved.

• Manual Restart: ALS is
on; the laser automatically
shuts down when traffic
outages (LOS) occur.
However, the laser must
be manually restarted
when conditions that
caused the outage are
resolved.

• Manual Restart for Test:
Manually restarts the laser
for testing.

Sets the ALS function
mode. The DWDM
transmitter supports ALS
according to ITU-TG.644
(06/99). ALS can be
disabled, or it can be set
for one of three mode
options.

ALS Mode
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ETSI OptionsANSI OptionsDescriptionParameter

• Duration of valid input
signal, in hh.mm format,
after which the card
becomes in service (IS)
automatically

• 0 to 48 hours, 15-minute
increments

The AINS
service state
is not
supported on
interlink
ports.

Note

• Duration of valid input
signal, in hh.mm format,
after which the card
becomes in service (IS)
automatically

• 0 to 48 hours, 15-minute
increments

The AINS
service state
is not
supported on
interlink
ports.

Note

Sets the automatic
in-service soak period.
Double-click the time and
use the up and down
arrows to change settings.

AINS Soak

The Reach options depend on
the traffic type that has been
selected.

The Reach options depend on
the traffic type that has been
selected.

Displays the optical reach
distance of the client port.

Reach

Shows the supported
wavelengths of the trunk port
after the card is installed in the
format: first wavelength-last
wavelength-frequency
spacing-number of supported
wavelengths. For example,
1529.55nm-1561.83nm-50gHz-8
are supported wavelengths. You
can also view the bandwidth of
the wavelength information in
THz.

Shows the supported
wavelengths of the trunk port
after the card is installed in the
format: first wavelength-last
wavelength-frequency
spacing-number of supported
wavelengths. For example,
1529.55nm-1561.83nm-50gHz-8
are supported wavelengths. You
can also view the bandwidth of
the wavelength information in
THz.

Tunable wavelength.Wavelength

Step 4 Click Apply.
Step 5 Click the Provisioning > Line >SONET or SDH tabs.
Step 6 Modify any of the settings described in the following table as needed.
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Table 160: ADM-10G Line SONET or SDH Tab Settings

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1 to 1-16
(STM1/STM4/STM16/GE)

• 17-1(STM64)

• 18-1 (STM64/Interlink)

• 19-1 (STM64)

Port 17 and
Port 18 are
trunk ports
that support
STM64
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

• 1-1 to 1-16
(OC3/OC12/OC48/GE)

• 17-1 (OC192)

• 18-1 (OC192/Interlink)

• 19-1 (OC192)

Port 17 and
Port 18 are
trunk ports
that support
OC192
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

(Display only) Displays the
client and trunk port
number.

Port

Checked or uncheckedChecked or uncheckedWhen checked, the card is
provisioned as anNE timing
reference.

ProvidesSync

Checked or uncheckedChecked or uncheckedEnables synchronization
status messages (S1 byte),
which allow the node to
choose the best timing
source.

SyncMsgIn

• 1E-3

• 1E-4

• 1E-5

• 1E-3

• 1E-4

• 1E-5

Sets the signal fail bit error
rate.

SF BER

Checked or uncheckedChecked or uncheckedWhen checked, sends a
DUS message on the S1
byte.

Send
DoNotUse
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ETSI OptionsANSI OptionsDescriptionParameter

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit
error rate.

SD BER

• SDH• SONET

• SDH

(Display only) Type of
node.

Type

• G811—Primary reference
clock

• STU—Sync traceability
unknown

• G812T—Transit node clock
traceable

• G812L—Local node clock
traceable

• SETS—Synchronous
equipment

• DUS—Do not use for timing
synchronization

• PRS—Primary Reference
Source (Stratum 1)

• ST2—Stratum 2

• TNC—Transit node clock

• ST3E—Stratum 3E

• ST3—Stratum 3

• SMC—SONET minimum
clock

• ST4—Stratum 4

• DUS—Do not use for timing
synchronization

• RES—Reserved; quality level
set by user

Overrides the
synchronization status
message (SSM)
synchronization traceability
unknown (STU) value. If
the node does not receive an
SSM signal, it defaults to
STU.

Admin SSM In

Step 7 Return to your originating procedure (NTP).

DLP-G398 Changing the ADM-10G Line Section Trace Settings
This task changes the line section trace settings for the ADM-10G cards.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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The Section Trace tab is available for ports configured as OC-N (Ports 1 through 16, Ports 17 and 18 [only
in a single-card configuration] and Port 19). Section trace is not available on interlink ports.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the section trace settings. The card view appears.

Step 2 Click the Provisioning > Line > Section Trace tabs.
Step 3 Modify any of the settings described in the following table.

Table 161: ADM-10G Section Trace Settings

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1 to 1-16
(STM1/STM4/STM16/GE)

• 17-1 (STM64)

• 18-1 (STM64)

• 19-1 (STM64)

Port 17 and
Port 18 are
trunk ports
that support
STM64
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

• 1-1 to 1-16
(OC3/OC12/OC48/GE)

• 17-1 (OC 192)

• 18-1 (OC192)

• 19-1 (OC192)

Port 17 and
Port 18 are
trunk ports
that support
OC192
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

Sets the port number.Port

• Off/None

• Manual

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• 1 byte

• 16 byte

• 64 byte

• 1 byte

• 16 byte

• 64 byte

Sets the trace string size.Transmit Section
Trace String
Size
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ETSI OptionsANSI OptionsDescriptionParameter

String of trace string sizeString of trace string sizeCurrent Transmit String
displays the current transmit
string; New Transmit String
sets a new transmit string.
Current String Type allows
you to choose between
ASCII or Hexadecimal
format. ClickHex to change
the display to hexadecimal
(button changes to ASCII);
click ASCII to change the
display to ASCII (button
changes to Hex).

Current

String of trace string sizeString of trace string size(Display only) Current
Received String displays the
current received string. You
can click Refresh to
manually refresh this
display, or check the
Auto-refresh every 5 sec
check box to keep this panel
updated.

Received

Checked/unchecked
(default)

Checked/unchecked
(default)

If checked, automatically
refreshes the display every
5 seconds.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G399ChangingtheADM-10GLineThresholdsforSONETandSDHPayloads
This task changes the line threshold settings for ADM-10G cards carrying
SONET payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the line threshold settings. The card view appears.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds or SDH Thresholds tabs.
Step 3 Modify any of the settings described in the following table.

Table 162: ADM-10G Card Line Threshold Settings

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1 to 1-16
(STM1/STM4/STM16/GE)

• 17-1 (STM 64)

• 18-1 (STM64)

• 19-1 (STM64)

Port 17 and Port
18 are trunk
ports that
support STM64
payload in a
single-card
configuration.
These ports are
interlink ports in
a double-card
configuration
(ADM-10Gpeer
group).

Note

• 1-1 to 1-16
(OC3/OC12/OC48/GE)

• 17-1 (OC 192)

• 18-1 (OC192)

• 19-1 (OC192)

Port 17 and
Port 18 are
trunk ports
that support
OC192
payload in a
single-card
configuration.
These ports
are interlink
ports in a
double-card
configuration
(ADM-10G
peer group).

Note

(Display only) Port
number

Port

Numeric. Threshold display options
include:

• Direction—Near End or Far
End

• Interval—15Min (minutes) or
1 day

• Types—Multiplex Section or
Regeneration Section (near
end only)

Choose an option in each category
and click Refresh.

—Path Errored Block
indicates that one or
more bits are in error
within a block

EB
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ETSI OptionsANSI OptionsDescriptionParameter

—Numeric. Threshold display
options include:

• Direction—Near End or
Far End

• Interval—15 Min
(minutes) or 1 day

• Types—Line or Section
(near end only)

Choose an option in each
category and click Refresh.

Coding violationsCV

Numeric. Threshold display options
include:

• Direction—Near End or Far
End

• Interval—15Min (minutes) or
1 day

• Types—Line or Section (near
end only)

Choose an option in each category
and click Refresh.

Numeric. Threshold display
options include:

• Direction—Near End or
Far End

• Interval—15 Min
(minutes) or 1 day

• Types—Line or Section
(near end only)

Choose an option in each
category and click Refresh.

Errored secondsES

Numeric. Threshold display options
include:

• Direction—Near End or Far
End

• Interval—15Min (minutes) or
1 day

• Types—Line or Section (near
end only)

Choose an option in each category
and click Refresh.

Numeric. Threshold display
options include:

• Direction—Near End or
Far End

• Interval—15 Min
(minutes) or 1 day

• Types—Line or Section
(near end only)

Choose an option in each
category and click Refresh.

Severely errored
seconds

SES
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ETSI OptionsANSI OptionsDescriptionParameter

Numeric. Threshold display options
include:

• Direction—Near End or Far
End

• Interval—15Min (minutes) or
1 day

• Types—Multiplex Section or
Regeneration Section (near
end only)

Choose an option in each category
and click Refresh.

—Background block
errors

BBE

—Numeric. Threshold display
options include:

• Direction—Near End or
Far End

• Interval—15 Min
(minutes) or 1 day

• Types—Line or Section
(near end only)

Choose an option in each
category and click Refresh.

(Line Section only)
Failure count

FC

—Numeric. Threshold display
options include:

• Direction—Near End or
Far End

• Interval—15 Min
(minutes) or 1 day

Choose an option in each
category and click Refresh.

Protection Switching
Count

PSC

—Numeric. Threshold display
options include:

• Direction—Near End or
Far End

• Interval—15 Min
(minutes) or 1 day

Choose an option in each
category and click Refresh.

Protection Switching
Duration

PSD
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ETSI OptionsANSI OptionsDescriptionParameter

Numeric. Threshold display options
include:

• Direction—Near End or Far
End

• Interval—15Min (minutes) or
1 day

• Types—Line or Section (near
end only)

Choose an option in each category
and click Refresh.

Numeric. Threshold display
options include:

• Direction—Near End or
Far End

• Interval—15 Min
(minutes) or 1 day

• Types—Line or Section
(near end only)

Choose an option in each
category and click Refresh.

(Line Section only)
Unavailable seconds

UAS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G412 Changing the ADM-10G Line RMON Thresholds for the 1G Ethernet
Payload

This task changes the line RMON threshold settings for an ADM-10G card
carrying the 1G Ethernet payload.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

DLP-G411 Provisioning an ADM-10G PPM and Port, on page 313

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

This task can only be performed if the ADM-10G card has at least one PPM port provisioned for Gigabit
Ethernet.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the line RMON thresholds. The card view appears.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
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Step 3 Click Create. The Create Threshold dialog box appears.
Step 4 From the Port drop-down list, choose the applicable port.
Step 5 From the Variable drop-down list, choose the applicable Ethernet variable. See the following table for a list

of available Ethernet variables.

Table 163: ADM-10G Gigabit Ethernet Thresholds

DescriptionVariable

Total number of octets received on the interface, including framing
characters.

ifInOctets

Number of inbound packets that contained errors preventing them
from being deliverable to a higher-layer protocol.

ifInErrors

Total number of octets transmitted out of the interface, including
framing characters.

ifOutOctets

Number of multicast frames received error-free.ifInMulticastPkts

Number of packets, delivered by a sublayer to a higher layer or
sublayer, that were addressed to a broadcast address at this sublayer.

ifInBroadcastPkts

Number of receive error bytes.ifInErrorBytePkts

Number of frames with frame check errors; that is, there is an integral
number of octets, but there is also an incorrect frame check sequence
(FCS).

dot3StatsFCSErrors

Number of received frames that were larger than the permitted
maximum size.

dot3StatsFrameTooLong

A count of MAC control frames received on this interface that contain
an opcode not supported by this device.

dot3ControlInUnknownOpcodes

A count of MAC control frames received on this interface with an
opcode indicating the PAUSE operation.

dot3InPauseFrames

A count of MAC control frames transmitted on this interface with an
opcode indicating the PAUSE operation.

dot3OutPauseFrames

Total number of packets received that were well-formed and less than
64 octets long (excluding framing bits and including FCS octets).

etherStatsUndersizePkts

Total number of packets received that were less than 64 octets in
length (excluding framing bits but including FCS octets) and had
either a bad FCS with an integral number of octets (FCS error) or a
bad FCS with a non-integral number of octets (alignment error).

It is normal for etherStatsFragments to increment. This
is because it counts both runts (which are normal
occurrences due to collisions) and noise hits.

Note

etherStatsFragments

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
415

Provisioning Transponder and Muxponder Cards
DLP-G412 Changing the ADM-10G Line RMON Thresholds for the 1G Ethernet Payload



Total number of packets (including bad packets) transmitted and
received by the interface that were 64 octets in length (excluding
framing bits and including FCS octets).

etherStatsPkts64Octets

Total number of packets (including bad packets) transmitted and
received by the interface that were between 65 and 127 octets in length,
inclusive.

etherStatsPkts65to127Octets

The total number of packets (including bad packets) transmitted and
received by the interface that were between 128 and 255 octets in
length, inclusive, excluding framing bits and including FCS octets.

etherStatsPkts128to255Octets

Total number of packets (including bad packets) transmitted and
received by the interface that were between 256 and 511 octets in
length, inclusive.

etherStatsPkts256to511Octets

Total number of packets (including bad packets) transmitted and
received by the interface that were between 512 and 1023 octets in
length, inclusive, excluding framing bits and including FCS octets.

etherStatsPkts512to1023Octets

Total number of packets (including bad packets) transmitted and
received by the interface that were between 1024 and 1518 octets in
length, inclusive, excluding framing bits and including FCS octets.

etherStatsPkts1024to1518Octets

Total number of good packets transmitted and received by the interface
that were directed to the broadcast address.

Multicast packets are not included.Note

etherStatsBroadcastPkts

Total number of good packets transmitted and received by the interface
that were directed to a multicast address.

This number does not include packets directed to the
broadcast address.

Note

etherStatsMulticastPkts

Total number of packets transmitted and received by the interface that
were well-formed and longer than 1518 octets, excluding framing bits
and including FCS octets.

etherStatsOversizePkts

Total number of packets received that were longer than 1518 octets
(excluding framing bits and including FCS octets), and had a bad FCS
with an integral number of octets (FCS error) or a bad FCS with a
non-integral number of octets (alignment error).

etherStatsJabbers

Total number of received packets.rxTotalPkts

Total number of transmit packets.txTotalPkts

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, the
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute.
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Relative restricts the threshold to use the number of occurrences in the user-set sample period. Absolute sets
the threshold to use the total number of occurrences, regardless of time period.

Step 8 Type an appropriate number of seconds for the Sample Period.
Step 9 Type the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.
Step 12 Return to your originating procedure (NTP).

DLP-G400 Provisioning the ADM-10G Interlink or Trunk Port Alarm and TCA
Thresholds

This task provisions the ADM-10G interlink or trunk port alarm and threshold
crossing alert (TCA) thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the interlink or trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.
Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.
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Step 4 Referring to the following table, verify the interlink or trunk port TCA thresholds for RX Power High, RX
Power Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking
the threshold value you want to change, deleting it, entering a new value, and pressing Enter.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

Table 164: ADM-10G Interlink and Trunk Port TCA Thresholds

TCA TX

Power Low

TCA TX

Power High

TCA RX

Power Low

TCA RX

Power High

Port

–4.0 dBm6.0 dBm–27.0 dBm–7.0 dBm17-1 and 18-1 (Trunk/Interlink)

Port 17 and Port 18 are trunk ports
in single-card configuration and an
interlink port in double-card
configuration (ADM-10G peer
group).

Note

–4.0 dBm6.0 dBm–27.0 dBm–7.0 dBm19-1 (Trunk)

Step 5 Click Apply.
Step 6 Under Types, click the Alarm radio button and click Refresh.
Step 7 Referring to the following table, verify the interlink or trunk port alarm thresholds for RX Power High,

RX Power Low, TX Power High, and TX Power Low.
Step 8 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,

entering a new value, and pressing Enter.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Table 165: ADM-10G Interlink and Trunk Port Alarm Thresholds

Alarm TX

Power Low

Alarm TX

Power High

Alarm RX

Power Low

Alarm RX

Power High

Port

–8.0 dBm1.0 dBm–13.0 dBm1.0 dBm17-1 (Trunk/Interlink)

Port 17 is a trunk port in single-card
configuration and an interlink port
in double-card configuration
(ADM-10G peer group).

Note
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Alarm TX

Power Low

Alarm TX

Power High

Alarm RX

Power Low

Alarm RX

Power High

Port

–3.0 dBm5.0 dBm–30.0 dBm–5.0 dBm18-1 (Trunk/Interlink)

Port 18 is a trunk port in single-card
configuration and an interlink port
in double-card configuration
(ADM-10G peer group).

Note

–3.0 dBm5.0 dBm–30.0 dBm–5.0 dBm19-1 (Trunk)

Step 9 Click Apply.
Step 10 Return to your originating procedure (NTP).

DLP-G401 Provisioning the ADM-10G Client Port Alarm and TCA Thresholds
This task provisions the client port alarm and TCA thresholds for the ADM-10G
card.

Purpose

NoneTools/Equipment

DLP-G278 Provisioning the Optical Line Rate, on page 317

DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.
Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.
Step 4 Referring to Table 135: TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds, on

page 360 and Table 136: TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm Thresholds, on
page 362, verify the Port 1 to 16 (Client) Alarm thresholds for RX Power High, RX Power Low, TX Power
High, and TX Power Low based on the client interface that is provisioned.

Step 5 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note
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Step 6 Click Apply.
Step 7 Under Types, click the Alarm radio button and click Refresh.
Step 8 Referring to Table 135: TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds, on

page 360 and Table 136: TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm Thresholds, on
page 362, verify the interlink ports 17-1 and 18-1 for RX Power High, RX Power Low, TX Power High, and
TX Power Low settings.

Step 9 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

Step 10 Click Apply.
Step 11 Return to your originating procedure (NTP).

DLP-G402 Changing the ADM-10G OTN Settings
This task changes the line OTN settings for the ADM-10G card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where you
want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then click one of the following subtabs: OTN Lines,
ITU-T G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in the following tables.

You must modify Near End and Far End independently; 15 Min and 1 Day independently; and
SM and PM independently. To do so, choose the appropriate radio buttons and click Refresh.

Note
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Table 166: ADM-10G Card OTN Lines Settings

OptionsDescriptionParameter

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 18 is a trunk port in
single-card configuration
and an interlink port in
double-card configuration
(ADM-10G peer group).

Note

(Display only) Displays the port number and
optional name.

Port

• Enable

• Disable

Sets the OTN lines according to
ITU-T G.709.

ITU-TG.709
OTN

• Disable—FEC is off.

• Standard—Standard FEC is on.

• Enhanced—Enhanced FEC is on.

Sets the OTN lines FEC mode. FEC mode
can be Disabled, Enabled, or, for the
TXP_MR_10E, Enhanced FEC mode can
be enabled to provide greater range and
lower bit error rate. For TXP_MR_10E
cards, Standard is the same as enabling FEC.

FEC

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• 1E-5(Display only) Indicates the signal fail bit
error rate.

SF BER

Synch mappingSets how the ODUk (client payload) is
mapped to the optical channel (OTUk).

Synch Mapping

Table 167: ADM-10G Card ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 18 is a trunk port in
single-card configuration
and an interlink port in
double-card configuration
(ADM-10G peer group).

Note

(Display only) Displays the port number and
optional name.

Port
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OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

SM (OTUk) is the ITU-T
G.709 optical channel transport
unit order of k overhead frame
used for management and
performance monitoring. PM
(ODUk) is the ITU-T G.709
optical channel data unit order
of k overhead frame unit used
for path performance
monitoring.

Note

Errored seconds. Selecting the SM (OTUk)
radio button selects FEC, overhead
management, and PMusingOTUk. Selecting
the PM radio button selects path PM using
ODUk.

ES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Severely errored secondsSES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Unavailable secondsUAS

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Background block errorsBBE
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OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Failure counterFC

Table 168: ADM-10G Card FEC Threshold Settings

OptionsDescriptionParameter

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 18 is a trunk port in
single-card configuration
and an interlink port in
double-card configuration
(ADM-10G peer group).

Note

(Display only) Displays the port number and
optional name.

Port

Numeric display. Can be set for 15-minute
or 1 day intervals.

Displays the number of bit errors corrected
during the selected time period.

Bit Errors
Corrected

Numeric display. Can be set for 15-minute
or 1 day intervals.

Displays the number of uncorrectable words
in the selected time period.

Uncorrectable
Words

Table 169: ADM-10GTrail Trace Identifier Settings

OptionsDescriptionParameter

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Port 18 is a trunk port in
single-card configuration
and an interlink port in
double-card configuration
(ADM-10G peer group).

Note

Sets the port number.Port

• Section

• Path

Sets the level.Level
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OptionsDescriptionParameter

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
disabled)

If a Trace Identifier Mismatch on
Section/Path overhead alarm arises because
of a J0/J1 overhead string mismatch, no
Forward Defect Indication (FDI) signal is
sent to the downstream nodes if this box is
checked.

Disable FDI on
TTIM

String of trace string size; trail trace
identifier is 64 bytes in length.

Current Transmit String displays the current
transmit string; New sets a new transmit
string. You can click the button on the right
to change the display. Its title changes, based
on the current display mode. In Transmit
String Type, clickHex to change the display
to hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit

String of trace string sizeCurrent Expected String displays the current
expected string; New sets a new expected
string. You can click the button on the right
to change the display. Its title changes, based
on the current display mode. In Expected
String Type, clickHex to change the display
to hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Current Received String
displays the current received string. You can
click Refresh to manually refresh this
display, or check the Auto-refresh every 5
sec check box to keep this panel updated.

Received

Checked/unchecked (default)If checked, automatically refreshes the
display every 5 seconds.

Auto-refresh
(every 5 sec)

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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NTP-G333 Adding an ADM-10G Card to an Existing Topology
This procedure adds an ADM-10G card to an existing topology. Perform the
steps in this procedure when OCHNC and DCC are present in the network. In
case of OCH trails, delete all the circuits in Step 3 that traverses the port before
deleting the OCH-trail.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC.

• Complete the turn up procedures in the "Turning Up a Node" chapter for
the node to be added.

• An updated Cisco Transport Planner network plan recalculated with the
new node.

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 If path protected circuits exist between Node A and Node B, complete the DLP-A197 Initiate a Path Protection
Force Switch task. This task applies a force switch on the path between Node A and Node B.

Step 2 Complete the NTP-G129 Add a DWDM Node task to add Node C.
Step 3 Complete the DLP-G106 Deleting Optical Channel Network Connections task to delete OCHNC circuit

between Node A and Node B.
Step 4 Complete the NTP-G59 Creating, Deleting, and Managing Optical Channel Network Connections task to

create OCHNC circuit between Node A-->Node C and Node C-->Node B for wavelength connectivity.

The ports on the card in Node C must be tuned to the same wavelength as Node A and Node B.Note

Step 5 Create DCC terminations on Node C. See the DLP-A377 Provision Section DCC Terminations task.
Alternatively, if additional bandwidth is needed for CTC management, complete the DLP-A378 Provision
Line DCC Terminations task.

TNC reloads when SDCC and LDCC co-exist on the same card. This behavior is observed in the following
cards:

• TXP-MR-10G

• TXP-MR-2.5G

• TXPP-MR-2.5G

• TXP-MR-10E

• MXP-MR-2.5G
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• MXPP-MR-2.5G

• MXP-MR-10DME

• MXP-MR-10DMEX

• ADM-10G

• TXP-MR-10EX

• TXPP-MR-10EX

• OTU2-XP

Step 6 Ensure that the DCCs are functional between Node A-->Node C and Node C-->Node B. See the "DLP-G76
Provision DCC/GCC Terminations" task.

Step 7 Complete the following task to create pass-through STS or VC circuits in Node C.

• NTP-G200 Creating, Deleting, and Managing STS or VC Circuits for the ADM-10G Card

Step 8 Complete the NTP-A301 Merge Circuits task for each circuit created.
Step 9 If path protected circuits exist between Node A and Node B, complete the DLP-A198 Clear a Path Protection

Force Switch task. This task clears a force switch on the path between Node A and Node B.

Stop. You have completed this procedure.

NTP-G97 Modifying the 4x2.5G Muxponder Card Line Settings
and PM Parameter Thresholds

This procedure changes the line and threshold settings for theMXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and
MXP_2.5G_10EX_C muxponder cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task to preserve the existing transmission
settings.

Step 2 Perform any of the following tasks as needed:

• DLP-G222 Changing the 4x2.5G Muxponder Card Settings, on page 427

• DLP-G223 Changing the 4x2.5G Muxponder Line Settings, on page 429

• DLP-G224 Changing the 4x2.5G Muxponder Section Trace Settings, on page 432

• DLP-G225 Changing the 4x2.5G Muxponder Trunk Settings, on page 433

• DLP-G226 Changing the 4x2.5G Muxponder SONET/SDH Line Thresholds Settings, on page 437

• DLP-G303 Provisioning the 4x2.5G Muxponder Trunk Port Alarm and TCA Thresholds, on page 439

• DLP-G304 Provisioning the 4x2.5G Muxponder Client Port Alarm and TCA Thresholds, on page 441

• DLP-G228 Changing the 4x2.5G Muxponder Line OTN Settings, on page 443

• DLP-G369 Changing the 4x2.5G Muxponder Trunk Wavelength Settings, on page 435

Step 3 As needed, complete the NTP-G103 Backing Up the Database task.

Stop. You have completed this procedure.

DLP-G222 Changing the 4x2.5G Muxponder Card Settings
This task changes the card settings for the MXP_2.5G_10G, MXP_2.5G_10E,
MXP_2.5G_10E_C,MXP_2.5G_10E_L, andMXP_2.5G_10EX_Cmuxponder
cards, including payload type, termination mode, and wavelength.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to
change the card settings.

Step 2 Click the Provisioning > Card tabs.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
427

Provisioning Transponder and Muxponder Cards
DLP-G222 Changing the 4x2.5G Muxponder Card Settings

http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#ID17
http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#ID17
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Step 3 Modify any of the settings described in the following table. The Parameters shown in the following table do
not apply to all 4x2.5G muxponder cards. If the parameter or option does not apply, it is not shown in CTC.

Table 170: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Settings

OptionsDescriptionParameter

For ANSI platforms:

• Transparent

• Section (MXP_2.5G_10E,
MXP_2.5G_10E_C,
MXP_2.5G_10E_L, and
MXP_2.5G_10EX_C only)

• Line (MXP_2.5G_10G only)

For ETSI platforms:

• Transparent

• Multiplex Section (MXP_2.5G_10G,
only)

• RegenerationSection (MXP_2.5G_10E,
MXP_2.5G_10E_C,
MXP_2.5G_10E_L, and
MXP_2.5G_10EX_C only)

Sets the mode of operation. Options that do
not apply to a card do not display.

The MXP_2.5G_10G card is based on
SONET/SDHmultiplexing. The transparent
mode terminates and rebuilds the B1 byte
(as well as other bytes) of the incoming
OC-48/STM-16 signal. The B2 byte is not
touched.

The MXP_2.5G_10E, MXP_2.5G_10E_C,
MXP_2.5G_10E_L, and
MXP_2.5G_10EX_C cards are fully
transparent in transparent mode based on the
OTN/ITU-T G.709 multiplexing scheme. It
does not terminate the B1 byte or other bytes.

It encapsulates OC-48/STM-16 bytes into
ODU1 first, then multiplexes them into an
OTU2.

Termination
Mode

• Ais

• Squelch

(MXP_2.5G_10E, MXP_2.5G_10E_C,
MXP_2.5G_10E_L, and
MXP_2.5G_10EX_C only) Sets the
transparent termination mode configuration.

AIS/Squelch

—(Display only) Shows the supported
wavelengths of the trunk port after the card
is installed. For the MXP_2.5G_10E_C, or
MXP_2.5G_10E_L cards, the first and last
supported wavelength, frequency spacing,
and number of supported wavelengths are
shown in the format: first wavelength-last
wavelength-frequency spacing-number of
supported wavelengths. For example, the
MXP_2.5G_10E_C card would show:
1529.55nm-1561.83nm-50gHz-82. The
MXP_2.5G_10G andMXP_2.5G_10E show
the four wavelengths supported by the card
that is installed. You can also view the
bandwidth of the wavelength information in
THz.

Tunable
Wavelengths

Step 4 Click Apply.
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Step 5 Return to your originating procedure (NTP).

DLP-G223 Changing the 4x2.5G Muxponder Line Settings
This task changes the line settings for the MXP_2.5G_10G, MXP_2.5G_10E,
MXP_2.5G_10E_C,MXP_2.5G_10E_L, andMXP_2.5G_10EX_Cmuxponder
cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to
change the line settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs.

The SONET tab appears only if you have created a PPM for a given port.Note

Step 3 Modify any of the settings described in the following table.

You must modify Near End and Far End independently; 15 Min and 1 Day independently; and
Line and Section independently. To do so, choose the appropriate radio button and clickRefresh.

Note

Table 171: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line Settings

OptionsDescriptionParameter

• 1

• 2

• 3

• 4

• 5 (Trunk) (MXP_2.5G_10G only)

(Display only) Port number. Ports 1 to 4 are client ports
(OC-48/STM-16). Port 5 is the DWDM trunk
(OC-192/STM-64) that provides wavelength services.
Client ports will not appear of the pluggable port
module is not provisioned for it.

Port

User-defined. Name can be up to 80 alphanumeric/ special
characters. Blank by default.

Provides the ability to assign the specified port a logical
name.

Port Name

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
429

Provisioning Transponder and Muxponder Cards
DLP-G223 Changing the 4x2.5G Muxponder Line Settings

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


OptionsDescriptionParameter

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Sets the port service state unless network conditions
prevent the change. For more information about
administrative states, see the Administrative and
Service States document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or
Locked-enabled,maintenance (ETSI)

(Display only) Identifies the autonomously generated
state that gives the overall condition of the port. Service
states appear in the format: Primary State-Primary State
Qualifier, Secondary State. For more information about
service states, see the Administrative and Service States
document.

Service State

• 1E-3

• 1E-4

• 1E-5

Sets the signal fail bit error rate.SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• Disable (default): ALS is off; the laser is not
automatically shut down when traffic outages (LOS)
occur.

• Auto Restart: ALS is on; the laser automatically shuts
down when traffic outages (LOS) occur. It
automatically restarts when the conditions that caused
the outage are resolved.

• Manual Restart: ALS is on; the laser automatically
shuts down when traffic outages (LOS) occur.
However, the laser must be manually restarted when
conditions that caused the outage are resolved.

• Manual Restart for Test: Manually restarts the laser
for testing.

Sets the ALS function mode. The DWDM transmitter
supports ALS according to ITU-TG.644 (06/99). ALS
can be disabled or can be set for one of three mode
options.

ALS Mode
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OptionsDescriptionParameter

• Duration of valid input signal, in hh.mm format, after
which the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments

Sets the automatic in-service soak period. Double-click
the time and use the up and down arrows to change
settings.

AINS Soak

• SONET

• SDH

Sets the optical transport type.Type

Checked or uncheckedEnables synchronization status messages (S1 byte),
which allow the node to choose the best timing source.
(This parameter does not appear for the
MXP_2.5G_10E trunk port.)

SyncMsgIn

Checked or uncheckedSets the ProvidesSync card parameter. If checked, the
card is provisioned as an NE timing reference. (This
parameter does not appear for the MXP_2.5G_10E
trunk port.)

ProvidesSync

Options: ANSI/ETSI

• Autoprovision/Autoprovision (default)

• SR

• SR 1/I-1—Short reach up to 2-km distance

• IR 1/S1—Intermediate reach, up to 15-km distance

• IR 2/S2—Intermediate reach up to 40-km distance

• LR 1/L1—long reach, up to 40-km distance

• LR 2/L2—long reach, up to 80-km distance

• LR 3/L3—long reach, up to 80-km distance

Displays the optical reach distance of the client port.Reach

• First Tunable Wavelength

• Further wavelengths: 850 nm through 1560.61 nm
100-GHz ITU spacing CWDM spacing . You can
also view the bandwidth of the wavelength
information in THz.

Displays the wavelength of the client port.Wavelength

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G224 Changing the 4x2.5G Muxponder Section Trace Settings
This task changes the section trace settings for the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and
MXP_2.5G_10EX_C muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

The Section Trace tab appears only if you have created a PPM for the card.Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to
change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.
Step 3 Modify any of the settings described in the following table.

Table 172: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Section Trace Settings

OptionsDescriptionParameter

• 1

• 2

• 3

• 4

• 5 (Trunk; MXP_2.5G_10G only)

Sets the port number.Port

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is not
disabled)

If an TIM on Section overhead alarm arises
because of a J0 overhead string mismatch,
no alarm indication signal is sent to
downstream nodes if this box is checked.

Disable
AIS/RDI on
TIM-S
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OptionsDescriptionParameter

• 1 byte

• 16 byte

Sets the trace string size. Select either radio
button.

Transmit
Section Trace
String Size

String of trace string sizeDisplays the current transmit string; sets a
new transmit string. You can click the button
on the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit

String of trace string sizeDisplays the current expected string; sets a
new expected string. You can click the
button on the right to change the display. Its
title changes, based on the current display
mode. Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec check box to keep
this panel updated.

Received

Checked/unchecked (default)If checked, automatically refreshes the
display every 5 minutes.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G225 Changing the 4x2.5G Muxponder Trunk Settings
This task provisions the trunk settings for the MXP_2.5G_10E,
MXP_2.5G_10E_C,MXP_2.5G_10E_L, andMXP_2.5G_10EX_Cmuxponder
cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Provisioning or higherSecurity Level

This task does not apply to the MXP_2.5G_10G card.Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10E,
MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to change the trunk
settings.

Step 2 Click the Provisioning > Line > Trunk tabs.
Step 3 Modify any of the settings described in the following table.

Table 173: MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Trunk Settings

OptionsDescriptionParameter

5 (Trunk)(Display only) Displays the port number. Port 5 is the
DWDM trunk (OC-192/STM-64) that provides
wavelength services.

Port

User-defined. Name can be up to 80 alphanumeric/
special characters. Blank by default.

Provides the ability to assign the specified port a logical
name.

Port Name

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Sets the port service state unless network conditions
prevent the change. For more information about
administrative states, see the Administrative and Service
States document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or
Locked-enabled,maintenance (ETSI)

(Display only) Identifies the autonomously generated
state that gives the overall condition of the port. Service
states appear in the format: Primary State-Primary State
Qualifier, Secondary State. For more information about
service states, see the Administrative and Service States
document.

Service State
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OptionsDescriptionParameter

• Disabled (default): ALS is off; the laser is not
automatically shut down when traffic outages
(LOS) occur.

• Auto Restart: ALS is on; the laser automatically
shuts down when traffic outages (LOS) occur. It
automatically restarts when the conditions that
caused the outage are resolved.

• Manual Restart: ALS is on; the laser automatically
shuts down when traffic outages (LOS) occur.
However, the laser must be manually restarted
when conditions that caused the outage are
resolved.

• Manual Restart for Test: Manually restarts the laser
for testing.

Sets the ALS function mode. The DWDM transmitter
supports ALS according to ITU-T G.644 (06/99). ALS
can be disabled or can be set for one of three mode
options.

ALS Mode

• Duration of valid input signal, in hh.mm format,
after which the card becomes in service (IS)
automatically

• 0 to 48 hours, 15-minute increments

(OC-N and STM-N payloads only) Sets the automatic
in-service soak period.

AINS Soak

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G369 Changing the 4x2.5G Muxponder Trunk Wavelength Settings
This task changes the trunk wavelength settings for the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and
MXP_2.5G_10EX_C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C card where you want
to change the trunk wavelength settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.
Step 3 Modify any of the settings described in the following table.

Table 174: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C Card Wavelength Trunk Settings

OptionsDescriptionParameter

5 (Trunk)(Display only) Displays the port number.Port

• C—The C-band wavelengths are
available in the Wavelength field.

• L—The L-band wavelengths are
available in the Wavelength field.

(Display only) Indicates thewavelength band
available from the card that is installed. If
the card is preprovisioned, the field can be
provisioned to the band of the card that will
be installed.

Band

• Even—Displays evenC-band or L-band
wavelengths in the Wavelength field.

• Odd—Displays odd C-band or L-band
wavelengths in the Wavelength field.

Sets the wavelengths available for
provisioning for MXP_2.5G_10E_C and
MXP_2.5G_10E_L cards. (This field does
not apply to MXP_2.5G_10G or
MXP_2.5G_10E cards.)

Even/Odd

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU-T
C-band or L-band spacing, depending
on the card that is installed. For
MXP_2.5G_10G andMXP_2.5G_10E
cards, the wavelengths carried by the
card are identified with two asterisks.
If the card is not installed, all
wavelengths appear with a dark grey
background.You can view the
bandwidth of wavelength information
in THz.

The wavelength provisioned for the trunk.Wavelength

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G226 Changing the 4x2.5G Muxponder SONET/SDH Line Thresholds
Settings

This task changes the SONET (ANSI) or SDH (ETSI) line threshold settings
for the MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C,
MXP_2.5G_10E_L, and MXP_2.5G_10EX_C muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to
change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs.
Step 3 Modify any of the settings described in the following table. Some parameter tabs or selections do not always

apply to all 4x2.5G muxponder cards. If the tabs or selections do not apply, they do not appear in CTC.

Table 175: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line Threshold Settings

SDH OptionsSONET OptionsDescriptionParameter

• 1

• 2

• 3

• 4

• 5 (MXP_2.5G_10G only)

• 1

• 2

• 3

• 4

• 5 (MXP_2.5G_10G only)

(Display only) Port
number

Port

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

—Path Errored Block
indicates that one or
more bits are in error
within a block

EB
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SDH OptionsSONET OptionsDescriptionParameter

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Coding violationsCV

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Errored secondsES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Severely errored
seconds

SES

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Near End Section or
Regeneration Section
only) Severely errored
framing seconds

SEFS
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SDH OptionsSONET OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

—Background block
errors

BBE

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only) Failure
count

FC

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only)
Unavailable seconds

UAS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G303 Provisioning the 4x2.5G Muxponder Trunk Port Alarm and TCA
Thresholds

This task changes theMXP_2.5G_10G,MXP_2.5G_10E,MXP_2.5G_10E_C,
MXP_2.5G_10E_L, and MXP_2.5G_10EX_C trunk port alarm and TCA
thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed
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Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to
change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.
Step 3 Select TCA (if not already selected), a 15 Min or 1 Day PM interval radio button and then click Refresh.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Step 4 Referring to the following table, verify the trunk port (Port 5) TCA thresholds for RX Power High, RX Power
Low, TX Power High, and TX Power Low.

Step 5 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

Do not modify the Laser Bias parameters.Note

Table 176: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Trunk Port TCA Thresholds

TCA TX

Power Low

TCA TX

Power High

TCA RX

Power Low

TCA RX

Power High

Card

–1 dBm7 dBm–18 dBm–8 dBmMXP_2.5G_10G

0 dBm9 dBm–18 dBm–9 dBmMXP_2.5G_10E

0 dBm9 dBm–18 dBm–9 dBmMXP_2.5G_10E_C

0 dBm9 dBm–18 dBm–9 dBmMXP_2.5G_10E_L

0 dBm9 dBm–18 dBm–9 dBmMXP_2.5G_10EX_C

Step 6 Click Apply.
Step 7 Under Types, click the Alarm radio button and click Refresh.
Step 8 Referring to the following table, verify the trunk port (Port 5) Alarm thresholds for RX Power High, RX Power

Low, TX Power High, and TX Power Low.
Step 9 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,

entering a new value, and pressing Enter.

Do not modify the Laser Bias parameters.Note
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Table 177: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Trunk Port Alarm Thresholds

Alarm TX

Power Low

Alarm TX

Power High

Alarm RX

Power Low

Alarm RX

Power High

Card

2 dBm4 dBm–20 dBm–8 dBmMXP_2.5G_10G

3 dBm7 dBm–20 dBm–8 dBmMXP_2.5G_10E

3 dBm7 dBm–20 dBm–8 dBmMXP_2.5G_10E_C

3 dBm7 dBm–20 dBm–8 dBmMXP_2.5G_10E_L

3 dBm7 dBm–20 dBm–8 dBmMXP_2.5G_10EX_C

Step 10 Click Apply.
Step 11 Return to your originating procedure (NTP).

DLP-G304 Provisioning the 4x2.5G Muxponder Client Port Alarm and TCA
Thresholds

This task provisions the client port alarm and TCA thresholds for the
MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L,
and MXP_2.5G_10EX_C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to
change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Referring to the following table, verify the client Port N (where N = 1 through 4) TCA thresholds for RX

Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other
end.
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Step 4 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK
Modules, on page 307

Note

Table 178: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Client Interfaces TCA
Thresholds

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module
(SFP)

Port Type
(by CTC)

–163–18–3ONS-SE-2G-S1OC-48

–116–18015454-SFP-OC48-IR

–163–18–3ONS-SE-2G-S1STM-16

–116–18015454E-SFP-L.16.1

Step 5 Provision each additional client port.
Step 6 Under Types, click the Alarm radio button and click Refresh.
Step 7 Referring to the following table, verify the client Port N (where N = 1 through 4) Alarm thresholds for RX

Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is
provisioned.

Step 8 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

Do not modify the Laser Bias parameters.Note

Table 179: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, or MXP_2.5G_10E_L Card Client Interfaces Alarm Thresholds

Alarm TX
Power Low

Alarm TX
Power High

Alarm RX
Power Low

Alarm RX
Power High

Pluggable Port Module
(SFP)

Port Type
(by CTC)

–130–210ONS-SE-2G-S1OC-48

–83–21315454-SFP-OC48-IR

–130–210ONS-SE-2G-S1STM-16

–83–21315454E-SFP-L.16.1
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Step 9 Click Apply.
Step 10 Return to your originating procedure (NTP).

DLP-G228 Changing the 4x2.5G Muxponder Line OTN Settings
This task changes the line OTN settings forMXP_2.5G_10G,MXP_2.5G_10E,
MXP_2.5G_10E_C,MXP_2.5G_10E_L, andMXP_2.5G_10EX_Cmuxponder
cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to
change the line OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines,
OTN G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings as described in the following tables.

You must modify Near End and Far End independently, 15 Min and 1 Day independently, and
SM and PM independently. To do so, choose the appropriate radio button and click Refresh.

Note

In the following table, some parameter tabs or values do not always apply to all MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, or MXP_2.5G_10E_L cards. If the tabs or values do not
apply, they do not appear in CTC.

Note

Table 180: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line OTN Settings

OptionsDescriptionParameter

5 (Trunk)(Display only) Displays the port
number.

Port

• Enable

• Disable

Sets the OTN lines according to
ITU-T G.709.

G.709 OTN
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OptionsDescriptionParameter

• Enable—(MXP_2.5G_10G only) FEC
is on.

• Disable—FEC is off.

• Standard—(MXP_2.5G_10Eonly) FEC
is on.

• Enhanced—(MXP_2.5G_10E only)
Enhanced FEC is on.

Sets the OTN line FEC mode. FEC
mode can be Disabled or Enabled.With
the MXP_2.5G_10E card, Enhanced
FEC (E-FEC) mode can be enabled to
provide greater range and lower bit error
rate. E-FEC applies only to the
MXP_2.5G_10E card.

FEC

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• 1E-5(Display only) Sets the signal fail bit
error rate.

SF BER

• ODU Multiplex(MXP_2.5G_10E only) The
MXP_2.5G_10E can perform standard
ODU multiplexing according to
ITU-T G.709. The card uses this to
aggregate the four OC-48 client signals.

Asynch/Synch
Mapping

Table 181: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

5 (Trunk)(Display only) Port numberPort
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OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

SM (OTUk) is the ITU-T
G.709 optical channel transport
unit order of k overhead frame
used for management and
performance monitoring. PM
(ODUk) is the ITU-T G.709
optical channel data unit order
of k overhead frame unit used
for path performance
monitoring.

Note

Errored secondsES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Severely errored seconds. Two types of
thresholds can be asserted. Selecting the SM
(OTUk) radio button selects FEC, overhead
management, and PMusingOTUk. Selecting
the PM radio button selects path PM using
ODUk.

SES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Unavailable secondsUAS

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Background block errorsBBE
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OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Failure counterFC

Table 182: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C FEC Threshold Settings

OptionsDescriptionParameter

5 (Trunk)(Display only) Displays the port number.Port

NumericDisplays the number of bit errors corrected
during the interval selected. The interval can
be set for 15 minutes or one day.

Bit Errors
Corrected

NumericDisplays the number of uncorrectable words
during the interval selected. The interval can
be set for 15 minutes or one day.

Uncorrectable
Words

Table 183: MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Trail Trace Identifier Settings

OptionsDescriptionParameter

5 (Trunk)Sets the port number. The trail trace
identifier is applicable only to the trunk
interface, which handles ITU-T G.709
frames.

Port

• Section

• Path

Sets the level.Level

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
disabled)

If a Trace Identifier Mismatch on Section
overhead alarm arises because of a J0
overhead string mismatch, no Forward
Defect Indication (FDI) signal is sent to the
downstream nodes if this box is checked.

Disable FDI on
TTIM
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OptionsDescriptionParameter

String of trace string size; trail trace
identifier is 64 bytes in length.

Displays the current transmit string; sets a
new transmit string. You can click the button
on the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit

String of trace string sizeDisplays the current expected string; sets a
new expected string. You can click the
button on the right to change the display. Its
title changes, based on the current display
mode. Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec box to keep this
panel updated.

Received

Checked/unchecked (default)If checked, automatically refreshes the
display every 5 minutes.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

NTP-G99 Modifying the 2.5G Data Muxponder Card Line Settings
and PM Parameter Thresholds

This procedure changes the line and threshold settings for the MXP_MR_2.5G
and MXPP_MR_2.5G muxponder cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task to preserve the existing transmission
settings.

Step 2 Perform any of the following tasks as needed:

• DLP-G236 Changing the 2.5G or 10G Data Muxponder Client Line Settings

• DLP-G237 Changing the 2.5G Data Muxponder Distance Extension Settings

• DLP-G238 Changing the 2.5G or 10G Data Muxponder SONET/SDH Settings

• DLP-G239 Changing the 2.5G or 10G Data Muxponder Section Trace Settings

• DLP-G240 Changing the 2.5G or 10G Data Muxponder SONET or SDH Line Thresholds

• DLP-G321 Changing the 2.5G or 10G Data Muxponder Line RMON Thresholds

• DLP-G307 Provisioning the 2.5G Data Muxponder Trunk Port Alarm and TCA Thresholds

• DLP-G308 Provisioning the 2.5G Data Muxponder Client Port Alarm and TCA Thresholds

• DLP-G370 Changing the 2.5G or 10G Data Muxponder Trunk Wavelength Settings

To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the
Alarm and TCA Monitoring and Management document.

Note

Stop. You have completed this procedure.

DLP-G236 Changing the 2.5G or 10G Data Muxponder Client Line Settings
This task changes the client line settings forMXP_MR_2.5G,MXPP_MR_2.5G,
MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C
muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
448

Provisioning Transponder and Muxponder Cards
DLP-G236 Changing the 2.5G or 10G Data Muxponder Client Line Settings

http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_011001.html#ID17
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_alarm_tca_monitoring.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the line settings.

Step 2 Click the Provisioning > Line > Client tabs. Tabs and parameter selections vary according to PPM
provisioning.

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK
Modules, on page 307.

Note

Step 3 Modify any of the settings for the Client tab as described in the following table.

Table 184: 2.5G or 10G Data Muxponder Card Client Settings

OptionsDescriptionParameter

• 1 and 2 for 2.5G data muxponder cards

• 1 through 8 for 10G data muxponder cards

(Display only) Port number.Port

User-defined. Name can be up to 80 alphanumeric/special characters.
Blank by default.

You can provision a string (port name) for each fiber
channel/FICON interface on the cards, which allows the
MDS FabricManager to create a link association between
that SAN port and a SAN port on a
Cisco MDS 9000 switch.

Note

The user can assign a logical name for each
of the ports shown by filling in this field.

Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states, see
the Administrative and Service States
document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled, automaticInService
(ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)

Identifies the autonomously generated state
that gives the overall condition of the port.
Service states appear in the format: Primary
State-Primary State Qualifier, Secondary
State. For more information about service
states, see the Administrative and Service
States document.

Service State
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OptionsDescriptionParameter

• Disabled (default): ALS is off; the laser is not automatically shut
down when traffic outages (LOS) occur.

• Auto Restart: (MXP_MR_2.5G only) ALS is on; the laser
automatically shuts down when traffic outages (LOS) occur. It
automatically restarts when the conditions that caused the outage
are resolved.

• Manual Restart: ALS is on; the laser automatically shuts down
when traffic outages (LOS) occur. However, the laser must be
manually restarted when conditions that caused the outage are
resolved.

• Manual Restart for Test: Manually restarts the laser for testing.

Sets the ALS function mode.ALS Mode

The reach distances that appear in the drop-down list depend on the
card:

• Autoprovision—The system to automatically provision the reach
from the pluggable port module (PPM) reach value on the
hardware.

• SX—Short laser wavelength on multimode fiber optic cable for
a maximum length of 550meters. The operating wavelength range
is 770-860 nm.

• LX—Long wavelength for a long haul fiber optic cable for a
maximum length of 10 km. The operating wavelength range is
1270-1355 nm.

• CX—Two pairs of 150-ohm shielded twisted pair cable for a
maximum length of 25 meters.

• T—Four pairs of Category 5 Unshielded Twisted Pair cable for
a maximum length of 100 meters.

• DX—Single mode up to 40 km. The operating wavelength range
is 1430-1580 nm.

• HX—Single mode up to 40 km. The operating wavelength range
is 1280-1335 nm.

• ZX—Extended wavelength single-mode optical fiber for up to
100 km. The operating wavelength range is 1500-1580 nm.

• VX—Singlemode up to 100 km. The operatingwavelength range
is 1500-1580 nm.

Displays the optical reach distance of the
client port.

Reach

• First Tunable Wavelength

• Further wavelengths:850 nm through 1560.61 nm; 100-GHz ITU
spacing; CWDM spacing

Displays the wavelength of the client port.Wavelength
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OptionsDescriptionParameter

• Squelch

• Disable

Shuts down the far-end laser in response to
certain defects. (Squelch does not apply to
ISC COMPACT payloads.)

Squelch

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G237 Changing the 2.5G Data Muxponder Distance Extension Settings
This task changes the distance extension settings for MXP_MR_2.5G and
MXPP_MR_2.5G muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Distance extension settings can be changed only if the facilities are out of service (OOS,DSBLD).Note

The distance extension parameters only apply to client ports (Ports 1 to 8) and not to the trunk ports (Port 9
for MXP_MR_2.5G card or Ports 9 and 10 for the MXPP_MR_2.5G card).

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or
MXPP_MR_2.5G card where you want to change the distance extension settings.

Step 2 Click the Provisioning > Line > Client tabs. A client port must be provisioned for the tab to be present.

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK
Modules, on page 307.

Note
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Step 3 Locate the Client port table row and verify that the Service State column value is OOS-MA,DSBLD (ANSI)
or Locked-enabled,disabled (ETSI). If yes, continue with Step 4. If not, complete the following substeps:
a) Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Maintenance (ETSI).
b) Click Apply, then Yes.

Step 4 Click the Provisioning > Line > Distance Extension tabs. Tabs and parameter selections vary according to
PPM provisioning.

Step 5 Modify any of the settings for the Distance Extension tab as described in the following table.

Table 185: MXP_MR_2.5G or MXPP_MR_2.5G Card Line Distance Extension Settings

OptionsDescriptionParameter

• 1

• 2

(Display only) Port numberPort

Checked or uncheckedAllows end-to-end distances of up to 1600
km for FC1G and up to 800 km for FC2G.
If Distance Extension is enabled, set the
connected Fibre Channel switches to Interop
or Open Fabric mode, depending on the
Fibre Channel switch. By default, the
MXP_MR_2.5G andMXPP_MR_2.5G card
will interoperate with the Cisco Multilayer
Director Switch (MDS) storage products.

Enable Distance
Extension

Checked or uncheckedAllows automatic detection of buffer credits
for Fibre Channel flow control.

Auto Detect
Credits

Numeric (range depends on the client
equipment attached to the card)

(Display only) Displays the number of buffer
credits available.

Credits
Available

Checked or uncheckedAllows the threshold of the generic framing
procedure (GFP) buffer between two
MXP_MR_2.5G or two MXPP_MR_2.5G
cards to be automatically adjusted.

Autoadjust GFP
Buffer
Threshold

NumericDisplays the number of GFP buffers
available between two MXP_MR_2.5G or
two MXPP_MR_2.5G cards.

GFP Buffers
Available

Step 6 Click Apply.
Step 7 Return to your originating procedure (NTP).
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DLP-G238 Changing the 2.5G or 10G Data Muxponder SONET/SDH Settings
This task changes the OC-48 (ANSI) or STM-16 (ETSI) settings for
MXP_MR_2.5G andMXPP_MR_2.5Gmuxponder cards. This task also changes
the OC-192 (ANSI) or STM-64 (ETSI) settings for the MXP_MR_10DME_C
and MXP_MR_10DME_L muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

SONET (OC-48)/SDH (STM-16) settings apply only to the trunk ports (Port 9 for the MXP_MR_2.5G card
and Ports 9 and 10 for the MXPP_MR_2.5G card.)

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the OC-48/STM-64 settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI). Tabs and parameter selections vary
according to PPM provisioning.

Step 3 Modify any of the settings for the SONET or SDH tab as described in the following table.

Table 186: MXP_MR_2.5G or MXPP_MR_2.5G Card Line SONET or SDH Settings

OptionsDescriptionParameter

9 (trunk for MXP_MR_2.5G, MXP_MR_10DME_C, and
MXP_MR_10DME_L) or 9 and 10 (trunks for
MXPP_MR_2.5G)

(Display only) Port number.Port

User-defined. Name can be up to 80 alphanumeric/ special
characters. Blank by default.

Provides the ability to assign the specified port a
name.

Port Name

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Sets the port service state unless network conditions
prevent the change. For more information about
administrative states, see the Administrative and
Service States document.

Admin State
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OptionsDescriptionParameter

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance
(ETSI)

(Display only) Identifies the autonomously generated
state that gives the overall condition of the port.
Service states appear in the format: Primary
State-Primary State Qualifier, Secondary State. For
more information about service states, see the
Administrative and Service States document.

Service State

• 1E-3

• 1E-4

• 1E-5

Sets the signal fail bit error rate.SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• Disable (default): ALS is off; the laser is not
automatically shut down when traffic outages (LOS)
occur.

• Auto Restart: ALS is on; the laser automatically shuts
downwhen traffic outages (LOS) occur. It automatically
restarts when the conditions that caused the outage are
resolved.

• Manual Restart: ALS is on; the laser automatically shuts
down when traffic outages (LOS) occur. However, the
laser must be manually restarted when conditions that
caused the outage are resolved.

• Manual Restart for Test: Manually restarts the laser for
testing.

Sets theALS functionmode. TheDWDM transmitter
supports ALS according to ITU-T G.644 (06/99).
ALS can be disabled or can be set for one of three
mode options.

ALS Mode

• Duration of valid input signal, in hh.mm format, after
which the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments

Sets the automatic in-service soak period.
Double-click the time and use the up and down
arrows to change settings.

AINS Soak

• SONET (ANSI)

• SDH (ETSI)

The optical transport type.Type
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OptionsDescriptionParameter

Checked or uncheckedSets the EnableSync card parameter. Enables
synchronization status messages (S1 byte), which
allow the node to choose the best timing source.

SyncMsgIn

Checked or uncheckedSets the Send DoNotUse card state. When checked,
sends a DUS message on the S1 byte.

Send DoNotUse

Checked or uncheckedSets the ProvidesSync card parameter. If checked,
the card is provisioned as an NE timing reference.

ProvidesSync

SF BER and SD BER thresholds apply only to trunk ports (Port 9 for MXP_MR_2.5G and Ports 9 and 10 for
MXPP_MR_2.5G).

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G239 Changing the 2.5G or 10G Data Muxponder Section Trace Settings
This task changes the section trace settings for the MXP_MR_2.5G,
MXPP_MR_2.5G, MXP_MR_10DME_C and MXP_MR_10DME_L
muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to PPM
provisioning.

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK
Modules, on page 307.

Note
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Step 3 Modify any of the settings in the Section Trace tab as described in the following table.

Table 187: 2.5G or 10G Data Muxponder Card Line Section Trace Settings

OptionsDescriptionParameter

• 9 (trunk port for MXP_MR_2.5G,
MXP_MR_10DME_C, and
MXP_MR_10DME_L)

• 9 and 10 (trunk ports for
MXPP_MR_2.5G)

(Display only) Port number.Port

• Off/None

• Manual

Sets the received trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is not
disabled)

If an TIM on Section overhead alarm arises because of a J0 overhead
string mismatch, no alarm indication signal is sent to downstream
nodes if this box is checked.

Disable
AIS/RDI on
TIM-S

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size

String of trace string sizeDisplays the current transmit string; sets a new transmit string. You
can click the button on the right to change the display. Its title
changes, based on the current display mode. Click Hex to change
the display to hexadecimal (button changes to ASCII); clickASCII
to change the display to ASCII (button changes to Hex).

Transmit

String of trace string sizeDisplays the current expected string; sets a new expected string.
You can click the button on the right to change the display. Its title
changes, based on the current display mode. Click Hex to change
the display to hexadecimal (button changes to ASCII); clickASCII
to change the display to ASCII (button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received string. You can click
Refresh to manually refresh this display, or check the Auto-refresh
every 5 sec check box to keep this panel updated.

Received

Checked/unchecked (default)If checked, automatically refreshes the display every 5 seconds.Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G370Changingthe2.5Gor10GDataMuxponderTrunkWavelengthSettings
This task changes the trunk wavelength settings for the MXP_MR_2.5G,
MXPP_MR_2.5G, MXP_MR_10DME_C, and MXP_MR_10DME_L cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the trunk wavelength settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.
Step 3 Modify any of the settings as described in the following table.

Table 188: 2.5G or 10G Data Muxponder Card Wavelength Trunk Settings

OptionsDescriptionParameter

9 (Trunk)

10 (Trunk) (MXPP_MR_2.5G only)

(Display only) Displays the port number.Port

• C—The C band wavelengths are
available in the Wavelength field.

• (MXP_MR_10DME_C, and
MXP_MR_10DME_L only) L—The
L-band wavelengths are available in the
Wavelength field.

(Display only) Indicates thewavelength band
that can be provisioned. The field is
display-only when a physical
MXP_MR_10DME_C or
MXP_MR_10DME_L is installed. If the card
is provisioned in CTC only, you can
provision the band for the card that will be
installed.

Band

• Even—Displays evenC-band or L-band
wavelengths in the Wavelength field.

• Odd—Displays odd C-band or L-band
wavelengths in the Wavelength field.

Sets the wavelengths available for
provisioning. This field does not apply to
MXP_MR_2.5GorMXPP_MR_2.5G cards

Even/Odd
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OptionsDescriptionParameter

• First Tunable Wavelength

• Further wavelengths in 100-GHz
ITU-T, C-band spacing. If the card is
installed, the wavelengths it carries are
identified with two asterisks. Other
wavelengths have a dark grey
background. If the card is not installed,
all wavelengths appear with a dark grey
background.

The wavelength provisioned for the trunk.Wavelength

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G240 Changing the 2.5G or 10G Data Muxponder SONET or SDH Line
Thresholds

This task changes the SONET or SDH line threshold settings for
MXP_MR_2.5G, MXPP_MR_2.5G, MXP_MR_10DME_C, and
MXP_MR_10DME_L muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) tabs.
Step 3 Modify any of the settings as shown in the following table.

You must modify Near End and Far End independently, 15 Min and 1 Day independently, and
Line and Section independently. To do so, choose the appropriate radio button and clickRefresh.

Note

In the following table, some parameters or options do not apply to all the cards. If the parameters
or options do not apply, they do not appear in CTC.

Note
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Table 189: 2.5G or10G Data Muxponder Card Line Threshold Settings

ONS 15454 SDH OptionsONS 15454 OptionsDescriptionField

• 9 (MXP_MR_2.5G)

• 9 and 10 (MXPP_MR_2.5G)

• 9 (Trunk) for MXP_MR_10DME_C and
MXP_MR_10DME_L

• 9 (MXP_MR_2.5G)

• 9 and 10 (MXPP_MR_2.5G)

• 9 (Trunk) for MXP_MR_10DME_C and
MXP_MR_10DME_L

(Display only)
Port number

Port

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or Regeneration
Section (near end only)

Choose an option in each category and click
Refresh.

—Path Errored
Block indicates
that one or more
bits are in error
within a block

EB

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Coding
violations

CV

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or Regeneration
Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Errored secondsES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or Regeneration
Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Severely errored
seconds

SES
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ONS 15454 SDH OptionsONS 15454 OptionsDescriptionField

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

—Background
block errors

BBE

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Section only

Choose an option in each category and click
Refresh.

(Section or
Regeneration
Section only)
Severely errored
framing seconds

SEFS

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Section only

Choose an option in each category and click
Refresh.

(Line or
Multiplex
Section only)
Failure count

FC

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Regeneration Section (only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Section only

Choose an option in each category and click
Refresh.

(Line or
Multiplex
Section only)
Unavailable
seconds

UAS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G321 Changing the 2.5G or 10G Data Muxponder Line RMON Thresholds
This task changes the line threshold settings for MXP_MR_10G and
MXPP_MR_2.5G transponder cards carrying the 1GEthernet or 1G FC/FICON
payloads. This task changes the line threshold settings forMXP_MR_10DME_C
and MXP_MR_10DME_L cards carrying Ethernet, FC/FICON, or ISC/ISC3
payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), display the card where you want to change
the line RMON threshold settings.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
Step 3 Click Create. The Create Threshold dialog box appears.
Step 4 From the Port drop-down list, choose the applicable port, either the payload port, for example “1-1 (ONE_GE)”,

or the equivalent ITU-T G.7041 GFP (Generic Frame Procedure) port.
Step 5 From the Variable drop-down list, choose an Ethernet, FC, FICON, or ISC variable.

Table 190: MXP_MR_2.5G and MXPP_MR 2.5G Card 1G Ethernet or 1G, 2G FC/FICON Variables

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets

Total number of receive packets.rxTotalPkts

Number of inbound packets that were chosen to be discarded even
though no errors had been detected to prevent their being
deliverable to a higher-layer protocol.

ifInDiscards

Total number of receive errors.ifInErrors

The total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of transmitted packets.txTotalPkts

Number of outbound packets that were chosen to be discarded
even though no errors had been detected to prevent their being
transmitted.

ifOutDiscards
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Total number of frames received that are less than 5 bytes. This
value is a part of high-level data link control (HDLC) and GFP
port statistics.

mediaIndStatsRxFramesTruncated

Number of received frames that exceed themaximum transmission
unit (MTU). This value is part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong

Number of receive data frames with payload cyclic redundancy
check (CRC) errors when HDLC framing is used.

mediaIndStatsRxFramesBadCRC

Number of transmitted data frameswith payload CRC errors when
HDLC framing is used.

mediaIndStatsTxFramesBadCRC

Number of 8b10b disparity violations on the Fibre Channel line
side.

8b10bInvalidOrderedSets

Number of 8b10b disparity violations on the Fibre Channel line
side.

8b10bStatsEncodingDispErrors

Table 191: MXP_MR_10DME_C or MXP_MR_10DME_L Ethernet Variables

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets

Total number of receive packets.rxTotalPkts

Total number of receive errors.ifInErrors

The total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of transmitted packets.txTotalPkts

Total number of frames received that are less than 5 bytes. This
value is a part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTruncated

Number of received frames that exceed the MTU. This value
is part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong

Number of receive data frames with payload CRC errors when
HDLC framing is used.

mediaIndStatsRxFramesBadCRC

Number of transmitted data frames with payload CRC errors
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC

Number of code violations/running disparity errors in the
8b/10b encoded characters received.

8b10bInvalidOrderedSetsDispErrorsSum

Table 192: MXP_MR_10DME_C or MXP_MR_10DME_L FC/FICON Variables

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets
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DescriptionVariable

Total number of receive packets.rxTotalPkts

Total number of receive errors.ifInErrors

The total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of transmitted packets.txTotalPkts

Total number of oversized packets output from the interface.ifOutOversizePkts

Total number of frames received that are less than 5 bytes. This
value is a part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTruncated

Number of received frames that exceed the MTU. This value
is part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong

Number of receive data frames with payload CRC errors when
HDLC framing is used.

mediaIndStatsRxFramesBadCRC

Number of transmitted data frames with payload CRC errors
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC

This is a count that increments when the FC/FICONTx credits
go from a non-zero value to zero.

fcStatsZeroTxCredits

Number of received RDY (Receive Ready) order set.fcStatsRxRecvrReady

Number of transmitted RDY (Receive Ready) order set.fcStatsTxRecvrReady

Number of Code Violations/Running Disparity errors in the
8b/10b encoded characters received.

8b10bInvalidOrderedSetsDispErrorsSum

Table 193: MXP_MR_10DME_C or MXP_MR_10DME_L ISC and ISC3Variables

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets

Total number of receive packets.rxTotalPkts

The total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of transmitted packets.txTotalPkts

Number of Code Violations/Running Disparity errors in the
8b/10b encoded characters received.

8b10bInvalidOrderedSetsDispErrorsSum

Table 194: MXP_MR_10DME_C or MXP_MR_10DME_L GFP RMON Variables

DescriptionVariable
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Received generic framing protocol (GFP) frames with single
bit errors in the core header (these errors are correctable).

gfpStatsRxSBitErrors

Received GFP frames with invalid type (these are discarded).
For example, receiving GFP frames that contain Ethernet data
when we expect Fibre Channel data.

gfpStatsRxTypeInvalid

Total number of superblock CRC errors with the receive
transparent GFP frame. A transparent GFP frame has multiple
superblocks which each contain Fibre Channel data.

gfpStatsRxSblkCRCErrors

Number of Rx client management frames with Client Signal
Fail indication.

gfpStatsCSFRaised

The number of Core HEC CRC Multiple Bit Errors.

This count is only for cHEC multiple bit error
when in frame. It is a count of when the state
machine goes out of frame.

Note

gfpStatsLFDRaised

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, the
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold
to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total
number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.
Step 9 Type in the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.

To view all RMON thresholds, click Show All RMON thresholds.Note

Step 12 Return to your originating procedure (NTP).
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DLP-G307 Provisioning the 2.5G Data Muxponder Trunk Port Alarm and TCA
Thresholds

This task changes the MXP_MR_2.5G andMXPP_MR_2.5G trunk port alarm
and TCA thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Throughout this task, trunk port refers to Port 9 (MXP_MR_2.5G and MXPP_MR_2.5G) and Port 10
(MXPP_MR_2.5G only).

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or
MXPP_MR_2.5G card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Step 3 Verify the trunk port TCA thresholds for RX Power High is –9 dBm and for RX Power Low is –23 dBm.
Step 4 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,

entering a new value, and hitting Enter.
Step 5 Under Types, click the Alarm radio button and click Refresh.

Do not modify the Laser Bias parameters.Note

Step 6 Verify the trunk port Alarm thresholds for RX Power High is –7 dBm and for RX Power Low is –26 dBm.
Step 7 Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,

entering a new value, and hitting Enter.
Step 8 Click Apply.
Step 9 Return to your originating procedure (NTP).
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DLP-G308 Provisioning the 2.5G Data Muxponder Client Port Alarm and TCA
Thresholds

This task provisions the client port alarm and TCA thresholds for the
MXP_MR_2.5G and MXPP_MR_2.5G cards.

Purpose

NoneTools/Equipment

DLP-G278 Provisioning the Optical Line Rate, on page 317

DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or
MXPP_MR_2.5G card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Referring to the following table, verify the client port (Ports 1 through 8) TCA thresholds for RX Power High,

RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. Provision
new thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a
new value, and hitting Enter.

Do not modify the Laser Bias parameters.Note

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK
Modules, on page 307.

Note
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Table 195: MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface TCA Thresholds

TCA TX
Power High

TCA TX
Power Low

TCA RX
Power High

TCA RX
Power Low

Pluggable Port Module
(XFP)

Port Type
(by CTC)

3–160–1715454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC1G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1515454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC2G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1715454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON1G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1715454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON2G

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

3–160–1715454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

ONE_GE

3–16–3–2015454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–11–32–14–21ONS-SE-200-MMESCON

Step 4 Click Apply.
Step 5 Repeat Steps 3 and 4 to provision each additional client port.
Step 6 Under Types, click the Alarm radio button and click Refresh.
Step 7 Referring to the following table, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power

High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.
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Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and hitting Enter.

Table 196: MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface Alarm Thresholds

Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module
(XFP)

Port Type
(by CTC)

–1–133–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC1G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–1815454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC2G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON1G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON2G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

ONE_GE

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–8–35–11–24ONS-SE-200-MMESCON

Step 8 Click Apply.
Step 9 Repeat Steps 7 and 8 to provision each additional client port.
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Step 10 Return to your originating procedure (NTP).

NTP-G148 Modifying the 10G Data Muxponder Card Line Settings
and PM Parameter Thresholds

This procedure changes the line and threshold settings for the
MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C
muxponder cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task to preserve the existing transmission
settings.

Step 2 Perform any of the following tasks as needed:

• DLP-G236 Changing the 2.5G or 10G Data Muxponder Client Line Settings

• DLP-G334 Changing the 10G Data Muxponder Distance Extension Settings

• DLP-G370 Changing the 2.5G or 10G Data Muxponder Trunk Wavelength Settings

• DLP-G238 Changing the 2.5G or 10G Data Muxponder SONET/SDH Settings

• DLP-G239 Changing the 2.5G or 10G Data Muxponder Section Trace Settings

• DLP-G240 Changing the 2.5G or 10G Data Muxponder SONET or SDH Line Thresholds

• DLP-G321 Changing the 2.5G or 10G Data Muxponder Line RMON Thresholds

• DLP-G338 Provisioning the 10G Data Muxponder Trunk Port Alarm and TCA Thresholds

• DLP-G339 Provisioning the 10G Data Muxponder Client Port Alarm and TCA Thresholds
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• DLP-G366 Changing the 10G Data Muxponder OTN Settings

To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the
Alarm and TCA Monitoring and Management document.

Note

Stop. You have completed this procedure.

DLP-G334 Changing the 10G Data Muxponder Distance Extension Settings
This task changes the distance extension settings for theMXP_MR_10DME_C,
MXP_MR_10DME_L, and MXP_MR_10DMEX_C muxponder card ports
provisioned for Fibre Channel or FICON payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_10DME_C,
MXP_MR_10DME_L, or MXP_MR_10DMEX_C card where you want to change the distance extension
settings.

Step 2 Click the Provisioning > Line > Distance Extension tabs.

The distance extension parameters only apply to client ports (Ports 1 to 8) and not to the trunk
port (Port 9).

Note

The client port must be in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state in order to
change the distance extension settings. If a Y-cable is provisioned on the client port, both the
working and protect client ports must be in OOS,DSBLD (ANSI) or Locked,disabled (ETSI)
state before you change the distance extension settings.

Note

Step 3 Modify any of the settings as described in the following table.

Table 197: MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C Card Line Distance Extension Settings

OptionsDescriptionParameter

—(Display only) Port number. Up to eight
ports might appear based on the number of
pluggable port modules that are provisioned.

Port
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OptionsDescriptionParameter

Checked or uncheckedAllows end-to-end distances of up to 1600
km for FC1G and up to 800 km for FC2G.
If Distance Extension is enabled, set the
connected Fibre Channel switches to Interop
or Open Fabric mode, depending on the
Fibre Channel switch. By default, the
MXP_MR_10DME_C and
MXP_MR_10DME_L cardwill interoperate
with the Cisco MDS storage products.

Enable Distance
Extension

Checked or unchecked (default)If unchecked, the end-to-end fiber channel
link is reinitialized every time a Y-cable
protection switch occurs. If checked,
reinitialization of the link is avoided when
a Y-cable protection switch occurs, thus
reducing the traffic hit considerably.

This feature is supported for FC1G, FC2G,
FC4G, FICON1G, FICON2G, and
FICON4G trunk failures as well as
user-initiated Y-cable protection switch such
as, Manual, Force, or Lockout. It is
recommended that you do not enable the Fast
Switch option as the link may not come up
after a Y-cable protection switch in certain
cases.

This option can be used only if
you have unchecked Enable
Distance Extension option.

Note

Fast Switch

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G338 Provisioning the 10G Data Muxponder Trunk Port Alarm and TCA
Thresholds

This task changes the MXP_MR_10DME_C and MXP_MR_10DME_L trunk
port alarm and TCA thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_10DME_C or
MXP_MR_10DME_L card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

Step 3 If TCA is not selected, click TCA and then click Refresh.
Step 4 Verify the trunk port (Port 9) TCA thresholds are set at the values shown as follows. Provision new thresholds

as needed by double-clicking the threshold value you want to change, deleting it, entering a new value, and
press Enter.

• RX Power High: –9 dBm

• RX Power Low: –18 dBm

• TX Power High: 9 dBm

• TX Power Low: 0 dBm

Step 5 Under Types, click the Alarm radio button and click Refresh.

Do not modify the Laser Bias parameters.Note

Step 6 Verify the trunk port (Port 9) Alarm thresholds are set at the values shown as follows. Provision new thresholds
as needed by double-clicking the threshold value you want to change, deleting it, entering a new value, and
press Enter.

• RX Power High: –8 dBm

• RX Power Low: –20 dBm

• TX Power High: 7 dBm

• TX Power Low: 3 dBm

Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).
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DLP-G339 Provisioning the 10G Data Muxponder Client Port Alarm and TCA
Thresholds

This task provisions the client port alarm and TCA thresholds for the
MXP_MR_10DME_C and MXP_MR_10DME_L cards.

Purpose

NoneTools/Equipment

DLP-G278 Provisioning the Optical Line Rate, on page 317

DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click theMXP_MR_10DME_C and
MXP_MR_10DME_L card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Referring to the following table, verify the client ports (Ports 1 through 8) TCA thresholds for RX Power

High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end.
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and hitting Enter.

Do not modify the Laser Bias parameters.Note

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE,
or ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the DLP-G278 Provisioning the Optical Line Rate, on
page 317.

Note
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Table 198: MXP_MR_10DME_C and MXP_MR_10DME_L Card Client Interfaces TCA Thresholds

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module
(XFP)

PPM Port
Rate

–163–17015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC1G

–163–20–315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–163–15015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC2G

–163–20–315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–163–17015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON1G

–163–20–315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–163–17015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON2G

–163–20–315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–163–170ONS-SE-G2F-SXISC3PEER
1G

ISC3PEER
2G

–163–200ONS-SE-G2F-LX

–154–120ONS-SE-4G-MMFC4G

–154–15–1ONS-SE-4G-SM

–154–120ONS-SE-4G-MMFICON4G

–154–15–1ONS-SE-4G-SM

Step 4 Click Apply.
Step 5 Repeat Steps 3 and 4 to provision each additional client port.
Step 6 Under Types, click the Alarm radio button and click Refresh.
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Step 7 Referring to the following table, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power
High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and hitting Enter.

Table 199: MXP_MR_10DME_C and MXP_MR_10DME_L Card Client Interface Alarm Thresholds

Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module
(XFP)

PPM Port
Rate

–1–133–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC1G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–1815454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FC2G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON1G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–2015454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

FICON2G

0–130–2315454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–1–133–20ONS-SE-G2F-SXISC3PEER
1G

ISC3PEER
2G

0–130–23ONS-SE-G2F-LX

–1–113–15ONS-SE-4G-MMFC4G

0–112–18ONS-SE-4G-SM

–1–113–15ONS-SE-4G-MMFICON4G

0–112–18ONS-SE-4G-SM
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Step 8 Click Apply.
Step 9 Repeat Steps 7 and 8 to provision each additional client port.
Step 10 Return to your originating procedure (NTP).

DLP-G366 Changing the 10G Data Muxponder OTN Settings
This task changes the OTN settings for the MXP_MR_10DME_C and
MXP_MR_10DME_L cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click theMXP_MR_10DME_C and
MXP_MR_10DME_L card where you want to change the OTN settings.

Step 2 Click the Provisioning >OTN tabs, then choose one of the following subtabs:OTN Lines,G.709 Thresholds,
FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in the following tables.

You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To
do so, choose the appropriate radio button and click Refresh.

Note

Table 200: MXP_MR_10DME_C and MXP_MR_10DME_L Card OTN Line Settings

OptionsDescriptionParameter

9 (Trunk)(Display only) Displays the port number.Port

• Enable

• Disable

Sets the OTN lines according to
ITU-T G.709.

G.709 OTN

• Standard

• Enhanced

Sets the OTN lines to forward error
correction (FEC).

FEC

• 1E-5(Display only) Sets the signal fail bit error
rate.

SF BER
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OptionsDescriptionParameter

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• Asynch mapping

• Synch mapping

Sets how the ODUk (client payload) is
mapped to the optical channel (OTUk).

Asynch/Synch
Mapping

Table 201: MXP_MR_10DME_C and MXP_MR_10DME_L Card ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

9 (Trunk)(Display only) Port number.Port

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Errored secondsES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Severely errored secondsSES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Unavailable secondsUAS

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Background block errorsBBE

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Failure counterFC

Latency for a 1G-FC payload without ITU-T G.709 is 4 microseconds, and with ITU-T G.709 is
40microseconds. Latency for a 2G-FC payload without ITU-TG.709 is 2microseconds, and with ITU-TG.709
is 20 microseconds. Consider these values when planning a FC network that is sensitive to latency.

Table 202: MXP_MR_10DME_C and MXP_MR_10DME_L Card FEC Threshold Settings

OptionsDescriptionParameter

2(Display only) Port number.Port

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for bit errors corrected.Bit Errors
Corrected
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OptionsDescriptionParameter

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for uncorrectable words.Uncorrectable
Words

Table 203: MXP_MR_10DME_C and MXP_MR_10DME_L Card Trail Trace Identifier Settings

OptionsDescriptionParameter

2(Display only) Port number.Port

• Section

• Path

Sets the level.Level

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

String of trace string sizeDisplays the current transmit string; sets a
new transmit string. You can click the button
on the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
disabled)

If a Trace Identifier Mismatch on Section
overhead alarm arises because of a J0
overhead string mismatch, no Forward
Defect Indication (FDI) signal is sent to the
downstream nodes if this box is checked.

Disable FDI on
TTIM

String of trace string sizeDisplays the current expected string; sets a
new expected string. You can click the
button on the right to change the display. Its
title changes, based on the current display
mode. Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec check box to keep
this panel updated.

Received

Step 4 Click Apply.
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Step 5 Return to your originating procedure (NTP).

NTP-G293 Modifying the 40G Muxponder Card Line Settings and
PM Parameter Thresholds

This procedure changes the line and parameter threshold settings of the
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C muxponder cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 Complete the NTP-G103 Backing Up the Database task to save the existing settings before modifying.
Step 2 Perform any of the following tasks as needed:

• DLP-G662 Changing the 40G Multirate Muxponder Card Settings

• DLP-G666 Changing the 40G Muxponder Line Settings

• DLP-G735 Provisioning the 40G Muxponder Ethernet Settings

• DLP-G667 Changing the 40G Muxponder SONET (OC-192)/SDH (STM-64) Settings

• DLP-G668 Changing the 40G Muxponder Section Trace Settings

• DLP-G669 Changing the 40G Muxponder SONET or SDH Line Thresholds

• DLP-G670 Changing the 40G Muxponder Line RMON Thresholds for Ethernet, 8G FC, or 10G FC
Payloads

• DLP-G671 Provisioning the 40G Muxponder Trunk Port Alarm and TCA Thresholds

• DLP-G672 Provisioning the 40G Muxponder Client Port Alarm and TCA Thresholds

• DLP-G673 Changing the 40G Muxponder OTN Settings
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To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the
Alarm and TCA Monitoring and Management document.

Note

Stop. You have completed this procedure.

DLP-G662 Changing the 40G Multirate Muxponder Card Settings
This task changes the card settings of the 40G-MXP-C, 40E-MXP-C, and
40ME-MXP-C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the card settings.

Step 2 Click the Provisioning > Card tabs.
Step 3 Modify either of the settings described in the following table.
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Table 204: 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Card Settings

ETSI OptionsANSI OptionsDescriptionParameter

• Muxponder

• Unidirectional Regen Set
themode to Unidirectional
Regen under the following
conditions:

• Trunk port is in
locked,disabled state.

• Pluggable port
modules of the card
must not be
configured for
payload.

• Regeneration peer
slot must be set to
None.

• Muxponder

• Unidirectional Regen Set
themode to Unidirectional
Regen under the following
conditions:

• Trunk port is in
OOS,DSBLD state.

• Pluggable port
modules of the card
must not be
configured for
payload.

• Regeneration peer
slot must be set to
None.

Sets the card mode.Card Mode

——Sets the clock selection. The line card sets the
clock switch based on the provisioning of the
card. The clock can be set in two ways: Internal
Clock and TNC Clock.

• Internal Clock: This is the default value for
normal operations; to avoid the traffic hits
in case of missing TNC.

• TNC Clock: This is the default value to
avoid traffic hit during maintenance
activities like software download. After the
maintenance activity is complete, the clock
must be set to use the internal clock.

A warning message is displayed
when the provisioning is set
because this activity affects traffic.

Note

Timing Source

——(Display only) Shows supported wavelengths of
the trunk port after the card is installed. The
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C
card that is installed shows the C-band
wavelengths that it supports.

Trunk
Wavelengths

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G666 Changing the 40G Muxponder Line Settings
This task changes the line settings of the 40G-MXP-C, 40E-MXP-C, and
40ME-MXP-C muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C or 40E-MXP-C
card where you want to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs. Tabs and parameters vary according to the PPM provisioning.
Step 3 Modify any of the settings as described in the following table.

Table 205: Line Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

OptionsDescriptionParameter

• 1 through 4 (client)

• 5 (trunk)

(Display only) Displays the port number.Port

User-defined. This can be up to 80 alphanumeric or special
characters, or both. The port name is blank by default.

You can assign a port name for each fiber
channel/FICON interface on the 40G-MXP-C,
40E-MXP-C, and 40ME-MXP-C card, enabling the
MDS Fabric Manager to associate the SAN port and
a SAN port on the Cisco MDS 9000 switch.

Note

Assigns a logical name for each of the port.Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information, see the Administrative and
Service States document.

Admin State
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OptionsDescriptionParameter

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)

(Display only) Shows the general condition of
the port. Service states appear in the format:
Primary State-Primary State Qualifier,
Secondary State. For more information about
service states, see the Administrative and
Service States document.

Service State

• Disabled (default)—ALS is off; the laser is not automatically
shut down when traffic outage or loss of signal (LOS) occurs.

• Auto Restart—(OC-192/STM-64 only) ALS is on; the laser
automatically shuts down during LOS. It automatically restarts
when the conditions that caused the outage are resolved.

• Manual Restart—ALS is on; the laser automatically shuts
down when traffic outage or LOS occurs. However, the laser
must be manually restarted when conditions that caused the
outage are resolved.

• Manual Restart for Test—Manually restarts the laser for
testing.

(Client ports only) Activates the ALS mode.ALS Mode

• Duration of valid input signal, in hh.mm format, after which
the card status changes to in service (IS) automatically

• 0 to 48 hours, 15-minute increments

Sets the automatic in-service soak period.
Double-click the time and use the up and down
arrows to the change settings.

AINS Soak
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OptionsDescriptionParameter

• Autoprovision—The system automatically provisions the
reach from the pluggable port module (PPM) reach value on
the hardware.

• EW

• LW

• SW

• LRM

• ER

• LR

• SR

• ZR

• IR 2

• LR 2

• DWDM

• CWDM40km

Sets the optical reach distance of the client
port.

Reach

• First Tunable Wavelength

• Further wavelengths: Further wavelengths in the 100-GHz
ITU-T C-band spacing. The card wavelengths are marked by
asterisks. If the card is not installed, all wavelengths appear
with a dark grey background.

Provisions the port wavelength.Wavelength

• Squelch/Laser-Off

Squelch does not apply to ISC COMPACT
payloads.

Note

• Disable/Transparent

Both Squelch/Laser-Off and AIS/Send Local
Fault options are supported when the selected
Termination Mode is Disable/Transparent. If
the Termination Mode selected is Section or
Line, then only AIS is supported. This is
applicable for OC-192/STM-64 and
OC-768/STM-256. For OTN payloads, both
Squelch/Laser-Off and AIS/Send Local Fault
options are supported.

Note

Shuts down the far-end laser in response to
certain defects.

Fault Signalling
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OptionsDescriptionParameter

• OFF (default)

• ON

Before the overclock is changed, delete any
existing 10G Ethernet LAN-Phy payload that
is present on the 40E-MXP-C and
40ME-MXP-C cards.

Note

(Trunk port only) Enables or disables
overclock mode on the trunk port.

Overclock

• First Tunable Wavelength

• Further wavelengths: Further wavelengths in the 100-GHz
ITU-T C-band spacing. The card wavelengths are marked by
asterisks. If the card is not installed, all wavelengths appear
with a dark grey background.

(Trunk port only) Provisions the trunk port
wavelength.

Rx Wavelength

• Disable (0 ms) - Default value

• 50 ms

• 100 ms

• 250 ms

• 500 ms

(Only for 40E-MXP-C card) Sets the period
in milliseconds that the client interface waits
for resolution of issues on the trunk side. The
client squelching starts after this period.

The user can configure the squelch hold off
timer in CTC only under the following
conditions:

• The card must be configured in TXP or
MXP operating modes.

• The client payload must be 10GE or
100GE.

• The Squelch drop-down in CTC must be
set to Squelch.

Squelch Hold
Off Timer

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G735 Provisioning the 40G Muxponder Ethernet Settings
This task changes the Ethernet settings for the 40G-MXP-C, 40E-MXP-C, and
40ME-MXP-C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed
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Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G Muxponder card
(40G-MXP-C, 40E-MXP-C, or 40ME-MXP-C card) where you want to change the Ethernet settings. The
card view appears.

Step 2 Click the Provisioning >Line >Ethernet tabs. The Ethernet tab is available once the 10G Ethernet LAN Phy
payload is selected as the port rate for the pluggable port module.

Step 3 Modify any of the settings for the Ethernet tab as described in the following table.

Table 206: 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Card Ethernet Settings

OptionsDescriptionParameter

—(Display only) The Port number (n-n) and rate.Port

—Allows you to enter a port name.Port Name

Jumbo: 64 to 9216 bytes (Default)(Display only) Themaximum size of the Ethernet
frames accepted by the port.

MTU

• GFP

• WIS

• CBR (only for 40E-MXP-C and 40ME-MXP-C)

CBR is automatically mapped when a
10G Ethernet LAN Phy payload is configured
with overclock on the trunk port turnedON. This
mapping cannot be changed.

Note

Sets the Ethernet mapping mode.Mapping
Mode

—Activates flow control when the check box is
selected.

Enable Flow
Control

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G667Changingthe40GMuxponderSONET(OC-192)/SDH(STM-64)Settings
This task changes the SONET OC-192 or SDH STM-64 settings for the
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C muxponder cards.

Purpose

NoneTools/Equipment
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DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the SONET (OC-192) or SDH (STM-64) settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI). Tabs and parameters vary according to
the PPM provisioning.

Step 3 Modify any of the settings described in the following table.

Table 207: Line SONET or SDH Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

OptionsDescriptionParameter

5 (Trunk)(Display only) Displays the port number.Port

User-defined. This can be up to 80 alphanumeric or special
characters, or both. The port name is blank by default.

Assigns a logical name assigned to a port. This field
is blank by default.

Port Name

• 1E-3

• 1E-4

• 1E-5

Sets the signal fail bit error rate.SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

Checked or unchecked(Display only) Displays the ProvidesSync card
parameter state.

ProvidesSync

Checked or uncheckedSets the EnableSync card parameter. Enables
synchronization status messages (S1 byte), which
allow the node to choose the best timing source.

SyncMsgIn
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OptionsDescriptionParameter

• STU—Sync traceability unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum clock

• ST4—Stratum 4

• DUS—Do not use for timing synchronization

• RES—Reserved; quality level set by user

Overrides the synchronization status message (SSM)
and the synchronization traceability unknown (STU)
value. If the node does not receive an SSM signal,
it defaults to STU.

If SyncMsgIn check box is checked in
40E-MXP-C card, the Admin SSM In
value does not change from STU.

Note

Admin SSM In

Checked or uncheckedSets the Send DoNotUse card state. When checked,
sends a DUS (do not use) message on the S1 byte.

Send DoNotUse

• SONET (ANSI)

• SDH (ETSI)

Indicates the optical transport type.Type

• Transparent

• Section (ANSI) or Regeneration Section (RS) (ETSI)

• Line (ANSI) or Multiplex Section (MS) (ETSI)

(Display-only for Standard Regeneration and
Enhanced FEC card configurations) Sets the mode
of operation.

Termination
Mode

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G668 Changing the 40G Muxponder Section Trace Settings
This task changes the section trace settings of the 40G-MXP-C, 40E-MXP-C,
and 40ME-MXP-C muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
488

Provisioning Transponder and Muxponder Cards
DLP-G668 Changing the 40G Muxponder Section Trace Settings

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to the
PPM provisioning.

Step 3 Modify any of the settings described in the following table.

Table 208: Line Section Trace Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

(Display only) Displays the port number that is applicable only for
OC-192/STM-64 payloads.

Port

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is not
disabled)

Disables the alarm indication signal.Disable
AIS/RDI on
TIM-S

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size

Transmit string sizeDisplays and sets the current transmit string. You can click the button
on the right to change the display. Its title changes, based on the
current display mode. In Transmit String Type, click Hex Mode to
change the display to hexadecimal (button changes to ASCII); click
ASCII to change the display to ASCII (button changes to HexMode).
The supported range for 1 bit Hex TX trace is 20 to 7E. If TX trace
is provisioned outside this range, client transmits 00.

Transmit

Expected string sizeDisplays and sets the current expected string. You can click the button
on the right to change the display. Its title changes, based on the
current display mode. In Expected String Type, click Hex Mode to
change the display to hexadecimal (button changes to ASCII); click
ASCII to change the display to ASCII (button changes to HexMode).
The supported range for 1 bit Hex TX trace is 20 to 7E. If TX trace
is provisioned outside this range, client transmits 00.

Expected
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OptionsDescriptionParameter

Received string size(Display only) Displays the current received string. Click Refresh to
manually refresh this display, or check the Auto-refresh every 5 sec
check box to keep this panel updated.

Received

• Checked

• Unchecked (default)

Automatically refreshes the display every 5 seconds.Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G691 Changing the 40G Muxponder OTU Settings
This task changes the OTU settings of the 40G-MXP-C, 40E-MXP-C, and
40ME-MXP-C muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the OTU settings.

Step 2 Click the Provisioning > Line > OTU tabs. Tabs and parameter selections vary according to the PPM
provisioning.

Step 3 Modify any of the settings described in the following table.

Table 209: OTU Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

• 1-1

• 2-1

• 3-1

• 4-1

(Display only) Displays the port number
that is applicable only for
OC-192/STM-64 payloads.

Port
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ETSI OptionsANSI OptionsDescriptionParameter

Checked or uncheckedChecked or unchecked(Display only) (OC-768/STM-256 only)
Sets the EnableSync card parameter.
Enables synchronization statusmessages
(S1 byte), which allow the node to
choose the best timing source.

SyncMsgIn

• G811—Primary reference clock

• STU—Sync traceability
unknown

• G812T—Transit node clock
traceable

• G812L—Local node clock
traceable

• SETS—Synchronous equipment

• DUS—Do not use for timing
synchronization

• PRS—Primary Reference
Source (Stratum 1)

• STU—Sync traceability
unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum
clock

• ST4—Stratum 4

• DUS—Do not use for timing
synchronization

• RES—Reserved; quality level
set by user

Overrides the synchronization status
message (SSM) and the synchronization
traceability unknown (STU) value. If
the node does not receive an SSM
signal, it defaults to STU.

Admin SSM

Checked or uncheckedChecked or unchecked(Display only) (OC-768/STM-256 only)
Sets the ProvidesSync card parameter.
If checked, the card is provisioned as a
network element (NE) timing reference.

ProvidesSync

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G669 Changing the 40G Muxponder SONET or SDH Line Thresholds
This task changes the SONET or SDH line threshold settings of the
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C muxponder cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) tabs.
Step 3 Modify any of the settings shown in the following table. Some parameters and options do not apply to all

40-G-MXP-C cards. If the parameter or options do not apply, they do not appear in CTC.

Table 210: Line Threshold Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

ETSI OptionsANSI OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

• 1-1

• 2-1

• 3-1

• 4-1

(Display only) Port
number. Applicable for
only OC-192/STM-64
payloads.

Port

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option individually in each
category and click Refresh.

Coding violationsCV

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option individually in each
category and click Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option individually in each
category and click Refresh.

Errored secondsES
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ETSI OptionsANSI OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option individually in each
category and click Refresh.

Click Reset to Default to restore default
values.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option individually in each
category and click Refresh.

Click Reset to Default to restore default
values.

Severely errored
seconds

SES

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option individually in each
category and click Refresh.

Click Reset to Default to restore default
values.

(Line or Multiplex
Section only) Failure
count

FC

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option individually in each
category and click Refresh.

Click Reset to Default to restore default
values.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option individually in each
category and click Refresh.

Click Reset to Default to restore default
values.

(Line or Multiplex
Section only)
Unavailable seconds

UAS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
493

Provisioning Transponder and Muxponder Cards
DLP-G669 Changing the 40G Muxponder SONET or SDH Line Thresholds



DLP-G670 Changing the 40G Muxponder Line RMON Thresholds for Ethernet,
8G FC, or 10G FC Payloads

This task changes the line threshold settings of 40G-MXP-C, or 40E-MXP-C
card carrying Ethernet, 8G FC, or 10G FC payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), display the 40G-MXP-C, or 40E-MXP-C
card where you want to change the line threshold settings in the card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
Step 3 Click Create. The Create Threshold dialog box appears.
Step 4 From the Port drop-down list, choose the payload port— for example “1-1 (TEN_GE)”, or the equivalent

ITU-T G.7041 GFP (Generic Frame Procedure) port.
Step 5 From the Variable drop-down list, choose an Ethernet or FC variable.

Table 211: Ethernet Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets

Total number of received packets.rxTotalPkts

Number of packets, delivered by this sub-layer to a higher sub-layer,
which were not addressed to a multicast or broadcast address at this
sub-layer.

ifInUcastPkts

Number of packets, delivered by this sub-layer to a higher sub-layer,
which were addressed to a multicast address at this sub-layer. For
a MAC layer protocol, this includes both Group and Functional
addresses.

inInMulticastPkts

Number of packets, delivered by this sub-layer to a higher sub-layer,
which were addressed to a broadcast address at this sub-layer.

ifInBroadcastPkts

Total number of received errors.ifInErrors

Total number of octets transmitted out of the interface, including
framing characters.

ifOutOctets
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DescriptionVariable

Total number of transmitted packets.txTotalPkts

Count of frames received on a particular interface that are an integral
number of octets in length but do not pass the Frame Check
Sequence (FCS) check.

dot3StatsFCSErrors

Count of frames received on a particular interface that exceed the
maximum permitted frame size.

dot3StatsFrameTooLong

Count of frames received on this interface with an opcode indicating
the PAUSE operation.

dot3StatsInPauseFrames

Count of MAC control frames transmitted on this interface with an
opcode indicating the PAUSE operation.

dot3StatsOutPauseFrames

Total number of packets transmitted and received by the interface
that were less than 64 octets long (excluding framing bits, but
including FCS octets) and were otherwise well formed.

etherStatsUndersizePkts

Total number of packets received that were less than 64 octets in
length (excluding framing bits but including FCS octets) and had
either a bad Frame Check Sequence (FCS) with an integral number
of octets (FCS Error) or a bad FCS with a non-integral number of
octets.

etherStatsFragments

Total number of packets (including bad packets, broadcast packets,
and multicast packets) transmitted and received by the interface.

etherStatsPkts

Total number of packets (including bad packets) transmitted and
received by the interface that were 64 octets in length (excluding
framing bits but including FCS octets).

etherStatsPkts64Octets

Total number of packets (including error packets) transmitted and
received by the interface that were between 65 and 127 octets in
length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts65to127Octets

Total number of packets (including error packets) transmitted and
received by the interface that were between 128 and 255 octets in
length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts128to255Octets

Total number of packets (including error packets) transmitted and
received by the interface that were between 256 and 511 octets in
length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts256to511Octets

Total number of packets (including error packets) transmitted and
received by the interface that were between 512 and 1023 octets in
length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts512to1023Octets

Total number of packets (including error packets) transmitted and
received by the interface that were between 1024 and 1518 octets
in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts1024to1518Octets
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DescriptionVariable

Total number of good packets transmitted and received by the
interface that were directed to the broadcast address.

etherStatsBroadcastPkts

Total number of good packets transmitted and received by the
interface that were directed to a multicast address. Note that this
number does not include packets directed to the broadcast address.

etherStatsMulticastPkts

Total number of packets transmitted and received by the interface
that were longer than 1518 octets (excluding framing bits, but
including FCS octets) and were otherwise well formed.

etherStatsOversizePkts

Total number of packets transmitted and received by the interface
that were longer than 1518 octets (excluding framing bits, but
including FCS octets), and were not an integral number of octets in
length or had a bad FCS.

etherStatsJabbers

Total number of octets of data (including those in bad packets)
transmitted and received by the interface on the network (excluding
framing bits but including FCS octets).

etherStatsOctets

Table 212: FC Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets

Total number of received packets.rxTotalPkts

Total number of received errors.ifInErrors

Total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of transmitted packets.txTotalPkts

Number of outbound packets or transmission units that could
not be transmitted because of errors.

ifOutErrors

Total number of frames received that are less than 5 bytes. This
value is a part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTruncated

Number of received frames that exceed the MTU. This value
is part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong

Number of receive data frames with payload CRC errors when
HDLC framing is used.

mediaIndStatsRxFramesBadCRC

Number of transmitted data frames with payload CRC errors
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC

Total number of transmitted data frames that are less than
5 bytes. This value is a part of HDLC and GFP port statistics.

mediaIndStatsTxFramesTooLong
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DescriptionVariable

Number of transmitted data frames that exceed the MTU. This
value is part of HDLC and GFP port statistics.

mediaIndStatsTxFramesTruncated

Table 213: GFP RMON Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

DescriptionVariable

Total number of received data frames.gfpStatsRxFrame

Total number of transmitted data frames.gfpStatsTxFrame

Total number of superblock CRC errors with the receive
transparent GFP frame. A transparent GFP frame has multiple
superblocks where each contains Fibre Channel data.

gfpStatsRxSblkCRCErrors

Total number of GFP data octets received.gfpStatsRxOctets

Total number of GFP data octets transmitted.gfpStatsTxOctets

Received GFP frames with single bit errors in the core header
(these errors can be corrected).

gfpStatsRxSBitErrors

ReceivedGFP frames withmultiple bit errors in the core header
(these errors cannot be corrected).

gfpStatsRxMBitErrors

Received GFP frames with invalid type (these are discarded).
For example, receiving GFP frames that contain Ethernet data
when we expect Fibre Channel data.

gfpStatsRxTypeInvalid

Count of core HEC CRC multiple bit errors.

This count is only of eHec multiple bit errors
when in frame. This can be looked at as a count
of when the state machine goes out of frame.

Note

gfpStatsLFDRaised

—gfpRxCmfFrame

—gfpTxCmfFrame

Step 6 From the Alarm Type drop-down list, choose an alarm type. The alarm type indicates whether or not an event
is triggered by the type of threshold.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold
to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total
number of occurrences, regardless of time period.

Step 8 Enter the number of Sample Period occurrences.
Step 9 Enter the number of Rising Threshold occurrences.

To trigger the alarm, the measured value of a threshold must always move from below the falling threshold
to above the rising threshold. For example, if a network moves from below a rising threshold of 1000 collisions
every 15 seconds to 1001 collisions.
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Step 10 Enter the appropriate number of occurrences for the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the exact opposite of a rising threshold. When the number of occurrences is above the
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the
network problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15
seconds, occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that
if network collisions again spike over a 1000 per 15-second period, an event again triggers when the rising
threshold is crossed. An event is triggered only the first time a rising threshold is exceeded.

Step 11 Click OK.
Step 12 Return to your originating procedure (NTP).

DLP-G671 Provisioning the 40G Muxponder Trunk Port Alarm and TCA
Thresholds

This task changes the trunk port alarm and TCA thresholds of the 40G-MXP-C,
40E-MXP-C, and 40ME-MXP-C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.

You must modify 15 Min and 1 Day independently. To do so, select the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

Step 3 If TCA is not selected, click TCA and then click Refresh. If it is selected, continue with Step 4.
Step 4 Verify the trunk port (Port 5) TCA thresholds are set at the values shown as follows:

• Laser Bias High (%): 95.0

• RX Power High (dBm): –9.0

• RX Power Low (dBm): –22.0
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• TX Power High (dBm): 9.0

• TX Power Low (dBm): 0.0

Provision new thresholds as needed by replacing the old values with new ones.

Step 5 Under Types area, click the Alarm radio button and click Refresh.

Do not modify the Laser Bias parameters.Note

Step 6 Verify the trunk port (Port 5) alarm thresholds are set at the values shown as follows:

• Laser Bias High (%): 98.0

• RX Power High (dBm): –8.0

• RX Power Low (dBm): –24.0

• TX Power High (dBm): 7.0

• TX Power Low (dBm): 3.0

Provision new thresholds as needed replacing the old values with new ones.

Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).

DLP-G672 Provisioning the 40G Muxponder Client Port Alarm and TCA
Thresholds

This task provisions the client port alarm and TCA thresholds of the
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.
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Step 3 If TCA is not selected, click TCA and then click Refresh. If it is selected, continue with Step 4.
Step 4 Referring to the following table, verify the client ports (Ports 1 through 4) TCA thresholds for RX Power

High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end.
Provision new thresholds as needed by replacing the old values with new ones.

Do not modify the Laser Bias parameters.Note

You must modify 15 Min and 1 Day independently. To do so, select the appropriate radio button
and click Refresh.

Note

Table 214: Client Interfaces TCA Thresholds of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module (XFP)PPM Port Rate

0.09.0–22–9ONS-XC-8G-FC-SMFC8G

0.09.0–22–9ONS-XC-10G-1470 through
ONS-XC-10G-1610
ONS-XC-10G-C
ONS-XC-10G-S1

FC10G

–7.08.0–15.82.0ONS-XC-10G-I2

–12.05.0–14.01.0ONS-XC-10G-L2

–6.06.00.00.0ONS-XC-10G-SR-MM

0.09.0–22–9ONS-XC-10G-30.3 through
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-SR-M
ONS-XC-10G-S1

10GE

–7.08.0–15.82.0ONS-XC-10G-I2

–2.56.5–24.0–7.0ONS-XC-10G-L2

0.09.0–22–9ONS-XC-10G-30.3 through
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 through
ONS-XC-10G-1610
ONS-XC-10G-I2
ONS-XC-10G-SR-MM

OC-192

–8.08.0–26.0–9.0ONS-XC-10G-L2

–12.05.0–11.0–1.0ONS-XC-10G-S1
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TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module (XFP)PPM Port Rate

0.09.0–22–9ONS-XC-10G-30.3 through
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 through
ONS-XC-10G-1610
ONS-XC-10G-I2
ONS-XC-10G-L2
ONS-XC-10G-SR-MM
ONS-XC-10G-S1

OTU2

Step 5 Click Apply.
Step 6 Repeat Steps 3 and 4 to provision the additional client ports.
Step 7 Under Types area, click the Alarm radio button and click Refresh.
Step 8 Referring to the following table, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power

High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.
Provision new thresholds as needed replacing the old values with new ones.

Table 215: Client Interface Alarm Thresholds of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module (XFP)PPM Port Rate

0.09.0–22–9ONS-XC-8G-FC-SM
ONS-XC-10G-S1

FC8G

0.09.0–22–9ONS-XC-10G-30.3 through
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 through
ONS-XC-10G-1610
ONS-XC-10G-S1

FC10G

–3.54.5–18.34.5ONS-XC-10G-I2

–2.56.5–26.5–4.5ONS-XC-10G-L2

–2.02.0–2.02.0ONS-XC-10G-SR-MM

0.09.0–22–9ONS-XC-10G-30.3 through
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-S1
ONS-XC-10G-SR-MM

10GE

–3.54.5–18.34.5ONS-XC-10G-I2

–2.56.5–26.5–4.5ONS-XC-10G-L2
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Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module (XFP)PPM Port Rate

0.09.0–22–9ONS-XC-10G-30.3 through
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 through
ONS-XC-10G-1610
ONS-XC-10G-I2
ONS-XC-8G-FC-SM
ONS-XC-10G-SR-MM

OC-192

–4.04.0–28.0–7.0ONS-XC-10G-L2

–8.01.0–13.0–1.0ONS-XC-10G-S1

0.09.0–22–9ONS-XC-10G-30.3 through
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 through
ONS-XC-10G-1610
ONS-XC-10G-S1
ONS-XC-10G-I2
ONS-XC-10G-L2
ONS-XC-8G-FC-SM
ONS-XC-10G-SR-MM

OTU2

Step 9 Click Apply.
Step 10 Repeat Steps 7 and 8 to provision additional client ports.
Step 11 Return to your originating procedure (NTP).

DLP-G673 Changing the 40G Muxponder OTN Settings
This task changes the OTN settings for the 40G-MXP-C, 40E-MXP-C, and
40ME-MXP-C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 40E-MXP-C
card where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, ITU-T G.709
Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in the following tables.

You must modify Near End and Far End, 15 Min and 1 Day, and SM and PM independently. To
do so, select the appropriate radio button and click Refresh.

Note

Table 216: OTN Line Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

(Display only) Displays the port number.

Applicable for trunk ports and ports with
OTU2 payload.

Port

• Enable

• Disable

Sets the OTN lines according to
ITU-T G.709.

ITU-T G.709
Thresholds

• Standard

• Enhanced

Sets the OTN lines to forward error
correction (FEC).

FEC

• 1E-5(Display only) Sets the signal fail bit error
rate.

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
503

Provisioning Transponder and Muxponder Cards
DLP-G673 Changing the 40G Muxponder OTN Settings



Table 217: ITU-T G.709 Threshold Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

(Display only) Displays the port
number.

Applicable for trunk ports and
ports with OTU2 payload.

Port

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or PM
(ODUk). Select the radio button individually and click
Refresh.

Click Reset to Default to restore default values.

Errored secondsES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or PM
(ODUk). Select the radio button individually and click
Refresh.

Severely errored secondsSES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or PM
(ODUk). Select the radio button individually and click
Refresh.

Unavailable secondsUAS

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or PM
(ODUk). Select the radio button individually and click
Refresh.

Background block errorsBBE

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or PM
(ODUk). Select radio button individually and click
Refresh.

Failure counterFC

Table 218: FEC Threshold Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

(Display only) Displays the port number.

Applicable for trunk ports and ports with
OTU2 payload.

Port
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OptionsDescriptionParameter

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for bit errors corrected.Bit Errors
Corrected

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for uncorrectable words.Uncorrectable
Words

Table 219: Trail Trace Identifier Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

OptionsDescriptionParameter

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

(Display only) Displays the port number.

Applicable for trunk ports and ports with
OTU2 payload.

Port

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is not
disabled)

Disables alarm indication signal.Disable
AIS/RDI on
TIM-S

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size

Transmit string sizeDisplays and sets the current transmit string.
You can click the button on the right to
change the display. Its title changes, based
on the current display mode. In Transmit
String Type, click Hex Mode to change the
display to hexadecimal (button changes to
ASCII); click ASCII to change the display
to ASCII (button changes to Hex Mode).

Transmit

Expected string sizeDisplays and sets the current expected string.
You can click the button on the right to
change the display. Its title changes, based
on the current display mode. In Expected
String Type, click Hex Mode to change the
display to hexadecimal (button changes to
ASCII); click ASCII to change the display
to ASCII (button changes to Hex Mode).

Expected
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OptionsDescriptionParameter

Received string size(Display only) Displays the current received
string. Click Refresh to manually refresh this
display, or check the Auto-refresh every 5
sec check box to keep this panel updated.

Received

• Checked

• Unchecked (default)

Refreshes the display automatically every 5
seconds.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

NTP-G281 Managing the GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE Card Channel Group Settings

This procedure changes the channel group settings for GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G46 Log into CTC

• DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
Card Mode, on page 311

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Perform any of the following tasks as needed:

• DLP-G611 Creating a Channel Group Using CTC

• DLP-G612 Modifying the Parameters of the Channel Group Using CTC

• DLP-G613 Managing Ports in a Channel Group, on page 513

• DLP-G614 Deleting a Channel Group, on page 513
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• DLP-G615 Retrieving Information on Channel Group, REP, CFM, and EFM, on page 514

• DLP-G616 Viewing PM Parameters of a Channel Group, on page 515

• DLP-G617 Viewing Utilization PM Parameters of a Channel Group, on page 516

• DLP-G618 Viewing History PM Parameters of a Channel Group, on page 516

• DLP-G619 Create a Channel Group on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using
PCLI

• DLP-G620 Add Ports to a Channel Group on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Using PCLI

Stop. You have completed this procedure.

DLP-G611 Creating a Channel Group Using CTC
This task creates a channel group on the GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

You can create up to 11 channel groups on the GE_XP and GE_XPE cards and up to 2 channel groups on the
10GE_XP and 10GE_XPE cards. You can create a channel group with ports only when the ports do not have
any UNI QinQ settings or NNI SVLAN settings. Otherwise, the channel group will be created with empty
ports.

Note

For information about interaction of LACP with other protocols, see the Protocol Compatibility list, on page
179.

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed according to the requirements
specified in Cable Connections for Y-Cable Protection of One Client Signal table.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 3 In card view, click the Provisioning > Channel Groups tabs.
Step 4 Click Create. The Channel Group Creation dialog box appears.
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Step 5 Enter the name of the channel group in the Name field.
Step 6 From the Stand Alone list, choose the ports that will belong to this channel group and click the right arrow

button to move the selected ports to the Bundled list.
Step 7 From the LACP Mode drop-down list, choose the LACP mode as needed:

• On—Default mode. In this mode, the ports will not exchange LACP packets with the partner ports.

• Active—In this mode, the ports will send LACP packets at regular intervals to the partner ports.

• Passive—In this mode, the ports will not send LACP packets until the partner ports send LACP packets.
After receiving the LACP packets from the partner ports, the ports will send LACP packets.

Step 8 From the LACP Hashing drop-down list, select the LACP hashing algorithm that the protocol uses to perform
the load balancing task between the bundled ports.

The following hashing algorithms are supported:

• Ucast SA VLAN Incoming Port

• Ucast DA VLAN Incoming Port

• Ucast SA DA VLAN Incoming port

• Ucast Src IP TCP UDP

• Ucast Dst IP TCP UDP

• Ucast Src Dst IP TCP UDP

Step 9 Click Create.

A new row is added in the LACP table and all the other parameters in the channel group are set to default
values. The default values of these parameters are taken from the first port that is attached to the channel
group.

Step 10 Return to your originating procedure (NTP).

DLP-G612 Modifying the Parameters of the Channel Group Using CTC
This task modifies the parameters of the channel group.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Ports cannot be added or removed using this procedure. For adding or removing the ports, see the DLP-G613
Managing Ports in a Channel Group, on page 513.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to modify the parameters of the channel group.

Step 2 In card view, click the Provisioning > Channel Groups tabs.
Step 3 Choose a channel group from the existing channel groups.
Step 4 Modify the channel group settings as described in the following table.

Table 220: Channel Group Settings

OptionsDescriptionParameter

N.A.(Display only) ID and name of the channel group.Channel Group

—Sets the name of the channel group.Name

N.A.(Display only) Port number (n-n) and rate (GE or
TEN_GE of the channel group).

Ports

• On

• Active

• Passive

Sets the LACP mode. The channel group must be in
OOS-DSBLD admin state.

LACP Mode

• Ucast SA VLAN
Incoming Port

• Ucast DA VLAN
Incoming Port

• Ucast SA DA VLAN
Incoming port

• Ucast Src IP TCP
UDP

• Ucast Dst IP TCP
UDP

• Ucast Src Dst IP TCP
UDP

Sets the LACP hashing algorithm. The channel group
must be in OOS-DSBLD admin state.

Hashing

• IS

• OOS, DSBLD

Sets the administrative state on the channel group.Admin State

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
509

Provisioning Transponder and Muxponder Cards
DLP-G612 Modifying the Parameters of the Channel Group Using CTC



OptionsDescriptionParameter

• IS-NR

• OOS-MA, DSBLD

(Display only) Sets the service state that indicates the
operational state of the channel group.

Service State

Numeric. Default: 9700

Range: 64 to 9700

Sets the maximum transfer unit (MTU), which sets the
maximum number of bytes per frame accepted on the
port. Themember ports must be in OOS-DSBLD admin
state. The default MTU value in the channel group is
taken from the default settings in the node.

MTU

• Auto

• 1000 Mbps

Sets the provisional port mode. If the port mode is
Auto, the Expected Speed field determines which ports
can belong to the bundle. The member ports must be
in OOS-DSBLD admin state.

Mode

• 10 Mbps

• 100 Mbps

• 1000 Mbps

Sets the expected speed of ports of the channel group.
The channel group must be in OOS-DSBLD admin
state.

Expected Speed

• Full(Display only) Expected duplex capability of ports of
the channel group.

Duplex

Numeric. Default: 100%

Range: 0 to 100%

Granularity: 0.1%

Sets the guaranteed information rate based on the
service-level agreement of the service provider. The
channel group must be in OOS-DSBLD admin state.

Committed Info
Rate

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1M

• 2M

• 4M

• 8M

• 16M

Sets the maximum number of bits transferred per
second. The channel group must be in OOS-DSBLD
admin state.

Committed Burst
Size
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OptionsDescriptionParameter

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1M

• 2M

• 4M

• 8M

• 16M

Sets the maximum number of bits credited for later
transfer if the committed burst rate cannot be
transmitted. The channel group must be in
OOS-DSBLD admin state.

Excess Burst Size

• UNI Mode
(Default)—provisions
the port as a
User-Network
Interface (UNI). This
is the interface that
faces the subscriber.

• NNI
Mode—provisions the
port as a
Network-to-Network
Interface (NNI). This
is the interface that
faces the service
provider network.

Sets the network interface mode (NIM) for the channel
group. The member ports must be in OOS-DSBLD
admin state.

The channel group NIM is set to UNI or NNI based on
the mode of the first port that is added to the channel
group.

NIM
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OptionsDescriptionParameter

• 0

• 1

• 2

• 3

• 4

• 5

• 6

• 7

• Trust

• CVLAN

• DSCP

Provisions the IEEE 802.1p ingress class of service
(CoS). Ingress CoS is used to set the priority of the
Ethernet frame in the service provider network. The
member ports must be in OOS-DSBLD admin state.

Ingress CoS

Numeric.

Default: 8100 (IEEE Std
802.1Q customer VLAN
tag type)

Range: 0x600 to 0xffff.

Defines the inner Ethertype field. The Ethertype field
indicates which protocol is being transported in an
Ethernet frame. The member ports must be in
OOS-DSBLDadmin state tomodify the Inner Ethertype
value to a non-default value.

Inner Ethertype
(Hex)

Numeric.

Default: 8100 (IEEE
standard 802.1Q service
provider VLAN tag type)

Range: 0x600 to 0xffff

Defines the outer Ethertype field. The Ethertype field
identifies which protocol is being transported in an
Ethernet frame. The member ports must be in
OOS-DSBLD admin state.

Outer Ethertype
(Hex)

• Checked—MAC
learning is enabled for
this port.

• Unchecked—(Default)
MAC learning is
disabled for this port.

Enables or disables MAC learning for the port on
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.
MAC learning is used by Layer 2 switches to learn the
MAC addresses of network nodes so that the Layer 2
switches send traffic to the right location. In GE_XPE
or 10GE_XPE cards, enableMAC address learning per
SVLAN.

MAC Learning

When you set the Committed Info Rate above 40% on 10GE_XP and 10GE_XPE cards, the
Committed Burst Size and Excess Burst Size must be set to at least 32K. The Committed Burst
Size and Excess Burst Size can be increased based on the packet size and Committed Info Rate
value.

Note

Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).
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DLP-G613 Managing Ports in a Channel Group
This task adds or removes ports to or from an existing channel group.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

• You can assign up to eight ports to a channel group on GE_XP and GE_XPE cards and up to three ports
on the 10GE_XP and 10GE_XPE cards.

• You can assign the ports to a channel group only if the ports are in OOS-DSBLD admin state. The ports
must not have any UNI QinQ rule or NNI SVLAN configuration.

• If the channel group is configured in UNI mode, only the UNI ports can be added to the channel group.
If the channel group is configured in NNI mode, only the NNI ports can be added to the channel group.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to add ports to an existing channel group.

Step 2 In card view, click the Provisioning > Channel Groups tabs.
Step 3 Choose a channel group from the existing channel groups.
Step 4 Click Add/Remove Ports.
Step 5 To add ports to an existing channel group, from the Stand Alone list, choose the required ports and click the

right arrow button to move the selected ports to the Bundled list.
Step 6 To remove ports from an existing channel group, complete the following: from the Bundled list, choose the

required ports and click the left arrow button to move the selected ports to the Stand Alone list.
Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).

DLP-G614 Deleting a Channel Group
This task deletes a channel group.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XP card where you want to delete the channel group.

Step 2 In card view, click the Provisioning > Channel Groups tabs.
Step 3 Choose a channel group that you want to delete.
Step 4 Click Delete.
Step 5 Return to your originating procedure (NTP).

DLP-G615 Retrieving Information on Channel Group, REP, CFM, and EFM
This task enables you to view and retrieve information on the channel group,
Resilient Ethernet Protocol (REP), Connectivity Fault Management (CFM),
and Ethernet in the First Mile (EFM) on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311

Step 2 In card view, click the Maintenance > Show Commands tabs.
Step 3 From the Command drop-down list, choose a command.

The following commands are supported:

• ETHLACP—Displays detailed LACP information from the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards.

• REP TOPO—Displays the topology information for a specific REP segment.

• REP TOPO ARCHIVE—Displays the previous topology information for a specific REP segment.
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• REP INTERFACE—Displays information on the REP interface status and configuration. You can retrieve
detailed information for each segment by selecting Detailed from the Level drop-down list and providing
the segment ID.

• OAM DISCOVERY—Displays discovery information for all the EFM interfaces or for a specific EFM
interface.

• OAM SUMMARY—Displays the active EFM sessions on a device.

• OAM STATISTICS—Displays detailed information about the EFM packets.

• OAM STATUS—Displays information about the EFM configurations for all the EFM interfaces or for
a specific interface.

For more information, see the Pseudo Command Line Interface Reference document.

Step 4 From the Level drop-down list, choose Normal or Detailed.
Step 5 Click Show. Depending on the command, the appropriate output appears in the text area.
Step 6 Return to your originating procedure (NTP).

DLP-G616 Viewing PM Parameters of a Channel Group
This task enables you to view current statistical performance monitoring
(PM) counts on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards
and channel groups to detect possible performance problems.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to view the channel group statistics. The card view appears.

Step 2 Click the Performance > Channel Groups > Statistics tabs.
Step 3 Click Refresh. Performance monitoring statistics for each channel group on the card appear in the Statistics

tab.

View the PM parameter names in the Param column. The current PM parameter values appear in the Port #
(CHGRP) column. For PM parameter definitions, see the Monitor Performance document.

To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure.Note
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Step 4 Return to your originating procedure (NTP).

DLP-G617 Viewing Utilization PM Parameters of a Channel Group
This task enables you to view line utilization PM counts on the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards and channel groups to detect
possible performance problems.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 In node view, double-click the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card where you want to view
the channel group utilization. The card view appears.

Step 2 Click the Performance > Channel Groups > Utilization tabs.
Step 3 Click Refresh. The utilization percentages for each channel group on the card appear in the Utilization tab.

View the Port # column to find the channel group you want to monitor.

The transmit (Tx) and receive (Rx) bandwidth utilization values, for the previous time intervals, appear in the
Prev-n columns. For PM parameter definitions, see the Monitor Performance document.

To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure.Note

Step 4 Return to your originating procedure (NTP).

DLP-G618 Viewing History PM Parameters of a Channel Group
This task enables you to view historical PM counts at selected time intervals
on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards and channel groups
to detect possible performance problems.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Retrieve or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE card where you want to view the channel group history PM data. The card view
appears.

Step 2 Click the Performance > Channel Groups > History tabs.
Step 3 From the Port field, choose a channel group.
Step 4 Click Refresh. Performance monitoring statistics for each channel group on the card appear in the History

tab.

View the PM parameter names that appear in the Param column. The PM parameter values appear in the
Prev-n columns. For PM parameter definitions, see the Monitor Performance document.

To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure.Note

Step 5 Return to your originating procedure (NTP).

NTP-G283 Managing the Card CFM Settings
This procedure changes the CFM settings for GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

• DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
Card Mode, on page 311

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Perform any of the following tasks as needed:

• DLP-G621 Enabling CFM on a Card

• DLP-G622 Enabling CFM for a Port

• DLP-G623 Creating a Maintenance Domain Profile
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• DLP-G624 Deleting a Maintenance Domain Profile

• DLP-G625 Creating a Maintenance Association Profile

• DLP-G626 Modifying a Maintenance Association Profile

• DLP-G627 Deleting a Maintenance Association Profile

• DLP-G628 Mapping Profiles

• DLP-G629 Creating a MEP

• DLP-G630 Deleting a MEP

• DLP-G631 Creating a MIP

• DLP-G632 Deleting a MIP

• DLP-G633 Pinging a MEP

• DLP-G634 Displaying Output of a Traceroute MEP

• DLP-G635 Enable CFM on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• DLP-G615 Retrieving Information on Channel Group, REP, CFM, and EFM

• DLP-G636 Create a Maintenance Domain on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Using PCLI

• DLP-G637 Create aMaintenance Intermediate Point on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
Cards Using PCLI

• DLP-G638 Create a Maintenance End Point on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Using PCLI

Stop. You have completed this procedure.

DLP-G621 Enabling CFM on a Card
This task allows you to enable or disable CFM on GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level
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CFM is disabled on the card by default. CFMmust be enabled at both card and port levels for the CFM service
to work.

Note

For information about interaction of CFM with other protocols, see the “Protocol Compatibility list” section.

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > Security tab.
Step 3 Uncheck the MAC security check box to disable MAC security.
Step 4 In card view, click the Provisioning > CFM > Configuration > Global Settings tabs.
Step 5 Check the Enable CFM check box that is present at the bottom of the screen.
Step 6 Choose the value for CC Timer field. The value can be 1 second, 10 seconds, or 1 minute.

Continuity Check (CC) messages are periodically exchanged between maintenance end points
(MEPs). The CC Timer field is used to set the time frequency for transmission of CC messages.

Note

Step 7 Click Apply to enable CFM on the card.

Uncheck the Enable CFM check box to disable CFM on the card.Note

Step 8 Return to your originating procedure (NTP).

DLP-G622 Enabling CFM for a Port
This task allows you to enable or disable CFM for each port on GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311
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CFM must be enabled at both card and port levels for the CFM service to work. However, CFM
is enabled on all the ports by default.

Note

Step 2 In card view, click the Provisioning > CFM > Configuration > Global Settings tabs.
Step 3 If you want to enable CFM on a specific port, check the Enable CFM check box against that port.
Step 4 Choose the value for CC Timer field. The value can be 1 second, 10 seconds, or 1 minute.

Continuity Check (CC)messages are periodically exchanged betweenMEPs. The CCTimer field
is used to set the time frequency for transmission of CC messages.

Note

Step 5 Click Apply to enable CFM on the port.

Uncheck the Enable CFM check box against the port to disable CFM on the port.Note

Step 6 Return to your originating procedure (NTP).

DLP-G623 Creating a Maintenance Domain Profile
This task allows you to create a maintenance domain profile on the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

You can create up to eight maintenance domain profiles on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards. Themaximum number of characters for the maintenance domain profile and the maintenance association
profile must not exceed 43 characters.

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > Domain Profiles tabs or in node/network
view, click the Provisioning > CFM Profiles > Domain Profiles tabs.

Use the network view to store the domain profile on multiple nodes.Note

Step 3 Click Add row(s).
Step 4 Enter the name of the domain in the Domain Name field.
Step 5 Enter the level of the domain profile in the Level field. The range of the domain profile level is from 0 to 7.
Step 6 Click Store.
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Step 7 Choose the card slot where you want to store this domain profile and click OK.
Step 8 Return to your originating procedure (NTP).

DLP-G624 Deleting a Maintenance Domain Profile
This task allows you to delete a maintenance domain profile on the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > Domain Profiles tabs or in node/network
view, click the Provisioning > CFM Profiles > Domain Profiles tabs.

Step 3 Select the domain profiles that you want to delete.
Step 4 Check the on Node check box.
Step 5 Click Delete Sel. row(s).
Step 6 Choose the card slot where you want to delete this profile and click OK.
Step 7 In the Deleting Profile dialog box, click Yes.
Step 8 Return to your originating procedure (NTP).

DLP-G625 Creating a Maintenance Association Profile
This task allows you to create a maintenance association profile on GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level
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You can create up to 1500 maintenance association profiles on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards.

Note

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
theDLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > MA Profiles tabs or in node/network view,
click the Provisioning > CFM Profiles > MA Profiles tabs.

Use the network view to store the maintenance association profile on multiple nodes.Note

Step 3 Click Add row(s).
Step 4 Enter the name of the maintenance association in the Maintenance Profile Name field.
Step 5 Enter the VLAN ID in the VLAN ID field. The range of the VLAN ID is from 1 to 4093.
Step 6 Check the CC Enable check box to receive Continuity Check messages.
Step 7 Click Store.
Step 8 Choose the card slot where you want to store this maintenance association profile and click OK.
Step 9 Return to your originating procedure (NTP).

DLP-G626 Modifying a Maintenance Association Profile
This task allows you tomodify amaintenance association profile on GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Ensure that the maintenance association profile you want to modify is not associated with a maintenance
domain profile.

Note
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Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > MA Profiles tabs or in node/network view,
click the Provisioning > CFM Profiles > MA Profiles tabs.

Step 3 Select the maintenance association profiles that you want to modify.
Step 4 Click Modify Selected Profile(s).
Step 5 Modify the values as required and click OK.
Step 6 Return to your originating procedure (NTP).

DLP-G627 Deleting a Maintenance Association Profile
This task allows you to delete a maintenance association profile on GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Ensure that the maintenance association profile you want to delete is not associated with a maintenance domain
profile.

Note

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > MA Profiles tabs or in node/network view,
click the Provisioning > CFM Profiles > MA Profiles tabs.

Step 3 Select the maintenance association profiles that you want to delete.
Step 4 Check the on Node check box.
Step 5 Click Delete Sel. row(s).
Step 6 Choose the card slot where you want to delete this profile and click OK.
Step 7 In the Deleting Profile dialog box, click Yes.
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Step 8 Return to your originating procedure (NTP).

DLP-G628 Mapping Profiles
This task allows you to map a maintenance association profile to a
maintenance domain profile on the GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Ensure that you have already created maintenance domain profiles and maintenance association profiles.Note

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > MA-Domain Mapping tabs.
Step 3 From the main drop-down list, choose a maintenance domain profile.
Step 4 Click Link MA Profiles.
Step 5 From the Available Profiles list, choose the required MA profiles and click the right arrow button to move

the MA profiles to the Linked Profiles list and click OK.

Themaintenance association profiles that are mappedwith a specific maintenance domain profile
must have a unique SVLAN ID.

Note

Step 6 Return to your originating procedure (NTP).

DLP-G629 Creating a MEP
This task allows you to create a Maintenance End Point (MEP) for a given
VLAN range on a specific maintenance domain.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

You can create up to 255 MEPs and MIPs on the GE_XP and 10GE_XP cards. You can create up to 500
MEPs and MIPs on the GE_XPE and 10GE_XPE cards.

Note

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > MEP tabs.
Step 3 Click Create.
Step 4 From the Port drop-down list, choose a port where you want to create the MEP.

CFM must be enabled on the port to create a MEP. The port must not belong to a channel group.Note

Step 5 From the Domain drop-down list, choose a maintenance domain.
Step 6 Enter the SVLAN ID in the Vlan Id field.

The specified VLAN must be configured on the selected port. The specified VLAN must also
appear in the MA-Domain Mapping table.

Note

Step 7 Enter the MP ID (identifier of the maintenance end point) in the MPID field and click OK. The range of the
MP ID is from 1 to 8191.

The MP ID must not be the same between the maintenance end points.

Step 8 Return to your originating procedure (NTP).

DLP-G630 Deleting a MEP
This task allows you to delete a MEP on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level
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Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > MEP tabs.
Step 3 Select the MEPs that you want to delete.
Step 4 Click Delete.
Step 5 Return to your originating procedure (NTP).

DLP-G631 Creating a MIP
This task allows you to create a Maintenance Intermediate Point (MIP) for
a given VLAN range with a specific maintenance level.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

You can create up to 255 MEPs and MIPs on the GE_XP and 10GE_XP cards. You can create up to 500
MEPs and MIPs on the GE_XPE and 10GE_XPE cards.

Note

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311

Step 2 In card view, click the Provisioning > CFM > Configuration > MIP tabs.
Step 3 Click Create.
Step 4 From the Port drop-down list, choose a port where you want to create the MIP.

The port must not belong to a channel group.Note

Step 5 From the Level drop-down list, choose a maintenance level. The range of the maintenance level is from 0 to
7.

Step 6 Enter the SVLAN range in the Vlan range field. The range of the SVLAN is from 1 to 4093.

The specified SVLAN must be configured on the selected port.Note
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Step 7 Click OK.
Step 8 Return to your originating procedure (NTP).

DLP-G632 Deleting a MIP
This task allows you to delete a MIP on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > CFM > Configuration > MIP tabs.
Step 3 Select the MIPs that you want to delete.
Step 4 Click Delete.
Step 5 Return to your originating procedure (NTP).

DLP-G633 Pinging a MEP
This task allows you to display the output of the ping command on the
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level
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Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311 task.

Step 2 In card view, click the Provisioning > CFM > Ping tabs.
Step 3 Enter the MP ID value in the MPID field. The range of the MP ID is from 1 to 8191.

Remote MP ID user cannot ping local MP ID.Note

Step 4 (Optional) Enter the MAC address of the remote maintenance point in the Mac Addr field. The format of
MAC address is abcd.abcd.abcd.

Step 5 Enter the SVLAN ID in the VLAN ID field. The range of the SVLAN ID is from 1 to 4093.
Step 6 Enter the domain name in the Domain Name field.
Step 7 Enter the size of the ping packet in the DataGram Size field. The default value is 100.
Step 8 Enter the number of ping packets in the No of Requests field. The default value is 5.
Step 9 Click Ping. The output of the ping command appears in the Ping Response area.
Step 10 Return to your originating procedure (NTP).

DLP-G634 Displaying Output of a Traceroute MEP
This task allows you to display the output of the traceroute command on the
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311

Step 2 In card view, click the Provisioning > CFM > Traceroute tabs.
Step 3 Enter the remote MP ID value in the MPID field. The range of the MP ID is from 1 to 8191.
Step 4 (Optional) Enter the MAC address of the remote maintenance point in the Mac Addr field. The format of

MAC address is abcd.abcd.abcd.
Step 5 Enter the SVLAN ID in the VLAN ID field. The range of the SVLAN ID is from 1 to 4093.
Step 6 Enter the domain name in the Domain Name field.
Step 7 Click TraceRoute Response.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
528

Provisioning Transponder and Muxponder Cards
DLP-G634 Displaying Output of a Traceroute MEP

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


The output of the traceroute command appears in the TraceRoute Response area.

• Verify the RlyHit message is shown in the traceroute display and LTM reaches a maintenance point
whose MAC address matches the target MAC address.

• Verify the RlyFDB message is shown in the traceroute display when the next hop address is found in
the forwarding database.

• Verify the RlyMPDB message is shown in the traceroute display when the next hop address is found in
the CCDN.

Step 8 Return to your originating procedure (NTP).

NTP-G285 Managing the Card EFM Settings
This procedure changes the EFM settings of the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
Card Mode, on page 311

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Perform any of the following tasks as needed:

• DLP-G639 Enabling EFM for a Port

• DLP-G640 Configuring EFM Parameters

• DLP-G641 Configuring EFM Link Monitoring Parameters

• DLP-G642 Enabling Remote Loopback for a Port

• DLP-G615 Retrieving Information on Channel Group, REP, CFM, and EFM

• DLP-G643 Enable EFM on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• DLP-G644 Configure the EFM Mode on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using
PCLI
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Stop. You have completed this procedure.

DLP-G639 Enabling EFM for a Port
This task allows you to enable or disable EFM for each port on the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

You can enable EFM on both UNI and NNI ports. You cannot enable or disable EFM for ports that belong
to a channel group. For information about interaction of EFM with other protocols, see the “11.14.2 Protocol
Compatibility list” section on page 11-62.

Note

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > EFM > Configuration tabs. The EFM details appear for each port.
Step 3 From the EFM State drop-down list, choose Enabled.
Step 4 Click Apply to enable EFM for that port.

From the EFM State drop-down list, choose Disabled to disable EFM for that port.Note

Step 5 Return to your originating procedure (NTP).

DLP-G640 Configuring EFM Parameters
This task allows you to configure EFM parameters on the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed
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Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > EFM > Configuration tabs.
Step 3 Modify the EFM parameter settings as described in the table.

Table 221: EFM Parameter Settings

OptionsDescriptionParameter

—(Display only) Port number (n-n) and rate (GE or
TEN_GE).

Port

• Enabled

• Disabled

Sets the state of the EFM protocol for each port.EFM State

• Active

• Passive

Sets the operating mode of the port. If the mode is
Active, the port sends OAM Protocol Data Units
(OAMPDUs) at regular intervals to the partner ports.
If the mode is Passive, the port will not send
OAMPDUs until the partner ports send OAMPDUs.

Mode

• Error Block

• None

Sets the Remote Failure Indication (RFI) action. If the
link is down on a port, the link fault RFI is sent to the
partner port through OAMPDU. An alarm indicating
the remote failure indication link fault (RFI-LF) is
raised. The alarm is cleared after you clear the link fault
condition.

You can specify the following actions for link fault
RFI:

• Error Block—The interface is placed in the
error-block state and the RFI-LF alarm is raised.

• None—Only the RFI-LF alarm is raised.

Dying Gasp and critical events are
not supported.

Note

Link Fault

Default: 5 seconds

Range: 2 to 30 seconds

Sets the duration up to when the EFM session is
retained with the partner port without receiving
OAMPDUs.

Session Timer

Step 4 Click Apply to save the changes.
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Step 5 Return to your originating procedure (NTP).

DLP-G641 Configuring EFM Link Monitoring Parameters
This task allows you to configure EFM link monitoring parameters for each
port on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311

Step 2 In card view, click the Provisioning > EFM > Link Monitoring tabs.
Step 3 Modify the EFM link monitoring parameter settings as described in the table.

Table 222: EFM Link Monitoring Parameter Settings

OptionsDescriptionParameter

—(Display only) Port number (n-n) and rate (GE or
TEN_GE).

Port

Range: 1 to 65535Sets the threshold value for the maximum number of
errored frames to detect during a specific period.

EF Max

Range: 0 to 65535Sets the threshold value for the minimum number of
errored frames to detect during a specific period.

EF Min

• None

• Squelch

Specifies that when the parameter value exceeds the
maximum threshold value, the applicable action is
None.

When the parameter value falls below the minimum
threshold value, a threshold crossing alert (transient
condition) is generated.

EF Action

Range: 10 to 600Period in which the errored frame parameters are
monitored.

EF Window

Range: 1 to 65535Sets the threshold value for the maximum number of
errored frames within the last n frames.

EFP Max
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OptionsDescriptionParameter

Range: 0 to 65535Sets the threshold value for the minimum number of
errored frames within the last n frames.

EFP Min

• None

• Squelch

Specifies that when the parameter value exceeds the
maximum threshold value, the applicable action is
None.

When the parameter value falls below the minimum
threshold value, a threshold crossing alert (transient
condition) is generated.

EFP Action

Range: 1 to 65535Period in which the EFP parameters are monitored.EFP Window

Range: 1 to 900Sets the threshold value for the maximum number of
errored seconds within the last m seconds.

EFSS Max

Range: 0 to 900Sets the threshold value for the minimum number of
errored seconds within the last m seconds.

EFSS Min

• None

• Squelch

Specifies that when the parameter value exceeds the
maximum threshold value, the applicable action is
None.

When the parameter value falls below the minimum
threshold value, a threshold crossing alert (transient
condition) is generated.

EFSS Action

Range: 100 to 9000Specifies the period when the EFSS parameters are
monitored.

EFSS Window

Step 4 Click Apply to save the changes.
Step 5 Return to your originating procedure (NTP).

DLP-G642 Enabling Remote Loopback for a Port
This task allows you to enable remote loopback for each port on the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level
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Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > EFM > Loopback tabs.

The remote loopback type details appear for each port.

Step 3 From the Remote Loopback Type drop-down list, choose Remote Loopback.
Step 4 Click Apply to save the changes.
Step 5 Return to your originating procedure (NTP).

NTP-G287 Managing the Card REP Settings
This procedure changes the REP settings for the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
Card Mode, on page 311

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Perform any of the following tasks as needed:

• DLP-G713 Provisioning Administrative VLAN for Ports in a REP Segment

• DLP-G645 Creating a Segment

• DLP-G646 Editing a Segment

• DLP-G647 Activating VLAN Load Balancing

• DLP-G648 Deactivating VLAN Load Balancing

• DLP-G615 Retrieving Information on Channel Group, REP, CFM, and EFM

• DLP-G649 Create a Segment on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI
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• DLP-G650 Configure STCN on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• DLP-G651 Configure Preemption Delay on the Primary Edge Port Using PCLI

• DLP-G652 Configure VLAN Load Balancing on the Primary Edge Port Using PCL

Stop. You have completed this procedure.

DLP-G713 Provisioning Administrative VLAN for Ports in a REP Segment
This task allows you to provision administrative VLAN for NNI and UNI
ports in a REP segment on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

One administrative CVLAN and one administrative SVLAN can be provisioned for each card. The REP
segments using NNI ports send Hardware Flood Layer (HFL) messages using the administrative SVLAN.
The REP segments using UNI ports send HFL messages using the administrative CVLAN. The two VLANs
need not be the same.

Note

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > REP > Admin VLAN Configuration tabs.
Step 3 To provision administrative VLAN for NNI ports in a REP segment, perform the following steps:

a) From the SVLAN drop-down list, choose a SVLAN. The following table describes the REP convergence
time for SVLANs.

Table 223: REP Convergence Time for SVLANs

REP Convergence TimeAdministrative VLANSVLAN

4 to 5 secondsNot configured0 (default)

Less than 200 millisecondsConfigured1 to 4093
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b) Click Apply
c) To associate the chosen SVLAN with the NNI ports, see DLP-G382 Adding SVLANS to NNI Ports.

Step 4 To provision administrative VLAN for UNI ports in a REP segment, perform the following steps:
a) Enter the CVLAN in the CVLAN field.
b) Click Apply.
c) To associate the CVLAN with the UNI ports, see DLP-G384 Provisioning the QinQ Settings.

Step 5 Return to your originating procedure (NTP).

DLP-G645 Creating a Segment
This task allows you to create a segment on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

• You can create up to three segments on a card. Each segment can have up to two ports on the same
switch.

• You must configure the REP administrative VLAN to activate the Hardware Flood Layer (HFL).

• Before creating REP segments, you must configure the administrative VLAN or use the default VLAN
1 and add the ports to the segment. Only one SVLAN can be configured per card for all the three segments.
REP uses the administrative VLAN to flood its own control traffic.

• The administrative CVLAN is required if a REP port is configured as a UNI port. However, the REP
ports are configured as NNI ports in many configurations, and hence the administrative CVLAN is not
required in these configurations. The option to configure the administrative CVLAN is present in CTC.

• You must configure two edge ports in the segment. A segment has only one primary edge port. If you
configure two ports in a segment as the primary edge port, for example, ports on different switches, REP
selects one of the ports to serve as the primary edge port based on port priority.

• If REP is enabled on two ports on a switch, both the ports must be either regular ports or edge ports.
However, if the No-neighbor port is configured, one port can be an edge port and another port can be a
regular port.

• You can also optionally configure where to send segment topology change notifications (STCNs) and
VLAN load balancing (VLB). STCNs are enabled only for primary edge ports. VLB configurations are
enabled on any edge ports. For information about interaction of REP with other protocols, see the
“11.14.2 Protocol Compatibility list” section on page 11-62

Note
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Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode.
SeeDLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > REP > Segment tabs.
Step 3 Click Create.
Step 4 Enter the segment ID in the Segment field. The range of the segment ID is from 1 to 1024.
Step 5 From the Port drop-drown list, choose a REP port that must belong to this segment.

A REP port can belong to only one segment.Note

Step 6 From the Port Role area, choose whether you want to configure the port as an edge port or a regular port. The
options are:
a) Edge—The port is configured as an edge port.

• Check the Primary check box to configure the edge port as a primary edge port. A segment can have
only one primary edge port.

If an edge port is configured as primary edge port, the other edge port in the ring
automatically becomes secondary edge port. If neither edge port is configured as primary
edge port, one edge port is automatically selected as primary edge port, and the other
edge port is secondary edge port. Configuring an edge port as a primary edge port is not
mandatory. However, it is recommended since VLAN load balancingmust be configured
on the node with the primary edge port.

Note

• Uncheck the Primary check box to configure the edge port as a secondary edge port.

• (Optional) Check thePreferred check box to configure the regular or edge port as a preferred alternate
port (alternate to primary edge port). This port blocks a range of SVLANs for VLAN load balancing.
There is no limit on the number of preferred ports in a REP ring. The preferred port, if configured,
is relevant even without VLAN load balancing, as it takes priority over non-preferred ports for
alternate port election.

Configuring a port as preferred does not ensure that it becomes the alternate port; it only
gets preference over the other ports that are not configured as preferred when an alternate
port is elected.

Note

• Check the NoNeighbor check box if the edge port must not have a neighbor port. REP does not
check for neighbor adjacency.

When the NoNeighbor check box is checked, ensure that only one segment is created.Note

b) None—The port is configured as a regular port. If you choose this option, Segment Topology Change
Notifications (STCN) and VLAN Load Balancing (VLB) configurations are disabled.

Check the Preferred check box to configure the regular port as a preferred alternate port.

Step 7 From the STCN area, configure the destination of STCN messages:
a) Check the Enable check box to enable sending STCN messages.
b) From the Port drop-down list, choose the STCN port to send STCN messages or enter the segment ID in

the Segment field to send STCN messages. The STCN port and REP port must be unique.
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Step 8 From the VLAN Load Balancing area, configure VLAN Load Balancing on the primary edge port:
a) Check the Enable check box to enable VLB.
b) Enter a single SVLAN or range of SVLANs in the SVLAN field. These SVLANs are blocked at the

alternate ports. The primary edge port blocks the remaining VLANs.
c) Enter the Rep PortId in the Rep PortId field to identify the VLAN blocking alternate port. This unique

port ID is automatically generated when REP is enabled.
d) Check the Preferred check box to select the segment port previously identified as the preferred alternate

port for VLAN load balancing.

When you check Preferred under VLAN Load Balancing area, you configure VLAN load balancing to
use one of the previously configured preferred ports (under the Port Role area) to be the load balancing
port. This restricts the load balancing port to be one among the preferred ports, but you cannot select a
specific preferred port.

Step 9 From the VLB Preempt Delay area, enter the trigger delay for automatic VLB activation. The range is 15 to
300 seconds.

Step 10 Click Next.
Step 11 Enter the details of the second port to add it to the segment.
Step 12 Repeat step6 to step 10 when the first port is configured as a regular port and the second port is configured

as a primary edge port. Repeat step 6 to step 7 when the first port is configured as a primary edge port and
the second port is configured as a regular port.

Step 13 Click Finish.
Step 14 Return to your originating procedure (NTP).

DLP-G646 Editing a Segment
This task allows you to edit a segment on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

You can edit only the STCN and VLB entries for a segment.Note
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Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > REP > Segment tabs. The list of segments appear.
Step 3 Choose a segment from the list of segments.
Step 4 Click Edit.
Step 5 Modify the values as required and click Finish.
Step 6 Return to your originating procedure (NTP).

DLP-G647 Activating VLAN Load Balancing
This task allows you to activate VLAN load balancing on the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > REP > Segment tabs.
Step 3 Choose a segment from the list of segments.
Step 4 Click Activate VLB.

When VLAN load balancing is activated, the default configuration is manual preemption with
the delay timer disabled.

Note

Step 5 Return to your originating procedure (NTP).

DLP-G648 Deactivating VLAN Load Balancing
This task allows you to deactivate VLAN load balancing on the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose
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NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. See
DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311.

Step 2 In card view, click the Provisioning > REP > Segment tabs.
Step 3 Choose a segment from the list of segments.
Step 4 Click Deactivate VLB.
Step 5 Return to your originating procedure (NTP).

NTP-G165 Modifying the Ethernet, Line and PM Thresholds
This procedure changes Ethernet, line, and PM threshold settings for the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G723 Install PPM on a Line Card

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database procedure, to preserve the existing transmission
settings.

Step 2 Verify the card mode:
a) Display the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card in card view.
b) Click the Provisioning > Card tabs.
c) Verify that the card mode is set to the mode designated by your site plan:
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• L2-over-DWDM (GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE)

• 10GE TXP (10GE_XP or 10 GE_XPE)

• 10GE MXP (GE_XP or GE_XPE)

• 20GE MXP (GE_XP or GE_XPE)

If the card mode is set correctly, continue with step 4. If not, complete the DLP-G379 Changing the
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311 task.

Step 3 Complete the DLP-G380 Provisioning Ethernet Settings task.
Step 4 If the ONS-SC-E1-T1-PWor ONS-SC-E3-T3-PWSFP is inserted in the GE_XPE card, complete the following

tasks, as needed.

• DLP-G684 Provisioning the PDH Ethernet Settings

• DLP-G685 Provisioning the Electrical Lines

Step 5 If the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card mode is L2-over-DWDM, complete the following
tasks, as needed. If the card mode is not L2-over-DWDM, continue with step 7.

• DLP-G381 Provisioning Layer 2 Protection Settings

• DLP-G382 Adding SVLANS to NNI Ports

• DLP-G383 Provisioning the Quality of Service Settings

• DLP-G384 Provisioning the QinQ Settings

• NTP-G205 Enabling Link Integrity on a Card

• DLP-G385 Provisioning the MAC Filter Settings

• NTP-G204 Enabling IGMP Snooping on a Card or NTP-G220 Enable IGMP Snooping on GE_XP,
10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI.

• NTP-G206 Enabling MVR on a Card or NTP-G224 Enable MVR on GE_XP, 10GE_XP, GE_XPE, or
10GE_XPE Cards Using PCLI.

• DLP-G460EnablingMACAddress Learning on SVLANs forGE_XPEor 10GE_XPECards orNTP-G226
Enable MAC Address Learning on SVLANs for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Using PCLI.

Step 6 Complete the following tasks, as needed:

• DLP-G386 Provisioning the Trunk Port Alarm and TCA Threshold

• DLP-G387 Provisioning the Client Port Alarm and TCA Thresholds

• DLP-G388 Changing the RMON Threshold

• DLP-G389 Changing OTN Settings

To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see
the Alarm and TCA Monitoring and Management document.

Note
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Stop. You have completed this procedure.

DLP-G380 Provisioning Ethernet Settings
This task changes the Ethernet settings for the GE_XP, 10GE_XP, GE_XPE,
or 10GE_XPE card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Ether Ports > Ethernet tabs.
Step 3 Modify any of the settings for the Ethernet tab as described in the table. The parameters that appear depend

on the card mode.

Table 224: GE_XP, 10GE_XP, GE_XPE, and 10GE_XPEEthernet Settings

OptionsCard ModeDescriptionParameter

—• L2-over-DWDM

• 10GE TXP

• 10GE MXP

• 20GE MXP

(Display only) The Port number (n-n)
and rate (GE or TEN_GE).

Port

Numeric. Default: 9700

Range 64 to 9700 (for R9.1 and later)
(jumbo frame)

• L2-over-DWDM

• 10GE TXP

• 10GE MXP

• 20GE MXP

The maximum size of the Ethernet
frames accepted by the port. The port
must be in OOS/locked state.

MTU
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OptionsCard ModeDescriptionParameter

• Auto (default)

• Display Only

• 1000 Mbps

• 10000 Mbps

• Auto_Fdx (10Mbps Full). This
option applies to ONS-SE-ZE-EL
copper SFP that carries traffic from
GE_XP and GE_XPE cards.

If Mode is set to Auto
on the GE_XP or
GE_XPE port,
autonegotiation gets
enabled on the peer
port.

Note

On GE_XP card, the
copper Pluggable Port
Module (PPM)
interface can
auto-negotiate and
carry traffic even
when the peer
interface operates at
rates other than 1000
Mbps.

Note

• L2-over-DWDM

• 10GE TXP

• 10GE MXP

• 20GE MXP

Sets the Ethernet mode. The port must
be in OOS/locked state before setting
the card mode.

For GE_XP and GE_XPE
cards that are in Y-cable
protection groups, Mode
must be set to 1000 Mbps
for those client ports that
are configured in Y-cable.
For 10GE_XP and
10GE_XPE cards that are
in Y-cable protection
groups, Mode must be set
to 10000 Mbps.

Note

Mode
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OptionsCard ModeDescriptionParameter

• ON—Flow control is enabled.

• OFF (default)—Flow control is
disabled.

• Display Only.

• L2-over-DWDM

• 10GE MXP

• 10GE TXP

• 20GE MXP

Enables/disables flow controlmessaging
with its peer port. When enabled, the
port can send and receive PAUSE
frames when buffer congestion occurs.
When disabled, no PAUSE frames are
transmitted and the PAUSE frames
received are discarded.

Flow control messaging is
symmetric and not
negotiated. When flow
control is enabled on one
port, the other end of the
link (peer port) is not
considered. That is, even
if flow control is disabled
on the peer port, the
GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE
card will send PAUSE
frames.

Note

Flow Control

• DS1 over Ethernet (ANSI)
ONS-SC-E1-T1-PW)

• DS3 over Ethernet (ANSI)
ONS-SC-E3-T3-PW)

• E1 Over Ethernet (ETSI)
ONS-SC-E1-T1-PW)

• E3 Over Ethernet (ETSI)
ONS-SC-E3-T3-PW)

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

PROV-MISMATCH
alarm is raised if the
Media Type is not set to
Ethernet Over DS1
(ANSI) or Ethernet Over
E1 (ETSI) for
ONS-SC-EOP1,Ethernet
Over DS3 (ANSI) or
Ethernet Over E3 (ETSI)
for ONS-SC-EOP3, or
DS1 Over Ethernet
(ANSI) or E1 Over
Ethernet (ETSI) for
ONS-SC-E1-T1-PW or
DS3 Over Ethernet
(ANSI) or E3 Over
Ethernet (ETSI)
ONS-SC-E3-T3-PW. Set
the correct Media Type to
clear the
PROV-MISMATCH
alarm.

NoteMedia Type

Numeric. Default: 100%

Range: 0 to 100%

Granularity: 0.1%

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Sets the guaranteed information rate
based on the service-level agreement of
the service provider. The port must be
in OOS/locked state.

Committed
Info Rate
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OptionsCard ModeDescriptionParameter

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1MB

• 2MB

• 8MB

• 16MB

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Sets the maximum number of bits that
will be transferred per second. The port
must be in OOS/locked state before the
Committed Burst Size is provisioned.

Committed
Burst Size

• None

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1MB

• 2MB

• 8MB

• 16MB

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

The maximum number of bits that are
credited for later transfer in the event
the committed burst rate cannot be
transmitted. The port must be in
OOS/locked state before the Excess
Burst Size is provisioned.

Excess Burst
Size
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OptionsCard ModeDescriptionParameter

• UNI Mode—provisions the port as
a user-to-network interface (UNI).
This is the interface that faces the
subscriber.

• NNI Mode—provisions the port as
a network-to-network interface.
This is the interface that faces the
service provider network.

L2-over-DWDMSets the port network interface mode
(NIM). This parameter classifies port
types designed for the Metro Ethernet
market to simplify deployment,
management, and troubleshooting. The
port must be in OOS/locked state before
the NIM is provisioned.

NIM

• Checked—QoS is enabled on the
port’s egress queues.

• Unchecked—(Default) QoS is
disabled on the port’s egress
queues.

L2-over-DWDMEnables Quality of Service (QoS) on the
port’s egress or output queues. The port
must be in OOS/locked state before the
Egress QoS is provisioned.

Egress QoS

• Checked—MAC learning is enabled
for this port.

• Unchecked—(Default) MAC
learning is disabled.

L2-over-DWDMEnables or disables MAC learning for
the port on GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards. MAC
learning is used by Layer 2 switches to
learn the MAC addresses of network
nodes so the Layer 2 switches send
traffic to the right location. Layer 2
switches, including the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE
cards in L2-over-DWDM mode with
MAC Learning configured, maintain a
MAC learning table that associates the
MAC addresses and VLANs with a
given port.

MAC addresses on
SVLANs attached to the
port must also be enabled
to provisionMAC address
learning on GE_XPE and
10GE_XPE cards.

Note

MAC address table aging
is 300 seconds. It cannot
be changed.

Note

MAC
Learning
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OptionsCard ModeDescriptionParameter

• 0—(default) All incoming frames
on the port will have the CoS.1p
bits in the SVLAN tag set to 0.

• 1—All incoming frames on the port
will have the CoS.1p bits in the
SVLAN tag set to 1.

• 2—All incoming frames on the port
will have the CoS.1p bits in the
SVLAN tag set to 2.

• 3—All incoming frames on the port
will have the CoS.1p bits in the
SVLAN tag set to 3.

• 4—All incoming frames on the port
will have the CoS.1p bits in the
SVLAN tag set to 4.

• 5—All incoming frames on the port
will have the CoS.1p bits in the
SVLAN tag set to 5.

• 6—All incoming frames on the port
will have the CoS.1p bits in the
SVLAN tag set to 6.

• 7—All incoming frames on the port
will have the CoS.1p bits in the
SVLAN tag set to 7.

• Trust—Automatically copies
customer VLAN tag into the service
provider VLAN tag.

• CVLAN—CoS can be provisioned
based on CVLAN. For information
on how CoS can be provisioned on
the IEEE 802.1QinQCVLAN tags,
refer to the DLP-G384 Provisioning
the QinQ Settings task.

If CVLAN CoS is configured on a
GE_XP or a 10GE_XP card, a
PROV-MISMATCH alarm is
raised. Until this alarm is cleared,
provisioning on the card is not
possible.

The CVLAN CoS configuration
takes effect only after QinQ is
configured.

L2-over-DWDMProvisions the IEEE 802.1p ingress
Class of Service (CoS). The CoS .1p
bits set the Ethernet frame priority. The
port must be in OOS/locked state before
the Ingress CoS is provisioned.

Ingress CoS is used to set the priority
of the Ethernet frame in the service
provider network, This parameter is
used to set the CoS.1p bits in the
SVLAN tag.

Ingress CoS applies only to ports
provisioned as UNI mode. It does not
apply to ports provisioned as NNImode.

Ingress CoS
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OptionsCard ModeDescriptionParameter

Numeric.

Default: 8100 (IEEE Std 802.1Q
customer VLAN tag type)

Range: 0x0600 to 0xFFFF

L2-over-DWDMDefines the inner Ethertype field. The
Ethertype field indicates which protocol
is being transported in an Ethernet
frame.

The inner Ethertype applies to ports
provisioned in UNI mode only. It does
not apply to ports provisioned as NNI
mode. The ports must be OOS/locked
before the inner Ethertype is
provisioned.

Inner
Ethertype
(Hex)

Numeric.

Default: 8100 (IEEE 802.1Q customer
VLAN tag type)

Range: 0x0600 to 0xFFFF

L2-over-DWDMDefines the outer Ethertype field. The
Ethertype field identifies which protocol
is being transported in an Ethernet
frame. The ports must be OOS/locked
before the Outer Ethertype is
provisioned.

The PROV-MISMATCH
alarm is raised on
GE_XPE and 10GE_XPE
cards if more than four
different Outer Ethertype
options are configured per
card.

Note

Outer
Ethertype
(Hex)

• Checked—IGMP static router port
is enabled.

• Unchecked—(Default) IGMP static
router port is disabled.

L2-over-DWDMAdds multicast-capable ports to the
forwarding table for every IP multicast.

IGMP Static
Router Port

• None—No action.

• Squelch—When anAIS packet
is received on a SVLAN
terminating on the UNI-port,
the UNI port is squelched.

L2-over-DWDMDefines the AIS action type provisioned
on the port.

AIS Action
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OptionsCard ModeDescriptionParameter

• None—No action.

• Squelch—The laser on the
standby port in a 1+1
protection group is squelched.
This setting has no effect if the
port is not part of the 1+1
protection group.

L2-over-DWDMConfigures the standby port behavior.

Set Protection Action to None if Media
Type is set to Ethernet Over DS1
(ANSI) or Ethernet Over E1 (ETSI) for
ONS-SC-EOP1, Ethernet Over DS3
(ANSI) or Ethernet Over E3 (ETSI) for
ONS-SC-EOP3, or DS1 Over Ethernet
(ANSI) or E1 Over Ethernet (ETSI) for
ONS-SC-E1-T1-PW or DS3 Over
Ethernet (ANSI) or E3 Over Ethernet
(ETSI) for ONS-SC-E3-T3-PW.

Protection
Action

The table shows the inner and outer Ethertype behavior based on the NIM setting (either NNI mode or UNI
mode). When the NIM is set to UNI, and the QinQ mode is set to Selective, the Ethertype behavior depends
on the SVLAN/CVLANoperation that is provisioned, either Add or Translate. (QinQ parameters are provisioned
in the DLP-G384 Provisioning the QinQ Settings task.)

A packet can exit out of any UNI/NNI port if the outermost tag in the packet matches with the
SVLAN provisioned on that port. In other words, in the egress path, the inner tags (even if present)
of the packet are not matched with the inner SVLAN or CVLAN provisioned on the port.

Note

The Committed Burst Size and Excess Burst Size must be configured based on the expected
packet size to ensure that no packets are dropped when Flow Control is enabled. For example, if
the CIR is 40% and packet size is 1 KB, the Committed Burst Size and Excess Burst Size should
be set to 1 MB.

Note

When you set the Committed Info Rate above 40% on 10GE_XP and 10GE_XPE cards, the
Committed Burst Size and Excess Burst Size must be set to at least 32K. The Committed Burst
Size and Excess Burst Size can be increased based on the packet size and Committed Info Rate
value.

Note

Table 225: Ethertype Behavior

UNI ModeNNI ModePort Type/
Ethertype

Selective Operation: TranslateSelective Operation: AddTransparent

Working (card-based)Working (card-based)Not applicable: all packets are
mapped over the SVLAN.

Not applicable: the
outer Ethertype value
is used.

Inner
Ethertype

This cannot be set by port, only
by card. The outer Ethertype is
automatically set to the inner
Ethertype.

Not applicable: the outer
Ethertype is the one contained
in the inner VLAN.

Not applicable: the outer
Ethertype is contained in the
inner VLAN (same as UNI
Selective mode).

Working (per port)Outer
Ethertype

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G684 Provisioning the PDH Ethernet Settings
This task changes the PDH Ethernet settings for the GE_XPE card.Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• Set the Media Type as DS1 Over Ethernet in Provisioning > Ether Ports
> Ethernet tab in DLP-G380 Provisioning Ethernet Settings

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XPE card where you
want to change the PDH Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Ether Ports > PDH Ethernet Parameters tabs. The PDH Ethernet Parameters tab
appear only when the . The PDH Ethernet Parameters tab is available in GE_XPE card view only, provided
the PPM for GE_XPE port is created in FE mode.

Step 3 Modify any of the settings for the PDH Ethernet Parameters tab as described in table.

Table 226: GE_XPE Card PDH Ethernet Settings

OptionsCard ModeDescriptionParameter

—• L2-over-DWDM

• 10GE MXP

• 20GE MXP

(Display only) The Port number (n-n) and
rate.

Port

—• L2-over-DWDM

• 10GE MXP

• 20GE MXP

(Display only) The port name.Port Name

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Sets the MPLS Inner Label value.
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OptionsCard ModeDescriptionParameter

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Sets the MPLS Outer Label value.

Table 227: Jitter Buffer Values for
Various Payload Types provides jitter
buffer values for different payloads.

The traffic is down if the
jitter buffer is set to
>=192000 when Media
Type is set to DS1 over
Ethernet (ANSI)
ONS-SC-E1-T1-PW) and
E1 Over Ethernet (ETSI)
ONS-SC-E1-T1-PW).

Note

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Sets the jitter buffer value.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

(ONS-SC-E1-T1-PW only) Sets the RX
sensitivity value.

—• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Only Unicast IP addresses are accepted.

—• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Only Unicast IP addresses are accepted.

Table 227: Jitter Buffer Values for Various Payload Types

Jitter Buffer ValuePayload Type

Upper LimitLower Limit

200001500T1 (DS1)

4500400T3 (DS3)

2000001500E1

60000400E3

Step 4 Click Apply.
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Step 5 Return to your originating procedure (NTP).

DLP-G685 Provisioning the Electrical Lines
This task changes the Electrical Lines settings for the GE_XPE card.Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• Set the Media Type as DS1 Over Ethernet in Provisioning > Ether Ports
> Ethernet tab in DLP-G380 Provisioning Ethernet Settings

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XPE card where you
want to change the Electrical Lines settings. The card view appears.

Step 2 Click the Provisioning > Ether Ports > Electrical Lines tabs. The Electrical Lines tab appear only when
the ONS-SC-E1-T1-PW or ONS-SC-E3-T3-PW SFP is inserted. The Electrical Lines tab is available in
GE_XPE card view only, provided the PPM for GE_XPE port is created in FE mode.

Step 3 Modify any of the settings for the Electrical Lines > DS1 or Electrical Lines > DS3 tab as described in table.

Table 228: GE_XPE Card Electrical Lines Settings

OptionsCard ModeDescriptionParameter

—• L2-over-DWDM

• 10GE MXP

• 20GE MXP

(Display only) The Port number (n-n

) and rate

Port

—• L2-over-DWDM

• 10GE MXP

• 20GE MXP

(Display only) The port name.Port Name
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OptionsCard ModeDescriptionParameter

Default:

• Internal (for ONS-SC-E3-T3-PW)

• Adaptive (for ONS-SC-E1-T1-PW)

Options:

• Loopback Timing

• Internal

• Adaptive

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Sets the Clock SourceClock Source

Default:

• C-BIT (forONS-SC-E3-T3-PWANSI)

• Unframed (for ONS-SC-E3-T3-PW
ETSI)

• ESF (for ONS-SC-E1-T1-PW ANSI)

• Framed (for ONS-SC-E1-T1-PW
ETSI)

Options:

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

• (for ONS-SC-E3-T3-PW ANSI)

• HDB3 (for ONS-SC-E3-T3-PWETSI)

• (for ONS-SC-E1-T1-PW ANSI)

• HDB3 (for ONS-SC-E1-T1-PWETSI)

• (ETSI)

• HDB3 (ETSI)

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

• 0-225 ft(for ONS-SC-E3-T3-PW
ANSI)

• (for ONS-SC-E1-T1-PW ANSI)

• 0-225 ft

• 225-450 ft

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G381 Provisioning Layer 2 Protection Settings
This task provisions the Layer 2 protection settings for the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE cards when the cards are provisioned in
L2-over-DWDM mode.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Layer 2 protection settings must be planned for the entire
VLAN ring. One card in the ring is provisioned as the primary card and one of its port is set to Blocking. The
primary card coordinates the protection switching for the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE in a
VLAN ring.

Up to 1024 SVLANs can be protected. This protection is used in FAPS ring. When a fault occurs on the
working path of FAPs ring, all the SVLANs whose protection is set, are moved to the protection path of the
FAPS ring. All the SVLANs can be protected or a range of SVLANs can be protected.

To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card must be in L2-over-DWDM
mode. To change the card mode, complete the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE Card Mode task.

Note

You can choose to enable another card in the ring to be the primary card. However, only one card in the ring
can be provisioned as primary card. Make sure that the provisioning settings on the card that was previously
configured as the primary are disabled as soon as another card is enabled as the primary card. To perform this
task complete the DLP-G507 Enabling a Different GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card as
Primary Card, on page 556 task.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the protection settings. The card view appears.

Step 2 Click the Provisioning > Protection tabs.
Step 3 In the Status column, modify the port protection status by clicking the appropriate table cell and choosing one

of the following from the drop-down list:

• Forwarding—Forwards the Ethernet packets that are received by the port.

• Blocking—Blocks the Ethernet packets that are received by the port.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
554

Provisioning Transponder and Muxponder Cards
DLP-G381 Provisioning Layer 2 Protection Settings

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


One port of the primary card within a VLAN ring must be set to Blocking. All other ports
must be set to Forwarding.

Note

Step 4 Check the Master check box if you want the card to serve as the protection coordinator for the VLAN ring.
If not, continue with step 5.

Step 5 From the Protection drop-down list, choose one of the following:

• Enabled—Enables protection.

• Disabled—Disables protection.

• Forced—Converts all the SVLANs to protected SVLANs irrespective of the SVLAN protection
configuration in the SVLAN database. This is applicable to a point-to-point linear topology. The SVLAN
protection must be forced to move all SVLANs, including protected and unprotected SVLANs, to the
protect path irrespective of provisioned SVLAN attributes.

Step 6 From the Hold Off Time drop-down list, choose one of the following:

• Disabled (default)—A FAPS switchover occurs immediately.

• 50 msec, 100 msec, 200 msec, 500 msec, 1 sec, 2 sec, or 5 sec—Holds off FAPS protection for the
selected duration.

To get consistent results ensure Hold Off Time values are the same throughout the ring.Note

FAPS is an Layer 2 protection enabled on a VLAN. When a fiber fault occurs, Layer 1
protection is triggered immediately to restore the traffic. Setting the Hold Off Time option
prevents Layer 2 FAPS protection from triggering at the same time as Layer 1 protection
thereby avoiding traffic hits.

Note

Step 7 Click Refresh to refresh the FAPS Layer 2 protection settings.
Step 8 Click Protect SVLAN's to protect the SVLANs.

The Protect All SVLAN's dialog appears.

a) Choose the Select All option to protect all the SVLANs.
b) Choose the Range option to provide the range of SVLANs to protect.

Upto 1024 SVLANs can be protected. SVLANs that are in use are excluded.

c) Click OK.

Step 9 Set the following parameters for FAPS switching with CRC errors:
a) Switch with CRC Alarm—Check this check box to enable FAPS switching with CRC errors.
b) CRCThreshold—Threshold for CRC error count. The default CRC threshold value is 10(-e)2. The available

options are 10(-e)2, 10(-e)3, and 10(-e)4.
c) CRC Soak Count—Number of times the CRC error rate exceeds the CRC threshold value before raising

the DATA-CRC alarm. The default CRC Soak Count is 10. The valid range is from 3 to 10.
d) CRC Poll Interval—Time interval (in seconds) between the successive polls. The default CRC Poll Interval

is 60 seconds.

For example, if the CRC Threshold value = 10(-e)2, CRC Soak Count = 10, and CRC Poll Interval =
60 seconds, then FAPS occurs when the incoming CRC error rate is more than 10(-e)2 continuously across
10 poll intervals (10*60 = 600 seconds).
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e) Clear/Suppress CRC Alarm—Uncheck the Clear/Suppress CRC Alarm check box for FAPS to occur.
If you check this check box, the DATA-CRC alarm gets cleared and FAPS does not occur.

As along as the Clear/Suppress CRC Alarm checkbox is checked, the DATA-CRC alarm
is not raised on that port and FAPS does not occur.

Note

For consistent result, ensure that all the values that are set in Step 7 are same throughout the
ring.

Note

Step 10 Click Apply.
Step 11 Return to your originating procedure (NTP).

DLP-G507 Enabling a Different GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card
as Primary Card

This task provisions another GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card
on a stable VLAN ring, to be the primary card when the cards are provisioned
in L2-over-DWDM mode.

Layer 2 protection must be enabled for the entire VLAN ring. One card in the
ring is provisioned as the primary card and one of its port is set to Blocking.
The primary card coordinates the protection switching for the GE_XP,
10GE_XP, GE_XPE, or 10GE_XPE cards in a VLAN ring.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

DLP-G381 Provisioning Layer 2 Protection Settings

To perform this task, the card must be in L2-over-DWDM mode. To change
the card mode, complete the DLP-G379 Changing the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE Card Mode, on page 311 .

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

You can choose to enable another card in the ring to be the primary card. However, only one card in the ring
can be provisioned as primary card. Make sure that the provisioning settings on the card that was previously
configured as the primary are disabled as soon as another card is enabled as the primary card.

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card in a VLAN ring where you want to enable primary card provisioning.

Step 2 Perform the following steps:
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a) Click the Provisioning > Protection tabs.
b) From the Status drop-down list, choose Blocking for a trunk port.

One port of the primary card within a VLAN ring must be set to Blocking. All other ports
must be set to Forwarding.

Note

c) Check the Master check box for the card that serves as the protection coordinator for the VLAN ring.
d) From the Protection drop-down list, choose Enabled.
e) Click Apply.

Step 3 The primary card provisioning on the other card must be disabled. Perform the following steps:
a) Click the Provisioning > Protection tabs.
b) Uncheck the Master check box for the card where Primary node provisioning must be disabled.
c) Click Apply.
d) From the Protection drop-down list, choose Disabled.
e) Click Apply.

Step 4 The protection on the card that was disabled in step 2 must be enabled again. Perform the following steps:
a) Click the Provisioning > Protection tabs.
b) From the Protection drop-down list, choose Enabled.
c) Click Apply.
d) From the Status drop-down list, choose Forwardingon both ports.
e) Click Apply.

Step 5 Return to your originating procedure (NTP).

DLP-G382 Adding SVLANS to NNI Ports
This task adds or removes service provider VLAN (SVLAN) provisioning
to/from GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE ports. This task only
applies to GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards in L2-over-
DWDM mode.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• To perform this task, the cardmust be in L2-over-DWDMmode. To change
the card mode, complete the DLP-G379 Changing the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE Card Mode, on page 311

• This task can only be performed on ports provisioned as NNI. See the
DLP-G380 Provisioning Ethernet Settings task.

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the SVLAN port settings. The card view appears.

Step 2 Click the Provisioning > SVLAN tabs.
Step 3 For each SVLAN shown in the table, click the check box under the Port [port name] table cell to include the

SVLAN in that port. If you do not want the SVLAN included, uncheck the check box.

If no SVLANs appear in the SVLAN tab, complete the DLP-G421 Creating and Storing an
SVLAN Database .

Note

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G383 Provisioning the Quality of Service Settings
This task provisions the Weighted Round Robin (WRR) value and bandwidth
for QoS Class of Service (CoS) egress queues on a GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE card port.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• To perform this task, the card must be in L2-over-DWDM mode and the
port must haveQoS enabled. Refer to the DLP-G379 Changing the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE Card Mode, on page 311 and the
DLP-G380 Provisioning Ethernet Settings, if needed.

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the QoS settings.

Step 2 Click the Provisioning > QoS tabs.
Step 3 In the Port field at the bottom of the window, choose the port where you want to provision the QoS settings.
Step 4 For each CoS egress queue, 0 through 7, define the following:

• WRR weight—sets the Weighted Round Robin (WRR) level for the CoS egress queue. The default is 1.
The range is 0 to 15, where 0 is Strict Priority.)
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The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE define a set of eight queues, one queue
for each CoS. Only one of the queues can be assigned the 0 WRR weight (Strict Priority).

Note

• Bandwidth—sets the bandwidth allocated for the CoS egress queue, 100 is the default. This bandwidth
value is the percentage (%) of bandwidth with respect to the SFP, XFP, or port speed (100 Mbps for FE,
1 Gbps for GE, and 10 Gbps for 10GE) of the interface.

Step 5 Click Apply. Click Yes in the confirmation dialog box.
Step 6 Return to your originating procedure (NTP).

DLP-G470 Provisioning the CoS Settings
This task provisions Class of Service (CoS) settings on the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• To perform this task, the card must be in L2-over-DWDM mode and the
port must be in OOS state.

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the CoS settings.

Step 2 Complete Ingress CoS section in the DLP-G380 Provisioning Ethernet Settings task.
Step 3 Return to your originating procedure (NTP).

DLP-G384 Provisioning the QinQ Settings
This task provisions the IEEE 802.1QinQVLAN tags on the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card UNI ports. QinQ tags expand the VLAN
capability by tagging the tagged packets to produce a “double-tagged” Ethernet
frame. For service providers the expanded VLAN allows specific services to
be provided on specific VLANs for specific customers, while other types of
services can be provided to other customers on other VLANs.

Purpose

NoneTools/Equipment
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• DLP-G46 Log into CTC

• DLP-G421 Creating and Storing an SVLAN Database
• This task can only be performed on the cards UNI ports. (To provision the
port Ethernet parameters, see the DLP-G380 Provisioning Ethernet Settings
task.)

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the QinQ settings.

Step 2 Click the Provisioning > QinQ tabs.
Step 3 Click the Port field and choose the port where you want to provision QinQ. Channel groups configured in

UNI mode appear in the Port field along with the physical ports.
Step 4 Click the Mode field and choose one of the following modes from the drop-down list:

• Selective—The incoming Ethernet packet is checked against the CVLAN and SVLAN table. If the
CVLAN is not found, the packet is dropped. If you choose Selective, add an entry in the QinQ tab to
map the administrative CVLAN to the SVLAN (if it is not same as the one used for data).

• Transparent—All incoming packets are transported with the additional VLAN chosen in the SVLAN
field. If you choose transparent, the traffic on administrative CVLAN will pass through.

Step 5 Click the BPDU field and choose one of the following bridge protocol data unit (BPDU) modes from the
drop-down list:

• Drop (default)—If checked, drops incoming packets with any of the following destinationMAC addresses.
The BPDU default can be applied for any UNI port.

• 01-80-c2-00-00-00—IEEE 802.1D

• 01-80-c2-00-00-02—Link Aggregation Control Protocol (LACP)

• 01-80-0c-cc-cc-cc—VLAN Spanning Tree Plus (PVST+)

• 01-00-c-cc-cc-cc—Cisco Discovery Protocol (CDP) type 0x2000, VLAN Trunk Protocol (VTP)
type 0x2003, Port Aggregation Protocol (PAgP), type 0x0104, Uni-Directional Link Detection
(UDLD) type 0x111, Dynamic Trunking Protocol (DTP) type 0x2004

• Tunnel—If checked, transparently sends any of the destination MAC addresses listed above.

Step 6 If the Mode was set to Selective, complete the following steps. If not, continue with step 7.
a) To add a row, click Add.
b) Click the CVLAN table and type in the CVLAN range. You can enter a single value or a range using “–”

between the two ends of the range.
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If you are using Software Release 8.5 or earlier, it is recommended that you do not specify
a CVLAN range due to certain limitations in the feature.

Note

c) Click the SVLAN table cell and choose an SVLAN from the drop-down list.
d) Click the Operation table cell and choose an operation:

• Add (default)—Adds the SVLAN on top of the CVLAN. The operation default can be applied for
any UNI port.

• Translate—CVLAN is translated with the SVLAN value.

• Double Add—(GE_XPE and 10GE_XPE cards only) Adds an inner and an outer SVLAN to double
tagged packets only. CVLAN settings are not required. If this double tagged selective operation is
present on a port, no other selective operation can be present.

• Translate Add—(GE_XPE and 10GE_XPE cards only) CVLAN gets translated to inner SVLAN
and the SVLAN is added.

If Double Add and Translate Add are configured on a GE_XP or a 10GE_XP card, a
PROV-MISMATCH alarm is raised. Until this alarm is cleared, provisioning on the
card is not possible.

Note

A CVLAN with a value of 0 means “untagged packet”.Note

Two or more CVLANs cannot be translated over the same SVLAN.Note

e) (GE_XPE and 10GE_XPE cards only) Click the COS table cell and choose a value from the drop down
list.

f) Click Apply.
g) Continue with step 9.

Step 7 If the Mode was set to Transparent, in the SVLAN field, choose the SVLAN to be added to incoming packets.
Step 8 Click DSCP-Cos mapping Table to provision CoS based on DSCP for each port.
Step 9 For each DSCP, choose a CoS value from 0 to 7 and click OK.
Step 10 Return to your originating procedure (NTP).

DLP-G221 Enabling MAC Address Learning on SVLANs
This task enables MAC address learning on SVLANS for GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

VLANs must already be created on the selected card.

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Provisioning or higherSecurity Level

Procedure

Step 1 Complete the following tasks, as needed:

• DLP-G460 Enabling MAC Address Learning on SVLANs for GE_XPE or 10GE_XPE Cards

• NTP-G226 EnableMACAddress Learning on SVLANs for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
Cards Using PCLI

Step 2 Return to your originating procedure (NTP).

DLP-G460EnablingMACAddressLearningonSVLANsforGE_XPEor10GE_XPE
Cards

This task enables MAC address learning on SVLANs attached to the port of a
GE_XPE or 10GE_XPE card.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• To perform this task, the card must be in L2-over-DWDM mode. Refer
to the DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE Card Mode, on page 311.

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

MAC address learning is applicable only for GE_XPE and 10GE_XPE cards. If MAC address learning is
configured on a GE_XP or a 10GE_XP card, a PROV-MISMATCH alarm is raised. Until this alarm is cleared,
provisioning on the card is not possible.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XPE or 10GE_XPE
card where you want to enable MAC address learning.

Step 2 Enable MAC address learning on the port. Perform the following steps:
a) Click Provisioning > Ethernet.
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b) Check the MAC Learning check box.

If the per port MAC address learning is configured on a GE_XP or 10 GE_XP cards, before
upgrading to a GE_XPE or 10 GE_XPE card, enable MAC address learning per SVLAN. Not
doing so disables MAC address learning.

Note

Step 3 Enable MAC address learning on the SVLAN attached to the port. Perform the following steps:
a) Click SVLAN > SVLAN DB tabs.
b) Click Load. This loads an SVLAN database from a network node or local file and replaces any SVLANs

that are in the network view VLAN DB table.
c) Check the MAC Learning check box related to the SVLAN (one or more than one SVLAN) to be

configured with MAC address learning.
d) Click Store. This records and enables the new configuration.

Step 4 Return to your originating procedure (NTP).

DLP-G385 Provisioning the MAC Filter Settings
This task provisions the MAC address filter for the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE cards when the cards are provisioned in
L2-over-DWDM mode. The MAC address filter is a list of MAC addresses
whose packets should be accepted or dropped.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
Card Mode

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the MAC filter settings.

Step 2 Click the Provisioning > Security > MAC Filter tabs.
Step 3 Click the port for which you want to create a MAC filter.
Step 4 Click Edit.
Step 5 In the Edit MAC Address dialog box, click Add. A new table entry appears with the MAC address

00-00-00-00-00-00.
Step 6 In theMACAddress Port field, type in theMAC address you want to filter over the default 00-00-00-00-00-00

address.
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Step 7 If you want to add more MAC addresses, repeat step 5 and step 6. (Up to eight MAC addresses can be added
for each port.) If not, click OK.

Step 8 On the MAC Filter table, provision the Allowed check box:

• Checked—All MAC addresses different from the address(es) entered in the table will be dropped.

• Unchecked—All MAC addresses matching the address(es) entered in the table will be dropped.

Step 9 Click Apply.
Step 10 Repeat step 3 to step 9 for each port of the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card that you want

to set up.
Step 11 Return to your originating procedure (NTP).

NTP-G237 Retrieving and Clearing MAC Addresses on SVLANs
This procedure retrieves and clears MAC addresses learned on GE_XP,
10GE_XP, GE_XPE, or 10GE_XPE cards.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
Card Mode, on page 311

• DLP-G221 Enabling MAC Address Learning on SVLANs

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Retrieving and clearing learned MAC addresses are CPU intensive and traffic affecting. You must clear the
MAC addresses only during a scheduled maintenance window.

Caution

It is not possible to simultaneously retrieve learned MAC addresses from both CTC and TL1 interfaces.Note

Procedure

Step 1 In the node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to retrieve the MAC addresses.

Step 2 To retrieve the MAC addresses learned, perform the following steps:

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
564

Provisioning Transponder and Muxponder Cards
NTP-G237 Retrieving and Clearing MAC Addresses on SVLANs

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


a) Click Maintenance > MAC Addresses > Learned.
b) In the SVLAN field, type a valid SVLAN range. The SVLAN range is from 1 to 4093.
c) Click Refresh.

The table displays the following fields:

• MAC Address—Displays the MAC address for the port.

• VLAN—Displays the VLAN identifier for the port.

• Port—Displays the port number.

d) Right-click the column heading to display the following options:

• Row Count—Displays the number of learned MAC addresses retrieved.

• Sort Column—Sorts the table by the column’s values.

• Hide Column—Hides the column from view.

• Reorder Columns Visibility—Displays all hidden columns.

Step 3 Click Refresh to refresh the list of MAC addresses learned.
Step 4 Click Clear to clear the MAC addresses learned on all the SVLANS of the card.

It is not possible to delete the MAC addresses learned on a per SVLAN basis.Note

Step 5 To view card MAC addresses, complete the DLP-G546 Viewing MAC Addresses on a Card task.

Stop. You have completed this procedure.

DLP-G546 Viewing MAC Addresses on a Card
This task allows you to view the MAC addresses for each client and trunk port
and the CPU port of the card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 To view the card MAC addresses, click Maintenance > MAC Addresses > Card. The MAC addresses for
each client and trunk port and the CPU port are displayed.
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The table displays these fields:

• Port—Displays the port number.

• MAC Address—Displays the MAC address for the port.

Step 2 Return to your originating procedure (NTP).

NTP-G311 Provisioning the Storm Control Settings
This task provisions the storm control settings for the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE cards when the cards are provisioned in
L2-over-DWDM mode.

Purpose

NoneTools/Equipment

To perform this task, the card must be in L2-over-DWDM mode. To change
the card mode, complete the DLP-G379 Changing the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE Card Mode, on page 311 .

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the storm control settings.

Step 2 Click the Provisioning > Security > Storm Control tabs.
Step 3 Modify any of the settings as described in table.

Table 229: Storm Control Settings

OptionsDescriptionParameter

(Display only) The Port number (n-n) and rate (GE
or TEN_GE).

Port

• Checked—DLF storm
control is enabled.

• Unchecked—DLFstorm
control is disabled.

Enables or disables DLF storm control on the card.DLF Storm Control

Range: 0 to 16777215
packets per second

Threshold value to set the number of unknown unicast
packets per second.

DLF Storm Control
Threshold (pps)
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OptionsDescriptionParameter

• Checked—Multicast
storm control is enabled.

• Unchecked—Multicast
storm control is
disabled.

Enables or disables Multicast storm control on the
card.

Mcast Storm Control

Range: 0 to 16777215
packets per second

Threshold value to set the number of multicast
packets per second.

Mcast Storm Control
Threshold (pps)

• Checked—Broadcast
storm control is enabled.

• Unchecked—Broadcast
storm control is
disabled.

Enables or disables Broadcast storm control on the
card.

Bcast Storm Control

Range: 0 to 16777215
packets per second

Threshold value to set the number of broadcast
packets per second.

Bcast Storm Control
Threshold (pps)

Step 4 Click Apply.

Stop. You have completed this procedure.

NTP-G205 Enabling Link Integrity on a Card
This task enables link integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards.

Purpose

NoneTools/Equipment

NonePrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Complete these tasks, as needed:

• DLP-G509 Enabling Link Integrity Using CTC

• NTP-G216 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI
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Stop. You have completed this procedure.

DLP-G509 Enabling Link Integrity Using CTC
This task enables link integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Create or load an SVLAN profile. To create a SVLAN profile see the DLP-G471 Creating SVLAN or CVLAN

Profile task.

Make sure the Link Integrity check box is selected to enable link integrity for a profile and save
it to the node.

Note

Step 3 Associate the SVLAN profile (with Link Integrity enabled) to a SVLAN on a port. To do this perform these
steps:
a) In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP,

GE_XPE, or 10GE_XPE card. The card view appears.
b) Click the Provisioning > Profiles Mapping > SVLAN tabs.
c) Enter the SVLANs or SVLAN range in the SVLAN to View text box.

A table appears that displays SVLANs and available ports. The SVLAN profiles that was created must
be applied to a SVLAN and a port. However, make sure the SVLAN has already been associated with
the port via the QinQ tab (For information on how to associate a SVLAN to a port, see the DLP-G384
Provisioning the QinQ Settings task).

d) Select the SVLAN for a port and choose the available SVLAN profile from the drop-box.
e) Click Apply.

Step 4 AIS action must be set on a per-UNI port basis. Select None or Squelch from the AIS action drop-down list.
For detailed instructions, see the DLP-G380 Provisioning Ethernet Settings task.

Step 5 Return to your originating procedure (NTP).
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DLP-G289 Provisioning CVLAN Rate Limiting on a Card
This task provisions CVLAN rate limiting on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Create or load a CVLAN profile by setting Committed Info Rate, Committed Burst, Excess Info, Excess Burst.

To create a CVLAN Profile see the DLP-G471 Creating SVLAN or CVLAN Profile.

You cannot provision CVLAN rate limiting on channel groups.Note

Step 3 Associate the CVLAN profile to a CVLAN on a UNI port. To do this perform theae steps:
a) In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP,

GE_XPE, and 10GE_XPE card. The card view appears.
b) Click the Provisioning > Profiles Mapping > CVLAN tabs.
c) Enter the CVLANs or CVLAN range in the CVLANS to View text box.

A table appears that displays CVLANs and available ports. The CVLAN profiles that were created must
be applied to a CVLAN and port. However, make sure the CVLAN has already been associated with the
port via the QinQ tab (For information on how to associate a CVLAN profile to a UNI port, see the
DLP-G384 Provisioning the QinQ Settings).

d) Select the CVLAN for a given port and choose the available CVLAN profile from the drop-down list.
e) Click Apply.

Step 4 Return to your originating procedure (NTP).

NTP-G208 Provisioning SVLAN Rate Limiting on a Card
This task provisions SVLAN rate limiting on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment
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DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Complete the following tasks, as needed:

• DLP-G515 Provisioning SVLAN Rate Limiting Using CTC

• NTP-G225 Provision SVLAN Rate Limiting on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card
Using PCLI

Stop. You have completed this procedure.

DLP-G515 Provisioning SVLAN Rate Limiting Using CTC
This task provisions SVLAN rate limiting on the GE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Create or load a SVLAN profile by setting Committed Info Rate, Committed Burst, Excess Info, Excess Burst.

To create a SVLAN Profile see the DLP-G471 Creating SVLAN or CVLAN Profile task.
Step 3 Associate the SVLAN profile to a SVLAN on a port. To do this, perform the following steps:

a) In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP,
GE_XPE, and 10GE_XPE card. The card view appears.

b) Click the Provisioning > Profiles Mapping > SVLAN tabs.
c) Enter the SVLANs or SVLAN range in the SVLAN to View text box.

A table appears that displays SVLANs and available ports. The SVLAN profiles that were created must
be applied to a SVLAN and port. However, make sure the SVLAN has already been associated with the
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port via the QinQ tab (For information on how to associate a SVLAN profile to a UNI port, see the
DLP-G384 Provisioning the QinQ Settings task and to a NNI port see the DLP-G382 Adding SVLANS
to NNI Ports task).

d) Select the SVLAN for a given port and choose the available SVLAN profile from the drop-down list.
e) Click Apply.

Step 4 Return to your originating procedure (NTP).

DLP-G471 Creating SVLAN or CVLAN Profile
This task creates an SVLAN profile.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

You cannot associate SVLAN or CVLAN profiles to channel groups. You can associate a CVLAN profile
only to a UNI port.

Note

Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Click the Provisioning > SVLAN > Profiles tabs.
Step 3 Click Add and a profile is added to the Profiles tab. Modify any of these settings:

• Name—The profile name can be up to 32 alphanumeric/special characters.

• Committed Info Rate—Sets the guaranteed information rate based on the service-level agreement of the
service provider. The valid value ranges from 0 to 100% with 0.1% granularity. The default value is
100%.

• Committed Burst—Sets the maximum number of bits that will be transferred per second.

• Peak Info rate—Sets the maximum access rate based on the service-level agreement of the service
provider. The valid value ranges from 0 to 100% with 0.1% granularity. The default value is 100%.
However, the value must be greater than or equal to the Committed Info Rate.

• Peak Burst Size—The maximum number of bits that are credited for later transfer in the event the
committed burst rate cannot be transmitted.
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• Link Integrity—Enables link integrity for the SVLAN profile. Do not check this check box if you are
creating a CVLAN profile.

When you set the Committed Info Rate above 40% on 10GE_XP and 10GE_XPE cards, the
Committed Burst Size and Excess Burst Size must be set to at least 32K. The Committed
Burst Size and Excess Burst Size can be increased based on the packet size and Committed
Info Rate value.

Note

Step 4 Click Store.

In the Store Profile(s) dialog box, choose one of the following:

• To Node(s)—Stores the SVLAN profile at one or more network nodes. Choose the network nodes where
you want to store the SVLAN profile. To choose more than one node, press the Shift key, or click Select
All.

• To File—Stores the SVLAN profile in a file. Enter a file name, then click Browse to navigate to a local
or network drive where you want to store the file.

Step 5 Click OK.
Step 6 Return to your originating procedure (NTP).

NTP-G204 Enabling IGMP Snooping on a Card
This procedure enables Internet GroupManagement Protocol (IGMP) snooping
on a per-SVLAN basis on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards.

Purpose

NoneTools/Equipment

NonePrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Complete the following tasks, as needed:

• DLP-G511 Enabling IGMP Snooping, Fast Leave, Report Suppression, and Protection

• NTP-G220 Enable IGMP Snooping on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• NTP-G217 Enable IGMP Fast-Leave Processing on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Using PCLI

• NTP-G219 Enable IGMP Report Suppression on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Using PCLI
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Stop. You have completed this procedure.

DLP-G511 Enabling IGMP Snooping, Fast Leave, Report Suppression, and
Protection

This procedure explains how to enable IGMP snooping, IGMP fast leave and
IGMP report suppression on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards using CTC.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Click the Provisioning > SVLAN > SVLAN DB tabs. Click Load to load the SVLANs on the card where

IGMP must be enabled.
Step 3 For each SVLAN shown in the table, select the following:

• Protection—Check the Protection check box to protect the SVLAN.

Check the Protect All SVLANS check box to protect all the SVLANs. Up to 1024 SVLANs can be
protected.

• MAC Learning—(GE_XP card only) Check the MAC Learning check box to enable or disable MAC
learning for the port.

• IGMP—Check the IGMP check box to enable IGMP for the selected SVLAN.

• IGMPFast Leave—Checking the IGMP Fast Leave check box causes the switch to immediately remove
a port from the IP multicast group when it detects an IGMP, version 2 (IGMPv2) leave message on that
port.

• IGMP Suppression—Check the IGMP Suppression check box to enable a single IGMP report to be
sent to each multicast group in response to a single query.

Step 4 Click Store SVLAN DB.

If card protection is enabled and one or more SVLANs are not protected, CTC informs the user that protection
check box is disabled on one or more SVLANs. This allows the user to check the Protection check box for
SVLANs if required.

In the Store SVLAN DB dialog box, choose one of the following:
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• To Node/Shelf/Card—Select the node and shelf. All the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE
cards in L2 over DWDM mode are displayed. Select the card where you want to store the SVLAN DB.

• Stores the SVLAN database at one or more network nodes. Choose the network nodes where you want
to store the SVLAN database. To choose more than one node, press the Shift key, or click Select All.

• To File—Stores the SVLAN database in a file. Enter a file name, then click Browse to navigate to a
local or network drive where you want to store the file.

• Select the card on which you want to save the changes made in step 3.

Step 5 Click OK.

If you want to add the multicast-capable ports to the forwarding table for every IP multicast,
select the IGMP Static Router Port check box as described in the DLP-G380 Provisioning Ethernet
Settings task.

Note

Step 6 Return to your originating procedure (NTP).

NTP-G206 Enabling MVR on a Card
This procedure enables Multicast VLAN Registration (MVR) on GE_XP,
10GE_XP, GE_XPE, or 10GE_XPE cards.

Purpose

NoneTools/Equipment

NonePrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Complete the following tasks, as needed:

• DLP-G513 Enabling MVR Using CTC

• NTP-G224 Enable MVR on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

Stop. You have completed this procedure.
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DLP-G513 Enabling MVR Using CTC
This procedure enables Multicast VLAN Registration (MVR) on GE_XP,
10GE_XP, GE_XPE, or 10GE_XPE cards using CTC.

Purpose

NoneTools/Equipment

DLP-G382 Adding SVLANS to NNI PortsPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to enable MVR. The card view appears.

At least one SVLAN must be configured on the card.Note

Step 2 Click the Provisioning > MVR tabs.
Step 3 Check the Enabled check box and enter the following information:

• IGMP CVLAN—Check box to enable IGMP snooping on CVLAN. This check box is enabled only
when MVR is enabled through the Enabled check box.

• Multicast SVLAN—Select the MVR SVLAN ID. The default value is the SVLAN with the lowest ID
configured on the card. The drop box lists all the SVLANs on the GE_XP, 10GE_XP, GE_XPE, or
10GE_XPE card.

SVLAN selected here can not be used for UNI port, make sure that the corresponding SVLAN
on the NNI port is checked.

Note

• Multicast Address—Sets the specified multicast group address as the MVRmulticast group. The default
address is 239.255.255.255 and the range is 224.0.0.0 to 239.255.255.255. Except the subrange
[224-239].[0/128].0.x.

• Count—Sets the range of any additional multicast group addresses. The default is 1, and range is 1 to 256.

Step 4 Click Apply

Step 5 Return to your originating procedure (NTP).

DLP-G386 Provisioning the Trunk Port Alarm and TCA Threshold
This task changes the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card trunk
port alarm and TCA thresholds.

Purpose
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NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards have two trunk ports. The GE_XP and GE_XPE
trunk ports are 21-1 and 22-1 on the card graphic and 21 (Trunk) and 22 (Trunk) on the Optics Thresholds
table. The 10GE_XP and 10GE_XPE card trunk ports are 3-1 and 4-1 on the card graphic and 3 (Trunk) and
4 (Trunk) on the Optics Thresholds table.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE or
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more
information about SFPs and XFPs, see the “11.26 SFP, SFP+, XFP, CXP, and CFP Modules”
section.

Note

Step 3 If TCA is not selected, click TCA and then click Refresh. When TCA is selected, continue with step 4.
Step 4 Verify the trunk port TCA thresholds are provisioned as shown in table. Provision new thresholds as needed

by double-clicking the threshold value you want to change, deleting it, entering a new value, and hitting Enter.

Table 230: GE_XP, 10GE_XP, GE_XPE, or 10GE_XPECard Trunk Interface TCA Thresholds

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module (XFP)

–46–23–7XFP WDM no FEC

–46–27–7XFP WDM standard FEC

–46–27–7XFP WDM Enhanced FEC

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
576

Provisioning Transponder and Muxponder Cards
DLP-G386 Provisioning the Trunk Port Alarm and TCA Threshold

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Step 5 Under Types, click the Alarm radio button and click Refresh.

Do not modify the Laser Bias parameters.Note

Step 6 Verify the trunk port alarm thresholds are provisioned as shown in table. Provision new thresholds as needed
by double-clicking the threshold value you want to change, deleting it, entering a new value, and hitting Enter.

Table 231: GE_XP, 10GE_XP, GE_XPE, or 10GE_XPECard Trunk Interface Alarm Thresholds

Alarm TX
Power Low

Alarm TX
Power High

Alarm RX
Power Low

Alarm RX
Power High

Pluggable Port Module (XFP)

–35–26–5XFP WDM no FEC

–35–30–5XFP WDM standard FEC

–35–30–5XFP WDM Enhanced FEC

Step 7 Click Apply.
Step 8 Repeat step 3 to step 7 to provision the second trunk port.
Step 9 Return to your originating procedure (NTP).

DLP-G387 Provisioning the Client Port Alarm and TCA Thresholds
This task provisions the client port alarm and TCA thresholds for the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G726 Preprovisioning a Multirate PPM

DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

The GE_XP card has 20 client ports. The ports are 1-1 through 20-1 on the card graphic and 1 (Client) through
20 (Client) on the Optics Thresholds table. The 10GE_XP card has 2 client ports. The ports are 1-1 and 2-1
on the card graphic and 1 (Client) and 2 (Client) on the Optics Thresholds table.

Note

The hardware device that plugs into the card faceplate to provide a fiber interface to the card is called a Small
Form-factor Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs).
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the fiber-optic
network. Multirate PPMs have provisionable port rates and payloads. For more information about SFPs and
XFPs, see the SFP, SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK Modules, on page 307 section.
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
a) If TCA is not selected, click TCA and then click Refresh. When TCA is selected, continue with step 4.
b) Verify the client port TCA thresholds are provisioned as shown in table. Provision new thresholds as

needed by double-clicking the threshold value you want to change, deleting it, entering a new value, and
hitting Enter.

Table 232: GE_XP, 10GE_XP, GE_XPE, or 10GE_XPECard Client Interface TCA Thresholds

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module (XFP)

–125–14110GE LAN PHY 10GBASE-LR

–163–1701000Base-SX (1Gbps)15

–163–20–31000Base-LX 1

15 Gigabit Ethernet client

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio
button and click Refresh.

Note

Step 3 Under Types, click the Alarm radio button and click Refresh.

Do not modify the Laser Bias parameters.Note

Step 4 Verify the client port Alarm thresholds are provisioned as shown in table. Provision new thresholds as needed
by double-clicking the threshold value you want to change, deleting it, entering a new value, and hitting Enter.

Table 233: GE_XP, 10GE_XP, GE_XPE, or 10GE_XPEcard Client Interface Alarm Thresholds

Alarm TX
Power Low

Alarm TX
Power High

Alarm RX
Power Low

Alarm RX
Power High

Pluggable Port Module (XFP)

–81–16310GE LAN PHY 10GBASE-LR

–12–2–2031000Base-SX (1Gbps)16

–12–2–1831000Base-SX (2Gbps)1

–12–1–2301000Base-LX 1

16 Gigabit Ethernet client

Step 5 Click Apply.
Step 6 Repeat step 3 to step 5 to provision each additional client port.
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Step 7 Return to your originating procedure (NTP).

DLP-G388 Changing the RMON Threshold
This task changes the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card RMON
threshold settings.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), display the GE_XP, 10GE_XP, GE_XPE,
or 10GE_XPE card where you want to change the RMON thresholds.

Step 2 Click the Provisioning > RMON Thresholds tabs.
Step 3 Click Create. The Create Threshold dialog box appears.
Step 4 From the Port drop-down list, choose an individual port, or choose All to provision RMON thresholds for all

ports.
Step 5 From the Variable drop-down list, choose an Ethernet variable. See the table for a list of available Ethernet

RMON variables.

Variable descriptions were obtained from the following Internet Engineering Task Force (IETF)
Requests for Comment (RFCs): RFC 3635, RFC 2233, and RFC 1757. Refer to the RFCs for
additional information.

Note

Table 234: Gigabit Ethernet RMON Variables

DescriptionVariable

Total number of receive packets.rxTotalPkts

The number of packets, delivered by this sub-layer to a higher (sub-)layer, which were not
addressed to a multicast or broadcast address at this sub-layer.

ifInUcastPkts

The number of packets, delivered by this sub-layer to a higher (sub-)layer, which were
addressed to a multicast address at this sub-layer. For a MAC layer protocol, this includes
both Group and Functional addresses.

ifInMulticastPkts

The number of packets, delivered by this sub-layer to a higher (sub-)layer, which were
addressed to a broadcast address at this sub-layer.

ifInBroadcastPkts
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DescriptionVariable

The number of inbound packets which were chosen to be discarded even though no errors
had been detected to prevent their being deliverable to a higher-layer protocol. One possible
reason for discarding such a packet could be to free up buffer space.

ifInDiscards

Total number of octets received on the interface, including framing characters.ifInOctets

Total number of octets transmitted out of the interface, including framing characters.ifOutOctets

Total number of transmitted packets.txTotalPkts

The total number of packets that higher-level protocols requested be transmitted, and which
were addressed to a multicast address at this sub-layer, including those that were discarded
or not sent. For a MAC layer protocol, this includes both group and functional addresses.

ifOutMulticastPkts

The total number of packets that higher-level protocols requested be transmitted, and which
were addressed to a broadcast address at this sub-layer, including those that were discarded
or not sent.

ifOutBroadcastPkts

The number of outbound packets which were chosen to be discarded even though no errors
had been detected to prevent their being transmitted. One possible reason for discarding such
a packet could be to free up buffer space.

ifOutDiscards

Number of outbound packets or transmission units that could not be transmitted because of
errors.

IfOutErrors

A count of frames received on a particular interface that are an integral number of octets in
length but do not pass the FCS check.

dot3StatsFCSErrors

A count of frames received on a particular interface that exceed the maximum permitted
frame size.

dot3StatsFrameTooLong

A count of MAC control frames received on this interface that contain an opcode that is not
supported by this device.

dot3ControlInUnknownOpCode

A count of MAC control frames received on this interface with an opcode indicating the
PAUSE operation.

dot3InPauseFrames

A count of frames received on a particular interface that are an integral number of octets in
length but do not pass the FCS check.

dot33StatsFCSErrors

A count of frames received on a particular interface that exceed the maximum permitted
frame size.

dot3StatsFrameTooLong

A count of MAC control frames received on this interface that contain an opcode that is not
supported by this device.

dot3ControlInUnknownOpCode

A count of MAC control frames received on this interface with an opcode indicating the
PAUSE operation.

dot3InPauseFrames

A count of MAC Control frames transmitted on this interface with an opcode indicating the
PAUSE operation.

dot3OutPauseFrames
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DescriptionVariable

Total number of packets received that had a length (excluding framing bits, but including
FCS octets) of between 64 and 1518 octets, inclusive, but had either a bad FCSwith an integral
number of octets (FCS Error) or a bad FCS with a non-integral number of octets (Alignment
Error).

etherStatsCRCAlignErrors

The total number of packets received that were less than 64 octets long (excluding framing
bits, but including FCS octets) and were otherwise well formed.

etherStatsUndersizePkts

The total number of packets received that were less than 64 octets in length (excluding framing
bits but including FCS octets) and had either a bad Frame Check Sequence (FCS) with an
integral number of octets (FCS Error) or a bad FCS with a non-integral.

etherStatsFragments

The total number of packets (including bad packets, broadcast packets, and multicast packets)
received.

etherStatsPkts

The total number of packets (including bad packets) received that were 64 octets in length
(excluding framing bits but including FCS octets).

etherStatsPkts64Octets

The total number of packets (including error packets) received that were between 65 and 127
octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts65to127Octets

The total number of packets (including error packets) received that were between 128 and
255 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts128to255Octets

The total number of packets (including error packets) received that were between 256 and
511 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts256to511Octets

The total number of packets (including error packets) received that were between 512 and
1023 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts512to1023Octets

The total number of packets (including error packets) received that were between 1024 and
1518 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts1024to1518Octets

The total number of packets (including error packets) received that were between 1519 and
1522 octets in length inclusive (excluding framing bits but including FCS octets).

This variable is supported only on client ports.Note

etherStatsPkts1519to1522Octets

The total number of good packets received that were directed to the broadcast addressetherStatsBroadcastPkts

The total number of good packets received that were directed to a multicast address. Note
that this number does not include packets directed to the broadcast address.

etherStatsMulticastPkts

The total number of packets received that were longer than 1518 octets (for untagged packets)
or 1522 octets (for tagged packets) (excluding framing bits, but including FCS octets) and
were otherwise well formed.

etherStatsOversizePkts

The total number of packets received that were longer than 1518 octets (for untagged packets)
or 1522 octets (for tagged packets) (excluding framing bits, but including FCS octets), and
were not an integral number of octets in length or had a bad FCS.

etherStatsJabbers
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DescriptionVariable

The total number of octets of data (including those in bad packets) received on the network
(excluding framing bits but including FCS octets).

etherStatsOctets

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, the
falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold
to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total
number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.
Step 9 Type in the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.
Step 12 To view all RMON thresholds, click Show All RMON thresholds.
Step 13 Return to your originating procedure (NTP).

DLP-G389 Changing OTN Settings
This task changes the optical transport network (OTN) settings for the GE_XP,
10GE_XP, GE_XPE, and 10GE_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP,
GE_XPE, or 10GE_XPE card where you want to change the OTN settings.

Step 2 Click the Provisioning >OTN tabs, then choose one of the following subtabs: OTN Lines, G.709 Thresholds,
FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in the tables.

You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To
do so, choose the appropriate radio button and click Refresh.

The table describes the values on the Provisioning > OTN > OTN Lines tab.

Note

Table 235: GE_XP, 10GE_XP, GE_XPE, or 10GE_XPECard OTN Line Settings

OptionsDescriptionParameter

3 (Trunk) and 4 (Trunk). 10GE_XP and
10GE_XPE cards

21 (Trunk) and 22 (Trunk). GE_XP and
GE_XPE cards

(Display only) Port number and description:Port

• Enable

• Disable

Sets the OTN lines according to
ITU-T G.709.

ITU-T G.709
OTN

• Standard

• Enhanced

Sets the OTN lines to forward error
correction (FEC).

FEC

• 1E-5(Display only) Sets the signal fail bit error
rate.

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

The table describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.

Table 236: GE_XP, 10GE_XP, GE_XPE, or 10GE_XPECard ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

3 (Trunk) and 4 (Trunk). 10GE_XP and 10GE_XPE
cards

21 (Trunk) and 22 (Trunk). GE_XP and GE_XPE cards

(Display only) Port number and
description:

Port
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OptionsDescriptionParameter

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Errored secondsES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Severely errored secondsSES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Unavailable secondsUAS

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Background block errorsBBE

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select a bullet and click Refresh.

Failure counterFC

The table describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 237: GE_XP, 10GE_XP, GE_XPE, or 10GE_XPECard FEC Threshold Settings

OptionsDescriptionParameter

3 (Trunk) and 4 (Trunk). 10GE_XP and
10GE_XPE cards

21 (Trunk) and 22 (Trunk). GE_XP and
GE_XPE cards

(Display only) Port number and description:Port

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for bit errors corrected.Bit Errors
Corrected

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for uncorrectable words.Uncorrectable
Words

The table describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 238: GE_XP, 10GE_XP, GE_XPE, and 10GE_XPECard Trail Trace Identifier Settings

OptionsDescriptionParameter

2(Display only) Port number.Port

• Section

• Path

Sets the level.Level
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OptionsDescriptionParameter

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

String of trace string sizeDisplays the current transmit string; sets a
new transmit string. You can click the button
on the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
disabled)

If a Trace Identifier Mismatch on Section
overhead alarm arises because of a J0
overhead string mismatch, no Forward
Defect Indication (FDI) signal is sent to the
downstream nodes if this box is checked.

Disable FDI on
TTIM

String of trace string sizeDisplays the current expected string; sets a
new expected string. You can click the
button on the right to change the display. Its
title changes, based on the current display
mode. Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec check box to keep
this panel updated.

Received

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

NTP-G314 Adding a Card on FAPS Ring
This procedure adds a GE_XP or 10GE_XP card on a FAPS ring.Purpose

Installed GE_XP or 10GE_XP cards.Tools/Equipment
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DLP-G46 Log into CTC

“NTP-G15 Install the Common Control Cards” in the Cisco ONS 15454
Hardware Installation Guide

Complete the "NTP-G179 Install the Transponder and Muxponder Cards"
procedure in "Turn up a node" chapter.

DLP-G379 Changing the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card
Mode, on page 311

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Perform any of the following tasks as needed:

• DLP-G687 Adding a Card Facing the Primary Card on FAPS Ring, on page 586

• DLP-G688 Adding a Card Between Secondary Cards on FAPS Ring, on page 587

Stop. You have completed this procedure.

DLP-G687 Adding a Card Facing the Primary Card on FAPS Ring
This procedure adds a GE_XP or 10GE_XP card that faces the primary card
on a FAPS ring.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 Verify that the GE_XP or 10GE_XP card is installed according to the requirements specified in table in
DLP-G375 Installing Fiber-Optic Cables on the Y-Cable Modules in the FlexLayer Shelf task.

Step 2 Insert the new GE-XP card with XFP on the slot.
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Step 3 Change theGE_XP cardmode to L2-over-DWDM. SeeDLP-G379Changing theGE_XP, 10GE_XP, GE_XPE,
and 10GE_XPE Card Mode, on page 311.

Step 4 Create and store an SVLAN database on the new GE_XP card. See the DLP-G421 Creating and Storing an
SVLAN Database task.

Step 5 Enable FAPS protection on the new card.
Step 6 Attach SVLAN to the trunk ports of the new card.
Step 7 Choose OOS,DSBLD from the Admin State column for port 22 on the primary card that is facing toward the

new card. This action places port 22 in the blocking state and port 21 in the forwarding state.

FAPS configuration mismatch alarm is raised on the primary card.Note

Step 8 Switch the traffic to the protect path.
Step 9 Choose OOS,DSBLD from the Admin State column for port 21 on the secondary card that is facing toward

the new card.
Step 10 Connect the fiber from the secondary card (that is facing toward the new card) to the new card in segment B.
Step 11 Connect the fiber from the primary card to the new card in segment A.
Step 12 Choose IS from the Admin State column for port 21 on the secondary card that is facing toward the new card.
Step 13 Choose IS from the Admin State column for port 22 on the new card to bring up segment B.
Step 14 Choose IS from the Admin State column for port 21 on the new card.

The FAPS state of the new card will be in the forwarding state for both the ports and port 21 of
the secondary card will be in the blocking state.

Note

Step 15 Choose IS from the Admin State column for port 22 on the primary card to bring up segment A.

The FAPS state of port 21 on the primary card will be in the blocking state and port 22 will be
in the forwarding state. The trunk ports of the remaining GE_XP cards will be in the forwarding
state. The port 21 of the secondary card (that is facing toward the new card) will change to the
forwarding state.

Note

Step 16 Return to your originating procedure (NTP).

DLP-G688 Adding a Card Between Secondary Cards on FAPS Ring
This procedure adds a GE_XP or 10GE_XP card between the two secondary
cards on a FAPS ring.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 Verify that the GE_XP or 10GE_XP card is installed according to the requirements specified in table in the
DLP-G375 Installing Fiber-Optic Cables on the Y-Cable Modules in the FlexLayer Shelf task.

Step 2 Insert the new GE-XP card with XFP on the slot.
Step 3 Change the GE_XP card mode to L2-over-DWDM. See the DLP-G379 Changing the GE_XP, 10GE_XP,

GE_XPE, and 10GE_XPE Card Mode, on page 311.
Step 4 Create and store an SVLAN database on the new GE_XP card. See the DLP-G421 Creating and Storing an

SVLAN Database task.
Step 5 Attach SVLAN to the trunk ports of the new card.
Step 6 Choose OOS, DSBLD from the Admin State column for port 22 on secondary card 1, and port 21 on secondary

card 2 that are facing toward the new card.
Step 7 Connect the fiber from the secondary card 1 to the new card in segment A.
Step 8 Connect the fiber from the secondary card 2 to the new card in segment B.
Step 9 Choose IS from the Admin State column for port 22 on the secondary card 1.
Step 10 Choose IS from the Admin State column for port 21 on the new card to bring up segment A.
Step 11 Choose IS from the Admin State column for port 22 on the new card.
Step 12 Choose IS from the Admin State column for port 21 on the secondary card 2 to bring up segment B.
Step 13 Return to your originating procedure (NTP).

NTP-G197 Provisioning the OTU2_XP Card Line Settings, PM
Parameters, and Thresholds

This procedure changes line settings, PM parameters, and threshold setting for
the OTU2_XP card.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G723 Install PPM on a Line Card

• DLP-G452 Changing the OTU2_XP Card Mode, on page 314

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task, to preserve the existing transmission
settings.

Step 2 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card.
Step 3 Verify the card mode:

a) Display the OTU2_XP card in card view.
b) Click the Provisioning > Card tabs.
c) Verify that the card mode is set to the mode designated by your site plan:

• Transponder

• Standard Regen

• Enhanced FEC

• Mixed

• 10G Ethernet LAN Phy to WAN Phy

If the card mode is set correctly, continue with step 6. If not, complete the DLP-G452 Changing the
OTU2_XP Card Mode, on page 314 task.

Step 4 Refer to the OTU2_XP Card Configuration Rules section on before performing any task listed in step 5.
Step 5 Perform any of the following tasks as needed.

• DLP-G453 Changing the OTU2_XP Card Settings

• DLP-G454 Changing the OTU2_XP Line Settings

• DLP-G455 Changing the OTU2_XP Line Section Trace Settings

• DLP-G456 Changing the OTU2_XP Line Thresholds for SONET or SDH Payloads

• DLP-G457 Provisioning the OTU2_XP Port Alarm and TCA Threshold

• DLP-G462 Changing the OTU2_XP Line RMON Thresholds

• DLP-G458 Changing the OTU2_XP OTN Settings

• DLP-G523 Changing the OTU2_XP Path Trace Settings

• DLP-G524 Provisioning the OTU2_XP Path Settings for 10G Ethernet LAN Phy to WAN Phy
Configuration

Stop. You have completed this procedure.

DLP-G453 Changing the OTU2_XP Card Settings
This task changes the card settings for the OTU2_XP card.Purpose

NoneTools/Equipment
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DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the card settings.

Step 2 Click the Provisioning > Card tab.
Step 3 Modify any of the settings described in table.

Table 239: OTU2_XP Card Settings

ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• Transponder

• Standard Regen

• Enhanced FEC

• Mixed

• 10GEthernet LANPhy to
WAN Phy

• Transponder

• Standard Regen

• Enhanced FEC

• Mixed

• 10G Ethernet LAN Phy to
WAN Phy

Sets the card configuration.Card
Configuration

• Transponder

• Standard Regen

• Transponder

• Standard Regen

Sets the port configuration when the card
configuration is set as Mixed. For card
configurations other than Mixed, this is a
display-only parameter. You can configure Ports
2 and 4 as port mode, when the card is in 10G
Ethernet LAN Phy to WAN Phy mode.

Port Mode

• Transparent

• Regeneration Section
(RS)

• Multiplex Section (MS)

• Transparent

• Section

• Line

Sets the mode of operation. (This option is only
available for SONET/SDH payloads). For
Standard Regen and Enhanced FEC card
configurations, this is a display-only parameter.

Termination
Mode

——(Display only) The card framing type, either
SONET or SDH.

Framing Type

• AIS

• Squelch

• AIS

• Squelch

Sets the transparent termination mode
configuration.

AIS/Squelch
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

——Sets the regeneration line name.Regen Line
Name

• Transparent Standard Use

• Cisco Extended Use

• Transparent Standard Use

• Cisco Extended Use

Sets the ODU overhead byte configuration. For
Transponder card configuration, this is a
display-only parameter.

ODU
Transparency

• Enable

• Disable

• Enable

• Disable

Enables or disables the proactive protection regen
mode.

Proactive
Protection
Regen

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G454 Changing the OTU2_XP Line Settings
This task changes the line settings for OTU2_XP card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the line settings.

Step 2 Click the Provisioning > Line > Ports/SONET/Ethernet tabs.
Step 3 Modify any of the settings described in table.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
591

Provisioning Transponder and Muxponder Cards
DLP-G454 Changing the OTU2_XP Line Settings

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Table 240: OTU2_XP Line Settings

ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• 1-1 (STM-64/10G Ethernet
WAN Phy/10G Ethernet LAN
Phy/10G FC)

• 2-1 (STM-64/10G Ethernet
WAN Phy/10G Ethernet LAN
Phy/10G FC)

• 3-1 (STM-64/10G Ethernet
WAN Phy/10G Ethernet LAN
Phy/10G FC)

• 4-1 (STM-64/10G Ethernet
WAN Phy/10G Ethernet LAN
Phy/10G FC)

• IB_5G

• 1-1 (OC192/10G Ethernet WAN
Phy/10G Ethernet LAN Phy/10G
FC)

• 2-1 (OC192/10G Ethernet WAN
Phy/10G Ethernet LAN Phy/10G
FC)

• 3-1 (OC192/10G Ethernet WAN
Phy/10G Ethernet LAN Phy/10G
FC)

• 4-1 (OC192/10G Ethernet WAN
Phy/10G Ethernet LAN Phy/10G
FC)

• IB_5G

(Display only) Displays the port
number.

Port

User-defined. Name can be up to
80 alphanumeric/special characters.
Blank by default.

For more information, see,
DLP-G104 Assigning a Name to a
Port

User-defined. Name can be up to
80 alphanumeric/special characters.
Blank by default. For more information,
see, DLP-G104 Assigning a Name to a
Port

Provides the ability to assign the
specified port a name.

Port Name

• Unlocked

• Unlocked,automaticInService

• Locked,disabled

• Locked,maintenance

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

Sets the port service state. For more
information about administrative
states, see the Administrative and
Service States document.

Admin State

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenance

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

(Display only) Identifies the
autonomously generated state that
gives the overall condition of the
port. Service states appear in the
format: Primary State-Primary State
Qualifier, Secondary State. For
more information about service
states, see the Administrative and
Service States document.

Service State
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• Disabled (default): ALS is off;
the laser is not automatically
shut down when traffic outages
(LOS) occur.

• Auto Restart: ALS is on; the
laser automatically shuts down
when traffic outages (LOS)
occur. It automatically restarts
when the conditions that caused
the outage are resolved.

• Manual Restart: ALS is on; the
laser automatically shuts down
when traffic outages (LOS)
occur. However, the laser must
be manually restarted when
conditions that caused the
outage are resolved.

• Manual Restart for Test:
Manually restarts the laser for
testing.

• Disabled (default): ALS is off; the
laser is not automatically shut
down when traffic outages (LOS)
occur.

• Auto Restart: ALS is on; the laser
automatically shuts down when
traffic outages (LOS) occur. It
automatically restarts when the
conditions that caused the outage
are resolved.

• Manual Restart: ALS is on; the
laser automatically shuts down
when traffic outages (LOS) occur.
However, the laser must be
manually restarted when
conditions that caused the outage
are resolved.

• Manual Restart for Test:Manually
restarts the laser for testing.

Sets the ALS function mode. The
DWDM transmitter supports ALS
according to ITU-T G.644 (06/99).
ALS can be disabled, or it can be
set for one of three mode options.

ALS Mode

The Reach options depend on the
traffic type that has been selected.

The Reach options depend on the traffic
type that has been selected.

Displays the optical reach distance
of the client/trunk ports.

Reach

• First Tunable Wavelength

• Further wavelengths: 850 nm
through 1610 nm, 100-GHz ITU
spacing; CWDM spacing

Supported
wavelengths are
marked by
asterisks (**).

Note

• First Tunable Wavelength

• Further wavelengths: 850 nm
through 1610 nm, 100-GHz ITU
spacing; coarse wavelength
division multiplexing (CWDM)
spacing

Supported
wavelengths are
marked by asterisks
(**).

Note

Displays the wavelength of the
client/trunk ports.

Wavelength

• Duration of valid input signal,
in hh.mm format, after which
the card becomes IS
automatically

• 0 to 48 hours, 15-minute
increments

• Duration of valid input signal, in
hh.mm format, after which the card
becomes in service (IS)
automatically

• 0 to 48 hours, 15-minute
increments

Sets the automatic in-service soak
period. Double-click the time and
use the up and down arrows to
change settings.

AINS Soak
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• 1E-3

• 1E-4

• 1E-5

• 1E-3

• 1E-4

• 1E-5

(SONET [ANSI] or SDH [ETSI]
only) Sets the signal fail bit error
rate.

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

(SONET [ANSI] or SDH [ETSI]
only) Sets the signal degrade bit
error rate.

SD BER

• SONET

• SDH

• SONET

• SDH

When Type is set to
SDH in a SONET
(ANSI) provisioning,
SDCC or LDCC on
OTU2_XP cards
cannot be
provisioned.

Note

(SONET [ANSI] or SDH [ETSI]
only) The optical transport type.

Type

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

The maximum size of the Ethernet
frames accepted by the port. The
port must be in OOS/locked state.

MTU stands for “Maximum
TransmissionUnit” typicallymeant
for configuring themaximum frame
size allowed. However, the
OTU2_XP card does not block the
frames based on Ethernet frame
size and Jumbo frames are
supported irrespective of the MTU
setting. In 10G LAN Phy to WAN
Phy mode, MTU can be set only to
1548 bytes.

MTU

Value of MAC address. Six bytes in
hexadecimal format.

Value of MAC address. Six bytes in
hexadecimal format.

Sets the incoming MAC address.IncomingMAC
Address
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• ON (default)—Flow control is
enabled.

• OFF—Flow control is disabled.

• ON (default)—Flow control is
enabled.

• OFF—Flow control is disabled.

Enables/disables flow control
messaging with its peer port. When
enabled, the port can send and
receive PAUSE frameswhen buffer
congestion occurs. When disabled,
no PAUSE frames are transmitted
and the PAUSE frames received
are discarded.

Flow Control
(Only when the
card is in 10G
Ethernet LAN
Phy to WAN
Phy mode)

• 10 km (default)

• 30 km

• 10 km (default)

• 30 km

Sets the fiber distance between the
client of OTU2_XP card and the
LAN port that is connected to the
OTU2_XP client port.

Client Distance
(Only when the
card is in 10G
Ethernet LAN
Phy to WAN
Phy mode)

• Disable (0 ms) - Default value

• 50 ms

• 100 ms

• 250 ms

• 500 ms

• Disable (0 ms) - Default value

• 50 ms

• 100 ms

• 250 ms

• 500 ms

Sets the period in milliseconds that
the client interface waits for
resolution of issues on the trunk
side. The client squelching starts
after this period.

The user can configure the squelch
hold off timer in CTC only under
the following conditions:

• The card must be configured
in TXP or MXP operating
modes.

• The client payload must be
10GE or 100GE.

• The Squelch drop-down in
CTC must be set to Squelch.

Squelch Hold
Off Timer

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G455 Changing the OTU2_XP Line Section Trace Settings
This task changes the line section trace settings for the OTU2_XP card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed
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Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.
Step 3 Modify any of the settings described in table.

Table 241: OTU2_XP Section Trace Settings

ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• 1-1 (STM-64)

• 2-1 (STM-64)

• 3-1 (STM-64)

• 4-1 (STM-64)

• 1-1 (OC192)

• 2-1 (OC192)

• 3-1 (OC192)

• 4-1 (OC192)

Sets the port number.Port

• Off/None

• Manual

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S
is not disabled)

• Checked (AIS/RDI on
TIM-S is disabled)

• Unchecked (AIS/RDI on
TIM-S is not disabled)

If a TIM on Section overhead alarm arises
because of a J0 overhead stringmismatch,
no alarm indication signal is sent to
downstream nodes if this box is checked.

This is a display-only parameter under
the following conditions:

• Received Trace Mode is Off/None

• Termination Mode is set to
Transparent or Section (see the
DLP-G453Changing theOTU2_XP
Card Settings task).

Disable
AIS/RDI on
TIM-S

• 1 byte

• 16 byte

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

String of trace string sizeString of trace string sizeDisplays the current transmit string; sets
a new transmit string. You can click the
button on the right to change the display.
Its title changes, based on the current
display mode. Click Hex to change the
display to hexadecimal (button changes
to ASCII); click ASCII to change the
display to ASCII (button changes to Hex).

Transmit

String of trace string sizeString of trace string sizeDisplays the current expected string; sets
a new expected string. You can click the
button on the right to change the display.
Its title changes, based on the current
display mode. Click Hex to change the
display to hexadecimal (button changes
to ASCII); click ASCII to change the
display to ASCII (button changes to Hex).

Expected

String of trace string sizeString of trace string size(Display only) Displays the current
received string. You can click Refresh to
manually refresh this display, or check
the Auto-refresh check box to
automatically refresh the display every 5
seconds.

Received

Checked/unchecked (default)Checked/unchecked (default)If checked, automatically refreshes the
display every 5 seconds.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G456 Changing the OTU2_XP Line Thresholds for SONET or SDH Payloads
This task changes the line threshold settings for the OTU2_XP card carrying
SONET or SDH payload.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) tabs.

If you have enabled 10G Ethernet LAN Phy to WAN Phy on the OTU2_XP card, the STS option
is automatically enabled. Only near end STS thresholds are supported. No STS thresholds are
support for Far End.

Note

Step 3 Modify any of the OTU2_XP card path threshold settings on a LAN Phy to WAN Phy mode.

Table 242: OTU2_XP Card Path Threshold Settings on a 10G Ethernet LAN Phy to WAN Phy Mode

ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• Port 3-1 (Trunk), VC4-1

• Port 4-1 (Trunk), VC4-1

• Ports 3-1 (Trunk), STS-1

• Ports 4-1 (Trunk), STS-1

(Display only) Port
number.

Port

Step 4 Modify any of the OTU2_XP Card Line Threshold settings described in table.

Table 243: OTU2_XP Card Line Threshold Settings

ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• 1-1 (STM-64)

• 2-1 (STM-64)

• 3-1 (STM-64)

• 4-1 (STM-64)

• 1-1 (OC192)

• 2-1 (OC192)

• 3-1 (OC192)

• 4-1 (OC192)

(Display only) Port
number

Port

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex
Section or Regeneration Section

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or
Section

Choose an option in each category and click
Refresh.

Coding violationsCV
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ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex
Section or Regeneration Section

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or
Section

Choose an option in each category and click
Refresh.

Errored secondsES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex
Section or Regeneration Section

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or
Section

Choose an option in each category and click
Refresh.

Severely errored
seconds

SES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex
Section or Regeneration Section

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or
Section

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only) Failure
count

FC

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex
Section or Regeneration Section

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or
Section

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only)
Unavailable seconds

UAS

Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).
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DLP-G457 Provisioning the OTU2_XP Port Alarm and TCA Threshold
This task provisions the OTU2_XP port alarm and threshold crossing alert
(TCA) thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.
Step 3 Under Types, verify that the TCA radio button is checked. If not, select it, then click Refresh.
Step 4 Refer to table to provision the port TCA thresholds for RX Power High, RX Power Low, TX Power High,

and TX Power Low.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

Table 244: OTU2_XP Port TCA Thresholds

TCA TX

Power Low

TCA TX

Power High

TCA RX

Power Low

TCA RX

Power High

Port

–12.0 dBm5.0 dBm–14.0 dBm1.0 dBm1-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

–12.0 dBm5.0 dBm–14.0 dBm1.0 dBm2-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

–12.0 dBm5.0 dBm–14.0 dBm1.0 dBm3-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

–12.0 dBm5.0 dBm–14.0 dBm1.0 dBm4-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

Step 5 Click Apply.
Step 6 Under Types, click the Alarm radio button and click Refresh.
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Step 7 Refer to table to provision the port alarm thresholds for RX Power High, RX Power Low, TX Power High,
and TX Power Low.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Table 245: OTU2_XP Port Alarm Thresholds

Alarm TX

Power Low

Alarm TX

Power High

Alarm RX

Power Low

Alarm RX

Power High

Port

–8.0 dBm1.0 dBm–16.0 dBm3.0 dBm1-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

–8.0 dBm1.0 dBm–16.0 dBm3.0 dBm2-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

–8.0 dBm1.0 dBm–16.0 dBm3.0 dBm3-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

–8.0 dBm1.0 dBm–16.0 dBm3.0 dBm4-1 (OC-192/10G Ethernet WAN Phy/10G
Ethernet LAN Phy/10G FC/IB_5G)

Step 8 Click Apply.
Step 9 Return to your originating procedure (NTP).

DLP-G462 Changing the OTU2_XP Line RMON Thresholds
This task changes the line threshold settings for OTU2_XP card carrying the
10G Ethernet or 10G FC payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the line threshold in the card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
Step 3 Click Create.
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Step 4 From the Port drop-down list, choose the applicable port.
Step 5 From the Variable drop-down list, choose an Ethernet variable.

Table 246: OTU2_XP Card 10G Ethernet Variables

DescriptionVariable

Total number of octets received on the interface, including framing
characters.

ifInOctets

Total number of received packets. rxTotalPkts increments for 10G FC
payload packets with FCS errors. However, 10G Ethernet LAN Phy
payload packets with CRC errors are not counted.

rxTotalPkts

Number of multicast frames received error free.ifInMulticastPkts

Number of packets, delivered by a sublayer to an higher sublayer, that
were addressed to a broadcast address at this sublayer.

ifInBroadcastPkts

Number of inbound packets that contained errors preventing them
from being delivered to a higher-layer protocol.

ifInErrors

Number of frames with frame check errors, that is, there is an integral
number of octets, but an incorrect Frame Check Sequence (FCS).

dot3StatsFCSErrors

Total number of packets received that were less than 64 octets long
(excluding framing bits, but including FCS octets) and were otherwise
well formed.

etherStatsUndersizePkts

Total number of packets received that were less than 64 octets in length
(excluding framing bits but including FCS octets) and had either a bad
FCS with an integral number of octets (FCS Error) or a bad FCS with
a non-integral number of octets (Alignment Error). Note that it is
entirely normal for etherStatsFragments to increment. This is because
it counts both runts (which are normal occurrences due to collisions)
and noise hits.

etherStatsFragments

Total number of packets (including bad packets) received that were
64 octets in length (excluding framing bits but including FCS octets).

etherStatsPkts64Octets

Total number of packets (including bad packets) received that were
between 65 and 127 octets in length inclusive (excluding framing bits
but including FCS octets).

etherStatsPkts65to127Octets

The total number of packets (including bad packets) received that were
between 128 and 255 octets in length inclusive (excluding framing
bits but including FCS octets).

etherStatsPkts128to255Octets

Total number of packets (including bad packets) received that were
between 256 and 511 octets in length inclusive (excluding framing
bits but including FCS octets).

etherStatsPkts256to511Octets
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DescriptionVariable

Total number of packets (including bad packets) received that were
between 512 and 1023 octets in length inclusive (excluding framing
bits but including FCS octets).

etherStatsPkts512to1023Octets

Total number of packets (including bad packets) received that were
between 1024 and 1518 octets in length inclusive (excluding framing
bits but including FCS octets).

etherStatsPkts1024to1518Octets

Total number of good packets received that were directed to the
broadcast address. Note that this does not include multicast packets.

etherStatsBroadcastPkts

Total number of good packets received that were directed to a multicast
address. Note that this number does not include packets directed to
the broadcast address.

etherStatsMulticastPkts

Total number of packets received that were longer than 1518 octets
(excluding framing bits, but including FCS octets) and were otherwise
well formed.

etherStatsOversizePkts

Total number of packets received that were longer than 1518 octets
(excluding framing bits, but including FCS octets), and had either a
bad FCS with an integral number of octets (FCS Error) or a bad FCS
with a non-integral number of octets (Alignment Error).

etherStatsJabbers

Total number of octets of data (including those in bad packets) received
on the network (excluding framing bits but including FCS octets).

etherStatsOctets

Number of MAC control frames passed by the MAC sublayer to the
MAC control sublayer.

rxControlFrames

Table 247: OTU2_XP Card 10G FC Variables

DescriptionVariable

Total number of octets received on the interface, including framing
characters.

ifInOctets

Total number of fiber channel frames received that are less than the
minimum 36-byte frame. This is inclusive of header, SOF, EOF, and
CRC with no data bytes.

mediaIndStatsRxFramesTruncated

Total number of fiber channel frames received that exceed the
maximum 2148-byte frame. This is inclusive of header, SOF, EOF,
CRC, and data bytes.

mediaIndStatsRxFramesTooLong

Total number of fiber channel frames received with CRC errors.mediaIndStatsRxFramesBadCRC

The number of inbound packets, which were chosen to be discarded
even though no errors had been detected to prevent their being
delivered to a higher-layer protocol. One possible reason for
discarding such a packet could be to free up buffer space.117

ifInDiscards
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DescriptionVariable

Total number of octets transmitted out of the interface, including
framing characters.1

ifOutOctets

Number of transmitted data frames with payload CRC errors when
HDLC framing is used.1

mediaIndStatsTxFramesBadCRC

Number of transmitted pause frames.1transmitPauseFrames

Total number of transmit packets.1txTotalPkts

17 This variable is supported when the 10G Ethernet LAN Phy to WAN Phy mode is enabled on
the OTU2_XP card.

Step 6 From the Alarm Type drop-down list, choose the event triggers. The available options are rising threshold,
falling threshold, or rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold
to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total
number of occurrences, regardless of time period.

Step 8 Enter an appropriate number of seconds for the Sample Period.
Step 9 Enter in the appropriate number of occurrences for the Rising Threshold.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.

To view all RMON thresholds, click Show All RMON thresholds.Note

Step 12 Return to your originating procedure (NTP).

DLP-G458 Changing the OTU2_XP OTN Settings
This task changes the OTN line settings for the OTU2_XP card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs. Then click one of the following subtabs: OTN Lines,
ITU-T G.709 Thresholds, FEC Thresholds, Trail Trace Identifier, or Proactive Protection Regen.

Step 3 Modify any of the settings described in the following tables.

You must modify Near End and Far End independently, 15 Min and 1 Day independently, and
SM and PM independently. To do so, select the appropriate radio button and click Refresh.

The following table describes the values on the Provisioning > OTN > OTN Lines tabs.

Note

Table 248: OTU2_XP Card OTN Lines Settings

OptionsDescriptionParameter

—(Display only) Displays the port number and
optional name.

Port

• Enable

• Disable

Sets the OTN lines according to
ITU-T G.709. Check the box to enable.

ITU-T G.709
OTN

• Disable—FEC is off.

• Standard—Standard FEC is on.

• Enhanced—Enhanced FEC is on.

Sets the OTN lines FEC mode. Enhanced
FECmode can be enabled to provide greater
range and lower bit error rate.

FEC

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• 1E-5(Display only) Indicates the signal fail bit
error rate.

SF BER
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OptionsDescriptionParameter

• Disable

• Enable

Sets the insertion of stuffing bytes. This
parameter only applies to 10GEthernet LAN
Phy signals in transponder card
configuration. This is a display-only
parameter for all other card configurations.

When the “No Fixed Stuff” parameter is
disabled, the bit rate is 11.09 Gbps.

When the “No Fixed Stuff” parameter is
enabled, the bit rate is 11.05 Gbps.

No Fixed Stuff

The following table describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.

Table 249: OTU2_XP Card ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

—(Display only) Displays the port number and
optional name.

Port

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

SM (OTUk) is the ITU-T
G.709 optical channel transport
unit order of k overhead frame
used for management and
performance monitoring. PM
(ODUk) is the ITU-T G.709
optical channel data unit order
of k overhead frame unit used
for path performance
monitoring.

Note

Severely errored seconds. Two types of
thresholds can be asserted. Selecting the SM
(OTUk) radio button selects FEC, overhead
management, and PMusingOTUk. Selecting
the PM radio button selects path PM using
ODUk.

ES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Severely errored secondsSES
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OptionsDescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Unavailable secondsUAS

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Background block errorsBBE

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and click
Refresh.

Failure counterFC

The following table describes the values on the Provisioning > OTNFEC Thresholds tab.

Table 250: OTU2_XP Card FEC Threshold Settings

OptionsDescriptionParameter

—(Display only) Displays the port number and
optional name.

Port

Numeric display. Can be set for 15-minute
or one-day intervals.

Displays the number of bit errors corrected
during the selected time period.

Bit Errors
Corrected

Numeric display. Can be set for 15-minute
or one-day intervals.

Displays the number of uncorrectable words
in the selected time period.

Uncorrectable
Words

The following table describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

You cannot change the Path Trail Trace Identifier settings when the OTU2_XP card is in the
Standard Regen mode, and if the ODU transparency is set to “Transparent Standard Use”. You
can change the Path Trail Trace Identifier settings when the OTU2_XP card is in the Standard
Regen mode, and if the ODU transparency is set to “Cisco Extended Use”.

Note

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
607

Provisioning Transponder and Muxponder Cards
DLP-G458 Changing the OTU2_XP OTN Settings



Table 251: OTU2_XP Card Trail Trace Identifier Settings

OptionsDescriptionParameter

—Sets the port number.Port

• Section

• Path

Sets the level.Level

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
enabled)

If a Trace Identifier Mismatch on Section
overhead alarm arises because of a J0
overhead string mismatch, no Forward
Defect Indication (FDI) signal is sent to the
downstream nodes if this box is checked.

Disable FDI on
TTIM

String of trace string size; trail trace
identifier is 64 bytes in length.

Displays the current transmit string; sets a
new transmit string. You can click the button
on the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit

String of trace string sizeDisplays the current expected string; sets a
new expected string. You can click the
button on the right to change the display. Its
title changes, based on the current display
mode. Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec check box to keep
this panel updated.

Received

Checked/unchecked (default)If checked, automatically refreshes the
display every 5 minutes.

Auto-refresh

The following table describes the values on the Provisioning > OTN > Proactive Protection Regen tabs.

Proactive protection regen is supported on ports of OTU2_XP only in Standard Regen and
Enhanced FEC mode.

Note
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Table 252: OTU2_XP Card Proactive Protection Regen Settings

OptionsDescriptionParameter

—(Display only) Displays the port number and
name (optional).

Port

• 1E-3

• 9E-4 to 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

Sets the maximum BER threshold to trigger
proactive protection.

Trigger
threshold

Time in milliseconds.Sets the duration for which BER is
monitored before triggering the proactive
protection.

The trigger window valuemust be a multiple
of:

• 10 ms for trigger thresholds between
1E-3 and 6E-6

• 100 ms for trigger threshold between
5E-6 to 1E-7

Trigger window must be less than or equal
to 10000 ms.

Trigger window
(ms)

• 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

• 9E-8 to 5E-8

Sets the revert threshold value of BER.

Revert Threshold settingsmust
be less than the Trigger
Threshold values.

Note

Revert
Threshold
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OptionsDescriptionParameter

Time in milliseconds.Sets the duration for which BER is
monitored for settings that are less than the
revert threshold value before which proactive
protection provided to the router is removed.

Revert Window value must be at least
2000ms and a multiple of:

• 10ms for a Revert Threshold of 1E-4
to 6E-7

• 100ms for a Revert Threshold of 5E-7
to 5E-8.

The revert windowmust be less than or equal
to 10000ms.

Revert window
(ms)

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G523 Changing the OTU2_XP Path Trace Settings
This task changes the path trace settings for the OTU2_XP card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the path trace settings.

Step 2 Click the Provisioning > Path > J1 Path Trace tabs.
Step 3 Modify any of the settings described in table.
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Table 253: OTU2_XP Path Trace Settings

ONS 15454 SDH (ETSI)
Options

ONS 15454 (ANSI) OptionsDescriptionParameter

• 3-1 (STM-64)

• 4-1 (STM-64)

• 3-1 (OC192)

• 4-1 (OC192)

Sets the port number.Port

• Off/None

• Manual

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

String of trace string sizeString of trace string sizeDisplays the current transmit
string; sets a new transmit
string. You can click the button
on the right to change the
display. Its title changes, based
on the current display mode.
ClickHex to change the display
to hexadecimal (button changes
to ASCII); click ASCII to
change the display to ASCII
(button changes to Hex).

Transmit

String of trace string sizeString of trace string sizeDisplays the current expected
string; sets a new expected
string. You can click the button
on the right to change the
display. Its title changes, based
on the current display mode.
ClickHex to change the display
to hexadecimal (button changes
to ASCII); click ASCII to
change the display to ASCII
(button changes to Hex).

Expected

String of trace string sizeString of trace string size(Display only) Displays the
current received string. You can
click Refresh to manually
refresh this display, or check
the Auto-refresh check box to
automatically refresh the
display every 5 seconds.

Received

Checked/unchecked
(default)

Checked/unchecked
(default)

If checked, automatically
refreshes the display every 5
seconds.

Auto-refresh

Step 4 Click Apply.
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Step 5 Return to your originating procedure (NTP).

DLP-G524 Provisioning the OTU2_XP Path Settings for 10G Ethernet LAN Phy
to WAN Phy Configuration

This task changes the path settings of the OTU2_XP card for 10G Ethernet
LAN Phy to WAN Phy configuration.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where you
want to change the path settings.

Step 2 Click the Provisioning > Path > SONET/SDH tab. You can now provision the SF BER and SD BER values.
Step 3 Modify any of the OTU2_XP path settings described in table.

Table 254: OTU2_XP Path Settings

ONS 15454 SDH (ETSI) OptionsONS 15454 (ANSI) OptionsDescriptionParameter

• Port 3-1 (trunk)

• Port 4-1 trunk

• Port 3-1 (trunk)

• Port 4-1 trunk

Sets the port number.Port

• 1E-3

• 1E-4

• 1E-5

• 1E-3

• 1E-4

• 1E-5

Sets the signal fail bit error
rate (SONET [ANSI] or
SDH [ETSI]).

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit
error rate (SONET [ANSI]
or SDH [ETSI]).

SD BER
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Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

NTP-G162 Changing the ALS Maintenance Settings
This procedure changes the ALS maintenance settings for the cards.

The automatic laser shutdown (ALS) function is normally disabled. Enable
ALS only when the cards are directly connected to each other.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

ALS is applicable only for OCn and OTN payloads.Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card where you want to
change the ALS maintenance settings.

Step 2 Click the Maintenance > ALS tabs.
Step 3 Modify any of the settings described in table. The provisionable parameters are listed in the Options column

in the table.

Table 255: ALS Settings

OptionsDescriptionParameter

—(Display only) Displays the port name.Port
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OptionsDescriptionParameter

From the drop-down list, choose one of
the following:

• Disable—Deactivates ALS.

• Auto Restart—(Default) ALS is
active. The power is automatically
shut down when needed and
automatically tries to restart using
a probe pulse until the cause of the
failure is repaired.

• Manual Restart

• Manual Restart for Test

Automatic laser shutdown. ALS provides
the ability to shut down the laser when the
card detects an LOS or LOS-P.

ALS Mode

From the drop-down list, choose one of
the following:

• On

• Off

Optical safety remote interlock. When set to
On, the OSC TX output power is shut down.

OSRI

—(Display only forManual Restart ALSmode)
Displays the duration of the optical power
pulse that begins when the card restarts.

The Recovery Pulse Duration value in
Manual Restart ALS mode is always 2.5
seconds. From R10.9, this value cannot be
changed by CTC.

Recovery Pulse
Duration

—(Display only) Displays the current status of
the laser.

Currently Shutdown

Checked or uncheckedIf checked, allows you to restart the laser for
maintenance.

Request Laser Restart

—(Display only) Displays the interval between
optical power pulses.

Recovery Pulse
Interval

Step 4 Click Apply. If the change affects traffic, a warning message displays. Click Yes to complete the change.

Stop. You have completed this procedure.
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NTP-G302 Configuring Loopback on a Card
This procedure configures or clears terminal or facility loopback on the
100G-LC-C, 10x10G-LC, CFP-LC, MR-MXP, 100G-CK-C, 100G-ME-C,
100ME-CKC, 100GS-CK-LC, 200G-CK-LC, 400G-XP-LC, and WSE cards.
The loopback on the CFP-LC card can be configured on the backplane of the
peer 100G-LC-C card. The facility loopback (drop) can be configured on the
100G-LC-C, CFP-LC, and 100G-CK-C cards.

In WSE card, do not enable encryption with far-end client loop
back. Enabling encryption with far-ed client loopback will result
in sync loss until the key is exchanged. The key is exchanged only
after the ODUk-AIS on the trunk is cleared.

Note

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

This procedure is traffic-affecting.Caution

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card where you want to
change the loopback settings.

Step 2 Click Maintenance > Loopback tab.

In WSE card, do not enable encryption with far-end client loopback. This affects the traffic.Note

Step 3 Modify any of the settings described in table. The provisionable parameters are listed in the Options column
of the table.

Before you configure a loopback, the port admin state must be set to OOS,MT(ANSI) or
Locked,maintenance (ETSI).

Note

Table 256: Loopback Settings

OptionsDescriptionParameter

—(Display only) Name of the port.Port
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OptionsDescriptionParameter

• IS (ANSI) or Unlocked (ETSI)

• OOS,MT (ANSI) or
Locked,maintenance (ETSI)

• OOS,DSBLD (ANSI) or
Locked,disabled (ETSI)

• IS,AINS (ANSI) or
Unlocked,AutomaticInService
(ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states, see
the Administrative and Service States
document.

Admin State

• IS-NR (ANSI) or
Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or
Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or
Locked-enabled,maintenance
(ETSI)

(Display only) Identifies the autonomously
generated state that gives the overall
condition of the port. Service states appear
in the format: Primary State-Primary State
Qualifier, Secondary State. For more
information about service states, see the
Administrative and Service States document.

Service State

• None—Clears loopback

• Terminal (Inward)

• Facility (Line)

• Facility Loopback (Drop)

• Terminal Loopback (Drop)

Configures or clears a port for a terminal
(inward), facility (line), facility loopback
(drop), or terminal loopback (drop) on the
required port.

Loopback

Step 4 Click Apply.

Stop. You have completed this procedure.

NTP-G299 Configuring Backplane Loopback on a Card
This procedure configures or clears the backplane terminal or facility loopback
on the 100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100G-ME-C,
100ME-CKC, and 100GS-CK-LC cards. The backplane facility (drop) loopback
can be configured on the 100G-LC-C, CFP-LC, and 100G-CK-C cards.

The loopback on the CFP-LC card can be configured on the
backplane of the peer 100G-LC-C card.

Note

Purpose
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NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

This procedure is traffic-affecting.Caution

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card where you want to
change the backplane loopback settings. The card view appears.

Step 2 Click Maintenance > Card tabs.
Step 3 Modify any of the settings described in the table. The provisionable parameters are listed in the Options

column in the table.

Before you configure a backplane loopback, the port admin state must be set to OOS,MT(ANSI)
or Locked,maintenance (ETSI).

Note

Table 257: Backplane Loopback Settings

OptionsDescriptionParameter

• IS (ANSI) or Unlocked (ETSI)

• OOS,MT (ANSI) or
Locked,maintenance (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states, see
the Administrative and Service States
document.

Admin State

• IS-NR (ANSI) or
Unlocked-enabled (ETSI)

• OOS-MA,MT (ANSI) or
Locked-enabled,maintenance
(ETSI)

(Display only) Identifies the autonomously
generated state that gives the overall
condition of the port. Service states appear
in the format: Primary State-Primary State
Qualifier, Secondary State. For more
information about service states, see the
Administrative and Service States document.

Service State

• None

• Backplane Facility

• Backplane Terminal

• Backplane Facility (Drop)

Configures or clears backplane terminal
(Inward), facility (Line),or facility (Drop)
loopback on the card. You can configure the
backplane loopback only if the card is
removed from service.

Loopback
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Step 4 Click Apply.

Stop. You have completed this procedure.

NTP-G192 Forcing FPGA Update
This procedure forces an upgrade of the FPGA image on the
MXP_MR_10DME_C and MXP_MR_10DME_L cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 Perform step 1 only if you are updating the node software, else proceed to step 2.
a) Close the CTC window, if open.
b) Delete the CTC Cache from the CTC Launcher browser window.
c) Close the CTC Launcher browser window.
d) Relaunch the CTC Launcher browser window.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the MXP_MR_10DME_C or
MXP_MR_10DME_L card to be upgraded.

Step 3 For all ports being provisioned on the card, click the Provisioning > Line tabs.
a) Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Disabled (ETSI).
b) Click Apply, then Yes.

Step 4 Click the Provisioning > Card tabs.
Step 5 Change the Card Mode as needed:

• FC-GE_ISC—Choose this option if you will provision any of the following PPM port rates: FC1G (Ports
1-1 through 4-1), FC2G (Ports 1-1 and 3-1 only), FICON1G (Ports 1-1 through 4-1), FICON2G (Ports
1-1 and 3-1 only), ONE_GE (Ports 1-1 through 4-1), ISC3 COMPAT (Ports 1-1 through 4-1), ISC3
PEER 1G (Ports 1-1 through 4-1), and ISC3 PEER 2G (Ports 1-1 and 3-1 only).

• FC4G—Choose this option if you will provision an FC4G or FICON4G PPM (Port 1-1 only).

Step 6 Click the Force FPGA Update button. This upgrades the FPGA image in the MXP_MR_10DME_C or
MXP_MR_10DME_L card, as appropriate. TheMXP_MR_10DME_C orMXP_MR_10DME_L card reboots
and the FPGA now contains the updated image.

Step 7 For all ports being provisioned on the card, click the Provisioning > Line tabs.
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a. Click the Admin State table cell and choose IS (ANSI) or Unlocked (ETSI).

b. Click Apply, then Yes.

Stop. You have completed this procedure.

NTP-G196 Forcing FPGA Update on a Card in Protection Group
This procedure forces an upgrade of the FPGA image on the
MXP_MR_10DME_C and MXP_MR_10DME_L cards when the card is part
of a protection group.

This procedure applies to a near-end node that has two MXP_MR_10DME_C
or MXP_MR_10DME_L cards, one card acting as the working card and the
other as the protect card. The far-end node has a similar configuration. The
near-end working card trunk port is connected to the far-end working card trunk
port. The near-end protect card trunk port is connected to the far-end protect
card trunk port.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 Perform step 1 only if you are updating the node software. Else, proceed to step 2.
a) Close the CTC window, if open.
b) Delete the CTC Cache from the CTC Launcher browser window.
c) Close the CTC Launcher browser window.
d) Relaunch the CTC Launcher browser window.

Step 2 Ensure traffic is running on the near-end and far-end working cards for each protection group on the
MXP_MR_10DME_C or MXP_MR_10DME_L card.

Step 3 In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > Protection
tab.

Step 4 For each protection group, verify that the working card client port is reported as working/active and the protect
card client port is reported as protect/standby.

Step 5 Repeat step 6 and step 7 for the far-end node.
Step 6 For each protection group on the near-end and far-end nodes, complete the DLP-G182 Apply a Lockout task

to prevent traffic from switching to the protect card.
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Step 7 At the near-end and far-end nodes, complete the NTP-G192 Forcing FPGA Update task to force an upgrade
of the FPGA image on the protect card.

Step 8 For each protection group on the near-end and far-end nodes, complete the DLP-G183 Clear a Lock-On or
Lockout task to remove a lockout and return a protection group to its usual switching method.

Step 9 For each protection group on the near-end and far-end nodes, complete the DLP-G179 Apply a Force Y-Cable
or Splitter Protection Switch task to move traffic from the working to the protect card.

Step 10 At the near-end and far-end nodes, complete the NTP-G192 Forcing FPGA Update task to force an upgrade
of the FPGA image on the working card.

Step 11 For each protection group on the near-end and far-end nodes, complete the DLP-G180 Clear a Manual or
Force Y-Cable or Splitter Protection Switch task to clear a Force protection switch on the working card. If
the protection group is revertive, this operation causes the traffic to revert to the working card. If the protection
group is non-revertive, this operation causes the traffic to remain on the protect card.

Stop. You have completed this procedure.

NTP-G232 Enabling Error Decorrelator
This task enables error decorrelator on a TXP_MR_10EX_C,
MXP_2.5G_10EX_C, or MXP_MR_10DMEX_C card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10EX_C,
MXP_2.5G_10EX_C, or MXP_MR_10DMEX_C card where you want to enable error decorrelator.

Step 2 Click the Provisioning > Line > Error Decorrelator Settings tabs.
Step 3 In the Error Decorrelator Settings area, select Enable.

To inter-operate with other cards, disable the error decorrelator. Click the Provisioning > Line >
Error Decorrelator Settings tabs and then select Disable.

Note

Stop. You have completed this procedure.
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NTP-G315 Enabling the Wavelength Drifted Channel Automatic
Shutdown Feature

This procedure allows you to enable or disable the wavelength drifted channel
automatic shutdown feature for 40-SMR1-C, 40-SMR2-C, 80-WXC-C,
40-WXC-C, and 40-WSS-C cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In the node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >Defaults
tabs. The Node Defaults page opens.

Step 2 Select the card from the Defaults Selector pane where you want to enable or disable the wavelength drifted
channel automatic shutdown feature.

Step 3 Select the <card name>.config.card.WavelengthDrift from the Default Name column. Choose Disable or
Enable from the Default Value drop-down list for the selected card.

For example, if you select 40-SMR2-C card from the Defaults Selector folder, the Default Name column reads
“40-SMR2-C.config.card.WavelengthDrift”.

Step 4 Click Apply to save changes.

Stop. You have completed this procedure.

NTP-G316 Enabling REP and FAPS on the Same Port
This task allows you enable REP and FAPS on the same port for the GE_XP
and 10GE_XP cards. You can configure REP and FAPS on port 22 and 21 for
GE_XP cards, and port 4 and 3 for 10GE_XP cards.

The FAPS primary node on the edge ring should never be the node that has a
common FAPS and REP port.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 To enable REP, complete the following procedures:
a) DLP-G645 Creating a Segment
b) DLP-G647 Activating VLAN Load Balancing

Step 2 To enable FAPS, complete the DLP-G381 Provisioning Layer 2 Protection Settings

Stop. You have completed this procedure.

NTP-G321 Provisioning Multiple Operating Modes
This procedure enables you to provision multiple operating modes on the
AR_MXP, AR_XP, or AR_XPE cards.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• DLP-G726 Preprovisioning a Multirate PPM

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to provision an operating mode. The card view appears.

Step 2 Click the Provisioning > Card tabs.
Step 3 In the Card tab, click Create.
Step 4 From the Card Config Rate Selection section, select Low Rate Mode or High Rate Mode.
Step 5 In the Card Config Selection section:

a) Choose the Operating Mode from the drop-down list.
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The Operating Mode options vary depending on the Card Type (AR_MXP, AR_XP, or AR_XPE) and
Card Config Rate Selection.

b) For MXP_DME and MXPP_DME card modes, choose the Client Trunk Mapping from the drop-down
list. For other card modes, CTC automatically selects the client trunk mapping.

Step 6 Click Next.
Step 7 Select the appropriate trunk port that is available and click Next.
Step 8 Select the appropriate client port that is available and click Finish.

The selected operating mode is provisioned on the AR_MXP, AR_XP, or AR_XPE card.

When you want to upgrade the FPGA image on the AR_MXP, AR_XP, or AR_XPE card, click
the FPGA/FIRMWARE Upgrade button. This upgrades the FPGA image on the AR_MXP,
AR_XP, or AR_XPE card as appropriate, without the need of upgrading the whole network.

Firmware upgrade is allowed only when the ports are in OOS (out-of-service) or Maintenance
service state.

Note

Stop. You have completed this procedure.

NTP-G322 Modifying the Card Line Settings and PM Parameter
Thresholds

This procedure changes the line and PM parameter threshold settings of the
AR_MXP, AR_XP, or AR_XPE cards.

Purpose

NoneTools/Equipment

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task, to preserve the existing transmission
settings.

Step 2 Perform any of the following tasks as needed:
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• DLP-G695 Changing the Card Line Settings

• DLP-G698 Changing the AR_MXP, AR_XP, or AR_XPE Card Section Trace Settings

• DLP-G699 Enabling Auto-sensing for AR_MXP, AR_XP, or AR_XPE Cards

• DLP-G701 Changing the AR_MXP, AR_XP, or AR_XPE Card Line RMON Thresholds

• DLP-G702 Provisioning the AR_MXP, AR_XP, or AR_XPE Card with Trunk Port Alarm and TCA
Thresholds

• DLP-G703 Provisioning the AR_MXP, AR_XP, or AR_XPECard Client Port Alarm and TCAThresholds

• DLP-G704 Changing the AR_MXP, AR_XP, or AR_XPE Card OTN Settings

• DLP-G734 Viewing the Mapping of ODU Object with Client Port

To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see
the Alarm and TCA Monitoring and Management document.

Note

Stop. You have completed this procedure.

DLP-G695 Changing the Card Line Settings
This task changes the line settings of the AR_MXP, AR_XP, or AR_XPE cards.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the line settings.

Step 2 Click theProvisioning >Line > Ports tabs. Tabs and parameter selections vary according to PPMprovisioning.
Step 3 Modify any of the line settings in the Ports tab as described in table.

Table 258: AR_MXP, AR_XP, or AR_XPE Card Line Settings

OptionsDescriptionParameter

1 through 10(Display only) Displays the port number.Port

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
624

Provisioning Transponder and Muxponder Cards
DLP-G695 Changing the Card Line Settings

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_alarm_tca_monitoring.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


OptionsDescriptionParameter

User-defined. Name can be up to 80 alphanumeric or special
characters, or both. Blank by default.

See, DLP-G104 Assigning a Name to a Port

You can provision a string (port name) for each fiber
channel/FICON interface on the AR_MXP, AR_XP,
or AR_XPE card, which allows the MDS Fabric
Manager to create a link association between that
SAN port and a SAN port on a
Cisco MDS 9000 switch.

Note

Assigns a logical name for the specified port.Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

• IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states, see
the Administrative and Service States
document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)

(Display only) Identifies the autonomously
generated state that gives the overall condition
of the port. Service states appear in the format:
Primary State-Primary State Qualifier,
Secondary State. For more information about
service states, see the Administrative and
Service States document.

Service State

• Disabled (default)—ALS is off; the laser is not automatically
shut down when traffic outage or loss of signal (LOS) occurs.

• Manual Restart— ALS is on; the laser automatically shuts
down when traffic outage or loss of signal (LOS) occurs.
However, the laser must be manually restarted when
conditions that caused the outage are resolved.

• Manual Restart for Test— Manually restarts the laser for
testing.

Sets the ALS function mode.ALS Mode

• Duration of valid input signal, in hh.mm format, after which
the card state changes to in service (IS) automatically.

• 0 to 48 hours, 15-minute increments.

Sets the automatic in-service soak period.
Double-click the time and use the up and down
arrows to change settings.

AINS Soak
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OptionsDescriptionParameter

The reach distances that appear in the drop-down list depend on
the card:

• Autoprovision—The system automatically provisions the
reach from the pluggable port module (PPM) reach value on
the hardware.

• I1—Intermediate reach

• S1—Short reach, up to 15-km distance

• S2—Short reach up to 40-km distance

• L1—long reach, up to 40-km distance

• L2—long reach, up to 80-km distance

• L3—long reach, up to 80-km distance

• CWDM— CWDM Reach

• MM—

• ULH—Ultra long-haul (ULH)

• DWDM—DWDM Reach

Sets the optical reach distance of the client
port.

Reach

• First Tunable Wavelength

• Further wavelengths:

• 850 nm through 1561.83 nm

• 100-GHz ITU spacing

• CWDM spacing

Displays the wavelength of the client port.Wavelength

• G AIS/Send Local Fault

• Squelch/Laser-Off

• NOS

• None

Shuts down the far-end laser in response to
certain defects. (Squelch does not apply to ISC
COMPACT payloads.)

Fault Signalling

• TransparentSets the mode of operation. (This option is
only available for SONET/SDH payloads).

Termination
Mode

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G696 Changing the AR_MXP, AR_XP, or AR_XPE Card Ethernet Settings
This task changes the Ethernet settings of the AR_MXP, AR_XP, or AR_XPE
cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Line > Ethernet tabs.
Step 3 Modify any of the Ethernet settings in the Ethernet tab as described in table. The parameters that appear depend

on the card mode.

Table 259: AR_MXP, AR_XP, and AR_XPE Card Ethernet Settings

ONS 15454 SDH (ETSI)

Options

ONS 15454 (ANSI) OptionsDescriptionParameter

——(Display only) Displays the port number
(n-n) and rate.

Port

——(Display only) Displays the port Name.Port Name

Numeric. Default: 9700

Range 64 to 9700 (for R9.4 and
later)

Numeric. Default: 9700

Range 64 to 9700 (for R9.4 and later)

Sets the maximum size of the Ethernet
frames accepted by the port. The port
must be in OOS/locked state.

MTU

100 Mbps for FE ports and
1000 Mbps for GE ports

100 Mbps for FE ports and 1000 Mbps
for GE ports

Sets the expected speed of the ports.Speed

FullFull(Display only) Displays expected duplex
capability of ports.

Duplex

Checked or uncheckedChecked or uncheckedIf checked, enables autonegotiation on
the same port.

Auto
negotiation

Checked or uncheckedChecked or uncheckedSets the ProvidesSync card parameter.
If checked, the card is provisioned as a
network element (NE) timing reference.

ProvidesSync
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ONS 15454 SDH (ETSI)

Options

ONS 15454 (ANSI) OptionsDescriptionParameter

Checked or uncheckedChecked or uncheckedSets the EnableSync card parameter.

Enables synchronization statusmessages
(S1 byte), which allow the node to
choose the best timing source.

SyncMsgIn

• G811—Primary reference
clock

• STU—Sync traceability
unknown

• G812T—Transit node
clock traceable

• G812L—Local node clock
traceable

• SETS—Synchronous
equipment

• DUS—Do not use for
timing synchronization

• PRS—Primary Reference Source
(Stratum 1)

• ST2—Stratum 2

• TNC—Transit node clock

• ST3E—Stratum 3E

• ST3—Stratum 3

• SMC—SONET minimum clock

• ST4—Stratum 4

• DUS—Do not use for timing
synchronization

• RES—Reserved; quality level set
by user

Overrides the synchronization status
message (SSM) and the synchronization
traceability unknown (STU) value. If
the node does not receive an SSM
signal, it defaults to STU.

Admin SSM In

——(Display-only for StandardRegeneration
and Enhanced FEC card configurations)
Sets the mode of operation.

Termination
Mode

Checked or uncheckedChecked or uncheckedWhen checked, sends a DUS message
on the S1 byte.

Send
DoNotUse

Checked or uncheckedChecked or uncheckedEnables the timing to be taken from the
Ethernet port.

ESMC Enable

——VideoVideo Type

Step 4 Return to your originating procedure (NTP).

DLP-G697 Changing the AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Settings
This task changes the SONET /SDH settings of the AR_MXP, AR_XP, or
AR_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the SONET (OC-192)/SDH (STM-64) settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs. The tabs and parameter selections
vary according to PPM provisioning.

Step 3 Modify any of the settings as described in table.

Table 260: AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Settings

OptionsDescriptionParameter

—(Display only) Displays the port number.Port

User-defined. Name can be up to 80 alphanumeric or special
characters, or both. Blank by default.

DLP-G104 Assigning a Name to a Port

Assign a name for the specified port.Port Name

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Sets the port service state unless network conditions
prevent the change. For more information about
administrative states, see the Administrative and
Service States document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance
(ETSI)

(Display only) Identifies the autonomously generated
state that gives the overall condition of the port.
Service states appear in the format: Primary
State-Primary State Qualifier, Secondary State. For
more information about service states, see the
Administrative and Service States document.

Service State

• 1E-3

• 1E-4

• 1E-5

Sets the signal fail bit error rate.SF BER 18
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OptionsDescriptionParameter

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER1

• SONET (ANSI)

• SDH (ETSI)

Sets the optical transport type.Type

• Disabled (default)—ALS is off; the laser is not
automatically shut down when traffic outage or loss of
signal (LOS) occurs.

• Auto Restart—ALS is on; the laser automatically shuts
downwhen traffic outage or loss of signal (LOS) occurs.
It automatically restarts when the conditions that caused
the outage are resolved.

• Manual Restart—ALS is on; the laser automatically
shuts down when traffic outage or loss of signal (LOS)
occurs. However, the laser must be manually restarted
when conditions that caused the outage are resolved.

• Manual Restart for Test—Manually restarts the laser
for testing.

Sets theALS functionmode. TheDWDM transmitter
supports ALS according to ITU-T G.644 (06/99).
ALS can be disabled or enabled for one of the three
mode options.

ALS Mode

• Duration of valid input signal, in hh.mm format, after
which the card state changes to in service (IS)
automatically.

• 0 to 48 hours, 15-minute increments.

Sets the automatic in-service soak period.
Double-click the time and use the up and down
arrows to change settings.

AINS Soak

Checked or uncheckedSets the ProvidesSync card parameter. If checked,
the card is provisioned as a NE timing reference.

ProvidesSync

Checked or uncheckedSets the EnableSync card parameter. Enables
synchronization status messages (S1 byte), which
allow the node to choose the best timing source.

SyncMsgIn

STUOverrides the synchronization status message (SSM)
and the synchronization traceability unknown (STU)
value. If the node does not receive an SSM signal,
it defaults to STU.

Admin SSM In
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OptionsDescriptionParameter

The reach distances that appear in the drop-down list depend
on the card:

• Autoprovision—The system to automatically provision
the reach from the pluggable port module (PPM) reach
value on the hardware.

• I1/IR1—Intermediate Reach

• S1/SR1—Intermediate reach, up to 15-km distance

• S2/SR2—Intermediate reach up to 40-km distance

• L1/LR1—long reach, up to 40-km distance

• L2/LR2—long reach, up to 80-km distance

• L3/LR3—long reach, up to 80-km distance

• CWDM—CWDM Reach

• MM

• SR—Short Reach

• ULH—Ultra long-haul (ULH)

• DWDM—DWDM Reach

Sets the optical reach distance of the client port.Reach

• First Tunable Wavelength

• Further wavelengths:

• 850 nm through 1561.83 nm

• 100-GHz ITU spacing

• CWDM spacing

Displays the wavelength of the client port.Wavelength

18 SF BER and SD BER thresholds apply only to trunk ports.

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G698 Changing the AR_MXP, AR_XP, or AR_XPE Card Section Trace
Settings

This task changes the section trace settings of the AR_MXP, AR_XP, or
AR_XPE cards.

Purpose

NoneTools/Equipment
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DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to PPM
provisioning.

Step 3 Modify any of the settings in the Section Trace tab as described in the table.

Table 261: AR_MXP, AR_XP, or AR_XPE Card Line Section Trace Settings

OptionsDescriptionParameter

• Client Ports (1-8)(Display only) Displays the port number.Port

• Off/None

• Manual

Sets the received trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is not
disabled)

If a TIM on section overhead alarm arises because of a J0 overhead
string mismatch, no alarm indication signal is sent to downstream
nodes if this box is checked.

Disable
AIS/RDI on
TIM-S

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size

String of trace string sizeDisplays the current transmit string or sets a new transmit string. Click
the button on the right to change the display. Its title changes, based
on the current display mode. Click Hex to change the display to
hexadecimal (button changes to ASCII); click ASCII to change the
display to ASCII (button changes to Hex).

For OCn and OTU traces, the junk squares appear in the
New Transmit String field when you click the default
button. Ignore the junk squares that appear in the New
Transmit String field.

Note

Transmit
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OptionsDescriptionParameter

String of trace string sizeDisplays the current expected string or sets a new expected string.
Click the button on the right to change the display. Its title changes,
based on the current display mode. Click Hex to change the display
to hexadecimal (button changes to ASCII); click ASCII to change
the display to ASCII (button changes to Hex).

For OCn and OTU traces, the junk squares appear in the
New Expected String field when you click the default
button. Ignore the junk squares that appear in the New
Expected String field.

Note

Expected

String of trace string size(Display only) Displays the current received string. Click Refresh to
manually refresh this display, or select the Auto-refresh every 5 sec
check box to keep this panel updated.

Received

Checked or unchecked (default)If checked, automatically refreshes the display every 5 seconds.Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G699 Enabling Auto-sensing for AR_MXP, AR_XP, or AR_XPE Cards
This task enables the auto sensing for AR_MXP, AR_XP, or AR_XPE cards.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to enable auto sensing.

Step 2 Click the Provisioning > Line > Auto Ports tabs. Tabs and parameter selections vary according to PPM
provisioning.

Step 3 Modify any of the settings in the Auto Ports tab as described in table.
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Table 262: AR_MXP, AR_XP, or AR_XPE Auto Sensing Settings

OptionsDescriptionParameter

Client Ports (1-8)(Display only) Displays the port number.Port

Checked or UncheckedIf checked, enables auto sensing.Auto Sensing

—Displays the auto-sensed signal type.Actual Port
Type

Step 4 Return to your originating procedure (NTP).

DLP-G700 Changing the AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Line
Thresholds

This task changes the SONET/SDH line threshold settings of AR_MXP,
AR_XP, or AR_XPE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the SONET/SDH line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) tabs.
Step 3 Modify any of the settings as shown in table.

You must modify Near End and Far End independently; 15 Min and 1 Day independently; and
Line and Section independently. To do so, choose the appropriate radio button and clickRefresh.

Note

Table 263: AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Line Threshold Settings

Options - ONS 15454 SDHOptions - ONS 15454DescriptionParameter

• Client Ports (1-8)• Client Ports (1-8)(Display only) Displays
the port number.

Port
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Options - ONS 15454 SDHOptions - ONS 15454DescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

—Path Errored Block
indicates that one or
more bits are in error
within a block.

EB

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Coding violationsCV

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Errored secondsES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Severely errored
seconds

SES
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Options - ONS 15454 SDHOptions - ONS 15454DescriptionParameter

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

—(Near End Section or
Regeneration Section
only) Severely errored
framing seconds

SEFS

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

—Background block
errors

BBE

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only) Failure
count

FC

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only)
Unavailable seconds

UAS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G701 Changing the AR_MXP, AR_XP, or AR_XPE Card Line RMON
Thresholds

This task changes the line threshold settings for AR_MXP, AR_XP, or AR_XPE
cards carrying Ethernet, FC/FICON, or ISC/ISC3 payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the line RMON threshold settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
Step 3 Click Create.
Step 4 From the Port drop-down list, choose the applicable port, either the payload port, for example “1-1 (ONE_GE)”,

or the equivalent ITU-T G.7041 GFP (Generic Frame Procedure) port.
Step 5 From the Variable drop-down list, choose an Ethernet, FC, FICON, or ISC variable. To change the values of

the variables, see the following tables.

Table 264: AR_MXP, AR_XP, or AR_XPE Card Ethernet Variables

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets

Total number of received packets.rxTotalPkts

Number of packets delivered by this sublayer to a higher
sublayer that are not addressed to a multicast or broadcast
address.

ifInUcastPkts

Number of packets delivered by this sublayer to a higher
sublayer that are addressed to a multicast address. For a MAC
layer protocol, this includes both group and functional
addresses.

ifInMulticastPkts

Number of packets delivered by this sublayer to a higher
sublayer that are addressed to a broadcast address.

ifInBroadcastPkts

Total number of received errors.ifInErrors
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DescriptionVariable

Total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of transmitted packets.txTotalPkts

Total count of good frames transmitted to a unicast group
destination address.

IfOutUcastPkts

Total number of packets that higher-level protocols requested
to be transmitted, which were addressed to a multicast address
at this sublayer. These include packets that were discarded or
not sent. For a MAC layer protocol, this includes both group
and functional addresses.

ifOutMulticastPkts

Total number of packets that higher-level protocols requested
to be transmitted, which were addressed to a broadcast address
at this sublayer. These include packets that were discarded or
not sent.

ifOutBroadcastPkts

Number of frames received on a particular interface that are
an integral number of octets in length but do not pass the FCS
check.

dot3StatsFCSErrors

Total number of frames received on a particular interface that
are not an integral number of octets in length and do not pass
the FCS check. This counter is only valid for FE modes of
operation.

dot3StatsAlignmentErrors

Number of frames received on a particular interface that exceed
the maximum permitted frame size.

dot3StatsFrameTooLong

Number of frames received on an associated RX_ER assertion
during a data reception error event (MII) or data reception error
event, or carrier extension error (GMII) from the PCS.

dot3StatsSymbolErrors
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DescriptionVariable

Number of Layer 1 errors as defined within the following
conditions:

• During Packet Reception—Layer 1 errors are only counted
one time per packet. The Layer 1 error is indicated as a
direct result of a line side protocol violation in which
RX_DV is asserted. This is an uncommon event from
which may be the reason why the device loses
synchronization.

• During Interpacket Reception—The Layer 1 error is
indicated as a direct result of a line side protocol violation
in which RX_DV is de-asserted. This is an uncommon
event. The Layer 1 error is also asserted on detection of
a False Carrier indication and is asserted on detection of
Erred byte (interpacket) signal encoding.When the Layer
1 error is asserted during inter-packet reception, it is only
statistically asserted in the vector.

dot3StatsLayer1Errors

Number of received line code violations at the PCS layer.dot3StatsLCVErrors

Total number of packets received that were less than 64 octets
long (excluding framing bits, but including FCS octets) and
were otherwise well formed.

etherStatsUndersizePkts

Total number of packets received that were less than 64 octets
in length (excluding framing bits but including FCS octets)
and had either a bad FCS with an integral number of octets
(FCS Error) or a bad FCS with a non-integral number of octets
(Alignment Error). Note that it is entirely normal for
etherStatsFragments to increment. This is because it counts
both runts (which are normal occurrences due to collisions)
and noise hits.

etherStatsFragments

Total number of packets (including bad packets) received that
were 64 octets in length (excluding framing bits but including
FCS octets).

etherStatsPkts64Octets

Total number of packets (including bad packets) received that
were between 65 and 127 octets in length inclusive (excluding
framing bits but including FCS octets).

etherStatsPkts65to127Octets

Total number of packets (including bad packets) received that
were between 128 and 255 octets in length inclusive (excluding
framing bits but including FCS octets).

etherStatsPkts128to255Octets

Total number of packets (including bad packets) received that
were between 256 and 511 octets in length inclusive (excluding
framing bits but including FCS octets).

etherStatsPkts256to511Octets
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DescriptionVariable

Total number of packets (including bad packets) received that
were between 512 and 1023 octets in length inclusive
(excluding framing bits but including FCS octets).

etherStatsPkts512to1023Octets

Total number of packets (including bad packets) received that
were between 1024 and 1518 octets in length inclusive
(excluding framing bits but including FCS octets).

etherStatsPkts1024to1518Octets

Total number of packets (including bad packets) received that
were between 1519 and the maximum frame size as
programmed within the RMAC Max Frame Length
Configuration Register in length inclusive (excluding framing
bits but including FCS octets).

etherStatsPkts1519toMaxSizeOctets

Total number of good packets received that were directed to
the broadcast address. Note that this does not include multicast
packets.

etherStatsBroadcastPkts

Total number of good packets received that were directed to a
multicast address. Note that this number does not include
packets directed to the broadcast address.

etherStatsMulticastPkts

Total number of packets received that were longer than 1518
octets (excluding framing bits, but including FCS octets) and
were otherwise well-formed.

etherStatsOversizePkts

Total number of packets received that were longer than 1518
octets (excluding framing bits, but including FCS octets) and
were otherwise well formed.

etherStatsOversizePkts

Total number of packets received that were longer than 1518
octets (excluding framing bits, but including FCS octets), and
had either a bad FCS with an integral number of octets (FCS
Error) or a bad FCS with a non-integral number of octets
(Alignment Error).

etherStatsJabbers

Total number of octets of data (including those in bad packets)
received on the network (excluding framing bits, but including
FCS octets).

etherStatsOctets

Total number of packets (including bad packets) received that
were 1591 octets in length (excluding framing bits, but
including FCS octets).

etherStatsPkts1519tomaxOctets

Number of transmitted frames containing less than the
minimumpermitted frame size as programmedwith the transmit
MAC Min Frame Length Configuration Register.

mediaIndStatsTXShortPkts
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Table 265: AR_MXP, AR_XP, or AR_XPE FC/FICON Variables

DescriptionVariable

Total number of received packets.rxTotalPkts

Total number of transmitted packets.txTotalPkts

Number of received data frames with payload CRC errors when
HDLC framing is used.

mediaIndStatsRxFramesBadCRC

Number of transmitted data frames with payload CRC errors
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC

Number of L1 line code violations received for lower rate FC,
which equate to invalid 8b10b ordered sets.

mediaIndStatsRxLcvErrors

Number of L1 line code violations transmitted for lower rate
FC, which equate to invalid 8b10b ordered sets.

mediaIndStatsTxLcvErrors

Number of 8B/10B words received.rx8b10bWords

Number of 8B/10B words transmitted.tx8b10bWords

Table 266: AR_MXP, AR_XP, and AR_XPE ISC Variables

DescriptionVariable

Number of L1 line code violations received for constant bit
rate protocols, which equate to invalid 8b10b ordered sets.

mediaIndStatsRxLcvErrors

Number of L1 line code violations transmitted for constant bit
rate protocols, which equate to invalid 8b10b ordered sets.

mediaIndStatsTxLcvErrors

Table 267: AR_MXP, AR_XP, and AR_XPE GFP RMON Variables

DescriptionVariable

Total number of CRC errors with the receive transparent GFP
frame.

gfpStatsRxCRCErrors

Total number of superblock CRC errors with the receive
transparent GFP frame. A transparent GFP frame has multiple
superblocks which each contain fiber channel data.

gfpStatsRxSblkCRCErrors

Number of Rx client management frames with Client Signal
Fail indication.

gfpStatsCSFRaised

Number of Core HEC CRC Multiple Bit Errors.

This count is only for cHEC multiple bit error
when in frame. It is a count of when the state
machine goes out of frame.

Note

gfpStatsLFDRaised
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DescriptionVariable

Number of received GFP frames with single bit errors in the
core header (these errors are uncorrectable).

gfpStatscHecRxMBitErrors

Number of received GFP frames with single bit errors in the
tHec (these errors are uncorrectable).

gfpStatstHecRxMBitErrors

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, the
falling threshold, or both the rising and falling thresholds.

The available options are Rising Threshold, Falling Threshold, and Both Rising and Falling Threshold.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute.

Relative restricts the threshold to use the number of occurrences in the user-set sample period. Absolute sets
the threshold to use the total number of occurrences, regardless of time period.

Step 8 Enter the appropriate number of seconds in the Sample Period field.
Step 9 Enter the appropriate number of occurrences in the Rising Threshold field.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.

To view all RMON thresholds, click Show All RMON thresholds.Note

Step 12 Return to your originating procedure (NTP).

DLP-G702 Provisioning the AR_MXP, AR_XP, or AR_XPE Card with Trunk Port
Alarm and TCA Thresholds

This task provisions the AR_MXP, AR_XP, or AR_XPE card with trunk port
alarm and TCA thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to provision the trunk port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

Step 3 If TCA is not checked, check the TCA check box and then click Refresh. If it is checked, continue with step
4.

Step 4 Verify if the trunk port (Port 9) TCA thresholds are set. Provision new thresholds as needed by double-clicking
the threshold value you want to change, deleting it, entering a new value, and pressing Enter.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Do not modify the Laser Bias parameters.Note

Step 6 Verify if the trunk port (Port 9) Alarm thresholds are set. Provision new thresholds as needed by double-clicking
the threshold value you want to change, deleting it, entering a new value, and pressing Enter.

Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).

DLP-G703 Provisioning the AR_MXP, AR_XP, or AR_XPE Card Client Port Alarm
and TCA Thresholds

This task provisions the client port alarm and TCA thresholds for the AR_MXP,
AR_XP, and AR_XPE cards.

Purpose

NoneTools/Equipment

DLP-G278 Provisioning the Optical Line Rate

DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the client port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Referring to the following table, verify the TCA thresholds for client ports (ports 1 through 8) for RX Power

High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end.
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

Do not modify the Laser Bias parameters.Note

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

The hardware device that plugs into a AR_MXP, AR_XP, or AR_XPE card faceplate to provide
a fiber interface to the card is called a Small Form-factor Pluggable (SFP or XFP). In CTC, SFPs
and XFPs are called pluggable port modules (PPMs). SFPs/XFPs are hot-swappable I/O devices
that plug into a port to link the port with the fiber-optic network. Multirate PPMs have
provisionable port rates and payloads. For more information about SFPs and XFPs, see SFP,
SFP+, QSFP+, XFP, CXP, CFP, CFP2 and CPAK Modules, on page 307.

Note

Table 268: AR_MXP, AR_XP, and AR_XPE Card Client Interfaces TCA Thresholds

TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module
(XFP)

PPM Port Rate

–163–170ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FC1G

–163–150ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FC2G

–163–170ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FICON1G

–163–170ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FICON2G

–154–120ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FC4G

–154–120ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FICON4G
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TCA TX
Power Low

TCA TX
Power High

TCA RX
Power Low

TCA RX
Power High

Pluggable Port Module
(XFP)

PPM Port Rate

–154–120ONS-XC-8G-MM
ONS-XC-8G-SM

FC8G

–154–120ONS-XC-8G-MM
ONS-XC-8G-SM

FICON8G

ONS-SI-GE-SX
ONS-SI-GE-LX
ONS-SI-GE-ZX
ONS-SE-ZE-EL

1GE

ONS-SE-GE-BXU
ONS-SE-GE-BXD

FE

ONS-SE-200-MMESCON

ONS-SC-155-EL
ONS-SI-155-SR-MM
ONS-SI-155-I1
ONS-SI-155-L1
ONS-SI-155-L2

OC3/STM1

ONS-SI-622-SR-MMOC12

ONS-SI-622-I1
ONS-SI-622-L1
ONS-SI-622-L2

OC12/STM4

ONS-SI-2G-S1
ONS-SI-2G-L1
ONS-SI-2G-L2

OC48/STM16

ONS-SI-2G-S1
ONS-SE-Z1
ONS-SI-2G-L2
ONS-SC-2G-xxxx

OTU1

ONS-XC-10G-96COTU2

ONS-SC-HD3GV-RX=3G-SDI,
HD-SDI,
SD-SDI

Step 4 Click Apply.
Step 5 Repeat step 3 and step 4 to provision each additional client port.
Step 6 Under Types, click the Alarm radio button and click Refresh.
Step 7 Referring to the following table, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power

High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.
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Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and hitting Enter.

Table 269: AR_MXP, AR_XP, and AR_XPE Card Client Interface Alarm Thresholds

Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module
(XFP)

PPM Port
Rate

–163–170ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FC1G

–163–150ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FC2G

–163–170ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FICON1G

–163–170ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FICON2G

–154–120ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FC4G

–154–120ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

FICON4G

–154–120ONS-XC-8G-MM
ONS-XC-8G-SM

FC8G

–154–120ONS-XC-8G-MM
ONS-XC-8G-SM

FICON8G

ONS-SI-GE-SX
ONS-SI-GE-LX
ONS-SI-GE-ZX
ONS-SE-ZE-EL

1GE

ONS-SE-GE-BXU
ONS-SE-GE-BXD

FE

ONS-SE-200-MMESCON

ONS-SC-155-EL
ONS-SI-155-SR-MM
ONS-SI-155-I1
ONS-SI-155-L1
ONS-SI-155-L2

OC3/STM1
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Alarm TX
Power High

Alarm TX
Power Low

Alarm RX
Power High

Alarm RX
Power Low

Pluggable Port Module
(XFP)

PPM Port
Rate

ONS-SI-622-SR-MMOC12

ONS-SI-622-I1
ONS-SI-622-L1
ONS-SI-622-L2

OC12/STM4

ONS-SI-2G-S1
ONS-SI-2G-L1
ONS-SI-2G-L2

OC48/STM16

ONS-SI-2G-S1
ONS-SE-Z1
ONS-SI-2G-L2
ONS-SC-2G-xxxx

OTU1

ONS-SC-HD3GV-RX=3G-SDI,
HD-SDI,
SD-SDI

Step 8 Click Apply.
Step 9 Repeat step 7 and step 8 to provision each additional client port.
Step 10 Return to your originating procedure (NTP).

DLP-G704 Changing the AR_MXP, AR_XP, or AR_XPE Card OTN Settings
This task changes the OTN settings for the AR_MXP, AR_XP, or AR_XPE
cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, or
AR_XPE card where you want to change the OTN settings.

Step 2 Click the Provisioning >OTN tabs, then choose one of the following subtabs: OTN Lines, G.709 Thresholds,
FEC Thresholds, Trail Trace Identifier, or Proactive Protection Regen.

Step 3 Modify any of the settings described in the following tables.
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You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To
do so, choose the appropriate radio button and click Refresh.

The following table describes the values on the Provisioning > OTN > OTN Lines tab.

Note

Table 270: AR_MXP, AR_XP, and AR_XPE Card OTN Line Settings

OptionsDescriptionParameter

All client and trunk ports(Display only) Displays the port number.Port

Enabled by defaultSets the OTN lines according to
ITU-T G.709.

G.709 OTN

• Disable

• Standard

• Enhanced-I.4

• Enhanced-I.7

Sets the OTN lines to forward error
correction (FEC).

FEC

• 1E-5(Display only) Displays the signal fail bit
error rate.

SF BER

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Sets the signal degrade bit error rate.SD BER

• Asynch mapping

• Synch mapping

Sets how the ODUk (client payload) is
mapped to the optical channel (OTUk).

Asynch/Synch
Mapping

• ODU1e

• ODU2e

• CBR10G

• ODU1Mux

• ODU1

Sets the client payload mapping to the trunkOTU Mapping

Checked or uncheckedSets the ProvidesSync card parameter. If
checked, the card is provisioned as a NE
timing reference.

ProvidesSync
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OptionsDescriptionParameter

Checked or uncheckedSets the EnableSync card parameter. Enables
synchronization status messages (S1 byte),
which allow the node to choose the best
timing source.

SyncMsgIn

STUOverrides the synchronization statusmessage
(SSM) and the synchronization traceability
unknown (STU) value. If the node does not
receive an SSM signal, it defaults to STU.

Admin SSM In

Checked or uncheckedIf checked, sends a DUS message on the S1
byte.

Send DoNotUse

• Transparent Standard Use

• Cisco Extended Use

Sets the ODU overhead byte configuration.ODU
Transparency

• Enable

• Disable

Enables or disables the proactive protection
regen mode.

Proactive
Protection
Regen

The following table describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 271: AR_MXP, AR_XP, and AR_XPE ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

9 (Trunk)(Display only) Displays the port
number.

Port 19

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Errored secondsES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Severely errored secondsSES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Unavailable secondsUAS

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Background block errorsBBE

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Failure counterFC
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19 Latency for a 1G-FC payload without ITU-T G.709 is 4 microseconds, and with ITU-T G.709 is
40 microseconds. Latency for a 2G-FC payload without ITU-TG.709 is 2 microseconds, and with
ITU-T G.709 is 20 microseconds. Consider these values when planning a FC network that is
sensitive to latency.

The following table describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 272: AR_MXP, AR_XP, and AR_XPE Card FEC Threshold Settings

OptionsDescriptionParameter

2(Display only) Displays the port number.Port

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for bit errors corrected.Bit Errors
Corrected

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for uncorrectable words.Uncorrectable
Words

The following table describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 273: AR_MXP, AR_XP, and AR_XPE Card Trail Trace Identifier Settings

OptionsDescriptionParameter

2(Display only) Displays the port number.Port

• Section

• Path

Sets the level.Level

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

String of trace string sizeDisplays the current transmit string or sets
a new transmit string. Click the button on
the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Transmit

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
disabled)

If a Trace Identifier Mismatch on Section
overhead alarm arises because of a J0
overhead string mismatch, no Forward
Defect Indication (FDI) signal is sent to the
downstream nodes if this box is checked.

Disable FDI on
TTIM
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OptionsDescriptionParameter

String of trace string sizeDisplays the current expected string or sets
a new expected string. Click the button on
the right to change the display. Its title
changes, based on the current display mode.
Click Hex to change the display to
hexadecimal (button changes to ASCII);
click ASCII to change the display to ASCII
(button changes to Hex).

Expected

String of trace string size(Display only) Displays the current received
string. You can click Refresh to manually
refresh this display, or check the
Auto-refresh every 5 sec check box to keep
this panel updated.

Received

Checked

Unchecked (default)

If checked, automatically refreshes the
display every 5 seconds.

Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G734 Viewing the Mapping of ODU Object with Client Port
This procedure allows you to view the mapping of ODU object with the
corresponding client port for the AR_XPE card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_XPE card to view the
ODU object mapping with the corresponding client port. The card view appears.

Step 2 Click the Provisioning > Card ODU Interfaces tabs. Displays the parameters as described in the table.
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Table 274: ODU Object and Client Port Mapping

DescriptionParameter

Displays the ODUk(k=0) AID that is used to raise the ODU0 level alarms.ODU Object

Displays the physical trunk port details that map to the virtual ODUk(k=0) port or object.Trunk Port Number

Displays the ODU1 frame number within the ODU-2 frame, which has the correspondingODUk(k=0)
frame.

ODU1

Displays the ODU0 frame number within a ODU1 frame.ODU0

Displays the physical client port number that maps to the virtual ODUk(k=0) port or object.Client Port Number

Step 3 Return to your originating procedure (NTP).

NTP-G235 Provisioning an Operating Mode
This procedure enables you to provision an operatingmode on the 100G-LC-C,
100G-CK-C, 100GS-CK-LC, , 200G-CK-LC,100G-ME-C, 100ME-CKC,
10x10G-LC, CFP-LC, or MR-MXP card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
provision an operating mode. The card view appears.

Step 2 Click the Provisioning > Card tabs.
Step 3 In the Card tab, click Create. The Operating Mode Configuration Creation window appears.
Step 4 From the Card Configuration drop-down list, choose the configuration. The card configuration options vary

depending on the card. If the TXP-10G, TXPP-10G, RGN-10G, or LOW LATENCY mode is selected on the
10x10G-LC card, go to Step 7. If the FANOUT-10x10G mode is selected in the 10x10G-LC card, go to Step
8.

Formore information about the card configurations, seeKey Features of 100G-LC-C, 100G-ME-C, 100G-CK-C,
100ME-CKC, 10x10G-LC, 100GS-CK-LC, 200G-CK-LC, CFP-LC, and MR-MXP Cards, on page 268.
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Step 5 Choose the slot number from the Peer Card drop-down list. This field is enabled only if a peer card is required
for the configuration.

Step 6 Choose the slot number from the Skip Peer card drop-down list. This field is enabled only for MXP_200G
and MXP_10x10G_100G operating modes.

Step 7 Select the port pair in the Card Configuration Dialog area.

The 10x10G-LC card supports a maximum of five TXP-10G modes, two TXPP-10G modes, five RGN-10G
modes, five LOW LATENCY modes, or a combination of five TXP-10G, RGN-10G, and LOW LATENCY
modes. For the TXPP-10G mode configuration, client ports can be port 3, port 7, or both. Port 4 and port 6
are selected as trunk ports when port 3 is selected as the client port. Port 8 and port 10 are selected as trunk
ports when port 7 is selected as the client port. For MXP_200G, MXP_10x10G_100G, and MXP_CK_100G
operating modes, the required ports are selected by default.

Step 8 Click Finish. The selected operating mode is provisioned on the card.
Step 9 Complete the DLP-G726 Preprovisioning a Multirate PPM task.
Step 10 Complete the DLP-G278 Provisioning the Optical Line Rate, on page 317 task.

Stop. You have completed this procedure.

NTP-G361 Provisioning an Operating Mode on the 400G-XP-LC
Card

This procedure enables you to provision an operatingmode on the 400G-XP-LC
card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Provision the PPM on the trunk ports ( Port 11 and 12) of the 400G-XP-LC card before you provision the
operating mode.

From Release 10.9, MXP 2x150G Operating modes are supported on the 400G-XP-LC card.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 400G-XP-LC card where
you want to provision an operating mode. The card view appears.
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Step 2 Click the Provisioning > Card tabs.
Step 3 In the Card tab, click Create. The Operating Mode Configuration Creation window appears.
Step 4 From the Card Configuration drop-down list, choose the operating mode.

For the OTNXC and the REGEN card modes, both trunk ports are configured with the same rate (100G or
200G). The trunk port configuration that is created for CFP2-11 is copied to CFP2-12. For the MXP 2x150G
card mode, both the trunk ports are configured at 150G.

Step 5 To configure the trunk port (CFP2 - 11, CFP2 - 12, or both trunk ports), perform the following steps:
a) Choose the operating mode from the Trunk Operating Mode drop-down list. If the mode selected is

M_100G, the Slice 1 or Slice 3 fields are disabled. If the mode selected is MXP_2x150G, the Slice 2 field
is disabled.

b) Choose the slice mode from the Slice drop-down list. The 10x10G-LC card is supported on Slice 2 only.
The configuration can be done only from the 400G-XP-LC card.

For more information about the trunk, slice, and port configuration, see Slice Definition and Line Card
Configuration for Card.

Slice configuration is not applicable for the REGEN mode.

Step 6 Click Finish.

The operating mode is provisioned on the card.

Step 7 Complete the DLP-G726 Preprovisioning a Multirate PPM task.
Step 8 Complete the DLP-G278 Provisioning the Optical Line Rate, on page 317 task.

To edit an operating mode:

Table 275: Rules for Editing an Operating Mode on the 400G-XP-LC Card

Restrictions/InformationClient PortTrunk PortEditing an Op Mode

Blocked if client payloads
are provisioned on the
slice being edited.

Allowed with trunk in ISModifying a slice mode
within a trunk

Related trunk PPM must
be provisioned.

--Adding a trunk

Blocked, if the trunk to be
deleted is the only
provisioned trunk on the
card.

Blocked if client payloads
are provisioned for the
trunk being deleted

Blocked if trunk is in IS
or if trunk is associated
with internal patch cords
(IPCs) or provisional
patch cords (PPCs).

Deleting a trunk

The existing OTU4 or
OTU4C2 trunk port is
deleted and recreated.

Blocked if client payloads
are provisioned for the
trunk being modified

Blocked if trunk is in IS
or if trunk is associated
IPCs or PPCs.

Modifying the trunk
operating mode

Step 9 In the Card tab, choose the configured operating mode and click Edit. The Operating Mode Configuration
window appears.

The OTNXC and the REGEN card mode cannot be edited after it is configured. To modify the card mode
configuration, you need to delete the existing configuration and create a new one.
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Step 10 Choose the trunk port to be edited from the Edit Trunk Configuration drop-down list.

Only one trunk port configuration can be edited at a time. The table above details the rules for
editing an operating mode.

Note

The Trunk Operating Mode cannot be edited for REGEN mode.

Step 11 Modify the Trunk Operating Mode and the Slice modes as needed.
Step 12 Click Finish.

The operating mode is updated with the new configuration on the card.

Step 13 Complete the DLP-G726 Preprovisioning a Multirate PPM task.
Step 14 Complete the DLP-G278 Provisioning the Optical Line Rate, on page 317 task.
Step 15 To delete an operating mode, in the Card tab, choose the configured operating mode and click Delete.

The operatingmode is deleted. A card operatingmode can be deleted only if client payloads are not provisioned
and the trunk ports in the out-of-service (OOS) state with no IPCs or PPCs associated.

Stop. You have completed this procedure.

NTP-G362 Manual FPGA Upgrade on the 400G-XP-LC Card
This procedure manually upgrades the FPGA/ firmware images in the
400G-XP-LC card.

Purpose

NoneTools/Equipment

NonePrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

The manual FPGA / firmware upgrade is allowed only when there is a version mismatch. ADifferent FPGA/
firmware image available condition is raised to notify the user of the availability of a new firmware image.

It is recommnded to upgrade the FPGA / firmware on the cards, at both ends of the circuit.

Note

Firmware upgrade is allowed only when the ports are in OOS (out-of-service) or Maintenance service state.Note

This procedure is traffic-affecting.Caution
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 400G-XP-LC card where
you want to provision an operating mode. The card view appears.

Step 2 Click the Provisioning > Card tabs.
Step 3 Click the FPGA/FIRMWARE Upgrade button.

A warning message is displayed.

Step 4 Click Yes.

The card undergoes a cold reset and the FPGA now contains the updated images. To view the FPGA and
firmware versions, click the Card view > Maintenance > Info tabs.

Stop. You have completed this procedure.

NTP-G366 Viewing the ODU Utilization for ODU Circuits
This procedure allows you to view the ODU utilization per 400G-XP-LC card,
OTN span, and ILK consumption for each ODU circuit.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 400G-XP-LC card. The
card view appears.

Step 2 Click the Provisioning > Card tabs.
Step 3 Click ODU Utilization.

An ODU utilization window for the 400G-XP-LC card is displayed where you can get information about the
availability of each port for ODU circuit creation.

All ODU ports are displayed according to the slice configuration that was configured. Each row represents
100G or ODU4 bandwidth. The client ports are listed first followed by the trunk ports. The ports that are
already used by the ODU circuit are displayed in green, the ports that are available for circuit creation are
displayed in orange and the ports that are not applicable nor configured are displayed in gray.

If a slice is configured with the OPM_100G option, the ODU usage is reserved for ODU4 circuits. If a slice
is configured with the OPM_10x10G option, the ODU usage is reserved for ODU2 circuits.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
656

Provisioning Transponder and Muxponder Cards
NTP-G366 Viewing the ODU Utilization for ODU Circuits

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Step 4 Click the Maintenance > ODU > ODU tabs. The pane displays the ILK consumption for each ODU circuit
as described in the table.

Table 276: ILK Consumption

DescriptionParameter

Displays the circuit name.Circuit

Displays the source port number.Source Port

Displays the source ODU number in useSource ODU #

Displays the destination port number.Destination Port

Displays the destination ODU number in use.Destination ODU #

Displays the ILK usage for the circuit. All protected circuits depicted by a tree hierarchy consume
one ILK bandwidth.

ILK Usage

Displays the bandwidth for the circuit.Bandwidth

The ILK, client, and trunk ODU2e usage per 400G-XP-LC card is also displayed in terms of a
percentage below the table.

Note

Step 5 To view the number of available link ODUs on the source and destination nodes, right-click the OTN span
in the network map in the network view and select the Span Utilization option.

In the case of OTU4 trunk, the first 10 ODUs are not available and are depicted with "-". If the ODU is in
use, it is depicted with an "x" and if the ODU is available, it is depicted with an tick mark. For the link ODU
to be available, both the source and destination ODUmust be available. The ODU utilization is also displayed
as a percentage.

Stop. You have completed this procedure.

NTP-G367 Provisioning Encryption on 400G-XP-LC Card
This procedure allows you to provision encryption on the 400G-XP-LC card.Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• NTP-G361 Provisioning an Operating Mode on the 400G-XP-LC Card,
on page 653

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Security user or security super userSecurity Level
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The encryption feature (Enable/Disable) requires a new hardware FPGA image. The 400G-XP LC card must
be running with FPGA version 1.02 or higher. The FPGA version information can be checked using Card
view > Maintenance > Info > FPGA_HW_VERSION in CTC. A Condition message warns the user about
availability of a new image. To upgrade the FPGA image, see NTP-G362 Manual FPGA Upgrade on the
400G-XP-LC Card, on page 655.

The encrypted traffic on 400G-XP-LC card goes down if the Key Exchange Fail (KEY-EX-FAIL) alarm
remains for more than 40 hours.

Procedure

Perform any of the following tasks as needed:

• DLP-G817 Configuring GCC2 Settings on 400G-XP-LC Card, on page 658

• DLP-G818 Enabling or Disabling Card Authentication and Payload Encryption on 400G-XP-LC Card,
on page 659

• DLP-G819 Resetting the Primary Key on 400G-XP-LC Card, on page 660

• DLP-G820 Changing the Primary Key Reset Interval on 400G-XP-LC Card, on page 661

Stop. You have completed this procedure.

DLP-G817 Configuring GCC2 Settings on 400G-XP-LC Card
This task configures a GCC2 channel on OTN enabled trunk ports to establish
a connection between two 400G-XP-LC cards by configuring the IP address
and ports of the source and destination cards.

Purpose

NoneTools/Equipment

Disable Card Authentication on 400G-XP-LC CardPrerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security user or security super userSecurity Level

Each card on a node must have unique GCC2 source IP address. This IP address must not match with the
source or destination IP address of other cards on the same node.

Note
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Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the 400G-XP-LC card for
which you want to configure the GCC settings.

Step 2 Go to Provisioning > Encryption > GCC2 Settings.
Step 3 In the Card IP Address field, specify the IP address of the source 400G-XP-LC card.
Step 4 Click on the Destination Card IP entry. Specify the IP address of the destination card.

The range of source and destination IP address is 172.16.0.1 to 172.16.0.255. The destination IP address must
be same for IPort1 and IPort2. The destination IP address must be same for IPort3 and IPort4.

There can be only two destination card IP addresses and destination ports for the 400G-XP-LC card.

Step 5 Click on the Destination Port entry. Specify the port number of the destination card.

The values of Destination Port must be 1 or 3 for IPort1, 2 or 4 for IPort2, 3 or 1 for IPort3, 4 or 2 for IPort4
depending on the trunk port of the peer card this card is connected.

Step 6 Click Apply.
Step 7 Return to your originating procedure (NTP).

DLP-G818 Enabling or Disabling Card Authentication and Payload Encryption
on 400G-XP-LC Card

This task initiates the authentication of a destination 400G-XP-LC card with a
source 400G-XP-LC card. This ensures that the source card communicates only
with the destination card. This task also enables payload encryption on
400G-XP-LC card.

Purpose

NoneTools/Equipment

DLP-G817 Configuring GCC2 Settings on 400G-XP-LC Card, on page 658Prerequisite Procedures

RequiredRequired/As Needed

Onsite or RemoteOnsite/Remote

Security user or security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the 400G-XP-LC card for
which you need to enable or disable card authentication and payload encyption.

Step 2 Go to Provisioning > Encryption > Security.
Step 3 From the Port list, choose the port on which card authentication is to be enabled or disabled.
Step 4 Check the Card Authentication checkbox to enable card authentication.
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Uncheck the Card Authentication checkbox to disable card authentication.

When the Card Authentication check box is checked, the Payload Encryption check box is
automatically checked and vice versa.

Note

The primary key for encryption is exchanged between the source and destination 400G-XP-LC cards and
OTN frames are encrypted.

Step 5 Click Apply.
Step 6 Repeat step 3 to step 5 for each port that carries the encrypted payload, as the card authentication takes place

independently on each port of the source 400G-XP-LC card.
Step 7 Return to your originating procedure (NTP).

DLP-G819 Resetting the Primary Key on 400G-XP-LC Card
This task allows to reset the primary key for each encrypted stream of the source
400G-XP-LC card.

For more information, see Key Management, on page 304.

Purpose

NoneTools/Equipment

• DLP-G818 Enabling or Disabling Card Authentication and Payload
Encryption on 400G-XP-LC Card, on page 659

Prerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security user or security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the 400G-XP-LC card for
which you want to reset the primary key.

Step 2 Go to Provisioning > Encryption > Key Management.
Step 3 Click the Reset Master Key button for a port to reset the primary key used for the payload encryption on that

port.

By resetting the primary key, a key exchange is enforced by overriding the existing primary key reset interval,
and a new interval is calculated from the time the key is reset.

Resetting the primary key does not affect traffic.

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G820 Changing the Primary Key Reset Interval on 400G-XP-LC Card
This task allows to change the primary key reset interval between two
consecutive resets of the primary key that is used for payload encryption.

Purpose

NoneTools/Equipment

• DLP-G818 Enabling or Disabling Card Authentication and Payload
Encryption on 400G-XP-LC Card, on page 659

Prerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security user or security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the 400G-XP-LC card for
which you want to change the primary key reset interval.

Step 2 Go to Provisioning > Encryption > Key Management.
Step 3 Click on the Master Key Change Interval entry for each port. Two spin boxes appear in place of the entry.

The box on the left registers the time in hours; the box on the right, the time in minutes.

The primary key interval can be set in multiples of 15 minutes between 15 minutes to 24 hours. The default
interval value is 15 minutes.

Step 4 Set the desired values in the boxes.

When the time interval elapses, a new primary key is exchanged between the source and destination
400G-XP-LC cards.

Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).

Limitations of Encryption on 400G-XP-LC Card
• AES frame size and location for Encryption overhead cannot be changed.

• OTN overhead settings such as AES security setting, ESP header and trailer locations, and Ingress/Egress
PRBS generation are not supported.

• Advanced settings such as Ingress/Egress BIP8 bypass is not supported.

• Payload authentication is not supported.

• Encryption PMs such as Sequence Mismatch parameter is not supported.

• When encryption is enabled, the operating mode cannot be disabled.
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• Each card on a node must have unique GCC2 source IP address. This IP address must not match with
the source or destination IP address of other cards on the same node.

• The client/trunk/Iport loopbacks are not supported if encryption is enabled on the corresponding Iport
and vice versa for MXP operating mode.

• The trunk mode or slice modes cannot be edited if encryption is enabled on the corresponding Iports.

NTP-G236 Modifying the 100G-LC-C, 100G-CK-C, 100G-ME-C,
100ME-CKC, 10x10G-LC, 100GS-CK-LC, , 200G-CK-LC, CFP-LC,
WSE, MR-MXP, or 400G-XP-LC Card Line Settings and PM
Parameter Thresholds

This procedure changes the line and PM parameter threshold settings of the
100G-LC-C, 100G-CK-C, 100G-ME-C, 100ME-CKC, 10x10G-LC, CFP-LC,
100GS-CK-LC, 200G-CK-LC, WSE, MR-MXP, or 400G-XP-LC cards.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task, to preserve the existing transmission
settings.

Step 2 Perform any of the following tasks as needed:

• DLP-G714 Changing the Card Line Settings

• DLP-G715 Changing the Card Ethernet Settings

• DLP-G716 Changing the 10x10G-LC and WSE Card SONET/SDH Settings

• DLP-G717 Changing the 10x10G-LC and WSE Card Section Trace Settings
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• DLP-G718 Changing the 10x10G-LC and WSE Card SONET/SDH Line Thresholds

• DLP-G719 Changing the Card Line RMON Thresholds

• DLP-G720 Provisioning the Card with Trunk Port Alarm and TCA Thresholds

• DLP-G721 Provisioning the Client Port Alarm and TCA Thresholds

• DLP-G722 Changing the Card OTN Settings

• DLP-G815 Changing the 400G-XP-LC Card ODU Settings, on page 697

• DLP-G770 Enabling PRBS Settings, on page 700

To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the
Alarm and TCA Monitoring and Management document.

Note

Stop. You have completed this procedure.

DLP-G714 Changing the Card Line Settings
This task changes the line settings of the 100G-LC-C, 100G-CK-C, 100G-ME-C,
100ME-CKC, 10x10G-LC, 100GS-CK-LC, 200G-CK-LC, CFP-LC,MR-MXP,
MR-MXP-LIC, WSE, or 400G-XP-LC cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs. Tabs and parameter selections vary according to pluggable port
modules (PPM) provisioning.

Step 3 Modify any of the line settings in the Ports tab as described in the following table.

Table 277: Card Line Settings

OptionsDescriptionParameter

1–12(Display only) Displays the port number.Port
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OptionsDescriptionParameter

User-defined. Name can be up to 80 alphanumeric or special
characters, or both. Blank by default.

See the"NTP-G104 Assign a Name to a Port" task in "Maintain
the Node" chapter.

Assigns a logical name for the specified port.Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS, DSBLD (ANSI) or Locked, disabled (ETSI)

• OOS, MT (ANSI) or Locked, maintenance (ETSI)

• IS, AINS (ANSI) or Unlocked, AutomaticInService (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states, see
the Administrative and Service States
document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU, AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA, DSBLD (ANSI) or Locked-enabled, disabled
(ETSI)

• OOS-MA, MT (ANSI) or Locked-enabled, maintenance
(ETSI)

• OOS-MA, LPBK&MT (ANSI) or Locked-enabled,loopback
& maintenance (ETSI)

(Display only) Identifies the autonomously
generated state that gives the overall condition
of the port. Service states appear in the format:
Primary State-Primary State Qualifier,
Secondary State. For more information about
service states, see the Administrative and
Service States document.

Service State

• Disabled (default)—ALS is off; the laser is not automatically
shut down when traffic outage or loss of signal (LOS) occurs.

• Auto Restart-ALS is on; the laser automatically shuts down
when traffic outage or LOS occurs. It automatically restarts
when the conditions that caused the outage are resolved.

• Manual Restart—ALS is on; the laser automatically shuts
down when traffic outage or LOS occurs. However, the laser
must be manually restarted when conditions that caused the
outage are resolved.

• Manual Restart for Test—Manually restarts the laser for
testing.

Sets the automatic laser shutdown (ALS)
function mode.

ALS Mode

• Duration of valid input signal, in hh.mm format, after which
the card state changes to in-service (IS) automatically.

• 0–48 hours, 15-minutes increments.

Sets the automatic in-service (AINS) soak
period. Double-click the time and use the up
and down arrows to change settings.

AINS Soak
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OptionsDescriptionParameter

• Autoprovision—The system automatically provisions the
reach from the pluggable port module (PPM) reach value on
the hardware.

The reach distances that appear in the drop-down list
depends on the card.

Note

On the 400G-XP-LC card, certain processes may fail
if unsupported PPMs are plugged into the card.

Note

Sets the optical reach distance of the client
port.

Reach

• First Tunable Wavelength

• Further wavelengths:

• 850–1610 nm

On 100G, 200G, and 400G LC cards, the wavelength
1528.77 nm is displayed twice.

Note

Displays the wavelength of the client port.Wavelength

• OFF

• ON

When an OTU2 payload is provisioned on the
10x10G-LC card in the TXP-10G or RGN-10G
operating mode, the overclock parameter is
automatically set to ON.

Note

Enables or disables overclock mode.OverClock

—Sets the threshold for minimum chromatic
dispersion.

Cd (Working
Range) Low

—Sets the threshold for maximum chromatic
dispersion.

In 200G-CK-LC card, the CD (Working
Range) High and CD (Working Range) Low
thresholds value in Provisioning > Line > Ports
tab in CTC do not change automatically after
installing the
100G_SD_FEC_OR_CD_RANGE license.
Hence, it is required to manually change the
threshold values in CTC. Otherwise, the
Chromatic Dispersion (CD) alarm is raised.

Cd (Working
Range) High

—If checked, the Tx optical power is turned off.
This can be done when the port is out of
service or in maintenance.

TX
SHUTDOWN
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OptionsDescriptionParameter

The range is from –10.0 to 0.25 dBm.

400G-XP-LC: The range for 100G is from –0.5 to –11.5 dBm;
The range for 200G is from –1.5 to –11.5 dBm.

Sets the Tx power to a specific value.TX Power

• AIS/Send Local Fault

AIS/Send Local Fault is not supported on all
the payloads. However, this option is present in
the drop-down list in CTC to allow a proper
software upgrade from the previous release.

Note

• Squelch/Laser-Off

When the 100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC, 100GS-CK-LC, ,
100GS-CK-LC, 200G-CK-LC cards are used
in the standalonemode or with the CFP-LC card
configured in the CFP-TXPmode, the value can
be set to Squelch/Laser-Off or AIS/Send Local
Fault on the trunk port of the 100G-LC-C,
100G-CK-C, 100G-ME-C, 100GS-CK-LC, ,
200G-CK-LC card. When the 100G-LC-C,
100G-CK-C, 100G-ME-C, 100GS-CK-LC,
100ME-CKC, and card is usedwith the CFP-LC
card configured CFP-MXPmode, the value can
be set to AIS on the trunk port of the
100G-LC-C, 100G-CK-C, 100G-ME-C,
100GS-CK-LC, 200G-CK-LC, and
100ME-CKC card.

Note

• LF/Local Fault—Supported for 10GE, 40GE, 16GFC, and
100GE payloads.

For 16GFC, this is the default mode; the user
can change this to squelch, if necessary.

Note

• Disable/Transparent—Supported for any data traffic such as
10GE, 8G FC, 10G FC, 40GE, 100GE.

Shuts down the far-end laser in response to
certain defects. (Squelch does not apply to ISC
COMPACT payloads.)

Fault Signalling
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OptionsDescriptionParameter

• CBR

CBR mapping mode supports Sync-E
transparency.

Note

• GFP

The mapping mode can be configured to GFP
for 10GE payloads. The GFP port is placed in
service when both the client and trunk ports of
the 10x10G-LC card are in service.

Note

When the mapping mode is set to CBR on the
10x10G-LC card, the overclock parameter is
set to On.

When the mapping mode is set to GFP on the
10x10G-LC card, the overclock parameter is
set to Off.

Note

Sets the mapping mode.MappingMode
(10x10G-LC
and WSE)

• TransparentSets the termination mode.Termination
Mode
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OptionsDescriptionParameter

• Disable (0 ms) - Default value

• 50 ms

• 100 ms

• 250 ms

• 500 ms

Squelch Hold
Off Timer
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OptionsDescriptionParameter

(Only for 100G-LC-C, 100G-CK-C,
100ME-CK-C, CFP-LC, 10x10G-LC,
100GS-CK-LC, 200G-CK-LC, andMR-MXP
cards) Sets the period in milliseconds that the
client interface waits for resolution of issues
on the trunk side. The client squelching starts
after this period.

The user can configure the squelch hold off
timer in CTC only under the following
conditions:

• The card must be configured in TXP or
MXP operating modes.

• The client payload must be 10GE or
100GE.

• The Squelch drop-down in CTC must be
set to Squelch.

Note • The squelch hold off timer
value can be changed
without changing the port
admin state.

• When the squelch holdoff
timer is set to a value other
than 0 ms, Y-Cable cannot
be provisioned.

• When the Squelch
drop-down is changed from
non-squelch to squelch, the
squelch holdoff timer is set
to 0 ms.

• When the node is upgraded
to R10.5.2, the squelch
hold-off timer is set to 0 ms.

• When the squelch timer
value is changed, the
changed value will be
applicable in the next
squelch interval.

• When squelch hold off
timer is active, the
OTU2_XP, TXP_MR_10E,
and 40E-MXP-C cards send
junk frames; the
100G-LC-C, 100G-CK-C,
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OptionsDescriptionParameter

100ME-CK-C, CFP-LC,
10x10G-LC, MR-MXP
cards send Local Fault (LF).
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Table 278: Reach Distances for 10x10G-LC, 100G-LC-C, 100G-CK-C, CFP-LC, MR-MXP, 100GS-CK-LC, 200G-CK-LC, 400G-XP-LC, and WSE
Cards

ReachPayloadCard

SR-MMOTU210x10G-LC

P1I1-2D1

P1S1-2D2b

P1L1-2D2

DWDM

SR-MMOC192

SR-1

IR-2

LR-2

DWDM

10GFC-SW10G FC

10GFC-LW

10GFC-EW

10GFC-ZW

DWDM

8GFC-SW8G FC

8GFC-LW

TEN_GE_SR10 GE

TEN_GE_LR

TEN_GE_ER

TEN_GE_ZR

DWDM

LX and SR-MMIB-5G

100GBASE-SR10 and 100GBASE-LR4100 GE100G-CK-C

4I1-9D1FOTU4

40GBASE-SR440 GE
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ReachPayloadCard

100GBASE-SR10100 GE100G-LC-C

100GBASE-SR10 and 100GBASE-LR4100 GE100GS-CK-LC

100GBASE-SR10 and 100GBASE-LR4100 GE200G-CK-LC

40GBASE-FR40 GECFP-LC

40GBASE-LR4

100GBASE-LR4100 GE

VSR2000-3R2OTU3

C4S1-2D1

4I1-9D1FOTU4

SR10 GEMR-MXP

TEN_GE_SR

MR-MXP

TEN_GE_ER

TEN_GE_ZR

DWDM

CX1

CWDM40km

100GBASE-SR10100 GE

100GBASE-LR4

MLR-QSFP+OTU2

TEN_GE_LR

TEN_GE_EP

QSFP-SR440GE

QSFP-LR4

MLR-QSFP+OC192/STM64

TEN_GE_LR

TEN_GE_EP
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ReachPayloadCard

Trunk ports400G-XP-LC

DWDMOTU4

OTU4C2

Client ports

100GBASE-LR4100 GE

100GBASE-SR4

4I1-9D1FOTU4

TEN_GE_LR10 GE

P1I1 2D1OTU2

16GFC-SW16GFC

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G715 Changing the Card Ethernet Settings
This task changes the Ethernet settings of the 100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC, 10x10G-LC, CFP-LC, 100GS-CK-LC,
200G-CK-LC, MR-MXP, WSE, or 400G-XP-LC cards.

The ethernet settings of the CFP-LC card can be changed on the
virtual port of the peer 100G-LC-C, 100G-CK-C, 100G-ME-C,
or 100ME-CKC card.

Note

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the Ethernet settings. The card view appears.
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Step 2 Click the Provisioning > Line > Ethernet tabs.
Step 3 Modify any of the Ethernet settings in the Ethernet tab. The parameters that appear depend on the card mode.

Table 279: Card Ethernet Settings

OptionsDescriptionParameter

—(Display only) Displays the port number n (-n) and rate.Port

—(Display only) Displays the port name.Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS, DSBLD (ANSI) or Locked,disabled
(ETSI)

• OOS, MT (ANSI) or Locked,maintenance
(ETSI)

• IS, AINS (ANSI) or
Unlocked,AutomaticInService (ETSI)

Sets the port service state unless network conditions prevent
the change. For more information about administrative
states, see the Administrative and Service States document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU, AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA, DSBLD (ANSI) or
Locked-enabled,disabled (ETSI)

• OOS-MA, MT (ANSI) or
Locked-enabled,maintenance (ETSI)

• OOS-MA, LPBK&MT (ANSI) or
Locked-enabled,loopback & maintenance
(ETSI)

(Display only) Identifies the autonomously generated state
that gives the overall condition of the port. Service states
appear in the format: Primary State-Primary State Qualifier,
Secondary State. For more information about service states,
see the Administrative and Service States document.

Service State

• Disabled (default)—ALS is off; the laser is not
automatically shut downwhen traffic outage or
loss of signal (LOS) occurs.

• Manual Restart— ALS is on; the laser
automatically shuts down when traffic outage
or LOS occurs. However, the laser must be
manually restarted when conditions that caused
the outage are resolved.

• Manual Restart for Test— Manually restarts
the laser for testing.

Sets the automatic laser shutdown (ALS) function mode.ALS Mode

• Duration of valid input signal, in hh.mm format,
after which the card state changes to in-service
(IS) automatically.

• 0 to 48 hours, 15-minutes increments.

Sets the automatic in-service (AINS) soak period.
Double-click the time and use the up and down arrows to
change settings.

AINS Soak
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OptionsDescriptionParameter

• Autoprovision—The system automatically
provisions the reach from the pluggable port
module (PPM) reach value on the hardware.

The reach distances that appear in
the drop-down list depend on the
card.

Note

Sets the optical reach distance of the client port.Reach

• First Tunable Wavelength

• Further wavelengths:

• 850 nm through 1610 nm

Displays the wavelength of the client port.Wavelength

Numeric. Default: 1548

Range 64 to 9700

Sets the maximum size of the Ethernet frames accepted by
the port. The port must be in OOS/locked state.

MTU

Value of theMAC address. Six bytes in hexadecimal
format.

Sets the MAC address of the incoming Ethernet signal.Incoming MAC
address

(100G-LC-C and
10x10G-LC)

• CBR

• GFP

Sets the mapping mode.Mapping Mode

(10x10G-LC)

• Transparent(Display-only) Sets the mode of operation.Termination
Mode

—VideoVideo Type

(100G-LC-C and
10x10G-LC)

• Auto (default)

When the auto mode is used, BJ
Fec is set to Off for QSFP28-LR4
and set to On for QSFP28-SR4.

Note

• Force-Fec-On

• Force-Fec-Off

Enables or disables BJ Fec on 100G ethernet client
interfaces based on the QSP28 pluggables used

BJ Fec
(400G-XP-LC)

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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DLP-G716 Changing the 10x10G-LC and WSE Card SONET/SDH Settings
This task changes the SONET (OC-192)/SDH (STM-64) settings of the
10x10G-LC and WSE cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the SONET (OC-192)/SDH (STM-64) settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs. Tabs and parameter selections vary
according to PPM provisioning.

Step 3 Modify any of the settings as described in the table.

Table 280: 10x10G-LC and WSE Card SONET/SDH Settings

OptionsDescriptionParameter

—(Display only) Displays the port number.Port

User-defined. Name can be up to 80 alphanumeric or special
characters, or both. Blank by default.

DLP-G104 Assigning a Name to a Port

Assign a name for the specified port.Port Name

• IS (ANSI) or Unlocked (ETSI)

• IS, AINS (ANSI) or Unlocked,automaticInService
(ETSI)

• OOS, DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS, MT (ANSI) or Locked,maintenance (ETSI)

Sets the port service state unless network conditions
prevent the change. For more information about
administrative states, see the Administrative and
Service States document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU, AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance
(ETSI)

(Display only) Identifies the autonomously generated
state that gives the overall condition of the port.
Service states appear in the format: Primary
State-Primary State Qualifier, Secondary State. For
more information about service states, see the
Administrative and Service States document.

Service State
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OptionsDescriptionParameter

• 1E-3

• 1E-4 (default)

• 1E-5

Sets the signal fail (SF) bit error rate (BER).SF BER

• 1E-5

• 1E-6

• 1E-7 (default)

• 1E-8

• 1E-9

Sets the signal degrade (SD) bit error rate (BER).SD BER

• SONET (ANSI)

• SDH (ETSI)

Sets the optical transport type.Type

• Disabled (default)—ALS is off; the laser is not
automatically shut down when traffic outage or loss of
signal (LOS) occurs.

• Auto Restart—ALS is on; the laser automatically shuts
down when traffic outage or LOS occurs. It
automatically restarts when the conditions that caused
the outage are resolved.

• Manual Restart—ALS is on; the laser automatically
shuts down when traffic outage or LOS occurs.
However, the laser must be manually restarted when
conditions that caused the outage are resolved.

• Manual Restart for Test—Manually restarts the laser
for testing.

Sets the automatic laser shutdown (ALS) function
mode. The DWDM transmitter supports ALS
according to ITU-T G.644 (06/99). ALS can be
disabled or enabled for one of the three mode
options.

ALS Mode

• Duration of valid input signal, in hh.mm format, after
which the card state changes to in-service (IS)
automatically.

• 0 to 48 hours, 15-minutes increments.

Sets the automatic in-service (AINS) soak period.
Double-click the time and use the up and down
arrows to change settings.

AINS Soak

• Checked

• Unchecked

Sets the ProvidesSync card parameter. If checked,
the card is provisioned as a NE timing reference.

ProvidesSync

• Checked

• Unchecked

Sets the EnableSync card parameter. Enables
synchronization status messages (S1 byte), which
allow the node to choose the best timing source.

SyncMsgIn
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OptionsDescriptionParameter

• Checked

• Unchecked

Sets the Send DoNotUse card state. When checked,
sends a do not use (DUS) message on the S1 byte.

Send

DoNotUse

(WSE)

STUOverrides the synchronization status message (SSM)
and the synchronization traceability unknown (STU)
value. If the node does not receive an SSM signal,
it defaults to STU.

Admin SSM In

• Autoprovision—The system to automatically provision
the reach from the pluggable port module (PPM) reach
value on the hardware.

The reach distances that appear in the
drop-down list depend on the card.

Note

Sets the optical reach distance of the client port.Reach

• First Tunable WavelengthDisplays the wavelength of the client port.Wavelength

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G717 Changing the 10x10G-LC and WSE Card Section Trace Settings
This task changes the section trace settings of the 10x10G-LC and WSE cards.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to PPM
provisioning.

Step 3 Modify any of the settings in the Section Trace tab as described in the table.
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Table 281: 10x10G-LC and WSE Card Line Section Trace Settings

OptionsDescriptionParameter

—(Display only) Displays the port number.Port

• Off/None

• Manual

Sets the received trace mode.Received Trace
Mode

• Checked (AIS/RDI on TIM-S is
disabled)

• Unchecked (AIS/RDI on TIM-S is not
disabled)

If a trace identifier mismatch (TIM) on a section overhead alarm arises
because of a J0 overhead string mismatch, no alarm indication signal
(AIS) is sent to the downstream nodes if this box is checked.

If the Received Trace Mode field is set to Manual, the Disable
AIS/RDI on TIM-S? checkbox is automatically checked.

Disable
AIS/RDI on
TIM-S?

• 1 byte

• 16 byte

Sets the trace string size.Transmit
Section Trace
String Size

• Hex Mode—Click to change the
display to hexadecimal (button changes
to ASCII Mode).

• ASCII Mode—Click to change the
display to ASCII (button changes to
Hex Mode).

The button title changes
based on the current
display mode.

Note

Displays the current transmit string or sets a new transmit string.

The transmit string cannot be configured when the
termination mode is transparent.

Note

Transmit

• Hex Mode—Click to change the
display to hexadecimal (button changes
to ASCII Mode).

• ASCII Mode—Click to change the
display to ASCII (button changes to
Hex Mode).

The button title changes
based on the current
display mode.

Note

Displays the current expected string or sets a new expected string.Expected
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OptionsDescriptionParameter

• Hex Mode—Click to change the
display to hexadecimal (button changes
to ASCII Mode).

• ASCII Mode—Click to change the
display to ASCII (button changes to
Hex Mode).

The button title changes
based on the current
display mode.

Note

(Display only) Displays the current received string.Received

• Checked

• Unchecked (default)

If checked, automatically refreshes the display every 5 seconds.Auto-refresh

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G718 Changing the 10x10G-LC and WSE Card SONET/SDH Line Thresholds
This task changes the SONET/SDH line threshold settings of the 10x10G-LC
card.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 10x10G-LC card where
you want to change the SONET/SDH line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) tabs.
Step 3 Modify any of the settings as shown in the table.

You must modify each of these options independently: Near End and Far End, 15 Min and 1 Day,
and Line and Section. To do so, choose the appropriate radio button and click Refresh.

Note
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Table 282: 10x10G-LC and WSE Card SONET/SDH Line Threshold Settings

SDH OptionsSONET OptionsDescriptionParameter

• Client Ports• Client Ports(Display only) Displays
the port number.

Port

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Coding violations (CV)CV

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

—Errored Block (EB)EB

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Errored seconds (ES)ES

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

Severely errored
seconds (SES)

SES
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SDH OptionsSONET OptionsDescriptionParameter

—Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only) Failure
count (FC)

FC

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

—Background block error
(BBE)

BBE

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or
Regeneration Section (near end only)

Choose an option in each category and click
Refresh.

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only)

Choose an option in each category and click
Refresh.

(Line or Multiplex
Section only)
Unavailable seconds
(UAS)

UAS

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G719 Changing the Card Line RMON Thresholds
This task changes the line RMON threshold settings for 100G-LC-C,
100G-CK-C, 100G-ME-C, 100ME-CKC, 10x10G-LC,CFP-LC, 100GS-CK-LC,
200G-CK-LC, MR-MXP, WSE, or 400G-XP-LC cards carrying Ethernet or
FC payloads.

The RMON threshold settings for the CFP-LC card can be changed
on the virtual port of the peer 100G-LC-C, 100G-CK-C,
100G-ME-C, or 100ME-CKC card.

Note

Purpose

NoneTools/Equipment
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DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the line RMON threshold settings in the card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
Step 3 Click Create.
Step 4 From the Port drop-down list, choose the applicable port, either the payload port, for example “1-1

(ONEHUNDRED_GE)” port.
Step 5 From the Variable drop-down list, choose an Ethernet, FC, FICON, or GFP variable. See the following tables

for the list of the available variables.

Table 283: Card Ethernet Variables

DescriptionVariable

Number of bytes received since the last counter reset.ifInOctets

Total number of received packets.rxTotalPkts

Total number of packets delivered by this sublayer to a higher
sublayer that are not addressed to a multicast or broadcast
address.

ifInUcastPkts 20

Total number of packets delivered by this sublayer to a higher
sublayer that are addressed to a multicast address. For a MAC
layer protocol, this includes both group and functional
addresses.

ifInMulticastPkts 1

Total number of packets delivered by this sublayer to a higher
sublayer that are addressed to a broadcast address.

ifInBroadcastPkts 1

Total number of received errors.ifInErrors

Total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of transmitted packets.txTotalPkts

Total count of packets transmitted to a unicast group destination
address.

IfOutUcastPkts
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Total number of packets that higher-level protocols requested
to be transmitted, which were addressed to a multicast address
at this sublayer. These include packets that were discarded or
not sent. For a MAC layer protocol, this includes both group
and functional addresses.

ifOutMulticastPkts

Total number of packets that higher-level protocols requested
to be transmitted, which were addressed to a broadcast address
at this sublayer. These include packets that were discarded or
not sent.

ifOutBroadcastPkts

Total number of frames received on a particular interface that
are not an integral number of octets in length and do not pass
the FCS check. This counter is only valid for FE modes of
operation.

dot3StatsAlignmentErrors

Total number of frames received on a particular interface that
are an integral number of octets in length but do not pass the
FCS check.

dot3StatsFCSErrors

Total number of frames received on a particular interface that
exceed the maximum permitted frame size.

dot3StatsFrameTooLong

Total number of packets received that were less than 64 octets
long (excluding framing bits, but including FCS octets) and
were otherwise well-formed.

etherStatsUndersizePkts

Total number of packets received that were less than 64 octets
in length (excluding framing bits, but including FCS octets)
and had either a bad FCS with an integral number of octets
(FCS error) or a bad FCS with a non-integral number of octets
(alignment error). Note that it is entirely normal for
etherStatsFragments to increment. This is because it counts
both runts (which are normal occurrences due to collisions)
and noise hits.

etherStatsFragments

Total number of frames received on an interface in both Rx
and Tx directions.

etherStatsPkts

Total number of packets (including bad packets) received that
were 64 octets in length (excluding framing bits, but including
FCS octets).

etherStatsPkts64Octets

Total number of packets (including bad packets) received that
were between 65 and 127 octets in length inclusive (excluding
framing bits, but including FCS octets).

etherStatsPkts65to127Octets

Total number of packets (including bad packets) received that
were between 128 and 255 octets in length inclusive (excluding
framing bits, but including FCS octets).

etherStatsPkts128to255Octets
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Total number of packets (including bad packets) received that
were between 256 and 511 octets in length inclusive (excluding
framing bits, but including FCS octets).

etherStatsPkts256to511Octets

Total number of packets (including bad packets) received that
were between 512 and 1023 octets in length inclusive
(excluding framing bits, but including FCS octets).

etherStatsPkts512to1023Octets

Total number of packets (including bad packets) received that
were between 1024 and 1518 octets in length inclusive
(excluding framing bits, but including FCS octets).

etherStatsPkts1024to1518Octets

Total number of good packets received that were directed to
the broadcast address. Note that this number does not include
multicast packets.

etherStatsBroadcastPkts

Total number of good packets received that were directed to a
multicast address. Note that this number does not include
packets directed to the broadcast address.

etherStatsMulticastPkts

Total number of packets received that were longer than 1518
octets (excluding framing bits, but including FCS octets) and
were otherwise well-formed.

etherStatsOversizePkts

Total number of packets received that were longer than 1518
octets (excluding framing bits, but including FCS octets), and
had either a bad FCS with an integral number of octets (FCS
error) or a bad FCS with a non-integral number of octets
(alignment error).

etherStatsJabbers

Total number of octets of data (including those in bad packets)
received on the network (excluding framing bits, but including
FCS octets).

etherStatsOctets

Total number of packets (including bad packets) received that
were 1591 octets in length (excluding framing bits, but
including FCS octets).

etherStatsPkts1519tomaxOctets

—pcs49RxErrBer

—pcs49RxErrDec

20 The counter does not increment for traffic with incorrect Ethertype and packet size of more than
64 bytes on the 10x10G-LC and 100G-LC-C cards.

Table 284: 10x10G-LC and WSE FC/FICON Variables

DescriptionVariable

Total number of received packets.rxTotalPkts

Total number of transmitted packets.txTotalPkts
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DescriptionVariable

Total number of received data frames with payload CRC errors
when HDLC framing is used.

mediaIndStatsRxFramesBadCRC

Total number of transmitted data frames with payload CRC
errors when HDLC framing is used.

mediaIndStatsTxFramesBadCRC

Total number of frames received that are less than 5 bytes. This
value is a part of the high-level data link control (HDLC) and
GFP port statistics.

mediaIndStatsRxFramesTruncated

Total number of transmitted data frames that exceed the MTU.
This value is a part of the HDLC and GFP port statistics.

mediaIndStatsTxFramesTruncated

Total number of received frames that exceed the maximum
transmission unit (MTU). This value is a part of the HDLC and
GFP port statistics.

mediaIndStatsRxFramesTooLong

Total number of transmitted data frames that are less than 5
bytes. This value is a part of the HDLC and GFP port statistics.

mediaIndStatsTxFramesTooLong

Total number of octets received on the interface, including the
framing octet.

ifInOctets

Total number of octets transmitted out of the interface,
including framing characters.

ifOutOctets

Total number of inbound packets that contained errors
preventing them from being delivered to a higher-layer
protocol.

ifInErrors

Total number of outbound packets or transmission units that
could not be transmitted because of errors.

ifOutErrors

—pcs49RxErrBer

—pcs49RxErrDec

Table 285: 10x10G-LC and WSE GFP RMON Variables

DescriptionVariable

Total number of received data frames.gfpStatsRxFrame

Total number of transmitted data frames.gfpStatsTxFrame

Total number of CRC errors with the receive transparent GFP
frame.

gfpStatsRxCRCErrors

Total number of GFP data octets received.gfpStatsRxOctets

Total number of GFP data octets transmitted.gfpStatsTxOctets
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Received GFP frames with single bit errors in the core header
(these errors can be corrected).

gfpStatsRxSBitErrors

ReceivedGFP frames with multiple bit errors in the core header
(these errors cannot be corrected).

gfpStatsRxMBitErrors

Received GFP frames with invalid type (these are discarded).
For example, receiving GFP frames that contain Ethernet data
when we expect Fibre Channel data.

gfpStatsRxTypeInvalid

—gfpRxCmfFrame

—gfpRxCmfFrame

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold,
falling threshold, or both the rising and falling thresholds.

The available options are Rising Threshold, Falling Threshold, and Rising and Falling Threshold.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the threshold
to use the number of occurrences in the user-set sample period. Absolute sets the threshold to use the total
number of occurrences, regardless of time period.

Step 8 Enter the appropriate number of seconds in the Sample Period field.
Step 9 Enter the appropriate number of occurrences in the Rising Threshold field.

For a rising type of alarm, the measured value must move from below the falling threshold to above the rising
threshold. For example, if a network is running below a rising threshold of 1000 collisions every 15 seconds
and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm.

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling threshold
is set lower than the rising threshold.

A falling threshold is the counterpart to a rising threshold.When the number of occurrences is above the rising
threshold and then drops below a falling threshold, it resets the rising threshold. For example, when the network
problem that caused 1001 collisions in 15 seconds subsides and creates only 799 collisions in 15 seconds,
occurrences fall below a falling threshold of 800 collisions. This resets the rising threshold so that if network
collisions again spike over a 1000 per 15-second period, an event again triggers when the rising threshold is
crossed. An event is triggered only the first time a rising threshold is exceeded (otherwise, a single network
problem might cause a rising threshold to be exceeded multiple times and cause a flood of events).

Step 11 Click OK.

To view all RMON thresholds, check the Show All RMON thresholds checkbox.Note

Step 12 Return to your originating procedure (NTP).

DLP-G720 Provisioning the Card with Trunk Port Alarm and TCA Thresholds
This task provisions the 100G-LC-C, 100G-CK-C, 100G-ME-C, 100GS-CK-LC,
200G-CK-LC, 100ME-CKC, or 400G-XP-LC cards with trunk port alarm and
TCA thresholds.

Purpose
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NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C, 100G-CK-C,
100G-ME-C, 100GS-CK-LC, 200G-CK-LC, 100ME-CKC, or 400G-XP-LC card where youwant to provision
the trunk port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

Do not modify the Laser Bias parameters.Note

The Optics Thresholds tab incorrectly lists the 100GE aggregate port on the CPAK-FR-S
pluggable for the 200G-CK-LC card and on the 100G-QSFP-FR-S pluggable for the 400G-XP-LC
card.

Note

Step 3 If TCA is not selected, click the TCA radio button and then click Refresh. If it is checked, continue with step
4.

Step 4 Verify if the port TCA thresholds are set. Provision new thresholds as needed by double-clicking the threshold
value you want to change, deleting it, entering a new value, and pressing Enter.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Do not modify the Laser Bias parameters.Note

Step 6 Verify if the port Alarm thresholds are set. Provision new thresholds as needed by double-clicking the threshold
value you want to change, deleting it, entering a new value, and pressing Enter.

Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).

DLP-G721 Provisioning the Client Port Alarm and TCA Thresholds
This task provisions the client port alarm and TCA thresholds for the
100G-LC-C, 10x10G-LC, CFP-LC, MR-MXP, 100G-CK-C, 100G-ME-C,
100GS-CK-LC, , 200G-CK-LC, 100ME-CKC, and 400G-XP-LC cards.

The client port alarm and TCA thresholds cannot be provisioned
on the QSFP+ ports of the MR-MXP cards.

Note

Purpose
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NoneTools/Equipment

• DLP-G278 Provisioning the Optical Line Rate, on page 317

• DLP-G46 Log into CTC

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the client port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.
Step 3 Verify if the TCA thresholds for client ports for RX Power High, RX Power Low, TX Power High, and TX

Power Low parameters are set based on the client interface at the other end. Provision new thresholds as
needed by double-clicking the threshold value you want to change, deleting it, entering a new value, and
pressing Enter.

Do not modify the Laser Bias parameters.Note

You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button
and click Refresh.

Note

The hardware device that plugs into a card faceplate to provide a fiber interface to the card is
called a Small Form-factor Pluggable (SFP, QSFP+, XFP, or CXP) or a C Form-factor Pluggable
(CFP, CFP2, or CPAK). In CTC, SFPs, QSFPs+, XFPs, CXPs, CFPs, and CPAKs are called
pluggable port modules (PPMs). SFPs/QSFPs+/XFPs/CXPs/CFPs/CPAKs are hot-swappable
I/O devices that plug into a port to link the port with the fiber-optic network. Multirate PPMs
have provisionable port rates and payloads. For more information, see SFP, SFP+, QSFP+, XFP,
CXP, CFP, CFP2 and CPAK Modules, on page 307.

Note

For multi-lane pluggables (CXP, CFP, CPAK), the thresholds are set on the first lane and copied
on the remaining lanes. You can edit only the first lane.

Note

Step 4 Click Apply.
Step 5 Repeat step 3 and step 4 to provision each additional client port.
Step 6 Under Types, click the Alarm radio button and click Refresh.
Step 7 Verify if the client port Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX

Power Low parameters are set based on the client interface that is provisioned. Provision new thresholds as
needed by double-clicking the threshold value you want to change, deleting it, entering a new value, and
hitting Enter.

Step 8 Click Apply.
Step 9 Repeat step 7 and step 8 to provision each additional client port.
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Step 10 Return to your originating procedure (NTP).

DLP-G722 Changing the Card OTN Settings
This task changes the OTN settings for the 100G-LC-C, 100G-CK-C,
100G-ME-C, 100ME-CKC, 10x10G-LC, 100GS-CK-LC, 200G-CK-LC,
CFP-LC, or 400G-XP-LC cards.

The OTN settings cannot be provisioned on the virtual port of the
MR-MXP card.

Note

Purpose

NoneTools/Equipment

Login to CTC.Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, ITU-T
G.709 Thresholds, FEC Thresholds, Trail Trace Identifier, or Proactive Protection Regen.

Step 3 Modify any of the settings described in the following tables.

You must modify each of these options independently: Near End and Far End, 15 Min and 1 Day,
and SM and PM. To do so, choose the appropriate radio button and click Refresh.

The following table describes the values on the Provisioning > OTN > OTN Lines tab.

Note

Table 286: Card OTN Line Settings

OptionsDescriptionParameter

All client and trunk ports(Display only) Displays the port number.Port

Enabled by defaultSets the OTN lines according to
ITU-T G.709.

ITU-T G.709
OTN

See .Sets the OTN lines to forward error
correction (FEC).

FEC

• 1E-5(Display only) Displays the signal fail (SF)
bit error rate (BER).

SF BER
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OptionsDescriptionParameter

• 1E-5

• 1E-6

• 1E-7 (Default)

• 1E-8

• 1E-9

Sets the signal degrade (SD) bit error rate
(BER).

SD BER

• Checked

• Unchecked

Sets the ProvidesSync card parameter. If
checked, the card is provisioned as a NE
timing reference.

ProvidesSync

• Checked

• Unchecked

Sets the EnableSync card parameter. Enables
synchronization status messages (S1 byte),
which allow the node to choose the best
timing source.

SyncMsgIn

• STU—Sync traceability unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum clock

• ST4—Stratum 4

• DUS—Do not use for timing

• RES—Reserved; quality level set

Overrides the synchronization statusmessage
(SSM) and the synchronization traceability
unknown (STU) value. If the node does not
receive an SSM signal, it defaults to STU.

Admin SSM In

• None (default value)

• Enable

Enables interoperability between 200G-CK
linecards and other vendor interfaces.

Interop Mode

The following table describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.

Table 287: ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

—(Display only) Displays the port
number.

Port

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Errored seconds (ES)ES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Severely errored seconds (SES)SES
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OptionsDescriptionParameter

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Unavailable seconds (UAS)UAS

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Background block errors (BBE)BBE

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals, or for SM (OTUk) or
PM (ODUk). Select an option and click Refresh.

Failure counter (FC)FC

The following table describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 288: Card FEC Threshold Settings

OptionsDescriptionParameter

—(Display only) Displays the port number.Port

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for bit errors corrected.Bit Errors
Corrected

Numeric. Can be set for 15-minute or
one-day intervals.

Sets the value for uncorrectable words.Uncorrectable
Words

The following table describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 289: Card Trail Trace Identifier Settings

OptionsDescriptionParameter

—Displays the port number.Port

• Section

• Path

Sets the level.Level

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
disabled)

FDI is not supported for
TTI-PM but is applicable for
TTI-SM.

Note

If a Trace Identifier Mismatch on Section
overhead alarm arises because of a J0
overhead string mismatch, no Forward
Defect Indication (FDI) signal is sent to the
downstream nodes if this box is checked.

This field is enabled only if the Received
Trace Mode is set to Manual.

Disable FDI on
TTIM?
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OptionsDescriptionParameter

• Hex Mode—Click to change the
display to hexadecimal (button changes
to ASCII Mode).

• ASCII Mode—Click to change the
display to ASCII (button changes to
Hex Mode).

Transmit is not supported
for TTI-PM but is
applicable for TTI-SM.

Note

The button title changes
based on the current
display mode.

Note

Displays the current transmit string or sets
a new transmit string.

Transmit

(Release 10.1
and earlier
releases )

Supported in
400G-XP-LC
card

• Hex Mode—Click to change the
display to hexadecimal (button changes
to ASCII Mode).

• ASCII Mode—Click to change the
display to ASCII (button changes to
Hex Mode).

The button title changes
based on the current
display mode.

Note

Displays the current expected string or sets
a new expected string.

Expected

(Release 10.1
and earlier
releases)

Supported in
400G-XP-LC
card

• Hex Mode—Click to change the
display to hexadecimal (button changes
to ASCII Mode).

• ASCII Mode—Click to change the
display to ASCII (button changes to
Hex Mode).

The button title changes
based on the current
display mode.

Note

(Display only) Displays the current received
string.

Received

(Release 10.1
and earlier
releases)

Supported in
400G-XP-LC
card

In Release 10.3 and later releases:

Transmit Area—The Edit Transmit Area allows you to enter a new transmit string. The Current Transmit
Area displays the current transmit string.

Expected Area—The Edit Expected Area allows you to enter a new expected string. The Current Expected
Area displays the current expected string.

Received Area—The Current Received Area displays the current received string.
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OptionsDescriptionParameter

—Source Access Point Identifier (SAPI) of the
TTI.

SAPI

—Destination Access Point Identifier (DAPI)
of the TTI.

DAPI

—User operator data of the TTI.User Operator
Data

—Sets the transmit or expected string type to
ASCII or Hex.

Edit Mode

—Uses the values of the current or expected
transmit string for the SAPI, DAPI, and User
Operator Data fields.

Fill from
Current

—When the button label displays “HexMode”,
the strings in the SAPI, DAPI and User
Operator fields are in ASCII format. Click
the Hex Mode button to display the string
in hexadecimal format. The button name also
changes to “ASCII Mode”. Click ASCII
Mode to return the strings to ASCII format.

Hex Mode

• Checked

• Unchecked (default)

If checked, automatically refreshes the
display every five seconds.

Do not check the auto-refresh
checkbox while configuring
the TTI strings.

Note

Auto-refresh

From Release 10.6.2, the 400G-XP line cards support SAPI/ DAPI (and not TTI).

The received trace value in the Provisioning -> OTN -> Trail Trace Identifier tab might be empty (even when
TTI is not OFF and is receiving information) upon the following conditions, for these cards - 100GS-CK-LC,
200G-CK-LC, 400G-CK-L, MR-MXP :

a. The user has logged into the node for the first time.

b. The user has upgraded the node.

c. The user has reset the card.

Click Refresh or Reset to view the received trace value immediately or click Auto-refresh to view the
received trace value after five seconds.

Table 290: Support for Proactive Protection Regeneration

Supported PayloadsOperating ModeCard

100GE, OTU4TXP-100G or RGN-100G100G-LC-C and
100G-ME-C
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Supported PayloadsOperating ModeCard

• CPAK-100G-LR4 with 100GE,OTU4
• CPAK-100G-SR10with 100GE,OTU4

TXP-100G or RGN-100G100G-CK-C and
100ME-CKC

OTU2MXP-10x10G10x10G-LC

100GE, OTU4CFP-TXPCFP-LC

The 100GS-CK-LC and 200G-CK-LC cards do not support proactive protection.Note

The following table describes the values on the Provisioning > OTN > Proactive Protection Regen tabs.

Table 291: Card Proactive Protection Regen Settings

OptionsDescriptionParameter

—(Display only) Displays the port number and
name (optional).

Port

• 1E-3

• 9E-4 to 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

Sets the maximum BER threshold to trigger
proactive protection.

Trigger
Threshold

Time in milliseconds.Sets the duration when BER is monitored
before triggering the proactive protection.

The trigger window valuemust be a multiple
of:

• 10 ms for trigger thresholds between
1E-3 and 6E-6

• 100 ms for trigger threshold between
5E-6 to 1E-7

Trigger window must be less than or equal
to 500 ms for trigger thresholds between
1E-3 and 6E-6. The trigger window must be
less than or equal to 3900 ms for trigger
thresholds between 5E-6 to 1E-7.

TriggerWindow
(ms)
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OptionsDescriptionParameter

• 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

• 9E-8 to 5E-8

Sets the revert threshold value of BER.

The revert threshold settings
must be less than the trigger
threshold values.

Note

Revert
Threshold

Time in milliseconds.Sets the duration when BER is monitored
for settings that are less than the revert
threshold value before which proactive
protection provided to the router is removed.

The revert window value must be at least
2000 ms and a multiple of:

• 10 ms for a revert threshold of 1E-4 to
6E-7

• 100 ms for a revert threshold of 5E-7
to 5E-8.

The revert windowmust be less than or equal
to 3900 ms.

Revert Window
(ms)
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OptionsDescriptionParameter

The available options for TXP-100G
operating mode on the 100G-LC or
100G-CK card are:

• Disabled—Proactive protection is not
enabled.

• FRR Proactive Protection—Supported
on all the pluggables except on
ONS-CC-100G-LR4= and
CPAK-100G-LR4 when the client
payload is 100GE-LAN.

• Pre-FEC PSM Proactive
Protection—This option is supported
on the trunk port only when the client
has ONS-CC-100G-LR4= and
CPAK-100G-LR4. Also, this option is
applicable only when the card is
configured in TXP-100G andCFP-TXP
operatingmodes using 100GE orOTU4
payload.

The available options for MXP-10x10G
operating mode are:

• Enabled
• Disabled

The available options for 10x10G-LC card
are:

• Egress Proactive Protection Enabled
• Egress Proactive Protection Disabled

Enables proactive protection.Enable Proactive
Protection

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G815 Changing the 400G-XP-LC Card ODU Settings
This task changes the ODU settings for the 400G-XP-LC cards configured in
the OTNXC mode.

The ODU parameters on the protected trunk-ODUs cannot be
edited independently. The ports inherit the values of the working
trunk-ODUs.

Note

The ODU line and ODU threshold settings are not applicable for
ODU4 interfaces. The TCAs and conditions are directly raised on
the trunk port.

Note

Purpose
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NoneTools/Equipment

Login to CTC.Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 400G-XP-LC card where
you want to change the ODU settings.

Step 2 Click the Provisioning >ODU tabs, then choose one of the following subtabs: ODU Lines, ODU Thresholds,
or ODU TTI.

Step 3 In the Port drop-down list, choose a port.
Step 4 Modify any of the settings described in the following tables.

You must modify each of these options independently: Near End and Far End, 15 Min and 1 Day,
and SM and PM. To do so, choose the appropriate radio button and click Refresh.

The following table describes the values on the Provisioning > ODU > ODU Lines tab.

Note

Table 292: Card ODU Line Settings

OptionsDescriptionParameter

trunk ports(Display only) Displays the port number.ODU

• 1E-5(Display only) Displays the signal fail (SF)
bit error rate (BER).

SF BER

• 1E-5

• 1E-6

• 1E-7 (Default)

• 1E-8

• 1E-9

Sets the signal degrade (SD) bit error rate
(BER).

SD BER

The following table describes the values on the Provisioning > ODU > ODU Thresholds tab.

Table 293: ODU Threshold Settings

OptionsDescriptionParameter

trunk ports(Display only) Displays the port
number.

Port
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OptionsDescriptionParameter

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals. Select an option and
click Apply.

Errored seconds (ES)ES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals. Select an option and
click Apply.

Severely errored seconds (SES)SES

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals. Select an option and
click Apply.

Unavailable seconds (UAS)UAS

Numeric. Can be set for Near End or Far End, for
15-minute or one-day intervals. Select an option and
click Apply.

Background block errors (BBE)BBE

Numeric. Can be set for Near End or Far End. Select an
option and click Apply.

Failure counter (FC)FC

To restore the default values, select a row from the table and click Reset to Default.Note

The following table describes the values on the Provisioning > ODU > TTI tab.

Table 294: Card Trail Trace Identifier Settings

OptionsDescriptionParameter

client portsDisplays the port number.Port

• PathSets the level.Level

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not
disabled)

If a Trace Identifier Mismatch on Section
overhead alarm arises because of a J0
overhead string mismatch, no Forward
Defect Indication (FDI) signal is sent to the
downstream nodes if this box is checked.

This field is enabled only if the Received
Trace Mode is set to Manual.

Disable FDI on
TTIM?

Transmit Area—The Edit Transmit Area allows you to enter a new transmit string. The Current Transmit
Area displays the current transmit string.

Expected Area—The Edit Expected Area allows you to enter a new expected string. The Current Expected
Area displays the current expected string.

Received Area—The Current Received Area displays the current received string.
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OptionsDescriptionParameter

—Source Access Point Identifier (SAPI) of the
TTI.

SAPI

—Destination Access Point Identifier (DAPI)
of the TTI.

DAPI

—User operator data of the TTI.User Operator
Data

—Sets the transmit or expected string type to
ASCII or Hex.

Edit Mode

—Uses the values of the current or expected
transmit string for the SAPI, DAPI, and User
Operator Data fields.

Edit Current
Values

—When the button label displays “HexMode”,
the strings in the SAPI, DAPI and User
Operator fields are in ASCII format. Click
the Hex Mode button to display the string
in hexadecimal format. The button name also
changes to “ASCII Mode”. Click ASCII
Mode to return the strings to ASCII format.

Hex Mode

• Checked

• Unchecked (default)

If checked, automatically refreshes the
display every five seconds.

Do not check the auto-refresh
checkbox while configuring
the TTI strings.

Note

Auto-refresh

Click Refresh or Reset to view the received trace value immediately or click Auto-refresh to view the
received trace value after five seconds.

Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).

DLP-G770 Enabling PRBS Settings
This task enables PRBS settings for the 100G-LC-C, 100G-CK-C, 100G-ME-C,
100ME-CKC, 100GS-CK-LC, and 200G-CK-LC cards.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
enable the PRBS settings.

Step 2 Click the Maintenance > PRBS tabs.
Step 3 Modify any of the settings as described in the following table.

Table 295: Card PRBS Settings

OptionsDescriptionParameter

Trunk ports(Display only) Displays the port number.Port

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or
Unlocked,automaticInService (ETSI)

• OOS,DSBLD (ANSI) or
Locked,disabled (ETSI)

• OOS,MT (ANSI) or
Locked,maintenance (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states, see
the Administrative and Service States
document.

Admin State

PRBS_31Displays the pattern generated by the line
card.

Generator
Pattern

• PRBS_11
• PRBS_23
• PRBS_31

Only PRBS_31 is supported on the
100GS-CK-LC and 200G-CK-LC cards.

Displays the pattern detected by the line
card.

Detected Pattern

• PATTERN_NONE
• PATTERN_OK
• PATTERN_ERROR

Displays the pattern sync status.Pattern Sync
Status

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).
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NTP-G351 Retrieving MAC Addresses on Cards
This procedure enables you to retrieve the MAC
address of the host connected to the MR-MXP ports
for 10 GE clients or 400G-XP-LC ports for 10GE or
100GE ports using the Link Layer Discovery Protocol
(LLDP).

Purpose

NoneTools/Equipment

NonePrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Retrieve or higherSecurity Level

Procedure

Step 1 In the node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want
to retrieve the source MAC addresses.

Step 2 Click the Maintenance > LLDP tabs.
Step 3 Click Retrieve.

The table displays the following fields:

• Port-Displays the port number.

• Source MAC Address-Displays the MAC address of the node to which the port is connected.

Stop. You have completed this procedure.

NTP-G338 Provisioning an Operating Mode on the WSE Card
This procedure enables you to provision an operating mode on the WSE card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Super userSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the WSE card where you want
to provision an operating mode. The card view appears.

Step 2 Click the Provisioning > Card tabs.

You cannot edit an existing operating mode on the WSE card.Note

Step 3 In the Operating Modes tab, click Create.
Step 4 Choose the configuration from the Card Configuration drop-down list. The card configuration options are

TXP-10G and RGN-10G modes.
Step 5 Select the defined port pair in the Card Configuration Dialog area. The WSE card supports a maximum of

five TXP-10G modes, five RGN-10G modes, or a combination of five TXP-10G, and RGN-10G modes.
Step 6 Click Finish. The selected operating mode is provisioned on the WSE card.
Step 7 Complete the DLP-G726 Preprovisioning a Multirate PPM task.
Step 8 Complete the DLP-G278 Provisioning the Optical Line Rate, on page 317 task.

Stop. You have completed this procedure.

NTP-G339 Modifying the WSE Card Line Settings and PM
Parameter Thresholds

This procedure changes the line and PM parameter threshold settings of the
WSE card.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• NTP-G179 Installing the Transponder and Muxponder Cards

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provisioning the Optical Line Rate, on page 317

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level
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Procedure

Step 1 As needed, complete the NTP-G103 Backing Up the Database task, to preserve the existing transmission
settings.

Step 2 Perform any of the following tasks as needed:

• DLP-G744 Changing the WSE Card Security Thresholds and Setting Authentication Error Thresholds

• DLP-G740 Changing the WSE Card Ethernet Settings

• DLP-G745 Changing the WSE Card Line RMON Thresholds

• DLP-G746 Provisioning the WSE Card with Port Alarm and TCA Thresholds

• DLP-G747 Change the WSE Card OTN Settings

To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see
the Alarm and TCA Monitoring and Management document.

Note

Stop. You have completed this procedure.

DLP-G739 Changing the WSE Card Line Settings
This task changes the line settings of the WSE card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the WSE card where you want
to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs.

Tabs and parameter selections vary according to pluggable port modules (PPM) provisioning.

Step 3 Modify any of the line settings in the Ports tab as described in the following table.
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Table 296: WSE Card Line Settings

OptionsDescriptionParameter

1 through 10(Display only) Displays the port number.Port

User-defined. Name can be up to 80 alphanumeric
or special characters, or both. Blank by default.

DLP-G104 Assigning a Name to a Port

Assigns a logical name for the specified
port.

Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS, DSBLD (ANSI) or Locked,disabled
(ETSI)

• OOS, MT (ANSI) or Locked,maintenance
(ETSI)

• IS, AINS (ANSI) or
Unlocked,AutomaticInService (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states,
see the Administrative and Service States
document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU, AINS (ANSI) or
Unlocked-disabled, automaticInService
(ETSI)

• OOS-MA, DSBLD (ANSI) or
Locked-enabled,disabled (ETSI)

• OOS-MA, MT (ANSI) or
Locked-enabled,maintenance (ETSI)

• OOS-MA, LPBK&MT (ANSI) or
Locked-enabled,loopback & maintenance
(ETSI)

(Display only) Identifies the
autonomously generated state that gives
the overall condition of the port. Service
states appear in the format: Primary
State-Primary State Qualifier, Secondary
State. For more information about service
states, see the Administrative and Service
States document.

Service State

• Disabled (default)— ALS is off; the laser is
not automatically shut down when traffic
outage or loss of signal (LOS) occurs.

• Auto Restart—ALS is on; the laser
automatically shuts downwhen traffic outage
or LOS occurs. It automatically restarts when
the conditions that caused the outage are
resolved.

• Manual Restart— ALS is on; the laser
automatically shuts downwhen traffic outage
or LOS occurs. However, the laser must be
manually restarted when conditions that
caused the outage are resolved.

• Manual Restart for Test—Manually restarts
the laser for testing.

Sets the automatic laser shutdown (ALS)
function mode.

ALS Mode

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
705

Provisioning Transponder and Muxponder Cards
DLP-G739 Changing the WSE Card Line Settings

http://www.cisco.com/c/en/us/td/docs/optical/15000r10_0/dwdm/network_config/guide/b_ons_network_configuration/b_ons_network_configuration_chapter_010100.html#ID677
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_administrative_service_states.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_administrative_service_states.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_administrative_service_states.html


OptionsDescriptionParameter

• Duration of valid input signal, in hh.mm
format, after which the card state changes to
in-service (IS) automatically.

• 0 to 48 hours, 15-minute increments.

Sets the automatic in-service (AINS) soak
period. Double-click the time and use the
up and down arrows to change settings.

AINS Soak

Autoprovision—The system automatically
provisions the reach from the pluggable port
module (PPM) reach value on the hardware.

Sets the optical reach distance of the client
port.

Reach

• First Tunable Wavelength

• Further wavelengths:

• – 850 nm through 1610 nm

Displays the wavelength of the client port.Wavelength

• OFF

• ON

When an OTU2 payload is
provisioned on the WSE card in the
TXP-10G or RGN-10G operating
mode, the overclock parameter is
automatically set to ON.

Note

Enables or disables overclock mode.OverClock

• AIS/Send Local Fault

• Squelch/Laser-Off

Shuts down the far-end laser in response
to certain defects.

Fault
Signalling

• CBR

• GFP

Sets the mapping mode.

In a WSE card with a 10-GE payload,
when a network fault or failure occurs,
and the user sets squelch to the Disable
state, the faults propagated downstream
are different in GFP and CBR mapping.

In GFP mapping, the device connected to
the client reports a momentary local fault,
but in CBR mapping, the local fault is
reported for the entire duration of the
fault.

Mapping
Mode

TransparentSets the termination mode.Termination
Mode
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Table 297: Reach Distances for WSE Card

ReachPayloadCard

SR-MM

P1I1-2D1

P1S1-2D2b

P1L1-2D2

DWDM

OTU2WSE

TEN_GE_SR

TEN_GE_LR

TEN_GE_ER

TEN_GE_ZR

DWDM

OTU2e

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G740 Changing the WSE Card Ethernet Settings
This task changes the ethernet settings of the WSE card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the WSE card where you want
to change the ethernet settings.

Step 2 Click the Provisioning > Line > Ethernet tabs.

Tabs and parameter selections vary according to pluggable port modules (PPM) provisioning.

Step 3 Modify any of the line settings in the Ethernet tab as described in the table.
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Table 298: WSE Card Ethernet Settings

OptionsDescriptionParameter

--(Display only) Displays the port number
n-n and rate.

Port

--(Display only) Displays the port name.Port Name

• IS (ANSI) or Unlocked (ETSI)

• OOS, DSBLD (ANSI) or Locked,disabled
(ETSI)

• OOS, MT (ANSI) or Locked,maintenance
(ETSI)

• IS, AINS (ANSI) or
Unlocked,AutomaticInService (ETSI)

Sets the port service state unless network
conditions prevent the change. For more
information about administrative states,
see the Administrative and Service States
document.

Admin State

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU, AINS (ANSI) or
Unlocked-disabled, automaticInService
(ETSI)

• OOS-MA, DSBLD (ANSI) or
Locked-enabled,disabled (ETSI)

• OOS-MA, MT (ANSI) or
Locked-enabled,maintenance (ETSI)

• OOS-MA, LPBK&MT (ANSI) or
Locked-enabled,loopback & maintenance
(ETSI)

(Display only) Identifies the autonomously
generated state that gives the overall
condition of the port. Service states appear
in the format: Primary State-Primary State
Qualifier, Secondary State. For more
information about service states, see the
Administrative and Service States
document.

Service State

• Disabled (default)— ALS is off; the laser is
not automatically shut down when traffic
outage or loss of signal (LOS) occurs.

• Manual Restart— ALS is on; the laser
automatically shuts downwhen traffic outage
or LOS occurs. However, the laser must be
manually restarted when conditions that
caused the outage are resolved.

• Manual Restart for Test—Manually restarts
the laser for testing.

Sets the automatic laser shutdown (ALS)
function mode.

ALS Mode

• Duration of valid input signal, in hh.mm
format, after which the card state changes to
in-service (IS) automatically.

• 0 to 48 hours, 15-minute increments.

Sets the automatic in-service (AINS) soak
period. Double-click the time and use the
up and down arrows to change settings.

AINS Soak
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OptionsDescriptionParameter

Autoprovision—The system automatically
provisions the reach from the pluggable port
module (PPM) reach value on the hardware.

Sets the optical reach distance of the client
port.

Reach

• First Tunable Wavelength

• Further wavelengths:

• – 850 nm through 1610 nm

Displays the wavelength of the client port.Wavelength

Numeric. Default: 1548

Range 64 to 9700

Sets the maximum size of the Ethernet
frames accepted by the port. The port must
be in OOS/locked state.

MTU

Transparent(Display-only) Sets the mode of operation.Termination
Mode

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G744 Changing the WSE Card Security Thresholds and Setting
Authentication Error Thresholds

This task changes the security threshold settings of the WSE card. This task
also sets the payload authentication error thresholds.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Security user or security super userSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the WSE card where you want
to change the security threshold settings.

Step 2 Click the Provisioning > Security Thresholds tabs.
Step 3 Modify any of the settings as described in the table.

You must modify each of these options independently: TCA and Alarm, and 15 Min and 1 Day.
To do so, choose the appropriate radio button and click Refresh.

Note
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Table 299: WSE Card Security Threshold Settings

DescriptionParameter

Selects the port number.Port

Shows the number of times the Sequence Number (SEQ) for an AES
packet has differed at the encryption and decryption ends.

Sequence
Mismatch

Step 4 Click Apply.
Step 5 To set the payload authentication error thresholds, go to Provisioning > Security Thresholds tab and click

the Alarm radio button.
Step 6 Enter the authentication error threshold value in the Payload Authentication Error field.

The default value is 1. The range is 1 to 500.

The Payload Authentication Alarm is raised when the payload authentication error PM counter for 10 seconds
in the Encryption PM tab exceeds the payload authentication error value set in the Security Thresholds tab.
The Payload Authentication Alarm is not raised if payload authentication is enabled only on the near end or
far end.

Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).

DLP-G745 Changing the WSE Card Line RMON Thresholds
This task changes the line RMON threshold settings for WSE cards carrying
Ethernet or FC payloads.

Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the WSE card where you want
to change the RMON threshold settings in the card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs.
Step 3 Click Create. The Create Threshold dialog box appears.
Step 4 From the Port drop-down list, choose the applicable port, either the payload port, for example “1-1 (TEN_GE)”

port.
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Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 11-230 for a list of available Ethernet
variables.

Table 300: WSE Card Ethernet Variables

DescriptionVariable

Total number of received packets.rxTotalPkts

Total number of frames received on an interface in both Rx and Tx directions.etherStatsPkts

Total number of octets of data (including those in bad packets) received on the network
(excluding framing bits, but including FCS octets).

etherStatsOctets

Total number of packets received that were longer than 1518 octets (excluding framing
bits, but including FCS octets) and were otherwise well-formed.

etherStatsOversizePkts

Total number of frames received on a particular interface that are an integral number of
octets in length but do not pass the FCS check.

dot3StatsFCSErrors

Total number of frames received on a particular interface that are not an integral number
of octets in length and do not pass the FCS check. This counter is only valid for FEmodes
of operation.

dot3StatsAlignmentErrors

Contains a count of received frames that have an associated RX_ER assertion during a
data reception error event (MII) or data reception error event or carrier extension error
(GMII) from the PCS.

dot3StatsSymbolErrors

Total number of frames received on a particular interface that exceed the maximum
permitted frame size.

dot3StatsFrameTooLong

Number of received line code violations at the PCS layer.dot3StatsLCVErrors/mediaIndStatsRxLcvErrors

Number of Layer 1 errors as defined within the following conditions:

• During Packet Reception—Layer 1 errors are only counted one time per packet.
The Layer 1 error is indicated as a direct result of a line side protocol violation in
which RX_DV is asserted. This is an uncommon event from which may be the
reason why the device loses synchronization.

• During Interpacket Reception—The Layer 1 error is indicated as a direct result of
a line side protocol violation in which RX_DV is de-asserted. This is an uncommon
event. The Layer 1 error is also asserted on detection of a False Carrier indication
and is asserted on detection of Erred byte (interpacket) signal encoding. When the
Layer 1 error is asserted during inter-packet reception, it is only statistically asserted
in the vector.

dot3StatsLayer1Errors

Total number of packets received that were longer than 1518 octets (excluding framing
bits, but including FCS octets), and had either a bad FCS with an integral number of
octets (FCS error) or a bad FCS with a non-integral number of octets (alignment error).

etherStatsJabbers

Total number of packets received that were less than 64 octets long (excluding framing
bits, but including FCS octets) and were otherwise well-formed.

etherStatsUndersizePkts
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DescriptionVariable

Total number of packets received that were less than 64 octets in length (excluding
framing bits, but including FCS octets) and had either a bad FCS with an integral number
of octets (FCS error) or a bad FCSwith a non-integral number of octets (alignment error).
Note that it is entirely normal for etherStatsFragments to increment. This is because
itcounts both runts (which are normal occurrences due to collisions) and noise hits.

etherStatsFragments

Total number of packets (including bad packets) received that were 64 octets in length
(excluding framing bits, but including FCS octets).

etherStatsPkts64Octets

Total number of packets (including bad packets) received that were between 65 and 127
octets in length inclusive (excluding framing bits, but including FCS octets).

etherStatsPkts65to127Octets

Total number of packets (including bad packets) received that were between 128 and 255
octets in length inclusive (excluding framing bits, but including FCS octets).

etherStatsPkts128to255Octets

Total number of packets (including bad packets) received that were between 256 and 511
octets in length inclusive (excluding framing bits, but including FCS octets).

etherStatsPkts256to511Octets

Total number of packets (including bad packets) received that were between 512 and
1023 octets in length inclusive (excluding framing bits, but including FCS octets).

etherStatsPkts512to1023Octets

Total number of packets (including bad packets) received that were between 1024 and
1518 octets in length inclusive (excluding framing bits, but including FCS octets).

etherStatsPkts1024to1518Octets

Total number of good packets received that were directed to a multicast address. Note
that this number does not include packets directed to the broadcast address.

etherStatsMulticastPkts

Total number of good packets received that were directed to the broadcast address. Note
that this number does not include multicast packets.

etherStatsBroadcastPkts

Total number of packets (including bad packets) received that were 1591 octets in length
(excluding framing bits, but including FCS octets).

etherStatsPkts1519tomaxOctets

Total number of packets delivered by this sublayer to a higher sublayer that are not
addressed to a multicast or broadcast address.

ifInUcastPkts

(The counter does not increment for traffic with
incorrect Ethertype and packet size of more than
64 bytes on the WSE card.)

Total number of packets delivered by this sublayer to a higher sublayer that are addressed
to a multicast address. For a MAC layer protocol, this includes both group and functional
addresses.

ifInMulticastPkts

(The counter does not increment for traffic with
incorrect Ethertype and packet size of more than
64 bytes on the WSE card.)

Total number of packets delivered by this sublayer to a higher sublayer that are addressed
to a broadcast address.

ifInBroadcastPkts

(The counter does not increment for traffic with
incorrect Ethertype and packet size of more than
64 bytes on the WSE card.)

Total number of received errors.ifInErrors

Total count of packets transmitted to a unicast group destination address.IfOutUcastPkts
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DescriptionVariable

Total number of packets that higher-level protocols requested to be transmitted, which
were addressed to a multicast address at this sublayer. These include packets that were
discarded or not sent. For a MAC layer protocol, this includes both group and functional
addresses.

ifOutMulticastPkts

Total number of packets that higher-level protocols requested to be transmitted, which
were addressed to a broadcast address at this sublayer. These include packets that were
discarded or not sent.

ifOutBroadcastPkts

Total number of octets transmitted out of the interface, including framing characters.ifOutOctets

Total number of transmitted data frames with payload CRC errors when HDLC framing
is used.

mediaIndStatsTXFramesBadCRC

Number of transmitted frames containing less than the minimum permitted frame size
as programmed with the transmit MAC Min Frame Length Configuration Register.

mediaIndStatsTXShortPkts

Total number of transmitted packets.txTotalPkts

Step 6 Click Apply.
Step 7 Return to your originating procedure (NTP).

DLP-G746 Provisioning the WSE Card with Port Alarm and TCA Thresholds
This task provisions the WSE card with port alarm and TCA thresholds.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the WSE card where you want
to provision the alarm and TCA threshold settings for the port.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

You must modify 15 Min and 1 Day independently. Choose the appropriate radio button and
click Refresh.

Note

Do not modify the Laser Bias parameters.Note

Step 3 If TCA is not selected, select the TCA option and then click Refresh. If it is checked, continue with Step 4.
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Step 4 Verify whether the port TCA thresholds for RX Power High, RX Power Low, TX Power High, and TX Power
Low are set.

Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

Step 5 Under Types, click the Alarm radio button and click Refresh.
Step 6 Verify whether the port alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX Power

Low are set.

Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting it,
entering a new value, and pressing Enter.

Step 7 Click Apply.
Step 8 Return to your originating procedure (NTP).

DLP-G747 Change the WSE Card OTN Settings
This task changes the OTN settings for theWSE card.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite
Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the WSE card where you want
to change the OTN settings.

Step 2 Click the Provisioning >OTN tabs. Choose one of these subtabs: OTN Lines, ITU-T G.709 Thresholds, FEC
Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in the tables.

You must modify each of these options independently: Near End and Far End, 15 Min and 1 Day,
and SM and PM. Choose the appropriate radio button and click Refresh.

Note

The table describes the values on the Provisioning > OTN > OTN Lines tab.

Table 301: WSE Card OTN Line Settings

OptionsDescriptionParameter

All client and trunk ports(Display only) Displays the port number.Port
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OptionsDescriptionParameter

Enabled by defaultSets the OTN lines according to ITU-T G.709.ITU-T G.709

OTN

• Disable

• Standard

• Enhanced

Sets the OTN lines to forward error correction (FEC).

When an OTN cloud is present between two WSE cards
used in stacked card scenario, it is recommended to keep
the same FEC setting on both ends of the OTN cloud to
avoid FEC-MISM alarm on the WSE cards.

FEC

1E-5(Display only) Displays the signal fail (SF) bit error rate
(BER).

SF BER

• 1E-5

• 1E-6

• 1E-7 (Default)

• 1E-8

• 1E-9

Sets the signal degrade (SD) bit error rate (BER).SD BER

• Checked

• Unchecked

Sets the ProvidesSync card parameter. If checked, the card
is provisioned as a NE timing reference.

ProvidesSync

• Checked

• Unchecked

Sets the EnableSync card parameter. Enables
synchronization status messages (S1 byte), which allow
the node to choose the best timing source.

SyncMsgIn

• PRS—Primary Reference
Source

• STU—Sync traceability
unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum
clock

• ST4—Stratum 4

• DUS—Do not use for
timing

• RES—Reserved; quality
level set

Overrides the synchronization status message (SSM) and
the synchronization traceability unknown (STU) value. If
the node does not receive an SSM signal, it defaults to
STU.

Admin SSM
In

The following table describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.
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Table 302: WSE ITU-T G.709 Threshold Settings

OptionsDescriptionParameter

All client and trunk ports(Display only) Displays the
port number.

Port

Numeric. Can be set for Near End or Far End, for 15-minutes or
one-day intervals, or for SM (OTUk) or PM (ODUk). Select an
option and click Refresh.

Errored seconds (ES)ES

Numeric. Can be set for Near End or Far End, for 15-minutes or
one-day intervals, or for SM (OTUk) or PM (ODUk). Select an
option and click Refresh.

Severely errored seconds
(SES)

SES

Numeric. Can be set for Near End or Far End, for 15-minutes or
one-day intervals, or for SM (OTUk) or PM (ODUk). Select an
option and click Refresh.

Unavailable seconds (UAS)UAS

Numeric. Can be set for Near End or Far End, for 15-minutes or
one-day intervals, or for SM (OTUk) or PM (ODUk). Select an
option and click Refresh.

Background block errors
(BBE)

BBE

Numeric. Can be set for Near End or Far End, for 15-minutes or
one-day intervals, or for SM (OTUk) or PM (ODUk). Select an
option and click Refresh.

Failure counter (FC)FC

The following table describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 303: WSE Card FEC Threshold Settings

OptionsDescriptionParameter

All client and trunk ports(Display only) Displays the port
number.

Port

Numeric. Can be set for 15-minutes or one-day
intervals. Select an option and click Refresh.

Sets the value for bit errors corrected.Bit Errors Corrected

Numeric. Can be set for 15-minutes or one-day
intervals. Select an option and click Refresh.

Sets the value for uncorrectable
words.

Uncorrectable
Words

The following table describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 304: WSE Card Trail Trace Identifier Settings

OptionsDescriptionParameter

All client and trunk ports(Display only) Displays the port number.Port

• Section

• Path

Sets the level.Level
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OptionsDescriptionParameter

• Off/None

• Manual

Sets the trace mode.Received Trace
Mode

• Checked (FDI on TTIM is disabled)

• Manual

Unchecked (FDI on TTIM is not disabled)

If a Trace Identifier Mismatch on
Section overhead alarm arises because
of a J0 overhead string mismatch, no
Forward Defect Indication (FDI) signal
is sent to the downstream nodes if this
box is checked.

This field is enabled only if the Received
Trace Mode is set to Manual.

Disable FDI on
TTIM?

• Hex Mode—Click to change the display to
hexadecimal (button changes to ASCII
Mode).

• ASCII Mode—Click to change the display
to ASCII (button changes to Hex Mode).

The button title changes based
on the current display mode.

Note

Displays the current transmit string or
sets a new transmit string.

Transmit

• Hex Mode—Click to change the display to
hexadecimal (button changes to ASCII
Mode).

• ASCII Mode—Click to change the display
to ASCII (button changes to Hex Mode).

The button title changes based
on the current display mode.

Note

Displays the current expected string or
sets a new expected string.

Expected

• Hex Mode—Click to change the display to
hexadecimal (button changes to ASCII
Mode).

• ASCII Mode—Click to change the display
to ASCII (button changes to Hex Mode).

The button title changes based
on the current display mode.

Note

(Display only) Displays the current
received string.

Received

• Checked

• Unchecked

If checked, automatically refreshes the
display every 5 seconds.

Auto-refresh

Step 4 Click Apply.
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Step 5 Return to your originating procedure (NTP).

NTP-G340 Provisioning Encryption on the WSE and MR-MXP
Cards

This procedure enables you to provision encryption on theWSE andMR-MXP
cards.

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTC

• NTP-G338 Provisioning an Operating Mode on the WSE Card

• NTP-G235 Provisioning an Operating Mode, on page 652

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Security super userSecurity Level

The card authentication and payload encryption must be enabled to check Bit Interleaved Parity-8 (BIP-8)
functionality on encrypted traffic.

When BIP-8 functionality is enabled on the MR-MXP card of the source node, the MR-MXP card of the
destination node raises only the ODUk-SD alarm instead of ODUk-SD and ODUk-SF alarms.The WSE card
raises both the ODUk-SD and ODUk-SF alarms for the same scenario.

Note

Procedure

Perform any of the following tasks as needed:

• DLP-G759 Configuring GCC2 Settings

• DLP-G748 Enabling or Disabling Card Authentication, on page 720

• DLP-G749 Enabling Payload Encryption

• DLP-G Enabling Payload Authentication, on page 721

• DLP-G751 Resetting the Primary Key, on page 722

• DLP-G752 Changing the Primary Key Reset Interval, on page 723

• DLP-G753 Setting AES Secure Packet Configuration

• DLP-G754 Specifying ESP Header and Trailer Locations
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• DLP-G755 Enabling PRBS Generation and Monitoring

Stop. You have completed this procedure.

DLP-G759 Configuring GCC2 Settings
This task configures a GCC2 channel on OTN enabled trunk ports to establish
a connection between two WSE or two MR-MXP cards by configuring the IP
address and ports of the source and destination cards.

Purpose

NoneTools/Equipment

DLP-G748 Enabling or Disabling Card Authentication

The card authentication and payload encryption are enabled by default and
cannot be disabled for MR-MXP-K9 and MR-MXP-K9= PIDs.

Prerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-XMP card
for which you want to configure the GCC settings.

Step 2 Go to Provisioning > Encryption > GCC2 Settings.
Step 3 In the Card IP Address field, provide the IP address of the source WSE or MR-MXP card.
Step 4 Click on the Destination Card IP entry. Specify the IP address of the destination card.
Step 5 Click on the Destination Port entry. Specify the port number of the destination card.

There can be multiple destination card IPs and destination ports for WSE card and only a single destination
card IP and destination port for MR-MXP card.

Step 6 Click Apply.

To change the MR-MXP or WSE card role from primary to secondary and vice versa:

a. Remove only the card IP address or only the destination card IP address or both.

b. Modify or configure the required IP address in the Card IP Address or Destination Card IP field.

Step 7 Return to your originating procedure (NTP).
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DLP-G748 Enabling or Disabling Card Authentication
This task initiates the authentication of a destination WSE or MR-MXP card
with a source WSE or MR-MXP card. This ensures that the source card
communicates only with the destination card.

The card authentication and payload encryption are enabled by default and
cannot be disabled for MR-MXP-K9 and MR-MXP-K9= PIDs.

Purpose

NoneTools/Equipment

NonePrerequisite Procedures

RequiredRequired/As Needed

Onsite or RemoteOnsite/Remote

Security Super UserSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-MXP card
for which you need to enable or disable card authentication.

Step 2 Go to Provisioning > Encryption > Security.
Step 3 (Only for WSE card) From the Port list, choose the port on which card authentication is to be enabled or

disabled.
Step 4 Check the Card Authentication checkbox to enable card authentication.

Uncheck the Card Authentication checkbox to disable card authentication.

The primary key for encryption is exchanged between the source and destination WSE or MR-MXP cards.

Step 5 Click Apply.
Step 6 (Only for WSE card) Repeat step 3 to step 5 for every port that carries the encrypted payload, as the card

authentication takes place independently on each port of the source WSE card.
Step 7 Return to your originating procedure (NTP).

DLP-G749 Enabling Payload Encryption
This task enables encryption of OTN frames emerging from a port of the source
WSE or MR-MXP card.

Purpose

NoneTools/Equipment
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• DLP-G759 Configuring GCC2 Settings, on page 719

• DLP-G748 Enabling or Disabling Card Authentication, on page 720

The card authentication and payload encryption are enabled by default and
cannot be disabled for MR-MXP-K9 and MR-MXP-K9= PIDs.

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or RemoteOnsite/Remote

Security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-MXP card
for which you want to enable payload encryption.

Step 2 Go to Provisioning > Encryption > Security.
Step 3 Check the Payload Encryption check box to enable encryption of the OTN frames.

In WSE card, do not enable encryption with far-end client loopback. This affects the traffic. In MR-MXP
card, the client loopback is disabled when encryption is enabled.

When encryption is enabled in the near end and disabled in the far end, the client port of MR-MXP card raises
Local Fault (LF) and the client port of WSE card raises SYNCLOSS alarm.

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G Enabling Payload Authentication
This task enables payload authentication on the MR-MXP card to validate the
integrity of the received payloads.

The payload authentication is enabled by default and can be disabled for
MR-MXP-K9 and MR-MXP-K9= PIDs of MR-MXP card.

Purpose

NoneTools/Equipment

• DLP-G748 Enabling or Disabling Card Authentication
• DLP-G749 Enabling Payload Encryption

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or RemoteOnsite/Remote

Super userSecurity Level
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Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click theMR-MXP card for which
you want to enable payload authentication.

Step 2 Go to Provisioning > Encryption > Security tab.
Step 3 Check the Payload Authentication check box to enable payload authentication and click Apply.
Step 4 Return to your originating procedure (NTP).

DLP-G751 Resetting the Primary Key
This task lets you reset the primary key for each encrypted stream of the source
WSE or MR-MXP card.

For more information, see Key Management, on page 304.

Purpose

NoneTools/Equipment

• DLP-G748 Enabling or Disabling Card Authentication, on page 720
• DLP-G749 Enabling Payload Encryption, on page 720

Prerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security user or security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-MXP card
for which you want to reset the primary key.

Step 2 Go to Provisioning > Encryption > Key Management.
Step 3 (For WSE card) Click the Reset Master Key button for a port to reset the primary key used for the payload

encryption on that port.

(For MR-MXP card) Click the Reset Master Key button to reset the primary key used for the payload
encryption on the card.

By resetting the primary key, a key exchange is enforced by overriding the existing primary key reset interval,
and a new interval is calculated from the time the key is reset.

Step 4 Check the TCA on Key Reset check box to raise TCA notification indicating MASTERKEY-SUCCESS
transient condition of the payload on a port listed in the Port column.

When this check box is checked on both the near end and far end, the Alarms and History tabs are updated
with TCA notifications on both the near end and far end in the specified key change interval. Two key resets
occur in every key reset interval.

Step 5 Click Apply.
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Step 6 Return to your originating procedure (NTP).

DLP-G752 Changing the Primary Key Reset Interval
This task lets you change the primary key reset interval between two consecutive
resets of the primary key that is used for payload encryption.

Purpose

NoneTools/Equipment

• DLP-G748 Enabling or Disabling Card Authentication, on page 720
• DLP-G749 Enabling Payload Encryption, on page 720

Prerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security user or security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-MXP card
for which you want to change the primary key reset interval.

Step 2 Go to Provisioning > Encryption > Key Management.
Step 3 Click on the Master Key Change Interval entry. For WSE card, two spin boxes appear in place of the entry

and for MR-MXP card, four spin boxes appear.

For WSE card, the box on the left registers the time in hours; the box on the right, the time in minutes. For
MR-MXP card, four boxes register the time in days, hours, minutes, and seconds.

For WSE card, the primary key interval can be set in multiples of 15 minutes between 15 minutes to 48 hours.
For MR-MXP card, the primary key interval can be set between 50 seconds and 48 hours.

Step 4 Set the desired values in the boxes.

When the time interval elapses, a new primary key is exchanged between the source and destination WSE or
MR-MXP cards.

Step 5 Check the TCA on Key Reset check box to raise TCA notification indicating MASTERKEY-SUCCESS
transient condition of the payload on a port listed in the Port column.

When this check box is checked on both the near end and far end, the Alarms and History tabs are updated
with TCA notifications on both the near end and far end in the specified key change interval. Two key resets
occur in every key reset interval.

Step 6 Click Apply.
Step 7 Return to your originating procedure (NTP).

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
723

Provisioning Transponder and Muxponder Cards
DLP-G752 Changing the Primary Key Reset Interval



DLP-G753 Setting AES Secure Packet Configuration
This task configures the number of OTN frames per AES secure packet. The
AES secure packet for each port can be made up of 4 or 8 OTN frames. For
more information, see AES Secure Packet, on page 305

Purpose

NoneTools/Equipment

• DLP-G759 Configuring GCC2 Settings, on page 719

• Disable Card Authentication for MR-MXP Card

The card authentication and payload encryption are enabled by default and
cannot be disabled for MR-MXP-K9 and MR-MXP-K9= PIDs.

Prerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-MXP card
for which you want to set the AES secure packet configuration.

Step 2 Go to Provisioning > Encryption > OTN Overhead for Packet traffic.
Step 3 Click on the AES Secure Packet entry corresponding to the port where the AES secure packet must be

configured. A dropdown list appears.
Step 4 From the drop-down list, choose either 4 OTN Frame Based or 8 OTN Frame Based.
Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).

DLP-G754 Specifying ESP Header and Trailer Locations
This task specifies the location of the ESP (Encapsulating Security Payload)
Header and Trailer in each OTN frame of the AES secure packet.

Purpose

NoneTools/Equipment

• DLP-G759 Configuring GCC2 Settings, on page 719

• Disable Card Authentication for MR-MXP Card

The card authentication and payload encryption are enabled by default and
cannot be disabled for MR-MXP-K9 and MR-MXP-K9= PIDs.

Prerequisite Procedures

As NeededRequired/As Needed
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Onsite or RemoteOnsite/Remote

Security super userSecurity Level

Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-MXP card
for which you want to specify the ESP header and trailer locations.

Step 2 Go to Provisioning > Encryption > OTN Overhead for Packet traffic.
Step 3 Click on the ESP Header Location entry corresponding to a port.

The locations available are A, B, C, D, E and F. The default values of ESP Header Location and ESP Trailer
Location are location A. The ESP header and trailer require a total of 32 bytes within the OTN overhead.

Step 4 Choose the ESP header location from the predefined values in the list.

The ESP Trailer Location is updated to match the location of the ESP header.

Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).

DLP-G755 Enabling PRBS Generation and Monitoring
This task lets you enable PRBS generation at the ingress, and PRBSmonitoring
at the egress of each port for the source and destination WSE or MR-MXP
cards.

For MR-MXP card, PRBS Generation and Monitoring is possible only when
card authentication and payload encryption are disabled.

Purpose

NoneTools/Equipment

• DLP-G759 Configuring GCC2 Settings, on page 719

• Disable Card Authentication and Payload Encryption for MR-MXP Card

The card authentication and payload encryption are enabled by default and
cannot be disabled for MR-MXP-K9 and MR-MXP-K9= PIDs.

Prerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security super userSecurity Level

PRBS does not work for WSE card when client loopback is enabled.Note
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Procedure

Step 1 In node view (single shelf mode), or shelf view (multi-shelf mode), double-click the WSE or MR-MXP card
for which you want to enable PRBS generation and PRBS monitoring.

Step 2 Go to Provisioning > Encryption > OTN Overhead for Packet traffic.
Step 3 Check the Ingress PRBS Generator check box for a port to enable PRBS generation at the ingress of that

port. The ingress of a port is the data path in the encryption block.
Step 4 Check the Egress PRBS Monitor check box for a port to enable PRBS monitoring at the egress of that port.

The egress of a port is the data path in the decryption block.
Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).

NTP-G342 Provisioning FIPS and CC Mode
This procedure lets you enable the FIPS and CC mode on the node.Purpose

NoneTools/Equipment

NonePrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Security super userSecurity Level

Provisioning a FIPS and CC mode is not supported in Macintosh computers.Note

Procedure

Perform any of the following tasks as needed:

• DLP-G761 Enabling FIPS and CC Mode, on page 727

Stop. You have completed this procedure.
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DLP-G761 Enabling FIPS and CC Mode
This task lets you enable the Federal Information Processing Standard (FIPS)
mode and Common Criteria (CC) for the node. The CTC can be run in FIPS
and CC mode. It supports FIPS 140-2 level 2 standards of encryption and
cryptographic services. The CC certification ensures that the node is accessed,
managed, monitored and provisioned in a highly secure manner. In the FIPS
and CC mode, only the algorithms that are approved by FIPS and CC can be
run. When the FIPS and CC mode is selected, the node reboots and performs
a self-test at startup.

Use this procedure with caution. Running FIPS and CC mode in
a multi-shelf node with the WSE card in the primary shelf, might
lead to loss of control with the secondary shelfs if a problem
occurs.

Note

Purpose

NoneTools/Equipment

• DLP-G46 Log into CTCPrerequisite Procedures

As NeededRequired/As Needed

Onsite or RemoteOnsite/Remote

Security super userSecurity Level

When FIPS mode is enabled during CTC startup, CTC cache directory path must not contain any space in the
Settings > Cache tab. Otherwise, CTC cannot be launched successfully.

Note

Procedure

Step 1 Select the node for which you want to enable FIPS and CC mode.
Step 2 Secure all the access points:

a) In the node view, click Provisioning > Security > Access.
b) Change the Access State of Pseudo IOS Access, Shell Access, EMS Access, TL1 Access , and SNMP

Access to Secure state.
c) Click Apply.

Step 3 Click the FIPS and CC tab.
Step 4 Select the FIPS and CC Mode check box to enable FIPS and CC mode for that node.

In a situation that warrants a breach into the system, the system can be protected by erasing the
private keys. To erase all the private keys in the WSE, MR-MXP, and TNC cards, click Zeroise
Key. A warning message is displayed with details about the consequence of zeroizing the keys.
This will rewrite all the private keys with zeros. This implementation for the private keys is a
requirement as per the FIPS 140-2 compliance.

Caution
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Step 5 Click Apply.
Step 6 Return to your originating procedure (NTP).

DLP-G760 Configuring Management of FIPS and CC Mode Enabled NE
This task configures the requirements to manage the Federal Information
Processing Standard (FIPS) and Common Criteria (CC) mode enabled network
element.

This procedure also applies to EMS and Shell Secure mode.

Purpose

NoneTools/Equipment

NonePrerequisite Procedures

Required to use the FIPS and CC modeRequired/As Needed

Onsite or RemoteOnsite/Remote

NoneSecurity Level

Procedure

Step 1 Install JRE version 7.0.
a) Uninstall previous versions of JREs from the control panel.
b) Restart the computer.
c) Download and install the latest JRE version 7.0. for Windows x64.

Step 2 Go to Java Control Panel and click the Advanced tab. Expand Security > General settings. Perform these
actions:
a) Uncheck the Use SSL 3.0 check box.
b) Check the Use TLS 1.0 check box.

Step 3 In the Java Control Panel, click the General tab. Click Settings and perform these actions to clear the JNLP
cache:
a) Clear the Keep temporary files on my computer check box.
b) Click Delete Files.
c) Select the files to delete and click OK.
d) Click OK and exit the Java Control Panel.

Step 4 Install Java Cryptography Extension (JCE)version 7.0.
a) Download the JCE.
b) Extract the contents of the downloaded policy file.
c) Copy and overwrite the security policy file to C:\Program Files\Java\jre7\lib\security\.

<java-home>/lib/security [Unix]

<java-home>\lib\security [Win32]
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where <java-home> is the location where the Jave SE Runtime Environmen (JRE) is installed.

Step 5 Configure the browser settings:

• Chrome browser settings:

a. Go to Chrome > Settings.

b. Click the Open Proxy settings and click the Advanced tab.

c. Uncheck the Use SSL 3.0 check box.

d. Check the Use TLS 1.0 check box and click OK.

• Firefox browser settings:

a. Go to Mozilla Firefox.

b. Type about:config in the Address bar.

c. Type TLS in the Search box.

d. Enter the value for security.tls.version.max as 0, 1, 2, 3, where 0 refers to SSL 3.0, 1 refers to TLS
1.0, 2 refers to TLS 1.1, 3 refers to TLS 1.2, and so on.

e. Enter the value for security.tls.version.min as 0, 1, 2,3, where 0 refers to SSL 3.0, 1 refers to TLS
1.0, 2 refers to TLS 1.1, 3 refers to TLS 1.2, and so on.

Click OK twice.

Step 6 Return to your originating procedure (NTP).

NTP-G363 Provisioning LSC on Cards
Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

RemoteOnsite/Remote

Security super userSecurity Level

You cannot provision LSCs on MR-MXP trunk cards configured in the 100G-B2B mode.Note
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Procedure

Step 1 Complete DLP-G803 Installing Locally Significant Certificates on Cards, on page 730, as needed.
Step 2 Complete DLP-G804 Switching Between LSC and MIC on Cards, on page 732, as needed.
Step 3 Complete DLP-G805 Viewing Certificates , on page 733, as needed.

Stop. You have completed this procedure.

DLP-G803 Installing Locally Significant Certificates on Cards
Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

Secure the Shell Access and EMS Access.

1. In the node view, click Provisioning > Security > Access.

2. Change the Access State of Shell Access, and EMSAccess to Secure State.

3. Click Apply.

Prerequisite Procedures

As neededRequired/As Needed

RemoteOnsite/Remote

Security super userSecurity Level

Ensure the size of each certificate (SUDI, MID, and ROOT) does not exceed 2000 bytes on WSE, MR-MXP,
and 400G-XP-LC cards.

Note

Procedure

Step 1 In the node view (single-shelf mode) or shelf view (multishelf view), click Provisioning > Certificate >
Certificate tabs.

Step 2 To generate the CSR file, perform the following steps:
a) Click Generate.

The Generate Certificate dialog box appears.

b) Select the Shelf ID, Slot ID, Encryption Algorithm, and Hashing from the drop-down lists.
c) Enter the name in the Common Name text box.

This name must be the same on both the near-end and far-end cards.
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d) (Optional) Click Additional Details.
e) Enter theCountry Name, State Name,Locality Name,Organization Name,Organization Unit Name,

and Mail ID in the corresponding text box.
f) Click Ok.

When the user changes the Shelf ID of SSC through the LCD, the shelf and slot numbers for all
the LSC entries of cards in a shelf might not be updated. The shelf and slot numbers might report
as Not Applicable (N/A). It is recommended to reset the card or to delete the LSC entry and create
it again.

Note

After the CSR file is generated, you can view the certificate details by right-clicking on it and selecting View
Details.

If the CSR generation fails, the Comments/Errors field is updated.

Step 3 To export the CSR file, perform the following steps:
a) Select the certificate and click Export.

The Certificate Export dialog box appears.

b) Click Browse to navigate to a local or network drive where you want to save the file.
c) Select the File Type from the drop-down list.
d) Click Ok.

The exported certificate is sent to the Certification Authority (CA) for generation of the LSC.

Step 4 To make CA sign the CSR request, you must enter the following X509v3 extension information in the
certificate:

Table 305: X509v3 Extension Information in Certificate

ExampleDescriptionX509v3 Extension Field in
the Certificate

Open SSL Config File Field

basicConstraints=CA:FALSESpecifies to avoid
interpreting an end user
certificate as a CA
certificate.

X509v3 Basic ConstraintsbasicConstraints

nsComment=”open ssl
generated certificate”

Displays the Netscape
comment

Netscape CommentnsComment

subjectKeyIdentifier=
hash

Specifies the key hash of
the certificate

X509v3 Subject Key
Identifier

subjectKeyIdentifier

authorityKeyIdentifier=
keyid,issuer

Specifies the key hash of
the issuer certificate

X509v3 Authority Key
Identifier

authorityKeyIdentifier

keyUsage =
critical,nonRepudiation,
digitalSignature,
keyEncipherment

Specifies the key usage
for a client certificate

X509v3 Key UsagekeyUsage
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ExampleDescriptionX509v3 Extension Field in
the Certificate

Open SSL Config File Field

nsCertType =
client,server,email

Specifies to include client
and server

If this field is not
populated, then the
certificate can be used for
anything other than object
signing

X509v3 Extended Key
Usage

nsCertType

This enables CA sign the CSR request in the certificate.

Step 5 To import the locally signed certificates from local or network drive into the system, perform the following
steps:
a) Select the certificate and click Import.

The Certificate Import dialog box appears.

b) Select the Certificate Format and No. of Files from the drop-down lists.
c) Browse and select the files.

Import the signed files in this sequence: SUDI, MID, and ROOT files.

d) Click Ok.

If the certificate import fails, the Comments/Errors field is updated.

Step 6 To install and switch to the locally signed certificates in the line card, perform the following steps:
a) Select the certificate and click Install & Switch.

The Certificate Install & Switch warning message is displayed.

b) Check the Auto delete after Install check box to auto-delete the entries after installation.
c) Click Ok.

The certificate undergoes a verification phase where the expired certificates are not installed. If the
verification is successful, the certificate is installed in the line card. After installation, it switches from
the MIC certificate to the LSC certificate.

Step 7 Return to your originating procedure (NTP).

DLP-G804 Switching Between LSC and MIC on Cards
Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

DLP-G803 Installing Locally Significant Certificates on Cards, on page 730

Prerequisite Procedures

As neededRequired/As Needed
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RemoteOnsite/Remote

Security super userSecurity Level

When the certificate option is switched from MIC to LSC on the client or server MR-MXP card, there is a
peer certification mismatch between the client and server MR-MXP cards. This causes the
PEER-CERT-VERIFICATION-FAILED alarm to be raised on the client MR-MXP card.

Note

Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card where you want to
change the certificate being used. The card view appears.

Step 2 In the card view, click Provisioning > Certificate > Maintenance tabs.
Step 3 In the Certificate Options area:

• Click the Use LSC (Locally Significant Certificate) radio button to switch to LSC for the card.

The LSC-NOT-PRESENT-MIC-IN-USE alarm is raised when the LSC is not installed on
the card and this option is selected in CTC. To generate and install the LSC, see DLP-G803
Installing Locally Significant Certificates on Cards, on page 730.

Note

• Click the Use MIC (Manufacturing Installed Certificate) radio button to switch to MIC for the card.

Step 4 Click Apply.
Step 5 Return to your originating procedure (NTP).

DLP-G805 Viewing Certificates
Purpose

NoneTools/Equipment

DLP-G46 Log into CTC

#unique_665

Prerequisite Procedures

As neededRequired/As Needed

RemoteOnsite/Remote

Security super userSecurity Level
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Procedure

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the card. The card view appears.
Step 2 In the card view, click Provisioning > Certificate > Details tabs.

The Certificate List Details area displays the certificate type (MIC/LSC) that is in use. You can choose a
level and view the certificate (in X.509 format) for that level.

Step 3 Return to your originating procedure (NTP).

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
734

Provisioning Transponder and Muxponder Cards
DLP-G805 Viewing Certificates



A P P E N D I X A
Configuring GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE Cards Using PCLI

The information in this chapter is in a new location. See Configure GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE Cards Using PCLI for information on how to provision GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards using Pseudo Command Line Interface (PCLI).
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A P P E N D I X B
Pseudo Command Line Interface Reference

The information in this chapter is in a new location. See Pseudo Command Line Interface Reference for
information related to Pseudo-IOS command line interface (PCLI) for GE_XP, 10GE_XP, GE_XPE, and
10GE_XPE cards.
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A P P E N D I X C
Card Features

This chapter describes features common to the Cisco ONS 15454 suite of cards.

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.Note

The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, Cisco
ONS 15454 M2 platforms, unless noted otherwise.

Note

In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to the
15454-M-RAMAN-COP card.

Note

In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card.

Note

• Automatic Laser Shutdown, on page 740
• Card-Level Indicators, on page 740
• Port-Level Indicators, on page 743
• Client Interface, on page 749
• DWDM Interface, on page 750
• DWDM Trunk Interface, on page 750
• FEC, on page 751
• Timing Synchronization, on page 754
• Multiplexing Function, on page 756
• SONET/SDH Overhead Byte Processing, on page 756
• Client Interface Monitoring, on page 756
• Jitter, on page 757
• Lamp Test, on page 757
• NTP-G335 Performing Lamp Test, on page 757
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• Onboard Traffic Generation, on page 758
• Performance Monitoring, on page 758
• Distance Extension, on page 758
• Interoperability with Cisco MDS Switches, on page 758
• Client and Trunk Ports, on page 758
• Automatic Power Control, on page 759
• Alarms and Thresholds, on page 759
• Card Protection, on page 759
• Far-End Laser Control, on page 765
• Jitter Considerations, on page 766
• Termination Modes, on page 766

Automatic Laser Shutdown
The Automatic Laser Shutdown (ALS) procedure is supported on both client and trunk interfaces. On the
client interface, ALS is compliant with ITU-T G.664 (6/99). On the data application and trunk interface, the
switch on and off pulse duration is greater than 60 seconds and is user-configurable.

For information on ALS provisioning, refer the following procedures, as necessary:

• NTP-G162 Changing the ALS Maintenance Settings

• DLP-G203 Changing the ALS Maintenance Settings for OSCM and OSC-CSM Cards

• DLP-G322 Changing the ALS Maintenance Settings for OPT-BST Card

Card-Level Indicators
Multiple colored LEDs indicate the status of the card.

Card-level LEDs for Transponder, Muxponder and Control Cards
The following table lists the three card-level LEDs on the following cards:

• TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE/TNCS

• TXP_MR_10G and TXP_MR_10E

• TXP_MR_10E_C and TXP_MR_10E_L

• TXP_MR_2.5G and TXPP_MR_2.5G

• 40E-TXP-C and 40ME-TXP-C

• MXP_2.5G_10G and MXP_2.5G_10E

• MXP_2.5G_10E_C and MXP_2.5G_10E_L

• MXP_MR_2.5G and MXPP_MR_2.5G

• MXP_MR_10DME_C and MXP_MR_10DME_L
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• 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C

• GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE

• ADM-10G

• OTU2_XP

• TXP_MR_10EX_C

• MXP_2.5G_10EX_C

• MXP_MR_10DMEX_C

• PSM

• TDC-CC and TDC-FC

• AR_MXP, AR_XP, and AR_XPE

• 100G-LC-C, 10x10G-LC, CFP-LC, 100G-ME-C, 100G-CK-C, 100GS-CK-LC, , 200G-CK-LC,
100ME-CKC, 400G-XP-LC

Table 306: Card-Level Indicators

DescriptionCard-Level LED

Red indicates that the card’s processor is not ready. This LED is on during reset.
The FAIL LED flashes during the boot process. Replace the card if the red FAIL
LED persists.

FAIL LED (Red)

Green indicates that the card is operational (one or both ports active) and ready to
carry traffic.

Amber indicates that the card is operational and in standby (protect) mode.

ACT/STBY LED

Green (Active)

Amber (Standby)

Amber indicates a signal failure or condition such as loss of signal (LOS), loss of
frame (LOF), or high bit error rates (BERs) on one or more of the card’s ports. The
amber SF LED is also illuminated if the transmit and receive fibers are incorrectly
connected. If the fibers are properly connected and the link is working, the LED
turns off.

SF LED (Amber)

Card-level LEDs on the AIC-I Card
Table 307: Card-Level Indicators on the AIC-I Card

DescriptionCard-Level LEDs

Indicates that the card’s processor is not ready. The FAIL LED is on during reset
and flashes during the boot process. Replace the card if the red FAIL LED persists.

Red FAIL LED

Indicates the AIC-I card is provisioned for operation.Green ACT LED
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DescriptionCard-Level LEDs

The PWR A LED is green when a supply voltage within a specified range has
been sensed on supply input A. It is red when the input voltage on supply input
A is out of range.

Green/Red PWR A LED

The PWR B LED is green when a supply voltage within a specified range has
been sensed on supply input B. It is red when the input voltage on supply input
B is out of range.

Green/Red PWR B LED

The INPUT LED is yellow when there is an alarm condition on at least one of
the alarm inputs.

Yellow INPUT LED

The OUTPUT LED is yellow when there is an alarm condition on at least one of
the alarm outputs.

Yellow OUTPUT LED

The RING LED on the local orderwire (LOW) side is flashing green when a call
is received on the LOW.

Green RING LED

The RING LED on the express orderwire (EOW) side is flashing green when a
call is received on the EOW.

Green RING LED

Card-level LEDs on the MS-ISC-100T Card
Table 308: Card-Level Indicators on the MS-ISC-100T Card

DescriptionCard-Level LEDs

The red FAIL LED indicates that the card processor is not ready or that a
catastrophic software failure occurred on the card. As part of the boot sequence,
the FAIL LED is turned on until the software deems the card operational.

FAIL LED (Red)

The green ACT LED provides the operational status of the card. If the ACT LED
is green, it indicates that the card is active and the software is operational.

ACT LED (Green)

Card-level LEDs on the Multiplexer, Demultiplexer and Optical Amplifier Cards
The following table lists the card-level LEDs on the following cards:

• 32MUX-O and 32DMX-O

• 4MD-xx.x

• OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L

• OPT-AMP-L, OPT-AMP-17-C, and OPT-AMP-C

• OPT-RAMP-C and OPT-RAMP-CE

• 32WSS and 32WSS-L

• 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, and 40-MUX-C
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• 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, and 16-WXC-FS

• 40-SMR1-C, 40-SMR2-C, 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS

• MMU

• OPT-EDFA-17 and OPT-EDFA-24

• EDRA-1-26, EDRA-1-35, EDRA-2-26, and EDRA-2-35

Table 309: Card-Level Indicators

DescriptionCard-Level Indicators

The red FAIL LED indicates that the card’s processor is not ready or that there
is an internal hardware failure. Replace the card if the red FAIL LED persists.

Red FAIL LED

The green ACT LED indicates that the card is carrying traffic or is traffic-ready.Green ACT LED

The amber SF LED indicates a signal failure on one or more of the card’s ports.
The amber SF LED also illuminates when the transmit and receive fibers are
incorrectly connected. When the fibers are properly connected, the light turns
off.

Amber SF LED

Card-level LEDs on OSCM and OSC-CSM Cards
Table 310: Card-Level Indicators on the OSCM and OSC-CSM Cards

DescriptionCard-Level Indicators

The red FAIL LED indicates that the card’s processor is not ready or that there
is an internal hardware failure. Replace the card if the red FAIL LED persists.

Red FAIL LED

The green ACT LED indicates that the OSCM or OSC-CSM is carrying traffic
or is traffic-ready.

Green ACT LED

The amber SF LED indicates a signal failure or condition such as loss of signal
(LOS), loss of frame alignment (LOF), line alarm indication signal (AIS-L), or
high BER on one or more of the card’s ports. The amber signal fail (SF) LED
also illuminates when the transmit and receive fibers are incorrectly connected.
When the fibers are properly connected, the light turns off.

Amber SF LED

Port-Level Indicators

Port-level LEDs
For the following cards, the status of the card ports is indicated on the LCD screen of the ONS 15454 fan-tray
assembly that displays the number and severity of alarms for a given port or slot.

• OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L
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• OPT-AMP-L, OPT-AMP-17-C, and OPT-AMP-C

• OPT-RAMP-C and OPT-RAMP-CE

• RAMAN-CTP and RAMAN-COP

• EDRA-1-26, EDRA-1-35, EDRA-2-26, and EDRA-2-35

• OSCM and OSC-CSM

• 32MUX-O and 32DMX-O

• 4MD-xx.x

• 32WSS and 32WSS-L

• 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, and 40-MUX-C

• 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, and 16-WXC-FS

• 40-SMR1-C, 40-SMR2-C, 17 SMR9 FS, 24 SMR9 FS, 34 SMR9 FS, and SMR20 FS

• MMU

• OPT-EDFA-17 and OPT-EDFA-24

In some cards, multiple colored LEDs indicate the status of the port.

Port-Level LEDs for AR_MXP, AR_XP, and AR_XPE cards depend on the configured card mode.

The following table lists the port-level LEDs on the following cards:

• TXP_MR_10E, TXP_MR_10E_C, and TXP_MR_10E_L

• TXP_MR_2.5G and TXP_MR_10EX_C

• 40E-TXP-C and 40ME-TXP-C

• MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C

Table 311: Port-Level Indicators

DescriptionPort-Level LED

The green Client LED indicates that the client port is in service and that it is
receiving a recognized signal. The MXP_2.5G_10E, MXP_2.5G_10E_C,
MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards have four client ports, and
so have four client LEDs.

Green Client LED

The green DWDM LED indicates that the DWDM port is in service and that it
is receiving a recognized signal.

Green DWDM LED
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Port-level LEDs on the TXP_MR_10G and MXP_2.5G_10G Cards
Table 312: Port-Level Indicators on the TXP_MR_10G and MXP_2.5G_10Gcards

DescriptionPort-Level LED

The green Client LED indicates that the client port is in service and that it is
receiving a recognized signal. The MXP_2.5G_10G card has four client ports,
and so has four client LEDs.

Green Client LED

The green DWDM LED indicates that the DWDM port is in service and that it
is receiving a recognized signal.

Green DWDM LED

Each port supports two wavelengths on the DWDM side. Each wavelength LED
matches one of the wavelengths. This LED indicates that the card is configured
for Wavelength 1.

GreenWavelength 1 LED

Each port supports two wavelengths on the DWDM side. Each wavelength LED
matches one of the wavelengths. This LED indicates that the card is configured
for Wavelength 2.

GreenWavelength 2 LED

Port-level LEDs on the TXPP_MR_2.5G Card
Table 313: Port-Level Indicators on the TXPP_MR_2.5G card

DescriptionPort-Level LED

The green Client LED indicates that the client port is in service and that it is
receiving a recognized signal.

Green Client LED

The green DWDMALED indicates that the DWDMA port is in service and that
it is receiving a recognized signal.

Green DWDM A LED

The green DWDMB LED indicates that the DWDMB port is in service and that
it is receiving a recognized signal.

Green DWDM B LED

Port-level LEDs on the GE_XP, 10DME and 40G Cards
The following table lists the port-level LEDs on the following cards:

• GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE

• MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C

• 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C
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Table 314: Port-Level Indicators

DescriptionPort-Level LED

Green—The client port is either in service and receiving a recognized signal (that
is, no signal fail), or Out of Service and Maintenance (OOS,MT or locked,
maintenance) in which case the signal fail and alarms will be ignored.

Red—The client port is in service but is receiving a signal fail (LOS).

Amber—The port is provisioned and in a standby state.

Off—The SFP is either not provisioned, out of service, not properly inserted, or
the SFP hardware has failed.

Port LEDs (eight LEDs,
four for each group, one
for each SFP/XFP)

Green/Red/Amber/Off

The green DWDM LED indicates that the DWDM port is in service and that it is
receiving a recognized signal.

Green DWDM LED

Port-level LEDs on the MXP_MR_2.5G and MXPP_MR_2.5G Cards
Table 315: Port-Level Indicators on the MXP_MR_2.5G and MXPP_MR_2.5G cards

DescriptionPort-Level LED

Green indicates that the port is carrying traffic (active) on the interface. Amber
indicates that the port is carrying protect traffic (MXPP_MR_2.5G). Red indicates
that the port has detected a loss of signal.

Client LEDs (eight LEDs)

Green indicates that the card is carrying traffic (active) on the interface.

A red LED indicates that the interface has detected an LOS or LOC.

DWDM LED
(MXP_MR_2.5G)

Green (Active)

Red (LOS)

Green indicates that the card is carrying traffic (active) on the interface.

When the LED is amber, it indicates that the interface is carrying protect traffic
in a splitter protection card (MXPP_MR_2.5G).

A red LED indicates that the interface has detected an LOS or LOC.

DWDMA and DWDMB
LEDs (MXPP_MR_2.5G)

Green (Active)

Amber (Protect Traffic)

Red (LOS)

Port-level LEDs on the ADM-10G and OTU2_XP Cards

Client or trunk ports can each be in active or standby mode as defined in the related section for each specific
protection type. For example, fiber-switched protection has active or standby trunk ports; 1+1 APS protection
has active or standby client ports, and client 1+1 protection does not utilize active or standby ports.

Note
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Table 316: Port-Level Indicators on the ADM-10G and OTU2_XP cards (client and trunk ports)

Tri-color LED DescriptionPort-Level Status

• If a port is in OOS/locked state for any reason, the LED is turned off.

• If a port is in IS/unlocked state and the PPM is preprovisioned or is physically
equipped with no alarms, the LED is green.

• If a port is in IS state and the PPM is physically equipped but does have
alarms, the LED is red.

The port-level LED is
active and unprotected.

• If a port is in OOS/locked state for any reason, the LED is turned off.

• If a port is in the IS/unlocked state and the PPM is preprovisioned or is
physically equipped with no alarms, the LED is amber.

• If a port is in IS state and physically equipped but does have alarms, the
LED is red.

The port-level LED is in
standby.

Port-level LEDs on the 100G-LC-C, 10x10G-LC, CFP-LC, 100GS-CK-LC,
200G-CK-LC, 100G-CK-C, 100G-ME-C, 100ME-CKC, and 400G-XP-LC Cards

Table 317: Port-Level Indicators

DescriptionPort-Level LED

Green—The client port is either in service and receiving a recognized signal (that
is, no signal fail), or Out of Service and Maintenance (OOS,MT or locked,
maintenance) in which case the signal fail and alarms will be ignored.

Red—The client port is in service but is receiving a signal fail (LOS).

Amber—The port is provisioned and in a standby state.

Off—The pluggable is either not provisioned, out of service, not properly inserted,
or the pluggable hardware has failed.

Port LEDs (

Green/Red/Amber/Off

Green indicates that the card is carrying traffic (active) on the interface.

When the LED is amber, it indicates that the interface is carrying protect traffic in
a splitter protection card.

A red LED indicates that the interface has detected an LOS or LOF.

DWDM LED

Green (Active)

Amber (Protect Traffic)

Red (LOS)
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Power-level LEDs on the Control Cards
Table 318: Power-Level Indicators on the Control Cards

DefinitionPower-Level LEDs

The PWR A LED is green when the voltage on supply input A is between the
low battery voltage (LWBATVG) and high battery voltage (HIBATVG)
thresholds. The LED is amber when the voltage on supply input A is between
the high battery voltage and extremely high battery voltage (EHIBATVG)
thresholds or between the low battery voltage and extremely low battery voltage
(ELWBATVG) thresholds. The LED is red when the voltage on supply input A
is above extremely high battery voltage or below extremely low battery voltage
thresholds.

Green/Amber/Red PWR
A LED

The PWR B LED is green when the voltage on supply input B is between the
low battery voltage and high battery voltage thresholds. The LED is amber when
the voltage on supply input B is between the high battery voltage and extremely
high battery voltage thresholds or between the low battery voltage and extremely
low battery voltage thresholds. The LED is red when the voltage on supply input
B is above extremely high battery voltage or below extremely low battery voltage
thresholds.

Green/Amber/Red PWR
B LED

The power-level LEDs are either green or red. The LED is green when the voltage on supply inputs is between
the extremely low battery voltage and extremely high battery voltage thresholds. The LED is red when the
voltage on supply inputs is above extremely high battery voltage or below extremely low battery voltage
thresholds.

Note

Network-level LEDs on the Control Cards
Table 319: Network-Level Indicators on the Control Cards

DefinitionSystem-Level LEDs

Indicates critical alarms in the network at the local terminal.Red CRIT LED

Indicates major alarms in the network at the local terminal.Red MAJ LED

Indicates minor alarms in the network at the local terminal.Yellow MIN LED

Provides first-level alarm isolation. The remote (REM) LED turns red when an
alarm is present in one or more of the remote terminals.

Red REM LED

Indicates that node timing is synchronized to an external reference.Green SYNC LED

After pressing the alarm cutoff (ACO) button, the ACO LED turns green. The
ACO button opens the audible alarm closure on the backplane. ACO is stopped
if a new alarm occurs. After the originating alarm is cleared, the ACO LED and
audible alarm control are reset.

Green ACO LED
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Ethernet Port-level LEDs on the Control Cards
Table 320: Ethernet Port-Level Indicators on the TNC/TNCE/TSC/TSCE/TNCS Cards

DefinitionPort-Level LEDs

Indicates the connectivity status.Green LINK LED

Indicates data reception.Amber ACT LED

SFP LEDs on TNC, TNCE, and TNCS Cards
Table 321: TNC, TNCE, and TNCS SFP Indicators

Activity LEDLink LEDPort Type

—• RED - No link

• GREEN - Link

OC3

Blinks on packet flow• RED - No link

• GREEN - Link

FE

Blinks on packet flow• RED - No link

• GREEN - Link

GE

Client Interface
The client interface in TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C cards
is implemented with a separately orderable XFP module. The module is a tri-rate transceiver, providing a
single port that can be configured in the field to support an OC-192 SR-1 (Telcordia GR-253-CORE) or
STM-64 I-64.1 (ITU-T G.691) optical interface, as well as 10GE LAN PHY (10GBASE-LR), 10GE WAN
PHY (10GBASE-LW), 10G FC signals or IB_5G signals (TXP_MR_10EX_C only).

The client side XFP pluggable module supports LC connectors and is equipped with a 1310-nm laser.

TheMXP_2.5G_10E,MXP_2.5G_10E_C,MXP_2.5G_10E_L, andMXP_2.5G_10EX_C cards provide four
intermediate- or short-range OC-48/STM-16 ports per card on the client side. Both SR-1 or IR-1 optics can
be supported and the ports use SFP connectors. The client interfaces use four lasers of 1310-nm wavelength.

The client interface in AR_MXP, AR_XP, and AR_XPE cards are implemented with a separately orderable
XFP/SFP module. The module can be single-rate or tri-rate transceiver, providing a single port that can be
configured in the field to support available payloads. For the list of supported payloads, see the section.
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DWDM Interface
The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards serve as an
OTN multiplexer, transparently mapping four OC-48 channels asynchronously to ODU1 into one 10-Gbps
trunk. The tunable wavelengths for the DWDM trunk is as follows:

• MXP_2.5G_10E—Tunable for transmission over four wavelengths in the 1550-nm, ITU 100-GHz spaced
channel grid.

• MXP_2.5G_10E_C and MXP_2.5G_10EX_C—Tunable for transmission over the entire C-band and
the channels are spaced at 50-GHz on the ITU grid.

• MXP_2.5G_10E_L—Tunable for transmission over the entire L-band and the channels are spaced at
50-GHz on the ITU grid.

• AR_MXP, AR_XP, and AR_XPE—The wavelengths for the DWDM trunk is based on the pluggable.

• 100G-LC-C, 10X10G-LC, CFP-LC, 100G-ME-C, 100GS-CK-LC, 200G-CK-LC, 100G-CK-C,
and 100ME-CKC—Tunable on 96 wavelength channels spaced at 50-GHz on the ITU grid over
the entire C band.

You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the card
in a loopback on the trunk port. Do not use direct fiber loopbacks as it can cause
irreparable damage to the card.

Caution

On the MXP_2.5G_10EX_C card, you cannot disable ITU-T G.709 on the trunk
side. If ITU-T G.709 is enabled, then FEC cannot be disabled.

Note

DWDM Trunk Interface
On the trunk side, the TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C cards
provide a 10-Gbps STM-64/OC-192 interface. There are four tunable channels available in the 1550-nm band
or eight tunable channels available in the 1580-nm band on the 50-GHz ITU grid for the DWDM interface.
The card provides 3R (retime, reshape, and regenerate) transponder functionality for this 10-Gbps trunk
interface. Therefore, the card is suited for use in long-range amplified systems. The DWDM interface is
complaint with ITU-T G.707, ITU-T G.709, and Telcordia GR-253-CORE standards.

The DWDM trunk port operates at a rate that is dependent on the input signal and the presence or absence of
the ITU-T G.709 Digital Wrapper/FEC. The possible trunk rates are:

• OC192 (9.95328 Gbps)

• OTU2 (10.70923 Gbps)

• 10GE (10.3125 Gbps) or 10GE into OTU2 (ITU G.sup43 11.0957 Gbps)

• 10G FC (10.51875 Gbps) or 10G FC into OTU2 (nonstandard 11.31764 Gbps)
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• (TXP_MR_10EX_C only) Proprietary rate at the trunk when the client is provisioned as IB_5G.

The maximum system reach in filterless applications without the use of optical amplification or regenerators
is nominally rated at 23 dB over C-SMF fiber. This rating is not a product specification, but is given for
informational purposes. It is subject to change.

On the trunk side, the AR_MXP, AR_XP, and AR_XPE cards provide a 10-Gbps OTU2 or 2.5-Gbps OTU1
or 4-Gbps FC interfaces. The trunk wavelength can be tuned to any C-band wavelength, based on the pluggable
inserted. The card provides 3R (retime, reshape, and regenerate) transponder functionality for this 10-Gbps
trunk interface. Therefore, the card is suited for use in the long-range amplified systems. The DWDM interface
is complaint with ITU-T G.707, ITU-T G.709, and Telcordia GR-253-CORE standards. The DWDM trunk
port operates at a rate that is dependent on the input signal and the presence or absence of the ITU-T G.709
Digital Wrapper/FEC.

The maximum system reach in filterless applications without the use of optical amplification or regenerators
is nominally rated at 23 dB over C-SMF fiber. This rating is not a product specification, but is given for
informational purposes. It is subject to change.

FEC
Forward error correction (FEC) is a feature used for controlling errors during data transmission. This feature
works by adding data redundancy to the transmitted message using an algorithm. This redundancy allows the
receiver to detect and correct a limited number of errors occurring anywhere in the message, instead of having
to ask the transmitter to resend the message.

FEC Modes for the TXP_MR_10E and MXP_2.5G_10E Cards
For the TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10E, MXP_2.5G_10E_C,
MXP_2.5G_10E_L, TXP_MR_10EX_C, or MXP_2.5G_10EX_C card, you can configure the forward error
correction in three modes: NO FEC, FEC, and E-FEC modes.

The E-FEC mode has a higher level of error detection and correction than the FEC mode. As a result, using
the E-FEC mode allows higher sensitivity (that is, a lower optical signal-to-noise ratio [OSNR]) with a lower
bit error rate than what the FEC mode allows. The E-FEC mode also enables longer distance trunk-side
transmission than what the FEC enables.

The output bit rate is always 10.7092 Gbps as defined in the ITU-T G.709 standard, but the error coding
performance can be provisioned in this way:

• NO FEC—No forward error correction

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm

• E-FEC—Standard ITU-T G.975.1 I.7, two orthogonally concatenated BCH super FEC code. This FEC
scheme contains three parameterizations of a single scheme of two orthogonally interleaved BCH. The
constructed code is decoded iteratively to achieve the expected performance.

FEC Modes for the AR_MXP, AR_XP and AR_XPE Cards
For the AR_MXP, AR_XP, and AR_XPE cards you can configure forward error correction on 10 Gbps trunk
XFP ports in four modes: NO FEC, FEC, I.4 E-FEC, and I.7 E-FEC. The 2.5Gbps SFP OTN ports have only
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two modes of operation: NO FEC and FEC. The output bit rate varies depending on the provisioned payload
and the configured FEC. The details of the error-coding performance that can be provisioned are:

• NO FEC—No forward error correction

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm

• I.4 E-FEC—Standard G.975.1 I.4 two interleaved codes (RS and BCH) super FEC codes

• I.7 E-FEC— Standard G.975.1 I.7 two orthogonally concatenated block (BCH) super FEC codes; this
FEC scheme contains three parameterizations of a single scheme of two BCH codes, with the constructed
code decoded iteratively to achieve expected performance.

G.709 OTN is enabled by default for all trunk ports, except for a 4GFC
transponder.

Note

FEC Modes for 100G-LC-C, CFP-LC, 100G-CK-C, 100GS-CK-LC, 200G-CK-LC, and
400G-XP-LC Cards

The cards support multiple FEC modes on its trunk and client interfaces.

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm with 7% overhead.

• I.7 FEC—Standard G.975.1 I.7 two orthogonally concatenated block (BCH) super FEC codes; this FEC
scheme contains three parameterizations of a single scheme of two BCH codes, with the constructed
code decoded iteratively to achieve expected performance.

• Soft Decision FEC—Employs an advanced differential encoding and cycle slip-aware algorithm offering
excellent performance and robustness against high cycle slip rates. The SD-FEC is suitable for applications
where maintaining sufficient signal to noise ratio is important. Examples include long haul and ultra-long
haul 100G transmission, and wavelengths employing high order modulation schemes such as 16QAM.

• HighGain FEC—HighGain FECwith 7% or 20% overhead provides better performance than the standard
G.975.1. The HG-FEC is suitable for all applications where 100G wavelengths are passing through a
high number of ROADM nodes, with limited pass-band performance.

G.709 OTN is enabled by default for OTU payloads.Note

• Hard Decision FEC—The HD-FEC with 7% overhead can be provisioned on the 100GS-CK-LC and
200G-CK-LC cards to allow trunk interoperability with the 100G-LC-C and 100G-CK-LC (older Line
Cards). The 100GS-CK-LC and 200G-CK-LC cards provisioned with 7% HD-FEC has 0.5dB better
B2B OSNR sensitivity than the 100G-LC-C and 100G-CK-LC cards. This FEC mode is available for
all 100G operating modes.
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Table 322: Supported FEC Modes for 100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100GS-CK-LC, 200G-CK-LC, and 400G-XP-LC Cards

Supported FEC ModesCard

• Standard

• 7% High Gain

• 20% High Gain

100G-LC-C

• GFECCFP-LC

• Standard

• 7% High Gain

• 20% High Gain

100G-CK-C

• Standard

• 7% Hard Decision

• 20% Soft Decision

100GS-CK-LC

• Standard

• 7% Hard Decision

• 20% Soft Decision

200G-CK-LC

• 15% Soft Decision Differential Encoding (DE)
OFF

• 25% Soft Decision Differential Encoding (DE)
OFF

• 15% Soft Decision Differential Encoding (DE)
ON

• 25% Soft Decision Differential Encoding (DE)
ON

400G-XP-LC

FEC Threshold Bit Error Correction Values
The maximum bit error correction value in R9.6.0.3 is lesser than the maximum bit error correction value in
earlier releases. During an upgrade to R9.6.0.3, the value of the Bit Errors Corrected does not change. In CTC,
the maximum bit error correction value can be manually reconfigured in the card view > Provisioning > OTN
> FEC Threshold tab using the values provided in the following table.
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Table 323: FEC Threshold Bit Error Correction Values

Maximum Bit Error Correction per 15
Seconds

Bit Error Correction
per Second

Frames per
Second

Bit Error
Correction

Data Rate

Releases earlier than R9.6.0.3

90336218112001003735756882026122368Any data rate

R9.6.0.3

7527997440083644416204214096OTU1

302380646400335978496820264096OTU2

121463930880013495992323294924096OTU3

315616296960035068477448561644096OTU4

Client-to-Trunk Mapping
The TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_10EX_C, AR_MXP, AR_XP, and
AR_XPE cards can perform ODU2-to-OCh mapping, which allows operators to provision data payloads in
a standard way across 10-Gbps optical links. Additionally, the AR_MXP, AR_XP, and AR_XPE cards can
perform ODU1-to-OCh mapping across 2.5 Gbps optical links.

Digital wrappers that define client side interfaces are called Optical Data Channel Unit 2 (ODU2) entities in
ITU-T G.709. Digital wrappers that define trunk side interfaces are called Optical Channels (OCh) in ITU-T
G.709. ODU2 digital wrappers can include Generalized Multiprotocol Label Switching (G-MPLS) signaling
extensions to ITU-T G.709 (such as Least Significant Part [LSP] and Generalized Payload Identifier [G-PID]
values) to define client interfaces and payload protocols.

Timing Synchronization
The TCC2/TCC2P/TCC3 card performs all system-timing functions for each ONS 15454. The
TNC/TNCE/TSC/TSCE/TNCS card performs all the system-timing functions for the ONS 15454 M2, ONS
15454 M6, and ONS 15454 M15 shelves.

Due to memory limitations, TCC2/TCC2P cards are not supported from Release 10.5.2 onwards. As a result,
in a multishelf configuration, the TCC2/TCC2P card cannot be a node controller or a shelf controller. Upgrade
the TCC2/TCC2P card to a TCC3 card.

Note

The control card monitors the recovered clocks from each traffic card and two BITS ports for frequency
accuracy. The control card selects a recovered clock, a BITS, or an internal Stratum 3 reference as the
system-timing reference. You can provision any of the clock inputs as primary or secondary timing sources.
A slow-reference tracking loop allows the control card to synchronize with the recovered clock, which provides
holdover if the reference is lost. The control card supports 64/8K composite clock and 6.312 MHz timing
output.
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The TNC/TNCE/TSC/TSCE/TNCS card supports the BITS-1 and BITS-2 external timing interfaces on the
ONS 15454 M6 and NCS 2015 shelves. The card supports the BITS-1 interface on the ONS 15454 M2 shelf.

Note

The TNC/TNCE/TSC/TSCE/TNCS card supports SNTP operation that allows the nodes to synchronize the
system clock automatically with a reference SNTP server following system reboots, card resets, and software
upgrades.

For more information on the timing function, see Timing Reference document.

TheMXP_2.5G_10G card is synchronized to the the control card clock during normal conditions and transmits
the ITU-T G.709 frame using this clock. The control card can operate from an external building integrated
timing supply (BITS) clock, an internal Stratum 3 clock, or from clock recovered from one of the four valid
client clocks. If clocks from both the control cards are not available, the MXP_2.5G_10G card switches
automatically (with errors, not hitless) to an internal 19.44 MHz clock that does not meet SONET clock
requirements. This will result in a clock alarm.

The MXP_2.5G_10E and MXP_2.5G_10EX_C cards are synchronized to the control clock and the
MXP_2.5G_10E_C and MXP_2.5G_10E_L cards are synchronized to the control card clock during normal
conditions and transmits the ITU-T G.709 frame using this clock. No holdover function is implemented. If
neither control clock is available, the cards switch automatically (hitless) to the first of the four valid client
clocks with no time restriction as to how long it can run on this clock. The cards continue to monitor the
control card. If a control card is restored to working order, the cards revert to the normal working mode of
running from the control-card clock. If no valid control-card clock is available and all of the client channels
become invalid, the cards wait (no valid frames processed) until the control card supplies a valid clock. In
addition, the cards can select the recovered clock from one active and valid client channel and supply that
clock to the control card card.

The AR_MXP, AR_XP, and AR_XPE cards are able to transparently transport synchronization and timing
information for payload enveloped within ODU-1 and ODU-2. The AR_MXP and AR_XP cards are
synchronized to the control card clock during normal conditions and transmit the ITU-T G.709 frame using
this clock. The AR_XPE card is synchronized to the control card clock during normal conditions and transmit
the ITU-TG.709 frame using this clock. The AR_MXP, AR_XP, and AR_XPE cards select its synchronization
source between an optical line, an external synchronization input, and the internal source. The optical line
can be either OCN, OTN or Ethernet based. The AR_MXP and AR_XP cards transmit the SyncE information
from an incoming SyncEthernet (ITU-T G.8262 and G.8264 ESMC) signal to the node controller (TNC).

The 100G-LC-C, 10x10G-LC, CFP-LC, 100G-ME-C, 100G-CK-C, and 100ME-CKC cards are synchronized
to TNC/TSC/TNCE/TSCE/TNCS clock during normal conditions and transmits the ITU-TG.709 frame using
this clock.

The 100GS-CK-LC and 200G-CK-LC cards cannot be used as a timing reference source.

Only one port per card can be selected as a timing reference. The OTN ports configured as clients shall not
be provisionable as timing source.

Note
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Multiplexing Function
The muxponder is an integral part of the reconfigurable optical add/drop multiplexer (ROADM) network.
The key function of the MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10EX_C,
AR_MXP, AR_XP, and AR_XPE cards is to multiplex 4 OC-48/STM16 signals onto one ITU-T G.709 OTU2
optical signal (DWDM transmission). The multiplexing mechanism allows the signal to be terminated at a
far-end node by another similar card.

Termination mode transparency on the muxponder is configured using OTUx and ODUx OH bytes. The
ITU-TG.709 specification defines OH byte formats that are used to configure, set, andmonitor frame alignment,
FEC mode, section monitoring, tandem connection monitoring, and termination mode transparency.

The card performs ODU to OTU multiplexing as defined in ITU-T G.709. The ODU is the framing structure
and byte definition (ITU-T G.709 digital wrapper) used to define the data payload coming into one of the
SONET/SDH client interfaces on the card. The term ODU1 refers to an ODU that operates at 2.5-Gbps line
rate. On the card, four client interfaces can be defined using ODU1 framing structure and format by asserting
an ITU-T G.709 digital wrapper.

The output of the muxponder is a single 10-Gbps DWDM trunk interface defined using OTU2. It is within
the OTU2 framing structure that FEC or E-FEC information is appended to enable error checking and correction.

SONET/SDH Overhead Byte Processing
The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10EX_C, AR_MXP, AR_XP,
AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 100GS-CK-LC, 200G-CK-LC, 100G-ME-C,
and 100ME-CKC cards pass the incoming SONET/SDH data stream and its overhead bytes for the client
signal transparently. The card can be provisioned to terminate regenerator section overhead. This is used to
eliminate forwarding of unneeded layer overhead. It can help reduce the number of alarms and help isolate
faults in the network.

Client Interface Monitoring
The following parameters are monitored on the MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L,
MXP_2.5G_10EX_C, AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C,
100GS-CK-LC, , 200G-CK-LC, 100G-ME-C, and 100ME-CKC cards:

• Laser bias current is measured as a PM parameter

• LOS is detected and signaled

• Transmit (TX) and receive (RX) power are monitored

The following parameters are monitored in real time mode (one second):

• Optical power transmitted (client)

• Optical power received (client)

In case of loss of communication (LOC) at the DWDM receiver or far-end LOS, the client interface behavior
is configurable. AIS can be invoked or the client signal can be squelched.
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Jitter
For SONET and SDH signals, the MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L,
MXP_2.5G_10EX_C, AR_MXP, AR_XP, AR_XPE cards comply with Telcordia GR-253-CORE,
ITU-T G.825, and ITU-T G.873 for jitter generation, jitter tolerance, and jitter transfer. For more information,
see the Jitter Considerations, on page 766.

Lamp Test
TheMXP_2.5G_10E,MXP_2.5G_10E_C andMXP_2.5G_10E_L,MXP_2.5G_10EX_C,AR_MXP,AR_XP,
AR_XPE, TDC-CC, TDC-FC, TNC, TNCE, TSC, TSCE, TNCS, RAMAN-CTP, and RAMAN-COP cards
support lamp test function activated from the shelf front panel or through CTC to ensure that all LEDs are
functional.

The Lamp Test is run during the initial node turn-up, periodic maintenance routine, identification of specific
cards, or LED testing.

NTP-G335 Performing Lamp Test
This procedure performs lamp test at the shelf and card levels.Purpose

NoneTools/Equipment

DLP-G46 Log into CTCPrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Superuser onlySecurity Level

Procedure

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance> Diagnostic
tab.

Step 2 Click the Lamp Test button. The Lamp Test dialog box appears.
Step 3 Perform lamp test at the shelf level.

• Select the All option.

• Click Lamp Test.

Step 4 Perform lamp test at the card level.

• Select the Lamp Test For Slot option

• Choose the required Slot ID or card from the drop-down list.
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• Click Slot Lamp Test.

Cards in pre-provisioned or improper removal state are not listed in the drop-down list.Note

Stop. You have completed this procedure.

Onboard Traffic Generation
The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards provide
internal traffic generation for testing purposes according to pseudo-random bit sequence (PRBS), SONET/SDH,
or ITU-T G.709.

Performance Monitoring
GFP-T performance monitoring (GFP-T PM) in MXP_MR_2.5G, MXPP_MR_2.5G, AR_MXP, AR_XP,
AR_XPE, 100G-LC-C, 10x10G-LC, 100G-CK-C, 100GS-CK-LC, 200G-CK-LC, 100G-ME-C, and
100ME-CKC cards are available via remote monitoring (RMON), and trunk PM is managed according to
Telcordia GR-253-CORE and ITU G.783/826. Client PM is achieved through RMON for FC and GE.

Distance Extension
In MXP_MR_2.5G and MXPP_MR_2.5G cards, buffer-to-buffer credit management scheme provides FC
flow control. When this feature is enabled, a port indicates the number of frames that can be sent to it (its
buffer credit), before the sender is required to stop transmitting and wait for the receipt of a “ready” indication
The MXP_MR_2.5G and MXPP_MR_2.5 cards support FC credit-based flow control with a buffer-to-buffer
credit extension of up to 1600 km (994.2 miles) for 1G FC and up to 800 km (497.1 miles) for 2G FC. The
feature can be enabled or disabled, as necessary.

Interoperability with Cisco MDS Switches
You can provision a string (port name) for each fiber channel/FICON interface on the MXP_MR_2.5G and
MXPP_MR_2.5G cards, which allows the MDS Fabric Manager to create a link association between that
SAN port and a SAN port on a Cisco MDS 9000 switch.

Client and Trunk Ports
The MXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser
(depending on the SFP) for the client ports. The card contains eight 12.5 degree downward tilt SFP modules
for the client interfaces. For optical termination, each SFP uses two LC connectors, which are labeled TX and
RX on the faceplate. In a MXP_MR_2.5G card, the trunk port is a dual-LC connector with a 45 degree
downward angle. In a MXPP_MR_2.5G card, there are two trunk port connectors (one for working and one
for protect), each a dual-LC connector with a 45-degree downward angle.
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Automatic Power Control
A transient gain range of 20 to 23 dB is available to APC in order to permit other amplifiers to reach their
expected set points. However, operation in this range is not continuous. At startup, the OPT-AMP-17-C card
caps the gain at a maximum of 20 dB.

When the OPT-AMP-17-C operates as a booster amplifier, APC does not control its gain.Note

Alarms and Thresholds
The following table lists the alarms and its related thresholds for the OSC-CSM card.

Table 324: Alarms and Thresholds

ThresholdsAlarmsPort

NoneLOSLINE RX

LOS-P Fail LowLOS-P

LOS-O Fail LowLOS-O

NoneNoneLINE TX

OPWR-DEG-HIGH ThOPWR-DEG-HIGHOSC TX

OPWR-DEG-LOW ThOPWR-DEG-LOW

OPWR-FAIL-LOW ThOPWR-FAIL-LOW

NoneNoneOSC RX

NoneNoneCOM TX

LOS-P Fail LowLOS-PCOM RX

Card Protection

Y-Cable and Splitter Protection
Y-cable and splitter protection are two main forms of card protection that are available for TXP, MXP,
AR_MXP, AR_XP, AR_XPE, and Xponder (GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, and OTU2_XP)
cards when they are provisioned in TXP or MXPmode. Y-cable protection is provided at the client port level.
Splitter protection is provided at the trunk port level.

Cisco ONS 15454 DWDM Line Card Configuration Guide, Release 10.x.x
759

Card Features
Automatic Power Control



GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards use VLAN protection when they are provisioned in
L2-over-DWDM mode. For more information, see the Layer 2 Over DWDM Protection, on page 765. The
ADM-10G card uses path protection and 1+1 protection. For more information, see the Protection section.

Note

Y-Cable Protection Availability on TXP, MXP, and Xponder Cards
Y-cable protection is available for the following ONS 15454 TXP, MXP, and Xponder cards:

• TXP_MR_10G

• TXP_MR_10E

• TXP_MR_2.5G

• 40E-TXP-C

• 40ME-TXP-C

• MXP_2.5G_10G

• MXP_2.5G_10E

• MXP_2.5G_10E_C

• MXP_2.5G_10E_L

• MXP_MR_2.5G

• MXP_MR_10DME_C

• MXP_MR_10DME_L

• 40G-MXP-C

• 40E-MXP-C

• 40ME-MXP-C

• GE_XP and GE_XPE (when in 10GE or 20GE MXP card mode)

• 10GE_XP and 10GE_XPE (when in 10GE TXP card mode)

• OTU2_XP (when in Transponder card configuration)

• AR_MXP

• AR_XP

• AR_XPE

• 10x10G-LC (when in TXP-10G or MXP-10G mode)—The client ports of the 10x10G-LC cards are
provisioned with OC192/STM-64, 10GE-LAN, OTU2, OTU2e, 8G FC, and 10G FC payloads.

Y-cable protection is supported when the 10x10G-LC card is configured in MXP-10x10G operating
mode with 200G-CK-LC card and the 10x10G-LC card is provisioned with 10GE, OC-192/STM-64
payloads. This configuration uses the ONS-SC+-10G-LR and ONS-SC+-10G-SR pluggables.
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A hardware reset or a hardware failure of the active 10x10G-LC card configured
in the TXP-10G orMXP-10Gmode in a Y-cable configuration causes a protection
switchover that may result in a traffic hit of more than 50 msec.

Note

• CFP-LC (when in CFP-TXP mode)—The client ports of the CFP-LC cards are provisioned with 100GE
payloads. This configuration uses only the CFP LR4 pluggable.

• CFP-LC (when in CFP-MXP mode)—The client ports of the CFP-LC cards are provisioned with 40GE
payloads. This configuration uses only the CFP LR4 pluggable.

• 200G-CK-LC (when in TXP-100Gmode)—Y-cable protection is supportedwhen the 200G-CK-LC card
is configured in TXP-100G operatingmode and the 100G client CPAK ports are provisioned with 100GE
payload. This configuration uses the CPAK-100G-LR4 pluggable.

• 100G-CK-C—The client ports of the 100G-CK-C cards are provisioned with 100GE/OTU4 payloads.
This configuration uses only the CPAK-100G-LR4 pluggable.

• 100GS-CK-LC and 200G-CK-LC—Y-cable protection is supported in MXP-10x10G operating mode.

Setting-up Y-Cable Protection
To set up Y-cable protection, create a Y-cable protection group for two TXP, MXP, or Xponder cards using
Cisco Transport Controller (CTC). Next, connect the client ports of the two cards physically with a Y-cable.
The single client signal is sent into the RX Y-cable and is split between the two TXP, MXP, or Xponder cards.
The two TX signals from the client side of the TXP, MXP, or Xponder cards are combined in the TX Y-cable
into a single client signal. Only the active card signal passes through as the single TX client signal. CTC
automatically turns off the laser on the protect card to avoid signal interference where the Y-cable joins.

On the GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, and OTU2_XP cards, the Y-cable protection mechanism
is provisionable and can be set ON or OFF (OFF is the default mode).

When a signal fault is detected, the protection mechanism software automatically switches between paths.
Y-cable protection also supports revertive and nonrevertive mode.

When an MXP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, AR_MXP, AR_XP, or AR_XPE
card that is provisioned with Y-cable protection is used on a storage ISL link (ESCON, FC1G, FC2G, FC4G,
FICON1G, FICON2G, FICON4G, or ISC-3 1/2G), a protection switchover resets the standby port to active.
This reset reinitialises the end-to-end link to avoid any link degradation caused due to loss of buffer credits
during switchover and results in an end-to-end traffic hit of 15 to 20 seconds.

When using the MXP_MR_10DME_C or MXP_MR_10DME_L card, enable the fast switch feature and use
it with a Cisco MDS storage switch to avoid this 15 to 20 second traffic hit. When enabling fast switch on the
MXP_MR_10DME_C or MXP_MR_10DME_L card, ensure that the attached MDS switches have the
buffer-to-buffer credit recovery feature enabled.

You can also use the TXP_MR_2.5G card to avoid this 15 to 20 second traffic hit. When a Y-cable protection
switchover occurs, the storage ISL link does not reinitialize and results in an end-to-end traffic hit of less than
50 ms.

AR_MXP, AR_XP, and AR_XPE cards support Y-cable protection on the client ports, which are part of an
unprotected card mode. The Y-cable protection is not supported for video and auto payloads.
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When using the AR_MXP, AR_XP, or AR_XPE card on storage ISL link, use it with a Cisco MDS storage
switch to avoid this 15 to 20 second traffic hit.

When the active AR_MXP, AR_XP, AR_XPE card is removed from the shelf, there is a traffic hit of 60 to
100 ms.

Y-cable connectors will not work with electrical SFPs because Y-cables are made up of optical connectors
and it is not possible to physically connect them to an electrical SFP. Y-cable protection is not supported on
IB_5G.

Note

There is a traffic hit of up to a of couple hundredmilliseconds on theMXP_MR_2.5G andMXP_MR_10DME
cards in Y-cable configuration when a fiber cut or SFP failure occurs on one of the client ports.

Note

If you create a GCC on either card of the protect group, the trunk port stays permanently active, regardless
of the switch state. When you provision a GCC, you are provisioning unprotected overhead bytes. The GCC
is not protected by the protect group.

Note

Loss of Signal–Payload (LOS-P) alarms, also called Incoming Payload Signal Absent alarms, can occur on
a split signal if the ports are not in a Y-cable protection group.

Note

Removing an SFP from the client ports of a card in a Y-cable protection group card causes an IMPROPRMVL
(PPM) alarm. The working and protected port raises the IMPROPRMVL alarm. The severity on the client
ports is changed according to the protection switch state.

Note

On the OTU2_XP card, when the 10G Ethernet LAN Phy toWAN Phy conversion feature is enabled, Y-cable
protection is not supported on the LAN to WAN interface (ports 1 and 3).

Note
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When using fixed DWDM or tunable XFPs for Y-cable protection, the protection switch time may exceed
50 ms.

The following figure shows the Y-cable signal flow.

Figure 51: Y-Cable Protection

Note

Splitter Protection
Splitter protection, shown in the following figure, is provided with TXPP cards, MXPP cards, and OTU2_XP
cards (on trunk ports that are not part of a regenerator group). You can create and delete splitter protection
groups in OTU2_XP card.

To implement splitter protection, a client injects a single signal into the client RX port. An optical splitter
internal to the card then splits the signal into two separate signals and routes them to the two trunk TX ports.
The two signals are transmitted over diverse optical paths. The far-end MXPP or TXPP card uses an optical
switch to choose one of the two trunk RX port signals and injects it into the TX client port. When using splitter
protection with two MXPP or TXPP cards, there are two different optical signals that flow over diverse paths
in each direction. In case of failure, the far-end switch must choose the appropriate signal using its built-in
optical switch. The triggers for a protection switch are LOS, LOF, SF, or SD.

In the splitter protected 10G Ethernet LAN Phy to WAN Phy mode, AIS-P and LOP-P acts as trigger (when
G.709 is enabled) for the Protection Switch, in addition to the existing switching criteria.

In the OTU2_XP card, the STS parameters such as, SF /SD thresholds, Path PM thresholds, and Path Trace
is set for the working path (Port 3). The same parameters are also applicable for the protected path (Port 4).
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Figure 52: Splitter Protection

1+1 Protection
The 1+1 protection is available for the GE_XP, GE_XPE, 10GE_XP, and 10GE_XPE cards:

The 1+1 protection is provided in the Layer 2 (L2) card mode to protect against client port and card failure.
1+1 protection is supported in both single shelf and multishelf setup. This means that the working card can
be in one shelf and the protect card can be in another shelf of a multishelf setup. Communication between the
two cards is across 10 Gigabit Ethernet interconnection interface using Ethernet packets. The Inter link (ILK)
trunk or internal pathcord must be provisioned on both the cards. This link is used to transmit protection
switching messages and data.

With 1+1 protection mechanisms, the switch time of a copper SFP is 1 second.Note

With 1+1 protection, ports on the protect card can be assigned to protect the corresponding ports on the
working card. A working card must be paired with a protect card of the same type and number of ports. The
protection takes place on the port level, and any number of ports on the protect card can be assigned to protect
the corresponding ports on the working card.

To make the 1+1 protection scheme fully redundant, enable L2 protection for the entire VLAN ring. This
enables Fast Automatic Protection Switch (FAPS). The VLAN configured on the 1+1 port must be configured
as protected SVLAN.

1+1 protection can be either revertive or nonrevertive.With nonrevertive 1+1 protection, when a failure occurs
and the signal switches from the working card to the protect card, the signal remains on the protect card until
it is manually changed. Revertive 1+1 protection automatically switches the signal back to the working card
when the working card comes back online. 1+1 protection uses trunk ports to send control traffic between
working and protect cards. This trunk port connection is known as ILK trunk ports and can be provisioned
via CTC.

The standby port can be configured to turn ON or OFF but the traffic coming to and from the standby port
will be down. If the laser is ON at the standby port, the other end port (where traffic originates) will not be
down in a parallel connection. Traffic is blocked on the standby port.

1+1 protection is bidirectional and nonrevertive by default; revertive switching can be provisioned using CTC.
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Layer 2 Over DWDM Protection
The Layer 2 Over DWDM protection is available for the following cards:

• GE_XP and GE_XPE

• 10GE_XP and 10GE_XPE

When the card is in L2-over-DWDM card mode, protection is handled by the hardware at the Layer 1 and
Layer 2 levels. Fault detection and failure propagation is communicated through the ITU-T G.709 frame
overhead bytes. For protected VLANs, traffic is flooded around the 10 Gigabit Ethernet DWDM ring. To set
up the Layer 2 protection, you identify a node and the card port that is to serve as the primary node and port
for the VLAN ring on the card view Provisioning > Protection tab. If a failure occurs, the node and port are
responsible for opening and closing VLAN loops.

The Forced option in the Protection drop-down list converts all the SVLANs to protected SVLANs irrespective
of the SVLAN protection configuration in the SVLAN database. This is applicable to a point-to-point linear
topology. The SVLAN protection must be forced to move all SVLANs, including protected and unprotected
SVLANs, to the protect path irrespective of provisioned SVLAN attributes.

Note

A FAPS switchover happens in the following failure scenarios:

• DWDM line failures caused by a fiber cut

• Unidirectional failure in the DWDM network caused by a fiber cut

• Fiber pull on the primary card trunk port followed by a hard reset on the primary card

• Hard reset on the primary card

• Hard reset on the secondary card

• An OTN failure is detected (LOS, OTUK-LOF, OTUK-LOM, OTUK-LOM, OTUK-SF, or OTUK-BDI
on the DWDM receiver port in the case of ITU-T G.709 mode)

• Trunk ports are moved to OOS,DSBLD (Locked,disabled) state

• Improper removal of XFPs

A FAPS switchover does not happen in the following scenarios:

• Secondary card trunk port in OOS,DSBLD (Locked,disabled) state followed by a hard reset of the
secondary card

• OTN alarms raised on the secondary card trunk port followed by a hard reset of the secondary card

Far-End Laser Control
The cards provide a transparent mode that accurately conveys the client input signal to the far-end client output
signal. The client signal is normally carried as payload over the DWDM signals. Certain client signals, however,
cannot be conveyed as payload. In particular, client LOS or LOF cannot be carried. Far-end laser control
(FELC) is the ability to convey an LOS or LOF from the near-end client input to the far-end client output.
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If an LOS is detected on the near-end client input, the near-end trunk sets the appropriate bytes in the OTN
overhead of the DWDM line. These bytes are received by the far-end trunk, and cause the far-end client laser
to be turned off. When the laser is turned off, it is said to be squelched. If the near-end LOS clears, the near-end
trunk clears the appropriate bytes in the OTN overhead, the far-end detects the changed bytes, and the far-end
client squelch is removed.

FELC also covers the situation in which the trunk port detects that it has an invalid signal; the client is squelched
so as not to propagate the invalid signal.

Payload types with the 2R mode preclude the use of OTN overhead bytes. In 2R mode, an LOS on the client
port causes the trunk laser to turn off. The far end detects the LOS on its trunk receiver and squelches the
client.

FELC is not provisionable. It is always enabled when the DWDM card is in transparent termination mode.
However, FELC signaling to the far-end is only possible when ITU-T G.709 is enabled on both ends of the
trunk span.

Jitter Considerations
Jitter introduced by the SFPs used in the transponders and muxponders must be considered when cascading
several cards. With TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_10E,
100G-LC-C, 10x10G-LC, CFP-LC, 100G-CK-C, 200G-CK-LC, 100GS-CK-LC, 100G-ME-C, 100ME-CKC,
AR_MXP, AR_XP, AR_XPE cards several transponders can be cascaded before the cumulative jitter violates
the jitter specification. The recommended limit is 20 cards. With TXP_MR_10G cards, you can also cascade
several cards, although the recommended limit is 12 cards.WithMXP_2.5G_10G andMXP_2.5G_10E cards,
any number of cards can be cascaded as long as the maximum reach between any two is not exceeded. This
is because any time the signal is demultiplexed, the jitter is eliminated as a limiting factor.

The maximum reach between one transponder and the other must be halved if a Y cable is used. For more
information on Y-cable operation, see the Y-Cable and Splitter Protection.

Termination Modes
Transponder and Muxponder cards have various SONET and SDH termination modes that can be configured
using CTC. The termination modes are summarized in the following table.

Table 325: Termination Modes

DescriptionTermination ModeCards

All the bytes of the payload pass transparently through the cards.Transparent TerminationAll TXP, MXP, and
OTU2_XP cards, with
the exception of the
MXP_2.5G_10G card
(see next row)

In line termination mode, the section and line overhead bytes for SONET
and the overhead bytes for the SDH multiplex and regenerator sections
are terminated. None of the overhead bytes are passed through. They are
all regenerated, including the SONET SDCC and line DCC (LDCC) bytes
and the SDH RS-DCC and multiplexer section DCC (MS-DCC) bytes.

Section Termination
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DescriptionTermination ModeCards

All client bytes pass transparently except the following: B1 is rebuilt, S1
is rewritten, A1 to A2 are regenerated, and H1 to H3 are regenerated.

Transparent TerminationMXP_2.5G_10G
(Clients operating at
the OC48/STM16 rate
are multiplexed into
an OC192/STM64
frame before going to
OTN or DWDM.)

The SONETTOH section bytes and the SDH regenerator section overhead
bytes are terminated. None of these section overhead bytes are passed
through. They are all regenerated, including the SONET TOH section
DCC bytes and the SDHRS-DCC bytes. In the section termination mode,
the SONET TOH line and SDH multiplex section overhead bytes are
passed transparently.

Section Termination

In the line termination mode, the section and line overhead bytes for
SONET and the overhead bytes for the SDH multiplex and regenerators
sections are terminated. None of the overhead bytes are passed through.
They are all regenerated, including the SONET SDCC and LDCC bytes
and the SDH RS-DCC and MS-DCC bytes.

Line Termination

For TXP and MXP cards, adhere to the following conditions while DCC termination provisioning:

• For SDCC/RS-DCCprovisioning, the card should be in the Section/RS-DCCor Line/MS-DCC termination
mode.

• For LDCC/MS-DCC provisioning, the card should be in the Line/MS-DCC termination mode.
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A P P E N D I X D
Card Specifications

The information in this chapter is in a new location. See Hardware Specifications for information related to
hardware and software specifications for the cards.
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A P P E N D I X E
Administrative and Service States

The information in this chapter is in a new location. See Administrative and Service States for an understanding
of administrative and service states for DWDM cards, optical payload ports, out-of-band optical service
channel (OSC) ports, optical channel network connections (OCHNCs), and transponder/muxponder cards
and ports.
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A P P E N D I X F
SNMP

The information in this chapter is in a new location. See SNMP for information related to Simple Network
Management Protocol (SNMP).
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A P P E N D I X G
CTC Enhancements, Operations, and Shortcuts

The information in this chapter is in a new location. See CTC Enhancements, Operations, and Shortcuts for
information on Cisco Transport Controller (CTC) views, menus options, tool options, shortcuts, table display
options, and shelf inventory data presented in CTC.
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A P P E N D I X H
Network Element Defaults

The information in this chapter is in a new location. See Network Element Defaults for information related
to factory-configured (default) network element (NE) settings.
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